Contents

Send Us Your Comments .............................................................................................................. xxxiii

Preface ............................................................................................................................................... xxxv

Audience for This Guide .................................................................................................................. xxxv
How To Use This Guide ................................................................................................................... xxxvi
Finding Out What's New ................................................................................................................... xxxvii

Other Information Sources ........................................................................................................... xxxviii

Online Documentation .................................................................................................................... xxxviii
Related User Guides ......................................................................................................................... xxxix

User Guides Related to All Products ............................................................................................... xxxix
  Oracle Applications User Guide ..................................................................................................... xxxix
  Oracle Alert User Guide ................................................................................................................ xxxix
  Oracle Applications Implementation Wizard User Guide ........................................................... xxxix
  Oracle Applications Developer's Guide ........................................................................................... x
  Oracle Applications User Interface Standards ............................................................................... x

User Guides Related to This Product ............................................................................................. x
  Oracle Applications Demonstration User’s Guide ...................................................................... x
  Oracle Bills of Material User’s Guide .............................................................................................. x
  Oracle Business Intelligence System Implementation Guide ...................................................... x
  BIS 11i User Guide Online Help .................................................................................................. xli
  Oracle Capacity User’s Guide .......................................................................................................... xli
  Oracle Demand Planning User’s Guide .......................................................................................... xli
  Oracle Flow Manufacturing User’s Guide ..................................................................................... xli
  Oracle Inventory User’s Guide ........................................................................................................ xli
  Oracle Master Scheduling/MRP and Oracle Supply Chain Planning User’s Guide ....... xli
1 Overview

Introducing Oracle Advanced Planning Suite
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle Advanced Supply Chain Planning</td>
<td>1-3</td>
</tr>
<tr>
<td>New Features</td>
<td>1-4</td>
</tr>
<tr>
<td>Centralized and Decentralized Planning</td>
<td>1-4</td>
</tr>
<tr>
<td>Advanced Planning for Mixed-Mode Manufacturing</td>
<td>1-4</td>
</tr>
<tr>
<td>Discrete and Process Manufacturing</td>
<td>1-4</td>
</tr>
<tr>
<td>Oracle Flow Manufacturing and Oracle ASCP</td>
<td>1-5</td>
</tr>
<tr>
<td>Oracle ASCP for Engineer to Order/Aerospace and Defense</td>
<td>1-5</td>
</tr>
<tr>
<td>Oracle Project Manufacturing</td>
<td>1-5</td>
</tr>
<tr>
<td>Simultaneous High-Level Planning and Detailed Scheduling</td>
<td>1-6</td>
</tr>
<tr>
<td>Finite, Constraint-Based Planning and Scheduling</td>
<td>1-6</td>
</tr>
<tr>
<td>Optimization Across Multiple Objectives with Weighting of Objectives</td>
<td>1-7</td>
</tr>
<tr>
<td>Advanced Simulation</td>
<td>1-8</td>
</tr>
<tr>
<td>Integrated Performance Management</td>
<td>1-8</td>
</tr>
<tr>
<td>Advanced Graphical User Interface</td>
<td>1-8</td>
</tr>
<tr>
<td>Key Performance Indicators</td>
<td>1-8</td>
</tr>
<tr>
<td>The Actions Tab</td>
<td>1-9</td>
</tr>
<tr>
<td>Graphics</td>
<td>1-10</td>
</tr>
<tr>
<td>Supply Chain Collaboration</td>
<td>1-10</td>
</tr>
<tr>
<td>Planning Engine Enhancements</td>
<td>1-11</td>
</tr>
<tr>
<td>Look-Ahead Heuristic</td>
<td>1-11</td>
</tr>
<tr>
<td>Firm Supply Allocation</td>
<td>1-11</td>
</tr>
<tr>
<td>Schedule Window Width</td>
<td>1-11</td>
</tr>
<tr>
<td>In-Line Forecast Consumption</td>
<td>1-11</td>
</tr>
<tr>
<td>Planning Time Fence</td>
<td>1-12</td>
</tr>
<tr>
<td>Efficiency and Utilization</td>
<td>1-12</td>
</tr>
<tr>
<td>Planner Workbench</td>
<td>1-12</td>
</tr>
<tr>
<td>3D to 2D Graph/Chart</td>
<td>1-12</td>
</tr>
<tr>
<td>Options for Displaying Number of Periods in Horizontal Plan Graph</td>
<td>1-13</td>
</tr>
<tr>
<td>Expand All Capability in Pegging Tree</td>
<td>1-13</td>
</tr>
<tr>
<td>Horizontal Plan and Graph Synchronization</td>
<td>1-13</td>
</tr>
<tr>
<td>Alternating Colors in Horizontal Plan</td>
<td>1-13</td>
</tr>
<tr>
<td>Gantt Chart</td>
<td>1-13</td>
</tr>
<tr>
<td>Navigate to Associated Activity</td>
<td>1-13</td>
</tr>
<tr>
<td>Ability to Change Activity Duration</td>
<td>1-13</td>
</tr>
<tr>
<td>View Subsets of Data</td>
<td>1-13</td>
</tr>
</tbody>
</table>
Split Views.................................................................................................................... 1-13
Oracle Shop Floor Manufacturing (OSFM) Integration .................................................... 1-14
  Support for Lot-Based Jobs ......................................................................................... 1-14
  Network Routings ....................................................................................................... 1-14
  Yield at Operation Level .............................................................................................. 1-14
  Support for Coproducts ............................................................................................... 1-14
Configure to Order (CTO) Enhancements ..................................................................... 1-15
  Multilevel Forecast Explosion and Consumption .................................................... 1-15
  Planning for Multilevel Configurations ...................................................................... 1-15
Oracle Risk Optimization .................................................................................................. 1-16
  Inventory Plan ............................................................................................................ 1-16
  Unconstrained and Constrained Safety Stocks ........................................................... 1-17
  Model Demand and Supply Variability ....................................................................... 1-17
  Service Level Requirements ....................................................................................... 1-17
  Flexible Optimization .................................................................................................. 1-17
  Capacity Exceptions .................................................................................................... 1-18
  Key Performance Indicators ....................................................................................... 1-18
    Time-Phased Inventory Levels (Dollarized) .............................................................. 1-18
    Service Level (Planned vs. Target) ........................................................................... 1-18
    Margin ..................................................................................................................... 1-18
    Cost Breakdown ...................................................................................................... 1-18
Integration to Advanced Supply Chain Planning .......................................................... 1-18
Oracle Global Order Promising ....................................................................................... 1-19
  Allocation (Allocated ATP, Allocation Hierarchies) ................................................... 1-20
  Multi-Level and Multiorg ATO Support ...................................................................... 1-20
  Workflow-Based Exceptions ...................................................................................... 1-21
Oracle Demand Planning ............................................................................................... 1-22
  Flat-file Import .......................................................................................................... 1-23
  Color-Coded Manual Edits ......................................................................................... 1-23
  Events, Promotions and New Product Introductions/Product Phase-Outs ................. 1-24
  Item-Based Unit of Measure (UOM) Conversions ...................................................... 1-24
  Dependent Demand Forecasting (Explosion) ............................................................. 1-24
  Time Effective Pricing ............................................................................................... 1-25
  Display Forecast Method, Parameters, and Errors .................................................... 1-25
  Level Values Window ............................................................................................... 1-25
2 Setting Up

Setup Overview .......................................................... 2-2
Deployment Configurations ........................................... 2-2
  One-Machine Implementation ..................................... 2-2
  Two-Machine Implementation ..................................... 2-3
  Three-Machine Implementation .................................. 2-4
  Four-Machine Implementation ................................... 2-5
Setup Flowchart ........................................................... 2-6
Setup Steps for the Source ................................................ 2-7
Setup Steps for the Destination ........................................ 2-13

3 Planning Business Flows

Business Flows .............................................................. 3-2
  APS Information Flows .................................................. 3-2
  The Demand-to-Make / Demand-to-Buy Business Flow . 3-3
  The Inquiry-to-Order Business Flow ............................... 3-4
Day in the Life of a Planner ............................................. 3-5
Specify Sources of Demand ............................................ 3-5
Run Collections ........................................................... 3-6
Create a Plan ............................................................... 3-6
Launch the Plan ............................................................ 3-6
Review Key Performance Indicators (KPIs) ......................... 3-7
Review Exceptions ........................................................ 3-7
Review Workflow Notifications ...................................... 3-8
View Pegged Supply and Demand .................................... 3-9
Modify Objectives ........................................................ 3-10
Modify Supply/Demand ................................................. 3-11
Modify Resources ......................................................... 3-11
Modify Supplier Parameters .......................................... 3-12
Run Net Change .......................................................... 3-12
  Review a Constrained Forecast that Results from Net Change Planning ............. 3-12
4 Running Collections for ASCP

Overview of Running Collections ................................................................. 4-2
Definitions .......................................................................................................... 4-2
   Oracle Applications Data Store (ADS) ............................................................ 4-2
   Operational Data Store (ODS) ........................................................................ 4-2
   Planning Data Store (PDS) ............................................................................ 4-2
   Data Collection .............................................................................................. 4-3
   Collection Workbench .................................................................................... 4-3
Collection Strategy .......................................................................................... 4-3
   Multiple Source Instances ............................................................................. 4-4
   Pull Architecture ............................................................................................. 4-4
   Detect Net Change to Synchronize Oracle Applications and Oracle ASCP ... 4-4
   Multi-Process Collection Architecture .......................................................... 4-4
   Data Consolidation ......................................................................................... 4-4
   Projects/Tasks, and Seiban Numbers ............................................................... 4-5
   Oracle Applications Version and RDBMS Version .......................................... 4-5
   Support for Several Configurations ............................................................... 4-5
Architecture ....................................................................................................... 4-5
   Supported Configurations ............................................................................. 4-7
      Centralized Planning .................................................................................... 4-7
      Decentralized Planning ............................................................................. 4-8
Running Collections Steps ................................................................................. 4-10
Data Changes That Can Be Collected in Net Change Mode ................................ 4-15

5 Defining Plans

Overview of Defining Plans ............................................................................. 5-2
Global Supply Chain Planning .......................................................................... 5-2
   Prerequisites for Running a Global Supply Chain Plan ................................ 5-3
   Advantages of the Single Plan ....................................................................... 5-4
Subset Plans ....................................................................................................... 5-6
   Pitfalls of Subset Planning ............................................................................ 5-7
Choosing Between Global Supply Chain and Subset Plans .......................... 5-9
Choosing a Plan Type ......................................................................................... 5-11
# 6 Supply Chain Modeling

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview of Supply Chain Modeling</td>
<td>6-2</td>
</tr>
<tr>
<td>Setting up the Supply Chain</td>
<td>6-2</td>
</tr>
<tr>
<td>Defining Sourcing Rules</td>
<td>6-3</td>
</tr>
<tr>
<td>Defining BODs</td>
<td>6-3</td>
</tr>
<tr>
<td>Defining Assignment Sets</td>
<td>6-3</td>
</tr>
<tr>
<td>Assignment Hierarchy</td>
<td>6-4</td>
</tr>
<tr>
<td>Setting Supplier Capacity</td>
<td>6-4</td>
</tr>
<tr>
<td>Allocation of Demand Based on Historical Allocations</td>
<td>6-4</td>
</tr>
<tr>
<td>Allocate Planned Orders With Capacity Constraints</td>
<td>6-4</td>
</tr>
<tr>
<td>Supplier-Specific Order Modifiers</td>
<td>6-5</td>
</tr>
<tr>
<td>Supplier-Specific Lead Times</td>
<td>6-5</td>
</tr>
<tr>
<td>Delivery/Reception Frequency Calendars</td>
<td>6-5</td>
</tr>
<tr>
<td>Flexible Tolerance Fences</td>
<td>6-5</td>
</tr>
<tr>
<td>Setting Up Supplier Capacity</td>
<td>6-5</td>
</tr>
<tr>
<td>Setting Supplier Capacity by Time Periods</td>
<td>6-6</td>
</tr>
<tr>
<td>Setting Supplier Specific Planning Constraints</td>
<td>6-9</td>
</tr>
<tr>
<td>Using Delivery and Reception Frequency Calendars</td>
<td>6-9</td>
</tr>
<tr>
<td>Using Supplier Specific Order Modifiers</td>
<td>6-10</td>
</tr>
<tr>
<td>Setting up Alternate and Simultaneous Resources</td>
<td>6-10</td>
</tr>
<tr>
<td>Advantages</td>
<td>6-10</td>
</tr>
<tr>
<td>Required Setup</td>
<td>6-11</td>
</tr>
<tr>
<td>Allocating Demand to Suppliers</td>
<td>6-18</td>
</tr>
<tr>
<td>Setting Rank and Allocation</td>
<td>6-18</td>
</tr>
<tr>
<td>Splitting Demand According To Sourcing Percentages</td>
<td>6-18</td>
</tr>
<tr>
<td>Allocating Demand to Suppliers Based on Historical Demand</td>
<td>6-19</td>
</tr>
<tr>
<td>Sourcing Example</td>
<td>6-20</td>
</tr>
<tr>
<td>Viewing the Supply Chain</td>
<td>6-29</td>
</tr>
<tr>
<td>Viewing Sourcing Rules</td>
<td>6-29</td>
</tr>
<tr>
<td>Viewing BODs</td>
<td>6-30</td>
</tr>
<tr>
<td>Viewing Assignment Set</td>
<td>6-30</td>
</tr>
<tr>
<td>Viewing Sourcing Assignment Hierarchy</td>
<td>6-30</td>
</tr>
<tr>
<td>Performing Tasks on the Planning Server</td>
<td>6-30</td>
</tr>
</tbody>
</table>
7 Simulations

Overview of Simulations ........................................................................................................... 7-2
Simulation Scenarios ................................................................................................................ 7-2
Supplier Capacity .................................................................................................................... 7-2
Resource Availability ............................................................................................................ 7-2
Supplies .................................................................................................................................. 7-2
Demands ............................................................................................................................... 7-2
Optimization Objectives ...................................................................................................... 7-3
Simulation Modes .................................................................................................................. 7-3
Net Change Replan ................................................................................................................ 7-3
Batch Mode Planner .............................................................................................................. 7-3
Online Planner ....................................................................................................................... 7-4
Running Net Change Replan Simulations ............................................................................ 7-5
Running Batch Replan .......................................................................................................... 7-5
Running Online Replan ........................................................................................................ 7-5
Using Undo to Reverse Actions or Changes ....................................................................... 7-9
Comparing Scenarios Quantitatively ................................................................................... 7-12

8 Optimization

Overview of Optimization ....................................................................................................... 8-2
Optimization Objectives ....................................................................................................... 8-2
Maximize Inventory Turns .................................................................................................... 8-3
Maximize Plan Profit ............................................................................................................ 8-3
Maximize On Time Delivery .................................................................................................. 8-3
Setting Penalty Factors ....................................................................................................... 8-4
Setting Late Demand Penalty Costs ................................................................................... 8-4
Hierarchy for Setting Penalty Factor for Late Demand ....................................................... 8-5
Setting Penalty Factors for Exceeding Material Capacity .................................................. 8-12
Hierarchy for Setting Penalty Factor for Exceeding Material Capacity ................................ 8-13
Setting Penalty Factors for Exceeding Resource Capacity ................................................ 8-20
Hierarchy for Setting Penalty Factor for Exceeding Resource Capacity ............................. 8-21
Setting Penalty Factors Using Plan Options ....................................................................... 8-26
Penalty Cost for Late Demand ............................................................................................. 8-26
Penalty Cost for Exceeding Material Capacity ................................................................... 8-26
Penalty Cost for Exceeding Transportation Capacity ......................................................... 8-27
Penalty Cost for Exceeding Resource Capacity .............................................................. 8-27
Setting Penalty Factors Using Optimization Profile Options............................................ 8-27
Penalty Factor for Late Demand ..................................................................................... 8-27
Penalty Factor for Exceeding Material Capacity ............................................................ 8-27
Penalty Factor for Exceeding Resource Capacity ........................................................... 8-27
Inventory Carrying Costs Percentage ............................................................................ 8-27
Maximum Allowable Days Late ..................................................................................... 8-28

Comparing Different Optimization Runs ........................................................................ 8-28

9 Performance Management

Overview of Performance Management ........................................................................... 9-2
Key Performance Indicators (KPIs) .................................................................................. 9-2
Inventory Turns .................................................................................................................. 9-4
Margin Percentage .......................................................................................................... 9-5
Planned Utilization ........................................................................................................... 9-5
Ontime Delivery ............................................................................................................... 9-6
Margin ............................................................................................................................... 9-6
Cost Breakdown .............................................................................................................. 9-6
Service Level .................................................................................................................... 9-7
Inventory Value ............................................................................................................... 9-7

KPI Setup .......................................................................................................................... 9-8

Tracking Plan Performance Using KPIs .......................................................................... 9-10
Increasing Inventory Turns ............................................................................................ 9-10
Increasing Planned Utilization ....................................................................................... 9-10
Increasing Margin Percentage ...................................................................................... 9-10
Increasing Ontime Delivery ........................................................................................... 9-11

Exception Messages ........................................................................................................ 9-12
Exception Summary Window .......................................................................................... 9-12
Exception Groups for Different Plans ........................................................................... 9-13
Planning Exception Sets ................................................................................................ 9-18
Prioritization and Navigation ............................................................................................ 9-19

Making Decisions Based on Exceptions ........................................................................ 9-20
Source versus Destination Instance ............................................................................... 9-21
Constraint/Bottleneck Management ............................................................................... 9-21
Late Sales Orders and Forecasts ..................................................................................... 9-22
Order at risk due to material shortage ................................................................. 9-22
Order at risk due to resource shortage ............................................................... 9-24
Late supply pegged to sales order ................................................................. 9-26
Late supply pegged to forecast ................................................................. 9-27
Past due sales orders ............................................................................. 9-27
Past due forecast ............................................................................... 9-29
Late replenishment for sales order ............................................................... 9-29
Late replenishment for forecast ...................................................................... 9-31
Early replenishment for sales order ............................................................... 9-32
Early replenishment for forecast ...................................................................... 9-33
Material and Resource Capacity .................................................................................................................. 9-34
  Material constraint ............................................................................... 9-34
  Resource constraint ........................................................................... 9-36
  Resource overloaded .......................................................................... 9-38
  Supplier capacity overloaded .............................................................. 9-39
  Resource underloaded .......................................................................... 9-40
Transportation and Distribution .................................................................................................................. 9-41
  Transportation resource constraint .......................................................... 9-41
  Transportation resource overloaded .......................................................... 9-42
  Transportation resource underloaded .......................................................... 9-42
Shortages and Excess .......................................................................................... 9-43
  Items with a shortage ........................................................................ 9-43
  Items below safety stock .................................................................... 9-44
  Items with excess inventory ................................................................. 9-44
Reschedules .......................................................................................................... 9-45
  Past due orders .................................................................................. 9-45
  Orders to be rescheduled out ................................................................. 9-46
  Orders to be cancelled ....................................................................... 9-46
  Orders to be rescheduled in ................................................................. 9-47
  Orders with compression days ................................................................. 9-48
Substitutes and Alternates Used .................................................................................................................. 9-49
  Planned order uses alternate BOM ........................................................... 9-49
  Planned order uses alternate routing ........................................................... 9-49
  Planned order uses substitute components .............................................. 9-50
  Planned order uses alternate resources .................................................. 9-51
Order sourced from alternate facility ................................................................. 9-51
Order sourced from alternate supplier ................................................................. 9-52
Projects/Tasks ........................................................................................................ 9-53
  Items with a shortage in a project/task .............................................................. 9-53
  Items allocated across projects/tasks ............................................................... 9-54
  Items with excess inventory in a project/task .................................................. 9-54
Item Exceptions ...................................................................................................... 9-55
  Items that are over-committed .......................................................................... 9-55
  Items with negative starting on hand ............................................................... 9-56
  Items with expired lot ......................................................................................... 9-57
  Items with repetitive variance .......................................................................... 9-57
  Items with no activity ......................................................................................... 9-58
Recommendations .................................................................................................. 9-58
  Discrete Jobs and Purchase Requisitions ......................................................... 9-58

10 Planner Workbench/User Interface

Overview of Planner Workbench/User Interface .................................................. 10-2
General Navigation ............................................................................................... 10-2
  Drill Down .......................................................................................................... 10-3
  Navigating Through a Find Window .................................................................. 10-3
  Pull-Down Menus ............................................................................................... 10-5
  Right-Click Menu Options ................................................................................ 10-6
  Properties Window ............................................................................................. 10-7
Tailoring the User Interface .................................................................................. 10-9
  Resize Windows ................................................................................................ 10-10
  Customize Columns .......................................................................................... 10-11
  Defining Display Preferences ............................................................................ 10-11
Using the Left Pane and the Navigation Tree ....................................................... 10-13
  Planner Workbench left pane tree layout for Actions ..................................... 10-13
  Planner Workbench left pane tree layout for the Items tree ............................. 10-15
  Planner Workbench left pane tree layout for Organizations ......................... 10-15
  Planner Workbench left pane tree layout for Projects .................................... 10-16
Using the Right Pane and the Navigation Tree .................................................... 10-17
  The Key Performance Indicators (KPIs) Tab ................................................... 10-17
  Inventory Turns ................................................................................................. 10-20
Ontime Delivery ................................................................................................................ 10-21
Planned Utilization .......................................................................................................... 10-21
Margin Percentage .......................................................................................................... 10-21
Reviewing Item Planning Information .......................................................................... 10-22
Comparing KPIs for Multiple Plans ............................................................................. 10-22
The Horizontal Plan and Vertical Plan Tabs ................................................................ 10-23
Dynamically Define Graphs .......................................................................................... 10-26
Dynamically Choose Types of Graphs .......................................................................... 10-27
View Available Capacity ............................................................................................... 10-27
Horizontal Capacity Plan ............................................................................................. 10-27
Identifying Capacity Problems .................................................................................... 10-30
Actions/Exceptions Tab ................................................................................................ 10-30
Folder Management ....................................................................................................... 10-33
Drill Down to Related Exceptions .............................................................................. 10-35
Relevant Information Buttons ....................................................................................... 10-37
Right Mouse Options .................................................................................................... 10-37
Viewing Pegging Supply and Demand Information ..................................................... 10-39
Viewing the Supply Chain ............................................................................................. 10-40
Implementing Planning Recommendations .................................................................. 10-43
Creating and Implementing Firm Planned Orders ....................................................... 10-43
Accessing and Executing Planned Orders Directly ....................................................... 10-43
Releasing Recommendations ....................................................................................... 10-43
Releasing All Recommendations .................................................................................. 10-45
Reviewing a BOM or Supply Chain Bill ....................................................................... 10-45
Interactive Scheduling Using the Gantt Chart ............................................................. 10-47
The Order-Centric View ............................................................................................... 10-48
The Resource-Centric View .......................................................................................... 10-50
Color Codes .................................................................................................................. 10-50
Find Window ................................................................................................................ 10-50
Right-Click Menu Options ............................................................................................ 10-51
Viewing Information on an Operation ......................................................................... 10-52
Specify Resources to Plot in the Lower Pane ............................................................. 10-55
Specifying Time Buckets ............................................................................................. 10-55
Rescheduling Operations .............................................................................................. 10-57
Firming an Operation ................................................................................................... 10-59
11 Constraint-Based Planning

Overview of Constraint-Based Planning ................................................................. 11-2
Constraint Types ........................................................................................................... 11-2
  Items .............................................................................................................................. 11-3
    Bills of Material ........................................................................................................ 11-3
    Engineering Changes (ECOs) ................................................................................ 11-3
    Substitute Components .......................................................................................... 11-4
    By-products .............................................................................................................. 11-5
    Product Families .................................................................................................... 11-5
    Safety Stock ........................................................................................................... 11-5
      MRP Planned Percent ...................................................................................... 11-6
      Inventory Methods .............................................................................................. 11-6
    Order Modifiers ....................................................................................................... 11-7
      Fixed Order Quantity ......................................................................................... 11-7
      Fixed Lot Multiple ............................................................................................... 11-7
      Minimum and Maximum Order Quantity ......................................................... 11-7
      Fixed Days Supply ............................................................................................... 11-8
      Rounding Order Quantities ................................................................................ 11-8
    Manufacturing Resources ...................................................................................... 11-8
      Routings ................................................................................................................ 11-8
      Resources ............................................................................................................. 11-8
      Workday Calendar ............................................................................................... 11-8
    Transportation Resources ...................................................................................... 11-9
    Sourcing Constraints/Suppliers .............................................................................. 11-9
      Tolerance Fences ................................................................................................. 11-10
    Demands .................................................................................................................. 11-10
  Enabling and Disabling Constraints ......................................................................... 11-11
    Setting Hard and Soft Constraints ...................................................................... 11-12
  Setting Constraints for Different Plan Types ...................................................... 11-14
  Rules Used in Constrained Plans Without Optimization .................................. 11-16
    Look-Ahead Heuristic ........................................................................................... 11-16
12 Planning in Mixed Mode Environments

Overview of Mixed Mode Manufacturing ................................................................. 12-2
Common Features in Hybrid Manufacturing Environments ..................................... 12-2
  Aggregate Resource for a Resource ........................................................................ 12-7
  Simultaneous Resource Sequence .......................................................................... 12-7
  Alternate Resource for an operation ...................................................................... 12-7
  Priority of Alternate Resources for an operation ................................................ 12-7
  Priority for Substitute Items .................................................................................. 12-7
  Cost of using Alternate BOM / Routing ............................................................... 12-7
Example .................................................................................................................. 12-7

Oracle Project Manufacturing .................................................................................... 12-11
  Hard and Soft Pegging .......................................................................................... 12-12
    Soft Pegging ....................................................................................................... 12-12
    Hard Pegging ..................................................................................................... 12-12
    Common Supply Netting ................................................................................. 12-13
  Supply Chain Project Planning with Hard Pegging ............................................... 12-13
    Planner Workbench ......................................................................................... 12-14
    Pegging ............................................................................................................. 12-15
  Model/Unit Effectivity (Serial Effectivity) ............................................................. 12-16
    Items .................................................................................................................. 12-16
    Define MDS/MPS Entries by Unit Numbers ...................................................... 12-16
    Unit Numbers in Sales Orders ......................................................................... 12-16
    Effectivity in the BOM ..................................................................................... 12-16
    Generating Planned Orders ............................................................................... 12-16
    Planner Workbench ......................................................................................... 12-16
    Pegging ............................................................................................................. 12-18
    WIP Mass Load/ PO Requisitions Interface ..................................................... 12-18
    Flow Line Scheduling ....................................................................................... 12-18
  Workflow Based Project Exception Messages ..................................................... 12-18
  Project Planning Implementation Steps ............................................................... 12-19
    Oracle Project Manufacturing Setup ................................................................ 12-19
    Oracle Inventory Setup .................................................................................... 12-19
    Oracle ASCP Setup ......................................................................................... 12-20
  Project Planning Logic ......................................................................................... 12-21
  Viewing the Plan .................................................................................................. 12-22
Oracle Flow Manufacturing ................................................................. 12-22
Oracle Process Manufacturing ........................................................... 12-26
OPM Data for Oracle ASCP ............................................................... 12-26
Merged Organization Structure ......................................................... 12-26
Differences Between Production in OPM and Oracle Applications ...... 12-27
Recommended OPM Organization Structure for Oracle ASCP .......... 12-28
Merging Effectivities, Formulas, and Routings .................................... 12-29
Creating a Resource Warehouse ....................................................... 12-29
Unit of Measure .............................................................................. 12-30
Setting Up and Using OPM Data ....................................................... 12-30
OPM Organizations ......................................................................... 12-30
Effectivity, Formulas and Routings ................................................... 12-31
Effectivity ...................................................................................... 12-31
Formula ......................................................................................... 12-31
Routings ......................................................................................... 12-31
Resources ....................................................................................... 12-32
Plant/Warehouse Relationships ....................................................... 12-33
MPS Schedule ................................................................................ 12-33
Integrating MPS Schedule Parameters With Oracle ASCP ............... 12-33
Integrating Forecasts With Oracle ASCP ......................................... 12-34
Integrating Production Orders With Oracle ASCP ............................. 12-34
Integrating Onhand Inventory With Oracle ASCP ............................. 12-35
Oracle Shop Floor Management ...................................................... 12-36
Lot-Based Jobs ................................................................................ 12-36
Coproducts .................................................................................... 12-37
Planned Order Released Qty. for Coproducts: ................................. 12-39
Operation Yield ............................................................................ 12-40
Network Routings .......................................................................... 12-42
Primary Path ................................................................................ 12-43
Planned Percent ........................................................................... 12-43
Optimize ....................................................................................... 12-43

13 Collaborative Planning

Overview of Collaborative Planning ............................................... 13-2
Providing Viewing and Updating Access ....................................... 13-2
Viewing Customer-Specific Forecasts................................................................. 13-2
Forecast Consumption Status............................................................................. 13-2
Consolidating Customer Forecasts................................................................. 13-3
  Oracle Demand Planning................................................................................. 13-3
  Incorporating Customer Forecasts Into the Demand Plan ......................... 13-3

Collaborating with Suppliers........................................................................... 13-4
  Providing View Access to Performance Metrics............................................ 13-4
  Viewing Partner Performance........................................................................ 13-4

Using Workflow in Oracle ASCP .................................................................... 13-5
  Defining and Modifying Business Rules...................................................... 13-5
  Delivering Electronic Notifications............................................................. 13-5

14 Configure to Order
  CTO Enhancements...................................................................................... 14-2
  Multilevel ATO with Example ...................................................................... 14-2
    Forecast Explosion..................................................................................... 14-4
    Planning Process......................................................................................... 14-4
    Order Promising....................................................................................... 14-7
  Set Up Required to Use Multilevel ATO ..................................................... 14-10

15 Cross-Instance Planning
  Overview of Cross-Instance Planning.......................................................... 15-2
  Instances..................................................................................................... 15-2
  Collections.................................................................................................. 15-3
  Sourcing Rules............................................................................................ 15-4
  Planning....................................................................................................... 15-6
  Global Order Promising.............................................................................. 15-8
  Execution..................................................................................................... 15-8
  Known Limitations...................................................................................... 15-8

16 Oracle Global Order Promising
  Overview of Oracle Global Order Promising.............................................. 16-2
    Accurate Global Statement of Availability............................................... 16-2
    ATP for Multiple Supply Locations.......................................................... 16-2
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Multilevel Supply Chain ATP</td>
<td>16-2</td>
</tr>
<tr>
<td>Detailed Availability Information with Graphical Pegging Tree</td>
<td>16-2</td>
</tr>
<tr>
<td>Allocation</td>
<td>16-3</td>
</tr>
<tr>
<td>Configuration ATP</td>
<td>16-3</td>
</tr>
<tr>
<td>Flexible Configuration</td>
<td>16-3</td>
</tr>
<tr>
<td>Centralized Order Promising</td>
<td>16-4</td>
</tr>
<tr>
<td>Decentralized Order Promising</td>
<td>16-5</td>
</tr>
<tr>
<td><strong>ATP Methods</strong></td>
<td>16-6</td>
</tr>
<tr>
<td><strong>Data Collection</strong></td>
<td>16-8</td>
</tr>
<tr>
<td><strong>Basic ATP</strong></td>
<td>16-9</td>
</tr>
<tr>
<td>Item Attributes</td>
<td>16-9</td>
</tr>
<tr>
<td>ATP Rule</td>
<td>16-9</td>
</tr>
<tr>
<td>Profile - INV: Capable to Promise</td>
<td>16-10</td>
</tr>
<tr>
<td>Profile - MRP: ATP Database Link</td>
<td>16-10</td>
</tr>
<tr>
<td>Basic ATP From i-Store</td>
<td>16-10</td>
</tr>
<tr>
<td>Basic ATP From Order Management</td>
<td>16-10</td>
</tr>
<tr>
<td>Basic ATP From Advanced Supply Chain Planning</td>
<td>16-11</td>
</tr>
<tr>
<td>ATP Logic in a Single Organization</td>
<td>16-11</td>
</tr>
<tr>
<td><strong>Single-Level Supply Chain ATP</strong></td>
<td>16-12</td>
</tr>
<tr>
<td>Single-Level Supply Chain ATP Business Application</td>
<td>16-12</td>
</tr>
<tr>
<td>Single-Level Supply Chain ATP Setup Steps</td>
<td>16-12</td>
</tr>
<tr>
<td>Item Attributes</td>
<td>16-12</td>
</tr>
<tr>
<td>ATP Rule</td>
<td>16-13</td>
</tr>
<tr>
<td>Sourcing Rule</td>
<td>16-13</td>
</tr>
<tr>
<td>Assignment Set</td>
<td>16-14</td>
</tr>
<tr>
<td>Inter-Location Transit Times</td>
<td>16-14</td>
</tr>
<tr>
<td>Profile - MRP: ATP Assignment Set</td>
<td>16-15</td>
</tr>
<tr>
<td>Profile - INV: Capable to Promise</td>
<td>16-15</td>
</tr>
<tr>
<td>Profile - MRP: ATP Database Link</td>
<td>16-15</td>
</tr>
<tr>
<td>Single-Level Supply Chain ATP With or Without APS</td>
<td>16-15</td>
</tr>
<tr>
<td>Single-Level Supply Chain ATP Data Collection</td>
<td>16-16</td>
</tr>
<tr>
<td>ATP Inquiry</td>
<td>16-16</td>
</tr>
<tr>
<td>Single-Level Supply Chain ATP From i-Store</td>
<td>16-16</td>
</tr>
<tr>
<td>Single-Level Supply Chain ATP From Order Management</td>
<td>16-16</td>
</tr>
<tr>
<td>Supply Chain ATP From Advanced Supply Chain Planning</td>
<td>16-17</td>
</tr>
</tbody>
</table>
ATP Logic for Single-Level Supply Chain ATP ................................................................. 16-17
Single-Level Supply Chain ATP Example ................................................................. 16-17
  Item Attribute ............................................................................................................. 16-18
  ATP Rule .................................................................................................................... 16-18
  Sourcing Rule ............................................................................................................. 16-18
  Assignment Set ......................................................................................................... 16-18
  Inter-Location Transit Times ..................................................................................... 16-19
  Profile MRP: ATP Assignment Set ........................................................................ 16-19
  Profile: INV: Capable to Promise ........................................................................... 16-19
  Profile MSC: ATP Assignment Set ........................................................................ 16-19
  Instance Setup ......................................................................................................... 16-19
  Single-Level Supply Chain ATP Inquiry .................................................................. 16-19
  ATO and PTO Models ............................................................................................ 16-20

Multilevel Supply Chain ATP .................................................................................. 16-21
  Multilevel Supply Chain ATP Business Application ............................................. 16-22
  Multilevel Supply Chain ATP Setup Steps ............................................................. 16-22
    Item Attributes ....................................................................................................... 16-22
    ATP Rule ................................................................................................................ 16-23
    Plan Options .......................................................................................................... 16-23
    Supply Chain ......................................................................................................... 16-23
    Manufacturing Capacity ......................................................................................... 16-24
    Supplier Capacity .................................................................................................... 16-24
    Interlocation Transit Times ..................................................................................... 16-24
    Profile - MRP: ATP Assignment Set ................................................................. 16-25
    Profile - INV: Capable to Promise ....................................................................... 16-25
    Profile - MSC: ATP Assignment Set .................................................................... 16-25
    Profile - MRP: ATP Database Link ....................................................................... 16-25
    Instance Setup ....................................................................................................... 16-25
  Data Collection and Running a Plan ...................................................................... 16-26
  ATP Inquiry ............................................................................................................. 16-26
    Multilevel ATP From i-Store ............................................................................... 16-26
    Multilevel ATP From Order Management ......................................................... 16-26
    Multilevel ATP From Advanced Supply Chain Planning ................................... 16-27
  ATP Logic for Multilevel Supply Chain ATP ......................................................... 16-27
    Multilevel ATP Logic in a Single Organization .................................................. 16-27
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Multilevel ATP Logic Involving Supply Chain</td>
<td>16-28</td>
</tr>
<tr>
<td>Multilevel Supply Chain ATP Example</td>
<td>16-28</td>
</tr>
<tr>
<td>Example 1: Multilevel ATP in a Single Organization</td>
<td>16-28</td>
</tr>
<tr>
<td>Product Dependency</td>
<td>16-37</td>
</tr>
<tr>
<td>Multilevel ATO Model</td>
<td>16-37</td>
</tr>
<tr>
<td><strong>Allocated ATP</strong></td>
<td>16-38</td>
</tr>
<tr>
<td>Allocated ATP Business Applications</td>
<td>16-38</td>
</tr>
<tr>
<td>Allocated ATP Setup Steps</td>
<td>16-39</td>
</tr>
<tr>
<td>Item Attributes</td>
<td>16-39</td>
</tr>
<tr>
<td>ATP Rule</td>
<td>16-39</td>
</tr>
<tr>
<td>ATP Plan</td>
<td>16-40</td>
</tr>
<tr>
<td>Define Demand Classes</td>
<td>16-40</td>
</tr>
<tr>
<td>Define Customer Class Hierarchy</td>
<td>16-40</td>
</tr>
<tr>
<td>Define Allocation Rules</td>
<td>16-40</td>
</tr>
<tr>
<td>Assign Allocation Rules</td>
<td>16-42</td>
</tr>
<tr>
<td>Profile - INV: Capable to Promise</td>
<td>16-43</td>
</tr>
<tr>
<td>Profile - MSC: Class Hierarchy</td>
<td>16-43</td>
</tr>
<tr>
<td>Profile - MSC: Enable Allocated ATP</td>
<td>16-44</td>
</tr>
<tr>
<td>Profile - MSC: Enable Allocated Workflow</td>
<td>16-44</td>
</tr>
<tr>
<td>Profile - MRP: ATP Database Link</td>
<td>16-44</td>
</tr>
<tr>
<td>Allocated ATP Data Collection</td>
<td>16-44</td>
</tr>
<tr>
<td>ATP Inquiry and Viewing Allocations</td>
<td>16-44</td>
</tr>
<tr>
<td>Allocated ATP From i-Store</td>
<td>16-45</td>
</tr>
<tr>
<td>Allocated ATP From Order Management</td>
<td>16-45</td>
</tr>
<tr>
<td>Allocated ATP From Advanced Supply Chain Planning</td>
<td>16-45</td>
</tr>
<tr>
<td>View Allocations Workbench</td>
<td>16-46</td>
</tr>
<tr>
<td>Refreshing Allocations</td>
<td>16-47</td>
</tr>
<tr>
<td>Allocated ATP Example</td>
<td>16-48</td>
</tr>
<tr>
<td>Allocated ATP based on Percentages</td>
<td>16-48</td>
</tr>
<tr>
<td>Allocated ATP based on Percentages and Priorities</td>
<td>16-49</td>
</tr>
<tr>
<td>Allocated ATP Using Customer-Class Hierarchy</td>
<td>16-51</td>
</tr>
<tr>
<td>Product Dependency</td>
<td>16-54</td>
</tr>
<tr>
<td>Resource Allocation</td>
<td>16-55</td>
</tr>
<tr>
<td><strong>Demand Class ATP</strong></td>
<td>16-56</td>
</tr>
<tr>
<td>Demand Class ATP Business Application</td>
<td>16-56</td>
</tr>
</tbody>
</table>
Demand Class ATP Setup Steps ................................................................. 16-56
  Item Attributes .................................................................................... 16-56
  ATP Rule ............................................................................................ 16-56
  Demand Class MPS ........................................................................... 16-57
  Profiles .............................................................................................. 16-57
Demand Class ATP versus Allocated ATP ............................................... 16-57
Demand Class ATP Data Collection ....................................................... 16-58
ATP Inquiry ........................................................................................ 16-58
  Demand Class ATP From Order Management .................................... 16-58
  Demand ATP From Advanced Supply Chain Planning ...................... 16-58
ATP Logic for Demand Class ATP ....................................................... 16-59

Other ATP Functions ............................................................................ 16-60
  Past-due demand days ..................................................................... 16-60
  Past-due supply days ...................................................................... 16-60
  Infinite Supply Time Fence .............................................................. 16-60
  Forward Consumption of Shortage .................................................. 16-61
  Backward Consumption of Shortage ................................................ 16-61
  Accumulate Available ..................................................................... 16-61
  ODS: Supply ................................................................................... 16-61
  ODS: Demand ................................................................................ 16-62
  PDS: Supply & Demand .................................................................. 16-62
  MRP: Include Substitute Components ............................................ 16-64
ATP Inquiry ........................................................................................ 16-65
Using Global ATP Server from Non-Oracle Applications ...................... 16-70
  API .................................................................................................. 16-70
  ATP Inquiry ................................................................................... 16-70
  ATP Scheduling ............................................................................ 16-70
  Collecting Data ............................................................................. 16-70

17 Risk Optimization

Overview of Oracle Risk Optimization .................................................... 17-2
  Service Level Decision Factors ....................................................... 17-3
  Safety Stock Decision Factors ........................................................ 17-4
  Inventory Location Decision Factors .............................................. 17-4
  Input .............................................................................................. 17-4
Output ........................................................................................................................................ 17-5

BIS Key Performance Indicators........................................................................................ 17-5

Defining a Plan.................................................................................................................... 17-6

Global Inventory Planning and Subset Planning ............................................................ 17-6
Choosing Between Global Inventory and Subset Plans .................................................. 17-6
Running an Inventory Plan ............................................................................................... 17-7
Setting Global Supply Chain vs. Subset Planning Parameters ........................................ 17-9

Setting Plan Options ......................................................................................................... 17-11

The Options Tab .................................................................................................................. 17-11
The Aggregation Tab .......................................................................................................... 17-12
The Optimization Tab ......................................................................................................... 17-14
The Organizations Tab ....................................................................................................... 17-15

Using an Existing Plan as a Supply Schedule for a New Plan ........................................ 17-17
Using an Existing Plan as a Demand Schedule For a New Plan ...................................... 17-17

Setting Demand Variability ............................................................................................... 17-17

How Probability Data is Used by the System ............................................................... 17-19
Weighted Average Calculation ....................................................................................... 17-19
How to Assign Forecasts and Forecast Sets to Scenario Sets .................................... 17-20

Set Supplier Lead Time Variability .................................................................................. 17-22
Selecting Planned Items .................................................................................................... 17-24
Setting Constraints ............................................................................................................ 17-25

Specifying Sources of Supply and Demand .................................................................... 17-27

Specify Supply Types ........................................................................................................ 17-27
Demand Schedules ............................................................................................................ 17-27
Supply Schedules ............................................................................................................. 17-27

Controlling Aggregation .................................................................................................... 17-29

Plan End Date ..................................................................................................................... 17-29

Forecast bucket and plan bucket granularity .............................................................. 17-29

Specifying Material Aggregation Levels ......................................................................... 17-30
Specifying Resource Aggregation Levels ....................................................................... 17-31
Specifying Routing Aggregation Levels ......................................................................... 17-32

Specifying Plan Objectives ............................................................................................... 17-33

Maximize Inventory Turns ............................................................................................. 17-33
Maximize Plan Profit ......................................................................................................... 17-33
Maximize Onetime Delivery ......................................................................................... 17-34
18 Implementing and Using Oracle Demand Planning

Demand Planning Architecture ................................................................. 18-2

The Demand Planning Forecasting Cycle ............................................... 18-4
  Step 1. Collect Data .................................................................................. 18-4
  Step 2. Define Demand Plan ................................................................. 18-5
  Step 3. Build Demand Plan ................................................................. 18-5
  Step 4. Assign Demand Planners and Generate Baseline Forecasts .... 18-5
  Step 5. Analyze and Modify Forecast .................................................. 18-5
  Step 6. Publish Forecast ................................................................... 18-6
  Step 7. Renew Forecast Cycle ............................................................. 18-6

Demand Planning Roles ........................................................................ 18-7
  Demand Planning Integration Administrator ..................................... 18-7
  Demand Planning Administrator ....................................................... 18-7
  Demand Planning Manager ............................................................... 18-8
  Demand Planner .............................................................................. 18-9
Demand Planning Setup ............................................................................................................ 18-10
1. Set Up Instances ............................................................................................................. 18-10
2. Set Up Data Collections ................................................................................................. 18-11
3. Set Up Demand Planning Dimensions ......................................................................... 18-13
4. Set Up Demand Planning Hierarchies ......................................................................... 18-15
5. Set Up Demand Planning Levels .................................................................................. 18-18
6. Set Up Demand Planning Hierarchy Levels .................................................................. 18-19
7. Set Up Profile Options ................................................................................................. 18-21

Data Collection .................................................................................................................... 18-24
Use of Collected Data ........................................................................................................ 18-27
Pull Data into Fact Tables .................................................................................................. 18-28
Use of BOM Data ................................................................................................................ 18-29

Defining a Demand Plan .................................................................................................... 18-30
Input Parameters ................................................................................................................ 18-34
Scenarios ............................................................................................................................. 18-37
Express Setup ...................................................................................................................... 18-40

Building a Demand Plan .................................................................................................. 18-42
Download Data from DPS to DPE ..................................................................................... 18-42
Choose Statistical Forecasting Method ............................................................................. 18-43
Choose Forecast Levels ..................................................................................................... 18-45
Choose Allocation Rule ...................................................................................................... 18-47
Select Predefined Reports: ................................................................................................. 18-49
Set Comment Reason Codes ............................................................................................. 18-50

Demand Planner Assignment ............................................................................................. 18-52

Generating Baseline Forecasts .......................................................................................... 18-54

Analyzing and Modifying Forecasts .................................................................................. 18-55

Demand Planner Responsibilities ....................................................................................... 18-56

Publishing the Consensus Forecast ................................................................................... 18-60
Collect Forecast Data from Individual Demand Planners ................................................. 18-60
Review Collected Forecast Data ....................................................................................... 18-62
Upload Approved Forecast Data to the Planning Server .................................................. 18-62
Publish Forecast Data Back to the Source ....................................................................... 18-62

Renewing the Forecasting Cycle ....................................................................................... 18-66
Collecting Data for the Next Forecast Cycle .................................................................... 18-66
Modifying a Demand Plan for the Next Forecast Cycle ................................................... 18-68
<table>
<thead>
<tr>
<th>Events</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Feature Description</td>
<td>18-70</td>
</tr>
<tr>
<td>Types of Events Supported:</td>
<td>18-70</td>
</tr>
<tr>
<td>Event-Modeling Capability</td>
<td>18-70</td>
</tr>
<tr>
<td>Simulation Capability</td>
<td>18-71</td>
</tr>
<tr>
<td>Conflict Resolution</td>
<td>18-71</td>
</tr>
<tr>
<td>Separate Statistical and Event Forecast</td>
<td>18-71</td>
</tr>
<tr>
<td>Business Application</td>
<td>18-71</td>
</tr>
<tr>
<td>Scenario:</td>
<td>18-72</td>
</tr>
<tr>
<td>Promotions</td>
<td>18-84</td>
</tr>
<tr>
<td>Mandatory and Optional Promotions</td>
<td>18-84</td>
</tr>
<tr>
<td>Types of Modification</td>
<td>18-84</td>
</tr>
<tr>
<td>Promotion Details</td>
<td>18-84</td>
</tr>
<tr>
<td>New Product Introductions and Cannibalization</td>
<td>18-85</td>
</tr>
<tr>
<td>Life cycle and supersession based new product introductions</td>
<td>18-85</td>
</tr>
<tr>
<td>Types of Modification</td>
<td>18-85</td>
</tr>
<tr>
<td>Details of New Product Introductions</td>
<td>18-85</td>
</tr>
<tr>
<td>Details of Base Products</td>
<td>18-86</td>
</tr>
<tr>
<td>Details of Cannibalized Products</td>
<td>18-86</td>
</tr>
<tr>
<td>Product Phase Outs</td>
<td>18-87</td>
</tr>
<tr>
<td>Linear and Nonlinear Phase Outs</td>
<td>18-87</td>
</tr>
<tr>
<td>Types of Modification</td>
<td>18-87</td>
</tr>
<tr>
<td>Product Phase-Out Details</td>
<td>18-87</td>
</tr>
<tr>
<td>Setups and Related Details</td>
<td>18-88</td>
</tr>
<tr>
<td>Forecasting for Dependent Demands</td>
<td>18-89</td>
</tr>
<tr>
<td>Forecasting Dependent and Independent Demand</td>
<td>18-89</td>
</tr>
<tr>
<td>Forecast Explosion</td>
<td>18-89</td>
</tr>
<tr>
<td>Business Application</td>
<td>18-90</td>
</tr>
<tr>
<td>Setups and Related Details</td>
<td>18-92</td>
</tr>
<tr>
<td>Forecast Control</td>
<td>18-92</td>
</tr>
<tr>
<td>Bill of Material Item Type</td>
<td>18-93</td>
</tr>
<tr>
<td>Bill of Material</td>
<td>18-94</td>
</tr>
<tr>
<td>Organizations</td>
<td>18-94</td>
</tr>
<tr>
<td>Data Collection</td>
<td>18-95</td>
</tr>
<tr>
<td>Example</td>
<td>18-96</td>
</tr>
</tbody>
</table>
Assumptions for the Sample Model Bill: ................................................................. 18-97
Product Dependency ............................................................................................. 18-101
Dependent revenue ............................................................................................... 18-101
API changes .......................................................................................................... 18-101

Customizing Demand Planning Hierarchies ......................................................... 18-102
Hierarchies Manipulation ...................................................................................... 18-102
User-Defined Levels, Hierarchies, and Dimensions ............................................. 18-102
Custom Association of Level Values ..................................................................... 18-103
Business Application ............................................................................................. 18-103
MSD_SR_SHIPTO_COUNT_V .................................................................................. 18-106
Manipulating the Level Values and Associations .................................................. 18-111

A  Profile Options

Profile Options ....................................................................................................... A-1
Oracle ASCP Scheduling Profile Options ............................................................... A-1
  MSO: Default Forecast Priority ............................................................................ A-1
  MSO: Default Sales Order Priority ...................................................................... A-1
  MSO: Floating Point Precision ............................................................................ A-1
  MSO: Heuristic type ............................................................................................ A-2
  MSO: Maximum Number of Prepones ................................................................. A-2
  MSO: Maximum Demands per Group ................................................................... A-2
  MSO: Maximum Demands per Slice .................................................................... A-2
  MSO: Maximum Lead Time Factor ....................................................................... A-2
  MSO: Maximum Number of Pull for Operation .................................................. A-3
  MSO: Maximum Resource Over-capacity ........................................................... A-3
  MSO: Network routing cycle time coefficient ...................................................... A-3
  MSO: Network routing fixed time window .......................................................... A-3
  MSO: NFL BACKWARD COMPRESSION PCT .................................................. A-3
  MSO: NFL FORWARD COMPRESSION PCT ..................................................... A-4
  MSO: Schedule Across Breaks ............................................................................. A-4
  MSO: schedule window width .............................................................................. A-4
  MSO: Firm Supply Allocation Window (days) ...................................................... A-4
Oracle ASCP Optimization Profile Options .......................................................... A-4
  MSO: Alternate Process Penalty .......................................................................... A-4
MSO: Alternate Source Penalty ................................................................. A-5
MSO: Inventory Carrying Costs Percentage .............................................. A-5
MSO: LP Optimization Algorithm .............................................................. A-5
MSO: Maximum Allowable Days Late ....................................................... A-5
MSO: Penalty Cost Factor for Exceeding Resource Capacity ................... A-6
MSO: Penalty Cost Factor for Late Demands ........................................... A-6
MSO: Queue Time Factor ................................................................. A-6
MSO: Substitute Item Penalty .............................................................. A-6

Other Oracle ASCP Profile Options: ...................................................... A-6
MSC: Default Workbench Height .......................................................... A-6
MSC: Default Workbench Width .......................................................... A-6
MSC: Hour UOM ................................................................................ A-6
MSC: Map Server Host ....................................................................... A-6
MSC: Map Server Port ....................................................................... A-6
MSC: Plan co-products ........................................................................ A-6
MSC: Planning Currency .................................................................... A-7
MSC: Sales Orders Offset Days ............................................................ A-7
MSC: Share Plan Partitions .................................................................. A-7
MSC: Sourcing Rule Category Set ........................................................ A-7

ILOG CPLEX Solver Profile Options ........................................................ A-7
MSO: Check Redundant Constraints ..................................................... A-7
MSO: CPLEX Crash Parameter ............................................................ A-7
MSO: CPLEX Refactor Rate ............................................................... A-8
MSO: CPLEX Scaling Factor ............................................................... A-8
MSO: Dual Simplex Parameter ............................................................. A-8
MSO: Global Time Limit ................................................................. A-8
MSO: List Size for Pricing Candidates ................................................ A-8
MSO: LP Markowitz Coefficient ........................................................... A-8
MSO: Maximum Simplex Iterations .................................................... A-8
MSO: Preprocessing Aggregator Fill .................................................... A-8
MSO: Preprocessing Aggregator Limit ................................................ A-8
MSO: Preprocessing Flag for LP Matrix ............................................... A-8
MSO: Primal Simplex Parameter ........................................................... A-9
MSO: Simplex Feasibility Tolerance ................................................... A-9
MSO: Simplex Optimality Tolerance ................................................................. A-9
MSO: Simplex Perturbation Constant .............................................................. A-9
MSO: Simplex Perturbation Limit ................................................................. A-9
MSO: Simplex Perturbation Indicator ............................................................ A-9
MSO: Simplex Presolve Limit ................................................................. A-9
MSO: Simplex Singularity Repair Limit ........................................................ A-9
MSO: Solve Dual Problem ............................................................................. A-9
Oracle ASCP Flexfield Attribute Profile Option ........................................... A-9
Oracle Global Order Promising Profile Options ............................................. A-10
  INV: Capable to Promise .......................................................................... A-10
  INV: External ATP .................................................................................. A-11
  MRP: Calculate Supply Demand .............................................................. A-11
  MRP: ATP Assignment Set ...................................................................... A-11
  MRP: ATP Database Link ........................................................................ A-11
  MRP: Include Substitute Components ...................................................... A-11
  MSC: ATP Debug Mode .......................................................................... A-11
  MSC: Enable Allocated ATP .................................................................. A-11
  MSC: Enable Allocated ATP Workflow .................................................... A-12
  MSC: ATP Assignment Set ...................................................................... A-12
  MSC: Class Hierarchy ............................................................................. A-12
  MRP: Set Category for Backlog Form ....................................................... A-12
Oracle Risk Optimization Profile Options .................................................... A-12
  MSR: Safety Stock Holding Strategy ........................................................ A-12
  MSR: Postponement Factor ..................................................................... A-12

**B Oracle ASCP Flexfields**

  Oracle ASCP Flexfields................................................................................. B-1
  Penalty Cost Factor for Late Demands (at the demand level) .................. B-1
  Penalty Cost Factor for Late Demands (at the item level) ....................... B-1
  Penalty Cost Factor for Late Demands (at the org level) ......................... B-1
  Penalty Cost Factor for Exceeding Material Capacity (at the item/vendor level) B-1
  Penalty Cost Factor for Exceeding Material Capacity (at the item level) .... B-1
  Penalty Cost Factor for Exceeding Material Capacity (at the org level) .... B-1
  Penalty Cost Factor for Exceeding Resource Capacity (at the resource level) B-2
  Penalty Cost Factor for Exceeding Resource Capacity (at the org level) ... B-2
Oracle Corporation welcomes your comments and suggestions on the quality and usefulness of this publication. Your input is an important part of the information used for revision.

- Did you find any errors?
- Is the information clearly presented?
- Do you need more information? If so, where?
- Are the examples correct? Do you need more examples?
- What features did you like most about this manual?

If you find any errors or have any other suggestions for improvement, please indicate the chapter, section, and page number (if available). You can send comments to us in the following ways:

Oracle Advanced Planning and Scheduling Documentation
Oracle Corporation
Attention: Scott Malcolm
300 Oracle Parkway, M/S 3OP10
Redwood Shores, CA 94065
Phone: (650) 506-7000 Fax: (650) 506-7200 Email: smalcolm@us.oracle.com

If you would like a reply, please give your name, address, and telephone number below.

If you have problems with the software, please contact your local Oracle Support Services.
Preface

Audience for This Guide


This manual is intended for both users and administrators of Oracle ASCP, Oracle Risk Optimization, Oracle Global Order Promising, and Oracle Demand Planning.

Note: The other components of Advanced Planning and Scheduling, namely Oracle Manufacturing Scheduling, which is documented in the Oracle Manufacturing Scheduling User Guide, part number A77021-02, and Oracle Supply Chain Exchange, which is documented in the online help for the product, are not documented in this guide.

It is for those who will both use and implement these products. It discusses how to perform common tasks using these applications, high-level conceptual issues, and why they must be resolved in certain ways.

This guide assumes you have a working knowledge of the following:

- The principles and customary practices of your business area.
- Oracle Advanced Supply Chain Planning, Oracle Risk Optimization, Oracle Global Order Promising, and Oracle Demand Planning

If you have never used these applications, we suggest you attend one or more training class for the product available through Oracle University.

- The Oracle Applications graphical user interface.
To learn more about the Oracle Applications graphical user interface, read the Oracle Applications User Guide.

See Other Information Sources for more information about Oracle Applications product information.

How To Use This Guide

This guide contains the information you need to understand and implement Oracle Advanced Supply Chain Planning, Oracle Risk Optimization, Oracle Global Order Promising, and Oracle Demand Planning.

This preface explains how this document is organized and introduces other sources of information that can help you. This guide contains the following chapters:

- Chapter 1 gives an overview of Oracle ASCP, Oracle Risk Optimization, Oracle Global Order Promising, and Oracle Demand Planning and describes new features in this release.
- Chapter 2 instructs you how to set up Oracle ASCP, Oracle Global Order Promising, and Oracle Risk Optimization.
- Chapter 3 describes the flows of information between the components of Oracle APS and how Oracle ASCP functionality relates to a planner’s daily business processes.
- Chapter 4 describes the ASCP data collections process and architecture.
- Chapter 5 describes features that help you select a plan that best satisfies your business requirements. It describes various issues to consider when setting up a plan including: deciding whether to run a subset plan, choosing a plan type, choosing a level of optimization, choosing an objective function, and choosing aggregation levels.
- Chapter 6 instructs you how to set up a supply chain.
- Chapter 7 describes Oracle ASCP’s advanced simulation capabilities which let you rapidly simulate changes to a plan and respond to changing conditions.
- Chapter 8 describes Oracle ASCP’s optimization capabilities.
- Chapter 9 discusses Oracle ASCP’s integration with Oracle Business Intelligence System (BIS), a performance management tool.
- Chapter 10 describes the Planner Workbench, a powerful graphical tool that lets you perform advanced simulation, review plan performance, and take actions based on system recommendations.
Chapter 11 discusses constraint-based planning and scheduling, an approach for balancing material and plant resources while meeting customer demand.

Chapter 12 describes Oracle ASCP’s support for mixed mode manufacturing which lets you plan distribution and manufacturing operations for hybrid environments.

Chapter 13 discusses Oracle ASCP’s support for powerful Internet-based collaboration, which allows you to communicate seamlessly with your customers.

Chapter 14 discusses Configure to Order which supports Multilevel Configurations where you can have configurations under configurations. You can source the configurations from anywhere in the supply chain.

Chapter 15 discusses Cross-Instance Planning, a tool that enables you to define, run, and execute a single plan across multiple source instances, which is a key feature for companies that implement a hub-and-spoke planning model.

Chapter 16 discusses Oracle Global Order Promising, a tool that enables sophisticated, fast, accurate, and flexible order promising.

Chapter 17 discusses Risk Optimization, a feature that enables you to optimize your strategic inventory investment decisions by helping you to identify optimal inventory stocking levels, order quantities, order frequency, and other operational policies given a set of requirements and objectives.

Chapter 18 discusses Oracle Demand Planning, offering high-level information on demand planning roles and detailed instructions on setting up a demand plan using Oracle Demand Planning.

Appendix A contains a list of some of the ASCP and Global Order Promising profile options.

Appendix B contains a list of ASCP flexfields.

Appendix C discusses the Order Backlog Workbench.

Finding Out What’s New

From the HTML help window for Oracle Advanced Supply Chain Planning, Oracle Risk Optimization, Oracle Global Order Promising, and Oracle Demand Planning, choose the section that describes new features or what’s new from the expandable menu. This section describes:
New features in 11i. This information is updated for each new release of Oracle Advanced Supply Chain Planning, Oracle Risk Optimization, Oracle Global Order Promising, and Oracle Demand Planning.

Information about any features that were not yet available when this document was printed. For example, if your system administrator has installed software from a mini pack as an upgrade, this document describes the new features.

Other Information Sources

You can choose from many sources of information, including online documentation, training, and support services, to increase your knowledge and understanding of Oracle Advanced Supply Chain Planning, Oracle Risk Optimization, Oracle Global Order Promising, and Oracle Demand Planning.

If this guide refers you to other Oracle Applications documentation, use only the Release 11i versions of those guides unless we specify otherwise.

Online Documentation

All Oracle Applications documentation is available online (HTML and PDF). The technical reference guides are available in paper format only. Note that the HTML documentation is translated into over twenty languages.

The HTML version of this guide is optimized for onscreen reading, and you can use it to follow hypertext links for easy access to other HTML guides in the library. When you have an HTML window open, you can use the features on the left side of the window to navigate freely throughout all Oracle Applications documentation.

- You can use the Search feature to search by words or phrases.
- You can use the expandable menu to search for topics in the menu structure we provide. The Library option on the menu expands to show all Oracle Applications HTML documentation.

You can view HTML help in the following ways:

- From an application window, use the help icon or the help menu to open a new Web browser and display help about that window.
- Use the documentation CD.
- Use a URL provided by your system administrator.

Your HTML help may contain information that was not available when this guide was printed.
Related User Guides

Oracle Advanced Supply Chain Planning, Oracle Risk Optimization, Oracle Global Order Promising, and Oracle Demand Planning share business and setup information with other Oracle Applications products. Therefore, you may want to refer to other documents when you set up and use Oracle Advanced Supply Chain Planning, Oracle Risk Optimization, Oracle Global Order Promising, and Oracle Demand Planning.

You can read the guides online by choosing Library from the expandable menu on your HTML help window, by reading from the Oracle Applications Document Library CD included in your media pack, or by using a Web browser with a URL that your system administrator provides.

If you require printed guides, you can purchase them from the Oracle store at http://oraclestore.oracle.com.

User Guides Related to All Products

**Oracle Applications User Guide**

This guide explains how to navigate the system, enter data, and query information, and introduces other basic features of the GUI available with this release of Oracle Advanced Supply Chain Planning, Oracle Risk Optimization, Oracle Global Order Promising, and Oracle Demand Planning (and any other Oracle Applications product).

You can also access this document online by choosing Getting Started and Using Oracle Applications from the Oracle Applications help system.

**Oracle Alert User Guide**

Use this guide to define periodic and event alerts that monitor the status of your Oracle Applications data.

**Oracle Applications Implementation Wizard User Guide**

If you are implementing more than one Oracle product, you can use the Oracle Applications Implementation Wizard to coordinate your setup activities. This guide describes how to use the wizard.
Oracle Applications Developer’s Guide
This guide contains the coding standards followed by the Oracle Applications development staff. It describes the Oracle Application Object Library components needed to implement the Oracle Applications user interface described in the Oracle Applications User Interface Standards. It also provides information to help you build your custom Oracle Developer forms so that they integrate with Oracle Applications.

Oracle Applications User Interface Standards
This guide contains the user interface (UI) standards followed by the Oracle Applications development staff. It describes the UI for the Oracle Applications products and how to apply this UI to the design of an application built by using Oracle Forms.

User Guides Related to This Product

Oracle Applications Demonstration User’s Guide
This guide documents the functional storyline and product flows for Vision Enterprises, a fictional manufacturer of personal computers products and services. As well as including product overviews, the book contains detailed discussions and examples across each of the major product flows. Tables, illustrations, and charts summarize key flows and data elements.

Oracle Bills of Material User’s Guide
This guide describes how to create various bills of materials to maximize efficiency, improve quality and lower cost for the most sophisticated manufacturing environments. By detailing integrated product structures and processes, flexible product and process definition, and configuration management, this guide enables you to manage product details within and across multiple manufacturing sites.

Oracle Business Intelligence System Implementation Guide
This guide provides information about implementing Oracle Business Intelligence (BIS) in your environment.
BIS 11/ User Guide Online Help
This guide is provided as online help only from the BIS application and includes information about intelligence reports, Discoverer workbooks, and the Performance Management Framework.

Oracle Capacity User’s Guide
This guide describes how to validate a material plan by verifying that there are resources sufficient to perform the planned work for repetitive and discrete jobs. Using finite capacity planning techniques, you learn how to use rough-cut capacity planning to validate a master schedule and capacity planning to validate the material plan.

Oracle Demand Planning User’s Guide
This guide explains how to use Oracle Demand Planning, an Internet-based solution for creating and managing forecasts.

Oracle Flow Manufacturing User’s Guide
This guide describes how to use Oracle’s Flow Manufacturing functionality to support the processes of flow manufacturing. It describes design features of demand management, line design and balancing, and kanban planning. It also describes production features of line scheduling, production, and kanban execution.

Oracle Inventory User’s Guide
This guide describes how to define items and item information, perform receiving and inventory transactions, maintain cost control, plan items, perform cycle counting and physical inventories, and set up Oracle Inventory.

Oracle Master Scheduling/MRP and Oracle Supply Chain Planning User’s Guide
This guide describes how to anticipate and manage both supply and demand for your items. Using a variety of tools and techniques, you can create forecasts, load these forecasts into master production schedules, and plan your end-items and their component requirements. You can also execute the plan, releasing and rescheduling planning suggestions for discrete jobs and repetitive schedules.

Oracle Project Manufacturing User’s Guide
This guide describes the unique set of features Oracle Project Manufacturing provides for a project-based manufacturing environment. Oracle Project Manufacturing can be tightly integrated with Oracle Projects. However, in addition
to Oracle Projects functionality, Oracle Project Manufacturing provides a comprehensive set of new features to support project sales management, project manufacturing costing, project manufacturing planning, project manufacturing execution and project quality management.

**Oracle Self Service Web Applications User’s Guide**

This guide describes how Oracle Self Service Web Applications enable companies to provide a self-service and secure web interface for its employees, customers and suppliers. Employees can change their personal status, submit expense reports or request supplies; customers can check on their orders; and suppliers can share production schedules with their trading partners. This guide is available in HTML only.

**Oracle Work in Process User’s Guide**

This guide describes how Oracle Work in Process provides a complete production management system. Specifically this guide describes how discrete, repetitive, assemble-to-order, project, flow, and mixed manufacturing environments are supported.

**Oracle Workflow Guide**

This guide explains how to define new workflow business processes as well as customize existing Oracle Applications-embedded workflow processes. You also use this guide to complete the setup steps necessary for any Oracle Applications product that includes workflow-enabled processes.

**Reference Manuals**

**Oracle Technical Reference Manuals**

Each technical reference manual contains database diagrams and a detailed description of database tables, forms, reports, and programs for a specific Oracle Applications product. This information helps you convert data from your existing applications, integrate Oracle Applications data with non-Oracle applications, and write custom reports for Oracle Applications products.

You can order a technical reference manual for any Oracle Applications product you have licensed.
Oracle Manufacturing and Distribution Open Interfaces Manual
This manual contains up-to-date information about integrating with other Oracle Manufacturing applications and with your other systems. This documentation includes open interfaces found in Oracle Manufacturing.

Oracle Applications Message Reference Manual
This manual describes all Oracle Applications messages. This manual is available in HTML format on the documentation CD-ROM for Release 11i.

Oracle Project Manufacturing Implementation Manual
This manual describes the setup steps and implementation for Oracle Project Manufacturing.

Oracle Self-Service Web Applications Implementation Manual
This manual describes the setup steps for Oracle Self-Service Web Applications and the Web Applications dictionary.

Oracle Applications Flexfields Guide
This guide provides flexfields planning, setup, and reference information for the Oracle Advanced Supply Chain Planning, Oracle Risk Optimization, Oracle Global Order Promising, and Oracle Demand Planning implementation team, as well as for users responsible for the ongoing maintenance of Oracle Applications product data. This guide also provides information on creating custom reports on flexfields data.

Installation and System Administration Guides

Oracle Applications Concepts
This guide provides an introduction to the concepts, features, technology stack, architecture, and terminology for Oracle Applications Release 11i. It provides a useful first book to read before an installation of Oracle Applications. This guide also introduces the concepts behind, and major issues, for Applications-wide features such as Business Intelligence (BIS), languages and character sets, and self-service applications.

Installing Oracle Applications
This guide provides instructions for managing the installation of Oracle Applications products. In Release 11i, much of the installation process is handled
using Oracle One-Hour Install, which minimizes the time it takes to install Oracle Applications and the Oracle 8i Server technology stack by automating many of the required steps. This guide contains instructions for using Oracle One-Hour Install and lists the tasks you need to perform to finish your installation. You should use this guide in conjunction with individual product user guides and implementation guides.

**Upgrading Oracle Applications**

Refer to this guide if you are upgrading your Oracle Applications Release 10.7 or Release 11.0 products to Release 11i. This guide describes the upgrade process in general and lists database upgrade and product-specific upgrade tasks. You must be at either Release 10.7 (NCA, SmartClient, or character mode) or Release 11.0 to upgrade to Release 11i. You cannot upgrade to Release 11i directly from releases prior to 10.7.

**Using the AD Utilities**

Use this guide to help you run the various AD utilities, such as AutoInstall, AutoPatch, AD Administration, AD Controller, Relink, and others. It contains how-to steps, screenshots, and other information that you need to run the AD utilities.

**Oracle Applications Product Update Notes**

Use this guide as a reference if you are responsible for upgrading an installation of Oracle Applications. It provides a history of the changes to individual Oracle Applications products between Release 11.0 and Release 11i. It includes new features and enhancements and changes made to database objects, profile options, and seed data for this interval.

**Oracle Applications System Administrator’s Guide**

This guide provides planning and reference information for the Oracle Applications System Administrator. It contains information on how to define security, customize menus and online help, and manage processing.

**Oracle Workflow Guide**

This guide explains how to define new workflow business processes as well as customize existing Oracle Applications-embedded workflow processes. You also use this guide to complete the setup steps necessary for any Oracle Applications product that includes workflow-enabled processes.
Training and Support

Training
We offer a complete set of training courses to help you and your staff master Oracle Applications. We can help you develop a training plan that provides thorough training for both your project team and your end users. We will work with you to organize courses appropriate to your job or area of responsibility.

Training professionals can show you how to plan your training throughout the implementation process so that the right amount of information is delivered to key people when they need it the most. You can attend courses at any one of our many Educational Centers, or you can arrange for our trainers to teach at your facility. We also offer Net classes, where training is delivered over the Internet, and many multimedia-based courses on CD. In addition, we can tailor standard courses or develop custom courses to meet your needs.

Support
From on-site support to central support, our team of experienced professionals provides the help and information you need to keep Oracle Advanced Supply Chain Planning, Oracle Risk Optimization, Oracle Global Order Promising, and Oracle Demand Planning working for you. This team includes your Technical Representative, Account Manager, and Oracle’s large staff of consultants and support specialists with expertise in your business area, managing an Oracle server, and your hardware and software environment.
Conventions

In this manual, we use a number of notational and text conventions to visually identify different kinds of information.

Notational Conventions

The following notational conventions are used in this manual:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>bold type</strong></td>
<td>Bold type is used to designate certain user interface objects, including button, radio button, and window names.</td>
</tr>
<tr>
<td>&lt;drive&gt;&gt;</td>
<td>A drive followed by a right caret denotes the Windows NT command prompt (for example, c:&gt;).</td>
</tr>
<tr>
<td><em>italic type</em></td>
<td>Italic type can mean one of two things: a) user-supplied information; or b) the title of a book, chapter, or section.</td>
</tr>
<tr>
<td><strong>monospace text</strong></td>
<td>Text in this typeface one of three things: a) feedback from Oracle ASCP; b) information you enter; or c) filenames and pathnames.</td>
</tr>
</tbody>
</table>

Text Conventions

The following text conventions are used in this manual:

Note

A Note calls attention to an important feature or fact that is related to the contents of the previous paragraph. Here is an example of a Note:

---

**Note:** This note is used to call attention to some feature or fact related to the previous paragraph.

---

Caution

A Caution represents information about a condition that could prevent the application from working correctly. Here is an example of a Caution:

---

**Caution:** This is a caution to pay attention to some feature or fact that could prevent Oracle ASCP from working correctly.

---
Code Examples
In code examples, an implied carriage return occurs at the end of each line, unless otherwise noted. You must press the Return key at the end of a line of input.

Choosing Menu Options
In procedures, an instruction to choose successive menu and sub-menu options is noted in an abbreviated way. For example, an instruction to select Action from the menu bar, then choose Save from the Action menu, is noted as follows:

To save your work choose Menu > Action > Save.

Do Not Use Database Tools to Modify Oracle Applications Data

We STRONGLY RECOMMEND that you never use SQL*Plus, Oracle Data Browser, database triggers, or any other tool to modify Oracle Applications tables, unless we tell you to do so in our guides.

Oracle provides powerful tools you can use to create, store, change, retrieve, and maintain information in an Oracle database. But if you use Oracle tools such as SQL*Plus to modify Oracle Applications data, you risk destroying the integrity of your data and you lose the ability to audit changes to your data.

Because Oracle Applications tables are interrelated, any change you make using an Oracle Applications form can update many tables at once. But when you modify Oracle Applications data using anything other than Oracle Applications forms, you might change a row in one table without making corresponding changes in related tables. If your tables get out of synchronization with each other, you risk retrieving erroneous information and you risk unpredictable results throughout Oracle Applications.

When you use Oracle Applications forms to modify your data, Oracle Applications automatically checks that your changes are valid. Oracle Applications also keeps track of who changes information. But, if you enter information into database tables using database tools, you may store invalid information. You also lose the ability to track who has changed your information because SQL*Plus and other database tools do not keep a record of changes.

About Oracle
Oracle Corporation develops and markets an integrated line of software products for database management, applications development, decision support and office automation, as well as Oracle Applications. Oracle Applications provides the
E-business Suite, a fully integrated suite of more than 70 software modules for financial management, Internet procurement, business intelligence, supply chain management, manufacturing, project systems, human resources and sales and service management.

Oracle products are available for mainframes, minicomputers, personal computers, network computers, and personal digital assistants, enabling organizations to integrate different computers, different operating systems, different networks, and even different database management systems, into a single, unified computing and information resource.

Oracle is the world’s leading supplier of software for information management, and the world’s second largest software company. Oracle offers its database, tools, and application products, along with related consulting, education and support services, in over 145 countries around the world.

**Your Feedback**

Thank you for using Oracle ASCP, Oracle Risk Optimization, Oracle Global Order Promising, and Oracle Demand Planning and this document.

We value your comments and feedback. This guide contains a Reader’s Comment Form you can use to explain what you like or dislike about Oracle Advanced Supply Chain Planning, Oracle Risk Optimization, Oracle Global Order Promising, and Oracle Demand Planning or this document. Mail your comments to the following address or call us directly at (650) 506-7000.

Oracle Applications Documentation Manager
Oracle Corporation
500 Oracle Parkway
Redwood Shores, CA  94065
U.S.A.

Or, send electronic mail to appsdoc@us.oracle.com.
Topics covered in this section include the following:

- Introducing Oracle Advanced Planning Suite on page 1-2
- Oracle Advanced Supply Chain Planning on page 1-3
- Oracle Risk Optimization on page 1-16
- Oracle Global Order Promising on page 1-19
- Oracle Demand Planning on page 1-22
Introducing Oracle Advanced Planning Suite

Oracle’s Advanced Planning Suite includes the following products:

- Oracle Advanced Supply Chain Planning™ (ASCP)
- Oracle Manufacturing Scheduling™
- Oracle Global Order Promising™
- Oracle Risk Optimization™
- Oracle Demand Planning™
- Oracle Supply Chain Exchange

Note: This document covers Oracle Advanced Supply Chain Planning, Oracle Risk Optimization, Oracle Global Order Promising, and Oracle Demand Planning.
Oracle Advanced Supply Chain Planning

Oracle Advanced Supply Chain Planning™ (ASCP) is a comprehensive, Internet-based planning solution that decides when and where supplies (for example, inventory, purchase orders and work orders) should be deployed within an extended supply chain. This is the supply planning function. Oracle ASCP addresses the following key supply planning issues:

- How do I plan my supply chain in the least amount of time possible?
- How do I minimize the number of plans and iterations?
- How do I plan my entire supply chain?
- How do I involve my trading partners?
- How can I access my plan from anywhere?
- How do I keep improving my plans?
- How can I plan all manufacturing methods?

The key capabilities of Oracle ASCP are:

- Holistic Optimization, Planning, and Scheduling. Oracle ASCP can plan all supply chain facilities simultaneously. Short-term detailed scheduling and long-term aggregate planning are supported within a single plan. This single plan also supports multiple manufacturing methods, including discrete, flow, project, and process manufacturing.

- Finite Capacity Planning and Scheduling. Oracle ASCP generates feasible supply chain plans that consider both resource and material constraints.

- Optimization. Users can easily configure Oracle ASCP to optimize specific business criteria. No programming is necessary to access Oracle ASCP’s powerful mathematical optimization capabilities.

- Backward Compatibility. Oracle ASCP’s component architecture allow it to be deployed against any combination of Oracle 10.7, Oracle 11 and Oracle 11i transaction systems.

- Workflow-Driven Exception Messaging. Oracle ASCP’s exception messages alert planners to critical issues across the extended supply chain. Workflows that drive these exceptions route data to and feedback from trading partners as required, thus effectively involving them in the supply chain planning process.

- Global Accessibility. Oracle ASCP’s database-centric architecture stores plan data in a central planning server database. These data are accessible from
anywhere via a simple browser. It is possible for multiple planners to simultaneously access data from a single plan.

- Integrated Planning and Execution. Oracle ASCP’s Advanced Planner Workbench user interface not only displays plan results, but also allows planners to execute planning recommendations. Planners do not have to move to the transaction system to perform plan execution.

- Simulation Capability. Oracle ASCP allows many types of changes to supply, demand, plan options, and resource profiles to simulate changing business conditions. You can generate a plan considering all the changes that have been entered via the Planner’s Workbench. Unlimited numbers of scenarios can be simulated and compared using online planning, copy plans, and exceptions. Examples of the types of changes are firming, changing sources, modifying quantities and dates, modifying priorities, modifying resource availability, modifying supplier capacity, and modifying objective weights.

**New Features**

**Centralized and Decentralized Planning**

You can choose how to deploy Oracle ASCP to support either centralized or decentralized planning strategies. You can run one rapid, single-step supply chain plan that optimizes, plans, and schedules your entire virtual enterprise. Alternatively, you can break the planning problem into subsets. For example, you might choose to run an enterprise-wide high level plan, but plan manufacturing at the individual factory level. You can plan all or any subset of your virtual enterprise in a single plan. This reduces the number of plans as well as the time and effort required to coordinate planning activities.

**Advanced Planning for Mixed-Mode Manufacturing**

Oracle ASCP supports full mixed-mode manufacturing. You can plan for the full range of process, discrete, repetitive, project, and flow manufacturing environments. You can also plan make to stock, make to order, assemble to order, and configure to order products simultaneously.

**Discrete and Process Manufacturing** ASCP is fully integrated with Oracle Manufacturing™ (Oracle’s discrete manufacturing solution) and Oracle Process Manufacturing.
You can plan distribution and manufacturing operations enterprise for hybrid environments. Oracle ASCP includes full support for by-products, co-products, lot expirations, and formula effectivities.

**Oracle Flow Manufacturing and Oracle ASCP** Oracle ASCP integrated with Oracle Flow Manufacturing™ lets you simultaneously deploy the two most significant advances in technology and methodology available today.

ASCP can dramatically improve supply chain throughput and reduce inventories by improving synchronization of operations between facilities. In turn, Flow Manufacturing increases manufacturing plant throughout by dramatically decreasing manufacturing cycle times and removing in-process and finished goods inventory. The combination of ASCP and Flow can completely transform supply chain performance.

**Oracle ASCP for Engineer to Order/Aerospace and Defense** Oracle ASCP supports constraint-based supply chain planning and optimization with online simulations for ETO/A&D manufacturing. It features the following:

- hard and soft pegging
- supply chain project planning
- group netting
- borrow payback
- model/unit effectivity (serial effectivity)
- common supply netting
- workflow based project exception messages
- Sefian manufacturing (Asian manufacturing method)

**Oracle Project Manufacturing** Oracle Project Manufacturing is an Internet-based manufacturing solution tailored to Engineer-to-Order, Make-to-Order, and Aerospace and Defense industries. Major features include:

- Engineering and configuration management
- Project Planning
- Supply chain management and execution
- Financial management

For more information, see the *Oracle Project Manufacturing User’s Guide*. 
Simultaneous High-Level Planning and Detailed Scheduling

You can optimize, plan, and schedule your entire supply chain simultaneously as part of a holistic planning process. Oracle ASCP combines many elements of planning that have historically forced companies into multi-step planning processes resulting in longer planning cycles and multiple plans to reconcile.

This comprehensive solution lets you generate and deploy long term plans that are optimal for meeting your business objectives, and are feasible to execute in the short term. You can specify flexible levels of granularity and control for the following:

- time bucketing
- item aggregation
- resource aggregation
- routing or bill of resources

Figure 1–1  The Aggregation Tab

Finite, Constraint-Based Planning and Scheduling

Using advanced constraint-based solving technology, Oracle ASCP ensures that your plan is feasible and respects your constraints, including finite material and
resource capacity, project pegging, and so on. You can be confident of your ability to execute the plan and meet your commitments to your customers.

You can define rules to prioritize demands, and prioritize based on combinations of criteria such as dates, customer priorities, and item priorities. You will be able to build and save rules based on the combinations you choose and specify a default rule. You can also specify flexible levels of scheduling granularity and duration.

**Optimization Across Multiple Objectives with Weighting of Objectives**

Oracle ASCP incorporates advanced optimization techniques. You can optimize your plans to:

- maximize inventory turns
- maximize plan profit
- maximize ontime delivery

*Figure 1–2 The Optimization tab*

The plan objective is derived by combining and weighting chosen objectives. Optimization uses sourcing rules to determine the best possible sources of supply, considering all your material, resource, and transportation constraints.
Advanced Simulation
Oracle ASCP provides online interactive simulation planning so you can rapidly simulate changes and respond to changing conditions. For example, you could generate an unconstrained plan and a constrained plan and compare the results based on your performance indicators. You can:

- simulate changes to material and capacity simultaneously
- copy and version your plan
- save and compare exceptions
- visually highlight changes
- simulate changes to demand priorities, add new demands
- firm, modify, add supplies
- run and compare multiple simulation scenarios
- simulate the effects of changing sources

Integrated Performance Management
Oracle ASCP is integrated with Oracle Business Intelligence System (BiS). Oracle BiS lets you set the organizational objectives used to drive continuous improvement in your enterprise. You can set performance targets and exception tolerances by business units or by period and automatically notify the appropriate people when exceptions arise.

Advanced Graphical User Interface
Oracle ASCP introduces a redesigned and updated version of the Planner Workbench. The new Planner Workbench is more flexible, intuitive, and easier to use.

Planners need to respond rapidly to a dynamic and complex environment. They need to have instant access to vast amounts of information including supply and demand information about the entire global supply chain. The new Planner Workbench streamlines the common activities of planners, while providing easy access to the information needed to answer the tough questions faced by planners.

Key Performance Indicators The opening window of the Planner Workbench is a graphical display of the plan’s Key Performance Indicators (KPIs).
Figure 1–3 Plan Performance Management

This window gives you a quantitative assessment of the quality of a plan, based on its business objectives. You can see instantly how a plan will perform at improving profitability, on time delivery, inventory turnover, and resource utilization. Selecting indicator graphs displays more detailed additional information about the measure. You can also use Oracle BIS for more extensive analysis of selected measures.

You can also use intuitive customizable tree structures to display detailed information about a plan, as shown above. Tree structures offer quick and easy access to frequently used information about your plan.

The Actions Tab Another key feature of the Planner Workbench, the Actions tab in the right pane, segregates all exceptions that require immediate attention. Clicking on a specific exception leads to exception details, then seamlessly to a variety of exception resolution screens.
**Figure 1–4  The Actions tab**

Graphics  The Planner Workbench also includes extensive graphics. All summary windows include customizable default graphical displays. You can specify data to be graphed, resize windows, add or hide columns and rows, and zoom in or out on the display. You can also control the granularity and mix of time buckets used in horizontal displays. For example, you could choose to display the first 2 weeks in daily buckets, the next 6 weeks in weekly buckets, and the next 10 months in monthly buckets.

Supply Chain Collaboration

Oracle ASCP is the most complete Internet-based planning solution. It allows low-cost web deployment of the entire advanced planning solution. Its architecture is compliant with open Internet standards and the data model is accessible through Java Business Objects and XML. This enables you to extend collaboration with Oracle’s web based ad-hoc query tools and OLAP tools, or any SQL-based query tool. Oracle’s Internet computing architecture provides an advanced framework for managing today’s collaborative supply chain.

Oracle ASCP enables Internet-based collaboration by automatically forwarding planning exceptions to trading partners using Oracle Workflow. Trading partners
can research and respond to exceptions by selecting links to self-service web applications including supplier capacity update, and a secured version of the Planner Workbench. Trading partner responses can, in turn, trigger other workflow activities such as an internal notification, or even an automatic reschedule of a purchase order or sales order.

**Planning Engine Enhancements**

**Look-Ahead Heuristic** ASCP provides a new look-ahead scheduling heuristic. You can choose between using the existing or the new heuristic using the profile option MSO: Heuristic type. The existing heuristic schedules strictly based on demand priority, and jobs are scheduled to complete exactly on time when feasible. The look-ahead heuristic intelligently schedules some jobs to complete early, opening up supply windows appropriately so that other jobs have the opportunity to complete on time. The amount of look-ahead employed by the heuristic is controlled by a system level profile option, MSO: Maximum Demands per Group.

**Firm Supply Allocation** ASCP allows firmed supplies to be used up by high-priority demands. The degree to which this occurs is controlled by the profile option MSO: Firm Supply Allocation Window. This profile option determines how far back firmed supply (for example, planned orders, discrete jobs, onhand, purchase requisitions) is to be considered for higher priority demands.

**Schedule Window Width** This new profile MSO: Schedule Window Width option is used to control the selection of primary and alternate resources. It tells the scheduling engine to wait a certain amount of time to see if a primary resource will become available before deploying an alternate resource.

The window is specified in days (includes non-working days), and represents the time between the primary and alternate resource availability. The window starts at the first availability of primary/alternate resources and ends based on the window width specified in the profile option. The scheduling logic selects the highest priority resource that is available within the window. Therefore,

1. If both primary and alternate resources are available within the window, the primary is selected;
2. If only the alternate resource is available within the window, the alternate is selected.

**In-Line Forecast Consumption** ASCP accepts forecasts directly from Oracle Demand Planning. These forecasts are consumed within ASCP itself. The old method of
publication of forecast from Oracle Demand Planning to a source transaction instance, consumption on the source instance via loading of an MDS, and then collection of the MDS from the source instance into the planning server instance for use by ASCP is no longer required.

**Planning Time Fence** ASCP generates a stable supply chain plan for manufacturing shops and helps companies to honor contractual commitments with external suppliers by supporting a planning time fence (PTF). PTF is a time parameter associated to an organization-item. Operations and orders (planned orders, work orders, purchase orders, transfer orders) with start dates within the PTF will not be permitted to be rescheduled or cancelled. Operations and orders with start dates beyond the PTF will not be permitted to be rescheduled inside the PTF. A new profile option, MSO: Firm Operations/Orders Within Time Fence, controls whether operations and orders that fall within the PTF are automatically firmed or not.

**Efficiency and Utilization** Efficiency is a measure (usually expressed as a percentage) of the actual output to the standard output expected. Efficiency measures how well something is performing relative to an existing standard.

Utilization is a measure (usually expressed as a percentage) of how intensively a resource is being used to produce a good or service. Utilization compares actual time used to available time.

Actual Usage is the ratio of theoretical usage (resource hours from routing) to the product of Efficiency and Utilization.

\[
\text{Actual Usage} = \frac{\text{Theoretical Usage}}{(\text{Efficiency}) \times (\text{Utilization})}
\]

ASCP plans on the basis of actual usage in order to produce schedules that can be consistently implemented on the manufacturing floor.

Efficiency and utilization factors from item routings are now collected by ASCP. The Planner Workbench and Collection Workbench have been modified to display these factors.

**Planner Workbench**

**3D to 2D Graph/Chart** All 3-dimensional charts in the Planner Workbench have been changed to 2-dimensional charts to increase readability and to allow for more time buckets within a chart.
Options for Displaying Number of Periods in Horizontal Plan Graph  The number of time periods displayed in a horizontal plan graph can be toggled between five, seven and ten using the right-mouse menu.

Expand All Capability in Pegging Tree  The demand/supply pegging tree can be entirely expanded to all levels in a single step by accessing the right-mouse menu option Expand All.

Horizontal Plan and Graph Synchronization  The time buckets displayed in the horizontal plan and the corresponding graph are synchronized.

Alternating Colors in Horizontal Plan  The rows of the horizontal plan are now displayed with alternating color backgrounds to improve readability.

Gantt Chart

Navigate to Associated Activity  When selecting a job or operation on the left hand panel, a planner can navigate to the associated activity bar in the right hand panel Gantt chart with a right click. The Gantt chart scrolls automatically as necessary.

Ability to Change Activity Duration  The duration of a supply activity can be increased or decreased by simply stretching the activity bar on-screen. This can represent delay or pull-ahead in the completion of the activity. (The duration of a demand or roll-up activity cannot be changed in this manner.)

View Subsets of Data  A planner can flexibly view subsets of Gantt chart data. Specific resources, resources belonging to specific departments, or resources belonging to specific organizations may be selected for view. Activities within specific start or end date ranges or within specific order number ranges may be selected for view. Resources and activities corresponding to specific exception types (for example, Resource Overloaded) may be viewed as a group. A Find window is provided to achieve this.

Split Views  The split/merge option is available from the View pull-down menu in the Gantt chart. This allows you to view activities in split views. Using this feature, short-term data in smaller time buckets (days) and long-term data in longer time buckets (e.g., quarters) can be seen. This makes the decision to reschedule easier because you have a complete picture of all the jobs. Both horizontal and vertical split views are offered.
Oracle Shop Floor Manufacturing (OSFM) Integration
Oracle ASCP has been enhanced to support full integration with Oracle Shop Floor Management (OSFM). OSFM integrates the Manufacturing Execution System (MES) and ERP, enabling supply chain transparency and event driven enterprise planning.

Support for Lot-Based Jobs
Lot-based jobs are captured via a snapshot process from the execution system, treated as a valid supply, and scheduled. Planned orders can be released as lot-based jobs to support additional demands. Further, lot-based jobs can be canceled or rescheduled from the Planner Workbench.

Network Routings
Network routings provide the flexibility of defining multiple manufacturing paths. With OSFM integration, network routings are captured via a snapshot and used to calculate and schedule resource requirements for existing lot-based jobs and Planned Orders. The scheduling can be done in three ways:

- Use primary path
- Use cumulative percentages
- Derive the percentages based on resource availability.

As the name suggests, with the first method, orders are scheduled on the primary path. The second method takes advantage of the precalculated accumulated percentages from various paths on network routing to guide scheduling. The last method analyzes the current conditions on the shop floor and intelligently chooses alternate paths and determines the quantity which needs to be processed on each path.

Yield at Operation Level
The reverse cumulative yields specified at the operation sequence level are captured in a snapshot by ASCP and used to derive the component requirements. ASCP loads resources using the inflated quantities derived from reverse cumulative yields at different operation sequences.

Support for Coproducts
In some production environments an item may turn into one or more parent items depending on the process control, test results, raw material quality, etc. This type of relationship is termed a coproduct relationship. OSFM allows you to specify multiple possibilities of assemblies (parents) which may be derived from a single part. Oracle ASCP calculates supply for multiple assemblies based on the demand for any one of the possible coproduct assemblies. The planner can generate and release planned orders for the item for which demand was realized. The planner can view coproduct supplies being generated for the rest of the items in coproduct relationship. This enables tracking of the production for all coproducts. The same applies if the planned order is converted into a lot-based job.
Configure to Order (CTO) Enhancements
Oracle’s Configure to Order solution has been enhanced to support multi-level configurations where you can have configurations under configurations. You can source the configurations from anywhere in the supply chain.

Multilevel Forecast Explosion and Consumption You can explode the forecast through multiple levels of configurations giving you the ability to derive forecasts at lower levels of configurations. Forecasts for assemble-to-order items are consumed at different levels in the BOM in the Manufacturing Organization.

Planning for Multilevel Configurations Once you configure your orders, you can place the demand from the configured orders on to the correct source or Manufacturing Organization and plan component requirements. You can explode through multilevel and multiorg ATO bills for forecasts and other independent demands. You can accurately reconcile the forecast and sales order numbers as demands, both before and after you create the configured item.
Oracle Risk Optimization

Oracle Risk Optimization is a comprehensive, Internet-based inventory planning solution that determines, on the basis of demand, supply and lead-time variabilities, when and where to hold inventories across the supply chain and extended supply chain so as to attain desired customer service levels. Oracle Risk Optimization is a strategic planning tool that addresses the following key business issues:

- How can I improve customer service while reducing inventory?
  - How can I make inventory postponement decisions?
  - How can I manage demand and supply variability?
- How can I identify my strategic sources?

Key capabilities of Oracle Risk Optimization are:

- Considers Demand, Supply and Lead Time Variability. Oracle’s exclusive stochastic optimization technology allows the interdependence of demand, supply and lead time variabilities to be accounted for when generating time-phased safety stock recommendations.
- What-if Capability. Oracle Risk Optimization allows multiple inventory planning scenarios (featuring, for example, different sets of customer service levels, different demand/supply variabilities) to be quickly evaluated, and the results to be graphically compared.
- Integration to Oracle Advanced Supply Chain Planning. The safety stock recommendations of Oracle Risk Optimization can be automatically fed into Oracle Advanced Supply Chain Planning to drive tactical supply chain planning decisions.

New Features

Inventory Plan

A new type of plan, an Inventory Plan, is produced by Oracle Risk Optimization. A single unified inventory plan prescribes time-phased safety stock levels for all items in a multi-organization, multi-tier supply chain. The inventory plan makes strategic postponement decisions that prescribe whether to hold inventory in the form of finished goods, raw material, or somewhere in between.

Via a variety of Plan Options, inventory plans can be configured to output:
optimal, time-phased safety stock target values for given customer service level requirements

achievable service levels and safety stock values for given resource and material constraints

optimal trade-off between customer service level and inventory costs

**Unconstrained and Constrained Safety Stocks**
Unconstrained safety stocks (target) are the safety stock quantities required to support a given service level. On the other hand, constrained safety stock quantities are the quantities achievable given the capacity limitations. The constrained safety stocks will always be less than or equal to the unconstrained equivalent.

Oracle Risk Optimization calculates and displays optimal time-phased values for both constrained and unconstrained safety stocks.

**Model Demand and Supply Variability**
In determining optimal time-phased safety stock targets and achievable levels, Oracle Risk Optimization considers variability in demand and supply.

Demand variability is input as probabilities tied to forecast sets or to scenarios from Oracle Demand Planning. These probabilities are specified in an inventory plan’s plan options.

Oracle Risk Optimization considers supplier lead-time variability. This is input as probability distribution for number of days late in the Collection Workbench.

**Service Level Requirements**
Customer service level requirements may be input at the item, customer, organization or plan levels. Values entered at more detailed levels override values entered at more aggregate levels.

Inputs for item, customer and organization-level customer service level requirements are enabled via flexfields. A plan-level customer service level requirement is entered in an inventory plan’s Plan Options.

**Flexible Optimization**
You can tailor the optimization performed by Oracle Risk to consider specific business objectives. The objectives supported are:

- on-time delivery
inventory turns
plan profit

The relative weighting of the above objectives is easily configured via the Plan Options window.

Capacity Exceptions
Material and Resource constraints will be generated for Inventory Plans only if the user chooses the option Enforce Capacity Constraints. In this option, the output will contain both unconstrained safety stock (i.e., the safety stock required to meet the target customer service level), and constrained safety stock (i.e., the achievable safety stock given the capacity constraints).

The constraint exception messages provide users with a list of capacity bottlenecks that prevent them from achieving the target service levels.

The exception messages generated for this case are the same as those available in ASCP.

Key Performance Indicators

Time-Phased Inventory Levels (Dollarized) Least-risk inventory values at the intersection of the levels in the hierarchies that the user has selected for inventory planning (e.g. item or product family and organization by month) are graphed in a time-phased view.

Service Level (Planned vs. Target) You can see Planned Service Level vs. Target Service Level at plan, organization and item levels. You can also drill down to a graph of service level trend.

Margin You can see Margin values at plan, organization, item category and item levels.

Cost Breakdown The Cost Breakdown KPI summarizes production, inventory holding, penalty and purchasing costs. You can see these costs at plan, organization, item category and item levels.

Integration to Advanced Supply Chain Planning
An inventory plan created by Risk Optimization can be used as a Demand Schedule input for a supply chain plan created by Advanced Supply Chain Planning. The RO plan provides safety stock demands that are planned for by ASCP.
Oracle Global Order Promising is a comprehensive, Internet-based order promising solution that determines, on the basis of the current and projected demands and supplies across a supply chain and an extended supply chain, when a customer order can be fulfilled. Oracle Global Order Promising addresses the following key business issues:

- How can I promise the most accurate dates?
- How quickly can I respond to a customer request?
- How can I get availability information from anywhere?

Key capabilities of Oracle Global Order Promising are:

- Available-To-Promise/Capable-To-Promise/Capable-To-Deliver. Oracle Global Order Promising can calculate promise dates on the basis of not just current on-hand supplies (available-to-promise), but also on the basis of future demand versus supply. It checks for availability at multiple bill-of-material levels and at multiple supply chain locations, drilling down into resource and supplier capacities as necessary (capable-to-promise). It also considers intransit resources and lead times in its calculations.

- Flexible and Configurable. Oracle Global Order Promising’s order promising solution is flexible and configurable. You can control the list of potential sources to be considered in the availability check. You can also control the number of levels in your supply chain bill to be considered in your check. At each level in the supply chain bill, you can specify the key components and bottleneck resources for which to check availability. You can also check the group availability of products that must ship together.

- Global Access. Oracle Global Order Promising is implemented as a PL/SQL package which is callable from web stores, order entry applications such as Oracle Order Management, and from the menu structure of the Oracle Advanced Planning Suite.

- Single Statement of Availability. You can consolidate data from multiple instances and different versions of Oracle Applications. Existing Oracle Applications Release 10.7 and 11.0 customers need not upgrade other applications. Multiple Order Entry systems can thus access a global statement of availability.

- Scalability. Oracle Global Order Promising leverages the multi-threading capabilities of the Oracle database to provide support for multiple concurrent order promising requests. Locking and read consistency of the data are
maintained so that the same supply is never promised to multiple concurrent users.

New Features

**Allocation (Allocated ATP, Allocation Hierarchies)**

The new allocation feature enables you to allocate material or resources among multiple sales channels. Based on your business strategy, you can establish an Allocation Rule that ranks the sales channels and ration the supply among them. You can time phase the allocation to reflect changes in your monthly or quarterly objectives. During order promising, Oracle Global Order Promising honors the allocation rule and calculates order due dates, considering material and capacity allocation at each level of the supply chain.

You can define two types of hierarchy to represent your various sales channels. You can use demand classes, which are single-level and user-defined. Otherwise, you can use customer classes, which have 3 levels: customer class, customer, and site. Whichever hierarchy you choose, you can define allocation rules. With these rules, allocation percentages can be specified for each node in the hierarchy. In addition, you can define priorities against your allocation rules. These priorities can be used to steal supplies from lower priority nodes if supplies are not available. The allocation rules can be assigned to either Global, Item Category, Item, Resource Group, or Department Resource level. Notifications are sent to you if scheduling fails, or if scheduling is only successful by stealing allocation from other nodes.

Allocation provides you with significant control over the demand fulfillment process to achieve your customer service and profitability goals.

**Multi-Level and Multiorg ATO Support**

The ATP Inquiry has been enhanced to support configured orders across the supply chain and orders for multi-level configurations (configurations under configurations).

You can specify sourcing rules at the model level. If a destination organization has a sourcing rule for a model, multi-level ATP will process/explode the model’s bill in the sourcing organization rather than the destination organization. At the time of ATP, you can determine the sourcing tree for the model and its components, and this will be honored by planning. In addition, the processing for models is now consistent with the processing of standard items. To achieve this, CTO provides the configured BOM structure/information to ATP, which then can be used like any standard item BOM. Furthermore, ATP supports automatic sourcing. You can
schedule a CTO order line without specifying a warehouse, and ATP will return the best shipping organization from which the CTO order can be fulfilled. Finally, ATP allows you to see the detailed availability picture in all possible organizations for a configured order.

**Workflow-Based Exceptions**

When a sales order is scheduled from Order Management and the corresponding call to Oracle Global Order Promising returns a date later than the request date, a workflow-driven exception notification is sent to the supply chain planner. If the allocation feature is being used and an order request date can be satisfied only by stealing supply from an allocation channel with lower priority, the supply chain planner receives a notification as well. Both of these exceptions are enabled with allocated ATP.
Oracle Demand Planning

Oracle Demand Planning (ODP) is an internet-based solution for understanding, predicting, and managing customer demand for effective decision making in supply chain management. Oracle Demand Planning is part of the Oracle E-Business Suite, an integrated set of applications, which is designed to transform your business to an e-business. Oracle Demand Planning addresses the following key business issues:

- How can I plan for future demand?
- How can I get different people and organizations within my company to collaborate on arriving at a consensus forecast?
- How can I achieve reduced inventory levels?
- How can I increase customer satisfaction?

Key capabilities of Oracle Demand Planning are:

- Collaborative Demand Planning. Oracle Demand Planning provides an internet-based framework for developing collaborative demand plans and forecasts. You can collect the data from disparate sources and use Oracle Workflow to route information, manage processes, and monitor performance. You can provide secure access to portions of the plan and manage multiple scenarios to develop a collaborative demand plan. Internet architecture enables you to include all interested parties, including your trading partners, in the demand planning process.

- Multi-dimensional Analysis. Oracle Demand Planning is based on a multi-dimensional server and architecture. It allows you to define your own dimensions and aggregations. It also allows you to define multiple sets of aggregations along all dimensions.

- Accurate Statistical Forecasts. Oracle Demand Planning provides several statistical methods for generating forecasts including moving averages, exponential smoothing, Holt-Winters, seasonal adjustment, linear, and non-linear models. A wizard guides you through the steps of defining your forecast. You can choose specific forecasting methods, or have Oracle Demand Planning pick the forecasting method that best fits the historical demand pattern for each item and dimension to be forecasted.

- Best-Fit Forecast With Expert System. Oracle Demand Planning provides pattern recognition to rapidly determine the model that will produce the best statistical forecast based on historical demand. This allows you to generate a best-fit forecast along every dimension of your demand plan. The expert system
limits the search to forecasting methods that will accurately predict future demand based on the historical pattern.

- **Multiple Views of Forecast and What-If Simulations With Consolidation Engine.** Oracle Demand Planning manages the consolidation of multiple forecasts into a single consolidated collaborative demand plan. It uses sophisticated allocation logic (top down, bottom up, middle out) to manage adjustments at multiple levels. Oracle Demand Planning allows you to manage and compare an unlimited number of scenarios.

- **Forecast Accuracy Measurement.** Oracle Demand Planning offers predefined forecast accuracy reports. This allows you to quantify the effectiveness of management overrides and the qualitative adjustments to the statistical forecasts.

### New Features

**Flat-file Import**

With this new feature, data can be imported into the Express User Interface using a specified format. This allows data to be loaded from an external source file. This feature enables you to:

- select a file to use for loading data and a forecast measure into which data will be loaded,
- load data from files of a specific format into existing forecasts, and
- validate imported data.

**Color-Coded Manual Edits**

Changes made to data in the Express User Interface are color coded, allowing the demand planner to easily identify data changes. This feature enables you to:

- color code all manual changes to future and historical data,
- color code all changes made through the Modify Data and Reforecast feature, and
- allow color coding to be retained during Save.
Events, Promotions and New Product Introductions/Product Phase-Outs
Oracle Demand Planning now supports the planning of events, which are defined in a new User Interface in the Demand Planning Server. Three event types are supported:

- Promotions
  - Define promotions; mandatory/optional promotions, product details
  - Enter quantity and price modification factors in percentage/numbers
  - Select dimension levels for applying modification factors
  - Specify start and end dates

- New Product Introductions
  - Define new product introductions; life cycle/supercession-based, product details
  - Specify start and end dates
  - Model based on more than one product and assign weights
  - Apply quantity modification factors in percentage/numbers

- Product Phase-Outs
  - Define product phase-outs; linear/nonlinear, product details
  - Enter Quantity and Price modification factors in percentage/numbers
  - Select dimension levels for applying modification factors
  - Specify start and end dates

Item-Based Unit of Measure (UOM) Conversions
You can roll up forecasts for items belonging to different UOM Classes into a common base UOM at higher levels of the product hierarchy. Features include:

- Item dependent UOM conversions within the same UOM class
- Item dependent UOM conversions across the UOM classes

Dependent Demand Forecasting (Explosion)
Oracle Demand Planning generates forecasts for models on the basis of model booking or shipping history, and then derives forecasts for lower-level model options and standard items on the basis of planning factors. This type of forecasting
is useful for short life cycle products for which historical data at the individual item level is too sparse to be of use in generating realistic forecasts. This feature enables you to:

- derive forecasts for partially or fully dependent demand
- collect independent historical part of the demand
- view both the dependent and independent portions of demand history that pertains to your data slice assignment

**Time Effective Pricing**

Oracle Demand Planning now recognizes date effectivities of price lists collected from Oracle Applications transaction source instances. This allows more realistic revenue forecasts to be generated.

**Display Forecast Method, Parameters, and Errors**

With this new feature, the demand planner is able to view the forecast method used by the system under expert (automatic) mode to generate the baseline forecast. In addition, forecast parameters and errors are displayed for every forecast method used. Features include:

- Predefined report generated to display forecast method and aggregated forecast parameters used for that forecast method
- Three measures of forecast accuracy (RMSE, MAD, MAPE) are also displayed in the report.

**Level Values Window**

The level values window enables you to examine the dimension (product, time, geography, sales channel) hierarchies that have been collected from the transaction system for use by Demand Planning. For example, the level values window can show that the Customer Group hierarchy within the Geography dimension consists of the levels Ship-To Location, Customer, Customer Group, All. Furthermore, it can show that ACME-Lansing and ACME-Holland are specific values of Ship-To Locations, and that these values are associated with a Customer (parent) value of ACME Inc. You can see that ACME Inc. is associated with the Customer Group (parent) value of Sporting Goods Retailers, and can use the level values window to change that association to the Customer Group Hardware Retailers. The level values window provides a means for reviewing and adjusting dimension hierarchies before they are used in the demand planning process.
Usability Enhancements in Demand Planning Engine
The following features were added:

- Decimal precision editing - edit number of decimals to avoid unnecessary zeros after decimal and to be able to round up the numbers.
- Improved error handling and informative error messages
- Enhancements to Demand Planner and Manager UI related to reports, worksheets, icons, and toolbars:
  - Modifications to toolbars: Object Navigator Toolbar
    - Added application Help button
    - Added Activity Log button
  - Modifications to toolbars: View Toolbar
    - Removed Close button; use close button on window title bar
  - Modifications to toolbars: Worksheet Toolbar
    - Removed Save Worksheet button; merged functionality with Save Data
    - Removed Close button; use close button on window title bar
  - Modifications to dialog boxes
    - Modify Data dialog: default Percent checkbox to selected
    - Reset Data: add warning before committing operation
    - Dialogs that initiate potentially long processes: display alert dialog during process
  - Changed background color of non-editable cells to match background color of table row and column headers

Enhanced Integration with Advanced Supply Chain Planning
Oracle Demand Planning demand plans can now directly be used by Oracle ASCP. Previously, users had to push the demand plans first to the source and then collect from the source to the ASCP planning server. The additional step of creating and collecting Master Demand Schedules (MDS) is now optional.
Enhanced Integration with Risk Optimization
Oracle Demand Planning demand plans can now directly be used by Oracle Risk Optimization. Previously, users had to push the demand plans first to the source and then collect from the source to the ASCP planning server.
Topics covered in this section include the following:

- Setup Overview on page 2-2
- Deployment Configurations on page 2-2
- Setup Flowchart on page 2-6
- Setup Steps for the Source on page 2-7
- Setups Steps for the Destination on page 2-13
Setup Overview

This section describes setup steps for Oracle Advanced Supply Chain Planning, Oracle Global Order Promising, and Oracle Risk Optimization. Setup for Oracle Demand Planning is briefly covered for the sake of completeness, but is described fully in the Implementing Oracle Demand Planning section.

Deployment Configurations

The first step in the setup process is to decide on the overall hardware configuration.

Oracle Advanced Planning Suite has a component architecture that separates the transaction data and associated processing (for example, inventory receipts and order entry) in a source instance from the planning calculations done in a destination instance. This allows planning calculations to be done on a different physical machine than the machine that performs transactions and results in better system response. It also allows planning calculations (demand planning, inventory planning, supply planning and order promising) to be applied simultaneously to information from across multiple source instances, which is useful when transaction information for a global supply chain is spread across multiple instances. Oracle Demand Planning also uses a third instance, an Express database, to hold data while multi-dimensional manipulation of demand data occurs.

The source can be any ERP system, but out-of-the-box integration to the Oracle Advanced Planning Suite destination instance (planning server) exists if the source is Oracle Applications Release 10.7, 11.0 or 11i. The planning server is an 11i instance.

One-Machine Implementation

For small implementations, source, destination, and Express can reside on the same machine and be in the same instance. The following figure illustrates this configuration.

Note: ASCP means Advanced Supply Chain Planning and DP means Demand Planning.
Two-Machine Implementation

For larger implementations where system throughput is more important, the various instances can be deployed on separate machines. A two-machine deployment configuration is appropriate when the size of the demand planning data is relatively small. The following figure illustrates this configuration.
Three-Machine Implementation

A three-machine deployment allows for the manipulation of high-dimensionality, large-scale demand planning data to occur on a machine separate from the planning calculations done on the planning server. The following figure illustrates this configuration.
Four-Machine Implementation

The Advanced Supply Chain Planning concurrent manager may also be deployed on a separate machine. This creates even greater system performance. The following figure illustrates the four-machine implementation.
In all deployment configurations, a collection process brings data from the source to the destination (planning server). A build process brings data from the planning server to the Express engine. A separate collection process takes data from the Express engine back to the planning server. Finally, a publish process takes data from the planning server back to the source Oracle Applications instance.

Global Order Promising and Risk Optimization planning calculations are also performed on the planning server.

**Setup Flowchart**

Set up for Oracle Advanced Planning Suite consists of steps for the source, steps for the destination, and steps for Express. Set up steps for Express are covered in Chapter 18, Implementing and Using Oracle Demand Planning.

The following figure is a flowchart illustrating the source and destination setup steps.
Setup Steps for the Source

1. Install the source instance patch

Before beginning the functional setup of the source instance(s), a patch must be applied that will create several new concurrent programs, flexfields, profile options, and database objects on the source database. The patch that is required is determined by the versions of the application and database on the source instance. The current patch requirements are given in the table below.

<table>
<thead>
<tr>
<th>Applications version</th>
<th>RDBMS version</th>
<th>Patch</th>
</tr>
</thead>
<tbody>
<tr>
<td>11</td>
<td>8.x</td>
<td>1238811</td>
</tr>
<tr>
<td>10.7</td>
<td>8.0</td>
<td>1260711</td>
</tr>
<tr>
<td>10.7</td>
<td>7.3</td>
<td>1268507</td>
</tr>
</tbody>
</table>
When successfully applied, the patch should:

- Create the Create Planning Flexfields, Create Global ATP Flexfields, and Refresh Snapshot programs under the All SCP Reports Request group.
- Create several new profile options prefixed by MRP as listed below, and described fully in Appendix A, Profile Options.
  - MRP: ATP Components at Item Level
  - MRP: ATP Database Link
  - MRP: Aggregate resource name flexfield attribute
  - MRP: Check ATP at Bill Level
  - MRP: Check ATP at Item Level
  - MRP: Check CTP at Department Resource Level
  - MRP: Check CTP at Routing Level
  - MRP: Cost of using a BOM/Routing flexfield attribute
  - MRP: Penalty cost factor for exceeding material capacity (Organization) flexfield
  - MRP: Penalty cost factor for exceeding material capacity (Supplier-Item) flexfield
  - MRP: Penalty cost factor for exceeding material capacity flexfield attribute
  - MRP: Penalty cost factor for exceeding resource capacity (Organization) flexfield
  - MRP: Penalty cost factor for exceeding resource capacity (Resource) flexfield
  - MRP: Penalty cost factor for exceeding transportation capacity (Organization)
  - MRP: Penalty cost factor for exceeding transportation capacity flexfield attribute
  - MRP: Penalty cost factor for late demands (Organization) flexfield attribute
  - MRP: Penalty cost factor for late demands flexfield attribute
  - MRP: Penalty cost factor for late forecasts
  - MRP: Penalty cost factor for late sales orders
Setup Steps for the Source

- MRP: Plan Revenue Discount Percent
- MRP: Plan Revenue Price List
- MRP: Principal Resource for operation flexfield attribute
- MRP: Principal resource for an operation flexfield attribute
- MRP: Priority for substitute items flexfield attribute
- MRP: Priority of resources for an operation
- MRP: Resource group for a line flexfield attribute
- MRP: Resource step number flexfield attribute

Create several new database objects that will be used in the data pull process.

2. Create a database link pointing to the planning server.

**Note:** Before beginning the installation of the source patch, count all (if any) invalid database objects. If after the patch is installed there are more invalid objects than before, there was a problem with the patch application.

A database link must be established on the source instance that points to the destination (11i planning) instance. This database link will be referenced in a newly created profile option, MRP: ATP Database Link, discussed in Step 6. This database link will also be used, along with a database link established on the destination instance, in setting up the instances on the planning server.

3. Create an Advanced Supply Chain Planner responsibility.

You must create a responsibility in the source instance that conforms to the following specifications:

Responsibility Name: Advanced Supply Chain Planner
Application: Oracle Manufacturing
Description: Used for running ASCP Report
Menu: SCP_TOP_4.0
Data Group Name: Standard
Application: Oracle Manufacturing
Setup Steps for the Source

Request Group: All SCP Reports
Application: Oracle Master Scheduling/MRP

This responsibility is used to run the concurrent program Refresh Snapshot during all data collection runs. The data collection process is discussed in Chapter 4, Running Collections for ASCP.

---

**WARNING:** The responsibility name must match Advanced Supply Chain Planner exactly. During the data collection process which runs on the destination server, the Refresh Snapshot program is launched automatically in the source from this responsibility. The refresh snapshot process will not complete properly if the responsibility name is not correct.

---

The Create Planning Flexfields concurrent program creates new segment definitions in existing descriptive flexfields to hold data that may be required for constrained and/or optimized planning. The program also populates profile values with the value corresponding to the descriptive flexfield attribute number for each attribute (planning parameter) created. The table below shows the descriptive flexfield attributes that are required, the name of the attributes that are created, the tables in which the data resides, and the profile options that correspond to each attribute.

<table>
<thead>
<tr>
<th>Descriptive Flexfield Names</th>
<th>Parameter Name</th>
<th>Base Table Name</th>
<th>Profile Option Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Items</td>
<td>Late Demands Penalty (Item)</td>
<td>MTL_SYSTEM_ITEMS</td>
<td>MRP: Penalty cost factor for late demands flexfield attribute</td>
</tr>
<tr>
<td>Items</td>
<td>Material Over-Capacity Penalty (Item)</td>
<td>MTL_SYSTEM_ITEMS</td>
<td>MRP: Penalty cost factor for exceeding material capacity flexfield attribute</td>
</tr>
<tr>
<td>Organization Parameters</td>
<td>Late Demands Penalty (Org)</td>
<td>MTL_PARAMETERS</td>
<td>MRP: Penalty cost factor for late demands (Organization) flexfield attribute</td>
</tr>
<tr>
<td>Organization Parameters</td>
<td>Material Over-Capacity Penalty (Org)</td>
<td>MTL_PARAMETERS</td>
<td>MRP: Penalty cost factor for exceeding material capacity (Organization) flexfield attribute</td>
</tr>
<tr>
<td>Descriptive Flexfield Names</td>
<td>Parameter Name (In flexfield form and report parameter)</td>
<td>Base Table Name</td>
<td>Profile Option Name</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>--------------------------------------------------------</td>
<td>-----------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>Organization Parameters</td>
<td>Resource Over-Capacity Penalty (Org)</td>
<td>MTL_PARAMETERS</td>
<td>MRP: Penalty cost factor for exceeding resource capacity (Organization) flexfield</td>
</tr>
<tr>
<td>Organization Parameters</td>
<td>Transport Over-Capacity Penalty (Org)</td>
<td>MTL_PARAMETERS</td>
<td>MRP: Penalty cost factor for exceeding transportation capacity (Organization) flexfield</td>
</tr>
<tr>
<td>Department Resource Information</td>
<td>Aggregate Resources</td>
<td>BOM_DEPARTMENT/Resources</td>
<td>MRP: Aggregate resource name flexfield attribute</td>
</tr>
<tr>
<td>Department Resource Information</td>
<td>Resource Over-Capacity Penalty (Resource)</td>
<td>BOM_DEPARTMENT/Resources</td>
<td>MRP: Penalty cost factor for exceeding resource capacity (Resource) flexfield</td>
</tr>
<tr>
<td>Attribute (Purchasing)</td>
<td>Material Over-Capacity Penalty (Supplier)</td>
<td>PO_ASL_ATTRIBUTES</td>
<td>MRP: Penalty cost factor for exceeding material capacity (Supplier-Item) flexfield</td>
</tr>
<tr>
<td>Substitute Component Information</td>
<td>Substitute Items Priority</td>
<td>BOM_SUBSTITUTE_COMPONENT</td>
<td>MRP: Priority for substitute items flexfield attribute</td>
</tr>
<tr>
<td>MTL Interorg ship methods</td>
<td>Transport Over-Capacity Penalty (Ship Method)</td>
<td>MTL_INTERORG_SHIP/METHOD</td>
<td>MRP: Penalty cost factor for exceeding transportation capacity flexfield attribute</td>
</tr>
<tr>
<td>Bill of Material Information</td>
<td>BOM/Routing Cost</td>
<td>BOM_BILL_OF_MATERIALS</td>
<td>MRP: Cost of using a BOM/Routing flexfield attribute</td>
</tr>
<tr>
<td>MRP Forecast Dates</td>
<td>Late Forecasts</td>
<td>MRP_FORECAST_DATES</td>
<td>MRP: Penalty cost factor for late forecasts</td>
</tr>
<tr>
<td>Additional Line Information</td>
<td>Late Sales Order Penalty</td>
<td>SO_LINES</td>
<td>MRP: Penalty cost factor for late sales orders</td>
</tr>
<tr>
<td>Production Line</td>
<td>Resource Group (Line)</td>
<td>WIP_LINES</td>
<td>MRP: Resource group for a line flexfield attribute</td>
</tr>
</tbody>
</table>

Launch the Create Planning Flexfields report from the newly created Advanced Supply Chain Planner responsibility. The parameters that must be set for the report are the attributes that you wish to utilize for the new flexfield definitions.
The list of values for each parameter lists only the available attributes in the subject descriptive flexfield.

**Note:** Keep track of the attribute number that you select for each flexfield segment. You will need to verify that each corresponding profile option was populated with the correct attribute number when the process completes.

After submitting the program, eleven additional processes should be spawned. These jobs are compiling the descriptive flexfield views.

**WARNING:** Check that the profile values corresponding to each flexfield attribute were populated with the correct attribute number. Some profile values may retain the value of unassigned after the Create Planning Flexfield program completed. You must change any unassigned profiles to the attribute number corresponding to the flexfield attribute where the new segment was defined.

4. Create the Global Order Promising flexfields.

The Create Global ATP Flexfields is very similar to the Create Planning Flexfields program. It creates new flexfield segments to hold global ATP data at the item, BOM, routing, and resource levels. The same process, including warnings and suggestions, applies for the Create Global ATP Flexfield program.

5. Set up source data with BOMs, resources, routings, supplier data, flexfields, purchasing information, item masters, Oracle BIS targets, and any other data required by your plans.

6. Set profile values.

If Global Order Promising is going to be utilized, the following two additional profile options must be set.

The MRP: ATP Database Link profile option must be set with the database link. The profile value is the name of the database link that resides on the source and points to the destination. There is no validation on this profile value. If Global Order Promising is not utilized, this need not be set.
The INV: External ATP profile must be set to Global ATP. This is a choice from the list of values. If Global ATP is not utilized, this need not be set.

7. Execute the Refresh Snapshot concurrent program.
   The Refresh Snapshot process must be run on the source. This concurrent program is available in the Advanced Supply Chain Planner responsibility created earlier. The process has no parameters to be set at run time. Verify that the process completes without error.

Setup Steps for the Destination

1. Install the destination instance patches.
   After installing the 11i application on the destination server, be sure that the proper patches are applied to the install. The patches can be found on Metalink. Query for patches for the following products:
   - msc - Oracle Supply Chain Planning, Oracle Global Order Promising
   - msd - Oracle Demand Planning
   - mso - Oracle Constraint Based Option
   - msr - Oracle Risk Optimization

2. Create a database link pointing to each source.
   These links will be needed when defining instances later on in this setup procedure.

3. Define the source instances to be collected from.
   The define instances setup establishes the means of communication between the source and destination instances. It also specifies the organizations in the source database for which data will be pulled.

4. From the Navigator, choose Setup > Instances.
   The Application Instances window appears.
Enter each of the Application instances for which you would like the Planning Server to plan.

5. Complete the fields and flags in the Applications Instance window as shown in the table below.

Note: You are only required to set up Applications Instances before the first time you perform data collection.

<table>
<thead>
<tr>
<th>Field/Flag</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Instance Code</td>
<td>This is a user-defined 3-character short form for the instance to be planned. It is subsequently prepended by ASCP to organization names and other designators to enable the user to positively identify the owning instance. For example, if two transaction instances TA1 and TA2 are to be planned, and both instances have an internal organization named M1, ASCP will display TA1's organization as TA1:M1 and TA2's organization and TA2:M1.</td>
</tr>
<tr>
<td>Instance Type</td>
<td>The valid values here are Discrete, Process, Discrete and Process. This controls whether discrete manufacturing data or process manufacturing data (or both) are collected from the transaction instance to the planner server for planning.</td>
</tr>
<tr>
<td>Version</td>
<td>The Oracle Application version of the transaction instance.</td>
</tr>
</tbody>
</table>

Figure 2-6  Application Instances

[Image of Application Instances window]

- Instance Code
- Instance Type
- Version
- Application Database Link
- Planning Database Link
6. Enter the organizations on each of the instances from which to collect the Planning data and plan for on the Planning Server by clicking the Organizations button.

The Organization window appears.

<table>
<thead>
<tr>
<th>Field/Flag</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Database Link</td>
<td>A link to connect the Applications database(s) to Oracle ASCP. This link is determined by the database administrator. This database link is defined on the transaction instance and points to the planning server. This link is used to publish releases from the ASCP back to the transaction instance as purchase orders or work orders.</td>
</tr>
<tr>
<td>Planning Database Link</td>
<td>A link to connect Oracle ASCP to the Applications database(s). This link is determined by the database administrator. This link is defined on the planning server and points to the transaction instance. This link is used to positively locate the source of the transaction data to be planned.</td>
</tr>
<tr>
<td>Enable Flag</td>
<td>Select this option to enable the collection process.</td>
</tr>
<tr>
<td>GMT Difference</td>
<td>The difference between instance time zone and GMT</td>
</tr>
<tr>
<td>Assignment Set</td>
<td>Enter the default assignment set for this instance. The assignment is used to resolve sourcing for order promising inquiries.</td>
</tr>
</tbody>
</table>
7. Select the organizations for a particular instance. Be sure to select the master organization.

8. Close the Organization window.

9. Save the Instance Definition setup.
Planning Business Flows

Topics covered in this section include the following:

- Business Flows on page 3-2
- Day in the Life of a Planner on page 3-5
- Specify Sources of Demand on page 3-5
- Run Collections on page 3-6
- Create a Plan on page 3-6
- Launch the Plan on page 3-6
- Review Key Performance Indicators (KPIs) on page 3-7
- Review Exceptions on page 3-7
- Review Workflow Notifications on page 3-8
- View Pegged Supply and Demand on page 3-9
- Modify Objectives on page 3-10
- Modify Supply/Demand on page 3-11
- Modify Resources on page 3-11
- Modify Supplier Parameters on page 3-12
- Run Net-Change on page 3-12
- Release or Firm Orders on page 3-13
Business Flows

This section describes the flows of information between the components of the Oracle Advanced Planning Suite and provides an overview of how these components are to be used together in order to accomplish several key business flows.

Topics covered in this section include the following:

- APS Information Flows
- The Demand-to-Make / Demand-to-Buy Business Flow
- The Inquiry-to-Order Business Flow

APS Information Flows

The major information flows between the components of the Oracle Advanced Planning Suite and the rest of Oracle Applications are shown in the figure below.
The Demand-to-Make / Demand-to-Buy Business Flow

The demand-to-make / demand-to-buy business flow begins with the establishment of independent demands that will drive the activities of the supply chain.

On the basis of sales history from Oracle Order Management, Oracle Demand Planning generates statistical demand forecasts. After adjustment by planners, these forecasts are then input into Oracle Risk Optimization.
Using user-supplied information about the variability of this forecast demand and the variability of supplier lead times, Oracle Risk Optimization generates an optimal time-phased safety stock plan.

Oracle Advanced Supply Chain Planning (hereafter, Oracle ASCP) considers three streams of independent demand: the safety stock planned demand from Oracle Risk Optimization, forecasts from Oracle Demand Planning, and sales order demand from Oracle Order Management. Oracle ASCP outputs a time-phased supply plan (planned orders) that can then be released directly to the appropriate execution systems: Oracle Purchasing, Oracle Work in Process (for discrete manufacturing), Oracle Process Manufacturing, Oracle Flow Manufacturing, Oracle Project Manufacturing, or Oracle Shop Floor Management (for semi-conductor manufacturing).

The Inquiry-to-Order Business Flow

The demand/supply picture output by Oracle ASCP serves as the basis for the order promising results calculated by Oracle Global Order Promising. Oracle Global Order Promising can be called either from a customer-facing order capture application such as a web store or from Oracle Order Management.

In the inquiry-to-order business flow, an inquiry for a potential order is sent from Oracle Order Management to Oracle Global Order Promising. The fulfillment date returned by Global Order Promising, if later than the original request date, is populated as the new request date of the order. This request date validation process is called scheduling. Once an order is successfully scheduled, then it can be booked and made visible to Oracle ASCP for supply planning purposes.
Day in the Life of a Planner

This section describes an end-to-end planning flow that a planner might perform during the course of a planning cycle. The flow demonstrates the key features of Oracle ASCP that a typical planner would use in the course of his or her work.

The general flow that occurs during a planning cycle is shown in the figure below.

Figure 3–1  A Day in the Life of a Planner:

Specify Sources of Demand

To specify sources of demand:

1. Load the adjusted (unconstrained) forecasts into a Master Demand Schedule (MDS) for use by Oracle ASCP.

Note: You can generate forecasts using Oracle Master Scheduling/MRP and Oracle Supply Chain Planning, or Oracle Demand Planning. If you generate a forecast using Oracle Demand Planning, you do not have to load an MDS or run collections. The forecast is available directly to Oracle ASCP on the APS Planner Server.

2. Choose MDS > Names to create the name of a new MDS or to use an existing MDS.

3. Choose MDS > Source List to associate individual forecasts with your MDS.
4. Individual forecasts for customers, sales regions, and so on, can be loaded into a single MDS so that all designated forecasts can be planned at once.

5. Choose MDS > Load-Copy-Merge to load merge your new or updated MDS with another MDS.

If you are using basic forecasting and MDS functionality found in Oracle Master Scheduling/MRP and Oracle Supply Chain Planning, see “Overview of Forecasting” in the Oracle Master Scheduling/MRP and Oracle Supply Chain Planning User’s Guide. If you are using Oracle Demand Planning, see the Oracle Demand Planning User’s Guide.

Run Collections

Run collections to bring planning data from the source instance to the planning server, where the data will be accessible to Oracle ASCP. See “Chapter 4, Running Collections for ASCP” for more information.

Create a Plan

After an MDS has been defined, a Production, Manufacturing, or Distribution plan/schedule can be created.

To create a plan:
1. Choose [Production, Manufacturing, or Distribution Plan] > Names to create a new plan/schedule or modify an existing plan/schedule.
2. Click the Plan Options button to specify plan options.
3. Click the Plan Organizations button to specify organizations to be planned.
4. Load MDS plans in the Demand Schedules section of the Plan Organizations window.
5. Save your work.

See Chapter 5, "Defining Plans" for more information.

Launch the Plan

After you have created your MRP, MPS, or DRP plan/schedule and saved it, choose the plan from [Production, Manufacturing, or Distribution Plan] > Names and click the Launch Plan button.
You can view the run status of your plan by choosing [Production, Manufacturing, or Distribution Plan] > View > Requests.

**Review Key Performance Indicators (KPIs)**

Once your new plan has completed running, you can evaluate the performance of the plan by comparing it to Key Performance Indicators (KPIs). Evaluating a plan based on its impact to KPIs is a good way to see the high level impact of the plan without doing off-line analysis and looking at plan details to see which demand is fulfilled on time and which is not.

The Key Indicators compare actual plan values to target values defined in the Target Repository. Evaluating plans against KPIs lets you select the plan which best meets organizational objectives that you have defined.

You can drill down to the trend over time using the right-mouse menu.

▶️ **To review KPIs for a plan:**

1. Navigate to the Planner Workbench.
2. Choose either the Organizations tab or the Items tab in the left pane.
3. Select the Key Performance Indicators tab in the right pane.
4. In the left panel, select the plan you want to evaluate or the plans you want to compare.
5. View the results on the graphs in the right panel.


**Review Exceptions**

After you have evaluated your plan(s) based on KPIs, you can evaluate a plan based on the number and types of exceptions it generates. Reviewing the exceptions generated by a plan lets you evaluate a plan’s performance in more detail than a KPI comparison provides. For each exception type displayed in the Planner Workbench, you can click and drill down on an exception to get more detailed information about the nature of the exception.

Oracle ASCP provides a range of exception messages for all plans. You can easily manage your plan by displaying only those items and orders that require your attention, and you can further narrow your search using other criteria such as by
buyer or by line. By saving the exception messages each time you replan simulations, you can compare different versions of the same plan or analyze the strengths and weaknesses of a single plan.

For guidelines on evaluating and interpreting the exceptions generated by your plan, see Chapter 9, “Performance Management.”

➢ **To review exceptions for a plan:**

1. Navigate to the Planner Workbench.
2. Choose the Organizations or Items tab in the left pane and select the plan(s) for which you want to view exceptions.
3. Choose the Actions tab on the right portion of the window. Exceptions are displayed by exception type on the top portion of the window. Exception counts can be viewed graphically at the bottom of the window.
4. Double click on an exception to drill down to detail.

Refer to Chapter 9, “Performance Management” for more information.

**Review Workflow Notifications**

Oracle ASCP’s powerful collaboration features enable you to automate and streamline your interactions with customers and suppliers.

You can automate the processing of exceptions which lets you take corrective action more quickly and efficiently, driving overhead costs out of your process.

You can define the process that a Workflow Notification should follow which includes the routing for the exception notifications, actions available to the recipient of the notifications, and the approval steps. The messages can be viewed either in Applications (see on page 3-7, "Review Exceptions") or via e-mail. Certain response actions may be required.

---

**Note:** Oracle ASCP comes with five standard workflow processes which generate various types of exceptions, which is shown in the table below.
Table 3–1

<table>
<thead>
<tr>
<th>Process</th>
<th>Exception Types</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item Workflow</td>
<td>• Item is over committed</td>
</tr>
<tr>
<td></td>
<td>• Item has a shortage</td>
</tr>
<tr>
<td></td>
<td>• Item has excess inventory</td>
</tr>
<tr>
<td></td>
<td>• Items with expired lots</td>
</tr>
<tr>
<td></td>
<td>• Past due forecast</td>
</tr>
<tr>
<td></td>
<td>• Late supply pegged to a forecast</td>
</tr>
<tr>
<td></td>
<td>• Items below safety stock</td>
</tr>
<tr>
<td>Rescheduling Workflow</td>
<td>• Item has orders to be rescheduled in</td>
</tr>
<tr>
<td></td>
<td>• Item has orders to be rescheduled out</td>
</tr>
<tr>
<td></td>
<td>• Item has orders to be cancelled</td>
</tr>
<tr>
<td></td>
<td>• Item has orders with compression days</td>
</tr>
<tr>
<td></td>
<td>• Item has past due orders</td>
</tr>
<tr>
<td>Sales Order Workflow</td>
<td>• Past due sales orders</td>
</tr>
<tr>
<td></td>
<td>• Late supply pegged to a sales order</td>
</tr>
<tr>
<td>Project Workflow</td>
<td>• Items with shortage in a project</td>
</tr>
<tr>
<td></td>
<td>• Items with excess in a project</td>
</tr>
<tr>
<td></td>
<td>• Items allocated across projects</td>
</tr>
<tr>
<td>Material Workflow</td>
<td>• Material constraint (supplier capacity constraint)</td>
</tr>
</tbody>
</table>

See the Oracle Workflow Guide for more information on creating notifications and building new workflows.

**View Pegged Supply and Demand**

You can easily analyze the impact of changing a supply or demand order at any level of your bill of material using the powerful graphical pegging feature. Full pegging traces supply information for an item to its corresponding end demand details. Full pegging can also link a demand order to all corresponding supply. You can trace a purchased item or subassembly shortage to the sales order that would be affected. You can use this information to prioritize critical material and capacity resources.
To use graphical pegging you must select Pegging in the Plan Options window. You must also have the Pegging item attribute (in Oracle Inventory) set to one of the pegging options.


Modify Objectives

If you are unsatisfied with the results of your plan, you may wish to change your optimization objectives to improve the plan’s performance against KPIs or reduce the number of exceptions.

Available Supply Chain Optimization objectives are:

- Maximize Inventory Turns
- Maximize Plan Profit
- Maximize On-time Delivery

To run an optimized plan:

Choose [Production, Manufacturing, or Distribution Plan] > Plan Options > Optimization tab to select a baseline plan and adjust optimization objectives or associated penalty costs.

Once you have changed objectives, you can run a new, separate plan, or you can run a simulation in net change mode to view only the differences between the baseline plan and the simulated plan.


Alternatively, you may evaluate your plan or check feasibility based on available material and resources by running an unconstrained plan.

To run an unconstrained plan:

Replace first sentence with:

2. Choose the Aggregation tab and check Enforce Demand Due Dates.
3. Check Plan Capacity.
4. Select No for the material and resource constraint settings.

5. In the Optimization tab, uncheck Optimization.

Once you have made the change you can run a new, separate plan, or you can run a simulation in net change model to view only the differences between the baseline plan and the simulated plan.

See Chapter 8, "Optimization" and Chapter 7, "Simulations" for additional information.

Modify Supply/Demand

After you have run additional plans or simulations based on changes to your optimization objectives, you may still be unsatisfied with the results of your plans.

At this point, you may wish to consider the impact to changing demand and supply levels. You can quickly and easily simulate the impact of changes in inventory, purchase order schedules, and product demand. Changes to demand can be performed directly in your MDS or to individual forecasts associated with your MDS. Changes to supply may consist of changes to material availability (for example, supplier capacity) or to resource availability. You can make changes to either capacity or materials and see the effects of these changes on your plan.

To modify demand/supply:

1. Navigate to the Planner Workbench.
3. Select the Supply/Demand you want to change from the list of values.
4. Make the desired changes and close the window.

Modify Resources

To increase available supply, you may wish to modify resource availability.

There are a number of ways in which to modify resources:

- Add additional production resources (for example, add shifts).
- Define alternate resources available for producing particular items.
- Change the resource consumption for an item (for example, change the amount of an item that can be produced in a given amount of time).
To modify resources:
1. Navigate to the Planner Workbench.
2. Choose Tools > Resources.
3. Make the desired changes and close the window.

Modify Supplier Parameters
At this point you might choose to modify supply parameters such as Supplier Capacity, Supplier Order Modifier, and Supplier Tolerance Fence. For more information see Chapter 6, “Supply Chain Modeling.”

Run Net Change
After you have changed optimization objectives, demand, supply or resources, you can run simulated plans in net-change mode to view only the differences of the simulated plan compared to a baseline plan.

Net-change is used for:
- changes in item supply and demand, resource availability
- changes in your objectives
- changes to demand priority rules
- changes to sourcing
- changes to BOM/Routing effectivity

See on page 7-5, “Running Net Change Replan Simulations“ for more information.

Review a Constrained Forecast that Results from Net Change Planning
The forecast or MDS that is loaded into an MRP, MPS, or DRP plan/schedule is generally a prediction of total customer demand, regardless of your company’s ability to produce the demand.

After an MRP, MPS, or DRP plan/schedule has been run based on an unconstrained forecast/MDS as an input, the resulting plan that has been constrained by material and resource availability is a demand plan constrained by production capabilities.

The easiest way to view the differences between an unconstrained demand plan and a constrained demand plan is to view the exceptions that occur after the
Production, Manufacturing, or Distribution Plan is run with material and resource constraints set to Yes in plan options.

The exception set Late forecast for customer demand will show all demand that could not be met due to material and resource limitations.

An alternate way to compare an unconstrained demand plan to a constrained plan is to run your MRP, MPS, or DRP once with material and resource constraints set to No in plan options and run a second plan with material and resource constraints set to Yes. The two plans can then be compared side by side via KPI comparisons or exception comparisons.

**Release or Firm Orders**

- To release or firm orders:
  1. From the Planner Workbench, choose Tools > Supply/Demand.
  2. In the Order tab, choose an organization and an item then choose to release or firm orders for that organization or item.

You can also redefine release properties for the organization or item.
Running Collections for ASCP

Topics covered in this section include the following:

- Overview of Running Collections on page 4-2
- Definitions on page 4-2
- Collection Strategy on page 4-3
- Architecture on page 4-5
- Running Collection Steps on page 4-10
- Data Changes That Can Be Collected in Net Change Mode on page 4-15

A Day in the Life of a Planner

1. General Updates: forecast, create new MDS
2. Perform setup, run data collection, set up supply chain
3. Set plan options and other planning parameters
4. Create material and capacity plan
5. Launch plan, evaluate plan performance, and respond to recommendations
6. Maintain relationships with customers and suppliers
7. Select orders and release to production
8. Run simulations to compare scenarios to baseline plan

Running Collections for ASCP 4-1
Overview of Running Collections

Oracle ASCP has a component architecture that allows a single instance of Oracle ASCP to plan one or more transaction instances. The transaction instances can be a mixture of Oracle 10.7, Oracle 11, and Oracle 11i instances. The Oracle ASCP planning instance (referred to as the planning server) can sit on the same instance as one of the transaction instances, or be a separate instance altogether. In either case (even if the planning server shares an instance with the transaction instance to be planned), data to be planned is brought from the transaction instance(s) to the planning server via a process called Collection.

This section describes the architecture used in the collection of planning data from multiple operational sources into Oracle ASCP. These sources could be different versions/instances of Oracle Applications or other legacy systems. Oracle ASCP uses a data store based on the planning data model that is exposed through interface tables. The data is pulled from the designated data sources into its data store; Oracle ASCP Collections are responsible for synchronization as changes are made to the data sources. The configurability of the collections is enabled through a pull program based on AOL concurrent program architecture. Thus, for example, different business objects can be collected at different frequencies. Supplies and demands, which change frequently, can be collected frequently. Routings and resources, which change relatively less often, can be collected less frequently.

The data collection process consists of the Data Pull and the Operational Data Store (ODS) Load. The collection process lets you collect across Oracle Application Versions 10.7 or higher. It supports several configurations. You can run complete or incremental refresh. You can also choose the frequency of refresh.

Definitions

You should be familiar with the following terms before examining the data collections architecture:

**Oracle Applications Data Store (ADS)** The set of source data tables in each transaction instance that contain data relevant to planning.

**Operational Data Store (ODS)** The planning data tables in the planning server that act as destination for the collected data from each of the data sources (both ADS and Legacy).

**Planning Data Store (PDS)** The outputs of the planning process. The PDS resides in the same data tables as the ODS. However, PDS data are marked with plan IDs that
show which plans they correspond to, while ODS data are marked with plan ID = -1.

Data Collection  Data collection consists of the following:

- **Pull program**
  Collects the data from the ADS and stores the data into the staging tables. This pull program is a registered AOL concurrent program that could be scheduled and launched by a system administrator. If you are using a legacy program, you must write your own pull program.

- **ODS Load**
  A PL/SQL program which performs the data transform and moves the data from the staging tables to the ODS. This collection program is a registered AOL concurrent program that could be scheduled and launched by the system administrator.

Collection Workbench  The Collection Workbench is a user interface for viewing data collected over to the planning server from the transaction instances. The functionality here is similar to Planner Workbench functionality. For more information on the Planner Workbench, see Chapter 10, "Planner Workbench/User Interface."

Collection Strategy
Major features of the collection process include:

- Multiple Source Instances
- Pull Architecture
- Detect Net Changes to Synchronize Oracle Applications and Oracle ASCP
- Multi-Process Collection Architecture
- Data Consolidation
- Projects/Tasks, and Seiban Numbers
- Support for several Oracle Applications Versions and RDBMS Versions
- Support for Several Configurations
Multiple Source Instances

You can register any number of source data instances and non-Oracle data sources on each Oracle ASCP installation.

Pull Architecture

You can collect new source data instances into Oracle ASCP with minimal impact. The data is pulled from the source data instance by Oracle ASCP. Each instance can have its own refresh interval. A failure in one instance will not affect data collections from other instances.

Detect Net Change to Synchronize Oracle Applications and Oracle ASCP

You can synchronize the data in Oracle Applications transaction instances and the Oracle ASCP planning server in a net change mode. Thus, only the changed source data is collected each time, reducing the computational burden on the collection process.

Multi-Process Collection Architecture

You can enhance the performance of the pull program by distributing the tasks to multiple collection workers.

Data Consolidation

The collection program can consolidate the entities shown in the following table across instances based on the corresponding user-defined keys.

<table>
<thead>
<tr>
<th>Entity</th>
<th>User Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>MTL_SYSTEM_ITEMS</td>
<td>Concatenated Item Segments</td>
</tr>
<tr>
<td>MTL_CATEGORIES</td>
<td>Concatenated Category Name</td>
</tr>
<tr>
<td>MTL_CATEGORY_SETS</td>
<td>Category Set Name</td>
</tr>
<tr>
<td>PO_VENDORS</td>
<td>Vendor Name</td>
</tr>
<tr>
<td>PO_VENDOR_SITES</td>
<td>Vendor Site Code</td>
</tr>
<tr>
<td>RA_CUSTOMERS</td>
<td>Customer Name</td>
</tr>
</tbody>
</table>
For all the entities not described in the table, the instance ID together with the entity key in each instance uniquely identifies each row.

Projects/Tasks, and Seiban Numbers

You can consider Projects, Tasks, and Seiban Numbers to be unique within the context of an Oracle Applications instance; no consolidation is required.

Oracle Applications Version and RDBMS Version

You can plan across Oracle Applications version 10.7 or higher. The following table shows you which version of the RDBMS supports which version of Oracle Applications.

<table>
<thead>
<tr>
<th>Version of Oracle Applications</th>
<th>Version of RDBMS</th>
</tr>
</thead>
<tbody>
<tr>
<td>10.7</td>
<td>8.0 and 8i</td>
</tr>
<tr>
<td>11.0</td>
<td>8.0 and 8i</td>
</tr>
<tr>
<td>11i</td>
<td>8i</td>
</tr>
</tbody>
</table>

Support for Several Configurations

You can perform centralized and decentralized configurations based on the scale of the enterprise and specific business needs. Source data applications and Oracle ASCP can reside on one server or on separate servers.

Architecture

Oracle ASCP’s data collection architecture, shown in the figure below, depicts the data objects, procedures, and data flow between source data and Oracle ASCP. The major repositories are ADS, ODS, and PDS. Procedures enable data cleansing, data
collecting, data communication, and net-change handling between data repositories.

When Oracle ASCP and its source data reside on the same instance, communication between them is enabled by PL/SQL based public API procedures or interface tables. In a distributed environment, procedure calls are made using database links.

*Data Collections Architecture*
**Supported Configurations**

Oracle ASCP supports the following configurations for installation and deployment.

- centralized planning
- decentralized planning

These configurations offer you enough flexibility to design a mode of planning that suits your business objectives. Both configurations are supported using a consistent architecture as outlined in the previous section. The sole distinction is that centralized planning uses database links to pull data into the Oracle ASCP data store.

**Centralized Planning**

The following figure shows the centralized planning configuration:

![Centralized Planning Diagram](image)

Oracle ASCP works as a central Planning Server across several source data instances. The collection program is installed on the planning server and the data stripped by instance_id is moved into staging tables within Oracle ASCP during the data collection process.

After the planning process, results can be pushed back to each instance.
Decentralized Planning

The following figure shows the decentralized planning configuration:

Oracle ASCP and its source data reside in the same database. No database link is required in this case. Two components can communicate through the planning object APIs and the interface tables defined in Oracle Applications.

In this configuration, shown in the following figure, a simplified architecture is used, and the data transformation is not required.
Simplified Data Collections Architecture

Oracle Applications

Planning Component

Planning

GUI

ADS

Pull Program

- Snapshot

Staging Tables

Data Cleansing

OOS Load

- ID transformation

Data Purging

Error Log

Outbound API

- Data Transformation

- Push Data to ADS

Callback API/
Interface Tables

Running Collections for ASCP
To run collections:
1. Sign in as Advanced Supply Chain Planner.
2. From the Navigator, choose Collection > Data Collection.
   The Planning Data Collection window appears. When you try to enter Data Pull parameters, the Data Pull Parameters window appears.

The Data Pull Parameters Window

3. Set up parameters in the Data Pull Parameters window.
### Table 4–3

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Instance</td>
<td>Source instance code from list of values.</td>
</tr>
<tr>
<td>Complete Refresh</td>
<td>Select Yes for a complete refresh, No for an incremental refresh (net change mode). Complete refresh collects all data. Incremental Refresh collects only the incremental changes in the transactional data since the most recent refresh. Default is Yes.</td>
</tr>
<tr>
<td>Complete Refresh Sales Order</td>
<td>Select Yes if you want to collect your sales orders. Default is No.</td>
</tr>
<tr>
<td>Number of Workers</td>
<td>One or more, this could be increased to improve performance (parallel process).</td>
</tr>
<tr>
<td>Timeout (minutes)</td>
<td>Enter the number of minutes you think it will take to complete the refresh snapshot at the source</td>
</tr>
<tr>
<td>Language</td>
<td>List of values</td>
</tr>
<tr>
<td>Pull Items</td>
<td>Yes or No (default is Yes)</td>
</tr>
<tr>
<td>Pull Suppliers</td>
<td>Yes or No (default is Yes)</td>
</tr>
<tr>
<td>Pull Customers</td>
<td>Yes or No (default is Yes)</td>
</tr>
<tr>
<td>Pull BOM/Routing</td>
<td>Yes or No (default is Yes)</td>
</tr>
<tr>
<td>Pull Reservations</td>
<td>Yes or No (default is Yes)</td>
</tr>
<tr>
<td>Pull Sourcing Rules</td>
<td>Yes or No (default is Yes)</td>
</tr>
<tr>
<td>Pull Work in Process</td>
<td>Yes or No (default is Yes)</td>
</tr>
<tr>
<td>Pull Safety Stock</td>
<td>Yes or No (default is Yes)</td>
</tr>
<tr>
<td>Pull Purchasing Supply</td>
<td>Yes or No (default is Yes)</td>
</tr>
<tr>
<td>Pull On Hand</td>
<td>Yes or No (default is Yes)</td>
</tr>
<tr>
<td>Pull Approved Supplier List</td>
<td>Yes or No (default is Yes)</td>
</tr>
<tr>
<td>Pull UOM</td>
<td>Yes or No (default is Yes)</td>
</tr>
<tr>
<td>Pull MDS</td>
<td>Yes or No (default is Yes)</td>
</tr>
<tr>
<td>Pull Forecast</td>
<td>Yes or No (default is Yes)</td>
</tr>
<tr>
<td>Pull MPS</td>
<td>Yes or No (default is Yes)</td>
</tr>
</tbody>
</table>
4. Click OK.

When you try to enter ODS Load parameters, the Parameters window appears.

**The Parameters Window**

5. Set up parameters in the ODS Load Parameters window.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recalculate Net Resource Availability (NRA)</td>
<td>Set to Yes when adding additional capacity to existing resource/WIP line in the source Instance, or when adding new resource/WIP line to source Instance; set to No when there is no change to resource(s) in source Instance. Defaults to Yes.</td>
</tr>
<tr>
<td>Recalculate Sourcing History</td>
<td>Recalculates sourcing history based on the previous assignment of orders to various sources. Defaults to Yes.</td>
</tr>
<tr>
<td>Analyze Tables</td>
<td>Yes or No (default is set to No). If you select Yes, statistics are computed on staging tables.</td>
</tr>
</tbody>
</table>
Running Collections Steps

Table 4–4

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Instance</td>
<td>Source instance code from list of values.</td>
</tr>
<tr>
<td>Number of Workers</td>
<td>Number of workers</td>
</tr>
<tr>
<td>Recalculate Net Resource Availability (NRA)</td>
<td>Set to Yes when adding additional capacity to existing resource/WIP line in the source Instance, or when adding new resource/WIP line to source Instance; set to No when there is no change to resource(s) in source Instance. Defaults to Yes.</td>
</tr>
<tr>
<td>Recalculate Sourcing History</td>
<td>Recalculates sourcing history based on the previous assignment of orders to various sources. Defaults to Yes.</td>
</tr>
</tbody>
</table>

6. Click on the Schedule button to open the Schedule window.

**Note:** If you want to perform an incremental refresh frequently, use this feature.
You have complete control over the timing and frequency of the collection of data from the transaction systems, as well as the timing and frequency of planning. You can manage the balance between network traffic and the need to monitor current status in your plans.

7. Select a frequency for running the job in the left pane. Complete any additional fields that appear based on your selection.

8. Click OK.

9. Choose Submit in the Planning Data Collection window.

10. From the toolbar, choose View > Requests to view the status of the collection process.

   The Find Requests window displays.
11. Select a type of requests to view then select Find.

The Requests Window displays data collection progress.

**Note:** Data cleansing is sometimes performed between the data pull and ODS load. Oracle provides some basic ID transformation for data cleansing. You can add data cleansing tools/programs to modify data in the staging tables to address your needs.

12. After the collection process completes, view your results.
13. From the Navigator window, choose Collection > Workbench.

**The Collection Workbench**

Notice that data is brought over from selected instances.

**Data Changes That Can Be Collected in Net Change Mode**

When the net change mode for collections is selected (by setting the collections parameter Complete Refresh to No), the data changes shown in the following table can be collected. All other data changes must be collected by running full
collections (by setting the collections parameter Complete Refresh to Yes). Net change collections run more quickly than full collections.

**Table 4–5**

<table>
<thead>
<tr>
<th>Data Element</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sales orders</td>
<td>Cancellations of or modifications to sales orders are captured. The Pull Sales Orders collections parameter must be set to Yes.</td>
</tr>
<tr>
<td>Reservations against demands</td>
<td>Reservations against both external and internal sales order demands are captured. The Pull Reservations collections parameter must be set to Yes.</td>
</tr>
<tr>
<td>Master production schedule demands</td>
<td>MPS demands that are added, modified or relieved in the source instance are captured. The Pull MPS collections parameter must be set to Yes.</td>
</tr>
<tr>
<td>Master demand schedule</td>
<td>The Pull MDS collections parameter must be set to Yes.</td>
</tr>
<tr>
<td>WIP component demands</td>
<td>Demand changes due to cancellation of WIP jobs, changes in the state of WIP jobs (for example, operations within a job have been performed or cancelled), and changes to WIP jobs because of changes in item information are captured. The Pull WIP collections parameter must be set to Yes.</td>
</tr>
<tr>
<td>WIP repetitive item demands</td>
<td>Demand changes due to cancellation of WIP repetitive schedules, changes in the state of WIP repetitive schedules, and changes to WIP repetitive schedules because of changes in item information are captured. The Pull WIP collections parameter must be set to Yes.</td>
</tr>
<tr>
<td>Forecast demands</td>
<td>Changes and deletions in forecasts are captured. The Pull Forecast collections parameter must be set to Yes.</td>
</tr>
<tr>
<td>User demands</td>
<td>Changes to user demands because of changes to item information are captured.</td>
</tr>
<tr>
<td>Master production schedule supplies</td>
<td>Changes in supply schedules or item information are captured. The Pull MPS collections parameter must be set to Yes.</td>
</tr>
<tr>
<td>User supplies</td>
<td>Changes to user supplies because of changes to item information are captured.</td>
</tr>
<tr>
<td>Purchase order supplies</td>
<td>Changes to PO supplies because of rejections, returns, or cancellations or changes to item information are captured. The collections parameter Pull PO collections parameter must be set to Yes.</td>
</tr>
</tbody>
</table>
Data Changes That Can Be Collected in Net Change Mode

On-hand supplies
The Pull On Hand collections parameter must be set to Yes.

Changes in WIP Jobs are captured. The Pull WIP collections parameter must be set to Yes.

Changes in WIP Jobs are captured. The Pull WIP collections parameter must be set to Yes.

The Recalculate NRA collections parameter must be set to Yes.

The Pull Supplier Capacity collections parameter must be set to Yes.

All BOM changes are captured: new components, disabled components, component quantities, effectivity dates, BOM revisions, and component substitutes. The Pull BOM/Routing collections parameter must be set to Yes.

Changes to and deletions of routing operations as a result of changes to operation sequences (for example, the addition of new operations, the disabling of operations, or the changing of operation dates), the disabling of a routing, the changing of routing dates, or changes to item information (for example, the disabling of an item, the creation of a new item) are captured. The Pull/BOM Routing collections parameter must be set to Yes.

Changes to and deletions of components needed for a routing operation are captured. The Pull BOM/Routing collections parameter must be set to Yes.

Changes to and deletions of operation resources or operation resource sequences within a routing are captured. The Pull BOM/Routing collections parameter must be set to Yes.

Changes in resource requirements of WIP jobs because of completion of the WIP jobs, completion of operations within the WIP jobs, or changes in item information are captured. The Pull WIP collections parameter must be set to Yes.

### Table 4–5

<table>
<thead>
<tr>
<th>Data Element</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>On-hand supplies</td>
<td>The Pull On Hand collections parameter must be set to Yes.</td>
</tr>
<tr>
<td>Work orders in Oracle Work in Process</td>
<td>Changes in WIP Jobs are captured. The Pull WIP collections parameter must be set to Yes.</td>
</tr>
<tr>
<td>Resource availability</td>
<td>The Recalculate NRA collections parameter must be set to Yes.</td>
</tr>
<tr>
<td>Supplier capacity</td>
<td>The Pull Supplier Capacity collections parameter must be set to Yes.</td>
</tr>
<tr>
<td>Bills of material</td>
<td>All BOM changes are captured: new components, disabled components, component quantities, effectivity dates, BOM revisions, and component substitutes. The Pull BOM/Routing collections parameter must be set to Yes.</td>
</tr>
<tr>
<td>Routing operations</td>
<td>Changes to and deletions of routing operations as a result of changes to operation sequences (for example, the addition of new operations, the disabling of operations, or the changing of operation dates), the disabling of a routing, the changing of routing dates, or changes to item information (for example, the disabling of an item, the creation of a new item) are captured. The Pull/BOM Routing collections parameter must be set to Yes.</td>
</tr>
<tr>
<td>Components needed for a routing operation</td>
<td>Changes to and deletions of components needed for a routing operation are captured. The Pull BOM/Routing collections parameter must be set to Yes.</td>
</tr>
<tr>
<td>Resources attached to a routing operation</td>
<td>Changes to and deletions of operation resources or operation resource sequences within a routing are captured. The Pull BOM/Routing collections parameter must be set to Yes.</td>
</tr>
<tr>
<td>Resource requirements for WIP jobs</td>
<td>Changes in resource requirements of WIP jobs because of completion of the WIP jobs, completion of operations within the WIP jobs, or changes in item information are captured. The Pull WIP collections parameter must be set to Yes.</td>
</tr>
</tbody>
</table>
Topics covered in this section include the following:

- Overview of Defining Plans on page 5-2
- Global Supply Chain Planning on page 5-2
- Subset Plans on page 5-6
- Choosing Between Global Supply Chain and Subset Plans on page 5-9
- Choosing A Plan Type on page 5-11
- Choosing Plan Classes on page 5-15
- Setting Plan Options on page 5-18
- Choosing Aggregation Levels on page 5-32
- Choosing an Objective Function on page 5-38

A Day in the Life of a Planner
Overview of Defining Plans

This section describes features that help you select a plan type that best satisfies your business requirements. You can choose to run a global supply chain plan or a subset plan to suit your supply chain environment or single organization environment, respectively. You can also select constrained, unconstrained, or optimized plan class based on business objectives such as maximizing inventory turns, ontime delivery, and plan profit. You can select to run a Production, Manufacturing, or Distribution plan to fulfill your planning needs. Lastly, you can specify aggregation levels to view plans at varying levels of detail.

Global Supply Chain Planning

Oracle ASCP can generate planned orders for an entire supply chain within a single multiorganization supply chain plan. This is illustrated below with a sample supply chain (Figure 5–1, “Sample Supply Chain”) and bill of material (Figure 5–2, “Sample Bill of Material”).

Figure 5–1 Sample Supply Chain
In this sample supply chain, SF1 and SF2 are subassembly facilities, AF1 is a final assembly facility, DC1 and DC2 are distribution centers, C1, C2, C3 and C4 are customers and S1, S2, S3 and S4 are suppliers.

A single plan of the entire supply chain has the following inputs:

- Demand quantity (forecast + actual sales orders) for A01 at DC1 for each of the time buckets in the planning horizon. This is captured in a Master Demand Schedule (MDS) for DC1.
- Demand quantity for A01 at DC2 for each of the time buckets in the planning horizon. This is captured in an MDS for DC2.

The plan output contains planned order quantities, start dates, and completion dates for A01 and all of its components and subcomponents.

**Prerequisites for Running a Global Supply Chain Plan**

In order to run a global supply chain plan, the following prerequisites are required:

- Each planned organization must be set up on the source instance.
- Collection programs must be directed to collect data from the transactional instance of each planned organization.
- Items to be planned must be enabled in each organization that can produce (or distribute) the item. During item setup, items can be enabled in all organizations or only in specific organizations.
- Routings and/or Bills of Resource for each planned item must exist or be enabled in each organization that is planned centrally.
- Suppliers and sourcing rules must be enabled in all relevant organizations.
Advantages of the Single Plan

The single-plan approach is advantageous for the following reasons:

- **Least planning effort.** Fewer plans need to be generated; fewer planning servers need to be deployed and maintained.

- **Data consistency.** Without the single-plan ability, requirements must be repeatedly transferred upstream within the supply chain to each successive supplier facility. Each transfer presents an opportunity for miscommunication or data loss.

- **Global optimization.** Intelligent tradeoffs between the performance of individual facilities (as measured by, for example, plan profit) can be made because Oracle ASCP optimizes the supply chain planned orders as a whole.

- **Minimum communication lag:**
  
  The effects of decisions made at the highest level of the supply chain are immediately visible at the lowest level of the supply chain. If individual facility plans are used, there is at least a one planning-run duration lag between the receipt of requirements at a facility and the passing of the dependent requirements to the facility’s suppliers. Moreover, this lag is often much greater due to differences in working hours between upstream and downstream facilities (for example, if the facilities are in different time zones). Also, the planning cycles of upstream and downstream facilities may not be in sync (for example, customer facility AF1 runs its plan on Monday, while supplier facility SF1 runs its plan on Sunday). This results in even longer communication lags.

  The overall effect of plan communication lag is to make the supply chain less responsive to meeting changes in customer demand.

To create and launch a global supply chain plan:

   
   The [Production, Manufacturing, or Distribution Plan] Names window appears.
2. Select the organizations (multiple) to be included in the plan, and click the Options button.

The Plan Options window appears.

3. Continue setting plan options and parameters.
Subset Plans

Figure 5–4  The Plan Options window, Options tab

There are some situations in which it makes sense to plan a portion of the supply chain separately, outside of the overall supply chain DRP plan.

Scenario 1: Unique Local Objectives Must be Respected Along with Global Objectives  Suppose that subassembly plant SF1 (Figure 5–1, “Sample Supply Chain”), which makes M12 (Figure 5–2, “Sample Bill of Material”), contains very expensive capital equipment. SF1 is the overall supply chain constraint, so every minute that its resources are utilized brings extra profits to the enterprise. Resource utilization is the most important objective for SF1. For the supply chain as a whole, however, due to rapid product life cycles and a fickle market, inventory turns might be the most important objective. In this situation you could run a two-stage planning process.

- An MRP for organization SF1 with resource utilization as the objective to generate planned orders for M11, M22, B31, and B21 (the portion required at SF1).

For more information, see “The Options Tab” on page 5-18.
A DRP for organizations DC1, DC2, AF1, SF1, and SF2 with the above MRP as a supply schedule with inventory turns as the objective to generate planned orders for A01, M12, B13, B23, and B21 (the portion required at SF2).

**Scenario 2: Local Restrictions Not Captured in Global Planning Inputs**  Suppose that item B21, a subcomponent of item M11 (Figure 5-2, “Sample Bill of Material”), has volatile pricing. In lieu of implementing the default planned orders in facility SF1 that a global DRP would generate for M11 and its subcomponents (B21), one could plan the supply chain as follows:

1. DRP plan for organizations DC1, DC2, AF1, and SF2 to generate planned orders for A01, M12, B13, M22, and M11.
2. Load the DRP as a demand schedule into a Master Production Schedule (MPS) for organization SF1. Dependent demand for M11 is derived from the planned orders for A01.
3. Run the MPS.
4. Manually adjust the planned orders for M11 in the MPS (for example, to pull ahead the orders for M11 in order to take advantage of a time-sensitive special promotion on B21.)
5. Run an MRP for organization SF1 with the adjusted MPS as input to create planned orders for M11 components and subcomponents (B21 in this case).

**Situation 3: Single Global Data Model Not Available**  The one-step supply chain planning capability of Oracle ASCP presumes either the installation of ASCP as part of an enterprise-wide implementation of Oracle Applications, or the existence of collection programs to pull cross-supply chain transaction data from various Oracle Applications instances or from legacy systems. Cross-supply chain data must be accessible to build the net change snapshot used by Oracle ASCP to generate planned orders. This may not be the case. For example, one or more facilities in the supply chain perform planning and/or transaction processing on legacy systems not yet integrated to Oracle ASCP via some sort of collection program. In this situation, the renegade facilities must be scheduled outside the global DRP plan according to the same steps as used in Scenario 2 above.

**Pitfalls of Subset Planning**

The two principal pitfalls of subset planning (as opposed to global, single-plan supply chain planning) are:
- local optimization as opposed to global optimization
- plan infeasibility due to supply chain interdependencies

The first pitfall is the fact that plans that optimize individual facilities may not be compatible with the optimum global supply chain plan. Take the case of the two distribution centers DC1 and DC2 in Figure 5–1, “Sample Supply Chain.” The way to maximize ontime delivery for DC1 is to allocate all production from AF1 to DC1. The same logic holds for DC2. The global optimum solution, which would be missed via subset planning, comes from some allocation of AF1 output to both DC1 and DC2.

A simple example of supply chain interdependency is Supplier S3 in Figure 5–1, “Sample Supply Chain.” This supplier supplies item B21 to both subassembly facilities SF1 and SF2. Individual plans run for SF1 and SF2 could not recognize the shared capacity at supplier S3 and could not evaluate, if the combined SF1 and SF2 demands for B21 are too high, how best to allocate the B21 to SF1 and SF2. In such a situation the SF1 and SF2 individual plans would be infeasible, but would not even generate any exception notices to alert the planners.
Choosing Between Global Supply Chain and Subset Plans

In general, resource and material capacity are most efficiently utilized in a global supply chain planning environment where planning distributes production requirements across multiple organizations. However, the choice of global supply chain versus subset planning should depend on a number of factors including:

- **Physical proximity of the organizations being planned** – If planned organizations are geographically dispersed, it is generally more difficult to fulfill demand in one region from a plant or distribution center far away because of transportation costs and longer lead times. Note, however, that the costs associated with fulfilling demand from remote plants can be modeled in planning. Planning can then optimize production allocation across plants to meet the objectives that have been set. For example, if balancing resource loads is the primary objective of a multi-organization plan, planning will distribute production across plants to meet that objective.

- **Commonality of the items produced** – If you have multiple organizations that produce similar products, global supply chain planning is beneficial because planning can consider factors like material and resource availability, material costs, and resource costs to create an optimal supply chain plan.

- **Commonality of the supply base** – Similar to producing common items, organizations sharing suppliers are good candidates for global supply chain planning because supply can be optimally distributed across plants depending on each plan’s production requirements. Global supply chain planning will ensure that supplier capacity is most effectively used to meet end customer demand and to minimize inventory.

- **Linkage among plants** – If production at one plant must be coordinated with production at other plants, global supply chain planning should be used. For example, if Plant A provides subassemblies to Plant B (Plant A is a feeder plant), both plants should be planned together.

- **Corporate structure** – The internal organizational structure of a corporation is also a major determinate of the planning method used. If there are clear organizational boundaries between divisions, global supply chain planning is difficult to implement.

The table below summarizes the factors to consider when deciding whether to run a global supply chain or subset plan.
Choosing Between Global Supply Chain and Subset Plans

Table 5-1

<table>
<thead>
<tr>
<th>Factor</th>
<th>Global Supply Chain Planning</th>
<th>Subset Planning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Physical proximity</td>
<td>Close Physical Proximity</td>
<td>Distant Physical Proximity</td>
</tr>
<tr>
<td>Commonality of items produced</td>
<td>High Commonality</td>
<td>Low Commonality</td>
</tr>
<tr>
<td>Commonality of supply base</td>
<td>High Commonality</td>
<td>Low Commonality</td>
</tr>
<tr>
<td>Linkage among plants</td>
<td>Tight Linkage Among Plants</td>
<td>Loose Linkage Among Plants</td>
</tr>
<tr>
<td>Corporate structure</td>
<td>Centralized Corporate Structure</td>
<td>Decentralized Corporate Structure</td>
</tr>
</tbody>
</table>
Choosing a Plan Type

In Oracle ASCP you can launch three type of plans:

- Production Plan
- Manufacturing Plan
- Distribution Plan

Each creates time-phased planned orders that satisfy independent and dependent demand while seeking to respect material and resource constraints.

A choice of plan types lets you tailor the degree of subset planning that is performed for the supply chain: from a single, global supply chain plan down to manually adjusted plans for each item in each organization of the supply chain.

To do this, the three types of plans need to be used in conjunction with the MRP Planning Type item attribute that is set for each item. Possible values for this attribute are:

- MRP Planned
- MPS Planned
- DRP Planned
- DRP and MRP Planned
- DRP and MPS Planned

To set the MRP Planning Type item attribute at the item level:
1. Sign on with the Manufacturing and Distribution Manager responsibility.
2. From the Navigator window, choose Inventory > Items > Master Items.

To set the MRP Planning Type item attribute at the more detailed item-organization level:
1. Sign on with the Manufacturing and Distribution Manager responsibility.
2. From the Navigator window, choose Inventory > Items > Organization Items.

Each type of plan includes or ignores an item for planning depending on the setting of its MRP Planning Type attribute. The discussion below focuses on the principal ways in which plan type (DRP, MPS, MRP) can be used in conjunction with MRP Planning Type item attribute values (MRP Planned, MPS Planned, DRP Planned, DRP and MRP Planned, DRP and MPS Planned).
Choosing a Plan Type

There is a logical equivalence between the different planning types as shown by the fact that the following plans, applied to the sample supply chain (Figure 5–1, “Sample Supply Chain”) and BOM (Figure 5–2, “Sample Bill of Material”), yield identical planned orders across the supply chain. In the BOMs illustrated in the next four figures, the values in parentheses indicate the setting of the MRP Planning Type item attribute.

**Figure 5–5 Sample Bill of Material**

<table>
<thead>
<tr>
<th>Plan Type: DRP</th>
<th>Plan Type: MPS</th>
<th>Plan Type: MRP</th>
</tr>
</thead>
<tbody>
<tr>
<td>Planning Orgs.: SF1, SF2, AF1, DC1, DC2</td>
<td>Planning Orgs.: SF1, SF2, AF1, DC1, DC2</td>
<td>Planning Orgs.: SF1, SF2, AF1, DC1, DC2</td>
</tr>
<tr>
<td>A01 (DRP)</td>
<td>A01 (MPS)</td>
<td>A01 (MRP)</td>
</tr>
<tr>
<td>M11 (DRP)</td>
<td>M12 (MPS)</td>
<td>B13 (DRP)</td>
</tr>
<tr>
<td>B21 (DRP)</td>
<td>M22 (MPS)</td>
<td>B23 (MPS)</td>
</tr>
<tr>
<td>B31 (DRP)</td>
<td>B31 (MPS)</td>
<td>B31 (MRP)</td>
</tr>
</tbody>
</table>

The usefulness of the different types of plans comes in when subset planning is used. Suppose, for example, that subset plan M12 and all its components and subcomponents are used. Some reasons for needing to do so are discussed above.

1. Run a DRP plan to generate planned orders for all items except for M12 and its components and subcomponents (Figure 5–6, “Sample Bill of Material”):

**Figure 5–6 Sample Bill of Material**

- Plan Name: DRP-1
- Plan Type: DRP
- Planning Orgs.: SF1, SF2, AF1, DC1, DC2

```
<table>
<thead>
<tr>
<th>Plan Type: DRP</th>
</tr>
</thead>
<tbody>
<tr>
<td>A01 (DRP)</td>
</tr>
<tr>
<td>M11 (DRP)</td>
</tr>
<tr>
<td>B21 (DRP)</td>
</tr>
<tr>
<td>B31 (MRP)</td>
</tr>
</tbody>
</table>
```
This combination of plan type and MRP Planning Type item attribute values creates cross-supply chain planned orders for A01, M11, B13, B21 and omits M12, M22, B23, B31.

2. Use the DRP plan as a demand schedule for an MPS plan run. This generates dependent demand for M12 from the planned orders for A01, and then generates planned orders for M12.

3. Manually modify the MPS for M12 as necessary.

**Note:** With Oracle ASCP, this step is less frequently necessary than before. This is because the finite-capacity planning performed by Oracle ASCP takes resource and material availability into account, and therefore eliminates much of the need to manually “smooth” production via an MPS.

4. Run an MRP plan, using the MPS as an input demand schedule. This generates planned orders for M22, B23 and B31 (Figure 5–8, “Sample Bill of Material”).
Choosing a Plan Type

Figure 5–8  Sample Bill of Material

This combination of plan type and MRP Planning Type item attribute values creates planned orders for M22, B23 and B31.

Two of the possible MRP Planning Type item attribute values

- DRP and MRP Planned
- DRP and MPS Planned

were not used in the above example. These values are useful in situations in which items which are generally globally planned may need to have their planned orders tweaked at a local organization level.
Choosing Plan Classes

Oracle ASCP allows for the following options for generating plans.

- Unconstrained
- Resource Constrained
- Material Constrained
- Material and Resource Constrained
- Optimized

Before discussing these options in the table below, please take note of the following key concepts.

Constraints

Oracle ASCP lets you prioritize how you enforce Capacity Constraints or Demand Due Dates. Whichever constraint takes precedence over the other is the hard constraint; the other is the soft constraint. You must choose one and only one type of constraint.

Enforce Demand Due Dates

If you choose to enforce Demand Due Dates (setting Demand Due Dates as a hard constraint), then primary resources are used and loaded to capacity to satisfy demand due dates. The system also evaluates alternate resources if additional capacity is required. If there is insufficient capacity to meet demand due dates, the primary resource is overloaded. The choice of whether to use an alternate resource or overload capacity depends on cost considerations if optimization is selected. Oracle ASCP returns exception messages if capacity is overloaded.

Enforce Capacity Constraints

If you choose to enforce Capacity Constraints (setting Capacity Constraints as a hard constraint), then resources are loaded to their limit to satisfy demand (if required). Unsatisfied demand is pushed into the future. In this case, Oracle ASCP returns late replenishment exception messages.
Choosing Plan Classes

**Optimization**

Oracle ASCP allows for multiple levels of optimization in generating plans. These are described in the table below along with the situations under which each would be most useful.

*Table 5–2*

<table>
<thead>
<tr>
<th>Optimization Level</th>
<th>Planning Horizon</th>
<th>Question/Goals</th>
<th>Scenario</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unconstrained Plan</td>
<td>Long Term Future</td>
<td>How much resource capacity and material availability do I need to arrange in order to satisfy all anticipated demand in a timely manner?</td>
<td>Decisions can be made on resource acquisition/disposition and supplier sourcing to address the exceptions.</td>
</tr>
<tr>
<td>Resource Constrained Plan</td>
<td>Long Term Future</td>
<td>How much material availability do I need to arrange in order to satisfy all anticipated demand in a timely manner?</td>
<td>Difficult to change resource capacity, but increased outsourcing is an option. Decisions can be made on supplier sourcing to address the exceptions.</td>
</tr>
<tr>
<td>Material Constrained Plan</td>
<td>Long Term Future</td>
<td>How much resource capacity do I need to arrange in order to satisfy all anticipated demand in a timely manner?</td>
<td>Difficult to change material availability but internal resource acquisition/disposition is an option. Decisions can be made on resource acquisition/disposition to address the exceptions.</td>
</tr>
<tr>
<td>Material and Resource Constrained Plan</td>
<td>Near Term Future</td>
<td>Generate a feasible plan that respects material, resource, distribution, and transportation constraints.</td>
<td>Impossible to overcome material and resource constraints and therefore must respect them in order to generate a feasible supply chain plan.</td>
</tr>
</tbody>
</table>
Choosing Plan Classes

The scope of optimization levels is summarized in the table below:

<table>
<thead>
<tr>
<th>Optimization Level</th>
<th>Planning Horizon</th>
<th>Question/Goals</th>
<th>Scenario</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optimized Plan</td>
<td>Near Term Future</td>
<td>Generate an optimized and executable plan based on plan objectives as well as material, resource, and transportation constraints.</td>
<td>Impossible to overcome material and resource constraints and therefore must respect them in order to generate a feasible supply chain plan.</td>
</tr>
</tbody>
</table>

Table 5–3

<table>
<thead>
<tr>
<th>Optimization Level</th>
<th>Scope</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nonoptimized (unconstrained, resource constrained, material constrained, material and resource constrained) (Optimized option unchecked which applies to the entire planning horizon)</td>
<td>Local settings that can be applied to temporal subsets of an overall supply chain plan. These simply dictate which types of constraints (material and resource) are obeyed in which portions of the plan. The planned orders for the Resource Constrained, Material Constrained and Material and Resource Constrained time portions of the plan are generated via a fast heuristic. The planned orders for the Unconstrained time portion of the supply chain plan are always generated using traditional MRP type logic.</td>
</tr>
<tr>
<td>Optimized (Optimized option checked which applies to the entire planning horizon)</td>
<td>Global setting that applies to the entire supply chain plan. The planned orders for the resource constrained, material constrained and material and resource constrained time portions of the plan are generated via a linear programming planning algorithm which explicitly optimizes objectives that are important to the user.</td>
</tr>
</tbody>
</table>

One should always check the Optimized option if execution time constraints permit.
Setting Plan Options

This section describes how to set plan options. The plan options types are as follows:

- Options
- Aggregation
- Optimization
- Organizations

Note: If you have purchased and are using Oracle Risk Optimization, please refer to “Overview of Oracle Risk Optimization” on page 17-2 for further options.

The Options Tab

To access the Options tab from the Navigator, choose [Production, Manufacturing, or Distribution Plan] > Options.

The Plan Options window appears with the Options tab selected.
Use the information in the following table to specify the fields and options:

**Table 5–4**

<table>
<thead>
<tr>
<th>Object</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assignment Set</td>
<td>The assignment set for your plan created within your organization.</td>
</tr>
<tr>
<td>Demand Priority Rule</td>
<td>Select the demand priority rule for your plan.</td>
</tr>
<tr>
<td>Org Selection</td>
<td>Based on all or a subset of organizations. This is a view-only field, determined by the value entered in the Names window.</td>
</tr>
<tr>
<td>Overwrite</td>
<td>Overwrite planned orders.</td>
</tr>
<tr>
<td>Append Planned Orders</td>
<td>Appends new planned orders to current plan.</td>
</tr>
<tr>
<td>Enforce Demand Due Dates</td>
<td>Choose if you want enforcing demand due dates to be your hard constraint. For more information, see “Setting Hard and Soft Constraints” on page 11-14 in Chapter 11, &quot;Constraint-Based Planning.&quot;</td>
</tr>
</tbody>
</table>
### Setting Plan Options

<table>
<thead>
<tr>
<th><strong>Object</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Enforce Capacity Constraints</td>
<td>Choose if you want enforcing capacity constraints to be your hard constraint. For more information, see “Setting Hard and Soft Constraints” on page 11-14 in Chapter 11, “Constraint-Based Planning.”</td>
</tr>
<tr>
<td>Demand Time Fence Control</td>
<td>Select to enforce demand time fence control.</td>
</tr>
<tr>
<td>Planning Time Fence Control</td>
<td>Select to enforce planning time fence control.</td>
</tr>
<tr>
<td>Lot for Lot</td>
<td>Select to force the creation of a separate supply for each demand. This prevents the creation of aggregate supplies that satisfy multiple demands, and overrides order quantity modifiers such as Minimum Lot Size and Fixed Lot Multiple.</td>
</tr>
<tr>
<td>Pegging</td>
<td>Select to calculate graphical pegging information. Oracle ASCP traces supply information for an item to its corresponding end demand details, which you can then view in a diagrammatic display.</td>
</tr>
<tr>
<td>Pegging – Reservation Level</td>
<td>Choose a reservation level: Planning Group, Project, Project-Task, or None.</td>
</tr>
<tr>
<td>Pegging – Hard Pegging Level</td>
<td>Choose a hard pegging level: Project, Project-Task, or None.</td>
</tr>
<tr>
<td>Material Scheduling Method</td>
<td>Choose from Operation Start Date or Order Start Date scheduling methods.</td>
</tr>
<tr>
<td>Planned Items</td>
<td>Choose planned items from the list of values.</td>
</tr>
<tr>
<td>Planned Resources</td>
<td>Choose all resources or bottleneck resources. If selecting bottleneck resources, you must first specify a Bottleneck Resource Group. (See Bottleneck Resource Group, below.)</td>
</tr>
<tr>
<td>Bottleneck Resource Group</td>
<td>If you have defined bottleneck resource groups in Oracle Bills of Material and you want to plan only those groups, designate them here.</td>
</tr>
</tbody>
</table>
The Aggregation Tab

To access the Aggregation tab from the Navigator, choose [Production, Manufacturing, or Distribution Plan] > Options > Aggregation tab. The Aggregation tab appears.

Figure 5–10 The Aggregation tab

Use the information in the following table to specify the fields and options:

Table 5–5

<table>
<thead>
<tr>
<th>Object</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Date</td>
<td>Choose a start date for your plan. This is a view-only field, whose value equals the start date of the plan if the plan has already been run. Otherwise, it defaults to the sysdate.</td>
</tr>
<tr>
<td>End Date</td>
<td>Shows the calculated end date for your plan. This is a view-only field, calculated based on the bucket sizes you specify.</td>
</tr>
<tr>
<td>Bucket Size</td>
<td>Specify bucket size in days, weeks, and periods.</td>
</tr>
</tbody>
</table>
Object | Description
--- | ---
Items | Choose aggregation at item level or product family level.
Resources | Choose resource aggregation at individual level or aggregate level.
Routings | Choose aggregation level at individual routing or bill of resources level.
Plan Capacity | Specify whether constraints are used.
Resource Constraints | Select Yes to consider resource constraints.
Material Constraints | Select Yes to consider material constraints.
Enable Scheduling | Specify whether to enable scheduling.
Minutes Bucket Size | Specify the bucket size in minutes for the Days planning period.
Hours Bucket Size | Specify the bucket size in hours for the Days planning period.
Days Bucket Size | Specify the bucket size in days for the Days planning period.

**The Optimization Tab**

To access the Optimization tab from the Navigator, choose [Production, Manufacturing, or Distribution Plan] > Options > Optimization tab.

The Optimization tab appears.
Use the information in the following table to specify the fields and options:

**Table 5–6**

<table>
<thead>
<tr>
<th><strong>Object</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Optimize</td>
<td>Select this check box if you are running an optimized plan.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> For this check box to be enabled, you must enable Plan Capacity and set at least one field in Material or Resource Constraints to Yes in the Aggregation tab.</td>
</tr>
<tr>
<td>Objective: Maximize</td>
<td>Specify a weighting percentage for this objective using the sliding bar or by entering a value between 0 and 1.</td>
</tr>
<tr>
<td>Inventory Turns</td>
<td></td>
</tr>
<tr>
<td>Objective: Maximize</td>
<td>Specify a weighting percentage for this objective using the sliding bar or by entering a value between 0 and 1.</td>
</tr>
<tr>
<td>Plan Profit</td>
<td></td>
</tr>
<tr>
<td>Objective: Maximize</td>
<td>Specify a weighting percentage for this objective using the sliding bar or by entering a value between 0 and 1.</td>
</tr>
<tr>
<td>On-time Delivery</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Setting Plan Options

<table>
<thead>
<tr>
<th>Object</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plan Level Defaults: Exceeding material capacity</td>
<td>Enter a numerical value to quantify the impact of exceeding material capacity.</td>
</tr>
<tr>
<td>Plan Level Defaults: Exceeding transportation capacity</td>
<td>Enter a numerical value to quantify the impact of exceeding transportation capacity</td>
</tr>
<tr>
<td>Plan Level Defaults: Exceeding resource capacity</td>
<td>Enter a numerical value to quantify the impact of exceeding resource capacity.</td>
</tr>
<tr>
<td>Plan Level Defaults: Demand Lateness</td>
<td>Enter a numerical value to quantify the impact of late demand.</td>
</tr>
</tbody>
</table>

**Note:** Penalty Factors set using the Optimization tab override default values set using flexfields. For more information on setting penalty factors using flexfields, see "Oracle ASCP Flexfields" on page B-1. For more information on the implications of setting these fields and options using the Optimization tab, see "Optimization" on page 5-16.
The Organizations Tab

To access the Organizations tab from the Navigator, choose [Production, Manufacturing, or Distribution Plan] > Options > Organizations tab.

The Organizations tab appears.

Figure 5–12 The Organizations tab

Use the information in the following table to specify the fields and options:

Table 5–7

<table>
<thead>
<tr>
<th>Object</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Org</td>
<td>Your plan’s organization. See “Choosing Between Global Supply Chain Planning and Subset Planning” on page 5-9.</td>
</tr>
<tr>
<td>Description</td>
<td>The name of your organization.</td>
</tr>
<tr>
<td>Net WIP</td>
<td>Select to consider Net WIP.</td>
</tr>
</tbody>
</table>
Setting Plan Options

Using an Existing Plan as a Demand Schedule For New Plan

The plan for one organization can be used as a demand (or demand schedule) for the plan of another organization.

<table>
<thead>
<tr>
<th>Object</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Net Reservations</td>
<td>Select to consider Net Reservation.</td>
</tr>
<tr>
<td>Net Purchasing</td>
<td>Select to consider Net Purchasing.</td>
</tr>
<tr>
<td>Plan Safety Stock</td>
<td>Select to consider plan safety stock.</td>
</tr>
<tr>
<td>Include Sales Order</td>
<td>Select to include sales order.</td>
</tr>
<tr>
<td>Bill of Resource</td>
<td>Select Bill of Resources from the list of values.</td>
</tr>
<tr>
<td>Simulation Set</td>
<td>Select Simulation Set from the list of values.</td>
</tr>
<tr>
<td>Demand Schedules</td>
<td>Select the name of your demand schedule/forecast/plan.</td>
</tr>
<tr>
<td>Interplant</td>
<td>Check this to use interorg orders and interorg planned order as demands. Leave unchecked to use all planned orders as demands.</td>
</tr>
<tr>
<td>Supply Schedules</td>
<td>Select the name of your supply schedule for each organization.</td>
</tr>
<tr>
<td>Subinventory Netting</td>
<td>Opens the Subinventory Netting window.</td>
</tr>
</tbody>
</table>

**Using an Existing Plan as a Demand Schedule For New Plan**

The plan for one organization can be used as a demand (or demand schedule) for the plan of another organization.

---

**Note:** Users can collect forecasts into the APS planning server. Optionally, they can choose to consume forecasts by sales orders when they run ASCP plans. Forecasts are consumed if the Include Sales Order check box in the Organizations tab of the Plan Options window is checked. For multilevel ATO items, forecasts are consumed at all levels if the forecast explosion has occurred in the source instance prior to the collection.

---

**To use an existing plan as a demand schedule for new plan:**

1. Choose [Production, Manufacturing, or Distribution Plan] > Names to create a new Production, Manufacturing, or Distribution plan for the organization that will use an existing plan as a source.
2. Click the Options button. The Plan Options window appears.
3. Choose the Organizations tab.

---

Oracle Advanced Planning and Scheduling Implementation and User's Guide
4. Specify the plan name to be used as a source for the new plan in the Demand Schedule portion of the window.

5. Click the Subinventory Netting button. The Subinventory Netting window appears.

**Figure 5–13 Subinventory Netting Window**

Use the information in the following table to specify the fields and options:

**Table 5–8**

<table>
<thead>
<tr>
<th>Object</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Shows all active inventory for your organization. This is a view-only field.</td>
</tr>
<tr>
<td>Description</td>
<td>A description of the subinventory. This is a view-only field.</td>
</tr>
<tr>
<td>Net</td>
<td>Select whether to net the subinventory.</td>
</tr>
</tbody>
</table>
**Inline Forecast Consumption**

This section explains some of the features related to forecast consumption. For a complete description of forecast consumption, please refer to the Forecasting chapter, Forecast Consumption section of the *Oracle Master Scheduling/MRP and Oracle Supply Chain Planning User’s Guide*.

**Setups in Collection**  If you want to consume a forecast with already shipped sales orders, the collection engine uses the profile option MSC: Sales Orders Offset Days. This option is used to set the number of days before the current day during which the collection engine will collect all shipped sales orders for consumption. So, for example, if you set this option to 5 days, the collection engine will collect all shipped sales orders for consumption starting from 5 days before the current day. The default for this option is 99999.

---

**Note:** All partially or nonshipped sales orders are collected regardless of this profile option value.

---

**Setups in Plan Options**  When you intend to consume a forecast with sales orders from any organization, you need to set up the following in the Plan Options window:

- In the Demand Schedule region of the Organization tab, specify the appropriate forecast sets
- In the Organizations region of the Organization tab, check the Include Sales Order check box.

**Planning**  The forecast consumption process happens in the snapshot phase. When you launch a plan, make sure that the Launch Snapshot field is set to Yes (the default is Yes).

**To see consumption results:**

1. Run the plan.
2. Navigate to the Planner’s Workbench.
3. Select the plan name, organization, and item.
4. Select the Item.
5. Right click on the item name.
   - A list of choices appear.
6. Select either Demand or Supply/Demand.

7. If you want to see how a forecast entry is consumed, in either the Demand or the Supply/Demand window, select any forecast in the Order Type column and right click on the forecast name.

A list of choices appears.

8. Select Consumption Details.

9. If you want to see how a sales order is consuming forecasts, go back to Step 6.

10. In either the Demand or the Supply Demand window, select a sales order entry in the Order Type column and right click on the sales order name.

A list of choices appears.

11. Select Consumption Details

Example

The following table shows the forecast and sales orders for Item 1.

Table 5–9

<table>
<thead>
<tr>
<th>Order Type</th>
<th>Quantity</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Forecast</td>
<td>50</td>
<td>June 1, 2001</td>
</tr>
<tr>
<td>SO1 (sales order 1)</td>
<td>10</td>
<td>June 1, 2001</td>
</tr>
<tr>
<td>SO2</td>
<td>25</td>
<td>June 1, 2001</td>
</tr>
</tbody>
</table>

After the plan is run, there are three demand entries in the Demand window for Item 1, as shown in the following table:

Table 5–10

<table>
<thead>
<tr>
<th>Order Type</th>
<th>Quantity</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Forecast</td>
<td>15</td>
<td>June 1, 2001</td>
</tr>
<tr>
<td>SO1</td>
<td>10</td>
<td>June 1, 2001</td>
</tr>
<tr>
<td>SO 2</td>
<td>25</td>
<td>June 1, 2001</td>
</tr>
</tbody>
</table>
To see the consumption details for line 1, select the forecast and right-click. Choose Consumption Details from the list that appears. The following table represents what will be shown:

**Table 5–11**

<table>
<thead>
<tr>
<th>Fcst Qty</th>
<th>Fcst Date</th>
<th>Consumed Qty</th>
<th>SO Date</th>
<th>SO Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>50</td>
<td>June 1</td>
<td>10</td>
<td>June 1</td>
<td>SO1</td>
</tr>
<tr>
<td>50</td>
<td>June 1</td>
<td>25</td>
<td>June 1</td>
<td>SO2</td>
</tr>
</tbody>
</table>

To see how Sales Order 1 is consuming forecast, select sales order 1 and right-click. Choose Consumption Details from the list that appears. The following table represents what will be shown:

**Table 5–12**

<table>
<thead>
<tr>
<th>Fcst Qty</th>
<th>Fcst Date</th>
<th>Consumed Qty</th>
<th>SO Date</th>
<th>SO Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>50</td>
<td>June 1</td>
<td>10</td>
<td>June 1</td>
<td>SO1</td>
</tr>
</tbody>
</table>

**Advanced Consumption Features: Backward/Forward Consumption Time Windows**  Backward/forward consumption time windows are defined in the source database at the forecast set level by using the Consumption Options region of the Forecast Sets window. If the backwards window is defined as eight days and the sales order is on day eight, the sales order will consume the forecast entries from day eight back to day one. Forecast entries closest to the sales order are consumed first.

**Advanced Consumption Features: Consumption Level**  Consumption can be defined at four levels:

- **Item Level:**
  - Most general level. No restriction in consumption

- **Customer Level:**
  - Only if forecast and sales order share the same customer can consumption take place

- **Ship to Level:**
Setting Plan Options

- Only if forecast and sales order share the same customer and ship address can consumption take place.

- Bill to Level:
  - Only if forecast and sales order share the same customer and billing address can consumption take place.

Consumption level is defined at forecast set level in the source database.

**Advanced Consumption Features: Outlier Percentage**  Outlier percentage controls the effects of abnormal demand with a maximum percent of the original quantity forecast that a single sales order can consume.

For example, if the outlier is 50%, the forecast is for 100, and the sales order is for 70, the sales order can only consume $100 \times 50\% = 50$ from this forecast.

**Advanced Consumption Features: Demand Class**  Demand Class can be defined at the forecast level. If it is not defined at this level, the planning engine takes the value of the demand class from the organization to which the demand class belongs. If the sales order has no defined demand class, the sales orders takes the default demand class from the organization.

Consumption takes place only if the demand class of the sales order and forecast match.

**Using an Existing Plan as a Supply Schedule for a New Plan**

The plan for one organization can be used as a constraint (or supply schedule) for the plan of another organization.

▷ To use an existing plan as a supply schedule for a new plan:

1. Choose [Production, Manufacturing, or Distribution Plan] > Names to create a new MRP, MPS, or DRP plan for the organization that will use an existing plan as a source.

2. Click the Options button.
   The Plan Options window appears.

3. Choose the Organizations tab.

4. Specify the plan name to be used as a source for the new plan in the Supply Schedule portion of the window.
Choosing Aggregation Levels

Oracle ASCP allows planning to occur at different levels of aggregation within the same plan. This allows detailed scheduling and long-range planning to take place within a single integrated plan. Flexible aggregation levels exist along several planning dimensions:

- time
- product
- resource/routing

Aggregation level options for each dimension is described below.

**Note:** Each plan has its own aggregation level settings that are set in the Aggregation tab of the plan’s Plan Options window.

Choosing Time Aggregation Levels

In ASCP, the available time aggregation levels are:

- minutes
- hours
- days
- weeks
- periods

In order to reduce the computational effort to calculate a plan and to reduce the volume of plan output (for clarity), time bucket sizes should be set only as small as is necessary to capture the necessary detail.

Time bucket size must increase or stay level over the planning horizon; it cannot decrease.

The following sequences of time aggregation levels are examples of those (but not all) that are valid within a single plan:

- minutes-hours-days-weeks periods (check Enable Scheduling)
- days (uncheck Enable Scheduling)
- days-weeks (uncheck Enable Scheduling)
Choosing Aggregation Levels

- hours-days-periods (check Enable Scheduling. Note: weeks time aggregation level is skipped.)
- Planning at the minute and hour aggregation levels is referred to as scheduling, and is enabled only when the Enable Scheduling check box in the Aggregation tab of the Plan Options window is checked.
- Periods default to months.
- All lower level demand that occurs within a higher level time bucket (for example, a daily demand occurring in the middle of a weekly time bucket) is moved to the last day of the higher level bucket for planning purposes. This is the information lost through aggregation.
- Supplies are always scheduled to arrive at the last day of periods.

Choosing Product Aggregation Levels

In ASCP, the available product aggregation levels are:
- item
- product family

Planning at the item level explodes material and resource requirements down to each bottom-level component (provided that the component’s MRP Planning Type item attribute matches the type of Manufacturing, Material, or Distribution Plan being run).

When planning at the product family level, no explosion of material or resource requirements occurs. Information concerning the resources required to make a product family are taken from the routing for the product family. Therefore, if planning is to be done at a product family level, there needs to be a routing defined for each product family. No material requirements are considered when planning at a product family level.

Choosing Resource Aggregation Levels

There are two ways in which the aggregation level of resource information may be specified in Oracle ASCP. The first is to employ the following resource aggregation levels:
- individual
- aggregate

The second is to employ the following routing aggregation levels:
Choosing Aggregation Levels

- routing
- bill of resource (BOR)

Note: Resource aggregation levels do not have any effect unless the Plan Capacity check box in the Aggregation tab of the plan options window is checked.

Resource aggregation levels can either be individual or aggregate.

- Individual: all resources listed in all item routings (if the item aggregation level is set to Item) or all product family routings (if the item aggregation level is set to Product Family) are considered in planning.

- Aggregate: only resources specified as aggregate resources are considered in planning. Aggregate resources are specified in the window accessed by the Operations Resources button during routing definition (Use the Manufacturing and Distribution Manager responsibility. From the Navigator window, choose Bills of Material > Routings > Routings). Each operation resource can have a designated aggregate resource (which may be itself or another resource).

Routing aggregation levels serve a similar function.

- Routing: all resources listed in all item routings (if the item aggregation level is set to Item) or all product family routings (if the item aggregation level is set to Product Family) are considered in planning. This is identical in meaning to the individual resource aggregation level described above.

- Bill of resource (BOR): only resources listed in bills of resources for items (if the item aggregation level is set to Item) or product families (if the item aggregation level is set to Product Family) are considered in planning. Bills of resource are lists which associate items or product families with individual resources and the processing times (usages) incurred on those resources for each item/product family. (To define a bill of resource, use the Manufacturing and Distribution Manager responsibility. From the Navigator window, choose Capacity Planning > Bill of Resources > Bill of Resource.) The usages in a bill of resource may be automatically generated by summing the resource usages from the routings for an item and its components and subcomponents. A bill of resource may also be manually defined, allowing you to include only certain key resources and to manually adjust the usage quantity for each key resource as necessary.
When using the routing aggregation level BOR, Oracle ASCP generates resource requirements during planning only for those items or product families that have defined BORs.

When using the routing aggregation level BOR, operation sequencing information is from the routings that are used to generate the BOR is lost.

The higher levels of resource aggregation (aggregate) and routing aggregation (BOR) both have the effect of limiting the number of resources considered in planning.

Resource and routing aggregation level have overlapping effects.

If either the resource aggregation level is set to individual or the routing aggregation level is set to routing, all individual resources for items (if the item aggregation level is set to Item) or product families (if the item aggregation level is set to Product Family) are considered in planning.

To set the resource aggregation levels for a time horizon:

1. Navigate to the Planner Workbench.
2. From the menu bar, choose Plan > Plan Options.
   The Plan Options window appears.
3. Choose the Aggregation tab.
4. Enter the time horizon in days, weeks, or periods.
   You can specify different levels of aggregation in different time buckets so that detailed information is considered more frequently and less detailed information is considered less frequently.

Resources can be scheduled either individually or in aggregate. Selecting individual resource scheduling generates schedules down to the individual resource level and considers the available capacity of each resource in the schedule recommendations.

Selecting aggregate resource scheduling considers the overall capacity of all resources in a resource group required for an item. For example, the overall capacity of a department to which the individual resources are assigned are used.

For more information, see “Defining a Resource” in the Oracle Bill of Materials User’s Guide.
Controlling Material Aggregation Levels

You can specify material aggregation levels for each of the three planning time horizons.

To set the material aggregation level for a time horizon:

1. Navigate to the Planner Workbench.
2. From the menu bar, choose Plan > Plan Options.
   - The Plan Options window appears.
3. Choose the Aggregation tab.

4. Enter the time horizon in days, weeks, or periods.
   - You can specify different levels of aggregation in different time buckets so that detailed information is considered more frequently and less detailed information is considered less frequently.
You can schedule the product at either the item level or the product family level. Ensure items are correctly assigned to a product family and that a planning percent is specified when setting up your BOMs.

**Controlling Routing Aggregation Levels**

You can specify routing aggregation levels for each of the three planning time horizons.

▶ To set the routing aggregation level for a time horizon:

1. Navigate to the Planner Workbench.
2. From the menu bar, choose Plan > Plan Options.
   - The Plan Options window appears.
3. Choose the Aggregation tab.
4. Enter the time horizon in days, weeks, or periods.

You can specify different levels of aggregation in different time buckets so that detailed information is considered more frequently and less detailed information is considered less frequently.

Either routings or bills of resources can be used for scheduling production. Selecting routing level aggregation will result in schedules that consider the capacity of each resource as well as the sequencing of the resources during the production of an item. Selecting BOR level aggregation will only consider the resource requirements needed to produce an item without considering the sequencing and interdependence among the resources required for an item.
Choosing an Objective Function

When generating plans via the Optimized option, Oracle ASCP lets you specify the objectives to be considered in generating planned orders across the supply chain.

All objectives are expressed in units of dollars.

This section describes each of the available objectives and how multiple objectives can be combined into a single objective function which captures tradeoffs between competing objectives.

You can optimize your plans to the objectives shown in the following table.

Table 5–13

<table>
<thead>
<tr>
<th>Objective Function</th>
<th>How Is The Objective Achieved?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximize Inventory Turns</td>
<td>Minimize inventory carrying cost</td>
</tr>
<tr>
<td>Maximize Plan Profit</td>
<td>Maximize plan revenue minus plan cost</td>
</tr>
<tr>
<td>Maximize On-Time Delivery</td>
<td>Minimize penalty cost for late demand</td>
</tr>
</tbody>
</table>

Inventory Turns

The inventory turns are maximized by minimizing inventory carrying cost. Inventory carrying cost is summed up for all items in all time buckets. Inventory carrying cost is calculated as follows:

inventory carrying cost = (average inventory per bucket) * (carrying cost percent) * (item cost)

Plan Profit Objective

Selecting Plan Profit Objective has the net effect of asking the optimization engine to do a dynamic cost rollup for all planned items. All other optimization objectives use standard costs and do not dynamically calculate a rolled-up cost.

The margin percentage objective is calculated as follows:

\[ \text{margin percentage} = \frac{\text{plan revenue} - \text{plan cost}}{\text{plan revenue}} \]

\[ \text{plan revenue} = \left( \text{sales order line price} \times \text{sales order quantity} \right) + \left( \text{item list price} \times \text{item discount} \times \text{forecast quantity} \right) \]
Plan revenue is calculated and summed up for all items with independent demand in all time buckets.

\[
\text{plan cost} = (\text{item cost}) + (\text{transportation cost}) + (\text{inventory carrying cost})
\]

Plan cost is calculated and summed up for all items, resources, and ship methods in all time buckets.

\[
\begin{align*}
\text{item cost} &= \{(\text{resource cost}) \times (\text{resource quantity used})\} + \\
&\quad \{(\text{buy item cost}) \times (\text{buy item quantity})\} + \\
&\quad \{(\text{process cost}) \times (\text{quantity using process})\}
\end{align*}
\]

\[
\begin{align*}
\text{transportation cost} &= \{(\text{transfer quantity}) \times (\text{item weight}) \times (\text{shipping cost per unit weight})\} + \\
&\quad \{(\text{buy quantity}) \times (\text{item weight}) \times (\text{shipping cost per unit weight})\}
\end{align*}
\]

\[
\begin{align*}
\text{inventory carrying cost} &= \{(\text{average inventory per bucket}) \times (\text{carrying cost pct}) \times (\text{item cost})\}
\end{align*}
\]

Margin percentage is the most aggregate of objectives in the sense that it combines multiple costs.

**Ontime Delivery Objective**

The ontime delivery objective is calculated as follows:

\[
\text{ontime delivery} = - (\text{penalty cost for late demand})
\]

Ontime delivery is calculated and summed up for all items with independent demand in all time buckets.

\[
\begin{align*}
\text{penalty cost} &= \{(\text{penalty cost factor for late demand [$/unit/day]} \times (\text{days for late demand}))[\text{(quantity of late demand)}] + \\
&\quad \{(\text{penalty cost factor for unmet demand [$/unit/day]} \times (\text{days late}))[\text{(quantity of unmet demand)}]
\end{align*}
\]

Ontime delivery sums two types of costs: late demand cost and unmet demand cost. An unmet demand is simply a very late demand. Specifically, it is a demand for which the plan generates supply that exceeds the demand due date by more than allowable days early/late. Allowable days early/late is a user-set profile option.

- Penalty cost factor for late demand is a user-specified plan option.
- Penalty cost factor for unmet demand is a system-supplied plan option, obtained by multiplying the penalty cost factor for late demand by a constant.
Choosing an Objective Function

that is greater than 1. This makes unmet (very late) demands cost more than late demands.

Implicit Objectives

In addition to the above objectives, which you can select/weight or deselect, Oracle ASCP maintains a set of implicit (hidden) objectives that it takes into consideration no matter what you select. These objectives are defined to be the negative of various penalty costs, as follows:

\[
\text{implicit objectives} = \\
-(\text{penalty cost for late demand}) \\
-(\text{penalty cost for resource capacity violation}) \\
-(\text{penalty cost for transport capacity violation}) \\
-(\text{penalty cost for material capacity violation}) \\
-(\text{penalty cost for safety stock violation}) \\
-(\text{penalty cost for using alternate sources}) \\
-(\text{penalty cost for using alternate routings}) \\
-(\text{penalty cost for using alternate resources}) \\
-(\text{penalty cost for using substitute items}) \\
-(\text{percentage of carrying cost})
\]

Maximizing implicit objectives results in minimization of the penalty costs.

Penalty costs are the product of the penalty factor and some other parameter such as list price, item cost, resource cost, or transportation cost. For example:

\[
\text{penalty cost for late demand [$/unit/day]} = (\text{penalty factor}) \times (\text{list price})
\]

You can set penalty factors at different levels using flexfields, plan options, or profile options. Flexfields let you set penalty factors at the most discrete level. For example, you can set the Penalty Factor for Late Demand at the Demand, Item, or Org level using flexfields. Plan options and profile options let you set the same penalty factor at the plan level and site level, respectively.

Combining Objectives

Oracle ASCP combines the above objectives into the following objective function:

\[
\text{overall objective} = \text{maximize } w_1 \times (\text{plan profit}) + w_2 \times (\text{on-time delivery}) + w_3 \times (\text{inventory turns}) + 1.0 \times (\text{implicit objectives})
\]

Objective weights \(w_1-w_3\) are restricted to the range 0 to 1. Setting an objective’s weight to 0 directs Oracle ASCP not to consider that particular objective. Setting an
Choosing an Objective Function

objective’s weight to 1 places the maximum possible emphasis on that objective. Objective weights w1-w3 may be set independently.

Objective weights w1-w3 in general do not precisely show the relative importance of each objective in planning decisions. As can be seen from the above definition of the overall objective, the percentage of the overall objective value occupied by a particular objective depends also on the dollar magnitude of the objective, and it is the product of the weight and the dollar magnitude of the objective which reflects the relative importance of each objective in planning decisions.

Take special note of interdependent objectives. Some costs are contained in more than one objective. For example, inventory carrying cost is a part of both the Plan Profit and Inventory Turns objectives. Therefore, only use these two objectives together if it is desired to artificially weight inventory carrying cost higher than the other costs (item cost, transportation cost) contained within plan profit.

A more subtle case is penalty cost for late demand, which appears both in the On-time Delivery objective and in the implicit objectives not seen by the user. Thus, no matter what the weight on-time delivery, Oracle ASCP considers late demand cost in its planning decision-making.

Factors Affecting Objectives

Implicit and explicit objectives are affected by several factors and rules. The following two tables present the relationship of these objectives to costs, prices, priority rules, and sourcing ranks. These tables also provide you with the minimum data requirements for optimized plans based on different objectives.

<table>
<thead>
<tr>
<th>Cost-Price / Objectives</th>
<th>Inventory Turns</th>
<th>On-time Delivery</th>
<th>Plan Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resource Cost</td>
<td>n/a</td>
<td>n/a</td>
<td>yes</td>
</tr>
<tr>
<td>Item Standard Cost</td>
<td>yes</td>
<td>n/a</td>
<td>yes</td>
</tr>
<tr>
<td>Carrying Cost Percentage</td>
<td>yes</td>
<td>n/a</td>
<td>yes</td>
</tr>
<tr>
<td>Late Demand Penalty Factor</td>
<td>n/a</td>
<td>yes</td>
<td>n/a</td>
</tr>
<tr>
<td>List Price and Selling Price</td>
<td>n/a</td>
<td>yes</td>
<td>n/a</td>
</tr>
<tr>
<td>Transportation Cost</td>
<td>n/a</td>
<td>n/a</td>
<td>yes</td>
</tr>
</tbody>
</table>

yes means cost/factor affects the objective.
Choosing an Objective Function

Table 5–15  Implicit Objectives (part 1)

<table>
<thead>
<tr>
<th>Factor</th>
<th>Penalty Cost for Late Demand</th>
<th>Penalty Cost for Resource Capacity Violation</th>
<th>Penalty Cost for Transport Capacity Violation</th>
<th>Penalty Cost for Material Capacity Violation</th>
<th>Penalty Cost for Safety Stock Violation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resource Cost</td>
<td>n/a</td>
<td>yes</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
</tr>
<tr>
<td>Item Standard Cost</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Carrying Cost Percentage</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
</tr>
<tr>
<td>Exceeding Item Capacity Penalty Factor</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
<td>yes</td>
<td>n/a</td>
</tr>
<tr>
<td>Exceeding Resource Capacity Penalty Factor</td>
<td>n/a</td>
<td>yes</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
</tr>
<tr>
<td>Exceeding Transport Capacity Penalty Factor</td>
<td>n/a</td>
<td>n/a</td>
<td>yes</td>
<td>n/a</td>
<td>n/a</td>
</tr>
<tr>
<td>Late Demand Penalty Factor</td>
<td>yes</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
</tr>
<tr>
<td>List Price and Selling Price</td>
<td>yes</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
</tr>
<tr>
<td>Transportation Cost</td>
<td>n/a</td>
<td>n/a</td>
<td>yes</td>
<td>n/a</td>
<td>n/a</td>
</tr>
</tbody>
</table>

yes means cost / factor affects the objective.

Table 5–16  Implicit Objectives (part 2)

<table>
<thead>
<tr>
<th>Factor</th>
<th>Penalty Cost for Using Alternate Sources</th>
<th>Penalty Cost for Using Alternate Routings</th>
<th>Penalty Cost for Using Alternate Resources</th>
<th>Penalty Cost for Using Substitute Items</th>
<th>Implicit Carrying Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resource Cost</td>
<td>n/a</td>
<td>n/a</td>
<td>yes</td>
<td>n/a</td>
<td>n/a</td>
</tr>
<tr>
<td>Item Standard Cost</td>
<td>yes</td>
<td>yes</td>
<td>n/a</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Carrying Cost Percentage</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
<td>yes</td>
</tr>
<tr>
<td>Sourcing Rank</td>
<td>yes</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
</tr>
<tr>
<td>Substitute Item Priority</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
<td>yes</td>
<td>n/a</td>
</tr>
<tr>
<td>BOM/Routing Priority</td>
<td>n/a</td>
<td>yes</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
</tr>
<tr>
<td>Alternate Resource Priority</td>
<td>n/a</td>
<td>n/a</td>
<td>yes</td>
<td>n/a</td>
<td>n/a</td>
</tr>
</tbody>
</table>
yes means cost/ factor affects the objective.

**Computational Burden Considerations**

At all levels of optimization except for unconstrained plan (see “Choosing Plan Classes” on page 5-15), Oracle ASCP performs some type of finite-capacity scheduling. This is computationally much more complex than the infinite-capacity planning performed in R11 and earlier versions. Therefore, formulating the planning problem so that it is less computationally intensive is worthwhile.

The computational burden of a planning problem increases with the number of resources, the number of items, and the number of demands.

Ways to decrease the number of resources include:

- Leave non-critical (non-constraint) resources out of routings. For example, an entire cell in a cellular manufacturing system might be modeled as a single resource instead of as a group of resources.
- Maximize the use of resource and routing aggregation (see “Choosing Resource Aggregation Levels” on page 5-33).

Ways to decrease the number of items include:

- Enable each item in as few organizations as possible because each combination of item-organization counts as a separate item.
- Maximize the use of item aggregation (to the product family level) in the plan options.
- Set the Planned Items plan option to something other than All Planned Items. For example, set it to demand schedule items only.

Ways to decrease the number of demands include:

- Maximize the use of time aggregation (larger time buckets) in plan options. This collapses multiple demands occurring within a larger time bucket to a single demand at the end of the time bucket.
- Maintain long-term forecasts in larger time buckets (for example, weeks or periods) instead of shorter time buckets such as days. This reduces the number of MDS demands once the forecast is loaded into an MDS for input to the planning process.
Optimized Plans Data Requirements

The majority of the data required for optimized plans for different objectives are available in ERP systems. These data include:

- Item Standard Cost, List Price, Selling Price, Discount
- Carrying Cost Percent
- Resource Cost
- Transportation Cost
- Sourcing Rank
- Substitute Item Priority
- BOM/Routing Priority
- Alternate Resource Priority

The remaining data can be set up at the profile option level or plan level to expedite the implementation of optimized plans. These data include:

- Exceeding Item Capacity Penalty Factor
- Exceeding Resource Capacity Penalty Factor
- Exceeding Transport Capacity Penalty Factor
- Late Demand Penalty Factor

Oracle ASCP considers some default values for these fields, such as 0.01 for the Standard Cost. The Optimization process cannot produce very valuable results based on these default values alone. It is recommended that you specify starting values for these fields at the profile option level at the start of implementation.

Optimization Effects on Sourcing

Oracle ASCP optimization does not consider allocation percentages specified in the sourcing rules and/or bills of distributions. Sourcing decisions are made based on capacity, item standard cost, and rank with respect to penalty costs and constraints.

Example 1: Enforce Capacity Constraints Scenario

Item A is sourced from organizations O1 and O2 with ranks equal to 1 and 2 respectively. If the total costs (item plus penalty costs) are equal in both organizations, and capacity is available only in O2; then this organization is used as the source for item A and ranking is overridden.
Example 2: Enforce Demand Due Dates Scenario

Item A is sourced from organizations O1 and O2 with ranks equal to 1 and 2 respectively. If the total costs (item plus penalty costs) are equal for both organizations, Organization O1 with rank 1 is loaded (or overloaded) to source item A.

Example 3: Enforce Demand Due Dates Scenario

Item A is sourced from organizations O1 and O2 with ranks equal to 1 and 2 respectively. If the total cost (item plus penalty costs) in organization O1 is greater than organization O2, Organization O2 with rank 2 is loaded (or overloaded) to source item A and ranking is overridden.

Nervousness

Nervousness is the condition in which small changes in demand cause large changes in supply (planned order releases). In traditional MRP, plan nervousness causes lost time due to extra setups (and confusion and frustration) on the plant floor. With Oracle ASCP’s ability to generate a single global supply chain plan, the effects of nervousness are magnified because they extend to trading partners (who may not have the same urgency to constantly replan manufacturing to accommodate rapidly changing requirements).

Consider the following example. End-item A has lead time 1 day and order modifier of Fixed Order Period = 3 days. End-item A contains one component B, which has a lead time of 3 days and order modifier Lot for Lot. Initial planned orders for A and B are shown in the next two tables.

Table 5–17

<table>
<thead>
<tr>
<th>Item A</th>
<th>Current</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gross Requirements</td>
<td>0</td>
<td>10</td>
<td>10</td>
<td>10</td>
<td>10</td>
<td>50</td>
</tr>
<tr>
<td>Scheduled Receipts</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Project On-Hand</td>
<td>15</td>
<td>5</td>
<td>-5</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Net Requirements</td>
<td>0</td>
<td>0</td>
<td>5</td>
<td>10</td>
<td>10</td>
<td>50</td>
</tr>
<tr>
<td>Planned Order Due Date</td>
<td>0</td>
<td>0</td>
<td>25</td>
<td>0</td>
<td>0</td>
<td>50</td>
</tr>
<tr>
<td>Planned Order Start Date</td>
<td>0</td>
<td>25</td>
<td>0</td>
<td>0</td>
<td>50</td>
<td>0</td>
</tr>
</tbody>
</table>
Now suppose that the demand for A on day 2 decreases by 5 units. Revised planned orders are shown in the table below.

**Table 5–18**

<table>
<thead>
<tr>
<th>Item B</th>
<th>Current</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gross Requirements</td>
<td>0</td>
<td>25</td>
<td>0</td>
<td>0</td>
<td>50</td>
<td>0</td>
</tr>
<tr>
<td>Scheduled Receipts</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Project On-Hand</td>
<td>25</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>-50</td>
<td>0</td>
</tr>
<tr>
<td>Net Requirements</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>50</td>
<td>0</td>
</tr>
<tr>
<td>Planned Order Due Date</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>50</td>
<td>0</td>
</tr>
<tr>
<td>Planned Order Start Date</td>
<td>0</td>
<td>50</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

**Table 5–19**

<table>
<thead>
<tr>
<th>Item A</th>
<th>Current</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gross Requirements</td>
<td>0</td>
<td>0</td>
<td>70</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Scheduled Receipts</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Project On-Hand</td>
<td>25</td>
<td>25</td>
<td>-50</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Net Requirements</td>
<td>0</td>
<td>0</td>
<td>50</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Planned Order Due Date</td>
<td>0</td>
<td>0</td>
<td>50</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Planned Order Start Date</td>
<td>0</td>
<td>50*</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

**Table 5–20**

<table>
<thead>
<tr>
<th>Item B</th>
<th>Current</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gross Requirements</td>
<td>0</td>
<td>10</td>
<td>5</td>
<td>10</td>
<td>10</td>
<td>50</td>
</tr>
<tr>
<td>Scheduled Receipts</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Project On-Hand</td>
<td>15</td>
<td>5</td>
<td>0</td>
<td>-10</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>
Late Start

Note that the decrease in demand caused the planned orders for A to change from 25 on Day 1 and 50 on Day 4 to 70 on Day 3. This is an example of nervousness at work.

Note further that the resulting change in dependent demand for B causes the planned orders for B to become infeasible, resulting in a late start - this after the demand for A decreased.

Several steps may be taken to reduce planning nervousness of the sort illustrated above.

- Eliminate the use of the order modifier Fixed Order Period for end items. Instead, use Fixed Lot Multiple or Fixed Order Quantity. Reserve Fixed Order Period for lowest-level items only.

- Make use of a planning time fence. A planning time fence of x days freezes planned orders in the interval [plan start date, plan start date + x]. This eliminates near-term disruptions to the manufacturing schedule.

- Make use of a release time fence. A release time fence of x days automatically firms and releases to the execution system planned orders in the time interval [plan start date, plan start date + x]. Subsequent planning runs then treat these planned orders as scheduled receipts, not subject to manipulation via order modifiers. This reduces planning nervousness.

Time fences can be used to freeze near-term plans and reduce nervousness. However, they also reduce the ability of the planning process to accommodate changes in demand. They should be set to the lowest values possible.
Choosing an Objective Function
Supply Chain Modeling

Topics covered in this section include the following:
- Overview of Supply Chain Modeling on page 6-2
- Setting up the Supply Chain on page 6-2
- Setting Supplier Capacity on page 6-4
- Setting Up Alternate and Simultaneous Resources on page 6-10
- Allocating Demand to Suppliers on page 6-18
- Sourcing Example on page 6-20
- Viewing the Supply Chain on page 6-29
- Performing Tasks on the Planning Server on page 6-30

A Day in the Life of a Planner

- General: Update forecasts, create new MDS
- Perform setup, run data collection, set up supply chain
- Select orders and release to production
- Run simulations to compare scenarios to baseline plan
- Set plan options and other planning parameters
- Create material and capacity plan
- Launch plan, evaluate plan performance, and respond to recommendations
- Maintain relationships with customers and suppliers
Overview of Supply Chain Modeling

Oracle ASCP is a tool that integrates manufacturing and distribution into a single planning process. With Oracle ASCP, you can generate plans that include the entire supply chain. In a single step you can schedule and plan material and distribution requirements for multiple organizations, or centrally plan the entire enterprise. You can also include customer and supplier inventories in the supply chain planning process.

Oracle ASCP lets you plan finished products, intermediate assemblies, and purchased items for all facilities in your supply chain. Material plans for feeder plants and distribution centers automatically consider requirements originating from any number of other facilities. You can load planned order demand from multiple user organizations into the master schedule of supplying organizations.

In addition to planning the material requirements of your supply chain, you can plan the requirements for your distribution network. This includes all warehouses, distribution centers, and any location that ships products. You can use these distribution requirements plans (DRPs) as input for your material plans.

You can combine centralized distribution and material planning for items with significant inter-organization supply or demand. You can perform subset planning where you prefer autonomous local planning. Output from the central plan can go into plant-level material plans and vice versa.

Oracle ASCP gives you a transparent view of the virtual enterprise, where all inventory locations participate in the planning process.

Setting up the Supply Chain

You can define the rules that govern the movement of goods throughout your supply chain. This network is the backbone of your material flow, and you can further control its behavior by defining a time-phased replenishment strategy. Oracle ASCP implements this strategy with sourcing rules and bills of distribution (BODs).

Sourcing rules and BODs both describe sourcing supply; in other words, for any organization, they answer the question “from where do I get part A?” (They never say “where do I send part A.”) Sourcing rules apply the answer to one organization or all the organizations in your enterprise. BODs define this behavior across multiple organizations (not just one or all).
Defining Sourcing Rules
You can define sourcing rules that specify how to replenish items in an organization, such as purchased items in plants. Sourcing rules can also specify how to replenish all organizations, as when the entire enterprise gets a subassembly from a particular organization.

If there are conflicts in Sourcing, a predetermined hierarchy will resolve the sourcing conflict. For instance, if you assign a bill of distribution to an organization AUS that tells it to source the part from another organization NYC, you can still define a local sourcing rule at organization AUS to source the part from yet another organization SAC. In this case, the local sourcing rule overrides the bill of distribution.

For more information on defining sourcing rules, see “Defining Sourcing Rules” in the Oracle Master Scheduling/MRP and Oracle Supply Chain Planning User’s Guide. For information on viewing sourcing rule assignments, see “Viewing the Supply Chain” on page 6-29.

Defining BODs
You can define BODs that specify a multilevel replenishment network of warehouses, distribution centers, manufacturing centers (plants), and trading partners.

For more information on defining BODs, see “Defining Bills of Distribution” in the Oracle Master Scheduling/MRP and Oracle Supply Chain Planning User’s Guide. For information on viewing BOD assignments, see “Viewing the Supply Chain” on page 6-29.

Defining Assignment Sets
Once you have defined your sourcing rules and BODs, you must assign them to particular items and/or organizations. These assignments are grouped together in assignment sets. This is where various sourcing strategies define a particular supply chain network.

Each assignment set represents a selection of organizations and/or items you want planned. To influence the planning process, you must include an assignment set in your plan options.

In an assignment set, you can assign your sourcing rules and BODs at different levels, as follows:

- Item-Instance-Organization
Setting Supplier Capacity

- Category-Instance-Organization
- Category-Instance
- Item-Instance
- Instance-Organization
- Instance

These levels allow you to assign a replenishment rule to as many or as few items as possible. For example, a category of items could be defined as packaging material, and a sourcing rule that identifies the suppliers could be assigned to this category.

For more information on assigning a sourcing rule or BOD, “Assigning Rules and Bills” in the Oracle Master Scheduling/MRP and Oracle Supply Chain Planning User’s Guide. For information on viewing sourcing rule and BOD assignments, see “Viewing the Supply Chain” on page 6-29.

Assignment Hierarchy

In the preceding list of assignment levels, rows above override rows below. For instance, Item-Organization overrides Item.

For information on viewing assignments, see “Viewing the Supply Chain” on page 6-29.

Setting Supplier Capacity

Constraints

Oracle ASCP considers the following supplier capacity constraints.

Allocation of Demand Based on Historical Allocations

You can allocate planned orders to sources taking historical allocations into account. Planning uses history to determine the allocations necessary to achieve your targeted allocations.

Allocate Planned Orders With Capacity Constraints

You can specify the capacity of individual suppliers to supply specific items. You can allocate planned orders taking capacity constraints of the suppliers into account. Planning uses the ranking information you specify and first attempts to source the planned orders with the primary sources. If the primary source does not
have the capacity to fulfill the demand, planning suggests sourcing with the alternative sources you have specified, in the priority you have specified.

**Supplier-Specific Order Modifiers**
You can specify supplier-specific order modifiers at an item/supplier site level. Planning respects the order modifier quantities defined for the sources of the item. This enables you to specify more precisely the conditions related to each source.

**Supplier-Specific Lead Times**
You can specify supplier-specific lead times for items. This ensures orders are placed early enough to provide the supplier time to react to your needs.

**Delivery/Reception Frequency Calendars**
You can specify the valid delivery dates for each of your suppliers or supplier/item combinations. The reception schedule defines the dates an organization is able to receive an item from each vendor. Planning adjusts planned orders so that deliveries are planned for valid dates.

**Flexible Tolerance Fences**
You can define capacity tolerance percentages that vary over time for each source. This allows the allocation of demand over capacity by a variable amount depending on the time in the future.

**Setting Up Supplier Capacity**
Please note the following when setting up supplier capacity.

- It is important to select Global in the Supplier Capacity window.
- Processing lead time can be selected in number of days. This is a lead time at the supplier end before the order is processed.
- The delivery calendar should be entered to reflect the days the supplier can deliver the order. Examples: M, W or M, W, F
- Minimum order quantity can be entered if the supplier has to deliver some minimum quantity if an order is placed. For example, if you have set the minimum order quantity to 25, and if 20 is ordered, 25 will be delivered.
Setting Supplier Capacity

- Fixed lot multiple value needs to be entered if the supplier delivers only in certain multiples. For example, if you have set the fixed lot multiple to 5, if quantity 103 is ordered, 105 will be delivered.

- The capacity area of the Supplier Capacity window is used to specify supplier’s capacity for a specific time period. The supplier could have different capacity on different days. For examples, from 10/11/00 to 10/22/00, the supplier could have 50 units/day, and from 10/23/00 to 10/31/00, the supplier could have 70 units/day.

- Tolerance fence values can be determined to reflect how much capacity a supplier can adjust if given enough advanced notice. For example, on 10/24/00, if tolerance percentage is 10, this means that on 10/24/00, the capacity will be 77 units (in the above example).

Setting Supplier Capacity by Time Periods

Supplier capacity can vary by time period. You can specify one daily capacity for period 1 and a different capacity for period 2. Time periods are specified from a start date to an end date.

Note: The methods you use to set capacity by time period vary depending on which version of Oracle Applications you are using.

If you are using version 11i, to set capacity by time period:

1. Navigate to the Purchasing module (you must use the Manufacturing and Distribution Manager responsibility).
2. Choose Purchasing > Supply Base > Approved Suppliers List.
3. Choose the searchlight icon in the toolbar to search for an item.
   The Find ASL Item/Commodity window appears.
4. Choose an item or commodity.
   Supplier information appears.
5. Choose a supplier by clicking in the Supplier field.
6. Click the Attributes button.
   The Items Attributes window appears.
7. Choose the Planning Constraints tab.

8. Enter the numbers of days in advance and the tolerance percentage.

For example, entering 15 days and 5% means that within 15 days, the supplier can increase the capacity by 5%.

**Note:** You can define capacity tolerance percentages that can vary for each of your items. The tolerance fence data in Oracle Purchasing is used to adjust production according to capacity changes for item/supplier combinations when the order is placed. Tolerance fence values can be specified for the capacity fluctuation allowed for available to promise; and used to determine demand based on the amount of advanced notice given to the supplier.

To see an example of how this might be used, please refer to Table 6–6, Table 6–7, and Table 6–8.
Setting Supplier Capacity

If you are using version 10.7 or 11.0, to set capacity by time period:

1. Choose Collection>Workbench.
2. Locate the Item/Supplier combination.
3. [Right-click] the Item/Supplier combination. Select Supplier Capacity.
   The Supplier Capacity window appears.

Figure 6–2  The Supplier Capacity window

4. Enter your supplier capacities by time period.

If you are using version 10.7 or 11.0, to set supplier flexfences:

1. Choose Collection>Workbench.
2. Locate the Item/Supplier combination.
3. [Right-click] the Item/Supplier combination. Select Supplier Flexfences.
   The Supplier Flexfences window appears.
Setting Supplier Specific Planning Constraints

To set a supplier specific lead time:
Enter a value in the Processing Lead Time field.

Using Delivery and Reception Frequency Calendars
You can specify delivery dates for each supplier or supplier/item combinations and create a schedule to define the dates an organization is able to receive items. The planning engine adjusts planned orders so deliveries are scheduled for the dates the receiving organization is available. You can define the delivery calendar just like a regular manufacturing calendar and you can define valid delivery dates and choose the calendar when you associate an item to a supplier site when defining the approved supplier list. The Delivery Calendar is independent of your workday calendar.
To set a delivery and reception frequency calendar:
Choose the value for the delivery/reception calendars.

Using Supplier Specific Order Modifiers
Order modifiers can be specified at the supplier site level, this overrides item level order modifiers. Two order modifiers can be specified:

- Minimum Order Quantity to specify minimum quantities that can be placed on a single order to a particular supplier site.
- Fixed Lot Multiple to specify order lot sizes that must be considered when ordering from a particular supplier. For example, if the Fixed Lot Multiple is 100 units, a planning order requirement for 125 units will result in a recommended order to the supplier for 200 units.

To set an order modifier:
Enter the order modifier value for Minimum Order Quantity or Fixed Lot Multiplier.

Setting up Alternate and Simultaneous Resources
This section discusses some of the advantages of setting up simultaneous and alternate resources and shows you how to set them up.

Advantages
- You can schedule two or more resources (simultaneous resources) to be used at the same time within the job operation. For example: you can schedule a person resource operating a machine resource (i.e., a lathe).
- You can define resource groups within the operation. This lets you give your primary resource a group number. This group can then be replaced by other resource(s). For example: a group of lathes can be replaced by a group of computer numerical control (CNC) machines.
- You have the ability to define substitute resource(s) for each primary resource group defined. This enables you to specify resource sequences that can replace the primary resource group. For example: a group of lathes can be replaced by a group of CNC machines.
- You can assign a priority to the substitute resource groups, and specify under what circumstances the substitute groups are to be considered. For example: you can assign a less expensive resource(s) as priority 1, and a more expensive
resource(s) as priority 2. This means that resource(s) with priority 1 (less expensive) will be used first.

**Required Setup**

**To set up an alternate resource if you use 11/ source:**

1. Sign on using the Manufacturing and Distribution Manager responsibility.
2. From the Navigator, choose Bills of Material > Routings > Routings.
   The Routing window appears.

**Figure 6–4 Routing window**

3. Click on the Find (flashlight) icon.
   The Find Routing window appears.
4. Use this window to find your routing, then click Find button.
   The Routing window appears with your routing.
5. From the main tab, select the operation sequence within which you want to set up alternate resources.

6. Click the operation resource button.

   The Operation Resource window appears with the first resource already entered. This resource is considered as a primary resource.

   **Figure 6–5  Operation Resource**

7. Click the Scheduling Tab.

8. Enter Schedule Sequence number so that you can enable the Alternate button. Schedule sequence number is used to tie the two resources together to establish alternate relationship. Schedule Seq. Number overrides Resource Sequence number.

9. Check the Principal Flag for the resource.

10. Click on Alternate button.

    The BOM Alternate Resource window appears.
11. Enter the alternate resource and choose Replacement Group #. Replacement Group number establishes relative priority. Enter a value of 1 or higher. If you have multiple alternates, enter them as multiple rows with appropriate Replacement Group #s to indicate priorities.

12. Check the Principle Flag for your alternate resource.

To set up an alternate resource if you use 10.7 or 11.0 source:

1. Sign on using the Manufacturing and Distribution Manager responsibility.
2. From the Navigator, choose Bill of Materials > Routings > Routings. The Routings window appears.
Setting up Alternate and Simultaneous Resources

Figure 6–7  The Routings window

3. Click the Find (flashlight) icon.  
The Find Routings window appears.

4. Use this window to find your routing, then click the Find button.  
The Routings window reappears.

5. From the Main tab, select the operations sequence for which you want to set up an alternate resource.

6. Click the Operation Resources Button  
The Operation Resources window appears.

6-14  Oracle Advanced Planning and Scheduling Implementation and User’s Guide
7. Enter the first resource. Fill in the Seq and Resource fields. Click the Schedule tab.

8. Enter 10 in the Schedule Seq field and check the Principal Flag box.

9. Click the Alternates button.

The Alternate Resources window appears.
Figure 6–9  Alternate Resources

10. Enter 1 in the Replacement Group field, 10 in the Schedule Seq field (to match that of the primary resource), and check the Principal resource flag.

The Replacement Group field is useful for designating multiple sets of alternate resources. Assume that R1 is a primary resource with Schedule Seq = 10, Principal Flag checked. It has two sets of alternate resources:

- R2 and R3 together
- R4 alone

In this case, all the alternate resources would have Schedule Seq = 10. R2 and R3 would have a Replacement Group of 1, while R4 would have a Replacement Group of 2. The Principal Resource box would be checked for R2, unchecked for R3, and checked for R4.

To set up simultaneous resources if you use 11i source:

1. Sign on using the Manufacturing and Distribution Manager responsibility.
2. From the Navigator, choose Bills of Material > Routings > Routings.
   The Routing window appears.
3. Click on the Find (flashlight) icon.
The Find Routing window appears.

4. Use this window to find your routing, then click find button.

The Routing window appears with your routing.

5. From the main tab, select the operation sequence within which you want to set up simultaneous resources.

6. Click the operation resource button.

The Operation Resource window appears with the first resource already entered.

7. Enter Schedule Sequence number. Schedule sequence number is used to tie the two resources together to establish simultaneous relationship. Schedule Seq. Number overrides Resource Sequence number.

8. Check the Principal Flag for the first resource.

9. Enter the simultaneous resource for the resource in step number 6 as a second row in the operation resources window. Ensure that schedule sequence number you entered is the same as in step number 7.

10. Do not check the Principle Flag for your simultaneous resource. You can have only one principal resource in a given simultaneous group.

To set up simultaneous resources if you use 10.7 or 11.0 source:

1. Sign on using the Manufacturing and Distribution Manager responsibility.

2. From the Navigator, choose Bill of Materials > Routings > Routings.

   The Routings window appears.

3. Click the Find (flashlight) icon.

   The Find Routings window appears.

4. Use this window to find your routing, then click the Find button.

   The Routings window reappears.

5. From the Main tab, select the operations sequence for which you want to set up a simultaneous resource.

6. Click the Operation Resources Button.

   The Operation Resources window appears.

7. Enter the first resource. Fill in the Seq, Resource, and Usage fields.
8. Enter the second resource you want to use simultaneously. Fill in the Seq, the Resource, and the Usage fields.

9. Click on the name of the first resource. Click the Schedule tab.

10. Designate this resource as the first simultaneous resource. To do this, enter 10 in the Schedule Seq field and check the Principal Resource box.

11. Click on the name of the other resource.

12. Designate this resource as the second simultaneous resource. To do this, enter 10 in the Schedule Seq field (to match that of the first resource) and uncheck the Principal resource box.

Allocating Demand to Suppliers

For more information on the following topics, see “Sourcing Rules and Bills of Distribution” in the Oracle Master Scheduling/MRP and Oracle Supply Chain Planning User’s Guide.

Setting Rank and Allocation

You can define a rank for each source of supply named in the sourcing rules and BODs. You can then define a sourcing percentage for each source within a rank, allowing you to allocate a portion of the total orders to each source.

Splitting Demand According To Sourcing Percentages

In unconstrained plans, demand can be divided and allocated to multiple sources according to target sourcing percentages set in the rules.

The data in these tables demonstrate how allocation percentages for planned orders are divided according to ranking information.

The demand for Item A is shown in the following table.

<table>
<thead>
<tr>
<th>Table 6–1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Demand</td>
</tr>
<tr>
<td>1</td>
</tr>
</tbody>
</table>

Sourcing for Item A is shown in the following table.
Demand is assigned using the ranking information and calculating the percentages assigned to each source to calculate the planned orders.

- S1: $300 \times 0.40 = 120$
- S2: $300 \times 0.30 = 90$
- S3: $300 \times 0.30 = 90$

Three planned orders are created for the quantities of 120, 90, and 90 respectively.

**Note:** All planned orders generated in this process are subject to item order modifiers.

If you run a constrained plan and did not use optimization, the supplies calculated above will be scheduled based on the supplier capacity established for the item. If optimization is used, Oracle ASCP will not split the orders per the sourcing splits in sourcing rules; it will evaluate the suppliers by rank and considers supplier capacities to come up with allocations to suppliers. The rank, lead time and capacity of 3 suppliers is shown in the following table.

**Table 6–2**

<table>
<thead>
<tr>
<th>Item</th>
<th>Source</th>
<th>Rank</th>
<th>Percentage</th>
<th>Effective From</th>
<th>Effective To</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>S1</td>
<td>1</td>
<td>40</td>
<td>05/15</td>
<td>12/31</td>
</tr>
<tr>
<td>A</td>
<td>S2</td>
<td>1</td>
<td>30</td>
<td>05/15</td>
<td>12/31</td>
</tr>
<tr>
<td>A</td>
<td>S3</td>
<td>1</td>
<td>30</td>
<td>05/15</td>
<td>12/31</td>
</tr>
</tbody>
</table>

Allocating Demand to Suppliers Based on Historical Demand

You can allocate planned orders taking into account historical allocations in unconstrained plans. The enhanced sourcing logic considers historical allocations and allows the splitting of demand to achieve target sourcing percentages.
Sourcing Example

Tables 6–4 through 6–11 contain the set up data required to explain the example. Table 6–12 has historical allocation data, which results from previous allocations.

<table>
<thead>
<tr>
<th>Table 6–4  Demand for Item A</th>
</tr>
</thead>
<tbody>
<tr>
<td>Demand for Item A</td>
</tr>
<tr>
<td>1</td>
</tr>
<tr>
<td>2</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Table 6–5  Sourcing Rules Data for Item A</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item</td>
</tr>
<tr>
<td>A</td>
</tr>
<tr>
<td>A</td>
</tr>
<tr>
<td>A</td>
</tr>
<tr>
<td>A</td>
</tr>
<tr>
<td>A</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Table 6–6  Supplier Capacity Profile for Item A</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source</td>
</tr>
<tr>
<td>S1</td>
</tr>
<tr>
<td>S2</td>
</tr>
<tr>
<td>S3</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Table 6–7  Supplier Capacity Tolerance Percentages for Item A</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source</td>
</tr>
<tr>
<td>S1</td>
</tr>
<tr>
<td>S2</td>
</tr>
<tr>
<td>S3</td>
</tr>
</tbody>
</table>
The numbers in Table 6–8 come from applying tolerance percentages from Table 6–7 to the supplier capacity profile in Table 6–6. For example, for supplier S1 on 7/16/98, total supplier capacity is $60 + 10\% (60) = 66$.

**Table 6–9  Supplier Delivery Patterns for Item A**

<table>
<thead>
<tr>
<th>Source</th>
<th>Reception Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>S1</td>
<td>Mondays and Wednesdays</td>
</tr>
<tr>
<td>S2</td>
<td>Mondays</td>
</tr>
<tr>
<td>S3</td>
<td>All days except Fridays</td>
</tr>
</tbody>
</table>

**Table 6–10  Supplier Processing Information for Item A**

<table>
<thead>
<tr>
<th>Source</th>
<th>Processing (days)</th>
</tr>
</thead>
<tbody>
<tr>
<td>S1</td>
<td>3</td>
</tr>
<tr>
<td>S2</td>
<td>2</td>
</tr>
<tr>
<td>S3</td>
<td>2</td>
</tr>
</tbody>
</table>

**Table 6–11  Order Modifiers at Each Source for Item A**

<table>
<thead>
<tr>
<th>Source</th>
<th>Min. Order Quantity</th>
<th>Fixed Lot Multiple</th>
</tr>
</thead>
<tbody>
<tr>
<td>S1</td>
<td>50</td>
<td>5</td>
</tr>
<tr>
<td>S2</td>
<td>25</td>
<td>25</td>
</tr>
<tr>
<td>S3</td>
<td>21</td>
<td>7</td>
</tr>
</tbody>
</table>

Order Modifiers for Item A:
- Minimum Order Quantity: 17
- Fixed Lot Multiple: 88
Sourcing Example

Lead Times for Item A:
- Preprocessing: 0
- Postprocessing: 1

Table 6–12 Historical Allocation Totals

<table>
<thead>
<tr>
<th>Source</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>S2</td>
<td>1400</td>
</tr>
<tr>
<td>S3</td>
<td>1000</td>
</tr>
</tbody>
</table>

Table 6–13 Horizontal Plan

<table>
<thead>
<tr>
<th>Item A</th>
<th>7/10/98</th>
<th>7/11/98</th>
<th>7/14/98</th>
<th>7/15/98</th>
<th>7/16/98</th>
</tr>
</thead>
<tbody>
<tr>
<td>Demand</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>310</td>
<td>280</td>
</tr>
<tr>
<td>Excess Schedule Receipts</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>16</td>
<td>0</td>
</tr>
<tr>
<td>Planned Orders - Org S1</td>
<td>0</td>
<td>0</td>
<td>288</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Planned Orders - Org S2</td>
<td>0</td>
<td>0</td>
<td>125</td>
<td>100</td>
<td>0</td>
</tr>
<tr>
<td>Planned Orders - Org S3</td>
<td>0</td>
<td>0</td>
<td>21</td>
<td>56</td>
<td>0</td>
</tr>
</tbody>
</table>

Allocations for Demand #1

Allocation Calculation Using Historical Allocation Information and Target Percentages for Demand #1:

Quantity = 310

Due Date = 7/15/98 (Tuesday)

Note: The first date of planning horizon is 7/9/98. Only the last three rows in the Source Rules Data (Table 6–5) apply due to effectivity dates. S1 has rank 1 with allocation percentage = 100 (Table 6–5). This indicates that the system should allocate as much as possible to S1 before allocating the excess to other sources.

Based on the input demand data, we can now calculate how the demand for Item A will be satisfied.
Step 1: Allocation to S1
Monday 7/14/98 is the latest reception date (from Table 6–9) before due date (7/15/98). This respects the processing and postprocessing lead times (Table 6–10).
Cumulative capacity = 180 from Table 6–8 (tolerance percentage = 0)
Unsatisfied demand = 310 - 180 = 130
Allocation to S1 = 180
Table 6–14 shows you the resource availability after the allocation of 180 items consumes capacity.

<table>
<thead>
<tr>
<th>Source</th>
<th>7/10/98 (Thurs)</th>
<th>7/11/98 (Fri)</th>
<th>7/14/98 (Mon)</th>
<th>7/15/98 (Tues)</th>
<th>7/16/98 (Wed)</th>
</tr>
</thead>
<tbody>
<tr>
<td>S1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>60</td>
<td>66</td>
</tr>
<tr>
<td>S2</td>
<td>80</td>
<td>80</td>
<td>80</td>
<td>84</td>
<td>88</td>
</tr>
<tr>
<td>S3</td>
<td>20</td>
<td>20</td>
<td>20</td>
<td>21</td>
<td>22</td>
</tr>
</tbody>
</table>

The values in Table 6–14 are derived from subtracting demand satisfied from Table 6–8.

Step 2: Calculation of Historical Allocations for Alternate Sources
Consider S2 and S3 from Table 6–12 with rank 2. Historical allocations beginning 1/1/98.
- S2 = 1400
- S3 = 1000
Total allocations for S2 and S3 = 2400

Step 3: Calculate Allocations to S2 Based on Historical Allocations and Target Sourcing Percentages

Note: Because S2 has a higher sourcing percentage, we will begin with allocations to S2.

Target source percentages: S2 = 60% (see Table 6–5)
Total target allocation = historical allocation + unsatisfied demand = 2400 + 130 = 2530

Using the S2 target allocation percentage, calculate the allocation to S2.

Allocation to S2 + 1400 (historical allocation)/2530 (total target allocation) = 0.6 (source percent)

S2 allocation = 118

**Step 4: Respect Order Modifiers If They Exist**

S2 Allocation: 118 becomes 125 because S2 has a fixed lot multiple of 25 (see Table 6–11). To respect that, 125 needs to be allocated.

**Step 5: Allocation to S2 with Following Constraints: Capacity, Lead Times, and Reception Calendars**

S2: Allocation = 125, Date = 7/15/98

Monday, 7/14/98, is the latest reception date before the due date. This respects the processing and postprocessing lead times.

Cumulative Available Capacity = 240 (tolerance percentage = 0)(see Table 6–14).

Table 6–15 shows you the resource availability after all allocations so far have consumed capacity.

<table>
<thead>
<tr>
<th>Source</th>
<th>7/10/98 (Thurs)</th>
<th>7/11/98 (Frid)</th>
<th>7/14/98 (Mon)</th>
<th>7/16/98 (Tues)</th>
<th>7/16/98 (Wed)</th>
</tr>
</thead>
<tbody>
<tr>
<td>S1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>60</td>
<td>66</td>
</tr>
<tr>
<td>S2</td>
<td>80</td>
<td>35</td>
<td>0</td>
<td>84</td>
<td>88</td>
</tr>
<tr>
<td>S3</td>
<td>20</td>
<td>20</td>
<td>20</td>
<td>21</td>
<td>22</td>
</tr>
</tbody>
</table>

**Step 6: Calculate Allocations to S3 Based on Allocation to S2**

Remaining quantity to allocate = 130 - 125 = 5

**Step 7: Respect Order Modifiers If They Exist**

S3 allocation: 5 becomes 21 because the minimum order quantity for S3 is 21 (see Table 6–11).
Step 8: Allocation to S3 with Following Constraints: Capacity, Lead Times, and Reception Calendars

Tuesday is a valid reception date. The reception date must be moved to Monday 7/14 due to postprocessing lead time. This respects all lead times (see Table 6–9 and Table 6–10).

Cumulative Available Capacity = 60

Table 6–16 shows you the resource availability after all allocations so far have consumed capacity.

<table>
<thead>
<tr>
<th>Source</th>
<th>7/10/98 (Thurs)</th>
<th>7/11/98 (Fri)</th>
<th>7/14/98 (Mon)</th>
<th>7/15/98 (Tues)</th>
<th>7/16/98 (Wed)</th>
</tr>
</thead>
<tbody>
<tr>
<td>S1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>60</td>
<td>66</td>
</tr>
<tr>
<td>S2</td>
<td>80</td>
<td>35</td>
<td>0</td>
<td>84</td>
<td>88</td>
</tr>
<tr>
<td>S3</td>
<td>20</td>
<td>19</td>
<td>0</td>
<td>21</td>
<td>22</td>
</tr>
</tbody>
</table>

Note: Scheduled receipt excess = 16 (for netting gross requirements for the next planning period) (see Table 6–13).

Table 6–17 Summary of Planned Order Allocations for Demand #1

<table>
<thead>
<tr>
<th>Source</th>
<th>Allocation</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>S1</td>
<td>180</td>
<td>7/14/98</td>
</tr>
<tr>
<td>S2</td>
<td>125</td>
<td>7/14/98</td>
</tr>
<tr>
<td>S3</td>
<td>21</td>
<td>7/14/98</td>
</tr>
</tbody>
</table>

The values for S1 come from "Step 1: Allocation to S1", the values for S2 come from "Step 4: Respect Order Modifiers If They Exist", and the values for S3 come from "Step 7: Respect Order Modifiers If They Exist".

Input Data for Demand #2

(see Table 6–4)

Quantity = 280

Due Date = 7/16/98 (Wednesday)
Unsatisfied Demand = 280 - 16 (scheduled receipt excess) = 264

**Allocations for Demand #2**

**Step 1: Allocation to S1**

Wednesday is a delivery date. The receiving date must be moved to Tuesday, 7/15, due to postprocessing lead time.

Tuesday is not a reception date. The allocation date is moved to Monday, 7/14/98.

Cumulative available capacity = 0 (tolerance percentage = 0) (see Table 6–16), hence allocation to S1 = 0

Unsatisfied demand = 280 - 16 (excess supply due to order modifiers from previous bucket(s)) = 264

**Step 2: Calculation of Historical Allocations for Alternate Sources**

Consider S2 and S3 with rank 2 from Table 6–12 and Table 6–17.

Historical Allocations beginning 1/1/98.

S2: 1400 + 125 = 1525
S3: 1000 + 21 = 1021

Total Allocations for S2 and S3 = 2546

**Step 3: Calculate Allocations to S2 Based on Historical Allocations and Target Sourcing Percentages**

**Note:** Because S2 has a higher sourcing percentage, we will begin with allocations to S2.

Target Sourcing Percentages: S2 = 60%

Total Target Allocation = Historical allocation + New allocation = 2546 + 264 = 2810

Using the S2 target allocation percentage, calculate the allocation to S2.

\[
\frac{S2 + 1525}{2810} = 0.6
\]

S2 Allocation = 161
Step 4: Respect Order Modifiers If They Exist
S2 Allocation: 161 becomes 175 because S2 has a fixed lot multiple of 25 (see Table 6–11), and to respect that 7*25 = 175 needs to be allocated.

Step 5. Allocation to S2 With Following Constraints: Capacity, Lead Times, and Reception Calendars
S2: Allocation = 175.

Date = 7/16/98 (Wednesday)
Reception date must be moved to Tuesday 7/15 due to postprocessing lead time of one day (see Table 6–11). Tuesday is not a reception date. Allocation date moved to Monday 7/14/98. This respects the processing and post-processing lead times.
Cumulative Available Capacity = 115 (see Table 6–16)
Respecting order modifiers: allocation of 115 becomes 125 because S2 has a fixed lot multiple of 25. To respect that, 5 x 25 = 125 needs to be allocated. However, accumulated capacity for S2 by 7/14/98 is 115, which is not a multiple of 25. Therefore, 100 units, which is the next lower value respecting order modifier and capacity will be scheduled.

Table 6–18 shows you the resource availability after all allocations so far have consumed capacity.

<table>
<thead>
<tr>
<th>Source</th>
<th>7/10/98 (Thurs)</th>
<th>7/11/98 (Fri)</th>
<th>7/14/98 (Mon)</th>
<th>7/15/98 (Tues)</th>
<th>7/16/98 (Wed)</th>
</tr>
</thead>
<tbody>
<tr>
<td>S1</td>
<td>0</td>
<td>0</td>
<td>60</td>
<td>66</td>
<td></td>
</tr>
<tr>
<td>S2</td>
<td>15</td>
<td>0</td>
<td>84</td>
<td>88</td>
<td></td>
</tr>
<tr>
<td>S3</td>
<td>20</td>
<td>19</td>
<td>0</td>
<td>21</td>
<td>22</td>
</tr>
</tbody>
</table>

Step 6: Calculate Allocations to S3 Based on Allocation to S2
Remaining quantity to allocate = 264 - 100 = 164

Step 7: Respect Order Modifiers If They Exist
S3 Allocation: 164 becomes 168 because S3 has a fixed lot multiple of 7, so 24*7 = 168 needs to be ordered.
Step 8. Allocation to S3 With Following Constraints: Capacity, Lead Times, and Reception Calendars

Allocation date moved to Tuesday 7/15/98 due to post-processing lead time. Tuesday is a valid reception date. This respects all lead times.

Cumulative Available Capacity = 60

Respecting order modifiers: allocation of 60 becomes 63 because S3 has an order modifier of 7. To respect that, \(9 \times 7 = 63\) needs to be allocated. However, accumulated capacity at S3 by 7/14/98 is 60, which is not a multiple of 7. Therefore, 56 units, which is the next lower value respecting order modifiers and capacity will be scheduled.

Unsatisfied quantity = 164 - 56 = 108

Table 6–19 shows you the capacity available after all allocations so far have consumed capacity.

<table>
<thead>
<tr>
<th>Source</th>
<th>7/10/98 (Thurs)</th>
<th>7/11/98 (Fri)</th>
<th>7/14/98 (Mon)</th>
<th>7/15/98 (Tues)</th>
<th>7/16/98 (Wed)</th>
</tr>
</thead>
<tbody>
<tr>
<td>S1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>60</td>
<td>66</td>
</tr>
<tr>
<td>S2</td>
<td>15</td>
<td>0</td>
<td>0</td>
<td>84</td>
<td>88</td>
</tr>
<tr>
<td>S3</td>
<td>4</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>22</td>
</tr>
</tbody>
</table>

Search for Alternative Sources:

- S1: Not possible due to post-processing lead time and reception date constraints.
- S2: Wednesday is not a delivery date. Tuesday is not a delivery date.

Allocation of Excess Demand:

- Excess Demand = 108
- Allocate excess demand to primary source S1.
- Post-processing = 1 day becomes Tuesday, 7/15/98 (7/16 minus 1 day of postprocessing = Tuesday, 7/15).
- Because Tuesday 7/15 is not a delivery date, the load excess is moved to Monday 7/14/98.

Table 6–20 shows you the capacity availability after all allocations so far have consumed capacity.
Viewing the Supply Chain

There are several view options with Oracle ASCP including:

- Viewing Sourcing Rules
- Viewing BOD
- Viewing Sourcing Rule and BOD Assignment Set
- Viewing Sourcing Assignment Hierarchy

Viewing Sourcing Rules

You can retrieve sourcing rules for reference. After retrieving a sourcing rule, you can display it in a convenient, hierarchical representation, or you can locate the assignment sets in which it is assigned.
Performing Tasks on the Planning Server

You can perform the following tasks only on the Planning Server:

- Create instances
- Define plan names and its options
- Create priority rules

You can perform the following tasks on the source or Planning Server:

For more information, see “Viewing Sourcing Rules” in the Oracle Master Scheduling/MRP and Oracle Supply Chain Planning User’s Guide.

Viewing BODs

You can quickly and easily retrieve BODs for reference. After retrieving a bill of distribution, you can display it in a convenient, hierarchical representation, or you can locate the assignment sets in which it is assigned.

For more information, see “Viewing Bills of Distribution” in the Oracle Master Scheduling/MRP and Oracle Supply Chain Planning User’s Guide.

Viewing Assignment Set

Once you have defined your sourcing rules and BODs, you must assign them to particular items and/or organizations. These assignments are grouped together in assignment sets. This is where your various sourcing strategies define a particular supply chain network.

You can view your assignment sets to review particular sourcing schemes, locate particular assignments of sourcing rules or BODs, or view the supply chain bill for a particular assignment set.

For more information, see “Viewing Sourcing Rules” and “Viewing Bills of Distribution” in the Oracle Master Scheduling/MRP and Oracle Supply Chain Planning User’s Guide.

Viewing Sourcing Assignment Hierarchy

You can display all the assignment levels and identify the active assignment level for an item.

For more information, see “Viewing Assignment Hierarchy” in the Oracle Master Scheduling/MRP and Oracle Supply Chain Planning User’s Guide.
Performing Tasks on the Planning Server

- Add new sourcing rules
- Add new assignment sets
- Add new bill of distribution
- Change the order priority for any independent demand
- Add/change supplier capacity and flex fences
- Change plan parameters
Simulations

Topics covered in this section include the following:

- Overview of Simulations on page 7-2
- Simulation Scenarios on page 7-2
- Simulation Modes on page 7-3
- Running Net Change Replan Simulations on page 7-5
- Using Undo to Reverse Actions or Changes on page 7-9
- Comparing Scenarios Quantitatively on page 7-12

A Day in the Life of a Planner

Generate/Update forecasts, create new MPS

Perform set-up, run data collection, set up supply chain

Set plan options and other planning parameters

Create material and capacity plan

Maintain relationships with customers and suppliers

Select orders and release to production

Run simulations to compare scenarios to baseline plan

Launch plan, evaluate plan performance, and respond to recommendations
Overview of Simulations

Oracle ASCP provides online interactive simulation planning so you can simulate changes and respond to changing conditions. Simulations can be run by changing plan inputs and parameters and rerunning the new, simulated plan. The new simulated plan can be saved as a new plan and compared to the original (baseline) plan. You can copy and version your plan, save and compare exceptions, and visually highlight changes.

Simulation Scenarios

You can simulate changes to material and resource capacity simultaneously. You can also simulate changes to the objectives and weights used for optimization or simulate changes to demand priorities. In addition, you can simulate the effects of changing planned orders.

Supplier Capacity

To simulate item supply changes, you can add new supplier capacity and adjust a supplier’s capacity (for example, change daily capacity from 100 units to 200 units) over a specified time frame.

Resource Availability

You can add new resource availability and modify how many resources are available over user defined time frame. Resource constraints includes available machine hours, available worker hours, and adding or removing shifts.

Supplies

To simulate supply changes, you can:
- Add new planned orders
- Firm planned orders, discrete jobs, and purchase orders
- Modify quantities, dates, sources, and alternates

Demands

You can alter the demand priority of any demand. Oracle ASCP then modifies the existing schedule to accommodate changes to demand priority. To simulate
demand changes, you can modify quantities and due dates for independent
demand (MDS entries). You can also add new Manual MDS.

**Optimization Objectives**

You can decide the relative importance of the many objectives Oracle ASCP tracks
according to your business or industry sector. These will provide the basis for
Oracle ASCP in optimizing the plan. For example, for some industries, inventory
turns are a much more important performance indicator than cycle time. The
following objectives are supported by Oracle ASCP:

- maximize inventory turns
- maximize plan profit
- maximize ontime delivery

You can also modify the weights that you have assigned for each objective and have
the system generate an optimal plan based on the new objectives.

**Simulation Modes**

You can use the Planner Workbench to simulate and evaluate changes to specific
orders, supplier capacity, and resource capacity. Additions to demand and supplies
can also be simulated. Net change replan simulation is a powerful What If analysis
feature that lets you update a material plan by planning only the items you have
changed in the Planner Workbench. Replanning is based on the snapshot data
gathered during the original planning run and the changes you have made with the
Planner Workbench. No other transactions, such as receipts in Oracle Inventory, are
considered in the replanning process. You can also implement the changes
recommended by net change replan.

**Net Change Replan**

Net change replan generates only those plan outputs that have changed compared
to a baseline plan. It allows evaluation of plans within seconds when minor changes
are made in the plan. When running net change replan you can run either batch
mode replan or online planner.

**Batch Mode Planner**

Batch mode lets you communicate directly with the database while making and
replanning your changes. While frequent replanning can place an excessive load on
system resources, batch mode gives other users access to the plan while you are performing simulations.

Batch mode is particularly useful when you want to complete a single replanning cycle.

**Online Planner**

The online planner lets you simulate and replan manual changes to supply and demand records without increasing database traffic. Starting an online session loads all planning data into memory. Afterwards, you can make changes to that data, then replan the changes to see their effect on the rest of the plan. You can implement and release your changes from within the session, or you can make changes and replan as many times as necessary before the release.

As a simulation tool, the online planner lets you see the effect of the changes you make in the Planner Workbench. As an implementation tool, it reduces unnecessary database transactions and offers rapid plan revision and execution. As a monitoring tool, it generates the full set of exception messages following a replan. It also lets you save the exceptions generated by previous sessions, offering you feedback on successive planning decisions.

The online planner is particularly useful when performing frequent simulation on a single plan. In online mode, you can do this without suffering a significant loss in performance.

The following are some of the rules of operation for the Online Planner:

- You can view any plan even if another user is running online simulation.
- You are not allowed to start another Online Planner session nor are you allowed to make changes to the plan when Online Replan is progressing.
- You are allowed to enter changes before and after, but not during Online Replan session.
- The changes you have made prior to Online Replan are incorporated into the replan.
- You can view all of the changes that have been made since the last batch rerun of the plan.
- You can see the user and timestamp of all changes.
- The changes you made during an online session can be undone.
Running Net Change Replan Simulations

You have two options for running net change replan simulations:

- Batch replan
- Online replan

Running Batch Replan

Note: Save and make a copy of your baseline plan before running batch replan (make modifications only to the copy). Otherwise, you will lose visibility to your baseline plan. See Using Undo to Reverse Actions or Changes on page 7-9.

To run a batch replan:
1. Select a plan in the Planner Workbench.
2. Make the desired changes to the plan.
3. Run your plan again by choosing Plan > Batch Replan.
4. Make a note of the concurrent request ID and choose OK.
5. Verify that the replanning process is complete.
6. Re-query the plan to review your changes.
7. If you are not satisfied with the replan results, repeat steps 2 through 6 as needed.

Running Online Replan

Note: Save and make a copy of your baseline plan before running online replan (make modifications only to the copy). Otherwise, you will lose visibility to your baseline plan.

To run online replan:
1. Select a plan in the Planner Workbench window.
2. Choose Plan > Start Online Planner.
3. Make a note of the concurrent request ID and choose OK.
While the online planner loads the data into memory, you will see the Online Planner Status window. This window displays the progress of the loading and signals you when the session is ready for planning.

4. When the status window informs you that the session is ready for planning, close the window to return to the Planner Workbench. Your online planner session is now active.

5. Make the desired changes to your plan.

6. Save the plan.

7. Choose Plan > Online Replan.

To check the status of an online planner session:

Choose Plan > Online Planner Status.

The Online Planner Status window appears.

Figure 7–1 The Online Planner Status window
Running Net Change Replan Simulations

Note: Though you can view a plan while another user is running an online simulation for that plan, you can neither make changes to the plan nor start another simulation until the current run completes. An icon denoting that online planning is running accompanies the plan in the left pane tree.

Note: It is recommended that the online planner be stopped as soon as a series of simulations is complete. Multiple active online planners could consume a lot of system resource (CPU/memory) in a production environment.

To stop an online planner session:
1. Choose Plan > Stop Online Planner.
2. Click OK to confirm your choice.

Note: Do not stop the online planner until all simulations are complete.

To save your actions:
1. Choose Plan > Save actions.
   A pop-up window indicates the version number of your saved actions. Note this version number if you wish to view your actions later.

To view your actions:
1. Select the Actions tab (left pane) then scroll down to the desired version.
Running Net Change Replan Simulations

**Figure 7-2  Actions tab**

<table>
<thead>
<tr>
<th>Action Type</th>
<th>Version</th>
<th>Count</th>
</tr>
</thead>
<tbody>
<tr>
<td>Late Sales Orders and Forecasts</td>
<td>1</td>
<td>48</td>
</tr>
<tr>
<td>Material and Resource Capacity</td>
<td>1</td>
<td>17</td>
</tr>
<tr>
<td>Substitutes and Alternates Used</td>
<td>1</td>
<td>18</td>
</tr>
<tr>
<td>Item Exceptions</td>
<td>1</td>
<td>4</td>
</tr>
<tr>
<td>Late Sales Orders and Forecasts</td>
<td>current</td>
<td>48</td>
</tr>
<tr>
<td>Material and Resource Capacity</td>
<td>current</td>
<td>8</td>
</tr>
<tr>
<td>Substitutes and Alternates Used</td>
<td>current</td>
<td>18</td>
</tr>
<tr>
<td>Item Exceptions</td>
<td>current</td>
<td>4</td>
</tr>
</tbody>
</table>
Using Undo to Reverse Actions or Changes

The Undo feature allows you to reverse changes for online planning. The following list details how this feature functions:

- You can undo your changes in any order, as long as the record you are undoing has not had subsequent changes made to it.
- You can undo changes until the plan is rerun in batch mode.
- You can view online planning changes using Undo Summary.
- You can view all of the changes that have been made since the last batch rerun of the plan. You can see the user and timestamp of all changes.
- You can tell immediately upon entering the Planner Workbench that the online planner is running or that it has been run.
- You can create a savepoint/bookmark and undo all of your changes to that savepoint. Bookmark names are not required to be unique.
- You cannot undo a release.
- You cannot undo changes made to the implement properties.

To view the Undo Summary for a plan:

1. Select Plan > Undo Summary.

The Undo Summary window appears. This window lists the user and timestamp for every action/change made to the plan since the last batch replan. It includes online planning changes, sorted by user.
Using Undo to Reverse Actions or Changes

**Figure 7–3 The Undo Summary window**

To view details on an action:
1. Select an action in the Undo Summary window.
2. Click the Detail button.
   The Undo Detail window appears.
To undo your actions:
You can undo actions you make in the online planner in any order so long as no one else has made subsequent changes to the record you are undoing.

Note: You can only undo changes made between batch replan runs.

1. Select Plan > Undo Summary.
   The Undo Summary window appears (See Figure 7-3).
2. Select a change you initiated in the online planner.
3. Click the Undo button.
To create a bookmark:
You can create save points for undoing online planner actions. Subsequently, you can undo only those online planner actions made after the bookmark.

1. Select Plan > Add Undo Bookmark.
2. In the pop-up window, enter a name for the bookmark.

Comparing Scenarios Quantitatively

Simulation lets you compare Key Performance Indicators (KPIs) of multiple plans and make necessary changes to reach your goals. Standard KPIs available in Oracle ASCP are:

- Inventory Turns
- Ontime Delivery
- Planned Utilization
- Margin Percentage
- Margin
- Cost Breakdown

You can quantify the results of simulation scenarios and graphically compare the results of multiple scenarios to help you choose the plan that best meets your performance objectives.

To compare scenarios quantitatively:
1. Navigate to the Planner Workbench.
2. Select the baseline plan.
3. While holding the shift key, select the simulated plan.

KPIs for both plans show side by side.

Note: You cannot undo another user’s changes. If you attempt to do so, you will receive an error message.
Figure 7-5 The Multiple Plans Comparison

Inventory Turns

Online Delivery

Margin Percentage

Planned Utilization

Key Indicators: Planned vs. Target

Record 1/1
Comparing Scenarios Quantitatively
Topics covered in this section include the following:

- Overview of Optimization on page 8-2
- Optimization Objectives on page 8-2
- Setting Penalty Factors on page 8-4
- Comparing Different Optimization Runs on page 8-28
Overview of Optimization

In optimized supply chain plans, Oracle ASCP uses a combination of traditional linear programming and constraint programming techniques.

You can choose to optimize your plans to meet one or more of the following objectives:

- maximize inventory turns
- maximize plan profit
- maximize ontime delivery

The plan objective is derived by combining and weighting chosen objectives. Optimization determines the best possible sources of supply, considering all your material, resource, and transportation constraints.

Optimized plans differ from unconstrained plans and constrained plans without optimization in that optimized plans make more choices automatically. Specifically, optimized plans automatically choose (on the basis of minimizing plan objective cost) the following:

- alternative bills of material
- alternative routings
- alternative resources

Optimized plans will override the rankings and sourcing percentages provided in sourcing rules and bills of distribution as necessary in order to minimize the plan objective cost.

Optimization Objectives

Multiple optimization objectives can be met by assigning weights to each. This is done using the Optimization tab.

For more information on the Optimization tab, see Chapter 5, “Defining Plans.”
Figure 8–1  The Optimization Tab

Following are descriptions of the various optimization objectives:

**Maximize Inventory Turns**  This objective is achieved by minimizing the total inventory for the plan duration.

**Maximize Plan Profit**  The following are considered:
- Item cost
- Resource cost
- Inventory carrying cost
- Transportation cost

Other penalty costs are considered, such as demand lateness, resource over utilization, etc.

**Maximize Ontime Delivery**  This maximizes ontime delivery by trying to ensure that all demand is met ontime. Penalty factors specify the relative importance of demands when maximizing ontime delivery.
Setting Penalty Factors

Oracle ASCP depends a great deal on data related to costs, penalties, and priorities above and beyond what is available from the ERP system. You can set penalty factors at different levels using flexfields, plan options, or profile options. Flexfields let you set penalty factors at the most discrete level. For example, you can set the Penalty Factor for Late Demand at the Demand, Item, or Org level using flexfields. Plan options and profile options let you set the same penalty factor at the Plan level and Site level, respectively.

CAUTION: Penalty costs are different from penalty factors. Penalty costs are the product of the penalty factor and some other parameter such as list price, item cost, resource cost, or transportation cost.

For all of the steps related to setting penalty factors, please log in as Manufacturing and Distribution Manager, unless otherwise noted. You must run the Create Planning Flexfields program beforehand for the flexfields used for setting penalty factors to be operational. Please see Appendix B, Oracle ASCP Flexfields for additional details. Finally, please refer to Chapter 5, "Choosing an Objective Function" for help with setting actual penalty costs.

For more information on setting penalty factors, see Appendix A, "Profile Options" and Appendix B, "Oracle ASCP Flexfields."

Setting Late Demand Penalty Costs

The following figure shows the hierarchy for Setting Penalty Factor for Late Demand.
### Hierarchy for Setting Penalty Factor for Late Demand

1. **Is the penalty cost defined at the demand level?**
   - **Yes**: Use this value
   - **No**: Is the penalty cost defined at the item level?
     - **Yes**: Use this value
     - **No**: Is the penalty cost defined at the org level?
       - **Yes**: Use this value
       - **No**: Is the penalty cost defined at the plan level?
         - **Yes**: Use this value
         - **No**: Is the penalty cost defined through a profile option?
           - **Yes**: Use this value
           - **No**: Use the internal default value

If the data is not available at a given level, Oracle ASCP will check for available data at the next level in the hierarchy and so on.

**To set late demand penalty cost at the demand level:**

1. From the Navigator, choose Supply Chain Planning > Forecast > Entries.
   The Item Forecast Entries window appears.
Setting Penalty Factors

Figure 8–2  Item Forecast Entries

2. Select a forecast.
3. Select the flexfield.

The MRP Forecast Dates window appears.

Figure 8–3  MRP Forecast Dates window

4. Enter the Late Forecasts Penalty factor.
To set late demand penalty cost at the item level:

1. From the Navigator, choose Inventory > Items > Master Items.
   The Master Item window appears.

2. Click the Item field.
3. Select View menu > Find.
   The Find Master Items window appears.
4. Enter a search string for the item in the Item field and click the Find button.
   The Master Item window appears.
5. Select the flexfield.
   The Items window appears.
6. Enter the Late Demands Penalty factor.

To set late demand penalty cost at the organization level:

1. From the Navigator, choose Inventory > Setup > Organizations > Parameters.
   The Organization Parameters window appears.
2. Select the flexfield.
   
   A second Organization parameters window appears.
Setting Penalty Factors

Figure 8–7  The Organization parameters window

3. Enter the Late Demands Penalty factor.

To set late demand penalty cost at the plan level:
1. Select the Advanced Supply Chain Planner responsibility.
2. From the Navigator, choose Manufacturing Plan [or Distribution, or Production] > Options.
3. Select a plan.
   The Plan Options window appears.
4. Select the Optimization tab.
5. Enter the penalty factor in the Demand Lateness field.

**To set late demand penalty cost through a profile option:**

1. Log in as the System Administrator.
2. From the Navigator, choose Profile > System.
   The Find System Profile Values window appears.
3. Enter the profile name MSO: Penalty Cost Factor for Late Demands in the Profile field and click the Find button.
   The System Profile Values window appears.
4. Enter the penalty factor in the Site column.

**Setting Penalty Factors for Exceeding Material Capacity**

The following figure shows the hierarchy for Setting Penalty Factor for Exceeding Material Capacity.
Hierarchy for Setting Penalty Factor for Exceeding Material Capacity

1. From the Navigator, choose Purchasing > Supply Base > Approved Supplier List.
2. Click the Attributes button.
   The Supplier-Item Attributes window appears.

If the data is not available at a given level, Oracle ASCP will check for available data at the next level in the hierarchy.

To set penalty factors for exceeding material capacity at the item/supplier level:

1. From the Navigator, choose Purchasing > Supply Base > Approved Supplier List.
2. Click the Attributes button.
   The Supplier-Item Attributes window appears.
3. Select the flexfield.
   The Attributes window appears.

   **Figure 8–11  The Attributes window**

4. Enter the Material Over-Capacity Penalty factor.
To set penalty factors for exceeding material capacity at the item level:

1. From the Navigator, choose Inventory > Items > Master Items.

   The Master Item window appears.

   Figure 8–12 The Master Item window

2. Click the Item field.

3. Select View menu > Find.

   The Find Master Items window appears.

4. Enter a search string for the item in the Item field and click the Find button.

   The Master Item window appears.

5. Select the flexfield.

   The Items window appears.
6. Enter the Material Over-Capacity Penalty factor.

**To set penalty factors for exceeding material capacity at the organization level:**

1. From the Navigator, choose Inventory > Setup > Organizations > Parameters. The Organization Parameters window appears.
2. Select the flexfield.

   A second Organization Parameters window appears.
3. Enter the Material Over-Capacity Penalty factor.

To set penalty factors for exceeding material capacity at the plan level:
1. Select the Advanced Supply Chain Planner responsibility.
2. From the Navigator, choose Manufacturing Plan [or Distribution, or Production] > Options.
3. Select a plan.
   The Plan Options window appears.
4. Select the Optimization tab.
5. Enter the penalty factor in the Exceeding material capacity field.

To set penalty factors for exceeding material capacity through a profile option:

1. Log in as the System Administrator.
2. From the Navigator, choose Profile > System.
   The Find System Profile Values window appears.
3. Enter the profile name MSO: Penalty Cost Factor for Exceeding Material Capacity in the Profile field and click the Find button.
   The System Profile Values window appears.
4. Enter the penalty factor in the Site column.

**Setting Penalty Factors for Exceeding Resource Capacity**

The following figure shows the hierarchy for Setting Penalty Factor for Exceeding Resource Capacity.
If the data is not available at a given level, Oracle ASCP will check for available data at the next level in the hierarchy.

**To set penalty factors for exceeding resource capacity at the resource level:**

1. From the Navigator, choose Bills of Material > Routings > Departments.
   The Departments window appears.
2. Find a department.
3. Click the Resources button.
   The Resources window appears.
4. Select the flexfield
   The Department Resource Information window appears.

5. Enter the Resource Over-Capacity Penalty factor.
To set penalty factors for exceeding resource capacity at the organization level:

1. From the Navigator, choose Inventory > Setup > Organizations > Parameters.
   The Organization Parameters window appears.

   *Figure 8–20*  The Organization Parameters window

2. Select the flexfield.
   The Organization Parameters window appears.
3. Enter the Resource Over-Capacity Penalty factor.

▶ To set penalty factors for exceeding resource capacity at the plan level:
   1. Select the Advanced Supply Chain Planner responsibility.
   2. From the Navigator, choose Manufacturing Plan [or Distribution, or Production] > Options.
   3. Select a plan.
      The Plan Options window appears.
   4. Select the Optimization tab.
5. Enter the penalty factor in the Exceeding resource capacity field.

To set penalty factors for exceeding resource capacity through a profile option:
1. Log in as the System Administrator.
2. From the Navigator, choose Profile > System.
   The Find System Profile Values window appears.
3. Enter the profile name MSO: Penalty Cost Factor for Exceeding Resource Capacity in the Profile field and click the Find button.
   The System Profile Values window appears.
Setting Penalty Factors

4. Enter the penalty factor in the Site column.

Setting Penalty Factors Using Plan Options

There are four penalty factors that can be set in the Optimization tab. For more information on the Optimization tab, see Chapter 5, "Defining Plans."

- Penalty Factor for Late Demand
- Penalty Factor for Exceeding Material Capacity
- Penalty Factor for Exceeding Transportation Capacity
- Penalty Factor for Exceeding Resource Capacity

Penalty Cost for Late Demand
The penalty cost for late demand (forecasts and sales orders) is equal to:

\[(\text{penalty factor}) \times \text{(list price)}\]

Penalty Cost for Exceeding Material Capacity
The penalty cost for exceeding material capacity is equal to:

\[(\text{penalty factor for exceeding material capacity}) \times \text{(item cost)}\]
Penalty Cost for Exceeding Transportation Capacity
The penalty cost for exceeding transportation capacity is equal to:

\[(\text{penalty factor for exceeding transportation capacity}) \times (\text{transportation cost})\]

Penalty Cost for Exceeding Resource Capacity
The penalty cost for exceeding resource capacity is equal to:

\[(\text{penalty factor for exceeding resource capacity}) \times (\text{resource cost})\]

---

**Note:** Unit costs (list price, item cost, and so on) play an important role in determining penalty costs.

---

**Setting Penalty Factors Using Optimization Profile Options**

These profile options can be used to specify default values necessary for optimization.

---

**Note:** For detailed information on setting these and other profile options, see Appendix A, "Profile Options."

---

Penalty Factor for Late Demand
Use this profile option to define a penalty factor common to all demands. The demands include sales orders and forecasts.

Penalty Factor for Exceeding Material Capacity
Use this profile option to define a global penalty factor for exceeding material capacity. This value will be common to all items in the plan.

Penalty Factor for Exceeding Resource Capacity
Use this profile option to define a global penalty factor for exceeding resource capacity. This value will be common to all manufacturing and transportation resources in the plan.

Inventory Carrying Costs Percentage
Use this profile option to specify the inventory carrying costs percentage for all items in the plan. The value is specified as a number between 0 and 1.
Comparing Different Optimization Runs

**Maximum Allowable Days Late**
Use this profile option to limit the number of days by which a demand or unfirmed scheduled receipt can be moved out. This value is used to improve performance during optimization. The value is specified as an integer greater than 0.

**Comparing Different Optimization Runs**
You can generate an optimized and executable plan based on your plan objectives as well as material, resource, and transportation constraints. Oracle ASCP provides online interactive simulation planning so you can rapidly simulate changes and respond to changing conditions. For example, you could compare two optimized plans with different objective weights and compare the results based on performance indicators.

Results of optimized plans are stored for use by future planning runs.

For more information on simulations see Chapter 7, “Simulations.” For more information on evaluating plan performance and comparing multiple plans, see Chapter 9, “Performance Management.”
Topics covered in this section include the following:

- Overview of Performance Management on page 9-2
- Key Performance Indicators (KPIs) on page 9-2
- KPI Setup on page 9-8
- Tracking Plan Performance Using KPIs on page 9-10
- Making Improvements Based on KPIs on page 9-10
- Exception Messages on page 9-12
- Making Decisions Based on Exceptions on page 9-20
- Recommendations on page 9-20

A Day in the Life of a Planner
Overview of Performance Management

Oracle ASCP is integrated with the Oracle Business Intelligence System (BIS) performance management system. BIS lets you set the organizational objectives.

Note: These objectives, known as Performance Measures in BIS, are referred to as Key Performance Indicators (KPIs) in Oracle ASCP.

KPIs are used to drive continuous improvement in your enterprise. You can set performance targets and exception tolerances by business units or by period and automatically notify the appropriate people when exceptions arise. For information on setting targets, refer to the Oracle Business Intelligence System Implementation Guide.

You can also compare the KPIs for multiple plan simulations using the Planner Workbench.

Key Performance Indicators (KPIs)

Oracle APS (Advanced Planning and Scheduling) provides eight KPIs against which a plan’s performance can be compared. The following table shows the KPIs that are available in the Oracle ASCP and Oracle Risk Optimization modules.

<table>
<thead>
<tr>
<th>KPIs</th>
<th>ASCP</th>
<th>RO</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inventory Turns</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Margin Percentage</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Planned Utilization</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Ontime Delivery</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Margin</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Cost Breakdown</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Service Level</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Inventory Value</td>
<td>No</td>
<td>Yes</td>
</tr>
</tbody>
</table>
Figure 9–1  Oracle ASCP Key Performance Indicators
Following are descriptions of various KPIs.

**Inventory Turns**

Inventory turns for a given plan between time periods $t_1$ and $t_2$ are calculated as follows:

\[
\text{(annual) inventory turns} = \frac{\text{dollar value of MDS demand in period } [t_1, t_2]}{\text{dollar value of average inventory in period } [t_1, t_2]} \times \frac{365}{t_2 - t_1}
\]

The dollar value of average inventory in period $[t_1, t_2]$ is calculated as:

\[
\text{dollar value of average inventory in period } [t_1, t_2] = \frac{\text{inventory at } t_1 + \text{inventory at } t_2}{2}
\]

where $t_1$ and $t_2$ are expressed in units of days.

Inventory at time $t_2$ is calculated as:

\[
\text{inventory at time } t_2 = \text{inventory at time } t_1 + \text{purchase orders during period } [t_1, t_2]
\]
\[
\quad + \text{purchase requisitions during period } [t_1, t_2]
\]
\[
\quad + \text{planned orders during period } [t_1, t_2]
\]
Margin Percentage

Margin Percentage is the net difference between planned revenues and planned production costs.

Margin Percentage = \[
\frac{\left(\text{total shipment units} \times \text{standard price} \times \text{standard discount}\right) - \left(\text{total shipment units} \times \text{standard cost}\right)}{\left(\text{total shipment units} \times \text{standard price} \times \text{standard discount}\right)}
\]

where total shipment units include sales orders and forecasts.

Planned Utilization

Planned Utilization for a resource or supplier for a planning time bucket is calculated as follows:

\[
\text{Planned Utilization} = \left(\frac{\text{Hours of capacity actually used}}{\text{Available hours of capacity}}\right) \times 100
\]

Note: These calculations use standard costs of items. Standard cost systems use a single value to cost all material and resource transactions in inventory and work in process systems.

Note: For production lines and supplier capacities, substitute units for hours.

Aggregate level utilizations for all hierarchy levels are based on average utilization. For example, Planned Utilization for a resource is calculated as follows:

Resource Planned Utilization = Sum of [Planned Utilization for all Planning time buckets] / Number of Planning time buckets

Plan level Planned Utilization does not include supplier utilization.
Key Performance Indicators (KPIs)

**Ontime Delivery**

Customer service level or delivery performance are calculated as follows:

\[
\text{On-time delivery} = \frac{(\text{Total number of orders} - \text{number of late orders}) \times 100}{\text{Total number of orders}}
\]

**Margin**

Margin is calculated as follows:

Top Assembly Margin = (total shipment units) * (standard price) * (standard discount) - (total shipment units)(standard cost)

Aggregate Level Margin = Sum of margin of top assemblies

You can drill down to Plan/Org level KPI (Revenue vs. Cost vs. Profit) or to KPI Trend. No target is available for Margin KPI.

**Cost Breakdown**

Cost Breakdown KPI is composed of four separate costs:

- Production Cost
- Inventory Carrying Cost
- Penalty Cost
- Purchasing Cost

Production cost is calculated based on the required resource time and its corresponding cost. Product cost is calculated as follows:

\[\text{Production Cost} = \text{Sum of (Resource time needed} \times \text{Resource Cost)} \text{for all resources in the organization.}\]

Inventory carrying cost is calculated based on average inventory level in each time bucket. Inventory carrying is calculated as follows:

\[\text{Inventory Carrying Cost (period i)} = \text{Average inventory of period i} \times \text{carrying cost percent}\]

Penalty cost is calculated as follows:

\[\text{Penalty Cost} = \text{demand lateness cost} \times (\text{demand satisfied date} - \text{requirement date}) \times \text{demand quantity} \times \text{item list price}\]
Standard item cost is used in the above equation in the absence of item list price. Purchasing cost is calculated based on the standard item cost and the supply quantity.

\[ \text{Purchasing Cost} = \text{Sum of } [\text{Standard Cost} \times \text{Supply quantity}] \text{ for all items} \]

You can drill down to Plan/Org KPI or to KPI Trend. No target is available for Cost Breakdown KPI.

**Service Level**

Service Level is calculated as follows:

\[ \text{Planned Item Service Level} = \frac{\text{Total demand quantity of item satisfied by due date}}{\text{Total demand quantity of item}} \]

\[ \text{Planned Aggregate Service Level} = \frac{\text{Total demand quantity satisfied by due date}}{\text{Total demand quantity}} \]

You can display Planned Service Level vs. Target Service Level at plan, organization, and item levels. You can also drill down to a graph showing service level trend.

**Inventory Value**

A graphical representation of the least risk inventory values at the intersection of the levels in the hierarchies that you have selected for inventory planning (e.g., item or product family and organization by month) are displayed in a time-phased view.

---

**Note:** For more information on using KPIs, refer to Chapter 10, Planner Workbench/User Interface.
Currently, setting up targets for the following KPIs or performance measures are set up within the BIS application. You can access the BIS application to set the following KPIs (now known as Performance Measures) at the following dimensions:

- MRP Gross Margin% at the Total Organizations and Total Time dimensions
- MRP Inventory Turns at the Total Organizations and Total Time dimensions
- MRP On-time Delivery% at the Total Organizations and Total Time dimensions
- MRP Planned Utilization% at the Total Organizations and Total Time dimensions

*Figure 9–3 Setting KPI Target Levels in Oracle BIS*
To set targets for KPIs or Performance Measures:

1. From the BIS Personal Home Page, click Performance Management Framework (Full Access).
2. Click Performance Measures.
3. In the Performance Measure drop down box, select the correct performance measure (e.g.; MRP Gross Margin%).
4. Click the View Target Levels button.
5. Click BIS_EDIT_VIEW in the row that shows the correct dimensions (e.g.; Total Organizations, Total Time).
6. Scroll down to the access section. Make sure the Selected Responsibilities include Performance Management Framework (Full Access) and Performance Management Framework (Targets Access).
7. Click the Save and View Targets button.
8. In the Organization drop down box, select Total Organizations.
9. Click the Find Targets button.
10. Click the Retrieve button.
11. In the Business Plan drop down box, select Standard.
12. Click the Refresh button.
13. If there is no target set and you wish to set a target, click the New Target button.
14. If there is an existing target you wish to edit, click BIS_EDIT_VIEW for the target you wish to edit.
15. Enter the target.
16. Click the Save button.
17. Use the home button in the Performance Target Details bar and start over with the next target.

Note: If you are using the 10.7 version of Oracle Applications, there is no user interface available for setting up these targets. A custom program is needed to input these targets.
Tracking Plan Performance Using KPIs

Oracle ASCP lets you track plan performance against KPIs. For more information, see Chapter 10, “Planner Workbench/User Interface.”

Making Improvements Based on KPIs

**Increasing Inventory Turns**
- Decrease the penalty factor for safety stock violation.
- Increase weight given to the maximize inventory turns objective, decrease weight given to other objectives by choosing Plan Options > Optimization tab.
- Change sourcing rules used by the plan to reflect material sources (for example, inventory stocks) that are controlled by the planner or the organization being planned. For example, if a plan is run with many inventory sources specified in the sourcing rules, inventory turns will be lower than if only a few inventory sources are used.

**Increasing Planned Utilization**
- Decrease penalty factor for exceeding resource capacity.
- Increase weight given to the maximize resource utilization objective, decrease weight given to other objectives.
- Increase the demand that is being planned. Note that increasing demand can have adverse impact to other KPIs (for example, Ontime Delivery) if material capacity is not sufficient to support the demand.

**Increasing Margin Percentage**
- Decrease penalty factors considered in the margin percentage calculation.
- Increase weight given to the maximize margin percentage objective, decrease weight given to other objectives.
- If material and/or resource capacity is constrained, demand will not be fulfilled by the request date and sales will either be lost or penalty costs will be incurred for late demand. See actions described in Increasing Ontime Delivery.
Increasing Ontime Delivery

- Ontime Delivery will suffer if material capacity and/or resource capacity are not sufficient to meet requested delivery dates. By looking at the exceptions that occur after a plan is run, you can determine whether material or resource capacity is the gating factor.

- To determine material and resource capacities required to meet all requested delivery dates for demand, run the plan unconstrained by material and capacity to determine total resource and material capacity requirements. (Choose Plan Options > Aggregation tab to specify material and resource constraints.)

Example 1 If material capacity is insufficient:

- Add capacity at the bottleneck supplier(s)
- Specify alternate components that can be used if the primary (constrained) component is not available
- Add capacity at feeder plants supplying sub assemblies

Example 2 If resource capacity is insufficient:

- Add capacity at the bottleneck resource. For example, add shifts, add outsourcing providers, add labor
- Specify alternate resources that can be used

Example 3 If material and resource capacities are not constrained:

- Increase penalty factor for unmet demand and late demand
- Increase weight given to the maximize on-time delivery objective, decrease weight given to other objectives
Exception Messages

Oracle APS provides highly advanced exception handling. First, planners can use plan options to make their plans consistent with the business drivers of their company. They can decide to run a plan for a single plant or for an entire supply chain. They can also choose to run plans that have no material and resource constraints, some material and resource constraints, or with optimization objectives like profit, inventory turns, in combination with penalties for late deliveries, working overtime, and so on.

For each of the plans, they can search for specific exceptions (for example, find exceptions that relate to a specific buyer or item), view the exceptions grouped together in order of priority, drill down to related exceptions and detailed supply and demand information, and run simulations to improve plans. Last, they can use the powerful capabilities of the embedded workflow engine to highlight specific exceptions within their company or to their trading partners, and even model how they should be resolved automatically under specific situations.

This section explains:

- What exceptions are generated for which type of plans
- How exceptions can be viewed and analyzed
- How exception situations potentially can be resolved

Exception Summary Window

Exception messages are viewed using the Actions tab in the Planner Workbench (right panel). Please refer to Chapter 10 for more information on Exception-related windows. Planners can access the exceptions using the Exception Summary window. The Exception Summary window displays information about all exception messages generated by the current planning run, along with all messages saved from previous simulation runs. The window has three default columns: Action Type (exception group), Version, and Count (the Count column shows the subtotal of the exception message count by exception group). In this window, exceptions are grouped together in preseeded order of importance: for example, late orders are more important than recommendations. Planners have the option to prioritize and sort exceptions based on their preferences using the Find Window action. Furthermore, they can drill down to the Exception Details window to view an individual exception by double clicking on any exception group.
Exception Groups for Different Plans

As mentioned earlier, plan options determine which exceptions are generated by the planning system. For example, some exceptions are only generated for constrained plans and some are only generated for unconstrained plans. Optimized plans generate additional exceptions.

The next nine tables list all of the exceptions by exception groups for the respective plan options. Exceptions are displayed in the order of most critical to least critical within the exception group. Exception groups and exceptions are only displayed if the exceptions exist.

Table 9–1  Late Sales Orders and Forecasts

<table>
<thead>
<tr>
<th>Exception Group/Exception</th>
<th>Base ASCP (unconstrained)</th>
<th>ASCP with CBO** (constrained)</th>
<th>ASCP with CBO** (optimized)</th>
<th>Risk Optimization</th>
</tr>
</thead>
<tbody>
<tr>
<td>Order at risk due to material shortage</td>
<td>yes</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
</tr>
<tr>
<td>Order at risk due to resource shortage</td>
<td>yes</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
</tr>
<tr>
<td>Late supply pegged to sales order</td>
<td>yes</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
</tr>
<tr>
<td>Late supply pegged to forecast</td>
<td>yes</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
</tr>
<tr>
<td>Past due sales orders</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Past due forecast</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Late replenishment for sales order</td>
<td>n/a</td>
<td>yes</td>
<td>yes</td>
<td>n/a</td>
</tr>
<tr>
<td>Late replenishment for forecast</td>
<td>n/a</td>
<td>yes</td>
<td>yes</td>
<td>n/a</td>
</tr>
<tr>
<td>Early replenishment for sales order</td>
<td>n/a</td>
<td>yes</td>
<td>yes</td>
<td>n/a</td>
</tr>
<tr>
<td>Early replenishment for forecast</td>
<td>n/a</td>
<td>yes</td>
<td>yes</td>
<td>n/a</td>
</tr>
</tbody>
</table>
### Table 9–2  Material and Resource Capacity Exception

<table>
<thead>
<tr>
<th>Exception Group/Exception</th>
<th>Base ASCP (unconstrained)</th>
<th>ASCP with CBO** (constrained)</th>
<th>ASCP with CBO** (optimized)</th>
<th>Risk Optimization</th>
</tr>
</thead>
<tbody>
<tr>
<td>Material constraint</td>
<td>n/a</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Resource constraint</td>
<td>n/a</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Resource overloaded (*)</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Supplier capacity overloaded (*)</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Resource underloaded</td>
<td>yes</td>
<td></td>
<td>yes</td>
<td>yes</td>
</tr>
</tbody>
</table>

### Table 9–3  Transportation and Distribution

<table>
<thead>
<tr>
<th>Exception Group/Exception</th>
<th>Base ASCP (unconstrained)</th>
<th>ASCP with CBO** (constrained)</th>
<th>ASCP with CBO** (optimized)</th>
<th>Risk Optimization</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transportation resource constraint</td>
<td>n/a</td>
<td>yes</td>
<td>yes</td>
<td>n/a</td>
</tr>
<tr>
<td>Transportation resource overloaded (*)</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Transportation resource underloaded</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
</tbody>
</table>

### Table 9–4  Shortages and Excess

<table>
<thead>
<tr>
<th>Exception Group/Exception</th>
<th>Base ASCP (unconstrained)</th>
<th>ASCP with CBO** (constrained)</th>
<th>ASCP with CBO** (optimized)</th>
<th>Risk Optimization</th>
</tr>
</thead>
<tbody>
<tr>
<td>Items with a shortage</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Items below safety stock</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>n/a</td>
</tr>
<tr>
<td>Items with excess inventory</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
</tbody>
</table>
Please see the following note for information on what the number 1 means.
## Exception Messages

### Table 9–7 Projects/Tasks

<table>
<thead>
<tr>
<th>Exception Group/Exception</th>
<th>Base ASCP (unconstrained)</th>
<th>ASCP with CBO** (constrained)</th>
<th>ASCP with CBO** (optimized)</th>
<th>Risk Optimization</th>
</tr>
</thead>
<tbody>
<tr>
<td>Items with a shortage in a project/task</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>n/a</td>
</tr>
<tr>
<td>Items allocated across projects/tasks</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>n/a</td>
</tr>
<tr>
<td>Items with excess inventory in a project/task</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>n/a</td>
</tr>
</tbody>
</table>

### Table 9–8 Item Exceptions

<table>
<thead>
<tr>
<th>Exception Group/Exception</th>
<th>Base ASCP (unconstrained)</th>
<th>ASCP with CBO** (constrained)</th>
<th>ASCP with CBO** (optimized)</th>
<th>Risk Optimization</th>
</tr>
</thead>
<tbody>
<tr>
<td>Items that are over-committed</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>n/a</td>
</tr>
<tr>
<td>Items with negative starting on hand</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Items with expired lot</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>n/a</td>
</tr>
<tr>
<td>Items with repetitive variance</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>n/a</td>
</tr>
<tr>
<td>Items with no activity</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
</tbody>
</table>

### Table 9–9 Recommendations

<table>
<thead>
<tr>
<th>Recommendations</th>
<th>Base ASCP (unconstrained)</th>
<th>SCP with CBO** (constrained)</th>
<th>ASCP with CBO** (optimized)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Discrete Jobs</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Purchase Requisitions</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
</tbody>
</table>
You can view the following exception messages listed in the table in the Planner Workbench Actions tab.

**Note:** (1) These exceptions are not a result of decisions made by the planning engine. They are only visible in an unconstrained plan, if a planner has manually chosen this alternative (for example, a planner can firm a planned order and choose an alternate routing in the Supply/Demand window).

**Note:** *Orders with compression days and overloaded exceptions (resource overloaded, supplier capacity overloaded, and transportation resource overloaded) are generated for constrained/optimized plans only when there are firm supplies in the plans or when the Enforce Demand Due Dates option is selected.

**CBO denotes Constraint Based Optimization.**
Planning Exception Sets

Generation of over-loaded and under-loaded exceptions is controlled by user-defined planning exception sets (in the source instance) that specify the sensitivity controls and exception time periods for each exception message.

Since different sensitivity controls and exception time periods are appropriate for different types of items, a planner can define as many planning exception sets as needed. The appropriate exception set can be assigned to each item using the Define Item form.

Sensitivity controls that define the quantity excess and repetitive variance exceptions are:

- Excess quantity
- Repetitive variance percentage
- Resource under-loaded
- Resource over-loaded
- User-defined time fence (in days)

Exception time period types that define the time period for over-committed, shortage, excess, and repetitive variance exceptions are:

- Cumulative manufacturing lead time
- Cumulative total lead time
- Planning time fence
- Total lead time
- User-defined time fence

**Note:** When choosing a user-defined time fence, the number of days that this time fence corresponds to must be defined.

**Prioritization and Navigation**

The Planner Workbench supports various ways to assist planners in managing plan exceptions. They can manage exceptions and drill-down to details using:

- Exceptions prioritization and sorting
- Default exceptions folders
- Relevant information buttons
- Right mouse options
- Drill down from Late Orders Exceptions to Constraint Exceptions (and vice versa)

For more information on viewing exceptions, see Chapter 10, “Planner Workbench/User Interface.”
Making Decisions Based on Exceptions

Oracle ASCP provides a range of exception messages for all plans. You can easily manage your plan by displaying only those items and orders that require your attention, and you can further narrow your search using other criteria such as by buyer or by line.

By saving the exception messages each time you perform simulations, you can compare different versions of the same plan or analyze the strengths and weaknesses of a single plan. Some of the guidelines to respond to the exceptions are detailed in the following sections.

Oracle enables Internet-based collaboration by automatically forwarding planning exceptions to trading partners using workflow. Trading partners can research and respond to exceptions by selecting links to self-service web applications including forecast maintenance, supplier capacity update, ATP, and even a secured version of the Planner Workbench. Trading partner responses can in turn trigger other workflow activities such as an internal notification, or even an automatic reschedule of a purchase order or sales order.

Using Online Planning

In general, Online Planning is a very efficient and effective way to try out different ways (simulation) to resolve the exception before you commit to making the final/permanent changes. However, you can eliminate one exception only to create another under certain circumstances. For example, if you decide to off-load some operations to a different resource, you could create an overload situation for another resource. Please refer to Chapter 7, Simulations for more information on Online Planning.

During on-line planning, a planner can modify the following information:

Supplier Capacity:
- Add new supplier capacity
- Modify dates and quantities

Resource Availability:
- Add new resource availability
- Modify dates and quantities
- Add new shifts

Supplies:
Making Decisions Based on Exceptions

- Add new planned orders
- Firm planned orders, discrete jobs, and purchase order
- Modify quantities, dates, sources, and alternates.

Demands:
- Add new Manual MDS
- Modify order priority

Plan Options:
- Modify objectives

Source versus Destination Instance
Based on the results from on-line planning session, planners can decide what changes to implement in the execution system. Most of the improvement adjustments or changes will need to be made in the source instance except for supplier capacity, supplier flex-fences, and sourcing rules.

Companies that operate an Oracle Applications Release 11i source instance, will make changes in the source instance. Companies that operate Oracle Applications Release 10.7 or 11.0 will make changes in the Collections Workbench of the destination instance (also referred to as Planning Server), because capacity can only be defined in the destination instance.

For cross-instance planning sourcing rules, changes need to be made in the destination instance. For sourcing rules, defined in the source, changes will need to be made in the source instance.

Constraint/Bottleneck Management
In general, it is more effective to resolve the most constrained resource (bottleneck) before the least constrained resource. Resource refers to manufacturing resources, transportation resources, and suppliers. Similarly, it is more logical to work on the high priority demands before working on low priority ones.

The next section explains each exception message in detail. For each exception message, the default exception detail (key fields/columns) is documented. It also provides some guidelines on how to resolve exceptions.
Late Sales Orders and Forecasts

Order at risk due to material shortage
This exception message is only generated for unconstrained plans. This exception shows an item that will potentially cause a late order because of material shortage.

Generation: The system looks at each supply node and calculates how much supply is pegged to an independent demand. If the total independent demand quantity is greater than the supply availability for that time bucket, the exception message is generated.

The following table illustrates a condition that would cause an exception to be generated due to the shortage on D1.

<table>
<thead>
<tr>
<th>Day</th>
<th>D1</th>
<th>D2</th>
<th>D3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Demand</td>
<td>5</td>
<td>5</td>
<td>5</td>
</tr>
<tr>
<td>Supply</td>
<td>0</td>
<td>15</td>
<td>0</td>
</tr>
</tbody>
</table>

The demand will not be rescheduled since it’s an unconstrained plan and the supplier capacity will be violated.

The following is a list of the names of the exception details default columns and the information supplied in each column.

<table>
<thead>
<tr>
<th>Exception</th>
<th>Exception Message Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Org</td>
<td>Organization where exception occurs</td>
</tr>
<tr>
<td>Item</td>
<td>Item of the order</td>
</tr>
<tr>
<td>Date</td>
<td>Demand Date</td>
</tr>
<tr>
<td>End Order Number</td>
<td>Sales Order Number, MDS</td>
</tr>
<tr>
<td>Supplier</td>
<td>Supplier Name</td>
</tr>
<tr>
<td>Supplier Site</td>
<td>Supplier Location</td>
</tr>
</tbody>
</table>

Action/Resolution: The exception serves as a warning for you since your plan is an unconstrained plan. There are several potential ways to resolve this:

- Adjust your sales order schedule date if possible;
Adjust your supplier capacity. Do this by performing a right-click on the supplier in the left pane of the Planner’s Workbench. Then, select Supplier Capacity from the menu that appears.

To find out which supplier(s) is/are overloaded, please see your Supplier capacity overloaded exception.

Contact your supplier to see if you can arrange for more supply (supplier capacity) and then adjust supplier capacity in the system.

Please make sure to rerun the plan to see if it’s feasible after the increased capacity.

**Figure 9–5 Supplier Capacity Adjustment Screen**

- Consider using an alternate supplier - you need to manually change your supplier in your sourcing rule since you’re not running a constrained plan.
- Consider substitute item - you need to manually change your setup for BOM since you’re not running a constrained plan.
Making Decisions Based on Exceptions

- Increase Supplier Flexfences - you can define capacity tolerance percentages that vary over time for each source. This allows you to represent the ability of your supplier to flex capacity upwards based on the amount of advanced notice you provide.
- Change quantity or modify the Sourcing Rule (for example, sourcing percentage)
- Make vs. Buy decisions
- Combination of the above

Order at risk due to resource shortage
This exception message is only generated for unconstrained plans. It shows an item that can cause a late order because a resource, required to manufacture the item, is overloaded.

Generation: The system goes through the pegging tree to find the resource requirements that originate from independent demands. If the total resource requirements are greater than the accumulative resource availability up to that date, the exception message is generated.

The demand will not be rescheduled since it’s an unconstrained plan, and the resource capacity will be violated.

The following is a list of the names of the exception details default columns and the information supplied in each column.

<table>
<thead>
<tr>
<th>Exception</th>
<th>Exception Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Org</td>
<td>Organization where exception occurs</td>
</tr>
<tr>
<td>Resource</td>
<td>Resource with the shortage</td>
</tr>
<tr>
<td>Dept/Line</td>
<td>Department that owns the resource</td>
</tr>
<tr>
<td>From Date</td>
<td>Shortage start date</td>
</tr>
<tr>
<td>To Date</td>
<td>Shortage end date</td>
</tr>
<tr>
<td>End Order Number</td>
<td>Sales Order Number, MDS</td>
</tr>
</tbody>
</table>

Action/Resolution: The exception serves as a warning for you since your plan is an unconstrained plan. There are several potential ways to resolve this:
- Adjust your sales order date if it’s possible
- Increase your resource availability (can be adjusted in three different ways):
- Increase hours available per unit (for example, working overtime) for the constrained resource
- Increase the resource assigned units to the operation (this needs to be changed in Source Instance/Bill of Materials/Routings/Routings)

**Note:** A 24-hour resource can only have one assigned unit at a time.

- Increase work days (for example, shift from 5 work days per week to 6 work days per week)

*Figure 9–6  Adjusting Resource Availability from the Planner Workbench*
Making Decisions Based on Exceptions

- Consider using an alternate resource or alternate routing for this item (you need to manually change your resource in your routing since you’re not running a constrained plan)
- Modify the sourcing rules
- Consider subcontracting
- Consider substitute items (you need to manually change your setup for bill of material since you’re not running a constrained plan)
- Change shift pattern or add capacity (for example, additional workday)
- Resource leveling: level underloaded and overloaded areas
- Combination of the above

**Note:** You can view and update resource availability using Resource Availability window using Right Mouse Options. Resource Requirements can be accessed using Right Mouse Options as well.

Late supply pegged to sales order
This exception message is only generated for unconstrained plans. This exception shows items with shortages that prevent sales order demand from being met, caused by component shortages.

**Generation:** If the late supply occurs in a lower level of the bill of material (BOM), the logic will search the BOM to determine the affected sales order.

The following is a list of the names of the exception details default columns and the information supplied in each column.

<table>
<thead>
<tr>
<th>Exception</th>
<th>Exception Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Org</td>
<td>Organization where exception occurs</td>
</tr>
<tr>
<td>Item</td>
<td>Item with late supply</td>
</tr>
<tr>
<td>Order Number</td>
<td>Order number</td>
</tr>
<tr>
<td>Old Date</td>
<td>Blank</td>
</tr>
<tr>
<td>Demand Date</td>
<td>Demand due date entered in MDS</td>
</tr>
<tr>
<td>Quantity</td>
<td>Quantity</td>
</tr>
</tbody>
</table>
Making Decisions Based on Exceptions

**Action/Resolution:** You should consider expediting the late supply if sales order schedule date can’t be adjusted. To find out which sales order is affected by this late supply, you can click on Supply/Demand to display the Supply Pegging tree which takes you up to the Sales Order MDS.

### Late supply pegged to forecast

This exception message is only generated for unconstrained plans. This exception shows items with shortages that prevent forecast demand from being met, caused by component shortages.

**Generation:** If the late supply occurs in a lower level of the bill of Material (BOM), the logic will search the BOM to determine the affected forecast.

The following is a list of the names of the exception details default columns and the information supplied in each column.

<table>
<thead>
<tr>
<th>Exception</th>
<th>Exception Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Org</td>
<td>Organization where exception occurs</td>
</tr>
<tr>
<td>Item</td>
<td>Item with late supply</td>
</tr>
<tr>
<td>Order Number</td>
<td>Order number</td>
</tr>
<tr>
<td>Old Date</td>
<td>Blank</td>
</tr>
<tr>
<td>Demand Date</td>
<td>Demand due date entered in MDS</td>
</tr>
<tr>
<td>Quantity</td>
<td>Quantity</td>
</tr>
</tbody>
</table>

**Action/Resolution:** You should consider expediting the late supply if the forecast date can’t be adjusted. To find out which forecast is affected by this late supply, you can click on Supply/Demand to display the Supply Pegging tree which allows you to peg up to the MDS entry.

### Past due sales orders

This exception message is generated when an item has a sales order due date that is earlier than the plan start date (beginning of your planning horizon).
Making Decisions Based on Exceptions

Figure 9-7 Exception Details for Past Due Sales Orders

**Generation:** The system searches through all sales orders to see if there is any sales order due date that falls prior to the beginning of the planning horizon.

The following is a list of the names of the exception details default columns and the information supplied in each column.

<table>
<thead>
<tr>
<th>Exception</th>
<th>Exception Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Org</td>
<td>Organization where exception occurs</td>
</tr>
<tr>
<td>Item</td>
<td>Sales Order item</td>
</tr>
<tr>
<td>Order Number</td>
<td>Sales Order number</td>
</tr>
<tr>
<td>Old Date</td>
<td>Old due date</td>
</tr>
<tr>
<td>Demand Date</td>
<td>Demand date</td>
</tr>
<tr>
<td>Quantity</td>
<td>Sales Order quantity</td>
</tr>
</tbody>
</table>
**Action/Resolution:** This exception serves as a warning since it’s already late! You should consider revising the sales order schedule date.

**Past due forecast**
This exception message is generated when items have a forecast demand due date that is earlier than the plan start date (beginning of your planning horizon).

**Generation:** The system searches through all forecast demand to see if there is any due date falls prior to the beginning of the planning horizon.

The following is a list of the names of the exception details default columns and the information supplied in each column.

<table>
<thead>
<tr>
<th>Exception</th>
<th>Exception Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Org</td>
<td>Organization where exception occurs</td>
</tr>
<tr>
<td>Item</td>
<td>Forecast item</td>
</tr>
<tr>
<td>Order Number</td>
<td>Forecast entry</td>
</tr>
<tr>
<td>Old Date</td>
<td>Old due date</td>
</tr>
<tr>
<td>Demand Date</td>
<td>Demand date</td>
</tr>
<tr>
<td>Quantity</td>
<td>forecast item quantity</td>
</tr>
</tbody>
</table>

**Action/Resolution:** This exception serves as a warning since it’s already late! You should consider either no longer planning for the forecast entry or revising the forecast entry due date.

**Late replenishment for sales order**
This exception message is only generated for constrained/optimized plans and when the Enforce Capacity Constraints option is selected. This exception message shows the potential late orders if the problem is not resolved.

**Generation:** This exception exists when the planned order’s Suggested Due Date is greater than the Need by Date. Please refer to ASCP Glossary for a clarification of these terms.

If Enforce Capacity Constraint option is specified and there is capacity shortage, Demand Satisfied Date gets moved further into the future which results in late replenishment exceptions to be generated.

The following is a list of the names of the exception details default columns and the information supplied in each column.
### Action/Resolution:

This is one of the most critical exception messages because frequent late orders could lead to loss of business. In Exception Details window, Days Late column shows number of calendar days late between the original due date and the demand satisfied date. You could sort the orders by Days Late to get the most urgent order that you need to address first. You could also use demand priority as your priority list.

There are several ways you could resolve the exception:

- Reevaluate and revise demand priority if necessary: you may want to use different priority rules to break the tie or simply use a different priority
- Expedite the supply
- Revising the sales order schedule date

#### To figure out the root cause of the late replenishment:

1. Select the order with the highest priority that is late.
2. Right mouse click to reveal more options (Right Mouse Options).
3. Click on Related Exceptions to show the cause of late replenishment.
   - The new window shows Material constraint, Resource constraint, Transportation constraint, or a combination of the above three constraints.
4. Go to the respective exception message section for resolution.
5. Move to the next late order and so on.

<table>
<thead>
<tr>
<th>Exception</th>
<th>Exception name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Org</td>
<td>Organization where exception occurs</td>
</tr>
<tr>
<td>End Item</td>
<td>Sales Order item (independent) in MDS</td>
</tr>
<tr>
<td>Quantity</td>
<td>Sales Order quantity entered in MDS</td>
</tr>
<tr>
<td>Order Number</td>
<td>MDS name</td>
</tr>
<tr>
<td>Priority</td>
<td>Demand priority</td>
</tr>
<tr>
<td>Customer</td>
<td>Customer Name</td>
</tr>
<tr>
<td>Customer Site</td>
<td>Customer Location</td>
</tr>
<tr>
<td>Demand Date</td>
<td>Demand Due Date entered in MDS</td>
</tr>
<tr>
<td>Demand Satisfied Date</td>
<td>Demand Satisfied Date based on the plan result</td>
</tr>
<tr>
<td>Days Late (in calendar days)</td>
<td>Number of calendar days late between the original due date and the demand satisfied date</td>
</tr>
</tbody>
</table>
Late replenishment for forecast

This exception message is only generated for constrained/optimized plans and when the Enforce Capacity Constraints option is selected.

**Generation:** This exception exists when the planned order’s Suggested Due Date is greater than the Need by Date. Please refer to ASCP Glossary for a clarification of these terms.

If Enforce Capacity Constraint option is specified and there is capacity shortage, Demand Satisfied Date will get moved further into the future which will result in late replenishment exceptions to be generated.

The following is a list of the names of the exception details default columns and the information supplied in each column.

<table>
<thead>
<tr>
<th>Exception</th>
<th>Exception name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Org</td>
<td>Organization where exception occurs</td>
</tr>
<tr>
<td>End Item</td>
<td>Forecast item (independent) entered in MDS</td>
</tr>
<tr>
<td>Quantity</td>
<td>Forecast item quantity entered in MDS</td>
</tr>
<tr>
<td>Order Number</td>
<td>MDS name</td>
</tr>
<tr>
<td>Priority</td>
<td>Demand priority</td>
</tr>
<tr>
<td>Customer</td>
<td>Customer name</td>
</tr>
<tr>
<td>Customer Site</td>
<td>Customer location</td>
</tr>
<tr>
<td>Demand Date</td>
<td>Demand due date entered in MDS</td>
</tr>
<tr>
<td>Demand Satisfied Date</td>
<td>Demand satisfied date based on plan result</td>
</tr>
<tr>
<td>Days Late</td>
<td>Number of calendar days late between the original due date and the demand satisfied date</td>
</tr>
</tbody>
</table>

**Action/Resolution:** In Exception Details window, Days Late column shows number of calendar days late between the original due date and the demand satisfied date. You could sort the forecast entries by Days Late to get the most urgent forecast entry that you need to address first. You could also use demand priority as your priority list.

There are several ways you could resolve the exception:

- Reevaluate and revise demand priority if necessary: you may want to use different priority rules to break the tie or simply use a different priority
- Expedite the supply
Revise the forecast date

To figure out the root cause of the late replenishment:
1. Select the forecast entry with the highest priority that is late.
2. Right mouse click to reveal more options (Right Mouse Options).
3. Click on Related Exceptions to show the cause of late replenishment.
   The new window shows Material constraint, Resource constraint, Transportation constraint, or a combination of the above three constraints.
4. Go to the respective exception message section for resolution.
5. Move to the next late forecast entry and so on.

Early replenishment for sales order
This exception message is only generated for constrained/optimized plans. This exception message shows the potential early orders.

Generation: This exception exists when the Planned Order’s Suggested Due Date is less than the Need by Date. Please refer to ASCP Glossary for a clarification of these terms.

The following is a list of the names of the exception details default columns and the information supplied in each column.

<table>
<thead>
<tr>
<th>Exception</th>
<th>Exception name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Org</td>
<td>organization where exception occurs</td>
</tr>
<tr>
<td>End Item</td>
<td>Sales Order item (independent) entered in MDS</td>
</tr>
<tr>
<td>Quantity</td>
<td>Sales Order quantity entered in MDS</td>
</tr>
<tr>
<td>Order Number</td>
<td>MDS name</td>
</tr>
<tr>
<td>Priority</td>
<td>Demand priority</td>
</tr>
<tr>
<td>Customer</td>
<td>Customer name</td>
</tr>
<tr>
<td>Customer Site</td>
<td>Customer location</td>
</tr>
<tr>
<td>Demand Date</td>
<td>Demand due date entered in MDS</td>
</tr>
<tr>
<td>Demand Satisfied Date</td>
<td>Demand satisfied date based on plan result</td>
</tr>
<tr>
<td>Item Description</td>
<td>Item Description</td>
</tr>
</tbody>
</table>
**Action/Resolution:** This exception message is for information purposes only. However, if you are implementing Just-In-Time (JIT) scheduling, this exception will help you minimize your inventory carrying cost.

Possible reasons that cause early replenishment(s) are:

- Supplier delivery calendar restriction: for example, your supplier only delivers on Monday (once a week). You may end up receiving supplies early most of the time.
- Some jobs are started and completed early due to a resource availability issue at a later time.
- Firmed supplies can also create the same effect.

**Early replenishment for forecast**

This exception message is only generated for constrained/optimized plans.

**Generation:** This exception is calculated in the same matter as the Early replenishment for sales order except it applies to forecast entries instead of sales orders.

The following is a list of the names of the exception details default columns and the information supplied in each column.

<table>
<thead>
<tr>
<th>Exception</th>
<th>Exception name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Org</td>
<td>Organization where exception occurs</td>
</tr>
<tr>
<td>End Item</td>
<td>Forecast item (independent) entered in MDS</td>
</tr>
<tr>
<td>Quantity</td>
<td>Forecast item quantity entered in MDS</td>
</tr>
<tr>
<td>Order Number</td>
<td>MDS</td>
</tr>
<tr>
<td>Priority</td>
<td>Demand priority</td>
</tr>
<tr>
<td>Customer</td>
<td>Customer name</td>
</tr>
<tr>
<td>Customer Site</td>
<td>customer location</td>
</tr>
<tr>
<td>Demand Date</td>
<td>Demand due date entered in MDS</td>
</tr>
<tr>
<td>Demand Satisfied Date</td>
<td>Demand satisfied date based on plan result</td>
</tr>
<tr>
<td>Item Description</td>
<td>Item description</td>
</tr>
</tbody>
</table>

**Action/Resolution:** See Action/Resolution for Early replenishment for sales order.
Material and Resource Capacity

**Material constraint**

This exception is generated for constrained/optimized plans only(153,683),(846,711).

**Generation:** This exception is generated when there is a lead time violation (that is, time available is not sufficient to provide required supply) or when there is a supplier capacity violation, as defined by the following conditions:

- For purchase items with supplier capacity: the scheduling engine takes the required supply and performs backward scheduling using supplier capacity. When the accumulated supply is less than the demand within the available time, the supplier capacity is violated. Hence, the exception message is generated. For example, if there is a demand on D5 and the supplier capacity is as shown in the following table:

<table>
<thead>
<tr>
<th>Day</th>
<th>D1</th>
<th>D2</th>
<th>D3</th>
<th>D4</th>
<th>D5</th>
</tr>
</thead>
<tbody>
<tr>
<td>Demand</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>20</td>
</tr>
<tr>
<td>Supplier Capacity</td>
<td>0</td>
<td>5</td>
<td>0</td>
<td>5</td>
<td>5</td>
</tr>
</tbody>
</table>

  Since there is not enough supplier capacity for 20, an exception message is generated on D1. D1 will be the Constraint Date.

- For purchase items with lead times (preprocessing, processing, post processing) defined in Item Attributes in Source instance: the scheduling engine uses the lead time offsets to see if there is sufficient time. If not, the lead time is violated. Hence, the exception message is generated. For example, if there is a demand of 5 on December 20 and the total lead time is 10 (preprocessing=1, processing=7, post processing=2), while the order must be started by December 10, today is already December 12.

- For make items without a routing: this is calculated in the same manner as the above example using lead time offsets. If the lead time is violated, the exception message is also generated for make items.

The following is a list of the names of the exception details default columns and the information supplied in each column.
Making Decisions Based on Exceptions

**Action/Resolution:** If this is a lead time violation of material constraint, it is possible that the root cause might be upstream in the supply chain. For example, the resource capacity issue may have forced the job to be processed earlier than it should be which results in the material constraint issue.

It is also very important to understand the potential consequence of these exceptions. In other words, will these exceptions cause any Late replenishment for sales order/forecast? If yes, how many days late? Since On Time Delivery and Customer Satisfaction have a direct relationship, these material constraint issues are the ones that you want to resolve first. Number of days late is one way to prioritize these material constraint issues. Demand priority is another way for issue prioritization.

To look for potential Late replenishment for sales order/forecast, use the Right Mouse Options to go to Related Exceptions to see if it returns any late exceptions.

Once you prioritize your Material constraint exceptions, you can now focus on resolving the lead time violation for each exception.

There are several ways to resolve this:

- Adjust your sales order schedule date if possible
- Adjust your supplier capacity by doing the following:
  - To find out which supplier(s) is/are overloaded, please see your Supplier capacity overloaded exception
  - Contact your supplier to see if you can arrange for more supply (supplier capacity) and then adjust supplier capacity in the system
  - Please make sure to rerun the plan to see if it’s feasible after the increased capacity
- Consider using an alternate supplier
- Consider substitute item (if not running an optimized plan, manual substitution will be required; optimized plan will automatically take this into consideration)
Making Decisions Based on Exceptions

- Increase Supplier Flexfences
- Change quantity or modify the Sourcing Rule (for example, sourcing percentage)
- Reevaluate lead time
- Combination of the above

Figure 9–8 Planner Workbench Sourcing Rule Screen

Resource constraint
This exception is generated for constrained/optimized plans only.

Generation: This exception is generated when the time available is not sufficient to manufacture required supply using specified resource as defined by the following condition:
For make items with a routing: the scheduling engine takes the total resource requirements and performs backward scheduling to derive a operation start date. If the total resource requirements are greater than the resource availability up to the plan run start date (for example, the operation start date turns out to be in the past), then the exception message is generated.

Daily resource availability is calculated by number of hours available multiplying the number of assigned units.

Start Constraint Date and End Constraint Date show the duration of the resource issue.

The following is a list of the names of the exception details default columns and the information supplied in each column.

<table>
<thead>
<tr>
<th>Exception</th>
<th>Exception name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resource</td>
<td>Constrained resource</td>
</tr>
<tr>
<td>Dept/Line</td>
<td>Department that owns the resource</td>
</tr>
<tr>
<td>Org</td>
<td>Organization where exception occurs</td>
</tr>
<tr>
<td>Start Constraint Date</td>
<td>Constraint start date</td>
</tr>
<tr>
<td>End Constraint Date</td>
<td>Constraint end date</td>
</tr>
<tr>
<td>Overload</td>
<td>Total hours over the availability</td>
</tr>
</tbody>
</table>

**Action/Resolution:** There are several potential ways to resolve this:

- Adjust your sales order date if possible
- Increase your resource availability (can be adjusted in three different ways):
  - Increase hours available per unit (for example, working overtime) for the constrained resource

**Note:** Overload column shows the additional hours you need to increase to resolve the exception.

**Note:** A 24-hour resource can only have 1 assigned unit at a time.
Making Decisions Based on Exceptions

- Increase work days (for example, shift from 5 work days per week to 6 work days per week)
- Consider using an alternate resource or alternate routing for this item
- Modify the sourcing rules
- Consider subcontracting
- Consider substitute items using different resource(s)
- Change shift pattern or add capacity (for example, additional workday)
- Combination of the above

**Note:** You can view and update resource availability using Resource Availability window using Right Mouse Options. Resource Requirements can be accessed using Right Mouse Options as well.

**Resource overloaded**

The exception is mostly generated for unconstrained plans and constrained/optimized plans with Enforce Demand Due Dates option selected, or with firm supplies (firm planned orders, firm discrete jobs, repetitive schedules, and so on) or firm operations (firm start date, firm end date, or both). The resource is overloaded because the supplies are firm, which leads to resource capacity violation.

**Generation:** This exception is generated when a resource is over-utilized, as defined by the over-utilization percentage entered in the exception set. For at least one time bucket, the resource requirement is greater than the resource availability. This exception is based on the load ratio calculated for the resource.

If Enforce Capacity Constraint option (constrained plan) is specified, the scheduling system resolves the overload exceptions unless there are firm supplies or firm operations in the plan. If there is capacity shortage, Demand Satisfied Date gets moved further into the future, which results in late replenishment exception and the resource constraint exception to be generated.

If Enforce Demand Due Date option is specified, the scheduling system resolves some of the overload exceptions. However, this option overloads the resource before pushing the Demand Satisfied Date into the future. So, these overload messages generated by the scheduling system are critical to the plan.
The following is a list of the names of the exception details default columns and the information supplied in each column.

<table>
<thead>
<tr>
<th>Exception</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Org</td>
<td>Organization where exception occurs</td>
</tr>
<tr>
<td>Resource</td>
<td>Overloaded resource</td>
</tr>
<tr>
<td>Dept/Line</td>
<td>Department that owns the resource</td>
</tr>
<tr>
<td>Start Constraint</td>
<td>Overload start date</td>
</tr>
<tr>
<td>End Constraint</td>
<td>Overload end date</td>
</tr>
<tr>
<td>Load Ratio</td>
<td>Resource requirement/resource availability</td>
</tr>
</tbody>
</table>

**Action/Resolution:** See Action/Resolution for Resource constraint. You should also consider adjusting the percentage entered in the exception set if it does not reflect the reality.

**Supplier capacity overloaded**

The exception is mostly generated for unconstrained plans and constrained/optimized plans with Enforce Demand Due Dates option selected, or with firm supplies (planned orders, firm purchase orders, and so on). The resource is overloaded because the supplies are firm, which leads to supplier capacity violation.

**Generation:** This exception is generated when a supplier is over-utilized, as defined by the over-utilization percentage entered in the exception set. The exception is generated when the required capacity of the supplier is more than the cumulative available capacity.

If Enforce Capacity Constraint option (constrained plan) is specified, the scheduling system resolves the overload exceptions unless there are firm supplies in the plan. If there is supplier capacity shortage, Demand Satisfied Date gets moved further into the future, which results in late replenishment exception and a material constraint exception to be generated.

If Enforce Demand Due Date option is specified, the scheduling system resolves some of the overload exceptions. However, this option overloads the supplier capacity before pushing the Demand Satisfied Date into the future. So, these overload messages generated by the scheduling system are critical to the plan.

The following is a list of the names of the exception details default columns and the information supplied in each column.
Making Decisions Based on Exceptions

<table>
<thead>
<tr>
<th>Exception</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Org</td>
<td>Organization where exception occurs</td>
</tr>
<tr>
<td>Item</td>
<td>Purchase item</td>
</tr>
<tr>
<td>From Date</td>
<td>Overload start date</td>
</tr>
<tr>
<td>To Date</td>
<td>Overload end date</td>
</tr>
<tr>
<td>Supplier</td>
<td>Supplier name</td>
</tr>
<tr>
<td>Supplier Site</td>
<td>Supplier location</td>
</tr>
<tr>
<td>Load Ratio</td>
<td>Supply requirement/supplier capacity</td>
</tr>
</tbody>
</table>

**Action/Resolution:** See Action/Resolution for Material constraint. You should also consider adjusting the percentage entered in the exception set if it does not reflect the reality.

**Resource underloaded**

This exception is generated for all plan options.

**Generation:** This exception is generated when a resource is under-utilized, as defined in under-utilization percentage entered in the exception set.

The following is a list of the names of the exception details default columns and the information supplied in each column.

<table>
<thead>
<tr>
<th>Exception</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Org</td>
<td>Organization where exception occurs</td>
</tr>
<tr>
<td>Resource</td>
<td>Underloaded resource</td>
</tr>
<tr>
<td>Dept/Line</td>
<td>Department that owns the resource</td>
</tr>
<tr>
<td>Start Constraint</td>
<td>Underload start date</td>
</tr>
<tr>
<td>End Constraint</td>
<td>Underload end date</td>
</tr>
<tr>
<td>Load Ratio</td>
<td>Resource requirement/resource availability</td>
</tr>
</tbody>
</table>

**Action/Resolution:** You should consider increasing the workload, decreasing available capacity, shifting resources to other work centers, processing rework, or executing special projects. In addition, you should probably consider balancing the loads. You should also consider adjusting the percentage entered in the exception set if it does not reflect the reality.
Transportation and Distribution

Transportation resource constraint
This exception is generated for constrained/optimized plans only. This exception is generated when there is a transportation capacity violation (that is, time available is not sufficient to ship required supply using a specified transportation resource).

Generation: At the item level, users specify volume and weight in item attributes. Capacity for transportation resources is also defined in volume and weight. For scheduling, transportation resources are handled very similarly to manufacturing resources. The scheduling engine takes the total transportation resource requirement and performs backward scheduling to derive a start date. If the total resource requirements are greater than the accumulative resource availability up to the plan run start date (for example, the operation start date turns out to be in the past), then the exception message is generated.

The following is a list of the names of the exception details default columns and the information supplied in each column.

<table>
<thead>
<tr>
<th>Exception</th>
<th>Exception name</th>
</tr>
</thead>
<tbody>
<tr>
<td>To Organization</td>
<td>Destination organization</td>
</tr>
<tr>
<td>From Organization</td>
<td>Source organization</td>
</tr>
<tr>
<td>Ship Method</td>
<td>Shipping method</td>
</tr>
<tr>
<td>Constraint Date</td>
<td>Constraint date</td>
</tr>
<tr>
<td>End Order Number</td>
<td>Sales Order Number</td>
</tr>
<tr>
<td>End Item</td>
<td>Sales Order item</td>
</tr>
<tr>
<td>Customer</td>
<td>Customer name</td>
</tr>
<tr>
<td>Customer Site</td>
<td>Customer location</td>
</tr>
<tr>
<td>Priority</td>
<td>Demand priority</td>
</tr>
<tr>
<td>Demand Date</td>
<td>Demand due date</td>
</tr>
<tr>
<td>Demand Satisfied Date</td>
<td>Demand satisfied date</td>
</tr>
<tr>
<td>Demand Quantity</td>
<td>Demand quantity</td>
</tr>
</tbody>
</table>

Action/Resolution: You could consider adjusting your transportation resource capacity (for example, increase volume/weight). You could also consider using a different ship method or a different shipping calendar.
Transportation resource overloaded

The exception is mostly generated for unconstrained plans and constrained/optimized plans with Enforce Demand Due Dates option selected, or with firm supplies. The resource is overloaded because the supplies are firm which leads to transportation resource capacity violation.

**Generation:** This exception is generated when a transportation resource is overloaded, as defined in overloaded percentage entered in the exception set.

If Enforce Capacity Constraint option (constrained plan) is specified, the scheduling system resolves the overload exceptions unless there are firm supplies in the plan. If there is capacity shortage, Demand Satisfied Date gets moved further into the future, which results in late replenishment exception and a transportation resource constraint exception to be generated.

If Enforce Demand Due Date option is specified, the scheduling system resolves some of the overload exceptions. However, this option overloads the transportation resource before pushing the Demand Satisfied Date into the future. So, these overload messages generated by the scheduling system are critical to the plan.

The following is a list of the names of the exception details default columns and the information supplied in each column.

<table>
<thead>
<tr>
<th>Exception</th>
<th>Exception name</th>
</tr>
</thead>
<tbody>
<tr>
<td>To Organization</td>
<td>Destination organization</td>
</tr>
<tr>
<td>From Organization</td>
<td>Source organization</td>
</tr>
<tr>
<td>Ship Method</td>
<td>Shipping method</td>
</tr>
<tr>
<td>From Date</td>
<td>Overload start date</td>
</tr>
<tr>
<td>To Date</td>
<td>Overload end date</td>
</tr>
<tr>
<td>Load Ratio</td>
<td>Requirement/availability</td>
</tr>
</tbody>
</table>

**Action/Resolution:** See also Transportation resource for suggestions. Consider adjusting the percentage entered in the exception set if it does not reflect the reality.

Transportation resource underloaded

This exception is generated for all plans.

**Generation:** This exception is generated when a transportation resource is under-utilized, as defined in under-utilization percentage entered in the exception set.
The following is a list of the names of the exception details default columns and the information supplied in each column.

<table>
<thead>
<tr>
<th>Exception</th>
<th>Exception name</th>
</tr>
</thead>
<tbody>
<tr>
<td>To Organization</td>
<td>Destination organization</td>
</tr>
<tr>
<td>From Organization</td>
<td>Source organization</td>
</tr>
<tr>
<td>Ship Method</td>
<td>Shipping method</td>
</tr>
<tr>
<td>From Date</td>
<td>Underload start date</td>
</tr>
<tr>
<td>To Date</td>
<td>Underload end date</td>
</tr>
<tr>
<td>Load Ratio</td>
<td>Requirement/availability</td>
</tr>
</tbody>
</table>

**Action/Resolution:** You should consider using the opportunity to balance your transportation loads. Also consider adjusting the percentage entered in the exception set if it does not reflect the reality.

**Shortages and Excess**

**Items with a shortage**
This exception shows an item whose quantity on hand is less than the sum of the requirements plus safety stock, within the exception time fence defined by the item’s planning exception set.

**Generation:** On some days, the item may have more demand than it has supply; therefore, you cannot satisfy all the demand on those days. To determine if this exception exists, the planning process performs the gross-to-net explosion. The planning process does not issue this exception if it has solved the shortage by recommending creating new orders.

The following is a list of the names of the exception details default columns and the information supplied in each column.

<table>
<thead>
<tr>
<th>Exception</th>
<th>Exception name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Org</td>
<td>Organization where exception occurs</td>
</tr>
<tr>
<td>Item</td>
<td>Item with the shortage</td>
</tr>
<tr>
<td>Quantity</td>
<td>Shortage quantity</td>
</tr>
<tr>
<td>From Date</td>
<td>Shortage start date</td>
</tr>
</tbody>
</table>
To Date          Shortage end date  
Item Description Item description

**Action/Resolution:** Usually, this exception occurs within a planning time fence (and lead time in a constrained plan); you should consider reviewing and correcting supply/demand imbalances inside the planning time fence.

**Items below safety stock**
This exception shows an item for which demand, less supply, brings the projected quantity on hand to a negative level or below safety stock. This exception is different from the Items with a shortage exception because the Planning Exception Set is not involved in the generation of this exception.

**Generation:** On some days, the item has less inventory than the specified safety stock level. If the quantity remains constant for a period of days, then there will be a date range provided for this exception message.

The following is a list of the names of the exception details default columns and the information supplied in each column.

<table>
<thead>
<tr>
<th>Exception</th>
<th>Exception name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Org</td>
<td>Organization where exception occurs</td>
</tr>
<tr>
<td>Item</td>
<td>Item below safety stock</td>
</tr>
<tr>
<td>Quantity</td>
<td>item quantity</td>
</tr>
<tr>
<td>From Date</td>
<td>Start date</td>
</tr>
<tr>
<td>To Date</td>
<td>End date</td>
</tr>
<tr>
<td>Item Description</td>
<td>Item description</td>
</tr>
</tbody>
</table>

**Action/Resolution:** You should consider expediting scheduled receipts.

**Items with excess inventory**
This exception shows an item whose quantity on hand exceeds (as defined in excess quantity item’s planning exception set) the total requirements against the item, within the exception time fence defined by the item’s planning exception set.

**Generation:** On some days, the item has more inventory than it needs to satisfy demand. If the quantity remains constant for a period of days then there will be a date range provided for this exception message.
Performance Management

Making Decisions Based on Exceptions

The following is a list of the names of the exception details default columns and the information supplied in each column.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exception</td>
<td>Exception name</td>
</tr>
<tr>
<td>Org</td>
<td>Organization where exception occurs</td>
</tr>
<tr>
<td>Item</td>
<td>Item with excess inventory</td>
</tr>
<tr>
<td>Quantity</td>
<td>Excess quantity</td>
</tr>
<tr>
<td>From Date</td>
<td>Start date</td>
</tr>
<tr>
<td>To Date</td>
<td>End date</td>
</tr>
<tr>
<td>Item Description</td>
<td>Item description</td>
</tr>
</tbody>
</table>

**Action/Resolution:** You should consider canceling unneeded scheduled receipts or transferring the material to another facility.

**Reschedules**

**Past due orders**
This exception shows an item with planned orders, discrete jobs, and purchase orders that are past due.

**Generation:** For discrete material only, the planning process has found at least one planned order for an item in which both the needed start date and the needed due date are in the past. The planning process recommends the planned order to start and be due on the date that the planning process is executed (planning start date).

**Note:** If Lot for Lot is not selected in the plan options, all past due order are lumped together when the Optimization Plan Option is selected.

The following is a list of the names of the exception details default columns and the information supplied in each column.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exception</td>
<td>Exception name</td>
</tr>
<tr>
<td>Org</td>
<td>Organization where exception occurs</td>
</tr>
<tr>
<td>Item</td>
<td>Past due item</td>
</tr>
</tbody>
</table>
Making Decisions Based on Exceptions

Order Number | Order number
Old Date | Old due date (past due)
Date | New due date based on plan result
Quantity | Item quantity

**Action/Resolution:** For discrete material planning only, you should consider checking the demand that resulted in this planned order and either arrange to change the demand and supply due dates or prepare to expedite the scheduled receipt that you create from this planned order.

**Orders to be rescheduled out**
This exception shows an item with orders that is recommended to be rescheduled to a later date by the planning process.

**Generation:** For discrete material only, the planning process found a scheduled receipt for an item for which the suggested due date is greater than the due date of the order.

The following is a list of the names of the exception details default columns and the information supplied in each column.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exception</td>
<td>Exception name</td>
</tr>
<tr>
<td>Org</td>
<td>Organization where exception occurs</td>
</tr>
<tr>
<td>Item</td>
<td>Rescheduled item name</td>
</tr>
<tr>
<td>Order Number</td>
<td>Order number</td>
</tr>
<tr>
<td>From Date</td>
<td>Original date</td>
</tr>
<tr>
<td>To Date</td>
<td>Rescheduled date</td>
</tr>
<tr>
<td>Quantity</td>
<td>Order quantity</td>
</tr>
</tbody>
</table>

**Action/Resolution:** For discrete material planning only, you should consider reviewing the recommendations for this item. The Planning system assumes that the recommendation/action will be taken.

**Orders to be cancelled**
This exception shows an item with orders that is recommended to be cancelled by the planning process.
Making Decisions Based on Exceptions

**Generation:** For discrete material only, the planning process found a scheduled receipt for an item for which it does not have demands.

The following is a list of the names of the exception details default columns and the information supplied in each column.

<table>
<thead>
<tr>
<th>Exception</th>
<th>Exception name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Org</td>
<td>Organization where exception occurs</td>
</tr>
<tr>
<td>Item</td>
<td>Cancelled Item name</td>
</tr>
<tr>
<td>Order Number</td>
<td>Order number</td>
</tr>
<tr>
<td>Old Date</td>
<td>Old due date</td>
</tr>
<tr>
<td>Date</td>
<td>New due date (Plan start date)</td>
</tr>
<tr>
<td>Quantity</td>
<td>Order quantity</td>
</tr>
</tbody>
</table>

**Action/Resolution:** For discrete material planning only, you should consider reviewing the recommendations for this item. The Planning system assumes that the recommendation/action will be taken.

**Orders to be rescheduled in**

This exception shows an item with orders that is recommended to be rescheduled to an earlier date by the planning process.

**Generation:** For discrete material only, the planning process found a scheduled receipt for an item for which the suggested due date is prior to the due date of the order.

The following is a list of the names of the exception details default columns and the information supplied in each column.

<table>
<thead>
<tr>
<th>Exception</th>
<th>Exception name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Org</td>
<td>Organization where exception occurs</td>
</tr>
<tr>
<td>Item</td>
<td>Rescheduled item name</td>
</tr>
<tr>
<td>Order Number</td>
<td>Order number</td>
</tr>
<tr>
<td>From Date</td>
<td>Original date</td>
</tr>
<tr>
<td>To Date</td>
<td>Rescheduled date</td>
</tr>
<tr>
<td>Quantity</td>
<td>Order quantity</td>
</tr>
</tbody>
</table>
Making Decisions Based on Exceptions

**Action/Resolution:** For discrete material planning only, you should consider reviewing the recommendations for this item. The Planning system assumes that the recommendation/action will be taken.

**Orders with compression days**
This exception shows an item with planned orders, discrete jobs, and purchase orders that have compression days and need to be expedited.

**Generation:** For discrete material, the planning process found a planned order/supply for an item for which the suggested order date is in the past. That is, item’s lead time is being violated. The planning process recommends the planned order/supply to start (order date) on the date that the planning process is executed (SYSDATE). It assigns one compression day for each work day between the suggested order date and the date that the planning process is executed and then issues this exception.

For example, if a planned order due date is Friday, the lead time offset for this item is three days (Thursday, Wednesday, and Tuesday), and the planning process executes on Wednesday, the planning process suggests that the order date should be on Wednesday with one compression day.

The following is a list of the names of the exception details default columns and the information supplied in each column.

<table>
<thead>
<tr>
<th>Exception</th>
<th>Exception name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Org</td>
<td>Organization where exception occurs</td>
</tr>
<tr>
<td>Item</td>
<td>Sales order item</td>
</tr>
<tr>
<td>Order Number</td>
<td>Sales order number</td>
</tr>
<tr>
<td>Demand Date</td>
<td>Demand due date</td>
</tr>
<tr>
<td>Quantity</td>
<td>Demand quantity</td>
</tr>
<tr>
<td>Compression Days</td>
<td>Number of compression days</td>
</tr>
</tbody>
</table>

**Action/Resolution:** For discrete material planning only, you should consider reviewing the recommendations for this item and possibly moving out the demand to eliminate or alleviate the compression days. The Planning system assumes that the recommendation/action will be taken.
Substitutes and Alternates Used

Planned order uses alternate BOM
This exception message is generated for optimized plans only.

**Generation:** This exception message appears when the planning result does not use the primary BOM set by the user.

---

**Note:** APS requires that an alternate routing be associated with an alternate bill of material in order to be selected. Therefore, the exception message Planned Order uses alternate routing is always seen with the exception message Planned Order uses alternate BOM.

---

The following is a list of the names of the exception details default columns and the information supplied in each column.

<table>
<thead>
<tr>
<th>Exception</th>
<th>Exception name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Org</td>
<td>Organization where alternate is used</td>
</tr>
<tr>
<td>Item</td>
<td>Item name</td>
</tr>
<tr>
<td>Demand Date</td>
<td>Demand due date</td>
</tr>
<tr>
<td>Quantity</td>
<td>Demand quantity</td>
</tr>
<tr>
<td>Alternate BOM</td>
<td>Alt. Bill of Material</td>
</tr>
<tr>
<td>Alternate Routing</td>
<td>Alt. Routing</td>
</tr>
</tbody>
</table>

**Action/Resolution:** For information and validation purposes only. Generally, alternatives are relatively more expensive or more difficult to obtain. If you are seeing a lot of these exceptions, you may want to investigate this.

Planned order uses alternate routing
This exception message is generated for optimized plans only.

**Generation:** This exception message appears when the planning result does not use the primary routings set by the user.
The following is a list of the names of the exception details default columns and the information supplied in each column.

<table>
<thead>
<tr>
<th>Exception</th>
<th>Exception name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Org</td>
<td>Organization where alternate is used</td>
</tr>
<tr>
<td>Item</td>
<td>Item name</td>
</tr>
<tr>
<td>Demand Date</td>
<td>Demand due date</td>
</tr>
<tr>
<td>Quantity</td>
<td>Demand quantity</td>
</tr>
<tr>
<td>Alternate BOM</td>
<td>Alt. Bill of Material</td>
</tr>
<tr>
<td>Alternate Routing</td>
<td>Alt. Routing</td>
</tr>
</tbody>
</table>

**Note:** APS requires that an alternate routing be associated with an alternate bill of material in order to be selected. Therefore, the exception message Planned Order uses alternate routing is always seen with the exception message Planned Order uses alternate BOM.

**Action/Resolution:** For information and validation purposes only.

**Planned order uses substitute components**
This exception message is generated for optimized plans only.

**Generation:** This exception message appears when the planning result does not use the primary components set by the user.

The following is a list of the names of the exception details default columns and the information supplied in each column.

<table>
<thead>
<tr>
<th>Exception</th>
<th>Exception name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Org</td>
<td>Organization where substitute is used</td>
</tr>
<tr>
<td>Item</td>
<td>Item name</td>
</tr>
<tr>
<td>Demand Date</td>
<td>Demand due date</td>
</tr>
<tr>
<td>Quantity</td>
<td>Demand quantity</td>
</tr>
<tr>
<td>Order Number</td>
<td>Planned order number</td>
</tr>
</tbody>
</table>
**Action/Resolution:** For information and validation purposes only. Generally, substitutes are relatively more expensive or more difficult to obtain. If you are seeing a lot of these exceptions, you may want to investigate this.

**Planned order uses alternate resources**
This exception message is generated for constrained and/or optimized plans only.

**Generation:** This exception message appears when the planning result does not use the primary resource set by the user due to the non-availability of the primary resource.

The following is a list of the names of the exception details default columns and the information supplied in each column.

<table>
<thead>
<tr>
<th>Exception name</th>
<th>Org</th>
<th>Department that owns the resource</th>
<th>Alt. Resource</th>
<th>Demand due date</th>
<th>Demand quantity</th>
<th>Planned order number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Demand Date</td>
<td>Quantity</td>
<td>Order Number</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Action/Resolution:** For information and validation purposes only. Generally, alternative resource are relatively more expensive or difficult to operate or less convenient to use. If you are seeing a lot of these exceptions, you may want to investigate this.

**Order sourced from alternate facility**
This exception message is generated for optimized plans only.

---
**Note:** If you change and firm the source of a planned order to an alternate facility manually, and then rerun your plan, this exception message is generated regardless of plan options.

**Generation:** This exception message appears whenever the system selects an alternate facility instead of the primary facility. Alternate facility is defined in the
sourcing rule within the Assignment Set associated to the plan that has a rank greater than 1 and primary facility has a rank of 1.

The following is a list of the names of the exception details default columns and the information supplied in each column.

<table>
<thead>
<tr>
<th>Exception</th>
<th>Exception name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Org</td>
<td>Organization where alternate is used</td>
</tr>
<tr>
<td>Item</td>
<td>Item name</td>
</tr>
<tr>
<td>Date</td>
<td>Date</td>
</tr>
<tr>
<td>Quantity</td>
<td>Quantity</td>
</tr>
<tr>
<td>Source Org</td>
<td>Source organization</td>
</tr>
<tr>
<td>Supplier</td>
<td>Supplier name</td>
</tr>
<tr>
<td>Supplier Site</td>
<td>supplier location</td>
</tr>
</tbody>
</table>

**Action/Resolution:** For information and validation purposes only. Generally, alternate facilities are relatively more expensive or not as convenient to use. If you are seeing a lot of these exceptions, you may want to investigate this.

**Order sourced from alternate supplier**

This exception message is generated for all plans (unconstrained, constrained, and optimized).

**Generation:** This exception message appears whenever the system selects an alternate supplier instead of the primary supplier. Alternate supplier is defined in the Sourcing Rule within the Assignment Set associated to the plan that has a rank greater than 1 and primary supplier has a rank of 1.

The following is a list of the names of the exception details default columns and the information supplied in each column.

<table>
<thead>
<tr>
<th>Exception</th>
<th>Exception name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Org</td>
<td>Organization where alternate is used</td>
</tr>
<tr>
<td>Item</td>
<td>Item name</td>
</tr>
<tr>
<td>Date</td>
<td>Date</td>
</tr>
<tr>
<td>Quantity</td>
<td>Quantity</td>
</tr>
<tr>
<td>Source Org</td>
<td>Source organization</td>
</tr>
</tbody>
</table>
Action/Resolution: For information and validation purposes only. Generally, alternate suppliers are relatively more expensive or less convenient to use. If you are seeing a lot of these exceptions, you may want to investigate this.

Projects/Tasks

Items with a shortage in a project/task
This exception shows an item whose demand exceeds supply with a project/task for an item.

Generation: The planning engine generates projects/tasks related exception messages only when the planning options are set according.

Note: If there is both a Project and a Task Manager, the exception message is sent to the Task Manager, as modeled within the exception workflow.

The following is a list of the names of the exception details default columns and the information supplied in each column.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supplier</td>
<td>Supplier name</td>
</tr>
<tr>
<td>Supplier Site</td>
<td>Supplier location</td>
</tr>
<tr>
<td>Exception</td>
<td>Exception name</td>
</tr>
<tr>
<td>Org</td>
<td>Organization where exception occurs</td>
</tr>
<tr>
<td>Item</td>
<td>Item name</td>
</tr>
<tr>
<td>Date</td>
<td>Shortage date</td>
</tr>
<tr>
<td>Quantity</td>
<td>Quantity</td>
</tr>
<tr>
<td>Planning Group</td>
<td>Planning group</td>
</tr>
<tr>
<td>Project</td>
<td>Project name</td>
</tr>
<tr>
<td>Task</td>
<td>Task name</td>
</tr>
<tr>
<td>To Project</td>
<td>To project</td>
</tr>
<tr>
<td>To Task</td>
<td>To task</td>
</tr>
</tbody>
</table>
Action/Resolution: You should consider reviewing and correcting supply/demand imbalances with the Project and/or Task Manager.

Items allocated across projects/tasks
This exception shows an item whose supply for one project has been allocated to the demand of a different project.

Generation: This can be achieved by assigning the same planning group to the allocated-from and allocated-to project.

Note: If both a Project and a Task Manager are present, the exception message is sent to the Task Manager, as modeled within the exception workflow.

The following is a list of the names of the exception details default columns and the information supplied in each column.

<table>
<thead>
<tr>
<th>Exception</th>
<th>Exception name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Org</td>
<td>Organization where exception occurs</td>
</tr>
<tr>
<td>Item</td>
<td>Item name</td>
</tr>
<tr>
<td>Date</td>
<td>Date</td>
</tr>
<tr>
<td>Quantity</td>
<td>Quantity</td>
</tr>
<tr>
<td>Planning Group</td>
<td>Planning Group</td>
</tr>
<tr>
<td>Project</td>
<td>Project name</td>
</tr>
<tr>
<td>Task</td>
<td>Task name</td>
</tr>
<tr>
<td>To Project</td>
<td>To project</td>
</tr>
<tr>
<td>To Task</td>
<td>To task</td>
</tr>
</tbody>
</table>

Action/Resolution: For information and validation purposes only.

Items with excess inventory in a project/task
This exception shows an item whose supply exceeds demand with a project/task for an item.
Making Decisions Based on Exceptions

**Generation:** This exception shows an item in a project/task whose quantity on hand exceeds the total requirements against the item within the exception time fence defined by the item’s planning exception set.

---

**Note:** If both a Project and a Task Manager are present, then the exception message is sent to the Task Manager, as modeled in the exception workflow.

---

The following is a list of the names of the exception details default columns and the information supplied in each column.

<table>
<thead>
<tr>
<th>Exception</th>
<th>Exception name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Org</td>
<td>Organization where exception occurs</td>
</tr>
<tr>
<td>Item</td>
<td>Item name</td>
</tr>
<tr>
<td>Date</td>
<td>Excess inventory date</td>
</tr>
<tr>
<td>Quantity</td>
<td>Quantity</td>
</tr>
<tr>
<td>Planning Group</td>
<td>Planning group</td>
</tr>
<tr>
<td>Project</td>
<td>Project name</td>
</tr>
<tr>
<td>Task</td>
<td>Task name</td>
</tr>
<tr>
<td>To Project</td>
<td>To project</td>
</tr>
<tr>
<td>To Task</td>
<td>To task</td>
</tr>
</tbody>
</table>

**Action/Resolution:** You should consider canceling unneeded scheduled receipts for this project or transferring the material to another project.

### Item Exceptions

**Items that are over-committed**

This exception shows an item for which available to promise (ATP) is negative or below safety stock.

**Generation:** This exception is generated when ATP is less than zero where:

\[
ATP = \text{Planned Production} - \text{Committed Demand}
\]
### Planned Production

Planned Production = Planned Orders, Scheduled receipts (Purchase Orders, Purchase Requisitions, and Discrete Jobs), suggested repetitive schedules, nettable quantity on hand.

### Committed Demand

Committed Demand = Sales orders, component demand (from planned orders, discrete jobs, and suggested repetitive schedules); excludes forecast demand or manual planned.

The following is a list of the names of the exception details default columns and the information supplied in each column.

<table>
<thead>
<tr>
<th>Exception</th>
<th>Exception name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Org</td>
<td>Organization where exception occurs</td>
</tr>
<tr>
<td>Item</td>
<td>Item name</td>
</tr>
<tr>
<td>Quantity</td>
<td>Item quantity</td>
</tr>
<tr>
<td>Demand Date</td>
<td>Demand due date</td>
</tr>
<tr>
<td>Item Description</td>
<td>Item description</td>
</tr>
<tr>
<td>Lot Number</td>
<td>Lot number</td>
</tr>
</tbody>
</table>

**Action/Resolution:** You should consider creating more planned orders or move some planned orders around.

**Items with negative starting on hand**

This exception shows an item with a negative onhand beginning balance.

**Generation:** This exception is generated when the onhand beginning balance is below zero.

The following is a list of the names of the exception details default columns and the information supplied in each column.

<table>
<thead>
<tr>
<th>Exception</th>
<th>Exception name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Org</td>
<td>Organization where exception occurs</td>
</tr>
<tr>
<td>Item</td>
<td>Item name</td>
</tr>
<tr>
<td>Quantity</td>
<td>Negative quantity</td>
</tr>
<tr>
<td>Demand Date</td>
<td>Blank</td>
</tr>
<tr>
<td>Item Description</td>
<td>Item description</td>
</tr>
<tr>
<td>Lot Number</td>
<td>Blank</td>
</tr>
</tbody>
</table>
**Making Decisions Based on Exceptions**

**Performance Management**

**Action/Resolution:** You should consider creating more planned orders.

**Items with expired lot**
This exception shows an item that has inventory lots that expire within the planning horizon.

**Generations:** This exception is generated when there is an expired lot in the planning horizon.

The following is a list of the names of the exception details default columns and the information supplied in each column.

<table>
<thead>
<tr>
<th>Exception</th>
<th>Exception name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Org</td>
<td>Organization where exception occurs</td>
</tr>
<tr>
<td>Item</td>
<td>Item name</td>
</tr>
<tr>
<td>Quantity</td>
<td>Item quantity</td>
</tr>
<tr>
<td>Demand Date</td>
<td>Demand due date</td>
</tr>
<tr>
<td>Item Description</td>
<td>Item description</td>
</tr>
<tr>
<td>Lot Number</td>
<td>Lot number</td>
</tr>
</tbody>
</table>

**Action/Resolution:** This exception serves as a warning. You should ensure that the item/component will be used prior to its expiration date.

**Items with repetitive variance**
This exception shows an item with suggested aggregate schedules that differ from current aggregate schedules by more than a user-defined repetitive variance percentage, up to the exception date defined by the item’s planning exception set.

**Generation:** This exception is generated based on Exception Set defined by users.

The following is a list of the names of the exception details default columns and the information supplied in each column.

<table>
<thead>
<tr>
<th>Exception</th>
<th>Exception name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Org</td>
<td>Organization where exception occurs</td>
</tr>
<tr>
<td>Item</td>
<td>Item name</td>
</tr>
<tr>
<td>Quantity</td>
<td>Item quantity</td>
</tr>
</tbody>
</table>
Recommendations

**9-58**

Oracle Advanced Planning and Scheduling Implementation and User’s Guide

---

**Recommendations**

**Discrete Jobs and Purchase Requisitions**

Based on the planning results, the plan suggests that the planner take actions or implement the recommendations through the generation of recommendations. By double clicking on the discrete job, it takes you to the Supply/Demand window where you can release the discrete jobs and purchase requisitions.

The following is a list of the names of the columns in the Order tab in the Supply/Demand window and the information supplied in each column.

<table>
<thead>
<tr>
<th>Column</th>
<th>Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Demand Date</td>
<td>Demand due date</td>
</tr>
<tr>
<td>Item Description</td>
<td>Item description</td>
</tr>
<tr>
<td>Lot Number</td>
<td>Lot number</td>
</tr>
</tbody>
</table>

**Action/Resolution:** You should review both schedules to understand the difference.

**Items with no activity**

This exception shows an item with no demand or supply in the current plan.

**Generation:** To determine if this exception exists, the planning process performs the gross-to-net explosion.

The following is a list of the names of the exception details default columns and the information supplied in each column.

<table>
<thead>
<tr>
<th>Column</th>
<th>Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exception</td>
<td>Exception name</td>
</tr>
<tr>
<td>Org</td>
<td>Organization where exception occurs</td>
</tr>
<tr>
<td>Item</td>
<td>Item name</td>
</tr>
<tr>
<td>Quantity</td>
<td>Blank</td>
</tr>
<tr>
<td>Demand Date</td>
<td>Blank</td>
</tr>
<tr>
<td>Item Description</td>
<td>Item description</td>
</tr>
<tr>
<td>Lot Number</td>
<td>Blank</td>
</tr>
</tbody>
</table>

**Action/Resolution:** You can consider changing the item attribute Planning Method to Not planned.
There are additional columns you could display using Right Mouse Options that provide some key information pertaining to the orders such as Suggested Due Date, Suggested Dock Date, Suggested Start Date, and Suggested Order Date. The calculations for these key terms are as follows:

- Suggested Due date = Date Material Is Required
- Suggested Dock Date = Due date – Postprocessing Lead Time
- Suggested Start date = Dock date – Processing Lead Time
- Suggested Order date = Start date – Preprocessing Lead time

The earliest Suggested Order Date allowed is today and no compression days are allowed.
Topics covered in this section include the following:

- Overview of Planner Workbench/User Interface on page 10-2
- General Navigation on page 10-2
- Tailoring the User Interface on page 10-9
- Using the Left Pane and the Navigation Tree on page 10-13
- Using the Right Pane and the Navigation Tree on page 10-17
- Viewing Pegging Supply and Demand Information on page 10-39
- Viewing the Supply Chain on page 10-40
- Implementing Planning Recommendations on page 10-43
- Reviewing a BOM or Supply Chain Bill on page 10-45
- Interactive Scheduling Using the Gantt Chart on page 10-47
Overview of Planner Workbench/User Interface

The Planner Workbench is a powerful graphical tool that lets you perform advanced simulation, review plan performance, and take actions based on system recommendations.

See "Advanced Graphical User Interface" on page 1-8 for general information on the Planner Workbench.

General Navigation

Figure 10–1  The Planner Workbench

The tree controls the context that is displayed in the right pane. The information shown in the right pane is aggregated to the level of the node selected in the left pane. For instance, if Organization is selected in the left pane then every tab in the right pane shows information aggregated for the organization. If the aggregated information cannot be displayed then the tab is disabled.
If you select more than one node in the left pane, the right pane displays information for both nodes selected. For instance, if you select two items in the left pane then the Horizontal Plan shows details for both items listed consecutively.

---
**Note:** You cannot use multi-select to select two nodes that do not belong to the same folder, nor can you multi-select an item and a product family.

---

You can select multiple items using Control-Click.

**Drill Down**

In any window with summary information like actions summary or horizontal plan, you can drill down to more detailed information by double-clicking on an element. This feature lets you do the following:

- Drill down on action messages to view details of a particular action.
- Drill down to different levels the Items, Organizations, and Resources tabs to view details.
- Drill either down or up from a supply or demand order in the Pegging tree.
- When working in the Items or Organizations tab, drill down from the Horizontal Plan to view supply/demand details. When working in the Resources tab, drill down from the Horizontal Plan to view resource availability.
- When working in the Items or Organizations tab, drill down from the Vertical Plan to view supply/demand details.

**Navigating Through a Find Window**

The Find windows enables you to control the volume of data displayed. You can set find criteria for all trees and detail windows.
The Find window enables you to display basic information for the items in the current plan, plus pegging and supply/demand information.

To display the Find window:
1. Select a plan in the Planner Workbench.
2. Choose Tools > [Items, Supply/Demand, Supply, Demand, or Resources].

The Find window appears. You can search for the following item details:
- ABC Class
- Buyer
- Category
- Item
- Planner
- Repetitive
3. To retrieve all records, leave all fields blank and choose Find.

4. To retrieve a subset of records, enter a search string. You can use just one string in your search (containing a criterion, an operator, and a value), or you can enter several strings to refine your search.

5. Once you have entered at least one string containing a field name, a condition, and (optionally) a value, choose Find to start your search.

6. Optionally, choose a folder to import a previously defined search strings and start the search.

**Pull-Down Menus**

Pull-down menus take context from the Planner Workbench tree.

For example, if an item node is selected, the pull-down menus will be related to that item. If a resource is selected, the pull-down menu will be related to that resource.
Right-Click Menu Options

From any window in the Planner Workbench, you can access menu options via the [right-click] button. [Right-click] menu options are context sensitive, and different depending on the window or selected screen element.
**Properties Window**

You can view properties for any node in a left pane tree or pegging tree by selecting the node, then choosing [right-click] > Properties.
Figure 10–5  Displaying Properties for a Planned Order Demand in the Pegging Tree
Tailoring the User Interface

The following table shows the menu options for the Planner Workbench and what happens when a particular menu option is selected.

<table>
<thead>
<tr>
<th>Menu</th>
<th>Menu Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit</td>
<td>Duplicate</td>
<td>Duplicate a record.</td>
</tr>
<tr>
<td>Edit</td>
<td>Clear</td>
<td>Edit the current field.</td>
</tr>
<tr>
<td>Edit</td>
<td>Delete</td>
<td>Delete the current field.</td>
</tr>
<tr>
<td>Edit</td>
<td>Preferences</td>
<td>Set a user profile.</td>
</tr>
<tr>
<td>View</td>
<td>Show Navigator</td>
<td>Display Navigator window.</td>
</tr>
<tr>
<td>View</td>
<td>Find</td>
<td>Find a record.</td>
</tr>
<tr>
<td>View</td>
<td>Find All</td>
<td>Find all records.</td>
</tr>
<tr>
<td>View</td>
<td>Query by Example</td>
<td>Run queries for certain information.</td>
</tr>
<tr>
<td>View</td>
<td>Record</td>
<td>View a record.</td>
</tr>
<tr>
<td>View</td>
<td>Requests</td>
<td>Review requests.</td>
</tr>
<tr>
<td>Tools</td>
<td>Exception Details</td>
<td>View exception details for your plan.</td>
</tr>
<tr>
<td>Tools</td>
<td>Supply/Demand</td>
<td>View supply and demand information.</td>
</tr>
<tr>
<td>Tools</td>
<td>Supply</td>
<td>View supply information.</td>
</tr>
<tr>
<td>Tools</td>
<td>Demand</td>
<td>View demand information.</td>
</tr>
<tr>
<td>Tools</td>
<td>On-Hand</td>
<td>View on-hand quantities.</td>
</tr>
<tr>
<td>Tools</td>
<td>Items</td>
<td>View items information.</td>
</tr>
<tr>
<td>Tools</td>
<td>Resources</td>
<td>View resources information.</td>
</tr>
<tr>
<td>Tools</td>
<td>Notifications</td>
<td>View notifications.</td>
</tr>
<tr>
<td>Tools</td>
<td>Launch Notifications</td>
<td>Launch notifications.</td>
</tr>
<tr>
<td>Tools</td>
<td>Work Dates</td>
<td>Set up work dates for your plan.</td>
</tr>
<tr>
<td>Tools</td>
<td>Preferences</td>
<td>Set preferences.</td>
</tr>
<tr>
<td>Plan</td>
<td>Start Online Planner</td>
<td>Start online planner</td>
</tr>
</tbody>
</table>
You can tailor the user interface in the following ways:

**Resize Windows**

You can resize windows as with any windows-based application. In the Planner Workbench you can adjust slide bars to change the relative widths of the left and right panes. You can also maximize the right pane independent of the left pane.
Customize Columns
You can add, hide columns, resize, and move columns on the horizontal plan and folder windows.

Defining Display Preferences
Display preferences control what horizontal material planning data, horizontal capacity planning data, supplier planning information, transportation planning information, and supply/demand detail are displayed for each item.

To define your display preferences:
1. Navigate to the Planner Workbench.
2. Choose Tools > Preferences.
   The Material Plan tab appears as the default tab.
3. Enter Display Buckets, Independent Demand Type, Display Factor, Decimal Places, Show Graph and check each type of plan information you want to display in your material plan.

4. Choose the Capacity Plan tab.

5. Check each type of plan information you want displayed in your capacity plan.

6. Choose the Supplier Plan tab.

7. Check each type of plan information you want displayed in your capacity plan.

8. Choose the Transportation tab.

9. Check each type of plan information you want displayed in your capacity plan.

10. Choose the Other tab.

   Supply/Demand details display.

11. Enter a Cutoff Date and Job Status.

    When the Planner Workbench creates discrete jobs from implemented planned orders, it assigns the job status you enter in the Preferences window.
12. Select a Job Class.

When the Planner Workbench creates discrete jobs from implemented planned orders, it assigns the job class you enter in the Preferences window.

13. Select a Req Group By default.

When the Planner Workbench creates purchase requisitions from implemented planned orders, it assigns the requisition load group you enter in the Preferences window.

14. Select the Default Left Tab and Default Right Tab under General.

15. Choose Apply to use your preference selections for the current session only.

16. Choose Reset to use your previously saved selections.

Using the Left Pane and the Navigation Tree

The left pane contains a hierarchical tree viewable by the following categories:

- Actions
- Items
- Organizations
- Projects
- Resources
- Suppliers

Choose a tree category from the list of values (View by) at the top of the left pane. The following figures show the layout for each category.

Figure 10–8  Planner Workbench left pane tree layout for Actions

Planner Workbench left pane tree layout for Actions

+ Plans
  + Versions
    + Exception Groups
      + Items Exceptions
        + Exceptions
          + Organizations
            + Items
+ Shortages and Excess
  + Exceptions
    + Organizations
      + Items
+ Reschedules
  + Exceptions
    + Organizations
      + Items
+ Late Sales Orders and Forecasts
  + Exceptions
    + Organizations
      + Items
+ Projects/ Tasks
  + Exceptions
    + Organizations
      + Items
+ Material and Resource Capacity Exceptions
  + Exceptions
    + Organizations
      + Items
+ Substitutes and Alternates Used
  + Exceptions
    + Organizations
      + Items
+ Recommendations
  + Discrete Jobs
    + Organizations
      + Items
  + Purchase Requisitions
    + Organizations
      + Items
  + Flow Schedules
    + Organizations
      + Items
  + Repetitive Schedules
    + Organizations
      + Items
Figure 10–9  Planner Workbench left pane tree layout for the Items tree

Planner Workbench left pane tree layout for the Items tree

+ Plans
  + Product Families/Models/Option Classes
  + Items
    + Organizations
    + Components
    + Departments
    + Lines
    + Transportation Resources
    + Approved Suppliers
+ Categories
  + Items
    + Organizations
    + Components
    + Departments
    + Lines
    + Transportation Resources
    + Approved Suppliers

Figure 10–10  Planner Workbench left pane tree layout for Organizations

Planner Workbench left pane tree layout for Organizations

+ Plans
  + Organizations
    + Product Families/Models/Option Classes
    + Items
      + Components
      + Approved Suppliers
    + Categories
      + Items
        + Components
        + Approved Suppliers
    + Departments
      + Resources (owned resources only)
        + Items
          + Components
          + Approved Suppliers
    + Lines
Using the Left Pane and the Navigation Tree

Figure 10–11 Planner Workbench left pane tree layout for Projects

Planner Workbench left pane tree layout for Projects

+ Plans
  + Organizations
    + Planning Groups
      + Common
        + Items
      + Items
    + Planning Groups
      + Common

Figure 10–12 Planner Workbench left pane tree layout for Resources

Planner Workbench left pane tree layout for Resources

+ Plans
  + Organizations
    + Department Classes
      + Departments
        + Resources
          + Items
    + Resource Groups
      + Departments
        + Resources
          + Items
    + Lines
      + Departments
        + Resources
          + Items
    + Transportation Resources
      + Departments
        + Resources
          + Items
Using the Right Pane and the Navigation Tree

The right pane contains summary information in tables and graphs, including:

- Key Indicators
- Horizontal Plan
- Vertical Plan
- Actions
- Supply Chain

You control the context of the right pane by highlighting one or more nodes on the tree. You can also use the Find window on either the left or right panes to further limit the context. From the right pane, you can drill down to more detailed information.

The Key Performance Indicators (KPIs) Tab

The initial window of the Planner Workbench, the summary chart, provides a graphical display of the plan’s Key Performance Indicators (KPIs). At a glance, you can see how the plan performs relative to the following measures:

- Inventory Turns
- On-time Delivery
- Planned Utilization
- Margin Percentage
- Cost Breakdown
- Margin
- Service Level
Inventory value

You can choose to see any four of these measures together. The availability of the KPIs depends on the type of plan chosen. For information on how these measures are calculated, please refer to Chapter 9, "Performance Management."

**Figure 10–14 The KPIs Summary Chart in the Planner Workbench**

To view KPIs:
1. Select a Plan, an Item, an Org, or a Product Family from the tree in the left pane.
2. Select Key Indicators in the right pane.
3. The right pane displays KPIs for the selected Plan, Item, Org, or Product Family.

To view an enlarged version of a KPI graph:
Double-click on a sub-window to see an enlarged version of a KPI graph. Double-click again to return to the normal view.
Additional display options for each sub-window in the summary chart are available via the [right-click] menu. For instance, you can display KPI information in a trend chart.
Figure 10–16  The KPIs Trend Chart

Inventory Turns
This graph compares the actual inventory turn values to the target values collected from the source. You can view overall inventory turns for a plan or select a node on the tree to see the node’s inventory turns. You can view the inventory turns value over time to evaluate the plan throughout the planning period. 

The Inventory Turns graph is displayed at the following nodes:

- plans
- organizations
- product families
- categories
- individual items
- components
- planning groups
Using the Right Pane and the Navigation Tree

- projects
- tasks

**Ontime Delivery**
The Ontime Delivery Percentage graph is displayed at the following nodes:
- plans
- organizations
- product families
- categories
- individual items
- components
- planning groups
- projects
- tasks

**Planned Utilization**
The Planned Utilization percentage is available at the following nodes:
- plans
- organizations
- departments
- resource groups
- resources
- production lines
- transportation resources
- approved suppliers

**Margin Percentage**
This graph compares the actual margin to the target values collected from the source. You can evaluate alternate plans based on the net difference between plan
revenues and costs. Plan revenues are derived from forecasts and booked sales orders while costs account for planned production schedule expenses.

Margin percentage is available at the following nodes:

- plan
- organization
- product family

**Reviewing Item Planning Information**

In the View by drop-down menu, select either Item or Organization, then drill down to an Item to view KPIs at the Item level.

*Figure 10–17  Viewing KPIs at the Item Level*

**Comparing KPIs for Multiple Plans**

KPIs of multiple plans can be compared in the summary chart by selecting two or more plans in the left pane.
Figure 10–18 Comparing KPIs for Multiple Plans

The Horizontal Plan and Vertical Plan Tabs

You can display your plan information vertically or horizontally.
The Vertical Plan view is only enabled for an Item-Org context and it displays the activity by item over time in a vertical format (non-bucketized).

To display your plan vertically:
1. Select one or more items from the tree in the left pane.
2. In the right pane, choose the Vertical Plan tab.
The horizontal plan information is displayed in a pivot table enabling you to drill down from years, to periods, to weeks, to days. The following table shows the default display for the horizontal plan for each plan type:

<table>
<thead>
<tr>
<th>Plan Type</th>
<th>Default Display</th>
</tr>
</thead>
<tbody>
<tr>
<td>Material Plan</td>
<td>Projected Available Balance</td>
</tr>
<tr>
<td>Capacity Plan</td>
<td>Required Hours vs. Hours Available</td>
</tr>
<tr>
<td>Supplier Plan</td>
<td>Required Capacity vs. Available Capacity</td>
</tr>
<tr>
<td>Transportation Plan</td>
<td>Weight Capacity Available vs. Weight Capacity</td>
</tr>
</tbody>
</table>

To display your plan horizontally:

1. Select one or more items, resources, lines, transportation resources, or suppliers from the tree in the left pane.
2. In the right pane, choose the Horizontal Plan tab.
Dynamically Define Graphs
Define graphs by selecting which pieces of information to graph.

Figure 10–21  Dynamically Define Graphs

To define information to be graphed:

1. In the right pane, choose the Horizontal Plan tab.
   Plan data appears in a horizontal plan.
2. Select the plan parameters you wish to graph.
   To graph two or more parameters together, hold the shift key as you select additional parameters. For example, you can graph either planned orders, gross requirements, or both. You can also choose to graph multiple items.
3. [Right-click] to show and hide graph or save preference in the Tools > Preferences menu.
4. [Right-click] on the Items or Organization area to display more options. Left click on Hide/Show Graph to hide the graph.
4. To change the number of periods being displayed in the horizontal graph, [right-click] anywhere in the graph and select Viewable Groups. Your choices are 5, 7, or 15. Five is the default.

**Dynamically Choose Types of Graphs**

After you have graphed parameters or items (see above) you can change the chart type using the [right-click] menu. For instance, if you have displayed a bar chart and you wish to display a line graph, select [right-click] > Line Chart.

**Figure 10–22  Dynamically Choose Types of Graphs**

**View Available Capacity**

**Horizontal Capacity Plan** The Horizontal Plan tab displays the Horizontal Capacity Plan for resources and resource type nodes.
To view Resources:

1. [Right-click] on an item in the navigation tree then choose the Resources option. The Resources window displays.

2. To view Resource Requirements, choose the Requirements button. The Resource Requirements window appears.
To view Resource Availability:

1. From the Resources window choose the Availability button.

   The Resource Availability window appears.
Identifying Capacity Problems Use exception messages or the horizontal capacity plan to view overloaded resources.

Actions/Exceptions Tab

The Actions tab and tree segregates all of the actions that require immediate attention. The Actions tree contains all of the recommended new orders due to be executed within a user defined time window, as well as all exception messages requiring attention.

To view exceptions:

1. Choose a plan for which to view exception messages. You can view exception messages at the item level by selecting an item in the Items or Organization tree.
2. In the right pane, choose the Actions tab.
The Exception Summary window lists exception groups and exception messages for the selected plan in order of their usefulness in troubleshooting. For instance, exceptions due to late sales orders appear before exceptions due to resource constraints.

Using the Find window, you can sort, group, or sub-total exceptions according to various criteria including item, supplier, or buyer, for example.

To sort exceptions:
1. From the Exception Summary window, select View > Find.
   The Find Actions window displays.
2. Select criteria by which to sort exceptions.
3. Check Display Message Count checkbox.
4. Click the Find button.
Exception messages appear in the Exception Summary window sorted accordingly.

To view exception details, drill down on an exception message.

The Exception Details window appears.

Figure 10–27 Exception Details window

Exception details display preseeded default folders (combination of various key columns) based on exception type. For example, Late Replenishment for Forecast exception detail has a different exception default folder than Material Constraint exception. If you select several different exceptions, the generic default folder appears.

Note: You can customize exception folders based on your preferences and save it as the default. This is explained in the next section.

10-32 Oracle Advanced Planning and Scheduling Implementation and User’s Guide
Please note that the Days Late column is available and filled in for the following exceptions: Late Replenishment for Forecast and Late Replenishment for Sales Order.

**Folder Management**
You can create and save new folders, or open and delete existing folders. When opening a new folder, the layout for the new folder replaces the layout for the current folder.

**To create a new folder:**
1. Choose Folder > New.
   The Create New Folder window appears.
2. Enter the new folder name. The name must be unique for the user’s sign-on and for the entity that the folder represents.
3. Set the auto-query option:
   - Always - automatically queries for a subset of records each time folder is opened.
   - Never - does not execute the query when opening this folder
   - Ask each time - opens a decision box that requests you to execute the query when opening the folder
4. Check Open as Default if the new folder definition should open as the default folder (each time you navigate to this folder for the first time).
5. Check Public if other Oracle Applications users (for example, other planners or buyers) are allowed to have access to this new folder.

**Note:** They can use it as their default folder, but only the original owner can modify the definition.

6. Choose OK when done.
Whenever this new folder is opened, the name that is assigned to this folder appears in the upper left corner of the folder block, next to the Open Folder button. The original default folder definition, provided with the product, does not have a folder title unless it is saved with a new name.
To recover the original default folder definition:
A user can recover the default folder that was shipped with the APS product, after creating a custom one, through the following steps:

1. Select Folder > Save As when you are in the custom default folder.
2. Uncheck Open as Default in the Save As window that appears.
3. Choose OK.
4. Close and reopen the form to display the original default folder.

We recommend that you save the original default folder by giving it another name before creating a new default folder. This way, the original default folder can be reinstated from a list of predefined folders.

To open another folder:
1. Select Folder > Open to load a predefined folder. You can also press the Open Folder button located in the upper left corner of the folder.
2. Select a private or public folder from the list window that appears and choose OK to replace the current folder with the new folder.

To save changes to a folder:
1. Select Folder > Save to save any layout or query changes made to the current folder, or select Folder > Save As to save the current folder under a new name. If there are any pending changes to the data in the form, you will be prompted to save the changes or cancel the save.
2. If you choose Save As, complete the information requested in the Save Folder window that appears and choose OK.

This window prompts you for the same information as the Create New Folder window.

Note: If you save a folder to Open as Default, then open another folder and save that second folder also as Open as Default, the second folder becomes the new default.
To delete an existing folder:

1. Select Folder > Delete.

2. Select a folder from the list that appears and choose OK to delete the folder. You can only delete folders that you have created. If there are any pending changes to the information in the folder, you will be prompted to save the changes or cancel the delete action.

If other users are referencing that folder definition as their ‘Open as Default’ folder, that reference will be deleted as well.

To create a custom folder for viewing exception details:

1. Choose Folder > [layout option].

2. Change the display as desired.

Drill Down to Related Exceptions

If you are working in a constrained or optimized plan, you can drill down from an exception to Related Exceptions (Right Mouse Options) to analyze questions like:

- Why is the order late? Is it because of a resource, material, or transportation resource constraint?

- A material/resource/transportation resource issue is detected. Will it cause any late orders?

The objective is to explain the cause and effect of the problems. The related exceptions that each exception drills down to are indicated by an arrow.

On the other hand, from the constraint exception (resource, material, or transportation resource), you can also drill down to Late replenishment for sales order/forecast if the constraint causes the late replenishment.

This feature only applies to the following:

- Late replenishment for sales orders
- Late replenishment for forecast

---

Note: Saving a public folder after any modification, will make the folder private. However, a public folder is opened and saved to ‘Open as Default’ with no other changes; you merely save a reference of that folder as a private default.
Using the Right Pane and the Navigation Tree

- Material constraint
- Resource constraint
- Transportation resource constraints

To view related exceptions for the Late Replenishment for Sales Order:
1. Select a row in the Late Replenishment for Sales Order Exception Details window.
2. Choose [right-click] > Related Exceptions.
   Related exceptions appear in the Exception Details window.

To graphically compare exceptions for multiple plan scenarios:
1. Select the plans you wish to compare in the tree navigator in the left pane.
2. In the right pane, choose the Actions tab.
3. View comparison of the exception messages.
4. View details of action.

**Relevant Information Buttons**

On the Exception Details window, additional information about the exception can be obtained through clicking the buttons on the bottom of the window. The type of exception will determine what buttons are available.

**Right Mouse Options**

From the Exception Details window, planners can obtain more information through a right mouse click on the exception. The type of right mouse options users have is determined by the exception that is selected. Options included are:

- Supply
- Demand
- Resource Availability
Using the Right Pane and the Navigation Tree

- Resource Requirements
- Sources
- Destinations
- Related Exceptions
- Gantt Chart
- Horizontal Plan
- Vertical Plan
Viewing Pegging Supply and Demand Information

The Pegging tree lets you trace supply information for an item to its corresponding end demand details. You can drill up or down from any item or component level.

To display the Pegging tree:

1. Select the desired item in the left pane.
3. In the Supply/Demand window, the Pegging tree appears in the bottom half of the window.
   Pegging information for the item displays in the Pegging tree.
4. To expand the Pegging tree, highlight the pegging node, then press [right-click] > Expand All.
5. To show the Properties of a node, press [right-click] > Properties.

Figure 10–29  The Pegging tree in the Supply/Demand window
Viewing the Supply Chain

The Pegging tree links the item’s demand to all corresponding supply at the same time. The default display is: if you peg from demand to supply, supply order details and end item demand order information; if you peg from supply to demand, supply order details, immediate parent demand information, and end item demand information.

You can explode each node to higher level or lower level nodes. You can also jump to other detail windows using the [right-click] menu.

---

**Note:** If you are running a constrained plan, Oracle ASCP will compute pegging for all items irrespective of their pegging attributes.

---

Viewing the Supply Chain

You can view contextual supply chain and where used information for an item graphically.

**To view Supply Chain or Where Used information:**

1. Drill down to an end item in the left pane.
2. Select the Supply Chain tab in the right pane.

A graphical representation of the item’s supply chain bill appears.
Use the drop down list to view where used information for a component of this end item.
Figure 10–31 Where Used Information for an End Item
Implementing Planning Recommendations

The Actions Summary view displays both recommendations and exceptions. The recommendations are divided into orders that must be released and future orders. In the Preferences window (Tools > Preferences), you can specify the time frame in days for which to show recommendations.

› To implement planning recommendations, choose Tools > Preferences.

Creating and Implementing Firm Planned Orders

Accessing and Executing Planned Orders Directly
You can access a subset of planned orders for a specified time period or other user defined sort criteria using the Supply/Demand window. You can also firm all planned orders or a specified subset of planned orders using a Firm All feature. You can release all planned orders using a Release All feature or you can individually select planned orders for release.

› To access and execute planned orders:
1. Select Actions tab > Recommendations.
2. Drill down to Purchase Requisitions or Discrete Jobs.
3. To firm a planned order, drill down to detail, then select the firm checkbox.

Releasing Recommendations

› To release recommendations:
1. In the right pane, choose Actions tab > Recommendations.
2. Drill down to Purchase Requisitions or Discrete Jobs.
3. Press [right-click] > Release to select the record(s) to release.
To modify release properties (optional):

1. Drill down to Supply/Demand.


Figure 10–33  Modifying Release Properties

Releasing All Recommendations

To release all recommendations:

1. In the right pane, choose Actions tab > Recommendations.
2. Drill down to Purchase Requisitions or Discrete Jobs.
3. Press [right-click]>Select All for Release to release all.
4. Make necessary changes and save.

Reviewing a BOM or Supply Chain Bill

The tree structure makes it easy to go down levels on a bill of material. In the Organization tab, you can left click to go down a level from a department, resource, or item level to the next level down.
The supply chain map also offers the Item/Location View. This view is available only at the item nodes and is the default for these nodes. This view displays a diagrammed flow view of all the sourcing rules and bills of distribution associated with the selected item. This view also serves as the indented bill of materials.

You can use the Where Used functionality in the Items window to find out where the item is used.

To review a BOM:
1. In the left pane of the Navigator, choose the Items tab.
2. Choose the item for which to view a bill of materials.
Interactive Scheduling Using the Gantt Chart

Interactive scheduling provides a time-phased graphical interface to your plan’s scheduled activities and resources to help resolve inevitable shop floor problems. It lets you troubleshoot exceptions arising from resource or material constraints; overloaded or underloaded resources; absenteeism, or machine downtime. Use interactive scheduling to pinpoint affected jobs and operations and simulate changes towards effective, timely resolution.

To access the Gantt Chart:

Follow the appropriate navigation path as shown in the table below:

<table>
<thead>
<tr>
<th>Current Window</th>
<th>Navigation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exception Details window</td>
<td>[Select any field] &gt; [right-click] &gt; Gantt Chart</td>
</tr>
<tr>
<td>Supply window</td>
<td>[Select any field] &gt; [right-click] &gt; Gantt Chart</td>
</tr>
<tr>
<td>Item window</td>
<td>[Select any field] &gt; [right-click] &gt; Gantt Chart</td>
</tr>
<tr>
<td>Resources window</td>
<td>Click the Gantt button</td>
</tr>
<tr>
<td>Left pane, Planner’s workbench</td>
<td>Select a resource&gt;[right-click]&gt;Gantt Chart</td>
</tr>
</tbody>
</table>
You can specify either a resource-centric view or an order-centric view using the drop down menu in this window’s left pane. The upper panel shows the respective views. The lower panel shows resources bucketed by units, hours, or days. The default display is bucketed by units.

**Note:** The Gantt Chart shows only the resource requirements that occur in the first horizon (days bucket). For example, if a plan’s buckets are 30 days, 10 weeks, and 3 periods, the Gantt Chart shows resource requirements for the first 30 days. You cannot move a job beyond the first planning horizon.

**The Order-Centric View**

The Order Centric View has orders/supply as a driver. It shows all the resources belonging to a given supply. Late jobs are shown in red. This view allows access to order information like order priority, job name, job type, operation sequence, demand type, alternate resource flag, item, quantity, project, task, unit number,
Interactive Scheduling Using the Gantt Chart

start and end times, priority, customer, and whether an activity is firmed by resource, by time or both. It also provides access to supply views within PWB.

A change in activity such as reschedule, change in duration of an activity, and change in priority is supported from Order-Centric View. When an activity is moved, the start date or the due date of the activity/operation is firmed.

**Figure 10–35  Order-Centric View**

As displayed in the above screen shot, order no. 75196459 shows pegging to order 75196868 for JOB-BBD. Sub assy 75196527 for JOB-BBX is also shown pegged to the end assy 75196459.

The node for Sub assy 75196527 was selected and was drilled down to reveal sub assy 75196603 and subsequently 4335, 4338, etc. at different levels.

Sub assy 4335 is further detailed in operations 10, 20 and 30, where each of the operations also show the activities and related resources.

Material is shown at the beginning of an operation where it is needed.
Interactive Scheduling Using the Gantt Chart

The Resource-Centric View
This view displays all the activities that are being worked on by the selected resource(s). This view can be accessed from the resource block of the Planner Workbench or by right clicking on selected resource(s) in the left pane of Planner Workbench.

Note: In both the order-centric and the resource-centric views, an activity that appears on the right pane and is not seen on the left pane can be brought in to the right pane by right clicking on that activity in the left pane. This makes it easy to navigate to an activity.

Color Codes
Operations in the Gantt Chart are color-coded according to the following scheme:

<table>
<thead>
<tr>
<th>Colors</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dark Blue</td>
<td>Required</td>
</tr>
<tr>
<td>Cyan</td>
<td>Available</td>
</tr>
<tr>
<td>Magenta</td>
<td>Overload</td>
</tr>
<tr>
<td>Pink</td>
<td>Updated</td>
</tr>
<tr>
<td>Green</td>
<td>Firmed</td>
</tr>
<tr>
<td>Pink with Green Border</td>
<td>Updated/Firmed</td>
</tr>
<tr>
<td>Blue with Green Border</td>
<td>Required/Firmed</td>
</tr>
</tbody>
</table>

Find Window
The Find window can be used to view subsets of data by selected criteria, such as by time or by parts within the Gantt chart.
To display the Find window, select File>Find.

*Figure 10–36  Find Window*

---

**Right-Click Menu Options**

The Gantt Chart provides easy access to important information and tasks related to operations. The following options are available if you right-click with your cursor over an operation:

<table>
<thead>
<tr>
<th>[Right-Click] Menu Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Alternate/Primary Resource</td>
<td>View Alternate/Primary Resource for this operation</td>
</tr>
<tr>
<td>Load Alternate/Primary Resource</td>
<td>Load Alternate/Primary Resource for this operation</td>
</tr>
<tr>
<td>View Simultaneous Resources</td>
<td>View Simultaneous Resources for this operation</td>
</tr>
<tr>
<td>Firm/Unfirm Operation</td>
<td>Firm/Unfirm Operation for this operation</td>
</tr>
<tr>
<td>Reschedule</td>
<td>Reschedule</td>
</tr>
</tbody>
</table>
Interactive Scheduling Using the Gantt Chart

<table>
<thead>
<tr>
<th>[Right-Click] Menu Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supply / Demand</td>
<td>Open the Supply / Demand window</td>
</tr>
<tr>
<td>Exception Details</td>
<td>Open the Exception Details window</td>
</tr>
<tr>
<td>Item</td>
<td>Open the Items window</td>
</tr>
<tr>
<td>Resource Availability</td>
<td>Open the Resource Availability window</td>
</tr>
<tr>
<td>Resource Requirements</td>
<td>Open the Resource Requirements window</td>
</tr>
<tr>
<td>Resources</td>
<td>Open the Resources window</td>
</tr>
</tbody>
</table>

**Figure 10–37  Right Click**

Viewing Information on an Operation

You can view information on an operation via the Property window or resource Tool Tips.
To display the Property window:

1. Select an operation in the right pane.
2. Double-click on an operation.

   The Property window appears.

*Figure 10–38 The Property window*

The Property window displays a host of information about the selected operation. Choose tabs to access different types of information.

When you double click on the Gantt chart bar on the right panel (or the labels on the left panel), a Property window appears with three tabs: resource, supply order, and end demand.

The properties for the Resource tab (only for the activity node) are: department/line, resource name, org/instance, operation sequence, resource sequence, alternate number, firm type, start time, end time, assigned units, and total hours required.
The properties for the supply order tab (only for the supply node) are: job number, job type, item, quantity, firm flag, suggest due date, ship date, need by date, unit number, project, task, alternate BOM, alternate routing, and time fence.

The properties for the end demand tab (only for the supply node) are: demand date, demand satisfied date, pegged quantity, demand name, demand qty, demand type, demand priority, customer, customer site, and item

▶ To access the resource Tool Tip for an operation, rest your cursor over the operation in the right panel.

**Figure 10–39  The Resource Tool Tip**

The resource Tool Tip is a subset of the Properties window showing resource name, number of units, and resource type.
Specify Resources to Plot in the Lower Pane

To select resources to plot:
1. Click the Select Resource(s) button in the lower pane.
   The Select Resources window displays.

Figure 10–40 The Select Resource(s) window

2. Move resources between the Available Resources and Selected Resources panes as desired.
3. Click the OK button.
   The selected resources appear in the lower pane.

Specifying Time Buckets
You can specify a new time bucket for the right and lower panes.

To specify a new time bucket for the right pane:
1. Right-click on the date in the upper right corner of the right pane.
2. Choose from the following intervals:
   - Quarters
   - Months
   - Weeks
   - Days
   - Hours
   - Thirty Minutes
   - Fifteen Minutes

These time intervals can be further broken down into smaller units of time in the lower pane.

*Figure 10–41 Time Buckets*

To specify a new time bucket for the lower pane:

1. Choose a time bucket from the drop down menu in the lower pane.
2. Choose from the following intervals:
   - No bucketing
   - Bucketing by hours
   - Bucketing by days

Rescheduling Operations

You can reschedule a job either by using the Reschedule window or by dragging and dropping the bar in the right pane.

To reschedule an operation using the Reschedule window:

1. In the left pane of the Gantt chart, right click on one of the nodes. The related activity appears in the right pane.
2. [Right-click] on the bar in the right pane. A list of tasks or options appears.
3. Select Reschedule The Reshedule window appears.
4. Select a new start or end date for the activity.

5. Click the OK button.

The activity’s new start or end date is reflected in the Gantt Chart. After moving an activity, you can firm it by the new start or end date, or by resource.

To change the duration of an activity:
1. Specify a new start or end date using the instructions above.
2. Select the Resize checkbox.
3. Click the OK button.

The activity’s new duration is reflected in the Gantt Chart. After changing an activity’s duration, you can firm it by the new start or end date, or by resource.

To reschedule an activity graphically:
1. Select the activity you wish to reschedule.
2. Drag the activity to a new date or time.
As you move the activity, a pop-up window shows the changing start and end date dynamically. The activity’s new start or end date is reflected in the Gantt Chart.

After moving an activity, you can firm it by the new start or end date, or by resource.

To resize an activity graphically:
1. Select the activity.
2. Drag the right end of the activity bar to a desired end date. After resizing, the activity can be firmed.

Firming an Operation

To firm an operation:
1. Place your cursor over the operation you wish to firm.
Interactive Scheduling Using the Gantt Chart

Figure 10–43  Firm Option

There are three ways to resolve overload of an operation. You can:

- Reschedule the operation to a time when sufficient resources are available.
- Select alternate resources for the operation.
- Add extra capacity to complete the operation with your current resources.

To reschedule an operation:

- Use the Reschedule window; or
- Drag and drop the operation in the Gantt Chart.

Note: When you move an operation, it is automatically firmed by start date. When you offload an operation, it is automatically firmed by resource.
To load an alternate resources:

1. Place your cursor over the operation you wish to offload.
2. Choose [right-click] > Offload to Alternate Resource.
3. Choose an Alternate resource.

A new resource is listed for the operation in the left pane. In the right pane, the operation’s shading changes to reflect that it is updated and firmed.

To add capacity:

Note: This functionality is available only in the resource-centric view.

1. Place your cursor over an operation on the resource for which you wish add capacity.

The Resource Availability Summary window appears.

Figure 10–44  The Resource Availability Summary window

3. Select a date for which you’d like to add capacity.
4. Click the Details button.

The Resource Availability window appears.

Figure 10–45 The Resource Availability window

5. Add capacity for a set duration for a particular shift.

6. Click the Apply button.

You can then run the online planner to see the results of adding capacity for this date. Your changes are also dynamically reflected in the Gantt Chart. Increased capacity is shown in the lower panel of this window.

When any changes are made in the Gantt chart, including offloading, adding capacity, rescheduling, or increasing time duration for an activity, these changes do not take effect until the Online Planner is run. Until then, the changes appear either in pink or pink with a green border in the Gantt chart window.
Gantt Chart Menu Options

The following table shows the menu options for the Gantt chart and what happens when a particular menu option is selected.

<table>
<thead>
<tr>
<th>Main Menu</th>
<th>Submenu</th>
<th>What happens when selected</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td>Save</td>
<td>Change is saved to the database.</td>
</tr>
<tr>
<td>File</td>
<td>Refresh</td>
<td>The change is rolled back and the Gantt Chart view is refreshed.</td>
</tr>
<tr>
<td>File</td>
<td>Find</td>
<td>A find window appears that you can use to fetch data.</td>
</tr>
<tr>
<td>File</td>
<td>Exit</td>
<td>Exits the Gantt Chart view. If you try to exit this Gantt Chart view or close this Gantt Chart window without saving the changes, a warning message appears asking you to choose one of the following: commit the changes, ignore the changes, or cancel the exit.</td>
</tr>
</tbody>
</table>

Saving Changes

After making changes to a plan in the Gantt Chart you can either save your changes or refresh. Saving changes commits them. Refreshing changes clears them.
Constraint-Based Planning

Topics covered in this section include the following:

- Overview of Constraint-Based Planning on page 11-2
- Constraint Types on page 11-2
- Enabling and Disabling Constraints on page 11-11
- Setting Constraints for Different Plan Types on page 11-14
- Rules Used in Constraint-Based Planning on page 11-16

A Day in the Life of a Planner

1. Generate Update forecasts, create new MRP
2. Perform set up, run data collection, set up supply chain
3. Set plan options and other planning parameters
4. Create material and capacity plan
5. Maintain relationships with customers and suppliers
6. Select orders and release to production
7. Run simulations to compare scenarios to baseline plan
8. Launch plan, evaluate plan performance, and respond to recommendations
Overview of Constraint-Based Planning

Constraint-based planning and scheduling is an approach for balancing material and plant resources while meeting customer demand. It takes into account constraints at the enterprise and plant levels. Material and capacity constraints are considered simultaneously. Capacity constraints include factory, distribution, and transportation resources and their respective availabilities. This complete picture of the problem provides instant and global visibility to the effects of planning and scheduling decisions throughout the supply chain.

Oracle ASCP supports two types of constraint-based planning: constraint-based planning without optimization and constraint-based planning with optimization. This section first describes constraint types that are applicable to both types, and then describes constraint-based planning without optimization. Constraint-based planning with optimization is described in Chapter 8, Optimization.

Constraint Types

You can define constraints for materials and resources in your plan. You will also be able to specify the level of importance of these constraints depending on your business needs and the planning horizon. You can generate plans using the following scenarios for each planning bucket type (days, weeks, periods):

- Plan considering material constraints only
- Plan considering resource constraints only
- Plan with respect to both material and resource constraints

See Chapter 5, "Defining Plans" for information on defining the relative importance of constraints.

The following table gives you the information you need to run a constraint-based plan:

<table>
<thead>
<tr>
<th>Constraint Type</th>
<th>Includes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Items</td>
<td>BOM effectivities (process effectivity), ECOs, alternate BOMs, substitute components, by-products, safety stocks, order modifiers, supplier-specific order modifiers, supplier-specific lead times, pegging restrictions</td>
</tr>
<tr>
<td>Manufacturing Resources</td>
<td>routing effectivities, alternate routings, alternate resources, resource capacities, line rates, workday calendar</td>
</tr>
<tr>
<td>Transportation Resources</td>
<td>carrier capacities, shipment and delivery calendars</td>
</tr>
</tbody>
</table>
Constraint Types

<table>
<thead>
<tr>
<th>Constraint Type</th>
<th>Includes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sourcing Constraints</td>
<td>sourcing effectivities, sourcing ranks, allocation percentages, supplier capacity</td>
</tr>
<tr>
<td>Suppliers</td>
<td>supplier capacity, supplier rank, supplier calendar, flex fences, supplier order modifier</td>
</tr>
<tr>
<td>Demands</td>
<td>sales orders/forecasts, demand priority, demand priority rules</td>
</tr>
</tbody>
</table>

Items

**Bills of Material**
You can set effective dates for BOMs. Similarly, you can set effective dates for process effectivity (this is for Oracle OPM only). You will also be able to specify effectivities in the form of effective dates, use ups, model/unit numbers. For more information, see “Effective Date Fields” in the *Oracle Bills of Materials User’s Guide*. For more information, see “Primary and Alternate Bills of Material” in the *Oracle Bills of Materials User’s Guide*.

*Note:* Effectivity can be set not only at the date level, but also at the unit number level.

**Engineering Changes (ECOs)**
Oracle ASCP evaluates the engineering change orders as of their scheduled effective date. You can order material and plan resources that you need for new revisions ahead of time.

*Note:* The planning process only suggests implementing engineering change orders when the unconstrained start date of the planned order is later than the effective date. Oracle ASCP does not suggest a planned order using an ECO if the planned order needs to start before the effective date of the ECO.

For a pending ECO, you can specify whether to include the engineering changes during the planning process. Set the MRP Active Flag to Yes in the Engineering Change Order window if you want the planning process to consider the engineering changes on the ECO.
Oracle ASCP considers engineering changes when generating component requirements for planned orders and suggested repetitive schedules. The quantity specified by an engineering change order is considered if the scheduled effective date of the ECO is before the suggested start date of the order. For example, if you have defined the following bill of material:

- Assembly A with a lead time of 2
- Component B with a usage of 2

You defined an engineering change order that changes the usage of B to 3. The ECO has a scheduled effective date of Day 4. As shown in the following table, if the material plan for Assembly A is:

<table>
<thead>
<tr>
<th>Demand or Supply</th>
<th>Day 2</th>
<th>Day 3</th>
<th>Day 4</th>
<th>Day 5</th>
<th>Day 6</th>
<th>Day 7</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gross Requirements</td>
<td>0</td>
<td>0</td>
<td>100</td>
<td>100</td>
<td>100</td>
<td>100</td>
</tr>
<tr>
<td>Planned Orders</td>
<td>0</td>
<td>0</td>
<td>100</td>
<td>100</td>
<td>100</td>
<td>100</td>
</tr>
</tbody>
</table>

The planned orders for Assembly A with due dates of Day 4 and Day 5 have start days of Day 2 and Day 3 respectively when offset by the lead time of 2 days. Since neither planned order has a start date that is on or after the scheduled effective date of the engineering change order, the component requirements are generated based on the current bill of material that specifies a usage of 2 Bs.

The planned orders for Assembly A with due dates of Day 6 and Day 7 have start dates of Day 4 and Day 5 respectively when offset by the lead time of 2 days. Since both planned orders have a start date that is on or after the scheduled effective date of the engineering change order, the component requirements are generated based on the revised usage of 3 Bs.

The material plan for component B is shown in the following table.

<table>
<thead>
<tr>
<th>Demand or Supply</th>
<th>Day 2</th>
<th>Day 3</th>
<th>Day 4</th>
<th>Day 5</th>
<th>Day 6</th>
<th>Day 7</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gross Requirements</td>
<td>200</td>
<td>200</td>
<td>300</td>
<td>300</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Planned Orders</td>
<td>200</td>
<td>200</td>
<td>300</td>
<td>300</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

Substitute Components

Substitute components are modeled similarly to alternate resources. Each primary BOM component is assumed to have a set of possible substitutes. The primary item will be used instead of the substitute when it is available.
For more information, see “Assigning Substitute Components” in the Oracle Bills of Material User’s Guide.

**By-products**
You can define negative usages for component items on a bill of material in Oracle Bills of Material. You can add by-products to discrete jobs using Oracle Work in Process.

Oracle ASCP includes by-products on standard and non-standard discrete jobs and components with a negative usage on a bill of material when netting supply and demand. Oracle ASCP considers this type of component requirement as supply available on the job completion date.

---

**Note:** You can manually add a negative requirement to a non-standard job in Oracle Work in Process to manage components that result in disassembly. You could use this option for repairing assembly units. It lets you track the item that is issued to the job as available supply on completion of the repair job.

---

**Product Families**
Product families improve plan performance, letting you plan further down the plan horizon. You can do the following at the product family level:

- specify demands
- run planning and scheduling
- create supplies

For more information, see Oracle Master Scheduling MRP and Oracle Supply Chain Planning User’s Guide.

**Safety Stock**
Safety stock is a quantity of stock you plan to remain in inventory to protect against fluctuations in demand or supply. Safety stock is sometimes referred to as overplanning, forecast, or a market hedge. In the context of master scheduling, safety stock refers to additional inventory planned as protection against forecast errors or short term changes in the backlog. You can specify safety stock days together with safety stock percent as item attributes in Oracle Inventory.
You can establish the default use of safety stock calculation when you define your planning parameters. You can override this option for individual material plans when you generate a MRP or MPS using the Launch window.

When launching the planning process, you can choose whether to calculate safety stock when generating suggested planned orders and repetitive schedules in the Plan Options window. If you choose to run the planning process with the safety stock option, Oracle ASCP looks at each item to determine the method of safety stock calculation. You can define safety stock methods for each item using Oracle Inventory.

For additional information, please see "Setting Plan Options" on page 5-18.

**MRP Planned Percent**  If you choose a safety stock method of MRP planned percent for an item, safety stock is dynamically calculated during the planning process. For discretely manufactured items, the safety stock quantity is dynamically calculated by multiplying the safety stock percentage you define by the average of gross requirements for a period of time defined by the safety stock days. For repetitively manufactured items, the planning process multiplies the percentage you define by the average daily demand for a given repetitive planning period.

The planning process recalculates the safety stock quantity for each repetitive period in the planning horizon.

**Inventory Methods**  Oracle Inventory provides several different methods for calculating safety stock.

The following methods are available within Oracle Inventory for calculating safety stock and are used during the planning process if your safety stock method is Non-MRP planned:

- Mean absolute deviation (MAD)
  
  Calculate safety stock using the mean absolute deviation (MAD). The formula is safety stock = Z * 1.25 * MAD, where Z is a function of the desired service level, which is a user input.

- User-defined percentage
  
  Calculate safety stock using the percentage you define times the average monthly demand.

- User-defined quantity
  
  Use a fixed safety stock quantity you define.
Safety stock quantities generated in Oracle Inventory according to effectivity dates are included in planning. Instead of manually changing the user-defined safety stock quantity each time a change is needed, you can now set effectivity dates for when a change in quantity takes place.

**Order Modifiers**

Order sizing is a set of item attributes that allow you to control the recommended order quantities for planned orders. The planning process creates planned orders using basic lot-for-lot sizing logic.

---

**Note:** The planning process ignores order modifiers for items that have a phantom supply type.

---

**Note:** Order modifiers for supplied items may be defined by their suppliers.

---

For additional information, please refer to Items, General Planning Attribute Group and MPS/MRP Planning Attribute Group in the *Oracle Inventory User's Guide*.

**Fixed Order Quantity**  The planning process places one or more orders for the user-defined quantity or repetitive rate.

- For discretely planned items, when the requirement for a given date exceeds the fixed order quantity, place multiple orders.
- For repetitively planned items, either recommend a rate equal to the fixed order quantity or a rate of zero.

**Fixed Lot Multiple**  The planning process places single orders in quantities that are multiples of the user-defined quantity or rate.

For example, when the fixed lot multiple quantity is 100 and the requirement equals 110 units, place a single order for 200 units.

**Minimum and Maximum Order Quantity**  The planning process places one or more orders for at least the minimum quantity, but no greater than the maximum quantity.

For discretely planned items, when the requirement for a given date exceeds the maximum order quantity, the planning process places multiple orders.
Constraint Types

**Fixed Days Supply**  The planning process places single orders for the quantity that covers the requirements for the user-defined number of days. When suggesting planned orders, the planning process looks forward this many days and accumulates all of the demand in that time period. It then suggests a planned order to satisfy the total quantity required for that time period.

**Rounding Order Quantities**  You can define, for each inventory item, whether the planning process should round order quantities when the actual order quantity is calculated as a fraction. If you choose to round, order quantities are rounded to the next highest whole number.

---

**Note:** By rounding up, the planning process may suggest a planned order for more than what is actually needed. This extra quantity is carried over into the next period as supply.

---

**Manufacturing Resources**

**Routings**

You can set effective dates for routings. If components and resources are not available to build from the primary routing, alternate routings or alternate resources may be used. You can define different routings with varying priorities. You can associate a BOM with routings. You can also define the cost of using a routing.

For more information, see “Routings” in the *Oracle Bills of Material User’s Guide*.

**Resources**

You can define alternate resources for an operation, but not for a routing. A resource for an operation can have different alternates, each with its own priority. You can specify if two resources must be used simultaneously.

For more information, see “Defining a Resource” in the *Oracle Bill of Materials User’s Guide*.

**Workday Calendar**

You define a workday calendar for one or more organizations, and assign an exception set to each calendar. For each workday calendar and exception set, you assign a list of holidays or workday exceptions. You then define shifts for your workday calendar, and assign any shift workday exceptions.
For more information, see “Defining a Workday Calendar” in the Oracle Bill of Materials User’s Guide.

Transportation Resources

Oracle APS considers Transportation and Storage Capacity constraints to plan accurately while providing a strong Available/Capable to Deliver (ATD/CTD).

You will be able to define transportation capacity for a lane of a ship method. In addition, you will be able to define aggregate capacity for an intransit/destination warehouse or a storage location.

Sourcing Constraints/Suppliers

You can specify the time-phased capacity of individual suppliers to specific items in Oracle Purchasing. You can allocate planned orders using the constraints of the suppliers—planned orders are assigned supplier sources in respect to their capacity. Planning uses the ranking information you specify and first attempts to source the planned orders with the primary sources. If the capacity to fulfill the demand is not available, alternative sources are used.

<table>
<thead>
<tr>
<th>Source</th>
<th>Rank</th>
<th>Percentage</th>
<th>Effective From</th>
<th>Effective To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supplier 1</td>
<td>1</td>
<td>40</td>
<td>05/15</td>
<td>12/31</td>
</tr>
<tr>
<td>Supplier 2</td>
<td>1</td>
<td>60</td>
<td>05/15</td>
<td>12/31</td>
</tr>
<tr>
<td>Supplier 3</td>
<td>2</td>
<td>100</td>
<td>05/15</td>
<td>12/31</td>
</tr>
</tbody>
</table>

Supplier capacity is specified in units per day over a designated time period. Supplier capacity accumulates if not used on a particular day. For example, if a supplier’s capacity is 100 units per day from 1/1/99 to 1/10/99 and no units are ordered from the supplier from 1/1/99 to 1/3/99, then planning considers a total of 1000 units to be available from 1/4/99 to 1/10/99. No capacity is assumed available on nonworking days based on the owning organization calendar.

Supplier capacity can vary by time period. You can specify one daily capacity for Period 1 and a different capacity for Period 2. Time periods are specified from a start date to an end date.

See Chapter 6, "Supply Chain Modeling" for more information about setting supplier capacity constraints.
Tolerance Fences
You can define capacity tolerance percentages that can vary for each of your items. The tolerance fence data in Oracle Purchasing is used to adjust production according to capacity changes for item/supplier combinations when the order is placed. Tolerance fence values can be specified for the capacity fluctuation allowed for available to promise; and used to determine demand based on the amount of advanced notice given to the supplier.

See "Supply Chain Modeling" for more information about setting tolerance fences.

Demands
You can specify priority rules by ordering demands. Scheduling is performed on a demand by demand basis.
Enabling and Disabling Constraints

To enable and disable constraints:
1. Navigate to the Planner Workbench.
2. Select a plan in the left pane of the Planner Workbench.
3. [Right-click]>Plan Options.
   The Plan Options window appears.
4. Select the Aggregation tab.

Figure 11–1  The Aggregation Tab in the Plan Options window

5. Using the drop-down menus, set Resource or Material Constraints to Yes or No based on your business requirements.

Note: To generate exception messages related to material resource capacity, you must select the Plan Capacity checkbox.
For more information on setting constraints prior to launching plans, see "Defining Plans."

6. Enter the time horizon in days, weeks, or periods.

You can specify different levels of aggregation in different time buckets so that detailed information is considered more frequently and less detailed information is considered less frequently.

**Note:** You cannot update the Start Date and End Date. The End Date is calculated based on your time bucket settings.

---

**Setting Hard and Soft Constraints**

Oracle ASCP lets you prioritize how you enforce Capacity Constraints or Demand Due Dates. Whichever constraint takes precedence over the other is the hard constraint; the other is the soft constraint. If you choose to enforce Demand Due Dates (setting Demand Due Dates as a hard constraint), then resources are used and possibly overloaded to satisfy demand due dates. In this case, Oracle ASCP returns overloaded exception messages.

If you choose to enforce Capacity Constraints (setting Capacity Constraints as a hard constraint), then resources are loaded to their limit to satisfy demand (if required). Unsatisfied demand are pushed to future. In this case, Oracle ASCP returns late replenishment exception messages.

**Note:** You must choose one and only one type of constraint.

---

**To set hard and soft constraints:**

1. [Right-click] Plan Options.

The Plan options window appears with the Options tab selected.
2. Check either the Enforce Demand Due Dates or the Enforce Capacity Constraints checkbox. The selected checkbox represents a hard constraint while the unselected checkbox represents a soft constraint.
### Setting Constraints for Different Plan Types

The following table describes the requirements for setting constraints for various types of plans:

<table>
<thead>
<tr>
<th>Plan Type</th>
<th>Options Tab</th>
<th>Aggregation Tab</th>
<th>Optimization Tab</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unconstrained</td>
<td>Enforce Demand Due Dates checkbox is checked.</td>
<td>Resource Constraint and Material Constraint fields are set to No.</td>
<td>Optimization checkbox is unchecked.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Plan Capacity checkbox is unchecked.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Plan capacity needs to be checked to calculate capacity even for unconstrained plans.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>But all the constraint fields are set to No to keep it unconstrained.</td>
<td></td>
</tr>
<tr>
<td>Material Constrained</td>
<td>Check either Enforce Demand Due Dates or Enforce Capacity Constraints checkbox.</td>
<td>Resource Constraint fields are set to No; Material Constraint fields are set to Yes.</td>
<td>Optimization checkbox is unchecked.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You can check only one checkbox.</td>
<td>Plan Capacity checkbox is checked.</td>
<td></td>
</tr>
<tr>
<td>Resource Constrained</td>
<td>Check either Enforce Demand Due Dates or Enforce Capacity Constraints checkbox.</td>
<td>Resource Constraint field set to Yes; Material Constraint fields are set to No.</td>
<td>Optimization checkbox is unchecked.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You can check only one checkbox.</td>
<td>Plan Capacity checkbox is checked.</td>
<td></td>
</tr>
<tr>
<td>Material and Resource Constrained</td>
<td>Check either Enforce Demand Due Dates or Enforce Capacity Constraints checkbox.</td>
<td>Resource Constraint and Material Constraint fields are set to Yes.</td>
<td>Optimization checkbox is unchecked.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You can check only one checkbox.</td>
<td>Plan Capacity checkbox is checked.</td>
<td></td>
</tr>
</tbody>
</table>
Setting Constraints for Different Plan Types

For additional information on setting constraints, please refer to Chapter 5, "Defining Plans" and Chapter 6, "Supply Chain Modeling."

<table>
<thead>
<tr>
<th>Plan Type</th>
<th>Options Tab</th>
<th>Aggregation Tab</th>
<th>Optimization Tab</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optimized</td>
<td>Depending on your hard and soft constraint requirements, check either Enforce Demand Due Dates or Enforce Capacity Constraints checkbox. <strong>Note:</strong> You can check only one checkbox.</td>
<td>Either or both Resource Constraint Material Constraint fields are set to Yes. Plan Capacity checkbox is checked.</td>
<td>Optimization checkbox is checked.</td>
</tr>
</tbody>
</table>
Rules Used in Constrained Plans Without Optimization

When running a constrained but not optimized plan, the following rules are used:

- Demand Priorities are respected

**Note:** When Demand Priorities are not specified, the default priorities of the various demand types are (in order): sales order, forecast, and safety stock.

- Alternate BOMs will not be considered
- Alternate routings will not be considered
- Substitute items will not be considered

Look-Ahead Heuristic

This product contains a new heuristic for scheduling in ASCP. You can now choose between using the existing or the new heuristic using the profile option [lookup]. The existing heuristic schedules are based on demand priority. Scheduling supplies based on the demand priority the supply is pegged to, can sometimes lead to work being scheduled in an undesirable way. You may find that lower priority demands are scheduled ahead of higher priority demand depending on the resource availability profile and the demand due dates.

With the new heuristic, you can schedule the supplies in a way that avoids working on lower priority demands ahead of higher priority demands. The way the schedules are generated depends on the number of demands being considered for scheduling at a time. You can specify the number of demands considered for scheduling at a time via a system level profile option: MSO:maximum demands per group.

The new look-ahead heuristic tries to predict some of the demands earlier than their actual due dates in order to accommodate the higher priority demands that are due later. By scheduling the demands with a higher priority earlier, the problem of having resources assigned to low priority demands before high priority demands come due is avoided.

You can evaluate the number of demands specified in the profile option. You can schedule the lowest priority demand on time and adjust the rest of the demands behind the lowest priority demand. This happens provided you have enough resources to schedule all the demands based on backward scheduling. If you do not
have enough resources to handle all the demands in the backward scheduling phase, you can forward schedule the demands starting with the highest priority demand.
Planning in Mixed Mode Environments

Topics covered in this section include the following:

- Overview of Mixed Mode Manufacturing on page 12-2
- Common Features in Hybrid Manufacturing Environments on page 12-2
- Oracle Project Manufacturing on page 12-11
- Oracle Flow Manufacturing on page 12-22
- Oracle Process Manufacturing on page 12-26
- Oracle Shop Floor Management on page 12-36
Overview of Mixed Mode Manufacturing

Oracle ASCP supports mixed mode manufacturing which lets you plan distribution and manufacturing operations for hybrid environments. You can plan for the full range of discrete, repetitive, process, project, and flow manufacturing environments. You can also plan to make to stock, make to order, assemble to order, and configure to order products simultaneously, using a single plan across all methods. This feature enables you to use the most efficient process to build each product.

Mixed mode manufacturing is supported by the following combination of Oracle Applications: Oracle BOM (for discrete manufacturing), Oracle Flow Manufacturing, Oracle Project Manufacturing, and Oracle Process Manufacturing. These serve primarily to provide process plan (routing) data to the Oracle ASCP engine. They also provide the user interfaces with which users of the different manufacturing modes view the output of the planning process.

---

**Note:** Repetitive manufacturing environments are supported in unconstrained planning, but not in constrained or optimized planning. For repetitive manufacturing environments that require constrained or optimized planning, it is recommended that you use flow schedules in Oracle Flow Manufacturing.

---

Common Features in Hybrid Manufacturing Environments

Oracle ASCP includes full support for by-products, co-products, lot expirations, and formula effectivities. For repetitive manufacturing, all features in Oracle Applications Release 10.7 and Release 11 are supported.

Phantom Routings

Phantoms are non-stocked assemblies that let you group together material needed to produce a subassembly. Oracle ASCP explodes requirements through a phantom subassembly to the components as if the components were directly tied to the parent assembly. No planned orders are generated for phantom assemblies. Routings for phantom items are used to generate resource requirements.

Phantom Routings are included for all phantom items in an organization based on the settings of the Organization level parameter use phantom routings in Oracle Bill of Material. An additional parameter inherit phantom operation sequence set at the inventory organization level in Oracle Bill of Material determines whether
components of phantom items will retain their operation sequence or inherit them from the parent.

**Note:** The combination of use phantom routings = Y and inherit phantom operation sequence = N is not supported.

The following table summarizes the different behavior of a phantom item and its components associated with settings of the two parameters, according to the example that follows.
Figure 12–1  Bill of Material Structure for Assembly A

Table 12–1

<table>
<thead>
<tr>
<th>Release</th>
<th>Use Phantom Routing</th>
<th>Inherit Phantom Op Seq</th>
<th>Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>10.7</td>
<td>Yes</td>
<td>Yes</td>
<td>Not supported</td>
</tr>
<tr>
<td>10.7</td>
<td>Yes</td>
<td>No</td>
<td>Not supported</td>
</tr>
<tr>
<td>Release</td>
<td>Use Phantom Routing</td>
<td>Inherit Phantom Op Seq</td>
<td>Behavior</td>
</tr>
<tr>
<td>---------</td>
<td>---------------------</td>
<td>------------------------</td>
<td>----------</td>
</tr>
<tr>
<td>10.7</td>
<td>No</td>
<td>Yes</td>
<td>Resource requirements generated for R1 and R2, but not R3 and R4. Due dates of Items E and F are calculated based on offset percentage of Op Seq 10.</td>
</tr>
<tr>
<td>10.7</td>
<td>No</td>
<td>No</td>
<td>Resource requirements generated for R1 and R2, but not R3 and R4. Due dates of Items E and F are calculated based on offset percentages of Op Seq 30 and 40, respectively.</td>
</tr>
<tr>
<td>11.0</td>
<td>Yes</td>
<td>Yes</td>
<td>Not supported</td>
</tr>
<tr>
<td>11.0</td>
<td>Yes</td>
<td>No</td>
<td>Not supported</td>
</tr>
<tr>
<td>11.0</td>
<td>No</td>
<td>Yes</td>
<td>Resource requirements generated for R1 and R2, but not R3 and R4. Due dates of Items E and F are calculated based on offset percentage of Op Seq 10.</td>
</tr>
<tr>
<td>11.0</td>
<td>No</td>
<td>No</td>
<td>Resource requirements generated for R1 and R2, but not R3 and R4. Due dates of Items E and F are calculated based on offset percentages of Op Seq 30 and 40, respectively.</td>
</tr>
<tr>
<td>11i</td>
<td>Yes</td>
<td>Yes</td>
<td>Resource requirements generated for R1, R2, R3 and R4. Due dates of Items E and F are calculated based on offset percentage of Op Seq 10.</td>
</tr>
<tr>
<td>11i</td>
<td>Yes</td>
<td>No</td>
<td>Not supported</td>
</tr>
<tr>
<td>11i</td>
<td>No</td>
<td>Yes</td>
<td>Resource requirements generated for R1 and R2, but not R3 and R4. Due dates of Items E and F are calculated based on offset percentage of Op Seq 10.</td>
</tr>
<tr>
<td>11i</td>
<td>No</td>
<td>No</td>
<td>Resource requirements generated for R1 and R2, but not R3 and R4. Due dates of Items E and F are calculated based on offset percentages of Op Seq 30 and 40, respectively.</td>
</tr>
</tbody>
</table>
Utilization Efficiency

Utilization and efficiency are incorporated into Capacity Planning with Oracle ASCP. Routings are used to generate capacity requirements for planned orders and suggested repetitive schedules by the memory-based planner. You can define utilization and efficiency on a department resource within Bills of Materials. For Flow Routings, the utilization and efficiency of individual resources used on a line in the Mixed Model Map definition are considered for determining the line rate. For repetitive schedules, it is assumed that the efficiency and utilization are factored into the user definition of line rate.

The range of values for utilization is 0.0 to 1.0. The range of values for efficiency is zero to infinity. The availability of department resources takes into account the utilization and efficiency of the resource. The net availability is calculated as follows:

Net availability = the number of hours the resource is available * utilization * efficiency.

(You can view utilization and efficiency in the Resources window in the Planner Workbench).

See also: Assigning Resources to a Department, Bills of Materials User’s Guide

Routing Effectivity

Routing Effectivity is incorporated into Capacity Planning with Oracle Planning Products.

Routings are used to generate capacity requirements for Planned Orders and Suggested Repetitive schedules by the planning engine. With the new functionality, resource requirements are generated using routings which are effective on the start date of the planned order or suggested repetitive schedule.

Each routing has an effective date and a disable date which indicates the date range for which the routing is effective. This is defined in Oracle Bills of Material. Routings are used to list the different resources which are required at each operation for an item.

See also: Creating a Routing, Oracle Bill of Material User’s Guide
Simultaneous, Aggregate, and Alternate Resources

The following new flexfields have been added in Oracle Applications to enter data for planning and scheduling. A sample implementation follows the flexfield definitions.

**Aggregate Resource for a Resource** This is defined in the Department Resources Form. It is based on the existing flexfield Aggregate Resource Id.

**Simultaneous Resource Sequence** This is defined via a flexfield in the Operation Resources Form.

**Alternate Resource for an operation** This is defined via a flexfield in the Operation Resources Form.

**Priority of Alternate Resources for an operation** This is defined via a flexfield in the Operation Resources Form.

**Priority for Substitute Items** This is defined in the Substitute Components Form.

**Cost of using Alternate BOM / Routing** This is defined via a flexfield in the Bills of Material Form.

---

**Note:** If your source is later than 11.5.3, the first four flexfields have been converted to regular fields and the names given are different. Please refer to *Oracle Bill of Materials User’s Guide* and Chapter 6, Supply Chain Modeling.

---

**Example**

**Note:** The following example assumes that your are either using 10.7 or 11.0 Oracle Applications.

- Assumption: Primary resource has a priority of 0
- Principal Flag: 1 - Yes (primary resource); 2 - No (alternate resource)
In the following table, Resources R1 and R2 are primary resources, and Resource R3 is an alternate for R1.

**Table 12–2  Scenario 1:**

<table>
<thead>
<tr>
<th>Operation Sequence</th>
<th>Resource Sequence</th>
<th>Resource</th>
<th>Flexfield</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>10</td>
<td>R1</td>
<td>Resource step number</td>
<td>10</td>
</tr>
<tr>
<td>10</td>
<td>10</td>
<td>R1</td>
<td>Priority/Group</td>
<td>0</td>
</tr>
<tr>
<td>10</td>
<td>10</td>
<td>R1</td>
<td>Principal Flag</td>
<td>1 (Yes)</td>
</tr>
<tr>
<td>10</td>
<td>20</td>
<td>R2</td>
<td>Resource step number</td>
<td>20</td>
</tr>
<tr>
<td>10</td>
<td>20</td>
<td>R2</td>
<td>Priority/Group</td>
<td>0</td>
</tr>
<tr>
<td>10</td>
<td>20</td>
<td>R2</td>
<td>Principal Flag</td>
<td>1 (Yes)</td>
</tr>
<tr>
<td>10</td>
<td>30</td>
<td>R3</td>
<td>Resource step number</td>
<td>10</td>
</tr>
<tr>
<td>10</td>
<td>30</td>
<td>R3</td>
<td>Priority/Group</td>
<td>1 (Yes)</td>
</tr>
<tr>
<td>10</td>
<td>30</td>
<td>R3</td>
<td>Principal Flag</td>
<td>1 (Yes)</td>
</tr>
</tbody>
</table>

In the following table, R1 and R2 are simultaneous, R3 and R4 are simultaneous, and (R3, R4) is an alternate for (R1, R2).

**Table 12–3  Scenario 2:**

<table>
<thead>
<tr>
<th>Operation Sequence</th>
<th>Resource Sequence</th>
<th>Resource</th>
<th>Flexfield</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>10</td>
<td>R1</td>
<td>Resource step number</td>
<td>10</td>
</tr>
<tr>
<td>10</td>
<td>10</td>
<td>R1</td>
<td>Priority/Group</td>
<td>0</td>
</tr>
<tr>
<td>10</td>
<td>10</td>
<td>R1</td>
<td>Principal Flag</td>
<td>1 (Yes)</td>
</tr>
<tr>
<td>10</td>
<td>20</td>
<td>R2</td>
<td>Resource step number</td>
<td>10</td>
</tr>
<tr>
<td>10</td>
<td>20</td>
<td>R2</td>
<td>Priority/Group</td>
<td>0</td>
</tr>
<tr>
<td>10</td>
<td>20</td>
<td>R2</td>
<td>Principal Flag</td>
<td>2 (No)</td>
</tr>
</tbody>
</table>
Table 12–3  Scenario 2:

<table>
<thead>
<tr>
<th>Operation Sequence</th>
<th>Resource Sequence</th>
<th>Resource</th>
<th>Flexfield</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>30</td>
<td>R3</td>
<td>Resource step number</td>
<td>10</td>
</tr>
<tr>
<td>10</td>
<td>30</td>
<td>R3</td>
<td>Priority/Group</td>
<td>1 (Yes)</td>
</tr>
<tr>
<td>10</td>
<td>30</td>
<td>R3</td>
<td>Principal Flag</td>
<td>1 (Yes)</td>
</tr>
<tr>
<td>10</td>
<td>40</td>
<td>R4</td>
<td>Resource step number</td>
<td>10</td>
</tr>
<tr>
<td>10</td>
<td>40</td>
<td>R4</td>
<td>Priority/Group</td>
<td>1 (Yes)</td>
</tr>
<tr>
<td>10</td>
<td>40</td>
<td>R4</td>
<td>Principal Flag</td>
<td>2 (No)</td>
</tr>
</tbody>
</table>

In the following table, R1 and R2 are simultaneous, R3 is sequential, and R4 is an alternate for R2.

Table 12–4  Scenario 3

<table>
<thead>
<tr>
<th>Operation Sequence</th>
<th>Resource Sequence</th>
<th>Resource</th>
<th>Flexfield</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>10</td>
<td>R1</td>
<td>Resource step number</td>
<td>10</td>
</tr>
<tr>
<td>10</td>
<td>10</td>
<td>R1</td>
<td>Priority/Group</td>
<td>0</td>
</tr>
<tr>
<td>10</td>
<td>10</td>
<td>R1</td>
<td>Principal Flag</td>
<td>1 (Yes)</td>
</tr>
<tr>
<td>10</td>
<td>20</td>
<td>R2</td>
<td>Resource step number</td>
<td>10</td>
</tr>
<tr>
<td>10</td>
<td>20</td>
<td>R2</td>
<td>Priority/Group</td>
<td>0</td>
</tr>
<tr>
<td>10</td>
<td>20</td>
<td>R2</td>
<td>Principal Flag</td>
<td>2 (No)</td>
</tr>
<tr>
<td>10</td>
<td>30</td>
<td>R3</td>
<td>Resource step number</td>
<td>30</td>
</tr>
<tr>
<td>10</td>
<td>30</td>
<td>R3</td>
<td>Priority/Group</td>
<td>0</td>
</tr>
<tr>
<td>10</td>
<td>30</td>
<td>R3</td>
<td>Principal Flag</td>
<td>2 (No)</td>
</tr>
<tr>
<td>10</td>
<td>40</td>
<td>R1</td>
<td>Resource step number</td>
<td>10</td>
</tr>
<tr>
<td>10</td>
<td>40</td>
<td>R1</td>
<td>Priority/Group</td>
<td>1 (Yes)</td>
</tr>
<tr>
<td>10</td>
<td>40</td>
<td>R1</td>
<td>Principal Flag</td>
<td>1 (Yes)</td>
</tr>
<tr>
<td>10</td>
<td>50</td>
<td>R4</td>
<td>Resource step number</td>
<td>10</td>
</tr>
<tr>
<td>10</td>
<td>50</td>
<td>R4</td>
<td>Priority/Group</td>
<td>1 (Yes)</td>
</tr>
<tr>
<td>10</td>
<td>50</td>
<td>R4</td>
<td>Principal Flag</td>
<td>2 (No)</td>
</tr>
</tbody>
</table>
If Resource step number is NULL, the value defaults to Resource sequence. If priority is NULL, the value defaults to the primary priority.

If your source is 11i, the following tables show you the set up required to model alternate and simultaneous resources.

In the following table, Resources R1 and R2 are primary resources, and Resource R3 is an alternate for R1.

**Table 12–5 Scenario 4**

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>10</td>
<td>R1</td>
<td>10</td>
<td>Checked</td>
<td>R3</td>
<td>1</td>
<td>Checked</td>
</tr>
<tr>
<td>10</td>
<td>20</td>
<td>R2</td>
<td>20</td>
<td>Checked</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
</tr>
</tbody>
</table>

In the following table, Resources R1 and R2 are simultaneous, R3 and R4 are simultaneous, and (R3,R4) is an alternate for (R1,R2).

**Table 12–6 Scenario 5:**

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>10</td>
<td>R1</td>
<td>10</td>
<td>Checked</td>
<td>R3</td>
<td>1</td>
<td>Checked</td>
</tr>
<tr>
<td>10</td>
<td>10</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>R4</td>
<td>1</td>
<td>Unchecked</td>
</tr>
<tr>
<td>10</td>
<td>20</td>
<td>R2</td>
<td>10</td>
<td>Unchecked</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
</tr>
</tbody>
</table>

In the following table, Resources R1 and R2 are simultaneous, R3 is sequential, and R4 is an alternate for R2.

**Table 12–7 Scenario 6:**

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>10</td>
<td>R1</td>
<td>10</td>
<td>Checked</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>10</td>
<td>20</td>
<td>R2</td>
<td>10</td>
<td>Unchecked</td>
<td>R4</td>
<td>1</td>
<td>Checked</td>
</tr>
<tr>
<td>10</td>
<td>30</td>
<td>R3</td>
<td>20</td>
<td>Checked</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
</tr>
</tbody>
</table>
Oracle Project Manufacturing

Oracle Project Manufacturing is designed to support companies that manufacture products for projects or contracts. It provides robust project tracking, billing, and budgeting. You can plan in a project or contract environment by segmenting all sources of supply and demand by project. This allows the planning process to identify components as shared or project specific, track existing inventories by project, and provide visibility to all supply and demand associated with the project.

Oracle Project Manufacturing also supports Seiban production. Seiban is a Japanese management practice. The word sei means production, and the word ban means number, thus implying a production number. A manufacturing plan is therefore managed by a Seiban number. All demand and supply for the manufacturing plan is associated with the Seiban number (via its project number).

Oracle Project Manufacturing is also designed for engineer-to-order (ETO) environment and an assemble-to-order environment. This enables a manufacturer to track supply and demand with a particular product, project, or customer.

Oracle ASCP supports Oracle Project Manufacturing through Project Planning. With Project Planning you can:

- Include project or project-task or Seiban numbers in forecast, MPS, and MDS entries.
- Load, copy or merge forecast, MPS, and MDS entries with project or project-task or Seiban numbers.
- Recognize and allocate supply according to project or project-task or Seiban numbers.
- Combine project or project-task and Seiban related supply and demand with common supply and demand in the same plan or schedule.
- Perform netting by planning groups, project or Seiban, and tasks
- Generate planned orders with project or Seiban, and task references
- Execute a plan in the Planner Workbench by planning group, project or project-task, and Seiban.
- Perform net change simulation in a project environment.
- Generate planned orders with project or project-task or Seiban.
- Implement planning suggestions by planning group, project or project-tasks, or Seiban numbers.
Oracle Project Manufacturing is integrated with Oracle ASCP. Oracle ASCP supports constraint-based supply chain planning and optimization with online simulations for Engineer-to-Order (ETO) manufacturing typical in the Aerospace and Defense Industry. It features the following:

**Hard and Soft Pegging**

The hard and soft pegging feature is fully supported by Oracle ASCP. An item’s attribute can be set to any of the following pegging levels which are elaborated below:

**Soft Pegging**

The planning process allocates supply at the project or project-task level (or Seiban) to demand at the project or project-task level (or Seiban) according to the reservation level set in the plan level options.

All reservations of supply to demand records is for a single item. Common, nonproject supply is used to satisfy project demand. For a soft pegged demand, excess project supply (or common supply) is always available for another project’s demand.

No project references are made to planned orders issued to soft pegged items.

(Choose the End Assembly/Soft Pegging option for both soft pegging and end assembly pegging. End assembly pegging traces the end assembly to which the item is pegged at the top of the bill of material.)

**Hard Pegging**

In this option, the planning process allocates supply at the project or project task level (or Seiban) to demand at the project or project task level (or Seiban), according to the reservation level set in the plan level options. Excess common supply from one project can only be shared among projects in the same planning group, if reservation level is set at planning group.

Project references are attached to planned orders for hard pegged items.

(Choose the End Assembly/Hard Pegging option for both hard pegging and end assembly pegging.)
Common Supply Netting
The new netting logic for Project Planning also takes into account excess common supply for project demand for hard pegged items. This netting logic is available only if the reservation level option for the plan is set to Planning Group.

For the above, you can generate a graphical pegging display. If none is used for pegging, project material allocation, end assembly pegging, and graphics are disabled.

Supply Chain Project Planning with Hard Pegging
In situations where projects are executed across multiple organizations, Oracle ASCP provides you with the same useful features for managing demand and supply across multiple organizations in the supply chain.

It uses similar logic as Project Manufacturing planning to plan projects in multiple organizations and ensures that the project information is permeated to all organizations in the Supply Chain. Supply for a project belonging to multiple organizations can be netted against the demand for the same project in a single planning run.

Project Supply Chain Planning provides you with a visibility across the entire supply chain. You can use the same features to obtain project specific information from the Planner Workbench.

**Note:** The project control level for all project manufacturing organizations must be the same for all organizations in the supply chain project planning scenario.

Group Netting
The netting logic can include a group of projects. Excess supply in one project can be reserved against demand for another project belonging to the same planning group. For this, set the reservation level to planning group. If reservation level is set to project then it is not group netting.

Borrow Payback
Two order types have been created in Project Planning to distinguish demand and supply resulting from a borrow/payback transaction in Project Manufacturing:

- Payback Demand
Payback Supply
You can search for borrow/payback demand/supply using these order types. You can also see these order types on the Planner Workbench.

Planner Workbench
You can view payback demand created in the borrowing project and payback supply created in the lending project for an Item in the horizontal material plan and the Supply/Demand window in the Planner Workbench.

A scheduled payback transaction is considered as a new type of supply called payback supply for the lending project and a new type of demand called payback demand for the borrowing project. The scheduled payback date is used as the supply and demand date.

In the Preferences window, you can choose to display the payback demand and payback supply for the horizontal material plan.
The supply/demand picture can be viewed. No changes are allowed here, for example rescheduling or changing the quantity.

In the enterprise view, the payback supply is in a separate column. Payback demand is included in the other independent demand column. Payback supply is included in total supply. Payback demand is included in gross requirements. In addition, payback supply is included in current schedule receipts.

**Pegging**
You can view the borrow and payback relationships in the pegging window.

Please see the *Oracle Project Manufacturing Implementation Manual* for more information on Borrow/Payback in Project MRP.
Model/Unit Effectivity (Serial Effectivity)

Oracle ASCP supports Model/Unit Effectivity.

**Items**

Items can be set for effectivity control method. The full pegging attribute for the item must not be set to no pegging if the item is under model effectivity control. It must be set to soft pegging or hard pegging.

**Define MDS/MPS Entries by Unit Numbers**

You can enter schedule entries by Model Unit Number. The unit number that you enter is validated against the master list of unit numbers that are eligible for that end item. If the item on the entry is a orderable subassembly, used in the bills of other end items, the entry can be associated with the unit numbers of its end item.

**Unit Numbers in Sales Orders**

You can load sales orders into a MDS, and have the unit number specified against the sales order.

**Effectivity in the BOM**

You can snapshot bills for items under unit effectivity in addition to those under date effectivity. The Engineering Changes Information snapshot as a part of the BOM can have the component effectivity specific to an end item unit number or a range of item unit numbers.

The snapshot tasks include end item unit number for different supply and demand entities used in the planner.

**Generating Planned Orders**

You can net all supply for a End Item Unit number to the demand for the end item. Oracle ASCP generates planned orders with Unit Number specified on them. Demand for components can be created with model/unit number effectivity in addition to components with date effectivity. Oracle ASCP does not generate suggested repetitive schedules with Unit Number specified on them.

**Planner Workbench**

You can view the unit numbers of all items under unit number effectivity in the demand, supply, items, end assemblies. In the Find window you can specify the unit numbers while viewing items, supply/demand or exceptions. You can enter
unit number information for new planned orders and MDS entries in the Planner Workbench. However, you cannot modify existing unit numbers tied to planned orders/MDS records from the Planner Workbench.

**Figure 12–3  Supply/Demand for Unit Effective Items**
Pegging
You can view the unit number information in the pegging views.

WIP Mass Load/ PO Requisitions Interface
When you implement Planned Orders in the Planner Workbench, you can pass on the unit number information to WIP and PO.

Flow Line Scheduling
You can view the unit numbers of all unscheduled orders under unit number effectivity in the Line Scheduling Workbench Unscheduled Orders window (Oracle Flow Manufacturing Workbench). When you create new schedules based on an unscheduled order unit number effectivity, the resulting flow schedule contains the unit number reference.

You can create new flow schedules under unit number effectivity and view the numbers for existing schedules in the Line Scheduling Workbench Detail window. You can create and update flow schedules under unit number effectivity using the API.

Workflow Based Project Exception Messages
Along with the other Exception Messages, Project Planning provides the following project related exception messages that can help monitor project material plans. Like other exception messages, these exception messages are also workflow enabled for better supply chain coordination. The Project Manager or Task Manager (if defined) are also be notified of these plan exceptions.

- Items with Excess inventory in a project-task: This exception message enlists all items with excess inventory in a project or project-task. This exception occurs when the projected on-hand quantity of the item in a project or project-task exceeds zero or safety stock by more than the value you entered in Excess Quantity in the exception set for the item.

- Items with Shortage in a project-task: This exception message highlights the items whose demand exceeds supply for that project or project-task. For items with a shortage in a project-task, an exception message is generated when the projected on hand quantity for an item in a project is negative or below the safety stock.

- Items allocated across project-task: This exception message indicates items where supply for one project or project-task is used to satisfy demand for another project or project-task.
Project Planning Implementation Steps

The steps to set up, run and view a plan in a project environment are as follows.

Oracle Project Manufacturing Setup

1. Define projects and tasks directly in Oracle Project Manufacturing, manually using Entry Project, or using the Project Manufacturing Seiban Number Wizard, or define Seiban numbers in Project Manufacturing using the Seiban Number Wizard.
2. Define planning group Quick Code.
3. Associate a project/Seiban to a planning group (in the project parameters form)

Refer to the Oracle Project Manufacturing User’s Guide for detailed setup instructions.

Oracle Inventory Setup

Define item pegging attributes. The following item pegging attributes can be used:

- Soft pegging, or End Assembly/Soft Pegging: In this case excess project or common supply is available to satisfy project demand of any project irrespective of plan options chosen. Planned orders do not carry project and task references.

- Hard Pegging, or End Assembly/Hard Pegging: In this case excess supply in one project can be used for demand of a different project in the same planning group if reservation is set to planning group. Excess common supply is also available for project demand only if the reservation level is planning group. Planned orders carry project and task references as defined by the hard pegging level plan option.

- None: Disables project material allocation. Also, planned orders do not carry any project or task reference irrespective of the hard pegging level plan option.

Refer to Oracle Inventory User’s Guide for detailed setup instructions.
Oracle ASCP Setup

1. Define Plan Options by choosing Tools > Pegging.

   The Pegging window appears.

2. Complete the following options in the Pegging window.

   **Table 12–8**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reservation Level</td>
<td>This option determines the method of pre-allocation of project supply to project demand. You can choose to reserve based on:</td>
</tr>
<tr>
<td></td>
<td>- Planning Group</td>
</tr>
<tr>
<td></td>
<td>In this case the plan reserves project-specific supply at the planning group level. Excess supply in one project can be reserved against demand for another project belonging to the same planning group. Excess common supply is also allocated to project demand.</td>
</tr>
<tr>
<td></td>
<td>- Project</td>
</tr>
<tr>
<td></td>
<td>In this case, project specific supply is used for demand specific to that project only. This allows cross-allocation across tasks within the same project.</td>
</tr>
<tr>
<td></td>
<td>- Task</td>
</tr>
<tr>
<td></td>
<td>This reserves supply for a project-task against demand for the same project-task only. No cross-allocation of material belonging to the same project but different tasks is allowed.</td>
</tr>
<tr>
<td></td>
<td>- None</td>
</tr>
<tr>
<td></td>
<td>This is a nonproject plan.</td>
</tr>
<tr>
<td>Hard pegging level</td>
<td>This option determines if the project or project-task references will be added to planned orders. This is applicable to hard pegged items only for which the pegging attribute must be hard pegging or End Assembly/Hard Pegging. For soft pegged items, no project references are associated. These work independent of the reservation level options.</td>
</tr>
</tbody>
</table>
3. Launch a plan

Refer to Defining Plans (see Chapter 5) for more information on defining plan options and launching plans.

Project Planning Logic

Refer to the Oracle Project Manufacturing Implementation Manual for Project planning logic. Netting Logic with examples of hard pegging with common supply netting and the pegging logic is explained here.

Note: Order modifiers are applied before project netting calculations.
Viewing the Plan

The plan can be viewed from the Planner Workbench. You can view planning information by project and implement manufacturing plans in the workbench by project.

Use the Supply, Demand or Supply/Demand window of the Planner Workbench to view information about the plan’s supply and demand. Planning Group, Project Number and/or Task Number may be used as the search criteria.

You could also use customizable folders in the Supply, Demand or Supply/Demand screens to query planning information for a particular project or project-task.

The Horizontal Plan and Enterprise View windows enable you to view supply and demand information by Planning Group, Project, and Project-Task. You can also choose to see the planning status of all the material or only common material in these forms.

The Planner Workbench also generates Reschedule In, Reschedule Out and Cancel action messages for project supply. It follows the current Planning Time Fence and Acceptable Days Early logic to generate these messages.

Oracle Flow Manufacturing

Oracle Flow Manufacturing is a demand driven production system with balanced production lines and processes designed to produce a constantly changing mix of products at a steady rate. Flow manufacturing uses schedules for mixed model production instead of work orders to drive production. The mixed model schedules are sequenced based on scheduling rules and material is replenished, or pulled through the sequence, using kanbans.

This is in contrast to a traditional discrete environment where the Master Production Schedule and MRP are used to explode requirements and create planned orders that are converted into purchase orders and work orders. There are some cases in which Oracle ASCP may be used effectively. For example - you have a seasonal business, and you use Oracle ASCP to create planned orders during your slow period to build up inventory to satisfy your peaks in demand. In these cases, planned orders may be converted into flow schedules.

When there is a hybrid of manufacturing methods, for example if a flow manufacturing system feeds to a discrete manufacturing plant, Oracle ASCP may be used effectively, because Oracle ASCP can consider a flow schedule as a supply.
Oracle ASCP continues to support features in Oracle Flow Applications Release 11.0.

**Supply Chain Synchronization**

Oracle ASCP can improve supply-chain throughput and reduce inventories by improving synchronization of operations between facilities. In turn, Oracle Flow Manufacturing increases manufacturing plant throughput by dramatically decreasing manufacturing times and removing in-process and finished goods inventory.

**Support for Flow Schedules**

If you specify line capacity, Oracle ASCP can constrain by that capacity to create plans. If demand is more than what can be manufactured, then Oracle ASCP creates a plan considering the constraints. These planned orders may be converted into flow schedules.

---

**Note:** You need to run the Push Plan Information concurrent program to see planned orders as valid inputs for flow schedules.

Oracle ASCP includes flow schedules to be considered as supplies.

The processes to define, implement, and maintain Oracle Flow Manufacturing are:

- Demand Management
- Line Design & Balancing
- Line Scheduling & Sequencing
- Production Execution
- Kanban Planning and Execution

Planning plays an important part in the design phase of an Oracle Flow Manufacturing implementation. The forecast, MDS, and/or MPS that are established are only used for planning purposes for line design and kanban sizing as described below. External to the enterprise, the forecasts are communicated with suppliers so that they may, in turn, plan their operations.
Demand Management

Oracle Flow Manufacturing forecast tools, Master Demand Schedules, and Master Production Schedules with Oracle ASCP are used for managing demand. Similar products are grouped into families to allow for planning at an aggregate level. The creation of forecasts, MDS/MPS are used for line design and kanban planning. If you are not building directly to customer demand, Oracle Flow Manufacturing can create schedules from the planned orders generated by the above tools.

The following planning capabilities need to be set up: Forecasting & Master Demand Schedules. Oracle Flow Manufacturing uses the Demand Management tools provided in Oracle MPS/MRP or Oracle ASCP to plan production volumes.

See also: Demand Management, Oracle Flow Manufacturing Implementation Manual

Line Design and Balancing

Line Design includes grouping products into product families, defining the processes, and events required to produce each product, and re-grouping events into line operations to approximate TAKT time (German for target cycle time). The statement of demand established in Demand Management, whether it is from a forecast, MDS, or MPS, is critical to the line design function. The demand sets the upper limit of production capacity and becomes the basis for balancing procedures.


Kanban Planning and Execution

Generally the same forecast, MDS, or MPS that is used to design a mixed model production line is also used for kanban planning. The derived demand of components is used to establish size requirements. Oracle ASCP uses the snapshot of inventory for on-hand quantity and safety stock.

Product Families

Flow uses product families to plan at an aggregate level. Oracle ASCP supports product family items. You can define different planning horizons for product families or item level. Resources can be planned at the product family level.

Oracle Process Manufacturing

The Oracle Process Manufacturing (OPM) user is fully integrated with Oracle ASCP and can plan based on plan objectives and use the materials and resources optimally. There is no need to execute OPM P/MRP.

Oracle ASCP provides an integrated plan for multiple modes of process manufacturing including batch, continuous, and packaging operations. It incorporates a formula-based, process unique requirements including co-products, and scaling.

The data used to plan materials and capacity exists in the OPM schema. This data is used by the Oracle ASCP Planning Server. Oracle ASCP uses Inventory, Production, Formula, Planning, and Sales data from OPM and purchasing data from Oracle Applications. The user can run multiple plans and manage materials and resources. Once satisfied with the plan, it can be executed in the Production Module.

The following changes have been made to the existing methodology:

- No need to execute OPM P/MRP
- Outside vendor for finite scheduling no longer needed
- All Planning Activities can be on a Separate Server
- Plans are no longer restricted to material planning
- OPM structure mimics Apps Organization Structure

OPM Data for Oracle ASCP

Merged Organization Structure

The OPM structure merges with the Oracle Applications structure, as shown.
OPM production batches and planning functions occur at the plant level. These are merged to production and planning data at the inventory organization level.

OPM demand is placed at the warehouse level and planning can occur at this level as well. These are merged to the inventory organization level.

OPM on-hand balances are stored at the warehouse or location level. Stock allocation and nettability takes place at the warehouse level. These are merged to the sub-inventory level of Oracle Applications.

The above data and transactions can also occur at the location level in OPM. The corresponding level in Oracle Applications is the locator level, but Oracle ASCP plans at the subinventory level. All OPM location data therefore must be merged into the warehouse and mapped at the sub-inventory level.

**Differences Between Production in OPM and Oracle Applications**

In Oracle Applications, at the Inventory Organization level, site locations are used for vendors and customers, and departments are used to control resources. In OPM, the resources are defined at the plant level.
A work order (a WIP job, in Oracle Applications) is roughly equal to a production batch in OPM. Both work orders and production batches consume resources. In Oracle Applications, a work order (created at the inventory organization level) can only draw from resources available in the inventory organization for which the work order was created. In OPM, a batch may only access resources for the plant.

Plant warehouse effectivities in OPM allow a production batch to draw from materials available outside the plant (WIP Warehouse) in which the production batch was created. OPM also lets you specify the warehouses from which to pull inventory to complete a production batch. You can define multiple allocation parameters for an item. This allows you to allocate inventory from multiple warehouses.

In Oracle ASCP, the ingredients for a batch must come from a single warehouse. OPM works around this issue by using the work-in-process warehouse or the resource warehouse, if available, as the single source of ingredient inventory when the batch has multiple sources or destinations. The work-in-process warehouse or the resource warehouse shows Oracle ASCP from where to allocate inventory.

**Recommended OPM Organization Structure for Oracle ASCP**

The following OPM organization structure is recommended in order for OPM data to smoothly merge with Oracle ASCP. Navigation paths are included:

- Each OPM production plant has only one associated warehouse called the Resource Warehouse. Production is assumed to take place in that warehouse. (For additional details, see Organizations Field Reference in the OPM System Administration User’s Guide. The navigation path to the screen in the OPM application is OPM > System Administration > Organizations > Resource Warehouse Field)

- There can be only one warehouse per plant. (For additional details, see Organizations Field Reference in the OPM System Administration User’s Guide. The navigation path to the screen in the OPM application is OPM > System Administration > Organizations > Resource Warehouse Field)

- Multiple production plants can draw raw material inventory from common warehouses to meet their production demand. (For additional details see Setting Up Plant Warehouse Relationships in the Oracle Process Manufacturing MPS/MRP and Forecasting User’s Guide. The navigation path to the screen in the OPM application is OPM > Planning > MPS > Setup > Plant Warehouse)

- Multiple production plants can supply common warehouses (distribution center). (For additional details see Setting Up Plant Warehouse Relationships in the Oracle Process Manufacturing MPS/MRP and Forecasting User’s Guide. The
navigation path to the screen in the OPM application is OPM > Planning > MPS > Setup > Plant Warehouse)

- Each OPM warehouse must have a corresponding inventory organization in Oracle Applications. (For additional details, see Organizations Field Reference in the OPM System Administration User’s Guide. The navigation path to the screen in the OPM application is OPM > System Administration > HR Organizations)

- If multiple production plants use the same warehouse as their raw material inventory source, then the production for these plants should be planned together.

**Merging Effectivities, Formulas, and Routings**

Oracle ASCP expects organization-specific formulas and routings.

Oracle ASCP includes the following OPM functionality:

- Effectivities
- Scaling
- One-level circular references

One-level circular references allow the definition of formulas that have a product or by-product listed as an ingredient in the same formula. For example, when making sourdough bread, you save a small portion of the dough to use as a starter for the next batch. Therefore, when defining a sourdough bread formula, the dough is a product, but it is also an ingredient.

**Creating a Resource Warehouse**

In Oracle ASCP, capacity planning occurs at the inventory organization, department, or resource level. OPM needs to perform capacity planning at the plant level. To bridge this gap between OPM and Oracle ASCP, one warehouse is defined for each production plant that requires capacity planning. These warehouses are called Resource Warehouses. Oracle ASCP recognizes Resource Warehouses as production facilities that require capacity planning.

**To create a resource warehouse:**

Use the following navigation path in the OPM application:
1. OPM > Planning > MPS > Setup > Plant Warehouse. For additional details, please refer to Setting Up Plant Warehouse Relationships in the Oracle Process Manufacturing MPS/MRP and Forecasting User’s Guide.

2. OPM > System Administration > Organizations. For additional details, please refer to Organizations in the OPM System Administration User’s Guide.

**Unit of Measure**

You can define item units of measure in OPM that are four characters long, but the value will be truncated to three characters once the unit of measure is copied into Oracle Applications. You can automatically convert UOMs from OPM to Applications.

This also applies for OPM organizations where OPM allows four characters and Applications allows three characters.

(For additional information, please refer to Editing Units of Measure in OPM System Administration User’s Guide. The navigation path to the screen in the OPM application is OPM > System Administration > Units of Measure).

**Setting Up and Using OPM Data**

The OPM data that must be set up are:

- OPM organizations & warehouses
- OPM items, Unit of Measure, and conversions
- Effectivities, formulas and routings
- Resources
- MPS Schedules for Oracle ASCP
- Plant warehouse effectivities
- Batches, FPOs, sales orders, forecasts, and on-hand inventory

For detailed instructions on setting up OPM data refer to the Oracle Process Manufacturing User’s Guide.

Besides the points stated in the previous section, some of the other areas which link to Oracle ASCP are described below.

**OPM Organizations**

If you plan to use the capacity planning function in Oracle ASCP, each OPM production plant must own one resource warehouse.
Effectivity, Formulas and Routings

Effectivity  OPM uses global effectivities by organization, as opposed to effectivities for a specific plant or resource warehouse. An organization’s effectivities then apply to all plants and warehouses associated with that organization.

The following effectivity functions can be used with Oracle ASCP: min and max quantities, start and end effective dates, formula and routing assignments, and preferences.

(For additional information, please refer to Setting Up Effectivities in the Oracle Process Manufacturing Formula Management User’s Guide. The navigation path to the screen in the OPM application is OPM > Development > Formula Management > Effectivities)

Formula  Oracle ASCP can accept one product per formula. If an OPM formula has multiple effectivities for a product or for co-products, a different formula is effectively viewed by Oracle ASCP. Oracle ASCP expects one product per bill of material (in our case, a formula) and this causes the co-products and byproducts to be reported as components with negative quantities. Also, linear and fixed scaling is implementable.

(For additional information, please refer to Setting Up Formulas in the Oracle Process Manufacturing Formula Management User’s Guide. The navigation path to the screen in the OPM application is OPM > Development > Formula Management > Formulas)

Routings  The routing/formula combination must be unique. The routing quantity uses the base UOM of the effectivities product. An OPM step is equivalent to an Operation. An OPM activity is equivalent to an Operation Resource Sequence. A routing resource is equivalent to an Operation Resource.

With OPM CRP, you have the option of using alternate resources. Resources are assigned a Plan Type indicating primary (1), auxiliary (2), or secondary (0) on the Operations form. In Oracle ASCP, only the primary and auxiliary resources are used. Secondary resources are ignored.

Oracle ASCP uses resource count and usage quantity information. You record resource count and usage quantity information in the Operations form. For example, if two identical blenders are used for mixing, enter 2 in the Count field. If the resource can mix 200 gallons per hour, enter 200 in the Process Quantity field and 1 in the Usage Quantity field.
Oracle ASCP enables you to use more than one resource at the same time during an operation, but you cannot complete more than one operation in a routing at the same time. Oracle ASCP enables you to overlap an operation with another operation, but this restricts OPM’s functionality of allowing concurrent operations and multiple dependent operations. Concurrent operations are not allowed with Oracle ASCP.

(For additional information, please refer to Understanding Routings in the Oracle Process Manufacturing Formula Management User’s Guide. The navigation path to the screen in the OPM application is OPM > Development > Formula Management > Routings)

**Resources**

When you complete the Resource Information form, you define a relationship between a plant and the resource. Because Oracle ASCP acknowledges the plant via the resource warehouse associated with the plant, Oracle ASCP views the resource as having a relationship with a resource warehouse instead of with a plant. Because a resource warehouse is mapped to a department in an inventory organization in Oracle Applications, the resource is essentially mapped to a department in an inventory organization via the plant resource form.

You can use Oracle ASCP to develop capacity plans for your resources. The resource warehouse for the plant indicates to Oracle ASCP the need to perform capacity planning. The Oracle ASCP capacity planning function assumes that all resource capacity is measured in hours. The Assigned Quantity field (the navigation path to this screen in the OPM application is OPM > Planning > Capacity Planning > Setup > Plant Resources) indicates the number/quantity of the resource used in the specified plant for which you are defining production costs and usage availability. The number you enter depends on how broad a resource categorization you are defining. For example, if you defined the resource as Blender 1 (a specific machine) you would enter 1. If you use three blenders in the production line, and you defined the resource as Blenders (rather than defining each individual machine) enter 3.

The cost of using a resource for one unit of measure (for example, the cost of running a mixer for one hour) that you define in OPM Cost Management is also used by Oracle ASCP, but this cost must be recorded in the nominal cost value for the resource. Oracle ASCP assumes the unit of measure for all resources is an hour.
To set capacity planning, from the Navigator, choose Capacity Planning > Setup > Resources.

Plant/Warehouse Relationships
Plant warehouse effectivities are also known as plant/warehouse relationships. Plant warehouse effectivities specify the warehouses from which a plant consumes each item when it is used as an ingredient in a batch. They also specify the warehouses that a plant replenishes with each item when the item is a product of a batch.

On the Plant Warehouses form (the navigation path to this screen in the OPM application is OPM > Planning > Capacity Planning > Setup > Plant Resources), if the Warehouse Item field is left blank for a particular warehouse, then any item can be consumed from or replenished to that warehouse. This is called a global rule.

The plant warehouse effectivity item consumption and replenishment rules are enforced by Oracle ASCP for both global and warehouse items. Setting global rules increases the amount of data transferred because all warehouse item data is transferred, regardless of whether or not the warehouse items are actually consumed or replenished from the warehouse.

You can transfer items between warehouses as long as the item is defined in plant warehouse effectivities as a global or a specific rule. The consumption and replenishment indicators for the item/warehouse combination can be turned off and the item/warehouse combination can still be considered for transfers.

MPS Schedule

Integrating MPS Schedule Parameters With Oracle ASCP When you define your master production schedule (MPS) parameters, you indicate which plants are included in a schedule and select the criteria for including different sources of inventory supply and demand. The MPS schedule parameters serve the same purpose in Oracle ASCP and are used to create the Oracle ASCP master demand schedule. The Oracle ASCP master demand schedule includes all plants linked to the MPS schedule in the MPS Schedule Parameters form detail (the navigation path to this screen in the OPM application is OPM > Planning > MPS > Setup > Scheduler).

For additional details, please refer to Defining an MPS Schedule in the Oracle Process Manufacturing MPS/MRP and Forecasting User’s Guide.

The MPS schedule must have a unique, five character name. The Oracle ASCP master demand schedule name consists of the MPS schedule name and the warehouse name. For example, a MPS schedule named SCHD1 for resource...
warehouse RSW1 would result in a master demand schedule named SCHD1/RSW1.

The Make to Stock field on the MPS Schedule Parameters form allows you to choose whether or not to include forecasts as a source of demand. The Make to Order field allows you to choose whether or not to include sales orders as a source of demand. The Plant Warehouses form defines the items and warehouses from which to pull the demand for each plant linked to the MPS schedule.

**Integrating Forecasts With Oracle ASCP** The setup steps necessary to use forecast consumption for Oracle ASCP are the same setup steps you must complete when using forecast consumption in OPM.

◿ To use forecast consumption:

1. Create Forecast by using the following navigation path in the OPM application: OPM > Planning > Forecasting > Forecast. For additional details, please refer to Forecasting in the *Oracle Process Manufacturing MPS/MRP and Forecasting User's Guide*.

2. Associate forecast with Schedule by using the following navigation path in the OPM application: OPM > Planning > Forecast > Schedule Association. For additional details, please refer to Forecast Schedule Association Field References in the *Oracle Process Manufacturing MPS/MRP and Forecasting User's Guide*.

Forecast information created and linked to an MPS schedule in OPM is used by Oracle ASCP to create the master demand schedule. The forecasts used by the MPS schedule are specified on the Forecast Schedule Association form. A forecast can contain any number of items in various warehouses, but the schedule only uses those items that are valid to consume for a warehouse according to the Plant Warehouses form.

---

**Note:** Because one forecast can be used in multiple MPS schedules, be careful not to duplicate the demand for an item in a warehouse.

---

**Integrating Production Orders With Oracle ASCP** Oracle ASCP views pending OPM production orders as a source of supply and demand. Oracle ASCP can only view pending OPM production orders (firm planned orders, pending batches, and work-in-process batches) for those items that have a item/warehouse/plant relationship defined on the Plant Warehouses form.
You must turn on Production Operations Control (POC) for a plant and you must define a resource warehouse for a plant if you want to create capacity plans for the plant. Do this for the desired Organization on the OPM Organizations form (For additional details, see Organizations in the OPM System Administration User’s Guide. The navigation path to the screen in the OPM application is OPM > System Administration > Organizations).

If POC is turned on, Oracle ASCP collects the plant’s routing and resource requirements once a batch is created and the batch information is transferred to Oracle ASCP. If a plant does not have a resource warehouse, routing and resource data is not transferred to Oracle ASCP.

The ingredients for a batch must come from a single warehouse. OPM works around this issue by using the work-in-process warehouse or the resource warehouse, if available, as the single source of ingredient inventory when the batch has multiple sources or destinations. The work-in-process warehouse or the resource warehouse shows Oracle ASCP from where to allocate inventory.

The quantity of a batch product is reported in the converted primary unit of measure of the item.

Firm planned orders are viewed by Oracle ASCP the same as batches, except the firm planned order routing and resource requirements are not considered. Routing and resource requirements are considered once a firm planned order is converted into a batch.

Production rules (defined in OPM Inventory) are not required, but they do ensure that batches created meet fixed and variable leadtime requirements.

The process of creating production batches or firm planned orders from planning suggestions remains the same, regardless of whether or not the planning suggestions was created in Oracle ASCP or OPM. Any user can create production batches or firm planned orders from Oracle ASCP planning suggestions as long as the plant is listed in their security schema.

**Integrating Onhand Inventory With Oracle ASCP** Oracle ASCP sees the on-hand inventory of item/warehouse combinations defined for the plant that is attached to the MPS schedule. If a lot has expired, Oracle ASCP does not consider the lot as available inventory. It also does not suggest that you use the available lot that is closer than the other lots to expiring. Oracle ASCP observes lot statuses and does not consider a lot for consumption unless the lot status identifies the lot as nettable.
Oracle Shop Floor Management

Oracle Shop Floor Management is a module which bridges planning and execution systems. It provides the following capabilities:

- Manage Complex shop floor lot transactions
  - Lot split and merge
  - Update of lot name, product, routing, quantity
  - Bonus lots creation
- Enable dynamic routings
  - Routing determined on the fly
  - Routing movements enforced based on legal next operations
  - Jumps allowed to any operation
- Provide end-to-end genealogy of your products
  - Product tracking all the way back to raw material
  - Forward and backward genealogy surfing
- Model and track operation yield based cost for your products.
  - Operation level yields
    - Yielded cost of product
    - Cost variance at operations
- Enable integration of ERP with third-party MES systems.
  - Seamless integration with Oracle Applications
- Co-Product modeling
  - Modeling of co-products

Oracle ASCP integrates seamlessly with OSFM to provide the following capabilities:

Lot-Based Jobs

Lot-Based Jobs is an execution entity in Oracle OSFM designed to handle Lot-Based production. You can implement planned orders for items with Network Routings as Lot-Based Jobs. Follow the instructions specified in Implementing Planning.
Recommendations to select and release planned orders from Planner’s Work Bench. You can implement Reschedule In, Reschedule out, and Cancellation recommendations in addition to releasing the planned orders. Implementing recommendations uses a concurrent program called Import Lot Based Jobs at the source.

You can pass job name, job start and completion dates, start quantity, BOM and Routing designators, demand class, and WIP class, etc. Oracle ASCP treats Lot-Based Jobs as valid supplies in the planning engine. You can pass the demand for the components of the assembly from Lot-Based Jobs, and calculate resource requirements. You can see the results of the transactions on a Lot-Based Job; for example, Issues, Moves, Completions, etc. Oracle ASCP schedules the Lot-Based Jobs based on the availability of resources considering the current load of the shop floor. If you progress the job through move transactions at the source, the next time plan runs, Oracle ASCP schedule the rest of the operations in the network.

---

**Note:** Lot-based Jobs are referred to as Discrete Jobs in the Planner’s Work Bench

---

**Coproducts**

This feature is available with the integration of APS and Oracle Shop Floor Management (OSFM).

In some production environments, an item may turn into one or more parent items depending on the process control, test results, raw material quality, etc. Such a relationship is defined by defining coproducts. OSFM allows you to specify multiple possibilities of assemblies (parents) that may be derived from a single part. With APS and OSFM integration, you can calculate supply for multiple assemblies based on the demand for any one of the possible coproduct assemblies. You can generate and release planned orders for the assembly for which you realized demand. You can view coproduct supplies being generated for the rest of the items in coproduct relationship. This enables you to track the production for all the coproducts. The same applies if the planned order is converted into a lot-based job.

You can set up coproducts using Oracle OSFM. Oracle ASCP collection program collects the coproducts information into the planning server which is then used by the planning engine. To explain this with an example, consider the diagram below. A, B, and C are coproducts produced from raw material X. The figures in % are the expected mix of production of coproducts.
Referring to figure above, if you intend to produce 10 units of assembly A, you work with a supply of 20 units of X (i.e., 10/0.5) to come up with 10 units of supply for A, 6 units of supply (20 * 0.3) for assembly B, and 4 units of supply (20* 0.2) for assembly C. The demand for item X is 20. You can consider any component level yield while passing the demand to item X. Please note that the supplies to be generated for B and C are of the type Planned order coproduct/byproduct and the supply generated for A is a planned order. In other words, you will see planned order for the item against which you realized the demand and Planned order coproduct/byproduct for other items in the coproduct list as defined in coproduct definition. Planned order coproduct/byproduct is treated as a valid supply and open for allocation for any demand for the respective items.

Note: Due to the nature of level by level and item by item planning, in some circumstances you may not be able to fully utilize the Planned order coproduct/byproduct supply.

The table below shows the supply/demand picture as a result of demand for A for 10 units as described above.

<table>
<thead>
<tr>
<th>Demand or Supply</th>
<th>Day 10</th>
<th>Day 25</th>
<th>Day 35</th>
</tr>
</thead>
<tbody>
<tr>
<td>Demand(A)</td>
<td>0</td>
<td>10</td>
<td>0</td>
</tr>
<tr>
<td>Supply(A)</td>
<td>0</td>
<td>10</td>
<td>0</td>
</tr>
<tr>
<td>Demand(B)</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>
The next table shows the supply/demand picture after you get independent demand of 2 units for assembly B, on Day 35.

<table>
<thead>
<tr>
<th>Demand or Supply</th>
<th>Day 10</th>
<th>Day 25</th>
<th>Day 35</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supply(B)</td>
<td>0</td>
<td>6</td>
<td>0</td>
</tr>
<tr>
<td>Demand(C)</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Supply(C)</td>
<td>0</td>
<td>4</td>
<td>0</td>
</tr>
</tbody>
</table>

The next table shows the supply/demand picture after you get independent demand of 10 units for assembly C on Day 10. Please note that Planned order Coproduct/Byproduct supply is not moved in or out to support demands, and Planned order Coproduct/Byproduct supply is treated as firm.

<table>
<thead>
<tr>
<th>Demand or Supply</th>
<th>Day 10</th>
<th>Day 25</th>
<th>Day 35</th>
</tr>
</thead>
<tbody>
<tr>
<td>Demand(A)</td>
<td>0</td>
<td>10</td>
<td>0</td>
</tr>
<tr>
<td>Supply(A)</td>
<td>0</td>
<td>10</td>
<td>0</td>
</tr>
<tr>
<td>Demand(B)</td>
<td>0</td>
<td>0</td>
<td>2</td>
</tr>
<tr>
<td>Supply(B)</td>
<td>0</td>
<td>6</td>
<td>0</td>
</tr>
<tr>
<td>Demand(C)</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Supply(C)</td>
<td>0</td>
<td>4</td>
<td>0</td>
</tr>
</tbody>
</table>

**Planned Order Released Qty. for Coproducts:**

Referring to the first table, if you release the planned order for assembly A, the system creates a Lot-Based Job with a quantity of 20 to account for the production of
A, B, and C with material requirements of X for 20. The actual supply open for assembly A within the planning engine is 10. The next time you run the plan, Oracle ASCP snapshots a supply of 10 units for assembly A and maintains Discrete Job coproduct/byproduct supply for B and C for 6 and 4 respectively. If for some reason you do not wish to create and maintain Discrete Job coproduct/byproduct supplies, you have control over this at the Job level. The Coproducts supply flag at the Job determines if you need to create the Discrete Job coproduct/byproduct supply.

**Operation Yield**

If you can attribute significant amount of materials loss to a specific production process, then identifying the process and managing the yield at an operation level is essential. Yields specified at operation sequence is often needed to calculate the amount of raw materials or sub assemblies and measure performance.

Consider a simple production process as described in the diagram below.
In order to calculate raw materials needed at the start of each operation, cumulative yields, reverse cumulative yields, and net planning percentages need to be calculated. The diagram above shows you the calculations. Cumulative Yields are shown as CY, Reverse Cumulative Yields are shown as RCY, and Net Planning Percent is shown as NPP on the diagram. Net Planning Percent is the expected percentage of the flow of materials at a given node. Cumulative yield is the multiplication of yields in the forward direction. Reverse Cumulative Yield is the multiplication of yields in the reverse direction. Please refer to the diagram above for detailed calculations.

You can specify the yields at operation sequence level in the Network Routings using Oracle OSFM. The system can automatically calculate Cumulative Yields, Reverse Cumulative Yields, and Net Planning Percentages by using the Calculate Cumulative Yield button from Tools menu on Network Routing form.
If you need to calculate materials needed at operation sequence 10, you need to divide the order quantity by Reverse Cumulative Yield and multiply it by Net Planning Percent at Operation sequence 10.

If you need item A at operation sequence 10, and you have an order quantity of 100, the component demand for A should be 100/.88*100%, which is 113.63. Oracle ASCP consumes resources at various operation sequences based on the inflated order quantity which accounts for the operation yield. In our example, resources at operation sequence 10 are scheduled for a quantity of 113.63.

If you decide to scrap or reject some of the items on a Lot-Based Job, you can apply yields for the rest of the pending operations. If you reject 20 units out of a total order of 100 at Operation sequence 20 and assume that there were no losses at operation sequence 10, you can determine the component requirements based on a quantity of 80 and the reverse cumulative yield at operation sequence 20.

If you have network routings where you have multiple nodes joining a single node, the cumulative yield calculation is based on the weighted average of the yields from the nodes that join to form a single node.

**Network Routings**

Alternate ways of producing an item often demands flexible definition of Routings. Network Routings give you the flexibility of defining multiple manufacturing paths. Network Routings are defined using Oracle OSFM at the source. When you set up Network Routings, you can specify the estimated percentage of the orders that need to be processed on a specific path. This is called the planning percent. You can collect the Network Routings into the planning server using the APS Collection program. You can snapshot the Network Routings and use them to calculate and schedule resource requirements for existing Lot-Based Jobs and planned orders when you run a plan. You can choose to schedule orders using Network Routings in three ways:

- Primary Path
- Planned Percent
- Optimize

To make your selection, navigate to Setup and use Parameters form at ASCP. You can choose the scheduling method at the organization level by setting OSFM Network Scheduling Method parameter for your organization. The following diagram shows Network Routings.
Primary Path
As the name suggests, you can schedule orders on primary path. In this case, Oracle ASCP calculates the Reverse cumulative yields and Net Planning Percent based on the Primary path.

Planned Percent
This method takes advantage of accumulated percentages derived from user-specified planning percentage on the Network Routing. Referring to the figure, the resource requirements at operation sequence 20 is calculated for $100 \times \text{Net Planning Percent}$ at operation sequence 20. Considering an order of 100 units, the resource requirements at operation sequence 40 is calculated for 8 units, and so on.

Optimize
With this method, you can analyze the current conditions on the shop floor, intelligently choose alternate paths, and determine the quantity that needs to be processed on various paths. Given a specific order, you should be able schedule the order on the primary path. If you run into capacity constraints on the primary path, you should be able to schedule as much of the order as possible using the primary path and schedule the rest of the order on alternate paths. If you happen to go to an alternate path, the objective still is to get back to the primary path as soon as possible. For example, if you schedule resources at 40, you should seek the path 50, 60, 80 instead of 70, 80 or 50, 70, 80.

You can influence the decision of using alternate paths as opposed to primary path or vice versa using system level profile options. Oracle ASCP provides profile
options to influence scheduling decision. Oracle ASCP schedules the orders based on the availability of resources in a window defined by the following profile options:

MSO: Network Routing Cycle Time coefficient, is a multiple of the longest path of the network; the longest path is based on theoretical durations.

MSO: Network Routing fixed time window, is a fixed amount of time in days that you would like to add to your window.

If the duration using longest path on the network is 5 days, and you entered 2 for MSO: Network Routing Cycle Time coefficient and 3 for MSO: Network Routing fixed time window, the total window size will be: fixed time window + cycle time coefficient * longest path on the network, or 3+ 2(5) = 13 days.

You can further influence the scheduling decision using the following two profile options:

MSO: NFL BACKWARD COMPRESSION PCT, specifies the percentage of resources available for scheduling within the window described earlier during backward scheduling. If you set this profile option to 60%, the system only considers 60% of the available capacity in the window specified above while backward scheduling.

MSO: NFL FORWARD COMPRESSION PCT, specifies the percentage of resources available for scheduling within the window described earlier during forward scheduling. If you set this profile option to 20%, the system only considers 20% of the available capacity in the window specified above while forward scheduling.

These last two profile options give you the flexibility in controlling the on time delivery of orders.
Topics covered in this section include the following:

- Overview of Collaborative Planning on page 13-2
- Collaborating with Suppliers on page 13-4
- Using Workflow in Oracle ASCP on page 13-5
Overview of Collaborative Planning

Oracle ASCP extends the collaborative features of Oracle Applications. It is built on Oracle’s Internet computing architecture which allows all of the applications to be deployed over the Internet or your corporate Intranet. It is also completely integrated with Oracle’s Self Service Web Applications.

Collaborating with Customers

Collaboration is practical only in environments where all can gain by sharing information. When collaborative arrangements are carefully established throughout a supply chain, many competitive advantages accrue to the group.

Sharing Forecasts/Demand Plans

Oracle ASCP supports powerful Internet-based collaboration, which allows you to communicate seamlessly with your customers.

Providing Viewing and Updating Access

Because Oracle ASCP is a complete Internet-based planning solution, it allows your customers to review and enter forecasts. Please refer to Oracle Demand Planning User Guide for information on how to review and enter forecasts.

Viewing Customer-Specific Forecasts

By allowing customers to enter their own forecasts, you have the freedom to view customer specific forecasts which in turn will help you better plan your own forecasts and demand plans.

Forecast Consumption Status

You should be able to perform regenerative forecast consumption during planning to improve the performance of your transaction system.

Within ASCP, collaboration is accomplished using Oracle Workflow and the BIS application.
Customer Submissions

Consolidating Customer Forecasts

Consolidated forecasts are complete forecasts for the entire business. They are built by consolidating all the forecasts into a single forecast. The forecast is then rolled up to the highest level of aggregation, and spread down to the lowest level of detail.

Oracle Demand Planning Demand forecasting is a crucial function for managing the manufacturing process. It provides the information necessary to improve the operational plans, as well as improve the companies ability to manage its profitability and customer expectations.

Oracle Demand Planning improves the planning process by providing the information necessary to make the product-mix decisions in a manner consistent with the goals of the company.

Oracle Demand Planning is a system that will enable manufacturers to systematically create the best forecasts with all the information available.

You can collect the data you need from multiple disparate sources and use Oracle Workflow to route information, manage processes, and monitor performance. You can provide secure access to portions of the plan and manage multiple scenarios to develop a collaborative consensus demand plan. The integration between Oracle ASCP and Oracle Demand Planning also allows you to maintain both constrained and unconstrained versions of the demand plan to manage the balance between market needs and production capabilities.

Incorporating Customer Forecasts Into the Demand Plan Oracle Demand Planning support Internet collaboration, incorporating information from sales, marketing, operations, and customers. Oracle Demand Planning provides a robust Internet-based framework for developing collaborative demand plans and forecasts.
Collaborating with Suppliers

From ASCP, a notification can be sent to a supplier for supplier capacity issues. This is done using notifications in the Plan menu of the Planner’s Workbench.

From the Oracle Self-Service Web Application, the supplier can review this notification and within the notification he or she can update the capacity information.

Performance Management and Supply Chain Partners

The planning system is integrated with the performance management system provided by Oracle Business Intelligence System (BIS). BIS is an Internet ready performance management system for Oracle Applications. By transforming transactional data into meaningful information, BIS lets you define, monitor, and analyze corporate performance in order to make strategic and timely decisions. BIS is a user-friendly, pre-packaged decision support solution integrated with Oracle Applications. You log onto BIS through a customizable web page for easy access to vital information. You receive notifications when enterprise performance does not meet predefined targets. These notifications include web links to related reports. BIS reporting is easy to understand, crosses functional areas, and provides different levels of analysis depending on your needs. Managers can respond immediately to BIS notifications in order to share information or take corrective actions. By enabling managers to proactively track, measure, and analyze enterprise performance, BIS provides a powerful corporate management tool, enabling strategic and timely decision-making.

Measuring Supply Chain Partner Performance

Oracle ASCP optimizes your plans to help you achieve your targets, and plans can be evaluated based on their impact on your key performance measure.

Providing View Access to Performance Metrics

From Planner Workbench, select your plan from navigation tree and go to the Key Indicators tab, you will be able to view KPIs for performance of your plan against target.

Viewing Partner Performance

Partner performance could also be view the same way. To view exceptions for a partner, select a plan and go to Action tab. You will be able to view your partner’s action and details of action.
Using Workflow in Oracle ASCP

Oracle ASCP enables web-based collaboration by automatically forwarding planning and forecast accuracy exceptions to trading partners using Oracle Workflow. Trading partners can research and respond to exceptions by clicking on links to navigate directly to self service web applications such as forecast maintenance, supplier capacity update, ATP, and a secured version of the Planner Workbench. Trading partner responses can, in turn, trigger other workflow activities such as an internal notification, or even an automatic reschedule of a purchase order or sales order.

Overview of Oracle Workflow

Business processes today involve getting many types of information to multiple people according to rules that are constantly changing. Oracle Workflow lets you automate and continuously improve business processes. It routes information of any type according to business rules. You can easily inform people both inside and outside your enterprise of any exceptions.

Defining and Modifying Business Rules

Oracle Workflow lets you define and continuously improve your business processes using a drag-and-drop process designer.

Unlike workflow systems that simply route documents from one user to another with some approval steps, Oracle Workflow lets you model sophisticated business processes. You can define processes that loop, branch into parallel flows and then rendezvous, decompose into subflows, and more. Because Oracle Workflow can decide which path to take based on the result of a stored procedure, you can use the full power of PL/SQL, the language of the Oracle8i Server, to express any business rule that affects a workflow process.

Delivering Electronic Notifications

Oracle Workflow extends the reach of business process automation throughout the enterprise and beyond to include any E-mail or Internet user. Oracle Workflow lets people receive notifications of items awaiting their attention via E-mail, and act based on their e-mail responses. You can even view your list of things to do, including necessary supporting information, and take action using a standard Web browser or an Oracle Applications Notification form.
Predefined Workflows for Oracle ASCP

There are five Workflow exception processes as shown in the following table:

<table>
<thead>
<tr>
<th>Workflow</th>
<th>Notifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item Forecast Workflow</td>
<td>Item is over committed</td>
</tr>
<tr>
<td></td>
<td>Item has a shortage</td>
</tr>
<tr>
<td></td>
<td>Item has excess inventory</td>
</tr>
<tr>
<td></td>
<td>Items with expired lots</td>
</tr>
<tr>
<td></td>
<td>Past due forecast</td>
</tr>
<tr>
<td></td>
<td>Late supply pegged to a forecast</td>
</tr>
<tr>
<td></td>
<td>Items below safety stock</td>
</tr>
<tr>
<td>Sales Order Workflow</td>
<td>Past due sales orders</td>
</tr>
<tr>
<td></td>
<td>Late supply pegged to a sales order</td>
</tr>
<tr>
<td>Rescheduling Workflow</td>
<td>Item has orders to be rescheduled in</td>
</tr>
<tr>
<td></td>
<td>Item has orders to be rescheduled out</td>
</tr>
<tr>
<td></td>
<td>Item has orders to be cancelled</td>
</tr>
<tr>
<td></td>
<td>Item has orders with compression days</td>
</tr>
<tr>
<td></td>
<td>Item has past due orders</td>
</tr>
<tr>
<td>Project Workflow</td>
<td>Items with shortage in a project</td>
</tr>
<tr>
<td></td>
<td>Items with excess in a project</td>
</tr>
<tr>
<td></td>
<td>Items allocated across projects</td>
</tr>
<tr>
<td>Material and Resource</td>
<td>Material constraint</td>
</tr>
<tr>
<td>Capacity Workflow</td>
<td></td>
</tr>
</tbody>
</table>

For a complete list of exception messages viewable in the Planner Workbench Actions tab, see Chapter 10, Planner Workbench/User Interface. For a general information on exceptions, see the Oracle Workflow Guide.
Configure to Order

Topics covered in this section include the following:

- CTO Enhancements on page 14-2
- Multilevel ATO with Example on page 14-2
- Set Up Required to Use Multilevel ATO on page 14-10
CTO Enhancements

Oracle’s Configure to Order solution has been enhanced to support Multilevel Configurations where you can have configurations under configurations. You can source the configurations from anywhere in the supply chain. The Configure to Order Solution contains the following features:

- Forecast Explosion and Consumption
  You can explode the forecast from models to sub-models, option classes, optional items, and mandatory items with forecast control set to Consume and Derive in the source organization. You can maintain and consume forecasts for ATO model in the source Organization.

- Planning
  Once you configure your orders, you can place the demand on to the correct source organization, consume forecasts, and plan component requirements. You can explode through multilevel and multiorg ATO bills for Forecasts and other independent demands. You can accurately reconcile the forecast and sales order numbers as demands prior to creating Configured item and after you create Configured item.

- Order Promising
  You can perform order promising inquiries for your selected configurations with multiple levels of ATO models based on a plan output. Oracle APS automatically places sales order demands for your configuration in question, evaluates the best possible promise dates, and schedules supplies if needed.

Multilevel ATO with Example

To illustrate this by an example, consider the supply chain bill shown in the following figure.
Please refer to the legends on the figure for an explanation of item types. Sourcing relationships are shown in dotted lines and the BOM relationship are shown in continuous lines. The BOM and the sourcing is defined using Oracle Bills of Material and Oracle Supply Chain Planning or Oracle APS. You can find the item names within each of the nodes. The item name is followed by a two-letter code to identify the organizations.

CMP mainframe has four configurable assemblies (ATO models): PCI module, Dual Pod Enclosure, Sub Prod 32, and Sub Prod 64. The company sells CMP mainframes from its shipping organizations at Boston and Singapore, and it has three manufacturing sites; Hong Kong, Mexico, and Boston. CMP mainframes are assembled in Boston and Hong Kong. The PCI module is manufactured and sourced at the Mexico facility. Dual Pod Enclosures are manufactured and sourced at Hong Kong along with the components Sub prod32 and Sub prod64. Optional items CD ROMs, DAT Drives, and Tape Drives can be sold as spares from either Boston or Hong Kong.

**Forecast Explosion**

You can maintain forecasts for any item at any level in the bill you need. Forecasts maintained for CMP mainframe at the Hong Kong organization can be exploded down to its models, sub-models, option classes, options and mandatory components within the Hong Kong organization. Console, Pdevices, PCI Module, Dual Pod Enclosure, Sub Prod OC, Sub Prod 32, Sub Prod 64, PTN32-1MB, etc. have exploded forecasts. Independent forecasts maintained for CD-ROM, DAT Drv, Tape Drv can be consolidated with the exploded forecasts from its parents.

Similarly, any independent forecasts maintained for Sub Prod 32 or Sub Prod 64 can be consolidated with the exploded forecasts from its parents and exploded to its component forecasts. If you have multiple levels of ATO models, the forecast explosion process explodes through multiple levels of models in the BOM. The forecast explosion process stops at Standard items. Another important behavior to note is that the forecast explosion process explodes down to its forecasts only if you set the forecast control attribute of the components to Consume and Derive.

**Planning Process**

You can explode the forecast entries of ATO models into its component requirements during the planning process. If the forecast control is set to None and Consume, the explosion can occur in the planning process. The explosion process depends on planning percentage on the Bills of Material. If the forecast control is set
to Consume and Derive, the planning engine does not explode the requirements down because it has been exploded once during forecast explosion process.

You can configure your orders using Oracle configurator and establish orders using Oracle Order Management. Irrespective of the organization from which you want to ship the orders, you can source the configuration at your source organization. You can collect the configured and scheduled orders and their associated forecasts into the planning server using the collection program. You can consume the forecast specified at the sourced organization using the sales orders you entered using Oracle Order Management prior to the planning process at the planning server.

**Note:** You need to use the assignment set specified in profile option MRP: Default Sourcing Assignment as the assignment set used in plan options. This is because if the models are sourced, Order Management selects sources for configurations for ATP purposes and it uses the assignment set from this profile option. If the plan uses an assignment set that is different than the one mentioned in this profile option, you run the risk of inconsistent sources.

Oracle ASCP places the sales order demands for Models, Sub Models, option classes, optional items, and mandatory components specific to your order configuration. The planning process further explodes the demand down from Standard Items and plans for components below if there are any.

For example, if you accept an order at the Singapore organization and select the following options for your configuration:

- CMP Main Frame,
- CD-ROM,
- PTN32-2MB,
- 32TLC Add On,
- 5V Card;

after you collect your configured and scheduled order into the APS server and run a plan, you will get the demand picture shown in the following table in your APS plan:
You can create a Configuration Item based on your selection at Oracle Order Management. After the Configuration Item is created, you can rerun collections and the plan. As a result, you will see a sales order line for the Configuration Item at the shipping Organization in the plan. Referring to our previous example, you will see a sales order line for Configuration Item at the Singapore Organization. You will also see Configuration Items for each of the ATO models in your selection, i.e., CMP Main Frame, PCI Module, Dual Pod Enclosure, Sub Prod 32 at Hong Kong. In addition, you will see Configuration Item for PCI Module at Mexico. You will also see Bills of Material for each of the Configuration Items based on your selection. This will be used to pass the demand down to components and execute the orders.

<table>
<thead>
<tr>
<th>Item</th>
<th>Org</th>
<th>Demands</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMP Main Frame</td>
<td>SG</td>
<td>None</td>
</tr>
<tr>
<td>CMP Main Frame</td>
<td>HK</td>
<td>Sales Order</td>
</tr>
<tr>
<td>Console</td>
<td>HK</td>
<td>Sales Order</td>
</tr>
<tr>
<td>P devices</td>
<td>HK</td>
<td>Sales Order</td>
</tr>
<tr>
<td>CD-ROM</td>
<td>HK</td>
<td>Sales Order</td>
</tr>
<tr>
<td>PCI Module</td>
<td>HK</td>
<td>None</td>
</tr>
<tr>
<td>PCI Module</td>
<td>MEX</td>
<td>Sales Order</td>
</tr>
<tr>
<td>Cables</td>
<td>MEX</td>
<td>Sales Order</td>
</tr>
<tr>
<td>PCI Cards</td>
<td>MEX</td>
<td>Sales Order</td>
</tr>
<tr>
<td>5V card</td>
<td>MEX</td>
<td>Sales Order</td>
</tr>
<tr>
<td>Compatibility Bridge</td>
<td>MEX</td>
<td>Sales Order</td>
</tr>
<tr>
<td>Dual Pod Enclosure</td>
<td>HK</td>
<td>Sales Order</td>
</tr>
<tr>
<td>Sub Prod OC</td>
<td>HK</td>
<td>Sales Order</td>
</tr>
<tr>
<td>Power Supply</td>
<td>HK</td>
<td>Sales Order</td>
</tr>
<tr>
<td>Sub Prod 32</td>
<td>HK</td>
<td>Sales Order</td>
</tr>
<tr>
<td>PTN-32 OC</td>
<td>HK</td>
<td>Sales Order</td>
</tr>
<tr>
<td>PTN32-2MB</td>
<td>HK</td>
<td>Sales Order</td>
</tr>
<tr>
<td>TLC1032</td>
<td>HK</td>
<td>Sales Order</td>
</tr>
<tr>
<td>32TLC Add On</td>
<td>HK</td>
<td>Sales Order</td>
</tr>
</tbody>
</table>
Forecast consumption will now reflect the Configuration Item instead of the ATO item.

The following table represents the demand picture in planning after creating the Configuration Item:

<table>
<thead>
<tr>
<th>Item</th>
<th>Org</th>
<th>Type of demand</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMP Main Frame*1</td>
<td>SG</td>
<td>Sales Order</td>
</tr>
<tr>
<td>CMP Main Frame*1</td>
<td>HK</td>
<td>Planned Order</td>
</tr>
<tr>
<td>Console</td>
<td>HK</td>
<td>Planned Order</td>
</tr>
<tr>
<td>CD-ROM</td>
<td>HK</td>
<td>Planned Order</td>
</tr>
<tr>
<td>PCI Module*1</td>
<td>HK</td>
<td>Planned Order</td>
</tr>
<tr>
<td>PCI Module*1</td>
<td>MEX</td>
<td>Planned Order</td>
</tr>
<tr>
<td>Cables</td>
<td>MEX</td>
<td>Planned Order</td>
</tr>
<tr>
<td>5V card</td>
<td>MEX</td>
<td>Planned Order</td>
</tr>
<tr>
<td>Compatibility Bridge</td>
<td>MEX</td>
<td>Planned Order</td>
</tr>
<tr>
<td>Dual Pod Enclosure*1</td>
<td>HK</td>
<td>Planned Order</td>
</tr>
<tr>
<td>Power Supply</td>
<td>HK</td>
<td>Planned Order</td>
</tr>
<tr>
<td>Sub Prod 32*1</td>
<td>HK</td>
<td>Planned Order</td>
</tr>
<tr>
<td>PTN-32 OC</td>
<td>HK</td>
<td>Planned Order</td>
</tr>
<tr>
<td>PTN32-2MB</td>
<td>HK</td>
<td>Planned Order</td>
</tr>
<tr>
<td>TLC1032</td>
<td>HK</td>
<td>Planned Order</td>
</tr>
<tr>
<td>32TLC Add On</td>
<td>HK</td>
<td>Planned Order</td>
</tr>
</tbody>
</table>

Notice that the Configuration Item is created for each ATO model shown as *1 appended to the item in the above table.

The ASCP engine creates appropriate planned supplies that you can convert to actual supplies and follow standard replenishment cycle to ship the sales orders between internal Organizations and finally to the customer.

**Order Promising**

You can use plans developed by Oracle ASCP to quote the promise dates for your customers. You need to ensure that you have the profile option Profile INV:
Capable to Promise set to Enable PL/SQL based ATP with planning output and perform your inquiries from Oracle Order Entry.

You can perform order promising queries based on the supply/demand data developed by the planning engine. As you receive additional orders for your configurations, the Order Promising engine inserts sales order demand at the shipping organization and sources the orders using the sourcing information for your ATO models. If the supply found in the plan is not sufficient, the Order Promising engine generates more supply based on resource and material availability defined in the plan. Derived demand and supply (if needed) is inserted in the plan as well.

If you use a Master Demand Schedule (MDS) to drive the plan, you need to load the MDS with all the scheduled sales orders, collect the data, and rerun the plan in order to insert the scheduled sales orders into the plan. If you use sales orders and forecasts directly as input to the plan, the new scheduled sales orders will automatically become part of the plan as soon as you rerun the plan.

The order promising query will walk you through the bill and sourcing structure and determine the best possible promise dates and ship dates.

You can visualize the order promising results via a very detailed pegging tree that shows you the replenishment paths traced by the order promising query.

Please refer to the following Demand flow diagram for details on the demand flow in a multilevel, multisource ATO scenario.
Demand flow in a Multi-Level, Multi-org ATO scenario

Set up the following:
- MRP: Default Sourcing Assignment Set - Specify assignment set which has sourcing for models
- Plan: Specify the same assignment set (as in Profile option. MRP):
  Default Sourcing Assignment Set-Plan should be set up to check ATP
- INV: Capable To Promise: Based PL/SQL ATP with Planning Output

Enter and Schedule Sales Order for an ATO Model

No changes in the plan

Are items ATP Enabled?

Oracle Global Order Promising will insert Sales Order line for parent model in the plan within the Shipping Org. For all other components (component models included), Oracle Global Order Promising will insert derived demand.

Run net change collections and rerun the plan

Sales Order lines are placed for models, option classes, options, and mandatory components in the plan

If the model is sourced, Sales Order lines for models are created in source org. Forecast consumption happens in sourced org. (not in the shipping Org.)

Create Configuration Item

Run net change complete refresh collections and rerun the plan

Configuration Item is created for each ATO Model. Sales Order demand placed for top level assembly in Shipping Org. All other items in the selected configuration will get planned order demands.
Set Up Required to Use Multilevel ATO

The profile INV: Capable to promise must be set to Enable PL/SQL based ATP with planning output in order to perform multilevel order promising.

The profile MRP: Default Sourcing Assignment Set should be set to the assignment set that defines the sourcing rules for your model. The same assignment set should be used in your plan.

If a model in an organization can be sourced from another organization, the sourcing rule needs to be set up. Sourcing rule at the model level means that all configurations derived from that model will be manufactured in the sourcing organization and finally be shipped in the shipping organization. Only one sourcing organization is supported at this time.

Order Promising Related Attributes

For the models and option classes, the Check ATP flag in all organizations should be set to None. The ATP components flag can be set to any value. If no order promising check is required for configuration, the ATP flag at the BOM level should be unchecked. If a model is sourced, the ASCP engine will honor the attribute settings for the model in the source organization.

Forecast Control attribute for a sourced model should be set to Consume or Consume and Derive in the source organization in order for the forecast to be consumed in the Source organization. The Forecast Control set up in the shipping organization does not matter since forecast is not consumed in the shipping organization.

You need to ensure that end assemblies are in a forecast which is used by the plan at the shipping organization. This ensures that the item gets picked up in the plan prior to creation of Sales Orders.

To use Multilevel ATO features:

1. Enter or create forecasts and explode the forecasts to component forecasts at the source. You can use either Oracle Master Scheduling/MRP or Oracle Supply Chain Planning.

2. Run Collection to collect all your data. If data is collected to the planning server for the first time, use Complete Refresh Collection. Use Collection program from Oracle APS.

3. Define and run ASCP plan in the planning server. Ensure that ATP flag is checked for the plan.
4. Enter Sales Orders for your configuration using Oracle Order Management and Oracle Configurator.

5. Check ATP for your configuration from Sales Order form (Optional).


7. Run net change collections as needed from Planning server.

8. Run a plan which will consume forecasts, explode sales orders and forecast requirements, and generate planned supplies.

9. Create Configuration item for the sales order using Oracle Order Management.

10. Run Net change/Complete Refresh collections.

11. Rerun your plan again.

12. Convert planned supplies to actual supplies by releasing planned orders form Planner’s Work Bench.

13. Follow the regular replenishment cycle and ship between internal Orgs. and to the customer as needed.
Cross-Instance Planning

Topics covered in this section include the following:

- Overview of Cross-Instance Planning on page 15-2
- Instances on page 15-2
- Collections on page 15-3
- Sourcing Rules on page 15-4
- Planning on page 15-6
- Global Order Promising on page 15-8
- Execution on page 15-8
- Known Limitations on page 15-8
Overview of Cross-Instance Planning

This section provides a brief explanation on how Oracle APS supports cross-instance planning and available-to-promise. Cross-instance planning is defined as defining, running, and executing a single plan across multiple source instances and is a key feature for companies that implement a hub-and-spoke planning model.

Instances

The Oracle Advanced Planning Suite can plan a single instance or multiple instances. An instance is a database and set of applications. In order to explain cross-instance planning, we will distinguish between source and destination instances. Source instances hold the source data, like items, bill of materials, actual orders, and so on. Source instances can be Oracle Applications instances (release 10.7, 11.0, and 11I) or legacy systems. The destination instance is generally referred to as the APS Planning Server. Using the Planning Server, planners collect source information from the source instances, run, analyze, and simulate plans, and implement planned orders. Collection against an Oracle Applications source instance works out-of-the-box, whereas for legacy systems, a customized collection must be developed as part of the implementation.

The picture below will be used to illustrate the concept of cross-instance planning as supported by Oracle APS.

The diagram represents four source instances (S11, ABC, TR1, and S07) and a planning server. To set up cross-instance planning, an administrator has to register the source instances in the planning server. This is a two-step process:

1. Establish a database link between the source instances and the APS planning server.
2. Log in as Advanced Supply Chain Planner.
3. From the Navigator window, choose Setup > Instances.
   The Applications Instances window appears.

Figure 15–1  Application Instance window

4. Use the Instances window to register the source instances. This window allows you to define Planning Database Links used to pull data from the source instances to the Planning Server, and Application Database Links used to release planning recommendations from the Planning Server back to the source instances.

Collections

Before running plans on the planning server, the source data (planning related data and transactional data) needs to be collected. In our example, a user would run collections to collect from the four source instances. These collections can run in parallel using Oracle Applications standard concurrent processing features.
This architecture improves the collections process cycle time dramatically. For example, if the Discrete Job transactions are the only data that frequently change, you could collect only the changes in Work In Process transactions without recollecting data that was unchanged from the previous collection.

**Sourcing Rules**

Sourcing Rules (Bills of Distribution) enable sourcing across instances. A planner assigns sourcing rules to items to determine how items are being sourced.

The sourcing and the assignments for cross instance planning are done within the planning server. For example, the following diagram represents five instance-org combinations sharing materials. The rectangles in the diagram represent the instance-orgs. The first three letters in each of the rectangles represent the instance name; the two letters after the semicolon represent the organization name within that instance. For example, “ABC:S1” refers to instance ABC, organization S1.

The setup described in the following table is used to define sourcing rules as represented in the diagram above:

<table>
<thead>
<tr>
<th>Sourcing Rule/BOD</th>
<th>Receiving Org</th>
<th>Shipping Org</th>
<th>Allocation %</th>
<th>Intransit Lead Times</th>
</tr>
</thead>
<tbody>
<tr>
<td>BOD100</td>
<td>S11:M1</td>
<td>TR1:M2</td>
<td>25%</td>
<td>3</td>
</tr>
<tr>
<td>BOD100</td>
<td>S11:M1</td>
<td>S07:M3</td>
<td>75%</td>
<td>10</td>
</tr>
</tbody>
</table>
Once the sourcing rules are assigned to the items, the system is ready to start running plans.

To set up Sourcing Rules:
1. From the Navigator, choose Sourcing > Sourcing Rules.
   The Sourcing Rule window appears.

   Figure 15–2 The Sourcing Rule window

2. Define your sourcing rules. These are the rules that dictate a pattern of sourcing from suppliers and inventory organizations across multiple instances.
To assign Sourcing Rules:

1. From the Navigator, choose Sourcing > Assign Sourcing Rules.

   The Sourcing Rule/Bill of Distribution Assignments window appears.

   **Figure 15–3  Sourcing Rule/Bill of Distribution Assignments window**

2. Use this window to assign sourcing rules defined above to either an item in an organization, a category of items in an organization, an item, an organization, or an instance.

Planning

The next step in the process is to define a plan that spans multiple instances. This is achieved by entering all instance-orgs that need to be used in planning at the plan option level.

Referring back to the example: choose all the five instance-org combinations along with valid demand and supply schedules.

The assignment set, as mentioned previously, needs to be set as a plan option. Once the plan is run, the planned orders generated at S11:M1 and ABC:S1 will have sources per the sourcing rules/BOD that were defined. For example, TR1:M2, S07:M3, and S07:S1 will be shown as sources (depending on the type of plan you
run). The combination of sourcing rules/BODs, bills of material, and routings create what, in Oracle terminology, we call a supply chain bill. In the example described above, the independent demand will be exploded throughout the entire multiple instance supply chain and appropriate planned supply will be created for each component at each level of the supply chain bill.

To define a plan:

1. From the Navigator, choose either Manufacturing Plan, Production Plan, or Distribution Plan.
2. Choose Options and select a plan.

The Plan Options window appears with the Option tab selected.

**Figure 15–4  Plan Options window**

Please refer to Chapter 5, Defining Plans, for more information on how to define a plan.
Global Order Promising

When performing global order promising based on planning data with cross-instance sourcing, the available-to-promise calculation uses the supplies generated in the plan to evaluate availability. If there is a need for more supply, the capable to promise calculation uses cross-instance sourcing and goes through the supply chain bill to evaluate the capability to produce, and returns a valid availability date.

Execution

Although most of the execution happens at the source, the integration between the source instance and the planning server is initiated at the planning server. As a result of the plan run, you will see planned orders in the Planner Workbench with sources across instances as described in planning section. Considering the current and source organizations from the table below, the current organization is the organization at which the planned order is generated (the ship-to organization) and source organization is the organization from which you are going to source the planned order (the ship-from organization).

<table>
<thead>
<tr>
<th>Item</th>
<th>Current Org</th>
<th>Source Org</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>S11:M1</td>
<td>TR1:M2</td>
</tr>
<tr>
<td>B</td>
<td>s11:M1</td>
<td>S07:M3</td>
</tr>
<tr>
<td>C</td>
<td>ABC:S1</td>
<td>TR1:M2</td>
</tr>
<tr>
<td>D</td>
<td>ABC:S1</td>
<td>S07:M3</td>
</tr>
</tbody>
</table>

When the plan is executed, output from the planning process is communicated back to the source instances. Output includes recommendations in the form of new purchase requisitions and discrete jobs, as well as other recommendations such as reschedules to existing entities like purchase orders. If you release the planned orders for item A, B, C, or D, internal purchase requisitions are created at the respective source organizations. The creation of sales orders, shipments, in-transit shipments, receipts, and so on, across instances are defined manually.

Known Limitations

The following limitations for cross-instance planning are currently known:

- The Planner Workbench currently releases the requisition as an internal requisition, rather than an external requisition.
Known Limitations

- When releasing the requisition, it is not always clear which vendor maps to the internal-org.
- Conversion of financial data to the base currency is not supported in the current release.
- There is a time difference you set up when you define the instances: the planning engine will currently not add or subtract the time difference to the snapshot data from the source.
- Currently, you cannot create and collect transactions across instances to the Planning Server.
Topics covered in this section include the following:

- Overview of Oracle Global Order Promising on page 16-2
- ATP Methods on page 16-6
- Data Collection on page 16-8
- Basic ATP on page 16-9
- Single-Level Supply Chain ATP on page 16-12
- Multilevel Supply Chain ATP on page 16-21
- Allocated ATP on page 16-38
- Demand Class ATP on page 16-56
- Other ATP Functions on page 16-60
- ATP Inquiry on page 16-65
- Using Global ATP Server from Non-Oracle Applications on page 16-70
Overview of Oracle Global Order Promising

Oracle APS includes Oracle Global Order Promising, a tool that enables sophisticated, fast, accurate, and flexible order promising.

Key Features

The following is a list of key features supported by Oracle Global Order Promising. Except where noted, all the features are available with any release of R11i.

Accurate Global Statement of Availability
Oracle Global Order Promising supports availability checks in a distributed environment. It can be deployed either as a component of a complete applications system, or by itself on a separate server. This flexibility allows you to support any combination of centralized and decentralized order promising. This also ensures high availability as well as enabling multiple Order Entry systems to access a global statement of availability. You can provide an extremely accurate statement of availability to all customers in your global supply chain.

ATP for Multiple Supply Locations
If you have multiple distribution centers in your enterprise, Global Order Promising can help you to determine the best location to fulfill a customer request. Alternatively, you can check ATP for any of the possible supply location, drill down to ATP detail, and select the desired location.

Multilevel Supply Chain ATP
Oracle Global Order Promising lets you perform a multilevel component and/or resource availability check across your supply-chain for the end items you specify. You can control the organizations and suppliers to be included in the availability inquiry, and you can control the number of levels in your supply chain bill to be considered in your check. At each level in the supply chain, you can specify the key components and bottleneck resources for which to check availability. Multilevel ATP also considers transportation lead time between the organizations and from the suppliers and to the customers to give you a delivery promise your customers can rely on.

Detailed Availability Information with Graphical Pegging Tree
The result of a multilevel ATP is represented in a detailed pegging tree that shows you the component and resource availability at all the levels across the supply
Overview of Oracle Global Order Promising

You can easily identify the material in shortage or the bottleneck resource. You can further look at the component or resource cumulative availability or supply/demand information for any time in the planning horizon.

**Allocation**

The Allocation feature allows you to allocate scarce material or resource among multiple sales channels. Based on your business strategy, you can establish an Allocation Rule which ranks the sales channels and rations the supply among them. You can base the allocations on forecast or constrained demand. You can time phase the allocation to reflect changes in your monthly or quarterly objectives. During order promising, Oracle Global Order Promising honors the allocation rule and calculates order due dates, considering material and capacity constraints at each level of the supply chain.

In addition, the allocations are managed on a continuous basis as orders are fulfilled. Workflow notification are sent when ATP fails on request date or supply is directed from lower ranking channel towards higher ranking channel. At any point, you can compare the demand to the allocation for a sales channel and be able to adjust the allocation to ensure maximum fulfillment and profitability.

Allocation provides you with significant control over the demand fulfillment process to achieve your customer service and profitability goals.

**Configuration ATP**

Oracle Global Order Promising supports Assemble to Order (ATO) environment. You can designate any optional items for ATP check at any level of the configuration. This provides an accurate availability date for the end configuration. Oracle Global Order Promising integrates with Oracle Configurator to provide you with real time availability check during product configuration.

**Flexible Configuration**

Oracle’s order promising solution is flexible and configurable. You can control the complexity of the availability inquiry. You can specify the list of potential sources to be considered in the availability check. Sourcing rules can be used to specify the approved sources. These sourcing rules can be assigned to products, or to customers. Sourcing rules allow you to control what products can be quoted to a customer from specific locations. A flexible, hierarchical, approach is used to assign sources. The hierarchical assignment allows you to employ sophisticated sourcing strategies with minimal data entry. Rules can be applied at several levels. For example, you can apply rules globally, to entire organizations, to categories of
products, or to individual stock keeping units. More specific rules override more general rules, allowing you to apply default rules and maintain them on an exception basis. This drastically reduces the overhead necessary to maintain your global model.

Global Order Promising also provides you these additional flexibilities:

- Check availability for an item or a set of items across bills and across organizations
- Control single level or multilevel availability check
- Availability check at a product family level allowing more rapid response in mixed mode production environments
- Specify ship set or arrival set as constraints in the availability inquiry
- Specify infinite time fence to limit the time the availability is constrained
- Allow forward and backward consumption

Integration with Other Oracle Applications

The following Oracle Application products are integrated with Global Order Promising to provide availability check:

- Oracle Order Management
- Oracle Configurator
- Oracle i-Store
- Oracle Advanced Supply Chain Planning

Architecture

Oracle Global Order Promising supports the following configuration for installation and deployment.

- Centralized order promising
- Decentralized order promising

Centralized Order Promising

The following figure shows the centralized order promising configuration:
Supply and demand are pulled from the source instances to the Global Order Promising instance through database links. Order promising is based on the global availability statement.

**Decentralized Order Promising**

The following figure shows the decentralized order promising configuration.

Oracle Global Order Promising and its source data reside in the same database. No database link is required in this case. Two components can communicate through the planning object APIs and the interface tables defined in Oracle Applications.
ATP Methods

There are two methods to run ATP:

- ATP based on collected transactional data. This method is often referred to as ODS-based ATP.
- ATP based on planning data. This method is often referred to as PDS-based ATP.

ATP Based on Collected Data

You can run ATP based on collected data from source instances. This method is often referred to as ODS-based ATP. When you run ATP in this method, you can perform Basic ATP and Single-Level Supply Chain ATP. Supply and demand data as well as other information such as items, customers, MPS entries, and suppliers are collected from source instances and stored in the tables (Object Data Store) that are shared between Global Order Promising and Advanced Supply Chain Planning.

When running ATP in this method, ATP Rule is used to specify the time fence options and supply and demand sources to use during order promising inquiry. Forward and backward consumption, and accumulation are automatically carried out in this method.

You run ATP in this method by setting the INV:Capable to Promise profile to Enable PL/SQL Based ATP Without Planning Output.

For detailed information on how to set ATP Rules, see “ATP Rule Options” in the Oracle Inventory User's Guide.

ATP Based on Planning Data

You can run ATP based on the planning output. This method is often referred to as PDS-based ATP. When you run ATP in this method, you can perform Basic ATP, Single-Level Supply Chain ATP, Multilevel Supply Chain ATP, and Allocated ATP. Supply and demand data as well as other information such as items, bills of material, routing, customers, MPS entries, and suppliers are collected and serves as the input to an Advanced Supply Chain plan. Planning output is used for ATP calculation. Whatever supply and demand is considered by planning will be considered by ATP. You specify supply and demand in plan options.

Forward and backward consumption, and accumulation are automatically carried out in this method.

ATP Rule is used to specify the infinite time fence.
You run ATP in this method by setting the INV:Capable to Promise profile to Enable PL/SQL Based ATP With Planning Output.

For detailed information on how to set plan options, see "Setting Plan Options" in Chapter 5, Defining Plans.
Data Collection

Data Collection is a process that pulls data from source instances into an area called Operational Data Store (ODS) in Oracle ASCP/Global Order Promising. You can perform Basic ATP and Global ATP based on ODS data.

If you also have the Oracle Advanced Supply Chain Planning product installed, ODS acts as the input for the planning process. As you will see later in this section, Global Order Promising takes advantage of the planning output to provide you with advanced ATP features such as Multilevel Supply Chain ATP/CTP/CTD and Allocated ATP.

Data should be collected from selected instances before running the ATP inquiry.

If you do not have Advanced Supply Chain Planning product and you perform ATP based on ODS data, you can run the collection program from Order Management menu. Because ODS-based ATP does not need all the information compared to PDS-based ATP, the collection program under Order Management does not include the following parameters:

- Pull BOM/Routing
- Pull Safety Stock
- Pull Approved Supplier List
- Pull MDS

If you have Advanced Supply Chain Planning product installed, you need to run the collection program from Advanced Supply Chain Planning menu.

Global Order Promising ensures that new sales orders are immediately reflected in either in ODS or PDS when they are entered. This ensures that changes to demand stays current and the ATP results are accurate.

See Chapter 4, “Running Collections for ASCP” for detailed information on how to launch a collection program.
Basic ATP

This section provides a detailed discussion on how to use Basic ATP.

Basic ATP allows you to perform an availability check based on statement of current and planned material supply against a given organization. You can perform ATP checks by specifying the item, need-by date, and warehouse. Results describing the need-by date quantity and the fulfillment date of their request are returned to you.

Basic ATP Business Application

Customers need fast and accurate availability information to meet their requirements. Businesses must do their best to keep their customer relations successful and to meet their customers needs. Basic ATP allows customers to perform availability checks and receive detailed information on whether their request can be met or on what date the order can be fulfilled. Based on statements of current and planned material supply, Basic ATP can determine the availability of items.

You perform a Basic ATP check when you only have one inventory location in your company or you simply want to check availability in one inventory location.

Basic ATP Setup Steps

Item Attributes

There are two item attributes: Check ATP flag and Component ATP flag.

The Check ATP flag can be set to either:

- Material only - Check material availability for this item at this level
- None - No need to check ATP at this level

The Material and Resource, and the Resource options are not currently supported.

For Basic ATP, the Component ATP flag should be set to None, which states that there is no need to check ATP for this item at the component level.

ATP Rule

ATP rules are used to define various ATP options. Each rule is a combination of ATP, time fence options, and supply and demand sources to use during the ATP inquiry. You can define multiple ATP rules to reflect the specific needs of your
organization and then use different rules to calculate availability for different items or groups of items. You can update the item attribute ATP rule to specify a default ATP rule for each item.

Please see Other ATP Functions on page 16-60 for more information on how to use each of these options to best meet your needs.

**Profile - INV: Capable to Promise**

This profile determines whether to use ODS data or PDS data for ATP calculation. There are two values for this profile:

- Enable PL/SQL Based ATP Without Planning Output: You use this value if you want ATP calculation to be based on the collected data from the source instances and when you run MRP or SCP on the source instance and you do not have APS. The supply and demand come from the source instances from MRP or SCP plan output.

- Enable PL/SQL Based ATP With Planning Output: You use this value if you want ATP calculation to be based on the APS planning output.

**Profile - MRP: ATP Database Link**

ATP uses this profile at the source instance to check if the planning server is on the same instance.

**Basic ATP Data Collection**

Data collection is used to collect transactional data into a common data store for order promising. You must run collection before performing ATP inquiries.

**ATP Inquiry**

**Basic ATP From i-Store**

An end user will specify the item and need-by date. i-Store uses the warehouse defined in the profile ASO:Default Ship From Org for ATP purpose. i-Store displays the need-by date quantity and the fulfillment date when the requested quantity will be available.

**Basic ATP From Order Management**

You can perform Basic ATP from the Sales Order Pad in Order Management. You specify the item, the request date and the warehouse. Basic ATP returns the
request date quantity and fulfillment date when the requested quantity will be available.

**Basic ATP From Advanced Supply Chain Planning**

You can perform Basic ATP from Advanced Supply Chain Planning using the ATP Inquiry window.

See ATP Inquiry section on page 16-65.

**ATP Logic**

**ATP Logic in a Single Organization**

1. If ATP item attribute is None, there is no need to do an ATP check.

   If ATP item attribute is materials, the system checks ATP for the item on the request date. If there is availability, you are done. Otherwise go to step 2.

2. ATP fails to satisfy this request. From the sysdate (usually today), try forward scheduling for this request. Find the earliest date that you can get the shortage available. The earliest date is the ATP date.
Single-Level Supply Chain ATP

This section provides a detailed discussion on how to use Single-Level Supply Chain ATP.

Single-Level Supply Chain ATP enables you to perform availability checks based on current and planned supply across multiple supplying organizations. You can rank the supply organizations so that the ATP will check for availability in the order you want. Single-Level Supply Chain ATP can automatically find the best supply organization for your request. You can also drill down to look at the availability at every supply organization.

Single-Level Supply Chain ATP Business Application

Any environment where multiple supply locations can be used to fulfill order demand can benefit from this feature. As you utilize available inventory from other locations, you successfully meet customers requirement and thus increase your company’s overall order fill rate by utilizing inventories that might become excess otherwise.

For example, a company has three stores in the United States. When a customer inquires about a particular product’s availability, the company wants to first check the preferred store (Org1). The product may not be available at the preferred store. The company then wants to check other stores (Org2 and Org3) to find out which store can meet the customer requirement (this is shown in the following diagram.) Single-Level Supply Chain ATP can help this company to achieve this goal.

![Diagram showing availability check process]

Single-Level Supply Chain ATP Setup Steps

Item Attributes

There are two item attributes: Check ATP and Component ATP.
The Check ATP flag lets you control whether to perform and ATP check for that item. The Component ATP flag lets you control whether to check component availability and/or resource availability.

For the Check ATP attribute, the choices are:

- Material only - Check material availability for this item at this level
- None - No need to check ATP at this level

The Material and Resource, and the Resource only options are not currently supported.

For Single-Level Supply Chain ATP, the Check ATP attribute should be set to Material. The Component ATP flag should be set to None, which means that there is no need to check ATP for this item at the component level.

**ATP Rule**

Each rule is a combination of ATP time fence options and supply and demand sources to use during the ATP inquiry. You can define multiple ATP rules to reflect specific needs of your organization and then use different rules to calculate availability for different items or groups of items. You can update the item attribute ATP rule to specify a default ATP rule for each item.

ATP rules are used to define how ATP is run from the ODS.

Please see Other ATP Functions on page 16-60 for more information on how to use each of these options to best meet your needs.

**Sourcing Rule**

Sourcing rules determine the movement of materials between the shipping organizations and the receiving party. The receiving party can be a customer or an internal organization.

In Single-Level Supply Chain ATP scenario, you use a sourcing rule to designate the shipping organizations. Only global sourcing rules are permitted when assigning rules to customers.

For detailed setup instructions, see “Sourcing Rules and Bills of Distribution” in the *Oracle Master Scheduling/MRP and Oracle Supply Chain Planning User’s Guide*. 
Assignment Set

Once you have defined your sourcing rules, you must assign them to particular items and/or organizations and customers. These assignments are grouped together in assignment sets.

In an assignment set, you can assign your sourcing rules at different levels, as follows:

- a single item in an organization
- category of items in an organization
- an item across all organizations
- category of items across all organizations
- all items in an organization
- all organizations (global)

You can create an assignment set at different levels based on your needs. If the receiving party is a customer, then assign the sourcing rule to this customer and its site. If you want a sourcing rule to be applicable to any customer or any items, then you assign the sourcing rule to Global.

For detailed setup instructions, see “Sourcing Rules and Bills of Distribution” in the Oracle Master Scheduling/MRP and Oracle Supply Chain Planning User’s Guide.

Inter-Location Transit Times

You can set up different shipping methods and transit lead times between the shipping location of your organization and a receiving location of your customer for each method. You can designate a particular shipping method as the default method. ATP attempts to use the shipping method specified on the request to calculate the lead time. If a shipping method is not specified on the request, ATP will use the shipping method from the sourcing rule. If that is not found, ATP will use the default shipping method to obtain the transit lead time.

Before you set up transit times between the locations, you need to have the following set up:

- Shipping methods
- A location for your organization as the default shipping location designated in the Organization window
- A location associated with the customers ship-to address in the Define Customer window
For detailed setup instruction, see Shipping Methods, Inter-location Transit Times in Oracle Inventory User's Guide.

Profile - MRP: ATP Assignment Set
When you perform Single-Level Supply Chain ATP from the source instance, this profile determines the assignment set ATP uses to figure out the shipping organization for the receiving organization or customer. This profile should point to the assignment set discussed above and should be set up at the source instance.

Profile - INV: Capable to Promise
This profile determines whether to use ODS data or PDS data for ATP calculation. There are two values for this profile:

- **Enable PL/SQL Based ATP Without Planning Output**: You use this value if you want the ATP calculation to be based on the collected data from the source instances and when you run MRP or SCP on the source instance and you do not have APS. The supply and demand come from the MRP or SCP plan output in the source instances. You will be able to perform Supply Chain ATP with this setting.

- **Enable PL/SQL Based ATP With Planning Output**: You use this value if you want the ATP calculation to be based on the APS planning output. You will be able to perform Supply Chain ATP with this setting.

Profile - MRP: ATP Database Link
ATP uses this profile at the source instance to check if the planning server is on the same instance or not.

**Single-Level Supply Chain ATP With or Without APS**
You can perform Single-Level Supply Chain ATP from Order Management or i-Store. If you do not have Advanced Supply Chain Planning products, Single-Level Supply Chain ATP will be based on the collected data (ODS). With Advanced Supply Chain Planning products, you can base Single-Level Supply Chain ATP on the planning output. If you have a constrained and/or optimized plan, you can be sure that your ATP also respects your internal constraints as well as your optimization objectives.
Single-Level Supply Chain ATP Data Collection

Data Collection allows you to collect transactional data from multiple instances or different application systems into a common data store for global order promising and supply chain planning. It collects various data entities such as item, bills of material, customers, forecast, sourcing rule as well as transactional data such as purchase order, miscellaneous receipts, inventory transfers, etc.

In general, if you create new entities, you need to run full (complete refresh) data collection. If you modify an existing entity, such as changing an item attribute, or you have new transactional data, you can run net-change (incremental) collection to refresh the data.

ATP Inquiry

You can perform a Single-Level Supply Chain ATP inquiry inside Order Management or i-Store. Single-Level Supply Chain ATP can either automatically choose the supply organization for you or let you view all the supply organizations and you can pick the warehouse. The calling application can decide which method it wants to use.

Single-Level Supply Chain ATP From i-Store

Oracle i-Store will perform Single-Level Supply Chain ATP if there is no default shipping organization specified in the profile ASO:Default Ship From Org. An end user specifies the item and the need-by date and then i-Store displays the need-by date quantity and the fulfillment date when the quantity will be available.

Single-Level Supply Chain ATP From Order Management

You can perform Single-Level Supply Chain ATP Inquiry from the Sales Order Pad. From the Sales Order Pad:

- You can perform a Single-Level Supply Chain ATP inquiry without specifying a warehouse on the order line. Single-Level Supply Chain ATP will automatically search for the warehouse that can meet the request based on the sourcing rule you define. The result is displayed in a popup ATP Result window.

- If you are not satisfied with the result, you can click on the Global ATP button inside the ATP Result window. This triggers Single-Level Supply Chain ATP to show you all the supply organizations as defined in the sourcing rule. You may decide to source the demand from two different organizations.
Supply Chain ATP From Advanced Supply Chain Planning
You can perform Single-Level Supply Chain ATP Inquiry from Advanced Supply Chain Planning using the ATP Inquiry window.

From the ATP Inquiry window:
- If you select Pick Sources to No and you do not specify an organization, Single-Level Supply Chain ATP will automatically search for the organization that can meet the request based on the criteria you enter and the sourcing rule you define.
- If you select Pick Sources to Yes, you can view availability from multiple supply organizations.

Please see ATP Inquiry on page 16-65 for additional information.

ATP Logic for Single-Level Supply Chain ATP
An ATP request is processed by the system in the following order:
1. The organization with highest rank is chosen.
2. An availability check for the end item on the request date for that organization is performed. If there is enough supply on that request date, this date becomes the ATP date.
3. If there is not enough supply, a future ATP date in this organization is found by forward scheduling from sysdate (typically today) until sysdate + Latest Schedule Limit. (Latest Schedule Limit is defined for a customer.)
4. If there is still not enough supply, the organization with next highest rank is used, and step 2 is repeated.
5. If all the above fails, the organization with the highest ranking is used.

Note: When organizations are ranked the same, organizations with higher allocation percentage are checked first.

Single-Level Supply Chain ATP Example
The following example will walk you through some of the set up steps and show you the Single-Level Supply Chain ATP result.
You have two supply organizations: M1 and M2. M1 is the preferred warehouse. For end item A, it is make at M1, but it is buy from supplier S1 at M2. This sourcing strategy is applicable to all customers.

You can ship the product to customers using either the standard 3-day delivery or 1-day express.

For any demand, you want ATP to look at the two supply warehouses based on the current and planned supply.

You do not have Advanced Supply Chain Planning product installed.

**Item Attribute**

For end item A:

Check ATP Flag: Material

Component ATP Flag: None

**ATP Rule**

You need to have an ATP rule either assigned at the item level or organization level.

**Sourcing Rule**

You can set up a sourcing rule as shown in the following table. Please note that you must check the All Org field in the Define Sourcing Rule form. For this example, the sourcing rule name is SR-A.

<table>
<thead>
<tr>
<th>Type</th>
<th>Org/Supp</th>
<th>Percent</th>
<th>Rank</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transfer</td>
<td>M1</td>
<td>100%</td>
<td>1</td>
</tr>
<tr>
<td>Transfer</td>
<td>M2</td>
<td>100%</td>
<td>2</td>
</tr>
</tbody>
</table>

This is a global sourcing rule.

**Assignment Set**

In the assignment set, you make an Item level assignment by assigning sourcing rule SR-A to item A, as shown in the following table.

<table>
<thead>
<tr>
<th>Type</th>
<th>Item</th>
<th>SR</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item</td>
<td>A</td>
<td>SR-A</td>
</tr>
</tbody>
</table>
Inter-Location Transit Times

You can set up the transit times for different shipping methods between your shipping location and any party’s receiving location. The following table, with customer ABC and receiving location ABC-RecLoc, shows the transit lead times between the shipping location and the receiving location.

<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
<th>Shipping Method</th>
<th>Lead Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>M1-ShipLoc</td>
<td>ABC-RecLoc</td>
<td>Express</td>
<td>1 day</td>
</tr>
<tr>
<td>M1-ShipLoc</td>
<td>ABC-RecLoc</td>
<td>Standard</td>
<td>3 days</td>
</tr>
<tr>
<td>M2-ShipLoc</td>
<td>ABC-RecLoc</td>
<td>Express</td>
<td>1 day</td>
</tr>
<tr>
<td>M2-ShipLoc</td>
<td>ABC-RecLoc</td>
<td>Standard</td>
<td>3 days</td>
</tr>
</tbody>
</table>

Profile MRP: ATP Assignment Set

This should point to the assignment set defined above.

Profile: INV: Capable to Promise

Because you do not have Advanced Supply Chain Planning, you should set this profile to Enable PL/SQL Based ATP Without Planning Output.

Profile MSC: ATP Assignment Set

This profile indicates the name of the assignment set to be used for Single-Level Supply Chain ATP. When you perform Single-Level Supply Chain ATP from the server side, this profile determines the assignment set.

Instance Setup

If there are multiple source instances, you can associate an assignment set for each instance. The assignment set you choose for an instance will be typically the same as the assignment set you define for the MRP: ATP Assignment Set at the source instance. The profile MSC: ATP Assignment Set takes precedence over the assignment set for each instance.

Single-Level Supply Chain ATP Inquiry

Assume the cumulative ATP quantity for each of the warehouses is as shown in the following table:
The following list shows the ATP request information:

- Order quantity = 100
- Request arrival date = Day 11
- Customer = ABC
- Customer Site = ABC-Site1
- Shipping Method = Express
- Latest Schedule Limit = 2 day.

First, using this information, you perform the ATP Inquiry. During the inquiry, the system does the following:

1. Single-Level Supply Chain ATP first looks at M1. Because the shipping lead time is 1 day, the quantity must be available on Day 10. However, it is not available.

2. Because the latest schedule limit for this customer is 2 days, Single-Level Supply Chain ATP looks forward to Day 11 and Day 12. It is still not available.

3. Single-Level Supply Chain ATP now looks at M2. It is available on Date 12.

4. Single-Level Supply Chain ATP thus returns M2 as the warehouse for the request with the availability date of Day 12.

If you not only want to look at the current and planned supply for A, but also want to find out whether you can make it in M1 if there is not enough supply for A, you can do that by performing Multilevel Supply Chain ATP.

### Notes

**ATO and PTO Models**

Currently, Global Order Promising does not recommend sourcing for ATO and PTO models. You need to enter the source warehouse when you perform an ATP inquiry.

<table>
<thead>
<tr>
<th>Org</th>
<th>Day 10</th>
<th>Day 11</th>
<th>Day 12</th>
<th>Day 13</th>
</tr>
</thead>
<tbody>
<tr>
<td>M1</td>
<td>80</td>
<td>85</td>
<td>90</td>
<td>100</td>
</tr>
<tr>
<td>M2</td>
<td>90</td>
<td>95</td>
<td>100</td>
<td>105</td>
</tr>
</tbody>
</table>
Multilevel Supply Chain ATP

This section provides a detailed discussion on how to implement Multilevel Supply Chain ATP.

Multilevel Supply Chain ATP Feature Description

Oracle Global Order Promising lets you perform a multilevel component and resource availability check across your supply chain for the end items you specify. You can control the organizations and suppliers to be included in the availability inquiry, and you can control the number of levels in your supply chain bill to be considered in your check. At each level in the supply chain, you can check the availability of key components and bottleneck resources. Multilevel ATP also considers transit lead times between the organizations, from the suppliers, and to the customers to give you a reliable delivery promise your customers can rely on.

The following diagram depicts a simplified supply chain scenario where item A can be shipped from organization Org1 and Org2 to a customer. Both organization manufacture the item. Item A has a key component B and a bottleneck resource. Component B comes from different supplier for different organizations with different lead times.

Multilevel ATP can help you decide the following:
- Do I have supply for A at Org1? If not, can I make it at Org 1 with unutilized supplier capacity for B and my manufacturing resource R1?
If not, do I have supply at Org2? If not, can I make at Org2?

Multilevel Supply Chain ATP Business Application

Multilevel ATP helps companies to increase order fill rate by promising orders using extra manufacturing and supplier capacity. Because of demand fluctuation, your planned production level can change and thus result in underutilization of manufacturing resources or supplier capacity at times. However, if demand increases beyond forecast, you want to be able to book those orders using the extra capacity. A multilevel ATP check will ensure whether you have enough capacity to book the unanticipated demand.

As companies today outsource more and more of their assemblies or subassemblies, order promising can only become accurate if the supply chain is being considered. A factory must capable of not only making the product on time, but also delivering the product to the parent factory on time. Transit lead time between the facilities and from the suppliers become critical elements in the availability calculation. Only Multilevel ATP is capable of providing you with an accurate promise date based on the entire supply chain.

This feature is also critical in an Assemble-to-Order environment where end configuration availability depends on the availability of optional items at lower level configuration. The availability of an optional item at a lower level configuration will constrain the configuration at that level, which will in turn constrain the final configuration. Multilevel ATP ensures that you promise the end configuration accurately.

Multilevel Supply Chain ATP Setup Steps

**Item Attributes**

There are two item attributes: Check ATP and Component ATP.

The Check ATP flag lets you control whether to perform ATP check for that item. The Component ATP flag lets you control whether to check component availability and/or resource availability.

For Check ATP attribute, the choices are:
- Material only - Check material availability for this item at this level
- None - No need to check ATP at this level

For Component ATP attribute, the choices are:
Multilevel Supply Chain ATP

- Material only - Check availability of the components in the bill for this item.
- Resource only - Check availability of the resources required to assemble this item.
- Material and Resource - Check availability of both materials and resources required to assemble this item.
- None - No need to check ATP for this item at the component level.

For Multilevel ATP, Check ATP attribute can be set to either value. Typically you would set it to Material because you want the system to first check the item availability, and only check component availability if there is not enough available. The Component ATP flag should be set to any value other than None.

**ATP Rule**

For Multilevel ATP, planning output is used for ATP (see below for how to specify planning options).

ATP Rule is used to specify the infinite time fence. If items have different infinite time fences, you want to define different ATP Rules and assign them at the item level. Otherwise, you can simply have a default ATP Rule at the organization level.

**Plan Options**

You need to identify a particular plan (MPS, MRP, or DRP) for ATP by checking the Check ATP flag in the plan definition window in Advanced Supply Chain Planning.

In a plan definition, the following options are used both for planning and ATP:

- Supply and demand
- Assignment set

For detailed setup instructions, see Setting Plan Options in Chapter 5, Defining Plans.

**Supply Chain**

You can model your supply chain through a sourcing rule (SR) or a bill of distribution (BOD) and assign SR/BOD to your items, organizations, suppliers, customers in assignment sets.

In the Single-Level Supply Chain ATP section, it was explained how you set up sourcing rule and assignment set for supplying from multiple locations.
(organizations). You can extend that model further to model your entire supply chain from distribution centers to final assembly plants, from final assembly plants to subassembly plants, and from subassembly plants to component suppliers.

For detailed setup instructions, see “Sourcing Rules and Bills of Distribution.” in the Oracle Master Scheduling/MRP and Oracle Supply Chain Planning User’s Guide.

**Manufacturing Capacity**
Manufacturing capacity is determined by the following setup in each organization.

- Department Resource
- Work Shift

For detailed setup instruction, see Defining Resources, Defining a Workday Calendar in Oracle Bills of Material User’s Guide.

**Supplier Capacity**
You can define time-phased supplier capacity and capacity tolerance percentages for each item and supplier.

See Chapter 6, Supply Chain Modeling for more information about setting supplier capacity constraints.

**Interlocation Transit Times**
You can set up different shipping methods and transit lead times between the shipping location of your organization and a receiving location of your customer for each method. You can designate a particular shipping method as the default method. ATP attempts to use the shipping method specified on the request to calculate the lead time. If a shipping method is not specified on the request, ATP will use the shipping method from sourcing rule. If that is not found, ATP will use the default shipping method to obtain the lead time.

Before you set up transit times between the locations, you need to have the following set up:

- Shipping methods
- A location designated for your organization as the default shipping location in the Organization window
- A location associated with the customer’s ship-to address in the Define Customer window
For detailed setup instruction, see Shipping Methods, Inter-location Transit Times in Oracle Inventory User’s Guide.

**Profile - MRP: ATP Assignment Set**

This profile points to an assignment set that determines the sourcing strategy discussed in the Single-Level Supply Chain ATP section. This profile should be set up at the source instance.

This assignment set may or may not be the same as the assignment set you specify in a plan used for ATP. You can use a different assignment set to define the different part of a supply chain or you can use one assignment set.

**Profile - INV: Capable to Promise**

This profile determines whether to use ODS data or PDS data for ATP calculation. There are two values for this profile: Enable PL/SQL Based ATP Without Planning Output and Enable PL/SQL Based ATP With Planning Output.

You must set this profile to Enable PL/SQL Based ATP With Planning Output in order to perform Multilevel ATP.

**Profile - MSC: ATP Assignment Set**

This profile indicates the name of the assignment set to be used for Supply Chain ATP. When you perform Supply Chain ATP from the server side, this profile determines the assignment set used. The assignment set in this profile takes precedence over the assignment set you define in the instance window.

**Profile - MRP: ATP Database Link**

ATP uses this profile at the source instance to check if the planning server is on the same instance.

**Instance Setup**

If there are multiple source instances, you can associate an assignment set for each instance. The assignment set you choose for an instance will be typically the same as the assignment set you define for the MRP: ATP Assignment Set at the source instance.
Data Collection and Running a Plan

Data Collection allows you to collect transactional data from multiple instances or different application systems into a common data store for global planning. It collects various data entities such as item, bills of material, customers, forecast, sourcing rules as well as transactional data such as purchase order, miscellaneous receipts, inventory transfers, etc.

In general, if you create new entities, you need to run full (complete refresh) data collection. If you modify an existing entity, such as changing an item attribute, or you have new transactional data, you can run net-change (incremental) collection to refresh the data.

After you run collection, you can launch a plan. The planning result is the basis for Multilevel ATP.

ATP Inquiry

You can perform Multilevel ATP inquiry inside Order Management, i-Store or from Advanced Supply Chain Planning. Multilevel ATP can provide you with a summarized result and let you view all the detail including cumulative availability and pegging information. The calling application can decide the level of detail it wants to display.

Whether the system performs a Single-Level or Multilevel ATP check depends on the Component ATP flag. In both case, the result formats are the same. The difference is that Multilevel ATP gives you a better promise date because it is capable of utilizing any additional capacity to fulfill the demand on the request date.

Multilevel ATP From i-Store

An end user will get a simple availability result back when he performs an ATP inquiry inside a shopping cart. Behind the scene, ATP can perform a Multilevel ATP check based on the Check ATP and Component ATP flags.

Multilevel ATP From Order Management

You can perform Multilevel ATP inquiry from the Sales Order Pad.

From the Sales Order Pad:

- When you click on the Availability button on an order line, you will see a pop up window telling you what quantity is available on the date you requested and what date the whole requested quantity is available if it’s not available on
the date you want. From this pop up window, you can click on the Global Availability button to view the multilevel supply chain availability picture, or the pegging tree.

**Multilevel ATP From Advanced Supply Chain Planning**

You can perform ATP inquiry using the ATP Inquiry window from the Advanced Supply Chain Planning product menu.

From the ATP Inquiry window:

- This window allows you to enter ATP criteria and view ATP result. You can see both the summarized ATP result as well as detailed pegging view.

Please see ATP Inquiry on page 16-65 for additional information.

**ATP Logic for Multilevel Supply Chain ATP**

Multilevel ATP is processed by the system as follows:

**Multilevel ATP Logic in a Single Organization**

1. If both the Check ATP flag and the Component ATP flag are set to None, no ATP check is performed.

   If the Check ATP flag is set to Materials, an ATP check for the item on the request date is performed. If there is enough supply on the request date, the ATP check is finished. If there is not enough supply, the system goes to step 2.

   If the Check ATP flag is set to None and Component ATP flag is not set to None, the shortage for the item is assumed to be the amount of the request quantity. The system goes to step 3.

2. If Component ATP flag is set to None, the request is not satisfied. The system goes to step 7.

3. If Component ATP flag is not set to None, a new supply to cover the shortage of this end item is simulated. The bill of material is exploded to get to the next level component and resource requirements to assemble the end item. The system goes to step 4.

4. If resource requirements exist, the availability of resources is checked. If resources are found, the system goes to step 5.

   If resources are not found, ATP fails for this request. The system goes to step 7.
5. If component requirements exist, the availability of material components is checked. If material components are found, the check is finished. If material components are not found, the system goes to step 6.

6. If Component ATP flag is not set to None, new supplies for the shortage are recursively simulated, the bill of material is exploded, and availability is checked at the next level. If there is still not enough supply and the system cannot go down to the next level for the shortage, the system goes to step 7.

7. ATP has failed to satisfy this request. From request date, forward scheduling for this request is performed. The system searches for the earliest date that it can get the remaining quantity. The earliest date is the ATP date.

**Multilevel ATP Logic Involving Supply Chain**

1. The source with the highest rank is chosen. If the source type is buy from, availability from sourcing is checked. If the source type is make at or transfer, the system goes to step 2.

2. Check ATP is run for the end item at that organization (refer to Single Org ATP for the ATP calculation) based on the Check ATP flag and Component ATP flag. The supply chain bill is exploded to get to the next level component requirements for the shortage of the end item based on end item Component ATP flag. Resource and materials requirements from the supply chain bill based on the flags are considered. If there is enough resource and material availability on a certain date, the ATP check is successful, and the date becomes the ATP date.

3. If not successful, the ATP date in this organization is found by forward scheduling from the request date. The system goes to the organization with next highest rank and repeats step 2. If the system does not find any more organizations, it goes to step 4.

4. The system returns the highest ranking organization as the source. The ATP date is the earliest availability date in that organization.

**Multilevel Supply Chain ATP Example**

**Example 1: Multilevel ATP in a Single Organization**

Assume assembly A has the following bill in Org1.
Lead time information for A and B is as shown in the following table:

<table>
<thead>
<tr>
<th>Item</th>
<th>Fixed Lead Time</th>
<th>Variable Lead Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>0</td>
<td>0.1</td>
</tr>
<tr>
<td>B</td>
<td>1</td>
<td>0.01</td>
</tr>
</tbody>
</table>

The routing information for Item A and Item B is as shown in the following table:

<table>
<thead>
<tr>
<th>Item</th>
<th>Op Seq</th>
<th>Resource</th>
<th>Usage</th>
<th>Lead time offset</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>1</td>
<td>R1</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>B</td>
<td>1</td>
<td>R2</td>
<td>2</td>
<td>20%</td>
</tr>
</tbody>
</table>

Planning information for Item A and Item B from an MRP run on Date 1 is as shown in the following table:

<table>
<thead>
<tr>
<th>Supply/Demand Type</th>
<th>Item A</th>
<th>Item B</th>
<th>Item C</th>
<th>Item D</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sales Orders</td>
<td>10</td>
<td>5</td>
<td>50</td>
<td>40</td>
</tr>
<tr>
<td>Forecasts</td>
<td>100</td>
<td>10</td>
<td>75</td>
<td>60</td>
</tr>
<tr>
<td>Dependent Demand</td>
<td>0</td>
<td>145</td>
<td>270</td>
<td>135</td>
</tr>
<tr>
<td>Scheduled Receipts</td>
<td>5</td>
<td>25</td>
<td>50</td>
<td>50</td>
</tr>
<tr>
<td>Planned Order</td>
<td>105</td>
<td>135</td>
<td>345</td>
<td>185</td>
</tr>
<tr>
<td>ATP</td>
<td>100</td>
<td>10</td>
<td>75</td>
<td>60</td>
</tr>
</tbody>
</table>
Suppose we have the cumulative ATP quantities from the planning run as shown in the following two tables:

<table>
<thead>
<tr>
<th>Item</th>
<th>Date0</th>
<th>Date1</th>
<th>Date2</th>
<th>Date3</th>
<th>Date4</th>
<th>Date5</th>
<th>Date6</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>100</td>
<td>100</td>
<td>110</td>
<td>110</td>
<td>150</td>
<td>160</td>
<td>170</td>
</tr>
<tr>
<td>B</td>
<td>10</td>
<td>10</td>
<td>10</td>
<td>200</td>
<td>255</td>
<td>260</td>
<td>270</td>
</tr>
<tr>
<td>C</td>
<td>10</td>
<td>75</td>
<td>85</td>
<td>85</td>
<td>85</td>
<td>90</td>
<td>100</td>
</tr>
<tr>
<td>D</td>
<td>50</td>
<td>60</td>
<td>60</td>
<td>60</td>
<td>60</td>
<td>65</td>
<td>70</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Resource</th>
<th>Date0</th>
<th>Date1</th>
<th>Date2</th>
<th>Date3</th>
<th>Date4</th>
<th>Date5</th>
<th>Date6</th>
</tr>
</thead>
<tbody>
<tr>
<td>R1</td>
<td>16</td>
<td>16</td>
<td>16</td>
<td>16</td>
<td>20</td>
<td>22</td>
<td>24</td>
</tr>
<tr>
<td>R2</td>
<td>16</td>
<td>16</td>
<td>16</td>
<td>16</td>
<td>22</td>
<td>24</td>
<td>26</td>
</tr>
</tbody>
</table>

The values of the Check ATP flag and Component ATP flag of the request item determine the level of the ATP check, which may cause different results for the same request. Assume that the Check ATP flag at bill level is Yes for all items.

**Example 1: Request 100 of Item A on Date3 in Org1**

<table>
<thead>
<tr>
<th>Item</th>
<th>Check ATP flag</th>
<th>Component ATP flag</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Materials</td>
<td>None</td>
</tr>
</tbody>
</table>

We do have ATP quantity 100 on Date3. ATP date is Date3.

**Example 2: Request 120 of Item A on Date3 in Org1**

**Case 2.1**

<table>
<thead>
<tr>
<th>Item</th>
<th>Check ATP flag</th>
<th>Component ATP flag</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Materials</td>
<td>None</td>
</tr>
</tbody>
</table>

1. We do not have ATP quantity 120 on Date3.
2. Component ATP flag is None. We cannot go to next level. ATP fails for this request.
For Item A, we can have 110 on Date3 and 120 on Date4. ATP date is Date4.

**Case 2.2**

<table>
<thead>
<tr>
<th>Item</th>
<th>Check ATP flag</th>
<th>Component ATP flag</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Materials</td>
<td>Materials</td>
</tr>
<tr>
<td>B</td>
<td>Materials</td>
<td>None</td>
</tr>
</tbody>
</table>

1. We don’t have 120 of Item A on Date3.

2. The Component ATP flag is Materials. The shortage is 10 for Item A. The lead time to build 10 of Item A is one day. Therefore, we need 10 of Item B on Date2 to build this simulated supply of 10.

3. We do have 10 of Item B on Date2. So ATP date is Date3; use 110 of Item A on Date3 and 10 of Item B on Date2.

**Case 2.3**

<table>
<thead>
<tr>
<th>Item</th>
<th>Check ATP flag</th>
<th>Component ATP flag</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Materials</td>
<td>Materials and Resources</td>
</tr>
<tr>
<td>B</td>
<td>Materials</td>
<td>None</td>
</tr>
</tbody>
</table>

1. We don’t have 120 of Item A on Date3. The shortage is 10.

2. The Component ATP flag of Item A is Materials and Resources. Simulate a supply of Item A for quantity 10. Explode the bill to the next level. The lead time to build 10 of Item A is one day. We need 10 of Item B on Date2 and 10 R1 on Date2 to build 10 of Item A.

   We do have 10 R1 on Date2.

   We do have 10 of Item B on Date2. So ATP date is Date3; use 110 of Item A on Date3, 10 of Item B on Date2, and 10 of R1 on Date2.

**Example 3: Request 165 of Item A on Date4 in Org1**

<table>
<thead>
<tr>
<th>Item</th>
<th>Check ATP Flag</th>
<th>Component ATP Flag</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Materials</td>
<td>Materials and Resources</td>
</tr>
<tr>
<td>B</td>
<td>Materials</td>
<td>Materials and Resources</td>
</tr>
<tr>
<td>C</td>
<td>Materials</td>
<td>None</td>
</tr>
</tbody>
</table>
We don’t have 165 of Item A on Date4. The shortage is 15.

2. The Component ATP flag of Item A is Materials and Resources. Simulate a supply of Item A for quantity 15. Explode the bill to the next level. The lead time to build 15 of Item A is two days. We need 15 of Item B on Date2 and 15 R1 on Date2 to build 15 of Item A.

3. We do have 15 R1 on Date2.

4. However, we only have 10 of Item B on Date2, and the shortage is 5.

5. The Component ATP flag of Item B is Materials and Resources. Simulate a supply of Item B for quantity 5. Explode the bill to the next level. The lead time to build 5 of Item B is two days. We need 10 of Item C and 5 of Item D on Date0, and 10 R2 on Date1 (Date2-CEIL((1+0.01*5)*80%)).

6. We do have 10 R2 on Date1.

7. We do have 10 of Item C and 5 of Item D on Date0. So ATP date is Date4; use 150 of Item A on Date4, 10 of Item B on Date2, 15 of R1 on Date2, 10 of Item C on Date0, 5 of Item D on Date0, and 10 of R2 on Date1.

Case 4: Request 130 of Item A on Date2 in Org1

We don’t have 130 of Item A on Date2.

2. The Component ATP flag of Item A is Materials and Resources. Simulate a supply of Item A for quantity 20. Explode the bill to the next level. The lead time to build 20 of Item A is two days. We need 20 of Item B on Date0 and 20 R1 on Date0 to build 20 of Item A.

3. We don’t have enough R1 on Date0. ATP fails for this request on request date.

4. We can only make 16 of Item A since we only have 16 R1 available on Date0.
5. We can only make 10 of Item A since we only have 10 of Item B available on Date0 although we have 16 R1 available on Date0. The request date ATP quantity is 120.

6. Do forward scheduling from sysdate (Date0) for Item A with quantity 10.

7. The earliest date we can have another 10 R1 is Date4 (the supply picture of R1 has been changed since we have used 10 R1 in Date0 to build 10 of Item A).

8. The earliest date we can have 10 of Item B is Date3 (the supply picture of Item B has been changed since we have used 10 of Item B in Date0 to build 10 of Item A).

9. Considering lead time, the earliest date we can have 10 of Item A built is Date5 (= max(Date3 + 1, Date4 + 1))

10. If we don’t build 10 of Item A, we can have 130 of Item A on Date4. Date4 < Date6. ATP date is Date4. We can provide 130 on Date4.

**Example 2: Multilevel ATP for a Supply Chain BOM**

The supply chain bill looks like the following figure:

![Supply Chain BOM Diagram]

For an item with no associated sourcing information, the item is assumed to make at in the current organization.

Assume that Customer1 has the following sourcing rule, shown in the next table, with assembly A.
Org1
The bill and routing for item A in Org1 is the same as the information provided in the previous example. No sourcing information is defined for item A in Org1. It is assumed that item A in Org1 has an implicit supply chain bill which is shown in the following table:

<table>
<thead>
<tr>
<th>Source Type</th>
<th>Org</th>
<th>Rank</th>
<th>Shipping Lead Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>transfer from</td>
<td>Org1</td>
<td>1</td>
<td>1 day</td>
</tr>
<tr>
<td>transfer from</td>
<td>Org2</td>
<td>2</td>
<td>2 days</td>
</tr>
</tbody>
</table>

Org1
The cumulative ATP quantities in Org1 are shown in the following table:

<table>
<thead>
<tr>
<th>Item</th>
<th>Date0</th>
<th>Date1</th>
<th>Date2</th>
<th>Date3</th>
<th>Date4</th>
<th>Date5</th>
<th>Date6</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>100</td>
<td>100</td>
<td>110</td>
<td>110</td>
<td>150</td>
<td>160</td>
<td>170</td>
</tr>
<tr>
<td>B</td>
<td>10</td>
<td>10</td>
<td>10</td>
<td>200</td>
<td>255</td>
<td>260</td>
<td>270</td>
</tr>
<tr>
<td>R1</td>
<td>16</td>
<td>16</td>
<td>16</td>
<td>16</td>
<td>20</td>
<td>24</td>
<td>26</td>
</tr>
</tbody>
</table>

Org2
The supply chain bill for item A in Org2 is shown in the following table:

<table>
<thead>
<tr>
<th>Source Type</th>
<th>Org</th>
<th>Rank</th>
<th>Shipping Lead Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>transfer from</td>
<td>Org3</td>
<td>1</td>
<td>1 day</td>
</tr>
<tr>
<td>make at</td>
<td>Org2</td>
<td>2</td>
<td>0 days</td>
</tr>
</tbody>
</table>

Item A in Org2 uses the common bill from item A in Org1. The fixed lead time of Item A is 0 and the variable lead time is 0.1 day.

Item B is a buy item and it sources from Supplier1 with lead time of 0 days. Assume Supplier1 can provide 100 of Item B for Org2 from Date0 to Date10.

The cumulative ATP quantities in Org2 are shown in the following table:
The cumulative ATP quantities in Org2 are:

<table>
<thead>
<tr>
<th>Item/Res</th>
<th>Item/Res</th>
<th>Date1</th>
<th>Date2</th>
<th>Date3</th>
<th>Date4</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>100</td>
<td>100</td>
<td>120</td>
<td>120</td>
<td>150</td>
</tr>
<tr>
<td>B</td>
<td>10</td>
<td>10</td>
<td>40</td>
<td>50</td>
<td>60</td>
</tr>
<tr>
<td>R1</td>
<td>16</td>
<td>16</td>
<td>16</td>
<td>16</td>
<td>16</td>
</tr>
</tbody>
</table>

**Org3**

The cumulative ATP quantities in Org3 are:

<table>
<thead>
<tr>
<th>Item</th>
<th>Date0</th>
<th>Date1</th>
<th>Date2</th>
<th>Date3</th>
<th>Date4</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>20</td>
<td>20</td>
<td>20</td>
<td>20</td>
<td>30</td>
</tr>
</tbody>
</table>

**Note:** Assume that the Check ATP flag at bill level for all items in every org is set to Yes.

**Example 1: Customer1 requests 100 of item A with Date4 delivery date**

<table>
<thead>
<tr>
<th>Item</th>
<th>Org</th>
<th>Check ATP flag</th>
<th>Component ATP flag</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Org1</td>
<td>M</td>
<td>None</td>
</tr>
<tr>
<td>A</td>
<td>Org2</td>
<td>M</td>
<td>None</td>
</tr>
</tbody>
</table>

1. The system checks the availability of 100 of Item A on Date3 at Org1. The item is available. Therefore, ATP date is Date3 from Org1 and Customer1 will receive it on Date4 because shipping lead time is 1 day. This request is satisfied by using 100 of Item A on Date3 in Org1.

**Example 2: Customer1 requests 120 of item A with Date4 delivery date**

<table>
<thead>
<tr>
<th>Item</th>
<th>Org</th>
<th>Check ATP flag</th>
<th>Component ATP flag</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Org1</td>
<td>M</td>
<td>None</td>
</tr>
<tr>
<td>A</td>
<td>Org2</td>
<td>M</td>
<td>M+R</td>
</tr>
</tbody>
</table>
1. The system checks the availability of 120 of Item A on Date3 at Org1. The request (refer to previous example) cannot be satisfied. Item A has availability of 120 on Date4. ATP date in Org1 is Date4 and Customer1 will receive it on Date5. The request is satisfied by using 110 of Item A in Org1 on Date3 and total of 120 of Item A in Org1 on Date4.

2. The system checks the availability of 120 of Item A on Date2 at Org2. The item is available. ATP date is Date2 from Org2 and Customer1 will receive it on Date4. The request is satisfied by using 120 of Item A in Org2 on Date2.

Example 3: Customer1 requests 145 of Item A with Date4 delivery date

<table>
<thead>
<tr>
<th>Item</th>
<th>Org</th>
<th>Check ATP flag</th>
<th>Component ATP flag</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Org1</td>
<td>M</td>
<td>None</td>
</tr>
<tr>
<td>A</td>
<td>Org2</td>
<td>M</td>
<td>M+R</td>
</tr>
<tr>
<td>A</td>
<td>Org3</td>
<td>M</td>
<td>None</td>
</tr>
</tbody>
</table>

1. The system checks the availability of 145 of Item A on Date3 at Org1. The request cannot be satisfied. Item A has availability of 145 on Date4. The ATP date in Org1 is Date4 and Customer1 will receive it on Date5. The request is satisfied by: 110 of Item A in Org1 on Date3 and total of 145 of Item A in Org1 on Date4.

2. The system checks the availability of 145 of Item A on Date2 at Org2. There is not enough of Item A and the shortage is 25.

3. The Component ATP flag is Material and Resources. Simulate a supply of Item A for quantity 25. Explode the supply chain bill to the next level and the org with the highest rank is Org3.

4. The system checks the availability at Org3 and tries to transfer 25 of Item A from Org3 on Date1 to cover the shortage. There is only 20, and so the shortage is 5.

5. The system checks the availability at Org2 and tries to make 5 of Item A to cover the shortage. Five of Item B and 5 R1 on Date1 is needed. There is 10 R1 on Date1. There is 10 of Item B on Date1. ATP date is Date2 from Org2 and customer will receive it on Date4. The request is satisfied by using 120 of Item A in Org2 on Date2, 20 of Item A in Org3 on Date1, 5 of R1 in Org2 on Date1, and 5 of Item B in Org2 on Date1.
Notes

Product Dependency
Oracle Global Order Promising and Oracle Advanced Supply Chain Planning product are required.

Multilevel ATO Model
For multilevel ATO models (ATO models within ATO model where sub-ATO models are nonphantom items), you can perform ATP inquiry for any optional items under any ATO models. You need Global Order Promising and Oracle Advanced Supply Chain Planning products installed.
Allocated ATP

This section provides a detailed discussion on how to use Allocated ATP.

Allocated ATP Feature Description

The Allocation feature allows you to allocate scarce material or resources among multiple sales channels. Based on your business strategy, you can establish an Allocation Rule which ranks the sales channels and rations the supply among them. You can time phase the allocation to reflect changes in your monthly or quarterly objectives. During order promising, Oracle Global Order Promising honors the allocation rule and calculates order due dates, considering material and capacity constraints at each level of the supply chain.

You can define two types of hierarchies to represent your various sales channels. You can use demand classes which are single-level and user-defined or, you can use customer classes which have 3 levels: customer class, customer, and site. Whichever hierarchy you choose, you can define allocation rules. With these rules, allocation percentages can be specified for each node in the hierarchy. In addition, you can define priorities against your allocation rules. These priorities can be used to steal supplies from lower priority nodes if supplies are not available. The allocation rules can be assigned to either Global, Item Category, Item, Resource Group or Department Resource level. Notifications are sent to you if scheduling fails, or if scheduling is only successful by stealing allocation from other nodes.

Allocation provides you with significant control over the demand fulfillment process to achieve your customer service and profitability goals.

Allocated ATP Business Applications

When supply is scarce, it is important for suppliers to control which customers and demands are satisfied. The supplier does not want to allow their most important customers to go to another supplier because their ATP request was not fulfilled. The supplier needs to guarantee that the important demands are met, and that each of their various sales channels are allocated a percentage of the total supply.

In addition, the supplier needs flexibility in controlling how their demands are grouped. In other words, the supplier may want to have a single-level grouping, and thus would use a demand-class hierarchy. Otherwise, the supplier may want to divide their customers by customer class, customer, and site, and thus use the three-level, customer-class hierarchy.

For example, a supplier could define a single-level hierarchy with demand classes based on their various sales channels by geographical locations, such as Africa,
Allocated ATP

Australia, Europe, and Asia. This supplier might want to guarantee that each of these areas gets an equal percentage of the total supply. Thus, the supplier will allocate 25% of their total supply to each of the demand classes. However, the supplier might have higher priority customers in Europe that they don’t want to risk losing, while the customers in Australia are less critical. Thus, the supplier would assign Europe a priority of 1, and Australia a priority of 2. If demands in Europe exceed the available allocated supply, then the demands can still be satisfied by stealing the allocation from Australia. The customer’s order in Europe would be fulfilled while the supplier would receive a notification indicating that the European demand class stole supply from the Australian demand class.

Allocated ATP Setup Steps

To enable allocation, the following setup steps must be performed.

Item Attributes

There are two item attributes: Check ATP flag and Component ATP flag.

You can control what type of ATP check you want to perform at the level of each item or higher. The Check ATP flag can be set to either:

- Material only - Check material availability for this item at this level
- None - No need to check ATP at this level

You can also control what kind of ATP check you want to perform at the component level. The possible choices for the Component ATP flag are:

- Material only - Check availability of the components in the bill for this item.
- Resource only - Check availability of the resources required to assemble this item.
- Material and Resource - Check availability of both materials and resources required to assembly this item.
- None - No need to check ATP for this item at the component level.

Even if the Component ATP flag indicates that a component check is required, the Check ATP flag at the bill level can override the setting in the Component ATP flag.

ATP Rule

For Allocated ATP, planning output is used for ATP.
ATP Rule is used to specify the infinite time fence. If items have different infinite time fence, you want to define different ATP Rules and assign them at the item level. Otherwise you can simply have a default ATP Rule at the organization level.

ATP Plan
You need to identify a particular plan (MPS, MRP, or DRP) for ATP by checking the Check ATP flag in the plan definition window in Advanced Supply Chain Planning.

In a plan definition, the following options are used both for planning and ATP:

- Supply and demand
- Assignment set

Define Demand Classes
If you are using demand class hierarchy, set up demand classes to represent the various sales channels. For more information on setting up demand classes, please refer to Oracle Master Scheduling/MRP and Oracle Supply Chain Planning User’s Guide.

Define Customer Class Hierarchy
If using customer class hierarchy, set up customer classes, customers, and sites to represent the various sales channels. For more information on setting up customer classes, please refer to the Oracle Accounts Receivable User’s Guide.

Define Allocation Rules
Allocation rules must be defined on the Planning server. These rules determine how the supply will be allocated to the various sales channels.

Allocation rules have the following features: effective dates, percentages, and priorities.

- Allocation Effective Dates
  The allocation rules can be time-phased. You can define and/or maintain the effective dates of the allocation rules. The ATP engine determines which allocation rule to use based on the dates of the supplies and demands.

- Allocation Percentages
  You can define allocation percentages for each node in the hierarchy. Your supply will be allocated to those nodes based on the allocation percentages. If the total percentages do not add up to 100% on each level, the remaining
percentages are assigned to the category of Other. All nodes on each level that were not assigned a percentage in the allocation rule are included in Other.

**Note:** This applies to Customer Hierarchy only.

- Allocation Priorities

You can define priorities against your allocation rules to be used to steal supply from other nodes if supply is not available. Priorities are assigned to each node on each level, and you can only steal from those with lower priority.

**To define the Allocation rules:**

1. From the Navigator window, choose Advanced Supply Chain Planning.
2. Choose ATP > Allocation > Define Allocation Rule.

The Allocation Rule window appears.

*Figure 16–1 Allocation Rule window*
3. Enter name, description, and the effective dates for the rule. For each demand class, assign an allocation percentage and priority.

Assign Allocation Rules

Once the rules have been defined, the allocation rules must be assigned so that the ATP engine knows which rule to use for each item, etc. Allocation rules can be defined at a variety of levels for supplier convenience.

For material planning, the levels are: (from general to specific)
- Global
- Item Category (those categories that are part of the planning category set)
- Item
- Organization
- Item/Organization

The levels for resources are: (from general to specific)
- Global
- Organization
- Resource Group
- Department Resource

A more specific level can override a more general level assignment. For example, if there is a rule for a particular item and a different rule for the category of that item, then the effective rule will be the item rule.

The refresh hierarchy process must be started for ATP to see the allocations. Please refer to the next section to see more information on where and how this process is enabled.

◨ To assign Allocation Rules:
1. From the Navigator window, choose Advanced Supply Chain Planning.
2. Choose ATP > Allocation > Assign Allocation Rules.
   The Assign Allocation Rules screen appears.
3. Choose level in the Assign To column.
4. Choose the correct level. Depending on the level you have chosen, you must fill in the respective column.
5. To include a description, scroll to the Description column and enter a description.
6. In the Allocation Rule column, either enter the name of the Allocation Rule or select the rule from the full list.

**Profile - INV: Capable to Promise**
This profile determines whether to use ODS data or PDS data for ATP calculation. There are two values for this profile: Enable PL/SQL Based ATP Without Planning Output and Enable PL/SQL Based ATP With Planning Output.
You must set this profile to Enable PL/SQL Based ATP With Planning Output for Allocated ATP to work.

**Profile - MSC: Class Hierarchy**
This profile determines the type of hierarchy that will be used. There are two values for this profile:
- Demand Class: This hierarchy is a user-defined, single-level hierarchy.
- Customer Class: This hierarchy has 3 levels: customer class, customer, and site.
Profile - MSC: Enable Allocated ATP
To enable allocation, set the profile option: MSC: Enable Allocated ATP to yes.

Profile - MSC: Enable Allocated Workflow
To enable workflow notifications that are specifically for Allocated ATP, set the profile option: MSC: Enable Allocated Workflow to yes.
Workflow notifications are automatically triggered and sent to the item planner and sales representative/customer contact when the following happens:
- ATP fails on request date during scheduling, or
- ATP is successful only by stealing allocation from a lower priority demand class

Profile - MRP: ATP Database Link
ATP uses this profile at the source instance to check if the planning server is on the same instance.

Allocated ATP Data Collection
Data Collection allows you to collect transactional data from multiple instances or different application systems into a common data store for global order promising and supply chain planning. It collects various data entities such as items, bills of material, customers, forecasts, sourcing rules as well as transactional data such as purchase orders, miscellaneous receipts, inventory transfers, etc.
In general, if you create new entities, you need to run full (complete refresh) data collection. If you modify an existing entity, such as changing an item attribute, or you have new transactional data, you can run net-change (incremental) collection to refresh the data.

ATP Inquiry and Viewing Allocations
You can perform an ATP inquiry inside Order Management, i-Store, or from Advanced Supply Chain Planning. The inquiry results include the available quantity on the request date and the fulfillment date when the entire quantity is available. In addition, the detailed response includes a pegging view that shows the supply that satisfies the demand. The calling application can decide the level of detail it wants to display.
When Enable Allocated ATP is set to Yes, Global Order Promising processes each ATP request based on the allocated supply rather than total supply. It uses the
Allocated ATP

demand class or customer information from the ATP request and nets the demand against the allocated supply for that specific demand class or customer. Depending on the profile MSC:Class Hierarchy, Global Order Promising will either use demand class or customer class for allocated ATP.

Allocated ATP From i-Store

You can perform allocated ATP by customer class from i-Store. The results seen by the end user who is performing the ATP inquiry is in the same format as Basic ATP.

Allocated ATP From Order Management

You can perform Allocated ATP by demand class or customer class (depending on the profile setting) from the Sales Order Pad.

From the Sales Order Pad:

- You can perform allocated ATP in the same way you perform other ATP functions. The ATP engine uses the demand class or customer information from the sales order to determine the allocated availability. The result is displayed in a popup ATP Result window.

Allocated ATP From Advanced Supply Chain Planning

You can perform ATP inquiry using the ATP Inquiry window from the Advanced Supply Chain Planning product menu.

From the ATP Inquiry window:

- This window allows you to enter ATP criteria and view ATP results. You can see both the summarized ATP results as well as a detailed pegging view. The only difference between an inquiry without allocation and one with allocation is that if Allocated ATP is being used, then it matters from where the request originates. Thus, depending on the hierarchy that is being used, the inquiries should contain either the demand class, or the customer class, customer, and site.

For example, ATP inquiries that are identical, in terms of item, quantity, etc., but differ only by demand class will lead to different results. The available supply has been allocated by percentages to the various demand classes, and thus the ATP result for each demand class may be different.

If you are using demand-class hierarchy and an ATP inquiry is made without a demand class, then the default demand class is used. A default demand class can be assigned to your organization.
View Allocations Workbench

You can view the horizontal plan for your allocated ATP through a view allocations workbench. In this workbench, the left-hand side is the tree structure representing your hierarchy. You can choose a node (for instance, a particular site within a customer if using customer-class hierarchy or a demand class if using demand-class hierarchy) and view the horizontal plan. The horizontal plan gives a picture over time of the total demand, total supply, net ATP, and cumulative ATP for the total and for the particular node that you chose.

In addition, you can change the allocation percentages and priorities for any node directly from the workbench and immediately view the effects. You can do this by clicking on any of the nodes and filling in the Define Allocation Rules form.

To view allocations:

1. From the Navigator window, choose Advanced Supply Chain Planning.
2. Choose ATP > Allocation > View Allocation.
   The View Allocations screen appears.
Figure 16–3 View Allocations

3. Enter Organization. Then enter either the item or the department/resource.

4. To choose a demand class, click once on the appropriate class in the Demand Class table.

Refreshing Allocations

You can make modifications to both the percentages and priorities that are defined in your allocation rules. You can get to these forms to make the changes by either opening the define allocation rule form from the advanced supply chain planner menu or from the allocations workbench. Any changes along the hierarchy can be instantly viewed in the allocation workbench. However, for any of these effects to be used by ATP, the hierarchy must be refreshed. You can refresh the allocation hierarchy from the Tools menu, or from a button found on the form and this will start the process to allocate the supplies based on the current rules. Again, the refresh hierarchy process must be started for the allocations to occur in ATP.
Allocated ATP Example

Here are a few examples to illustrate how allocated ATP can be used. The first example is simple, and shows allocated ATP based on percentages. The second example also incorporates priorities, and thus shows the stealing functionality. The first two examples use the demand-class hierarchy. The final example shows how ATP works with a customer-class hierarchy.

Allocated ATP based on Percentages

In this case, the supplier is using two demand classes to represent various sales channels. Demand class DCb contains customers that are more important to this supplier, and thus he wants to guarantee that 60% of the total supply is allocated to this group of demands.

Allocation Rule

<table>
<thead>
<tr>
<th>Demand Class</th>
<th>Percentage</th>
</tr>
</thead>
<tbody>
<tr>
<td>DCa</td>
<td>40%</td>
</tr>
<tr>
<td>DCb</td>
<td>60%</td>
</tr>
</tbody>
</table>

The supply and demand picture for this example is shown in the table below. There is one sales order coming from demand class DCa for 20 and there are two sources of supply: a work order for 25 and a purchase order for 35.

Demands and Supplies

<table>
<thead>
<tr>
<th>Demands and Supplies</th>
<th>Demand Class</th>
<th>Quantities</th>
</tr>
</thead>
<tbody>
<tr>
<td>Demand Sales Order</td>
<td>DCa</td>
<td>20</td>
</tr>
<tr>
<td>Supply Work Order</td>
<td>n/a</td>
<td>25</td>
</tr>
<tr>
<td>Supply Purchase Order</td>
<td>n/a</td>
<td>35</td>
</tr>
</tbody>
</table>

The overall availability picture is $25+35-20= 40$. This is calculated by adding the total supplies and subtracting the already committed demand of 20. If there is no allocation, the availability for any ATP requests from any demand class is 40.

With the allocation rules in place, this supply is rationed to the demand classes based on the predefined percentages.
For Demand Class DCa:

<table>
<thead>
<tr>
<th>Demands and Supplies</th>
<th>Quantities</th>
</tr>
</thead>
<tbody>
<tr>
<td>Demand S/O</td>
<td>20</td>
</tr>
<tr>
<td>Supply W/O</td>
<td>10 (= 25 * 40%)</td>
</tr>
<tr>
<td>Supply P/O</td>
<td>14 (= 35 * 40%)</td>
</tr>
</tbody>
</table>

Thus, the ATP quantity for this demand class is 4 = 10 + 14 - 20.

For Demand Class DCb:

<table>
<thead>
<tr>
<th>Demands and Supplies</th>
<th>Quantities</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supply W/O</td>
<td>15 (= 25 * 60%)</td>
</tr>
<tr>
<td>Supply P/O</td>
<td>21 (= 35 * 60%)</td>
</tr>
</tbody>
</table>

Thus, the ATP quantity for this demand class is 36 = 15 + 21 - 0.

Therefore, with the allocation rules, demand class DCb is guaranteed to be allocated 60% of the supply which is 36. Without these rules in place, customers from demand class DCa could keep submitting orders, and when a demand came from DCb, no supply would be available.

**Allocated ATP based on Percentages and Priorities**

This example illustrates how allocated ATP works with both percentages and priorities. The supply is allocated to the demand classes based on the percentages that are defined within the allocation rules. Yet, if a higher priority demand class still needs more supply, they can steal the necessary supply from the lower priority demand classes.

**Allocation Rule**

<table>
<thead>
<tr>
<th>Demand Class</th>
<th>Priority</th>
<th>Percentage</th>
</tr>
</thead>
<tbody>
<tr>
<td>DCa</td>
<td>1</td>
<td>30%</td>
</tr>
<tr>
<td>DCb</td>
<td>2</td>
<td>20%</td>
</tr>
<tr>
<td>DCc</td>
<td>3</td>
<td>50%</td>
</tr>
</tbody>
</table>
In this example, the supplier has defined three demand classes. He has assigned certain percentages to these demand classes, but in addition he has ranked the priorities of these demands. In this scenario, demand class DCc has the largest number of customers and thus has been allocated the largest percentage of the available supply. However, demand class DCa has more important customers and thus they should be allowed to steal the supply from the other demand classes if they want to submit an order.

The supply and demand picture is as follows:

**Demands and Supplies**

<table>
<thead>
<tr>
<th>Demands and Supplies</th>
<th>Demand Class</th>
<th>Quantities</th>
</tr>
</thead>
<tbody>
<tr>
<td>Demand Sales Order</td>
<td>DCa</td>
<td>20</td>
</tr>
<tr>
<td>Demand Forecast</td>
<td>DCb</td>
<td>30</td>
</tr>
<tr>
<td>Demand Forecast</td>
<td>DCa</td>
<td>10</td>
</tr>
<tr>
<td>Supply Work Order</td>
<td>n/a</td>
<td>25</td>
</tr>
<tr>
<td>Supply Purchase Order</td>
<td>n/a</td>
<td>35</td>
</tr>
</tbody>
</table>

Based on the above tables, the available quantity is $25 + 35 - 20 = 40$. Note that the demand forecasts are not included in the availability calculation. The available supply is based purely on the total supply less the committed demand.

Using the percentages defined in the allocation rules, the tables below illustrate the availability picture in each of the demand classes.

**For Demand Class DCa:**

<table>
<thead>
<tr>
<th>Demands and Supplies</th>
<th>Quantities</th>
</tr>
</thead>
<tbody>
<tr>
<td>Demand S/O</td>
<td>20</td>
</tr>
<tr>
<td>Demand F/C</td>
<td>10</td>
</tr>
<tr>
<td>Supply W/O</td>
<td>7.5 ( = 25 * 30%)</td>
</tr>
<tr>
<td>Supply P/O</td>
<td>10.5 ( = 35 * 30%)</td>
</tr>
</tbody>
</table>

Thus, the ATP quantity for this demand class is $-2 = 10.5 + 7.5 - 20.$
For Demand Class DCb:

<table>
<thead>
<tr>
<th>Demands and Supplies</th>
<th>Quantities</th>
</tr>
</thead>
<tbody>
<tr>
<td>Demand F/C</td>
<td>30</td>
</tr>
<tr>
<td>Supply W/O</td>
<td>5 ( = 25 * 20%)</td>
</tr>
<tr>
<td>Supply P/O</td>
<td>7 ( = 35 * 20%)</td>
</tr>
</tbody>
</table>

Thus, the ATP quantity for this demand class is 12 = 5 + 7 - 0.

For Demand Class DCc:

<table>
<thead>
<tr>
<th>Demands and Supplies</th>
<th>Quantities</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supply W/O</td>
<td>12.5 ( = 25 * 50%)</td>
</tr>
<tr>
<td>Supply P/O</td>
<td>17.5 ( = 35 * 50%)</td>
</tr>
</tbody>
</table>

Thus, the ATP quantity for this demand class is 30 = 12.5 + 17.5 - 0.

The above figures only take into account the percentages. Notice that the ATP quantity for demand class DCa is negative. Since this demand class has the highest priority, these demands must be satisfied if possible, so this demand class steals from the lower priority demand classes.

The final availability picture for each of the demand classes is as follows:

- The availability for DCa is -2.
- The availability for DCb is 10. This is because DCa has a higher priority than DCb, so DCb needs to take care of the over commitment from DCa. Demand class consumption is used and 2 are stolen DCa. Thus, the availability for DCb is 12 + (-2) = 10.
- The availability for DCc is 30 because nothing from DCa and DCb needs to be taken care of here. Demand class consumption is used for DCa at DCb. Since DCb has already taken care of DCa, no further consumption is necessary.

Allocated ATP Using Customer-Class Hierarchy

This example illustrates how allocated ATP works with customer-class hierarchy. The supply is allocated to the customer classes, customers, and sites based on the percentages that were defined within the allocation rules.
The following diagram illustrates a customer-class hierarchy.

![Customer-Class Hierarchy Diagram]

The following percentages and priorities have been defined in the allocation rule. The actual percentage is calculated by multiplying the entered percentage by the parent’s allocation percentage. For example, in the computer industry there are 3 customers, Dell, IBM, and other. The percentages for those 3 must add up to 100. The entered percentage for Dell is 40% and thus the actual percentage of the total that Dell will receive is 40% of what the Computer Industry is allocated, and thus 28%.

**Allocation Rule**

The following tables show the allocation rule:

### Customer Class Level

<table>
<thead>
<tr>
<th>Customer Class</th>
<th>Priority</th>
<th>Percentage</th>
<th>Actual Percentage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Computer Industry</td>
<td>1</td>
<td>70%</td>
<td>70%</td>
</tr>
<tr>
<td>Other</td>
<td>2</td>
<td>30%</td>
<td>30%</td>
</tr>
</tbody>
</table>

### Customer Level

<table>
<thead>
<tr>
<th>Customer Class</th>
<th>Customer</th>
<th>Priority</th>
<th>Percentage</th>
<th>Actual Percentage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Computer Industry</td>
<td>Dell</td>
<td>1</td>
<td>40%</td>
<td>28%</td>
</tr>
<tr>
<td>Computer Industry</td>
<td>IBM</td>
<td>2</td>
<td>40%</td>
<td>28%</td>
</tr>
</tbody>
</table>
The supply and demand picture is detailed in the following table.

### Demands and Supplies

<table>
<thead>
<tr>
<th>Demands and Supplies</th>
<th>Customer Class/ Customer/ Site</th>
<th>Quantities</th>
</tr>
</thead>
<tbody>
<tr>
<td>Demand Sales Order</td>
<td>Computer Industry/ Dell/ Europe</td>
<td>20</td>
</tr>
<tr>
<td>Demand Sales Order</td>
<td>Computer Industry/ IBM/ Russia</td>
<td>10</td>
</tr>
<tr>
<td>Demand Sales Order</td>
<td>Computer Industry/ IBM/ China</td>
<td>5</td>
</tr>
<tr>
<td>Demand Sales Order</td>
<td>Computer Industry/ Dell/ Australia</td>
<td>10</td>
</tr>
<tr>
<td>Supply Purchase Order</td>
<td>n/a</td>
<td>100</td>
</tr>
</tbody>
</table>

Before allocation, the total supply is 100, and the total demand is 45. Thus, the available to promise would be 55.

Using the allocation rules, the picture looks as shown in the following table. The table displays the sites, actual allocation percentages, supply allocated to the specific sites, the demand, and what is ATP for each site. This table only shows the ATP calculated using percentages. The priorities and stealing effects are described below the table.
Because there are a few sites with a negative availability, the priorities must be examined to see if the negative quantities can be resolved with stealing.

Because Computer Industry/ Dell/ Europe has a higher priority than Computer Industry/ Dell/ Asia, the -6 ATP can be resolved by making the availability for Computer Industry/ Dell/ Asia to be 1.

Because Dell has a higher priority than IBM, then the -3 availability in Dell/ Other can be resolved by stealing from IBM/ Russia. Thus, the availability for IBM/ Russia would now be 1.

Notice, that stealing can happen between sites within a customer and sites among different customers. First, if a negative quantity needs to be resolved, ATP looks at the sites within the same customer to see if the demand can be met. Otherwise, if the customers have different priority, then stealing can happen among customers if necessary.

### Notes

**Product Dependency**
Oracle Global Order Promising, Oracle Advanced Supply Chain Planning, and Oracle Workflow are required.
Resource Allocation
Resource allocation is only considered during Multilevel ATP check when Global Order Promising performs a resource availability check.
Demand Class ATP

This section provides a detailed discussion on how to use Demand Class ATP.

Demand Class ATP Feature Description

Demand Class ATP enables you to perform availability checks by demand class. The availability calculation only considers the supply in a master schedule with the same demand class as that on the ATP request.

Demand Class ATP Business Application

This feature is useful when you want to use a known statement of supply of independent items for a specific sales channel for order promising. For example, your sales channels may be countries. You know how much supply you would give to each country. Aggregate demand from customers in a country cannot exceed supply allocated to that country. You can use demand class to represent the country and state the supply for each country using a specific MPS. Global Order Promising honors the MPS and will only promise demand based on the demand class MPS.

Demand Class ATP Setup Steps

Item Attributes

There are two item attributes: Check ATP and Component ATP.

The Check ATP flag lets you control whether to perform ATP check for that item. Component ATP flag lets you control whether to check component availability and/or resource availability.

For Check ATP attribute, the choices are:

- Material only - Check material availability for this item at this level
- None - No need to check ATP at this level

Since Demand Class ATP usage is only meaningful when you want to use a specific statement of supply for independent items, Component ATP attribute should be set to None.

ATP Rule

You need to check the Demand Class field in the ATP rule. Assign the ATP rule to an item or an organization.
Demand Class ATP restricts the supply and demand to sources with a specified demand class. A demand class ATP rule cannot include on-hand quantity, purchase orders, supplier requisitions, internal requisitions, or intransit shipments as sources of supply.

Please see Other ATP Functions on page 16-60 for more information on how to use each of these options to best meet your needs.

**Demand Class MPS**

You need to define an MPS for each demand class for which you will perform Demand Class ATP. You need to create entries for each of the demand class MPS.

**Profiles**

In order to use Demand Class ATP, set the following profiles:

- INV: Capable to Promise: You can choose Enable PL/SQL Based ATP Without Planning Output, or Enable PL/SQL Based ATP With Planning Output.
- MSC: Enable Allocated ATP: Set this to No.
- MSC: Enable Allocated Workflow: Set this to No.

**Demand Class ATP versus Allocated ATP**

Demand Class ATP capability exists in 10.7. It lets you promise orders by sales channels through the use of demand class. Users will use specific MPS for each demand class and populate the MPS’s with a statement of supply for that demand class. Global Order Promising uses the demand class MPS to calculate the available supply against the demand with the same demand class. The mechanism is simple and may work well in an environment where demand does not fluctuate much and supply is relatively fixed.

Allocated ATP is a new feature in R11i. It provides the same capability as Demand Class ATP; that is, to ensure some level of supply for your designated sales channels. However the feature is much more powerful and the implementation is more flexible. It differs from Demand Class ATP in the following ways:

- Allocated ATP allows you to designate sales channel by demand class, or customer class/customer/ship-to site hierarchy. Demand Class ATP lets you designate sales channel by demand class only.
- Allocated ATP allows you to define time-phased allocated rules that designate a percentage of your total supply to each of the sales channel. The allocation
Demand Class ATP

Rule is applied to your production MPS or MRP plan during order promising. Demand Class ATP requires you to maintain a specific MPS for each demand class and uses that as statement of supply during order promising. You need to synchronize the demand class MPS’s and the production MPS.

- Allocated ATP performs a capable-to-promise check when demand exceeds allocation. Demand Class ATP cannot.
- Allocated ATP provides automatic stealing from lower ranked sales channels. Demand Class ATP requires you to resolve the shortage by manually adjusting the demand class MPS.

Demand Class ATP Data Collection

Data Collection allows you to collect transactional data from multiple instances or different application systems into a common data store for global order promising and supply chain planning. It collects various data entities such as item, bills of material, customers, forecasts, and sourcing rules as well as transactional data such as purchase orders, miscellaneous receipts, inventory transfers, etc.

In general, if you create new entities, you need to run full (complete refresh) data collection. If you modify an existing entity, such as changing an item attribute, or you have new transactional data, you can run net-change (incremental) collection to refresh the data.

ATP Inquiry

You can perform Demand Class ATP either from Order Management or Advanced Supply Chain Planning.

Demand Class ATP From Order Management

When you enter a customer on a sales order, by default, Order Management places the demand class that is associated with the customer or customer ship-to address on the sales order header or line. You can also manually enter the demand class. When you perform ATP inquiry, Order Management passes the customer, demand class and other information to ATP. ATP finds an MPS of the same demand class and check availability using that MPS.

Demand ATP From Advanced Supply Chain Planning

You can use the ATP Inquiry window to perform a Demand Class ATP. Along with other criteria you enter in the window, you must enter a demand class. ATP finds an MPS of the same demand class and checks availability using that MPS.
ATP Logic for Demand Class ATP

An ATP request is processed by the system as follows:

1. The ATP Rule (either item level or org level) is checked to see if Demand Class ATP needs to be done.
2. If Demand Class ATP is enabled on the ATP rule, the system checks for a plan having the same demand class as the demand class on the ATP request.
3. In case no demand-class specific plan is found, the generic plan with no demand class is used.

**Note:** If Allocated ATP is enabled, ATP uses the generic plan with no demand class.
Other ATP Functions

Time fence options, computation options, and supply/demand are general ATP concepts. However, depending on whether you use ODS or PDS, you set them up in different places and sometimes not to the same granularity.

### Time Fence Options

The time fence options are specified inside an ATP rule. Not all options are applicable to PDS-based ATP.

#### Past-due demand days

ATP does not include any demand orders with a due date before this time fence. The ATP process considers all demand from the beginning of the past-due demand time fence to the current date as demand for the current date.

This is not used for PDS-based ATP. PDS-based ATP considers all past due demand.

#### Past-due supply days

ATP does not include any supply orders with a due date before this time fence. The ATP process considers all supply from the beginning of the past-due supply time fence date to the current date as supply for the current date.

This is not used for PDS-based ATP. PDS-based ATP considers all past due demand.

#### Infinite Supply Time Fence

This time fence is used to specify the end of your ATP horizon. ATP considers any demand that falls beyond this time fence as available. There are four options:

- **Cumulative total lead time**: The total lead time of an assembly plus the largest adjusted cumulative total lead time of its components.

- **Cumulative manufacturing lead time**: The manufacturing lead time of an assembly plus the largest adjusted cumulative manufacturing lead time of its components.

- **Total lead time**: The sum of the preprocessing, processing, and postprocessing lead times of the item.

- **User-defined time fence**: The lead time that you specify in the Days field.
This option is applicable to both ODS- and PDS-based ATP. In the case of PDS-based ATP, the plan end date is used as the infinite supply time fence if ATP does not find this specified.

**Computation Options**

All options are applicable to ODS- and PDS-based ATP.

**Forward Consumption of Shortage**

You can calculate ATP information by using a surplus quantity of an item from future ATP periods to cover an earlier-period shortage. If the period ATP is negative, you can go forward through the supply periods, one at a time, and subtract the shortage from the available quantity. You can keep going forward until the shortage disappears or until you run out of periods.

Note that forward consumption has not been enabled yet for Allocated ATP.

**Backward Consumption of Shortage**

You can calculate ATP information by using a surplus quantity of an item from prior ATP periods to cover a period shortage. If the period ATP is negative, you can go backward through the supply periods, one at a time, and subtract the shortage from the available quantity. You can keep going backward until the shortage disappears or until you run out of periods.

**Accumulate Available**

Global Order Promising assumes infinite accumulation.

**Supply and Demand**

When you use ATP based on the ODS, then supply and demand are specified in the ATP rules. When you use ATP based on the PDS, then supply and demand are specified within a plan.

**ODS: Supply**

You can control which sources are chosen for consideration for the availability requests.

The possible supply sources are: discrete MPS, repetitive MPS, discrete WIP, repetitive WIP, available QOH, non-standard WIP, internal requisitions, vendor requisitions, purchase orders, in-transit shipments, and user-defined supply.
You can use the on-hand available check box to choose whether to include the available on-hand quantity as a source of supply. Typical make-to-order and assemble-to-order manufacturing environments do not use the available on-hand quantity as a source of supply.

Oracle Inventory designates a supply period as beginning on a scheduled supply date and ending the day before the next scheduled supply date. A supply period can cover several days or be a minimum of one day in duration. If supply occurs on a nonworkday, the ATP calculation considers that supply as belonging to the next workday. If multiple supply events occur on the same day, the ATP process sums the supplies.

**ODS: Demand**

The possible demand sources are: sales orders, internal orders, discrete WIP demand, repetitive WIP demand, nonstandard WIP, flow schedules demand, and user-defined demand.

ATP demand is the sum of all demand quantities occurring within the supply period. If demand occurs on a nonworkday, the ATP calculation considers that demand as belonging to the next workday. If multiple demand events occur on the same day, the ATP process sums the demands.

If you select ATP by Demand Class, the ATP calculation looks only at the supply and demand for a particular demand class. The demand class feature enables you to forecast, plan, and promise based on subdivisions of your demand. For example, a demand class might represent a large customer or group of related customers. When the ATP by Demand Class check box is selected, ATP only considers the following sources of supply: discrete MPS, repetitive MPS, discrete WIP, repetitive WIP, and nonstandard WIP.

**PDS: Supply & Demand**

When using ATP based on PDS, then the inquiries are based on the plan outputs. Thus, ATP rules are not used. For each of these plans, you can specify the supply and demand schedules to be included. Furthermore, for each organization that is included in each plan, you can specify whether to include the following options: net WIP, net reservations, net purchasing, plan safety stock, and sales orders.

The supply and demand are specified in the plan options of the plans that you are running.
Component Substitution

ATP supports the use of substitute components if the primary component is not available. If sufficient quantity of primary component is not available, the ATP searches for substitute components.

Many substitutes are possible for a primary item. In this case, the sequence of search for substitutes is determined by substitute priority, which is a flex field in the Bills of Material.

ATP splits demand among the primary and substitute components. For example,

- Demand for 10 comes for item A
- Item A has Item B as a component
- Item B has two substitutes: B1 and B2
- Item B has 2 available, B1 has 4 available, and B2 has 20 available

Then, the ATP results will return, 2 for Item B, 4 for B1, and 4 for B2. It will not just return 10 for B2.

Consider the BOM (shown below) where A is made up of component B. B can be substituted by B(1) whenever B does not exist.

```
A

B--------B(1)

C
```

Oracle Global Order Promising searches for substitute components before doing a multilevel search. If there is not sufficient quantity of A to meet the requirement at a given date, the quantity for B is checked. If that is also not enough, the substitute B(1) is considered. If that is also not sufficient, C which is the component of B is considered.

Oracle Global Order Promising does not search for the components of B(1), which is the substitute for B.
Even after the inclusion of B(1) and C, the demand is not satisfied. Then Oracle Global Order Promising searches forward in date to suggest the earliest date when the complete quantity will be available.

The substitute quantity available on the request date is considered in the forward case, but the schedule receipts are not considered.

**MRP: Include Substitute Components**

This site level profile must be enabled in order to consider substitute items in the ATP inquiry.

**Using Multiple Plans**

If you use planning output for ATP, then ATP supports the inclusion of multiple plans. To include multiple plans, check the Inventory ATP box for all the plans that ATP needs to use in the plan options form.

As ATP moves in its search, it chooses a plan for each item. Each move in a search could be down one level in the BOM in a multilevel search or across the supply-chain as per the assignment set. The plan that is picked must be a successfully run plan, and should have a unique combination among item, organization, instance and demand class. If there are multiple occurrences of this set, the plan which has the lowest plan identification number is picked.

There may be situations where one plan is used as the source for another plan. For example, an MPS plan is the source for an MRP run. In this case, ATP searches for the real plan using the item attribute in-source plan.
ATP Inquiry

This section provides a detailed explanation on how to use the ATP Inquiry window.

You can view the available quantity for the date you requested. You can view the request date available to promise quantity, or the earliest date beyond the requested date that the request quantity is available. For PDS you can view the pegging tree and a time-phased view of material and resource availabilities.

ATP Criteria

ATP criteria lets you enter parameters for the desired ATP check.

To enter ATP criteria:

1. Choose ATP > ATP Inquiry.

   The ATP Criteria window displays.

Figure 16–4  ATP Criteria

![ATP Criteria Window](image)
2. Complete the following fields and options in this window. Not all of these fields are required.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pick Sources</td>
<td>Choose Yes to manually specify the sources for the order promising inquiry. Choose No to let Oracle Global Order Promising return the best sources based on your supply chain’s sourcing rules, bills of distribution, and assignment sets.</td>
</tr>
<tr>
<td>ATP Type</td>
<td>Choose from Ship Set or Arrival Set or [Blank]</td>
</tr>
<tr>
<td>Customer</td>
<td>Enter the customer name</td>
</tr>
<tr>
<td>Site</td>
<td>Enter the customer site</td>
</tr>
<tr>
<td>Request Date</td>
<td>Choose Ship Date or Arrival Date</td>
</tr>
<tr>
<td>Assignment Set</td>
<td>The assignment (view-only)</td>
</tr>
<tr>
<td>Demand Class</td>
<td>Choose the demand class from a list of values.</td>
</tr>
<tr>
<td>Org</td>
<td>Specify the organization(s) to consider in the order promising calculation.</td>
</tr>
<tr>
<td>Item</td>
<td>Specify the items to consider in the order promising calculation.</td>
</tr>
<tr>
<td>ATP Rule</td>
<td>If the order promising calculation is based on ODS, the ATP rule appears.</td>
</tr>
<tr>
<td>UOM</td>
<td>Enter the unit of measure.</td>
</tr>
<tr>
<td>Qty</td>
<td>Enter the quantity.</td>
</tr>
<tr>
<td>Req Date</td>
<td>Enter the request date.</td>
</tr>
</tbody>
</table>

3. Click the ATP Results button.

The ATP Workbench window displays ATP results and the pegging tree.

**Note:** This window displays the available to promise quantity for the specified date and the date by which the full quantity will be available.
The pegging tree shows how demand is being met. Red bullets on the window indicate demand; green bullets indicate supply.

4. Select a line of the pegging tree.

5. Click the Details button

The ATP Detail window appears.
**Figure 16–6  ATP Detail window (Supply and Demand tab)**

This window shows supply and demand for the selected line of the pegging tree.

6. Choose the Horizontal ATP tab.
This tab shows material availability details in a horizontal time scale. It shows total demand, total supply, net available to promise, and cumulative available to promise.
Using Global ATP Server from Non-Oracle Applications

Using Global ATP Server from Non-Oracle Applications

The Global ATP server can be used from non-Oracle applications, yet the following points should be noted.

API
The ATP API is a public API that can be used to determine availability. The API will process an item or a group of items and determine material and resource availability across the supply chain. The API is a set of stored PL/SQL procedures and functions. The name of the API is Call_ATP and it can be found in the package MRP_ATP_PUB.

ATP Inquiry
ATP inquiry is performed from the third-party application.

ATP Scheduling
Third-party applications can also call ATP APIs to perform sales order scheduling.

Collecting Data
Customers can place their transactional data into the staging tables, and then Data Collection can pick up the data from those tables.

For more information on Data Collection, please refer to Oracle Advanced Supply Chain Planning Technical Reference Manual.
The following topics are covered in this section:

- Overview of Oracle Risk Optimization on page 17-2
- Defining a Plan on page 17-6
- Setting Plan Options on page 17-11
- Viewing Output on page 17-44
- Reviewing Exception Messages on page 17-52

A Day in the Life of a Planner
Overview of Oracle Risk Optimization

Oracle® Risk Optimization enables you to optimize your strategic inventory investment decisions by helping you to identify optimal inventory stocking levels, order quantities, order frequency, and other operational policies given a set of requirements and objectives.

Oracle’s exclusive stochastic optimization technology is a revolutionary breakthrough in optimization technique that helps you manage the uncertainty inherent in your business decisions. Stochastic optimization techniques let you:

- Manage variability and risk
- Evaluate cost and risk tradeoffs
- Consider uncertainty in demand and supply
- See a graphic representation of your strategic inventory plan
- Plan telescoping time horizons
- Provide accurate inputs to tactical plans
- Manage to key performance indicators and drive continuous improvement
- Improve customer service while lowering inventory investment

Business Process

The following diagram describes the business process flow for Oracle Risk Optimization:
Key Inventory Decisions

Service Level Decision Factors

The following sections describe the key inventory decisions:

Service Level Cost Trade-off Decision

The service level cost trade-off decision considers the expected costs of inventory stockouts and backorders associated with poor customer service. These costs are weighed against the expected costs of maintaining high safety stock inventories and expedited purchasing, production, and distribution costs associated with high customer service levels.
Safety Stock Decision Factors
Since the purpose of safety stock is to buffer uncertainty, safety stock investment should be placed where there is uncertainty. In many cases, the degree of variability of supply and demand changes over time.

Inventory Location Decision Factors
This decision involves a trade-off between delivery time and flexibility. When safety stock is distributed to be closer to customers, delivery time is decreased. However, greater flexibility is provided when safety stock is stored in a single central location.

When safety stock is stored in the form of finished goods, the lead time for those finished goods is decreased. However, the components and materials used in making those finished goods are committed, and cannot be used to satisfy unexpected demand for other items. Greater flexibility is provided when safety stock is stored at the raw material or component level.

Input
Oracle Risk Optimization takes the following information as input:

- Demands uncertainty scenarios and their associated probabilities.
- Customer service level requirement for each independent demand. If the customer service level is specified at a higher level of granularity (e.g. customer), the service level value will apply to all independent demands for that customer.
- Supplier lead time variation scenarios and their associated probabilities.
- Supply chain network in the form of sourcing rules and bill of distribution.
- List of items to be included.
- Bills of material, including effectivity and item substitution.
- Routings and key resources for items.
- Capacity constraints in the form of supplier capacity, transportation capacity, and resource availability or line rates.
- Cost elements, including production cost, item cost, carrying cost percentages, purchase cost, transportation cost, and resource cost.

You will be able to establish the following instances as eligible source instances for Oracle Risk Optimization data:
Overview of Oracle Risk Optimization

- Oracle Applications R10.7
- Oracle Applications R11 (Discrete or Process Manufacturing)
- Oracle Applications R11i (Discrete or Process Manufacturing)

Output

The output of Oracle Risk Optimization is a time-phased strategic inventory plan and material budget. More specifically, output includes the following:

- Time-phased constrained and unconstrained safety stock levels and order quantities for each stockkeeping unit (SKU). The time-phased constrained safety stock quantities can be specified as input to Oracle ASCP in the form of demand plan(s).
- Recommended service level obtained for each SKU in each bucket.
- BIS key performance indicators.
- Exception messages and recommendations (for postponement, for example)
- Total cost of achieving the target customer service level and the individual cost elements that make up the total cost.

BIS Key Performance Indicators

Oracle Risk Optimization is integrated with Oracle Business Intelligence’s performance management system. Oracle Business Intelligence lets you set the organizational objectives.

KPIs are used to drive continuous improvement in your enterprise. You can set performance targets and exception tolerances by business units (an organization, for example) or by period and automatically notify the appropriate people when exceptions arise.

Using the Planner Workbench, you can run multiple simulations, comparing them to your own performance metrics. As you firm a plan, you can directly update performance metrics in the execution system.

**Note:** These objectives, known as Performance Measures in the Oracle Business Intelligence System (BIS), are referred to as Key Performance Indicators (KPIs) in Oracle Risk Optimization.
Defining a Plan

This section describes features that help you select a plan that best satisfies your business requirements. You can choose to run a global inventory plan or a subset plan to suit your supply chain environment or single organization environment, respectively. You can optimize your plan based on business objectives such as maximizing inventory turns, ontime delivery, and plan profit. Lastly, you can specify aggregation levels to view plans at varying levels of detail.

Global Inventory Planning and Subset Planning

Oracle Risk Optimization enables you to create material and capacity plans for single organizations or multiple organizations. Global inventory planning refers to planning across multiple organizations while subset planning refers to single organization planning.

Choosing Between Global Inventory and Subset Plans

In general, resource and material capacity are most efficiently utilized in a global inventory planning environment where planning distributes production requirements across multiple organizations. However, the choice of global supply chain versus subset planning should depend on a number of factors including:

- **Physical proximity of the organizations being planned** – If planned organizations are geographically dispersed, it is generally more difficult to fulfill demand in one region from a plant or distribution center far away because of transportation costs and longer lead times. Note, however, that the costs associated with fulfilling demand from remote plants can be modeled in planning. Planning can then optimize production allocation across plants to meet the objectives that have been set.

- **Commonality of the items produced** – If you have multiple organizations that produce or distribute similar products, global inventory planning is beneficial because planning can consider factors like material and resource availability, material costs, and resource costs to create an optimal supply chain plan.

- **Commonality of the supply base** – Similar to producing common items, organizations sharing suppliers are good candidates for global inventory planning because supply can be optimally distributed across plants depending on each plan’s production requirements. Global inventory planning will ensure that supplier capacity is most effectively used to meet end customer demand and to minimize inventory.
- **Linkage among plants** – If production at one plant must be coordinated with production at other plants, global inventory planning should be used. For example, if Plant A provides subassemblies to Plant B (Plant A is a feeder plant), both plants should be planned together.

- **Corporate structure** – The internal organizational structure of a corporation is also a major determinate of the planning method used. If there are clear organizational boundaries between divisions, global inventory planning is difficult to implement.

The table below summarizes the factors to consider when deciding whether to run a global supply chain or subset plan.

<table>
<thead>
<tr>
<th>Factor</th>
<th>Global Inventory Planning</th>
<th>Subset Planning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Physical proximity</td>
<td>Close Physical Proximity</td>
<td>Distant Physical Proximity</td>
</tr>
<tr>
<td>Commonality of items produced</td>
<td>High Commonality</td>
<td>Low Commonality</td>
</tr>
<tr>
<td>Commonality of supply base</td>
<td>High Commonality</td>
<td>Low Commonality</td>
</tr>
<tr>
<td>Linkage among plants</td>
<td>Tight Linkage Among Plants</td>
<td>Loose Linkage Among Plants</td>
</tr>
<tr>
<td>Corporate structure</td>
<td>Centralized Corporate Structure</td>
<td>Decentralized Corporate Structure</td>
</tr>
</tbody>
</table>

**Running an Inventory Plan**

To run an inventory plan, the following prerequisites are required:

- Each planned organization must be set up on the source instance.

- Collection programs must be directed to collect data from the transactional instance of each planned organization.

- Items to be planned must be enabled in each organization that can produce (or distribute) the item. During item setup, items can be enabled in all organizations or only in specific organizations.

- Routings and/or Bills of Resource for each planned item must exist or be enabled in each organization that are planned centrally.

- Suppliers and sourcing rules must be enabled in all relevant organizations.

**To create and launch an inventory plan:**


   The IP Names window appears.
2. In the Organization Selection fields, specify if all or multiple organizations are planned.

3. Click the Options button.
   The Options tab of the Plan Options window appears.

4. Continue setting plan options and parameters.
Figure 17–2  The Options tab

For more information, see “The Options Tab” on page 5-18 and the Oracle Master Scheduling/MRP and Oracle Supply Chain Planning User’s Guide.

Note: Only selected organizations are planned, regardless of whether planned items, routings, and so on, have been enabled in other organizations.

5. Click the Launch button.
   The Launch Parameters window appears.

6. Verify launch parameters and click OK button to launch the plan.

Setting Global Supply Chain vs. Subset Planning Parameters
You can choose the way you deploy Oracle Risk Optimization to support either global supply chain or subset planning strategies. You can run one rapid single step supply chain plan that optimizes and plans your entire virtual enterprise. You can also choose to break the planning process into subsets. For example, you may
choose to run an enterprise-wide high level plan, but plan manufacturing at the individual factory level. You can plan all, or any subset of your virtual enterprise in a single planning process. This reduces the number of plans and reduces the time and effort required to coordinate planning activities.

If you have a single instance of Oracle Applications, or if you prefer to pursue a strategy of subset planning, Oracle Risk Optimization can be deployed as a module of an integrated Oracle Applications instance.
Setting Plan Options

This section describes how to set plan options. The plan option types are as follows:

- Options
- Aggregation
- Optimization
- Organizations

The Options Tab

To access the Options tab:
1. Navigate to the Planner Workbench.
2. Choose Plan Options > Options tab.
   The Options tab displays.

Figure 17–3 The Options tab
You can specify the fields and options shown in the following table:

<table>
<thead>
<tr>
<th>Object</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assignment Set</td>
<td>The assignment set for your plan created within your organization.</td>
</tr>
<tr>
<td>Org Selection</td>
<td>Based on all or a subset of organizations. This is a view-only field, determined by the value entered in the Names window.</td>
</tr>
<tr>
<td>Overwrite</td>
<td>List of values.</td>
</tr>
<tr>
<td>Enforce Service Level Constraints</td>
<td>This option will enforce the service level specified at the most detailed level. Material and resource capacity will be exceeded beyond its availability if necessary.</td>
</tr>
<tr>
<td>Enforce Demand Due Dates</td>
<td>This option will enforce a 100% service level on all demands in the plan. Material and resource capacity will be exceeded beyond its availability if necessary. For more information, see “Setting Hard and Soft Constraints” in “Constraint Based Planning.”</td>
</tr>
<tr>
<td>Enforce Capacity Constraints</td>
<td>This option will enforce material and resource capacity constraints in the plan. The maximum service level possible will be output by the system.</td>
</tr>
<tr>
<td>Planned Items</td>
<td>Choose planned items from the list of values.</td>
</tr>
<tr>
<td>Planned Resources</td>
<td>Choose all resources or bottleneck resources. If selecting bottleneck resources, you must first specify a Bottleneck Resource Group. (See Bottleneck Resource Group, below.)</td>
</tr>
<tr>
<td>Bottleneck Resource Group</td>
<td>If you have defined bottleneck resource groups in Oracle Bills of Material and you want to plan only those groups, designate them here.</td>
</tr>
</tbody>
</table>

**The Aggregation Tab**

>To access the Aggregation tab:
1. Navigate to the Planner Workbench.
2. Choose Plan Options > Aggregation tab.
The Aggregation tab displays.

Figure 17–4  The Aggregation tab

You can specify the fields and options shown in the following table:

<table>
<thead>
<tr>
<th>Object</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Date/End Date</td>
<td>Based on the length of the planning horizon. You cannot specify either of these dates.</td>
</tr>
<tr>
<td>Bucket Size</td>
<td>Specify bucket size in days, weeks, and periods.</td>
</tr>
<tr>
<td>Items</td>
<td>Choose aggregation at item level or product family level.</td>
</tr>
<tr>
<td>Resources</td>
<td>Choose resource aggregation at individual level or aggregate level.</td>
</tr>
<tr>
<td>Routings</td>
<td>Choose aggregation level at individual routing or bill of resources level.</td>
</tr>
<tr>
<td>Plan Capacity</td>
<td>Specify whether constraints are used.</td>
</tr>
<tr>
<td>Resource Constraints</td>
<td>Select Yes to consider resource constraints.</td>
</tr>
<tr>
<td>Material Constraints</td>
<td>Select Yes to consider material constraints.</td>
</tr>
</tbody>
</table>
The Optimization Tab

To access the Optimization tab:
1. Navigate to the Planner Workbench.
2. Choose Plan Options > Optimization tab.

The Optimization tab displays.

Figure 17–5  The Optimization tab

You can specify the fields and options shown in the following table:

<table>
<thead>
<tr>
<th>Objective</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Objective: Maximize Inventory Turns</td>
<td>Specify a weighting percentage for this objective using the sliding bar or by entering a value between 0 and 1.</td>
</tr>
<tr>
<td>Objective: Maximize Plan Profit</td>
<td>Specify a weighting percentage for this objective using the sliding bar or by entering a value between 0 and 1.</td>
</tr>
<tr>
<td>Objective: Maximize On-time Delivery</td>
<td>Specify a weighting percentage for this objective using the sliding bar or by entering a value between 0 and 1.</td>
</tr>
</tbody>
</table>
The Organizations Tab

To access the Organizations tab:
1. Navigate to the Planner Workbench.
2. Choose Plan Options > Organizations tab.
The Organizations tab displays.

Figure 17–6  The Organizations tab

You can specify the fields and options shown in the following table:

<table>
<thead>
<tr>
<th>Object</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Org</td>
<td>Your plan’s organization. See on page 17-6, Global Inventory Planning and Subset Planning.</td>
</tr>
<tr>
<td>Description</td>
<td>The name of your organization.</td>
</tr>
<tr>
<td>Net WIP</td>
<td>Select to consider Net WIP.</td>
</tr>
<tr>
<td>Net Reservations</td>
<td>Select to consider Net Reservation.</td>
</tr>
<tr>
<td>Net Purchasing</td>
<td>Select to consider Net Purchasing.</td>
</tr>
<tr>
<td>Bill of Resource</td>
<td>Select Bill of Resources from the list of values.</td>
</tr>
<tr>
<td>Simulation Set</td>
<td>Select Simulation Set from the list of values.</td>
</tr>
<tr>
<td>Demand Schedules</td>
<td>Select the name of your demand schedule.</td>
</tr>
<tr>
<td>Probability</td>
<td>Assign probabilities for forecast sets.</td>
</tr>
</tbody>
</table>
**Using an Existing Plan as a Supply Schedule for a New Plan**

The plan for one organization can be used as a supply source (or supply schedule) for the plan of another organization.

1. Choose [Inventory Plan] > Names to create a new inventory plan for the organization that will use an existing plan as a source.
2. Choose Plan Options > Organizations.
3. Specify the plan name to be used as a source for the new plan in the Supply Schedule portion of the form.

**Using an Existing Plan as a Demand Schedule For a New Plan**

The plan for one organization can be used as a demand source (or demand schedule) for the plan of another organization.

1. Choose [Inventory Plan] > Names to create a new inventory plan for the organization that will use an existing plan as a source.
2. Choose Plan Options > Organizations.
3. Specify the plan name to be used as a source for the new plan in the Demand Schedule portion of the form.

**Setting Demand Variability**

You can specify demand variability as a discrete distribution. The Plan Options window has a new field that let you specify probability for a given forecast set. Forecast sets are grouped together in scenario sets by using the scenario set field.

<table>
<thead>
<tr>
<th>Object</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supply Schedules</td>
<td>Select the name of your supply schedule for each organization.</td>
</tr>
</tbody>
</table>

**Note:** Scenario sets are planned separately.

1. Choose Plan Options > Organizations tab.
The Organization tab appears.

**Figure 17–7  The Organizations tab**

2. In the Scenario Set field, enter the scenario set number.
3. In the Name field, enter the demand schedule name (forecast set or MDS).
4. In the Probability field, specify corresponding probabilities for forecast sets.

**Note:** One scenario set includes a list of one or more forecast sets. A forecast set includes a list of one or more forecasts. Use the Probability field to enter an estimate of probability that a particular forecast set within the scenario set will occur. For example, if a scenario set includes three forecasts sets named; Optimistic, Most likely, and Pessimistic, one could estimate the probability of the forecasts occurring as 0.15, 0.65, and 0.20, respectively.
The sum of probabilities of forecast sets in a scenario set can be more than 1. They are normalized to 1 within the Risk Optimization code. If a forecast set probability is not specified, a value of 1 is considered as default.

How Probability Data is Used by the System
The probability information is used in three ways:

- Probability acts like a weight in a normalization calculation.
- Normalized probabilities are used to calculate an expected value for forecast quantities.
- The distribution of the discrete probabilities is used to estimate variance, which is a factor in calculating safety stock quantity.

Safety stock is sized in proportion to the variance of forecast sets probability distributions.

The following table shows how the variance of forecast set probability distribution affects the size of the safety stock.

<table>
<thead>
<tr>
<th>Forecast Set</th>
<th>Prob. Dist A</th>
<th>Prob. Dist B</th>
</tr>
</thead>
<tbody>
<tr>
<td>FCSTA</td>
<td>0.182</td>
<td>0.100</td>
</tr>
<tr>
<td>FCSTB</td>
<td>0.364</td>
<td>0.800</td>
</tr>
<tr>
<td>FCSTC</td>
<td>0.454</td>
<td>0.100</td>
</tr>
</tbody>
</table>

All other relevant factors being equal, the safety stock quantity for a situation depicted by probability distribution B would be smaller than safety stock quantity for a situation depicted by probability distribution A, because the variance of probability distribution B is less than the variance of probability distribution A.

Weighted Average Calculation
The probabilities of forecast sets within one scenario set can be entered so that they total more than 1. When this occurs, the probabilities are normalized within Risk Optimization code so that they do sum to 1. In the following table, probabilities of the forecast sets within scenario set 10 are 0.8, 0.4, and 1.0, respectively. Recall that

Note: Safety stock is not calculated if there is no demand and supply variability.
blank values default to 1.0. The sum of the probabilities is 2.2. Dividing the entered probabilities by the sum results in normalized probabilities 0.364, 0.182, and 0.454, respectively. The normalized probabilities sum to one.

<table>
<thead>
<tr>
<th>Scenario Set</th>
<th>Forecast Set</th>
<th>Probability (entered)</th>
<th>Probability (used)</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>FCST1</td>
<td>0.4</td>
<td>0.4/2.2 = 0.182</td>
</tr>
<tr>
<td>10</td>
<td>FCST2</td>
<td>0.8</td>
<td>0.8/2.2 = 0.364</td>
</tr>
<tr>
<td>10</td>
<td>FCST3</td>
<td>(blank)</td>
<td>1.0/2.2 = 0.454</td>
</tr>
</tbody>
</table>

### How to Assign Forecasts and Forecast Sets to Scenario Sets

The following tables present the relationships of forecasts, forecast sets, and scenario sets when specifying demand variability.

Forecasts and probability distributions for Item A are displayed in the following table:

<table>
<thead>
<tr>
<th>Time Period</th>
<th>Quantity</th>
<th>Probability</th>
</tr>
</thead>
<tbody>
<tr>
<td>D1</td>
<td>100</td>
<td>0.80</td>
</tr>
<tr>
<td>D1</td>
<td>90</td>
<td>0.07</td>
</tr>
<tr>
<td>D1</td>
<td>80</td>
<td>0.13</td>
</tr>
<tr>
<td>D2</td>
<td>200</td>
<td>0.80</td>
</tr>
<tr>
<td>D2</td>
<td>220</td>
<td>0.07</td>
</tr>
<tr>
<td>D2</td>
<td>210</td>
<td>0.13</td>
</tr>
<tr>
<td>D3</td>
<td>150</td>
<td>0.60</td>
</tr>
<tr>
<td>D3</td>
<td>120</td>
<td>0.30</td>
</tr>
<tr>
<td>D3</td>
<td>180</td>
<td>0.10</td>
</tr>
<tr>
<td>D4</td>
<td>180</td>
<td>0.60</td>
</tr>
<tr>
<td>D4</td>
<td>190</td>
<td>0.30</td>
</tr>
<tr>
<td>D4</td>
<td>120</td>
<td>0.10</td>
</tr>
</tbody>
</table>

Note that Item A has the same probability distribution for D1 and D2, and another distribution represents its demand for D3 and D4.
The scenario sets, forecast sets, and forecasts shown in the following tables should be defined to specify demand variability for item A:

<table>
<thead>
<tr>
<th>Item</th>
<th>Quantity</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>100</td>
<td>D1</td>
</tr>
<tr>
<td>A</td>
<td>200</td>
<td>D2</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Item</th>
<th>Quantity</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>90</td>
<td>D1</td>
</tr>
<tr>
<td>A</td>
<td>220</td>
<td>D2</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Item</th>
<th>Quantity</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>80</td>
<td>D1</td>
</tr>
<tr>
<td>A</td>
<td>210</td>
<td>D2</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Item</th>
<th>Quantity</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>150</td>
<td>D3</td>
</tr>
<tr>
<td>A</td>
<td>180</td>
<td>D4</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Item</th>
<th>Quantity</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>120</td>
<td>D3</td>
</tr>
<tr>
<td>A</td>
<td>190</td>
<td>D4</td>
</tr>
</tbody>
</table>
These forecast sets are tied to their corresponding probabilities and assigned to scenarios sets in the Organization Tab of the Plan Options form as shown in the following table:

<table>
<thead>
<tr>
<th>Scenario Set</th>
<th>Forecast Set</th>
<th>Probability</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>FCST1</td>
<td>0.80</td>
</tr>
<tr>
<td>10</td>
<td>FCST2</td>
<td>0.07</td>
</tr>
<tr>
<td>10</td>
<td>FCST3</td>
<td>0.13</td>
</tr>
<tr>
<td>20</td>
<td>FCST4</td>
<td>0.60</td>
</tr>
<tr>
<td>20</td>
<td>FCST5</td>
<td>0.30</td>
</tr>
<tr>
<td>20</td>
<td>FCST6</td>
<td>0.10</td>
</tr>
</tbody>
</table>

If item B has the same probability distribution as item A, you can include item B in the above forecasts and forecast sets. If item B does not follow the same probability distributions, then separate forecast sets and forecasts should be defined for item B. In this case, item A and B cannot share the same scenario sets either.

**Set Supplier Lead Time Variability**

You can specify supplier lead time variability either at the item-supplier level or at the supplier level. If variability information is defined at the item-supplier level, it will be used by the optimization engine. Otherwise, the engine will use variability information defined at the supplier level.

Define supplier lead time variability in the Item Supplier Variability window.

**Note:** You can only input supplier lead time variability information in the planning server.
To set supplier lead time variability:
1. Navigate to the Planner Workbench.
2. Choose Supplier from the drop down menu in the left pane.
3. Drill down to and select an item underneath a supplier in the left plane.
   The Supplier Variability window appears.

![Figure 17–8  The Supplier Variability window](image)

5. Use the information in the following table to complete the fields in this window (all other fields are populated automatically).

<table>
<thead>
<tr>
<th>Object</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Days Late</td>
<td>The number of days in whole numbers the item is delivered late. Days Late can be measured in negative whole numbers, indicating early delivery.</td>
</tr>
<tr>
<td>Probability</td>
<td>The probability expressed as number between 0 and 1 corresponding to each estimation of days late for the item. The probabilities should sum to equal 1.0.</td>
</tr>
</tbody>
</table>
Selecting Planned Items

Oracle Risk Optimization calculates safety stock quantities only for those items whose safety stock planning method is set to MRP planned. Safety stock quantities are not calculated for items whose safety stock planning method is set to Non-MRP planned. However, time-phased planned order quantities are calculated for all items in the plan.

To specify items to be included in the inventory plan:

1. Navigate to the Planner Workbench.
2. Choose Plan Options > Options tab.
   - The Options tab displays.
3. Choose an associated ABC classification for the plan from the Planned Items drop down menu.

If you input an inventory plan as a demand schedule for Oracle ASCP, the safety stock quantities in the inventory plan are used instead of safety stock percent and bucket days in Oracle ASCP.
Constraint-based planning is an approach for balancing material and plant resources while meeting customer demand. It takes into account constraints at the enterprise and plant levels. Material and capacity issues are considered simultaneously, and factory, distribution, and transportation issues are integrated. This complete picture of the problem provides instant and global visibility to the effects of planning and scheduling decisions throughout the supply chain.

You can select one of the following three constraint options:

- **Enforce Demand Due Dates**
  
  Enforce a 100% service level on all demands in the plan. Material and resource capacity will be exceeded beyond their availability if necessary.

- **Enforce Service Level Constraints**
  
  This option enforces the service level specified at the most detailed level. In a simple example, if the plan level (global) service level is set to 95% and the service level for item AS12345 is set to 98%, the 98% service level is enforced for
item AS12345 and the 95% service level is enforced for all other aspects of the inventory plan. Material and production resources are utilized beyond available capacity constraints if necessary to attain the desired service levels.

- **Enforce Capacity Constraints**

  This option enforces material and resource capacity constraints throughout the plan. Service Level Key Performance Indicator (KPI) reports the achievable service level.

  For more information, see on page 11-12, “Setting Hard and Soft Constraints” in “Constraint Based Planning.”

To set Oracle Risk Optimization constraints choose one of the enforcement checkboxes in the Options tab.

*Figure 17–10  The Options Tab*
Setting Plan Options

Specifying Sources of Supply and Demand

**Specify Supply Types**
You can specify existing supply types (On-Hand, PO, WO, and so on) to be included or excluded.

To specify supply type:
1. Navigate to the Planner Workbench.
2. Choose Plan Options > Organizations tab.
   The Organizations tab appears.
3. Choose the appropriate checkbox for each source of supply.

**Demand Schedules**
You can specify a demand schedule or forecast set as input demand for an inventory plan.

To specify sources of demand:
1. Navigate to the Planner Workbench.
2. Choose Plan Options > Organization tab.
   The Organization tab appears.
3. Select the demand schedule (MDS or Forecast) from the list of values.

**Supply Schedules**

To specify sources of supply:
1. Navigate to the Planner Workbench.
2. Choose Plan Options > Organization tab.
   The Organization tab appears.
3. Select the supply schedule from the list of values.
Controlling Aggregation

Oracle Risk Optimization enables you to specify various types and levels of aggregation for time buckets, materials, resources, and routings in your inventory plan. Aggregation control lets you specify the level of detail desired for different time horizons within a plan. For example, you may want detailed planning of items and individual resources using routings in daily time increments for the short term portion of the plan. You may want aggregated scheduling at the product family level using aggregated resources and bills of resources in monthly time buckets for the long term portion of the plan.

Plan End Date

Forecast bucket and plan bucket granularity In the inventory plan, the forecast buckets and granularity (defined in the ERP system in the Forecast Entries window) and the planning granularity (defined in the Plan Options window) should be aligned correctly. This means that the start date and end date for each forecast entry should match the start date and end date for each planning bucket respectively.

The Plan End Date is calculated based on the length of the planning horizon defined by the specified bucket sizes in the Aggregation tab.

To view the end date for your inventory plan:
1. Navigate to the Planner Workbench.
2. Choose Plan Options > Aggregation tab.
   The Aggregation tab appears showing the end date for your inventory plan.
Setting Plan Options

Figure 17–12 The Aggregation Tab

Specifying Material Aggregation Levels
You can specify material aggregation levels for each of the three planning time horizons.

To set the material aggregation level for a time horizon:
1. Navigate to the Planner Workbench.
2. Choose Plan Options > Aggregation tab.

Note: The start date is hard coded as the sysdate.
The Aggregation tab appears.

**Figure 17–13  The Aggregation tab**

3. Enter the time horizon in days, weeks, or periods.

You can specify different levels of aggregation in different time buckets so that detailed information is considered more frequently and less detailed information is considered less frequently.

You can plan the product at either the item level or the product family level.

Ensure items are correctly assigned to a product family and that a planning percent is specified when setting up your BOMs.

**Specifying Resource Aggregation Levels**

You can specify resource aggregation levels for each of the three planning time horizons.

**To set the resource aggregation levels for a time horizon:**

1. Navigate to the Planner Workbench.
1. Choose Plan Options > Aggregation tab.

2. Enter the time horizon in days, weeks, or periods.

   You can specify different levels of aggregation in different time buckets so that
detailed information is considered more frequently and less detailed
information is considered less frequently.

Resources can be planned either individually or in aggregate. Selecting Individual
resource planning will generate plans down to the individual resource level and
will consider the available capacity of each resource in the plan recommendations.

Selecting Aggregate resource scheduling will consider the overall capacity of all
resources in a resource group required for an item. For example, the overall
capacity of a department to which the individual resources are assigned are used.

For more information, see “Defining a Resource” in the Oracle Bill of Materials User’s
Guide.

**Specifying Routing Aggregation Levels**

You can specify routing aggregation levels for each of the three planning
time horizons.

**To set the routing aggregation level for a time horizon:**

1. Navigate to the Planner Workbench.

2. Choose Plan Options > Aggregation tab.

   Enter the time horizon in days, weeks, or periods.

   You can specify different levels of aggregation in different time buckets so that
detailed information is considered more frequently and less detailed
information is considered less frequently.

Either routings or bills of resources can be used for inventory planning. Selecting
routing level aggregation will result in plans that consider the capacity of each
resource and the sequencing of the resources during the production of an item.
Selecting BOR level aggregation will only consider the resource requirements
needed to produce an item without considering the sequencing and
interdependence among the resources required for an item.

You can set aggregation levels for modeling items, resources, alternates and
routings in your inventory plan. You can specify different levels of aggregation in
different time buckets so that detailed information is considered more frequently
and less detailed information is considered less frequently.
Specifying Plan Objectives

Multiple optimization objectives can be met by assigning weights to each. This is done using the Optimization tab, assigning weights to each optimization objective.

For more information on the Optimization tab, see on page 17-14, “The Optimization Tab.”

Following are descriptions of the various optimization objectives:

**Maximize Inventory Turns** This objective is achieved by minimizing the total inventory for the plan duration.

**Maximize Plan Profit** The following factors are considered:

- Revenue from independent demands
- Item cost
- Resource cost
Setting Plan Options

- Inventory carrying cost
- Transportation cost

**Maximize Ontime Delivery** This objective maximizes ontime delivery by trying to ensure that all demand is met ontime. Penalty factors specify the relative importance of demands when maximizing ontime delivery.

**Note:** If your goal is to determine the least amount of inventory required to enforce the service level constraint, this can be achieved by, first, specifying the maximum weight to the inventory turns objective; and second, setting enforce service level constraints to Yes. You do this by selecting the Enforce Service Level Constraints check box in the Options tab of the Plan Options window.

**Setting Service Levels**

You can define service levels at each of the following hierarchies:

- Item/Demand class
- Item
- Category/Demand class
- Customer
- Organization
- Demand class
- Plan (global)

If the value is not specified at a certain level in the hierarchy, the system defaults to the value specified at the next higher level.

**Note:** For more information on allocating demand to suppliers, see “Sourcing Rules and Bills of Distribution” in the *Oracle Master Scheduling/MRP and Oracle Supply Chain Planning User’s Guide.*
**Item/Demand Class**

A field in the Define Allocation Rules window lets you define the Demand Class service level. Define the Item Demand Class service level by assigning rules to specific items in the Assign Allocation Rules window.

**To define the Demand Class service level:**

1. From the Navigator, choose ATP > Allocation > Define Allocation Rule. The Allocation Rule window appears.

   ![Allocation Rule window](image)

   **Figure 17–15 Allocation Rule window**

2. Enter a service level for each Demand Class in the Service Level field.

**To set the Item Demand Class service level:**

1. From the Navigator, choose Allocation > Assign Allocation Rule. The Assign Allocation Rule window displays.
2. Choose Item from the drop down list in the Assign To field.

3. Scroll right then choose an allocation rule from the list of values in the Allocation Rule field.

**Figure 17–17  Assign Allocation Rule, Allocation Rule field**

**Item**

A flexfield in the Oracle Inventory Master Item window in the source instance lets you define the Item service level.
To set the Item service level:
1. Choose Inventory > Items > Master Items > [New].
   The Master Item window appears.
2. Click on the item flexfield entry box to the right of the Description field.
   The Items window appears.

Figure 17–18  Items window

3. Enter a value in the Service Level flexfield.

Category/Demand Class:
A field in the Define Allocation Rules window lets you define the Demand Class level service level. You can define the Category Demand Class level service level by assigning rules to specific categories in the Assign Allocation Rules window.

To set the Category Demand Class service level:
1. From the Navigator, choose Allocation > Assign Allocation Rule.
The Assign Allocation Rule window displays.

**Figure 17–19 Assign Allocation Rule window**

2. Choose Item Category from the drop down list in the Assign To field.

3. Scroll right, then choose an allocation rule from the list of values in the Allocation Rule field.

**Figure 17–20 The Assign Allocation Rule window, Allocation Rule field**
Customer
A flexfield in the Oracle Order Management Customers window in the source instance lets you define the Customer service level.

Service level by item overrides service level by customer.

To set the Customer service level:
   The Customers window appears.
2. Click on the customer information flexfield.
   The Customer Information window appears.

3. Enter a value in the Service Level flexfield.

Organization
A flexfield in the Oracle Inventory Organization Parameters window in the source instance lets you define the Organization service level.
To set the Organization service level:
1. Choose Inventory > Setup > Organizations > Parameters.
   The Organization Parameters window appears.
2. Click on the organization parameters flexfield.
   The Organization parameters window appears.

Figure 17–22 Organization Parameters window

3. Enter a value in the Service Level flexfield.

Demand Class
A field in the Define Allocation Rules window lets you define the Demand Class service level. The rule you assign to the Global Assignment Type in the Assign Allocation Rules window determines the Demand Class service level.

To set the Demand Class service level:
1. From the Navigator, choose Allocation > Assign Allocation Rule.
The Assign Allocation Rule window displays.

2. Choose Global from the drop down list in the Assign To field.
3. Scroll right, then choose an allocation rule from the list of values in the Allocation Rule field.

**Global (Plan Level)**

Use the Service Level field in the Optimization tab to define the Plan service level. For more information, refer to on page 17-14, "The Optimization Tab."
Setting Penalty Costs

You can specify penalty costs instead of service levels for independent demands and have the system calculate safety stocks. The system trades off the cost of late demands with production costs, purchasing costs, and inventory costs in determining the best attainable service level.

The system uses the penalty costs, service level or both in calculating safety stock quantities as shown in the following table:

<table>
<thead>
<tr>
<th>Plan Level Defaults</th>
<th>Enforce Service Level</th>
<th>Enforce Capacity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Level</td>
<td>used</td>
<td>used only for target safety stock calculation</td>
</tr>
<tr>
<td>Resource Penalty Costs</td>
<td>used</td>
<td>used only for target safety stock calculation</td>
</tr>
<tr>
<td>Material Penalty Costs</td>
<td>used</td>
<td>used only for target safety stock calculation</td>
</tr>
<tr>
<td>Late Demand Penalty Costs</td>
<td>not used</td>
<td>used</td>
</tr>
</tbody>
</table>
When you specify Enforce Service Level Constraints, the system calculates safety stock quantities for the specified service levels while minimizing penalty costs for exceeding material capacity, exceeding resource capacity, and exceeding transportation capacity.

Penalty cost for late demand is used only when you specify Enforce Capacity Constraints.

---

**Note:** Specifying input penalty costs for late demand and specifying input service level are mutually exclusive.

---

For information on setting penalty factors or costs, refer to on page 8-4, “Setting Penalty Factors.”

### Setting Performance Indicators

You can compare inventory plan output to the following performance indicators:

- Inventory Turns
- Service Level
- Planned Utilization
- Margin
- Margin Percentage
- Cost Breakdown
- Inventory Value

Refer to the *Oracle Business Intelligence System Implementation Guide* for information on setting performance indicator targets.

---

**Note:** You can set targets for all Performance Indicators except Margin and Cost Breakdown.
Viewing Output

Oracle Risk Optimization lets you view the following types of output:

- Horizontal plan
- Vertical Plan
- Performance Indicators
- Time-phased Supply and Demand
- Constrained and Unconstrained Safety Stocks

Refer to Chapter 10, "Planner Workbench/User Interface" for more information on viewing horizontal and vertical plans.

Performance Indicators

The initial window of the Planner Workbench, the summary chart, provides a graphical display of the plan’s Key Performance Indicators (KPIs). At a glance, you can see how the plan performs relative to the following measures:

- Inventory Turns
- Service Level
- Planned Utilization
- Margin
- Margin Percentage
- Cost Breakdown
- Inventory Value
Figure 17–25  The KPIs Summary Chart in the Planner Workbench

Refer to Chapter 10, "Planner Workbench/User Interface" for more information on viewing performance indicators.

Time-Phased Supply and Demand

You can view time-phased demand and supply for all items in your inventory plan.

To view time-phased supply and demand choose Tools > Supply/Demand. The Supply/Demand window appears.
The following information is available in the various tabs of the Supply/Demand window and by scrolling to the right:

**Order Tab**
- Org
- Item
- For Release
- Firm
- Order Type
- Suggested Due Date
- Probability
- Qty/Rate
- Order Number
- ABC Class
- Alternate BOM
- Alternate Routing
- Bucket Type
Safety Stocks and Target Safety Stocks

Target safety stocks, which are unconstrained safety stocks, are the safety stock quantities required to support a given service level. Safety stocks, which are constrained safety stock quantities, are the quantities achievable given the capacity limitations. The constrained safety stocks are always less than or equal to the unconstrained target safety stocks equivalents.

Oracle Risk Optimization calculates and displays both constrained safety stocks and unconstrained target safety stocks.

Using capacity exceptions and the unconstrained and constrained safety stock quantities, users of Oracle Risk Optimization can determine the following:

- what service level is achievable
- what they need to do in order to achieve the target service level

Time-phased safety stock quantities for all items is available in the Horizontal Plan, Vertical Plan, and Supply and Demand windows.
To view time-phased safety stocks, choose the Horizontal Plan tab. The Horizontal Plan window appears.

**Figure 17–27 The Horizontal Plan window**

Resource Requirements

You can view time-phased resource requirements for all resources in your inventory plan.

To view time-phased resource requirements:

1. [Right-click] on an item in the navigation tree then choose the Resources option.

The Resources window appears.
2. Choose the Requirements button.

The Resource Requirements window appears.

The following fields are displayed in the Resource Requirements window. Some of the fields appear when you scroll to the right:

- Dept/Line
- Resource
- Org
- Owning Dept.
- Dept. Class
- Resource Type
- Resource Group
- Start Date
- End Date
- Schedule Quantity
- Using Assembly
Material/Resource Availability

You can view time-phased material and resource availability for all items/resources in your inventory plan.

To view time-phased material and resource availability:

1. [Right-click] on an item in the navigation tree then choose the Resources option.
   The Resources window displays.
2. Choose the Availability button.
   The Resource Availability Summary window appears.
Figure 17–29  Resource Availability Summary window
Reviewing Exception Messages

This section describes exception messages associated with Oracle Risk Optimization.

Capacity Exceptions

Material and Resources constraints are generated for Inventory Plans only if you choose the option Enforce Capacity Constraints. In this option, the output contains both unconstrained safety stocks (i.e., safety stocks required to meet the target customer service level), and constrained safety stocks (i.e., the achievable safety stock given the capacity constraints).

The constraint exception messages provide users with a list of capacity bottlenecks that prevent them from achieving the target service levels.

The exception messages generated for this case are the same as those available in ASCP. Please refer to Chapter 9, Exception Messages for information on what exceptions are generated for which type of plans, how exceptions can be viewed and analyzed, and how exception situations potentially can be resolved.

The following is a list of exceptions for Risk Optimization:

- Late Sales Orders and Forecasts
  - Past due transportation resource constraint
  - Past due forecast
- Material and Resource Capacity
  - Material constraint
  - Resource constraint
  - Resource overloaded
  - Supplier capacity overloaded
  - Resource underloaded
- Transportation and Distribution
  - Transportation resource overloaded
  - Transportation resource underloaded
- Shortage and Excess
  - Item with a shortage
• Item with excess inventory

• Substitutes and Alternates Used
  • Planned order uses alternate BOM
  • Planned order uses alternate routing
  • Planned order uses substitute components
  • Planned order uses alternate resources
  • Order sourced from alternate facility
  • Order sourced from alternate supplier

• Item Exceptions
  • Items with negative starting onhand
  • Items with no activity
Topics covered in this section include the following:

- Demand Planning Architecture on page 18-2
- The Demand Planning Forecasting Cycle on page 18-4
- Demand Planning Roles on page 18-7
- Demand Planning Setup on page 18-10
- Data Collection on page 18-24
- Defining a Demand Plan on page 18-30
- Building a Demand Plan on page 18-42
- Demand Planner Assignment on page 18-52
- Generating Baseline Forecasts on page 18-54
- Analyzing and Modifying Forecasts on page 18-55
- Demand Planner Responsibilities on page 18-56
- Publishing the Consensus Forecast on page 18-60
- Renewing the Forecasting Cycle on page 18-66
- Events on page 18-69
- Forecasting for Dependent Demands on page 18-89
- Customizing Demand Planning Hierarchies on page 18-102
Demand Planning Architecture

As with the other applications of the Oracle Advanced Planning Suite, Oracle Demand Planning (ODP) has a component architecture. This means that in lieu of working directly off of data generated by other Oracle Applications, ODP first copies that data to a localized data store in a process called collection. This is done for two reasons:

- It allows the computational-intensive planning and forecasting calculations done by ODP to be off-loaded to a separate planning server (where the localized data store resides), to avoid excessive load on the server hosting the ERP transactions.

- It allows ODP to be deployed against multiple versions of Oracle Applications (10.7, 11 and 11i). There are separate collection programs for each of these versions of Oracle Applications.

The business process of demand planning requires slicing and dicing demand along different dimension levels. For example, manufacturing planners may plan and view demand at a product/manufacturing location level, whereas sales managers may plan and view demand at a product family/geographic region level. The ability to accept demand data input at one set of dimension levels, display it at another set of dimensional levels, and maintain a consistent set of underlying demand data that is independent of the levels at which it is displayed is covered by a technique call Online Analytical Processing (OLAP). ODP uses a database engine for rendering OLAP calculations called Express.

ODP thus consists of two major components: the Demand Planning Server (DPS) and the Demand Planning Express Server (DPE). DPS is the planning server.
referred to above, and holds the inputs (such as sales history) to ODP from Oracle Applications as well as the forecast outputs from ODP back to Advanced Supply Chain Planning and other Oracle Applications. DPE is the processing engine of ODP, and holds data while OLAP manipulations are being performed.
The Demand Planning Forecasting Cycle

The information flows between the two major components of ODP (DPS and DPE) during the Demand Planning forecasting cycle are shown in the following figure and described in the steps below. This basic flow will be utilized throughout this section for details on how to use ODP for demand planning.

Step 1. Collect Data

Data such as items, sales history, and inventory organizations are collected from the source (Oracle Applications, or perhaps legacy transaction systems) into staging tables on the Demand Planning Server (data flow 1). The purpose of the staging tables is to provide a temporary repository that allows users to review the collected data, adjust them as necessary, and clean out any irrelevant data, thus making the data more useful for forecasting. Note that ODP does not provide an explicit data viewing or cleansing tool. You can use any data manipulation tool such as SQL for
Step 2. Define Demand Plan
Once data is collected from the source, the next step is to define a demand plan. This is where the user defines how they would like to analyze the data. The user specifies the dimensions and hierarchies within dimensions such as geography and sales group, as mentioned in the previous section on Demand Planning architecture.

Users also specify what type of historical data will be used and how much of the history will be used. Besides historical data, users can select reference data such as manufacturing data for comparing forecasts generated by ODP based on historical data.

Users also specify one or more scenarios to perform what if analysis, based on different histories, date ranges for forecast horizons, etc.

Once the demand plan is defined, it goes through four stages within the DPE, which is the analytical tool of ODP. Also, the same demand plan can be used in the next forecasting cycle by modifying its parameters.

Step 3. Build Demand Plan
From the fact tables, data are downloaded into the Demand Planning Express Server (DPE), in preparation for their manipulation via OLAP. The initial download is into a shared database portion of DPE (data flow 3). This is stage 1 of the demand planning cycle within DPE.

Step 4. Assign Demand Planners and Generate Baseline Forecasts
These data are then divided into slices called assignments. A demand planner is given responsibility for each assignment.

Oracle Demand Planning generates a baseline forecast for each assignment. The baseline forecasts and the historical and reference data associated with the assignments are then distributed to the personal databases of the demand planners (data flow 4). This is stage 2 of the demand planning cycle within DPE.

Step 5. Analyze and Modify Forecast
Demand planners can independently review and enhance the forecasts in their personal databases. They can modify historical and forecast data, and generate new forecasts using the same or different statistical techniques than used in the baseline
forecasts. Each demand planner submits final forecasts back to the shared database of DPE (data flow 5). After all the submissions, sliced forecast data is consolidated into the demand plan. This the stage 3 of the demand planning cycle within DPE.

**Step 6. Publish Forecast**
The completed demand plan is then published back to DPS in the fact tables. This is stage 4 of the demand planning cycle within DPE.

The demand plan is now ready to be published to the source database (data flow 7) for the planning and scheduling process. Furthermore, the same demand plan then can be used for the next cycle of forecasting.

**Step 7. Renew Forecast Cycle**
The time horizon parameters of the demand plan are adjusted to accommodate generating forecasts for the next rolling time horizon.

All of the steps described above require different skills. ODP predefines these roles for these steps. The roles are described next.
Demand Planning Roles

Oracle Demand Planning assumes that the forecast cycle described in the previous section is accomplished by a group of people with four functional roles. These roles are:

- Demand Planning Integration Administrator
- Demand Planning Administrator
- Demand Planning Manager
- Demand Planner

**Demand Planning Integration Administrator**

The Demand Planning Integration Administrator (DPIA) has overall responsibility for collecting data into Oracle Demand Planning from the source transaction instance (Oracle Applications), making sure the data is clean and usable, and for publishing ODP output back to the source for planning and scheduling. The DPIA is responsible for the following forecast cycle steps:

- Step 1. Collect Data
- Step 2. Define Demand Plan
- Step 6. Publish Forecast (from DPS to source)
- Step 7. Renew Forecast Cycle

**Demand Planning Administrator**

The Demand Planning Administrator (DPA) determines the overall default settings for the demand planning system from a deep understanding of the business process. The DPA is responsible for specifying the forecast level, assigning data to individual demand planners, specifying the baseline forecast methods and forecast allocation rules, selecting and setting defaults for the predefined reports, and invoking forecast consolidation after all the data from personal databases have been sent to the shared database.

The DPA is responsible for the following forecast cycle steps:

- Step 3. Build Demand Plan
- Step 4. Assign Demand Planners and Generate Baseline Forecasts
- Step 6. Publish Forecast (from DPE to DPS)
The DPA should have thorough knowledge of the demand planning process as well as familiarity with how the ODP Express engine works. The figure below shows the DPA job functions in the demand planning cycle.

**Demand Planning Administrator Role**

1. **Download**
   - Source of forecast scenarios, event factors, history data

2. **Forecast & Distribute**
   - Personal databases
   - Demand Planners: Analyze baseline forecast and history, submit adjusted forecasts

3. **Collect**
   - Demand Plan Manager: Review and adjust consolidated forecasts

4. **Upload**

**Demand Planning Manager**

The Demand Planning Manager is responsible for the final forecast numbers that are submitted back to the Planning Server. Once the individual Demand Planners submit the forecasts, these are rolled up to obtain the final consolidated forecast by the Demand Planning Administrator, who invokes this consolidation process. The Demand Planning Manager looks at the consolidated forecast and decides whether to accept or reject them. He or she could modify the numbers, or choose to re-assign them to the individual planners through the Demand Planning Administrator. The Demand Planning Manager is expected to be in charge of the planning and forecasting process.
Demand Planner
The Demand Planner is responsible for analyzing and forecasting demand in an assigned data segment, and for submission of demand forecasts. A Demand Planner is an individual forecaster. Qualifications for this role include forecasting and data analysis abilities as well as a good understanding of the business processes governing the data to be forecasted.
Demand Planning Setup

Before data is collected, demand planning requires some set ups to be done, as described next.

1. Set Up Instances

Instances setup is required to link the source Oracle Applications instance to the ODP planning server instance.

To set up Instances:

1. Choose the Demand Planning Integration Administrator responsibility.
2. In the Navigator, choose Setup > Instances.
   
   The Application Instances form appears.

**Figure 18–1  The Applications Instances form**

3. Complete the fields in this window as shown in the following table:
4. Click an Organization button, and select all inventory organizations in the source instance that contain data that need to be collected over to the planning server for demand planning purposes.

2. Set Up Data Collections
The purpose of this setup is to enhance collection performance by limiting collection to the relevant dates. It collects names of inventory organizations and product categories from the Oracle Applications source instance to the Demand Planning Server (DPS). It caches data essential to the collection process in DPS so that collections can proceed as rapidly as possible.

To set up Collections
1. Choose the Demand Planning Integration Administrator responsibility.
2. In the Navigator, choose Setup > Setup Collections.
   The Planning Data Collection form appears.

### Demand Planning Integration Setup

#### Field Function Legal Values

<table>
<thead>
<tr>
<th>Field</th>
<th>Function</th>
<th>Legal Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Instance Code</td>
<td>Identifies source transaction instance.</td>
<td>VARCHAR2(3)</td>
</tr>
<tr>
<td>Instance Type</td>
<td>Describes the type of data in the source instance.</td>
<td>Discrete, Process, Discrete &amp; Process, Other</td>
</tr>
<tr>
<td>Version</td>
<td>The Oracle Application version of the source instance.</td>
<td>10.7, 11.0, 11i</td>
</tr>
<tr>
<td>From Source to APS</td>
<td>Name of database link defined on the planning server side that allows collection of data from the source instance to the planning server.</td>
<td>Valid database link name</td>
</tr>
<tr>
<td>From APS to Source</td>
<td>Name of database link defined on the source instance that allows publishing of forecast data from the planning server back to the source instance.</td>
<td>Valid database link name</td>
</tr>
<tr>
<td>GMT Difference</td>
<td>A numerical offset indicating the difference between the source instance time zone and GMT. Not used by ODP.</td>
<td>NUMBER</td>
</tr>
<tr>
<td>Currency</td>
<td>Base currency of the source instance.</td>
<td>Lookup values</td>
</tr>
<tr>
<td>Assignment Set</td>
<td>Not used by ODP</td>
<td>Leave blank</td>
</tr>
</tbody>
</table>
3. Click on the first Parameter field in the window above. Another screen appears in which you select the instance to be collected from the list of values. You can also specify the number of workers (between 1-3) to be used in collections. The greater the number of workers, the greater the computational resources devoted to the collection process.

4. Click on the second Parameter field in the window above. Select the instance to be collected from the list of values. This setup is used for direct import of data to the fact table.

The source instance inventory organizations from which Setup Collections retrieves data are dictated by the organizations selected by the user in Setup Instances.

Setup Collections needs to be run each time the following changes:

- the source instance from which data is collected
3. Set Up Demand Planning Dimensions

Simple demand data has two dimensions: product and time. With each demand quantity there is an associated item and a time bucket. Product and time are the minimum dimensions required by Oracle Demand Planning in any demand plan. However, in many global organizations, data comes from various sources. For example, sales forecasts may come from various parts of the world, from various sales groups and teams, from various business groups, and from key customers. Similarly, shipments can be made from various business units/distribution centers.

In this situation, typically a number of Demand Planners will be working on specific segments of the data for demand analysis and forecast enhancements. ODP facilitates this by providing the following most frequently used dimensions: ship-from location, geography, sales channel and sales representative besides the product and time dimensions.

---

**Note:** This setup step is typically not needed, unless user-defined dimensions are needed. User-defined dimensions and customization of hierarchies within dimensions is covered in the section Customizing Demand Planning Hierarchies on page 18-102.

---

To define Demand Planning Dimensions:

1. Choose the Demand Planning Integration Administrator responsibility.
2. In the Navigator, choose Setup > Dimensions.
   
   The Application Utilities: MSD_DIMENSIONS Lookups window appears.
Use this window to view the six pre-defined Demand Planning Dimensions and to change the Meaning and Description names. Two user-defined Dimensions are also available.

3. Complete the fields in this window as shown in the following table:

<table>
<thead>
<tr>
<th>Field</th>
<th>Function</th>
<th>Legal Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code</td>
<td>Lookup code that uniquely identifies the Demand Planning Dimension</td>
<td>CHN, GEO, ORG, PRD, REP, TIM, UD1, UD2</td>
</tr>
<tr>
<td>Meaning</td>
<td>Name of the Demand Planning Dimension</td>
<td>Default values, can be changed by user</td>
</tr>
<tr>
<td>Description</td>
<td>Describes the Code as being a Demand Planning Dimension</td>
<td>Default values, can be changed by user</td>
</tr>
</tbody>
</table>
4. Set Up Demand Planning Hierarchies

Each dimension may contain multiple hierarchies. For example, the product dimension may contain the Product Category and Product Family hierarchies. A product (for example, an automobile model - the Corvette) may fit into both a Product Family (a marketing brand - say, Chevrolet) and a Product Category (a vehicle style - say, Sports Car). Each hierarchy may need to be analyzed separately. ODP provides a set of most frequently used hierarchies for the six dimensions:

Product Dimension:
- Product Category Hierarchy:
  - Product > Product Category > All Products
- Product Family Hierarchy:
  - Product > Product Family > All Products

Time Dimension:
- Manufacturing Calendar Hierarchy:
  - Day > Mfg. Week > Mfg. Period > All Time
- Gregorian Calendar Hierarchy:
  - Day > Month > Quarter > Year > All Time
- Fiscal Calendar Hierarchy:
  - Day > Fiscal Month > Fiscal Quarter > Fiscal Year > All Time

Geography Dimension:
- Geography Hierarchy:
  - Ship to Location > Region > Country > Area > All Geography
- Customer Group Hierarchy:
  - Ship to Location > Customer > Customer Group > All Geography
- Customer Class Hierarchy:
  - Ship to Location > Customer > Customer Class > All Geography

Ship From (Organization) Dimension:
- Organization Hierarchy:
  - Organization > Operating Units > Legal Entity > Business Group > All Organizations
Sales Channel Dimension:
- Organization Hierarchy:
  - Sales Channel > All Sales Channels

Sales Representative Dimension:
- Sales Representative Hierarchy:
  - Sales Rep > Sales Manager 1 > Sales Manager 2 > Sales Manager 3 > Sales Manager 4 > All Sales Rep.
  - Sales Group Hierarchy:
  - Sales Rep. > Sales Group 1 > Sales Group 2 > Sales Group 3 > Sales Group 4 > All Sales Rep.

**Note:** This setup step is typically not needed, unless custom hierarchies are needed. Customization of hierarchies within dimensions is covered in the section Customizing Demand Planning Hierarchies on page 18-102.

Dimensions contain hierarchies that are used for aggregating data. Multiple hierarchies can exist for each dimension, allowing one hierarchy to be used for allocation while others are used for reporting.

**To define Demand Planning Hierarchies:**
1. Choose the Demand Planning Integration Administrator responsibility.
2. In the Navigator, choose Setup > Hierarchies.
   - The Demand Planning Hierarchies window appears.
Use this window to view the preseeded hierarchies and their associations with a Demand Planning Dimension defined in the previous window.

In this example, the Hierarchy Name Geography has been created for the Geography Dimension with a description of Geography Hierarchy. Note that multiple hierarchy names can be created for a dimension as in the case of Sales Representative which has Sales Group and Sales Representative.

3. Complete the fields in this window as shown in the following table:

<table>
<thead>
<tr>
<th>Field</th>
<th>Function</th>
<th>Legal Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Hierarchy Name</td>
<td>VARCHAR2(30)</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed description for the hierarchy name</td>
<td>VARCHAR2(240) (users can change the names)</td>
</tr>
<tr>
<td>Dimension</td>
<td>Demand Planning Dimension Name</td>
<td>List of Values (users can change the names)</td>
</tr>
</tbody>
</table>
5. Set Up Demand Planning Levels

Demand Planning Levels represent different ways of aggregating data within a Dimension.

**Note:** This setup step is typically not needed, unless custom hierarchies are needed. Customization of hierarchies and levels within dimensions is covered in the section Customizing Demand Planning Hierarchies on page 18-102.

To define Demand Planning Levels:

1. Choose the Demand Planning Integration Administrator responsibility.
2. In the Navigator, choose Setup > Levels.
   The Demand Planning Levels window appears.

*Figure 18–5 The Demand Planning Levels window*

Use this window to view preseeded hierarchy levels and identify the position of the level in the dimension.
In this example, the following level names: All Geography, Area, Country, Region, and Ship To Location have been defined for the Geography Dimension with detailed description names. The positioning of the levels in the hierarchy have also been defined with All Geography being the top level and Ship to Location the bottom level. Area, Country, and Region level names are the intermediate Levels.

3. Complete the fields in this window as shown in the following table:

<table>
<thead>
<tr>
<th>Field</th>
<th>Function</th>
<th>Legal Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Level Name</td>
<td>VARCHAR2(30) (user can change the name)</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed Description for the Level</td>
<td>VARCHAR2(240) (user can change the description)</td>
</tr>
<tr>
<td>Dimension</td>
<td>The Demand Planning Dimension to which the Level is associated</td>
<td>Lookup Values</td>
</tr>
<tr>
<td>Level Type Code</td>
<td>The position of the Level in a Hierarchy</td>
<td>Lookup Values (1: Top, 2: Bottom, 3: Intermediate)</td>
</tr>
<tr>
<td>User Attribute 1-5</td>
<td>The User Attribute associated with the Level</td>
<td>VARCHAR2(240)</td>
</tr>
</tbody>
</table>

Note: This setup step is typically not needed, unless custom hierarchies are needed. Customization of hierarchies and levels within dimensions is covered in the section Customizing Demand Planning Hierarchies on on page 18-102.

To define Demand Planning Hierarchy Levels:
1. In the Navigator, choose Setup > Hierarchy Levels.

The Demand Planning Hierarchy Levels window appears.
Use this window to view the links in the hierarchies by associating the levels to its Parent Level within a Demand Planning Hierarchy. Here you also specify the view as well as the columns in this view that will be used to fetch this information for a link from the source instances. Once the links are defined and saved, you can click on the Validate Hierarchies button to make sure that all the levels in a hierarchy are valid.

In this example, the level name of Area is associated with parent level name of All Geography, the level name of Country is associated with the parent level name of Area, the level name of Region is associated with the parent level name of Country, and the level name of Ship To Location is associated with parent level name of Region for the Hierarchy Name Geography.
2. Complete the fields in this window as shown in the following table:

<table>
<thead>
<tr>
<th>Field</th>
<th>Function</th>
<th>Legal Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hierarchy Name</td>
<td>Name of the hierarchy</td>
<td>VARCHAR2(30) [Lookup Values]</td>
</tr>
<tr>
<td>Level Name</td>
<td>Name of the level</td>
<td>VARCHAR2(30) [Lookup Values]</td>
</tr>
<tr>
<td>Parent Level Name</td>
<td>The Parent Level to which the level is aggregated in this Hierarchy</td>
<td>VARCHAR2(30) [Lookup Values]</td>
</tr>
<tr>
<td>Relationship View</td>
<td>The view from which this relationship information can be collected into the Planning Server</td>
<td>VARCHAR2(30)</td>
</tr>
<tr>
<td>Level Value Column</td>
<td>The column from which the Level Value will be fetched</td>
<td>VARCHAR2(30)</td>
</tr>
<tr>
<td>Parent Value Column</td>
<td>The column from which the Parent Level Value will be fetched</td>
<td>VARCHAR2(30)</td>
</tr>
</tbody>
</table>

7. Set Up Profile Options
Demand Planning profile options begin with three letters: MSD, which stands for Manufacturing, Supply Chain, Demand Planning.

To set up profile options:
1. In the Navigation window, select Other > Profile.
   The Find Personal Profile Values window appears.
2. Search for MSD%.
   The Personal Profile Values window appears.
Following is an explanation of the Profiles.

3. Complete the fields in this window as shown in the following table:

<table>
<thead>
<tr>
<th>Field</th>
<th>Function</th>
<th>Legal Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>MSD_CATEGORY_SET_NAME, User Value</td>
<td>Category sets composed of a number of product categories are defined in the source instance. These category sets are collected using Setup Data Collection, described earlier. A selection of one of the category sets will limit the data collection to those categories. If the user value is left blank, then all categories will be selected for data collection.</td>
<td>Blank, or valid category set name</td>
</tr>
<tr>
<td>Field</td>
<td>Function</td>
<td>Legal Values</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-------------------------------------</td>
</tr>
<tr>
<td>MSD_CONVERSION_TYPE, User Value</td>
<td>This profile determines what conversion rates are collected from the general ledger rates table.</td>
<td>List of values</td>
</tr>
<tr>
<td>MSD_CONVERSION_CODE, User Value</td>
<td>This profile designates the currency used as the base currency for calculation of revenue forecasts.</td>
<td>List of values</td>
</tr>
<tr>
<td>MSD_ONE_STEP_COLLECTION, User Value</td>
<td>Data collection from source instances are first brought into a staging area. This serves two purposes: data cleansing, and consolidation of data if data is collected from multiple instances. If data is relatively clean and collected from a single instance, it is not necessary to consolidate data in the staging table. When this profile is set to Yes, data is brought into the fact tables directly after being populated in the staging tables.</td>
<td>No (default), Yes</td>
</tr>
</tbody>
</table>
Data Collection

Data collection copies data streams from the data source to the Demand Planning server. If data source is other than Oracle Applications, then the data can be inserted from a legacy source into DPS Staging tables using a custom SQL*Loader program. The following figure shows the data collection process.

 Execution of Data Collection Process

If the data are collected from an Oracle source, they can be optionally moved into the DPS staging tables for data cleansing and then moved into the DPS fact tables, or inserted directly into the DPS fact tables. The next figure illustrates the process. If the data is from a legacy system, it must be collected to the staging tables for data cleansing and verification.

Data stored in the fact table is overwritten by newly collected data within specific date ranges. When data is pulled from the staging tables to the fact tables, that data is no longer in the staging table.
To collect data:

1. Choose the Demand Planning Integration Administrator responsibility.

2. In the Navigator, choose Collections > Collect Data > [Shipment Data, Booking Data, Currency Conversion, UOM Conversion, Manufacturing Forecast, All Fact Data, Level Values, Time Data, Pricing Data]. All Fact Data includes Shipment Data, Booking Data, Currency Conversion, UOM Conversion, and Manufacturing Forecast.

   A Parameters pop-up window appears.
3. Complete the fields in this window for each of the data selected as shown in the following table:

<table>
<thead>
<tr>
<th>Field</th>
<th>Function</th>
<th>Legal Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Instance</td>
<td>The Instance from which the data is to be moved to the staging tables in the Demand Planning Server</td>
<td>Lookup Values</td>
</tr>
<tr>
<td>Date From (Optional)</td>
<td>The date to start data collection</td>
<td>DATE</td>
</tr>
<tr>
<td>Date To (Optional)</td>
<td>The date to end data collection</td>
<td>DATE</td>
</tr>
</tbody>
</table>

4. Click the OK button.

5. Click Submit.

Submitting the request starts the collection process from the source instance into the DPS staging tables. The collection can be scheduled or can be set to execute immediately.
Use of Collected Data

Shipment Data and Booking Data are normally used for statistical forecasting. Statistical techniques analyze the patterns in the data and then predict future patterns. These are the historical data from the Order Management System.

Currency Conversion collection brings in the currency conversion rates from the general ledger rate table source data. In a multinational organization, currency needs to be converted to a common currency for ease of computation, display of amounts, and comparing and analysis of the forecast.

Unit of Measure Conversion collection brings in UOM conversions data from the selected source. This data helps to generate forecasts for items at all hierarchy levels within a dimension in a common unit making it easier to roll up or down the hierarchy level.

Manufacturing Forecasts are collected from the source. A manufacturing forecast is generally produced by manufacturing operations. The manufacturing forecast is a useful comparison to the statistical forecast. In case of major discrepancies, this may lead to root cause analysis, and ultimately an enhanced forecast by the Demand Planner.

Level Values collections brings in level values for each dimension (except for the time dimension - which is collected separately) along with its association between level values (parent-child relation in the hierarchy). Level value data can be collected for the following:

- all level values
- previously defined demand plans (defining demand plans will be covered later in this section)
- specific dimensions
- specific hierarchies within a dimension
- specific levels within a dimension

This filtering mechanism allows for the collection of only the level values necessary for demand planning, thus reducing the processing burden.

Time data collection brings in Time dimension data along with the associated hierarchy levels. Each Time hierarchy (Manufacturing Calendar, Gregorian Calendar, and Fiscal Calendar) is collected separately. Time data collection helps in the roll-up or down of demand along the time dimension. For example, demand of a car model can be rolled from a daily forecast amount to monthly to
quarterly to yearly in the Gregorian Calendar. The appropriate selection of calendar type depends on the availability of source data in these calendars.

Pricing data collection is used to bring in prices in the variable pricing application of ODP discussed in a separate section. Price list and the source instance need to be selected.

Note that the next time data is collected from the same instance, it overrides the previous data for the specified date range for that instance. Any data beyond the date range from the previous collection is added to the staging table. This is how to bring incremental data into the Demand Planning Server.

**Pull Data into Fact Tables**

The process is similar to collecting data into the staging table. Pulling data from the staging table empties the staging table for the next cycle of data collection.

- **To collect bills of material data:**
  1. Choose the Demand Planning Integration Administrator responsibility.
  2. From the Navigator, choose Collections > Collect Data > BOM Collections

    The Planning Data Collection window appears.
3. Click on the first Parameters field, and enter the instance to be collected from.

4. Click on the second Parameters field, and enter the instance to be collected from.

**Use of BOM Data**

BOM data is used for dependent demand forecasting for forecasting various optional components used in a product model. Dependent demand forecasting is explained later in this section.

Once data is collected, the next step is to define a demand plan.
Defining a Demand Plan

A demand plan is a group of parameters that defines both the inputs and outputs of the demand planning process as well as the dimensional levels along which the demand analysis is to occur.

Each Demand Plan is defined for a specific inventory / owner organization (defined during setup of instances). However, a demand plan is global and is not limited to any organization.

You can associate up to four User Dimensions with a Demand Plan. The remaining Demand Planning Dimensions can be collapsed into other User Dimensions. Although you cannot view more than four User Dimensions at one time, this collapsing allows you to toggle between them. Time and Product Demand Planning Dimensions are mandatory.

There may be situations where different units of measure exist for items within the same product family. This makes it extremely difficult to determine what the forecast should be at an aggregate level when there is no common unit of measure. The Base UOM field provides a method to change the units for all items within a higher level of aggregation to a common unit of measure as determined by the Demand Planning Administrator.

The Calendar selected here must be used for all scenarios created for this Demand Plan.

To define Demand Plans:

1. Choose the Demand Planning Integration Administrator responsibility.

2. In the Navigator, choose Demand Plan Definitions > Demand Plans.

3. Choose an organization if you have not already done so.

   The Demand Plans window appears.
Defining a Demand Plan

Implementing and Using Oracle Demand Planning

18-31

Figure 18–10 The Demand Plans window

Use this window to define a Demand Plan – name a Demand Plan, and define its UOM, average discount, calendar and category sets. The bottom region of this form is used for collapsing the various demand planning dimensions to the user dimensions associated with this Demand Plan.

In this example, the name and description of the Demand Plan is Universal 1. The base UOM is Ea and the avg discount is .1. The calendar type used for this Demand Plan is the Gregorian calendar. Six demand planning dimensions are being collapsed into four user dimensions. Sales channel, geography, and sales representative are being collapsed into the geography user dimension. Product and time are the other user dimensions and must always be included in a Demand Plan.

4. Complete the fields in this window as shown in the following table:

<table>
<thead>
<tr>
<th>Field</th>
<th>Function</th>
<th>Legal Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Demand Plan Name</td>
<td>VARCHAR2(30)</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed Description for the Demand Plan</td>
<td>VARCHAR2(240)</td>
</tr>
</tbody>
</table>
The next step is to associate hierarchies with each dimension in the demand plan. At least one hierarchy needs to be assigned for each of the dimensions. For example,

<table>
<thead>
<tr>
<th>Field</th>
<th>Function</th>
<th>Legal Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Base UOM</td>
<td>The Demand Plan UOM is the UOM that will be used for aggregating at higher levels above the product level</td>
<td>VARCHAR2(3)</td>
</tr>
<tr>
<td>Average Discount</td>
<td>The average discount that would be applied to products if the product’s individual discount is not defined</td>
<td>NUMBER below 1</td>
</tr>
<tr>
<td>Calendar Type</td>
<td>The Type of Calendar used for this Demand Plan</td>
<td>Lookup Values (1: Gregorian, 2: Manufacturing, 3: Fiscal)</td>
</tr>
<tr>
<td>Manufacturing Calendar</td>
<td>This is required only if the Calendar Type is Manufacturing Calendar. It defines the Manufacturing Calendar used for the Demand Plan.</td>
<td>Lookup Values</td>
</tr>
<tr>
<td>Fiscal Calendar</td>
<td>This is required only if the Calendar Type is Fiscal Calendar. It defines the Fiscal Calendar used for the Demand Plan.</td>
<td>Lookup Values</td>
</tr>
<tr>
<td>Dimension</td>
<td>The Demand Planning Dimension collapsed to the User Dimension associated with this for the Demand Plan</td>
<td>Lookup Values</td>
</tr>
<tr>
<td>User Dimension</td>
<td>The User Dimension defined from the Demand Planning Dimensions for the Demand Plan</td>
<td>Lookup Values</td>
</tr>
<tr>
<td>Status</td>
<td>Shows the Demand Plan status</td>
<td>Invalid/valid</td>
</tr>
<tr>
<td>Enable Forecast Explosion</td>
<td>If this item is checked, it activates Dependent Demand explosion process</td>
<td>Checked or unchecked</td>
</tr>
</tbody>
</table>
for the Product dimension, one can choose the Product Family hierarchy or the Product Category hierarchy or both.

To define Demand Plan Hierarchies:

1. In the Navigator, choose Demand Plan Definitions > Demand Plan Hierarchies.
   The Demand Plan window appears.
2. Click the DP Hierarchy button.
   The Demand Plan Hierarchies window appears.
3. Either select Copy All or individually select hierarchy names for the dimension.

Figure 18–11   The Demand Plan Hierarchies window
Use this window to associate hierarchies with a Demand Plan. You can select only the hierarchies that belong to the demand planning dimensions that are collapsed into the user dimensions for this Demand Plan. The user can click on Copy All to select all hierarchy names associated with a user dimension.

In this example, all hierarchy names are being associated with the geography user dimension for the seeded Demand Plan.

4. Complete the fields in this window as shown in the following table:

<table>
<thead>
<tr>
<th>Field</th>
<th>Function</th>
<th>Legal Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Demand Plan</td>
<td>Demand Plan Name</td>
<td>VARCHAR2(30)</td>
</tr>
<tr>
<td>User Dimension</td>
<td>The User Dimension defined from the Demand Planning Dimensions for the Demand Plan</td>
<td>From selected dimension in the Demand Planning window</td>
</tr>
<tr>
<td>Hierarchy Name</td>
<td>Name of the Hierarchy</td>
<td>List of Values</td>
</tr>
<tr>
<td>Dimension Name</td>
<td>Demand Planning Dimension associated with the Hierarchy Name</td>
<td>Populated automatically</td>
</tr>
</tbody>
</table>

**Input Parameters**

Input Parameters determine the data that will be imported into Oracle Express for creating and analyzing forecasts. Multiple inputs can be specified and used in different Scenarios.
To define Input Parameters:

1. In the Demand Plans window, click on the Input Parameters tab.

**Figure 18–12  The Demand Plan Parameters window**

Use this window to specify the various inputs to the Demand Planning engine. You can specify any one of the following kinds of input parameters: manufacturing forecast, booking history, shipment history, sales forecast, sales opportunities, and other scenarios from different Demand Plans.

You can also specify a historical or future date range depending on the type of input parameter that needs to be uploaded into Oracle Express. You can filter or group the information that is uploaded using the view name associated with every input parameter. For each one of the input parameters you can select the fact information you want to work with, such as quantity used, manufacturing forecast, forecast by shipment and booking history, amount used for sales forecast, and forecast used for input scenario.

2. Complete the fields in this window as shown in the following table:
## Defining a Demand Plan

<table>
<thead>
<tr>
<th>Field</th>
<th>Function</th>
<th>Legal Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Type of Input Parameter</td>
<td>Lookup Values</td>
</tr>
<tr>
<td>Name</td>
<td>Manufacturing Forecast Name</td>
<td>VARCHAR2(240)</td>
</tr>
<tr>
<td>Start Date</td>
<td>Start Date for the Type of Input Parameter</td>
<td>DATE</td>
</tr>
<tr>
<td>End Date</td>
<td>End Date for the Type of Input Parameter</td>
<td>DATE</td>
</tr>
<tr>
<td>Forecast by</td>
<td>This is specific to Booking History and Shipment History Input Parameters</td>
<td>Lookup Values (1: Booked Date, 2: Shipped Date, 3: Requested Date, 4: Promised Date)</td>
</tr>
<tr>
<td>Quantity Used</td>
<td>This is specific only to the Manufacturing Forecast</td>
<td>Lookup Values (1: Original Quantity, 2: Current Quantity)</td>
</tr>
<tr>
<td>Forecast Used</td>
<td>This is specific only to the Input Scenario Name</td>
<td>Lookup Values (1: Overridden Forecast, 2: Baseline Forecast)</td>
</tr>
<tr>
<td>Fact Type</td>
<td>This is specific to the Manufacturing Forecast, Sales Forecast, Opportunity History, and Input Scenario</td>
<td>Lookup Values (1: Partially Recalculable, 2: Fully Recalculable, 3: Chaotic)</td>
</tr>
<tr>
<td>View Name</td>
<td>This is an optional field for all the Input Parameters you can use to write your own view to filter and group the fact data so that only the relevant information is uploaded into Oracle Express</td>
<td>VARCHAR2(30)</td>
</tr>
<tr>
<td>Publish</td>
<td>If checked, this option indicates that the scenario will be published back to the planning server.</td>
<td>Unchecked or checked (default). The demand plan is accordingly validated later.</td>
</tr>
<tr>
<td>Enabled</td>
<td>If checked, this option indicates that the scenario will be visible to DPE.</td>
<td>Unchecked or checked (default)</td>
</tr>
</tbody>
</table>
Scenarios

Scenarios represent forecasts from multiple sources like marketing, sales, customer, or statistical. A scenario may also represent a set of forecasting assumptions, such as 5% economic growth, a certain set of new product introductions, or the implementation of a promotion campaign. A Demand Plan can contain multiple Scenarios.

The output level of the scenario should reflect the level of detail required by the customer of your forecast.

To define Demand Plan Scenarios:

1. In the Demand Plans window, click on the Scenarios tab.
   The Demand Plan Scenarios window appears.

   Use this window to define scenarios for a Demand Plan. Specify the following:
   a scenario name, the time level at which the forecast needs to be published back
   from DPE to the Planning Server, the time frame in which this scenario needs to
be generated, information about the type of history to be used for generating the forecast, and the specific period type to be used for generating the forecast.

2. Complete the fields in this window as shown in the following table:

<table>
<thead>
<tr>
<th>Field</th>
<th>Function</th>
<th>Legal Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Scenario Name</td>
<td>VARCHAR2(30)</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed Description for the Scenario</td>
<td>VARCHAR2(240)</td>
</tr>
<tr>
<td>Output Period Type</td>
<td>The Time Level at which the Scenario will be published back from Oracle Express to the Planning Server</td>
<td>Lookup Values</td>
</tr>
<tr>
<td>History Start Date</td>
<td>The Start Date of the historical data used for forecasting</td>
<td>DATE</td>
</tr>
<tr>
<td>History End Date</td>
<td>The End Date of the historical data used for forecasting</td>
<td>DATE</td>
</tr>
<tr>
<td>Horizon Start Date</td>
<td>The Start Date for the Scenario</td>
<td>DATE</td>
</tr>
<tr>
<td>Horizon End Date</td>
<td>The End Date for the Scenario</td>
<td>DATE</td>
</tr>
<tr>
<td>Forecast Based On</td>
<td>The type of history used to generate the forecast for this Scenario</td>
<td>Lookup Values (1: Booking History, 2: Shipment History)</td>
</tr>
<tr>
<td>Forecast Period Type</td>
<td>This is a specific Period Type used to generate the forecast for this Scenario</td>
<td>Lookup Values (1: Booked Date, 2: Shipped Date, 3: Requested Date, 4: Scheduled Date, 5: Promised Date)</td>
</tr>
</tbody>
</table>

3. Open the Scenario Output Levels window by selecting the Output Levels button from the Demand Plan Scenario window.
Figure 18–14  The Scenario Output Levels window

Use this window to define the various levels in the Demand Planning Dimensions at which the forecast for this scenario is to be published from DPE to the Planning Server (except for the time dimension).

In this example, Level Item in the Product Dimension, Level Organization in the Ship from Location Dimension, Level Region in the Geography Dimension, and Level Sales Channel in the Sales Channel Dimension, will be the level of detail published back to the Planning Server for Scenario1.

4. Complete the fields in this window as shown in the following table:

<table>
<thead>
<tr>
<th>Field</th>
<th>Function</th>
<th>Legal Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scenario</td>
<td>Scenario Name</td>
<td>Lookup Values (this changes depending on what you selected in the Demand Plan Scenarios window).</td>
</tr>
<tr>
<td>Dimension</td>
<td>Demand Planning Dimension</td>
<td>Lookup Values</td>
</tr>
</tbody>
</table>

Implementing and Using Oracle Demand Planning  18-39
Defining a Demand Plan

Express Setup

To define Express Setup:

1. In the Demand Plans window, choose the Express tab.

   The Express Setup window appears.

   Figure 18–15 The Express Setup window

   Use this form to set up the Oracle Express system parameters for the demand plan.
2. Complete the fields in this window as shown in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Function</th>
<th>Legal Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shared DB Prefix</td>
<td>Express Database Names will be based on this value. If empty, will be defaulted to ODPxxx, where xxx is Demand Plan ID.</td>
<td>VARCHAR2(30)</td>
</tr>
<tr>
<td>Code Location</td>
<td>Express Code Databases Directory</td>
<td>VARCHAR2(80)</td>
</tr>
<tr>
<td>Shared DB Location</td>
<td>Express Databases Directory</td>
<td>VARCHAR2(80)</td>
</tr>
<tr>
<td>Express Port</td>
<td>Express Server Computer and Port Number</td>
<td>VARCHAR2(80)</td>
</tr>
<tr>
<td>OWA Virtual Path</td>
<td>Virtual Directory Path defined in the Oracle Express Web Agent Cartridge</td>
<td>VARCHAR2(240)</td>
</tr>
<tr>
<td>EAD Name</td>
<td>Express Server Instance Identifier</td>
<td>VARCHAR2(80)</td>
</tr>
<tr>
<td>Express Connect String</td>
<td>String needed for XRB to set EXPRESS_SNAPI Connection</td>
<td>VARCHAR2(80)</td>
</tr>
</tbody>
</table>

**Note:** This step is usually performed by the System Administrator.
Building a Demand Plan

Once the demand plan is defined, the next step is to build the demand plans in the DPE. In the course of building a demand plan, you will accomplish the following:

- Download data from DPS to DPE, so that forecasting and manipulation/analysis along multiple dimensions can be done.
- Verify that data has been downloaded successfully.
- Choose the statistical method to be used to generate the baseline forecast for each scenario (the initial forecast that the Demand Planner will then modify to produce a final forecast).
- Choose the dimension levels at which forecasts will be generated.
- Choose the allocation rule that will be used to derive detailed forecasts from more aggregate forecasts.
- Predefine reports to be made available to the individual demand planners.
- Set reason codes that can be used by demand planners when entering comments.

Building a demand plan is done by the Demand Planning Administrator.

Download Data from DPS to DPE

To download data from DPS to DPE:

1. Choose the Demand Plan Administrator responsibility.

2. Choose a demand plan from the list presented.
   A dialog box with the message, This plan does not exist. Do you wish to build it? appears.

3. Click Yes.
   The Demand Planning Administration window for DPE appears.

Note: If the demand plan is built for the first time, the user will be required to enter their user id and password.
4. Expand the hierarchical tree display on the left side of the window by clicking on the plus sign beside the demand plan name.

5. Click on Batch Log.

6. When the Batch Log displays Finished Downloading Data from Planning Server, the DPS to DPE download process is complete.

Choose Statistical Forecasting Method

To choose the statistical forecasting method to be used for a scenario within a demand plan:

1. Select Output Scenarios in the left-hand pane.
2. Select the scenario name in the right-hand pane.
3. Click the Properties button.
4. The Scenario Properties window appears.

Figure 18–17 Scenario Properties

5. Click the Forecast Method tab.
6. Select one of the available methods from the drop-down menu. See Note below.
7. Click OK.
Choose Forecast Levels

To choose the dimension levels at which Oracle Demand Planning will generate statistical forecasts:

1. Select Output Scenarios in the left-hand pane.
2. Select the scenario name is the right-hand pane.
3. Click the Properties button.
4. The Scenario Properties window appears

Note: For Auto mode, choose Automatic Best-Fit. Even for Manual, choose Automatic Fit unless there is sufficient evidence from detailed (but not necessarily exhaustive) data analysis that a specific model and a given parameter set always perform better. The Automatic Best-Fit searches exhaustively through all the data, and as a baseline model, this could be preferred as detailed analysis might not be possible at the Demand Planning Administrator level. Choice of other methods and parameters could always be done by the individual Demand Planners on their personal database.
5. Click the Forecast Levels tab.

6. Click in the Level field beside each dimension. Select the desired forecast level for that dimension.

7. Click OK.

Choosing forecast levels defines the aggregate level at which forecasts are to be generated. If the leaf nodes (bottom level) are specified, the variations in the data might be large causing decreased forecast ability and high forecast variability, and these might get magnified at the aggregate levels. If top nodes are specified, the forecasts after aggregation might pick up localized trends and allocate them wrongly (for example, if demand only increases for one product in a family, and forecasts are generated only at the product family level, the results of allocation could show that all products in the family have higher demand). A middle level selection for forecast output is recommended.

The DPA also needs to make a choice on the time dimension for forecasting. Depending on the calendar and the granularity desired, an appropriate dimension such as month should be selected. Important factors, once again, are the volatility of
the data sparsity and the memory and storage requirements for the computer. The screen shot shows the selection window for a specific scenario A1_BOOKED.

**Choose Allocation Rule**

Once forecasts are generated, allocation rules are used to explode data down to lower dimension level values.

The allocation rule that best preserves the trends and does not need too much heuristics is the one based on forecasts generated at all levels. This should be the preferred method, even though it is more computationally expensive. The three allocation methods are:

- **Lowest level** - Dynamic allocation weights based on forecast trends evident at the leaf or bottom level. This means the proportions are based on forecast trends at the bottom level rather than history. Use of trends results in time-varying weights at the bottom level. The higher level values are then rolled-up from the bottom.

- **Each level** - Weights are based on forecast trends evident at each level.

- **Historical weights** - This means that quantities for forecasts at lower levels will be prescribed in the same proportion as found in the historical data. The allocation does not change over time. This is the fastest method.

**To choose the allocation rule for a scenario:**

1. Select Output Scenarios in the left-hand pane.
2. Select the scenario name in the right-hand pane.
3. Click the Properties button.

   The Scenario Properties window appears.
4. Click the Allocation Rule tab.

5. Click one of the three allocation methods.

6. Click OK.

To set default dimension levels and default measures for reports:
1. Select Default Report Settings in the left-hand pane.

   The Default Report Settings window appears in the right-hand pane.
2. Select the desired default dimension levels and default measures in the right-hand pane.

Select Predefined Reports:

The DPA selects predefined reports to be used by the demand planners. For a detailed description of these reports please refer to Oracle Demand Planning User’s Guide, Section 6. There are 22 reports available. The default dimensions and dimension levels for reporting can be selected by the DPA.

To select predefined reports:

1. Select Report Selection in the left-hand pane.

The Report Selection window appears in the right-hand pane.
2. Check the desired dimensions for each report in the right-hand pane. The selected reports will be made available to each demand planner for the demand plan.

Set Comment Reason Codes

The DPA can set up reason codes that demand planners can use in their comments when forecasts are modified. This helps the demand planner to view the changes made by reason code during the planning process.

To set comment reason codes:

1. Select Comment Reason Codes in the left-hand pane.

The Comment Reason Code window appears in the right-hand pane.
2. Enter the reason code in the right-hand pane.
Demand Planner Assignment

The Demand Planning Administrator needs to assign the entire data (which is present in the shared database) to individual Demand Planners. The individual Demand Planners then can view their separate slices of the overall data in their personal databases. Data can be assigned at any level.

The Demand Planning Administrator needs to understand the responsibilities of the Demand Planners, then divide the data accordingly. For example, if the responsibility is by customer group, then appropriate customer groups should be assigned to individual Demand Planners.

One Demand Planner may have multiple assignments, but only one planner is allowed per assignment.

Overlapping assignments are technically allowed (with a warning from ODP), but are not sound business practice. This is because changes made in one demand planner's personal database will be overwritten by data in a second demand planner's personal database in the region where their two assignments intersect. The demand plan submitted by the last planner will prevail.

To assign data to individual demand planners:

1. Select Demand Planner Assignments in the left-hand pane.

   The Demand Planner Assignments window appears in the right-hand pane.
2. Click New.

3. Enter the Demand Planner ID from the list of values, and select the dimension level values to assign to the Demand Planner from the drop-down menus.

Use the buttons in this screen as shown in the following table:

<table>
<thead>
<tr>
<th>Button Name</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Enter another filename</td>
</tr>
<tr>
<td>Settings</td>
<td>Select the slice or data segment</td>
</tr>
<tr>
<td>Edit</td>
<td>Make changes to the assignment</td>
</tr>
</tbody>
</table>

To view the portion of the overall data that remains unassigned (as a check of whether the Demand Planner assignment process is complete):
1. Select Demand Planner Assignments in the left-hand pane.
2. Click Unassigned.
Generating Baseline Forecasts

The next step in the Demand Planning process is to generate baseline forecasts and distribute them to the individual demand planners. This is again done by the Demand Planning Administrator.

To generate baseline forecasts and distribute demand planning data to individual demand planners:

1. Select a demand plan and click the Start button.
2. Click on the radio button by Forecast Data and Distribute to Planners.
3. Click Apply.
4. Select Batch Log in the left-hand pane.
   The Batch Log window appears in the right-hand pane.

5. Once the distribution process is complete you should see Completed Forecasting and Distributing Data to Planners in the batch log in the right-hand pane.
Individual demand planners analyze the baseline forecasts, compare them with reference and event data (events are described later in this section), and modify the baseline forecasts. Demand Planners can generate their own variations of the baseline forecasts. For details, consult Demand Planning Users’ Manual. The following window shot shows forecast and history data for an item.
Demand Planner Responsibilities

The Demand Planner looks at his or her personal database (the segment assigned to him or her by the Demand Planning Administrator), the baseline forecasts, (generated by the Demand Planning Administrator in the shared database), and any reference scenarios defined during demand planning definition.

Choosing the Statistical Forecasting Model

The Demand Planner could use the Modify Forecast button to change the forecast methods:

1. Choosing a new statistical model type – There are two broad kind of models; regression models and exponential smoothing models. A time series typically has two components; a deterministic portion, and a non-deterministic or random component. The deterministic component is best handled through curve-fitting techniques like regression, while the random component can be modeled by exponential smoothing. Theoretically, depending on the degree of determinism in the data, one of the two methods could be chosen. In practice, quantifying the determinism, while statistically feasible, is not an easy task, and it might be just easier to try the various models and see how they perform on held-out data, or data not used during model fitting.

2. Choosing among regression models – The degree and nature of nonlinearity in the data determines the choice of a specific model. Linear regression models attempt to use historical data to calculate linear coefficients, modeling a future demand (dependent variable) as a function of previous demand (independent variable). All the nonlinear regression models used in ODP use linear regression equations, but on transformed data. Thus, while the relationships between the transformed variables are linear, the overall relation could be nonlinear. Linear regression is dealt with in elementary statistical textbooks. One way to determine the best model would be to look at the behavior of the dependent variable (or its transformations) as a function of the independent variable (or its transformations). The linear regression coefficient would indicate the degree of fit with the original or transformed data. Once again, it might be just easier to try the various models and see how they perform on held-out data, or data not used during model fitting.

3. Choosing among exponential smoothing models – The exponential smoothing models calculate future demand as a weighted sum of previous demand and previous forecasts for the demand. It could be shown through some mathematical manipulation that this is identical to forecasting future demand as a weighted function of all previous demands, with the value of the weights
decaying exponentially as one gets further back in time. Single exponential smoothing can model a random component. Double exponential smoothing could also handle trends, while triple or Holt-Winter’s handles trend and seasonality. Presence of trends and seasonality could be guessed at by visual inspection, or through statistical significance tests and measures like auto-correlation and spectral densities. As before, it might be just easier to try the various models and see how they perform on held-out data, or data not used during model fitting.

Choosing the Aggregate Level, Granularity, and Past Data

See the discussions for forecast level and historical time periods in the Demand Planning Administrator’s task list in the Demand Planning Roles section on on page 18-7.

Please note that computation performance is dependent only on the length of the input series; thus, granularity might be a factor.

Manipulating Demand Data

The Demand Planner is primarily responsible for using available information at all aggregate levels to edit baseline forecasts, either manually or through the data modification wizard. The Alerts maintained on the personal database could play a critical role, as forecast inaccuracy reports could be sent to the field. The Demand Planner must note that any locks put on the data are for the planner’s benefit only because they are lost in the shared database. Further, only the data at the leaf nodes (lowest aggregate level) are passed to the shared database. Thus, careful consideration must be given to ensure that information at higher aggregate levels are preserved. It is important to plan cooperatively with other Demand Planners who might have a different view of the data at lower aggregate levels, but identical views at higher levels.

The Demand Planner could choose to remove effects of causal factors and events (which are not expected to be repeatable) from the actual demand history. However, the history must be preserved, and a variant could be created, using the Modify Data button, or by editing manually. Once the effects of events are removed, the Demand Planner could choose to reforecast to determine what the future would look if there are no events. Finally, the planner could choose to apply known event factors to these new forecasts.

A Demand Planner has a number of options for generating new forecast data:
Demand Planner Responsibilities

- Copy, then manually modify demand history (the original demand history cannot be modified). Then generate a new statistical forecast on the basis of the modified demand history.
- Modify an existing forecast, or any portion of the forecast by reforecasting using a different statistical method.
- Manually modify cells of an existing forecast.
- Copy an existing forecast, then applying one of the above two modification methods.
- The Demand Planner chooses to which demand plan scenario a forecast should be tied.

Performing What-if Simulations
Editing capabilities of history and forecasts provide powerful tools for what-if simulations and planning. History could be subjectively modified to try and remove (or add) causal and event (real or hypothetical) effects. These could then be used to generate forecast variants to answer questions like what would happen if a promotion or a new product were introduced.

Reacting to Administrator Alerts and Maintaining Individual Alerts
The Demand Planning Administrator should notify individual Demand Planners if there has been a system-generated Alert in the shared database. To inform other Demand Planners and also organizations like sales and manufacturing about exceptions or variances, as well as to get inputs from knowledgeable sales personnel, the Demand Planner maintains Alerts on his or her personal database. These should be carefully thought out, and each user alerted should know his or her responsibilities.

Generating Predefined and Ad-hoc Reports
The Demand Planner can view predefined reports based on his or her data, and can also create ad-hoc reports of his or her own. These reports form powerful analytical tools for analyzing trends and adjusting forecasts.

Submitting Forecasts
After the Demand Planner is satisfied with the edited forecasts, he/she submits the forecasts for consolidation with other forecasts by other Demand Planners.
To submit a forecast:

1. Click on the Submit button in the forecast worksheet.
   The Submit Data window appears.

Figure 18–25  Submit Data

2. For each scenario of the demand plan, select a forecast to submit to represent that scenario from the drop-down menu.

3. Click OK.
Collect Forecast Data from Individual Demand Planners
Once the individual Demand Planners submit forecasts from the personal to the shared Express database for each forecast scenario, these are collected and rolled up to obtain the final consolidated forecast by the Demand Planning Administrator.

To collect final forecast data from individual demand planners:
1. Change responsibility to Demand Planning Administrator.
2. Select the demand plan. Click Start Demand Planning.
   The Demand Planning Administrator window appears.
3. In the right-hand pane, click Collect Forecasted Data from Planners.

4. In the Workflow Dates region, set the date at the beginning of which the collection will take place.

5. If desired, check Enable Reminder Messaging to send reminders to the Demand Planners of the submission deadline once per day for the number of days that you specify.

6. Click Apply.
7. Click on Batch Log in the left-hand pane to monitor process status. The process has completed once the message Completed Collecting Data from Planners appears in the batch log.

**Review Collected Forecast Data**
At this point the Demand Plan Manager may choose to review the overall forecast and make any revisions necessary.

➢ **To review the collected forecasts from the individual Demand Planners:**
1. Select the Demand Plan Manager responsibility.
2. Select the demand plan.
3. Click Start Demand Planning.
4. Make changes using the same methods as used by the individual Demand Planners.

**Upload Approved Forecast Data to the Planning Server**
After the Demand Plan Manager review, the Demand Planning Administrator may upload the approved forecast numbers back to the Demand Planning Server, where it can then be used by Oracle Advanced Supply Chain Planning.

➢ **To upload forecasts to the planning server (DPS):**
1. Select the Demand Planning Administrator responsibility.
2. Select the demand plan. Click Start Demand Planning.
3. In the right-hand pane, click Upload Forecasts to Planning Server.
4. Click Apply.
5. Click on Batch Log in the left-hand pane to monitor process status. The process has completed once the message Completed Uploading Data to the Planning Server appears in the batch log.

**Publish Forecast Data Back to the Source**
Once the forecast data reaches the planning server, it may be published back to the source Oracle Applications transaction system, where it can then (optionally) be loaded into a Master Demand Schedule for the purpose of consuming it against available sales orders.
Publishing of forecasts back to the planning server is optional, because Oracle Demand Planning scenarios can be directly read by Oracle Advanced Supply Chain Planning as independent demand. Consumption of forecasts is done directly inside Oracle Advanced Supply Chain Planning.

**Note:** In order for an ODP scenario to be published back to the source as a forecast, its output level in the Product dimension (as defined in the demand plan) must be at the Product or Product Family levels; its output level at the Organization (Ship From location) dimension must be at the Organization level. The Time dimension should be at the day level.

To publish forecast data back from DPS to an Oracle Applications source instance:

1. Select the Demand Planning Integration Administrator responsibility.
2. Choose Publish Forecast.

The Publish Forecast window appears.

*Figure 18–27  Publish Forecast window*
3. Complete the fields in this window as shown in the following table:

<table>
<thead>
<tr>
<th>Field</th>
<th>Function</th>
<th>Legal Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Demand Plan</td>
<td>The demand plan containing the scenario to be published back to the source.</td>
<td>List of values.</td>
</tr>
<tr>
<td>Scenario</td>
<td>The scenario to be published back to the source.</td>
<td>List of values</td>
</tr>
<tr>
<td>Out-of-calendar Dates</td>
<td>If a date in the scenario to be published falls outside the working days of the manufacturing calendar of the destination organization, perform the action listed here.</td>
<td>Reject, Shift Forward, Shift Backward This is applicable to manufacturing calendars with nonworking days in the week.</td>
</tr>
<tr>
<td>Instance</td>
<td>The instance code of the source instance to which the forecast will be published.</td>
<td>List of values</td>
</tr>
<tr>
<td>Forecast</td>
<td>The forecast name on the source. If this already exists, the existing forecast entries in the source will be overridden. If it does not already exist, it will be created.</td>
<td>Valid forecast name Select from LOV from source.</td>
</tr>
<tr>
<td>Forecast Set</td>
<td>The forecast set name on the source. If this already exists, the existing forecast entries in the source will be overridden. If it does not already exist, it will be created.</td>
<td>Valid database link name Select from LOV from source.</td>
</tr>
<tr>
<td>Demand Class</td>
<td>The demand class to which you would like to publish the forecast. Optional.</td>
<td>List of values</td>
</tr>
<tr>
<td>Level</td>
<td>This is for filtering any data that you do not want to publish.</td>
<td>Select from LOV.</td>
</tr>
<tr>
<td>Value</td>
<td>Value for the level specified in the previous field.</td>
<td>List of values.</td>
</tr>
<tr>
<td></td>
<td>This is for filtering any data that you do not want to publish.</td>
<td>This is for filtering any data that you do not want to publish.</td>
</tr>
<tr>
<td>Customer</td>
<td>The customer that you would like to associate with the forecast. Optional.</td>
<td>List of values</td>
</tr>
<tr>
<td>Location</td>
<td>The customer ship-to site for which you would like to publish the forecast. Optional. The customer field must be populated in order for this field to be populated.</td>
<td>Lookup values</td>
</tr>
</tbody>
</table>

4. Click Publish Forecast.
**Note:** If the demand class, customer or location fields are populated, only the elements from the scenario with demand class, customer and location dimension values matching the populated values will be published into the designated forecast.

Only one scenario with one demand plan can be published at a time.
Renewing the Forecasting Cycle

After one cycle is complete, DPS holds the following data:

- Data from the previous collection and pull.
- Demand Plans from previous cycle.

Any data collected or imported will override the data in the tables for the date range the data was collected. Incremental data can be imported if a nonoverlapping different date range is specified. This is something the Demand Planning Integration Administrator needs to consider before importing the next set of data. The issue is whether to add the last period incremental data from the source to the data already existing or refresh it completely. A purge option exists for purging all data in the fact tables before pulling the next cycle data.

To purge all data from the fact tables:
1. Select the Demand Planning Integration Administrator responsibility.
2. Select Other > Purge Fact Data.
   The Collection Utility window appears.
3. Click on the Parameters field.
4. Select the source instance whose fact data you would like to purge from the list of values.
5. Click OK.

Whether purging is done or not, data needs to be collected for the next cycle. As mentioned in connection with data collection, new data overwrites any existing data within the date range of the collection.

Collecting Data for the Next Forecast Cycle
Launch collections. In the Date From field, specify the date of the last collection. In the Date To field, specify today’s date.

Once data is collected and pulled into the fact tables, the Demand Planning Integration Administrator can either define a new demand plan or choose to use the previously defined demand plans. Also it is possible to copy a demand plan with a new name, modify it, and use it for the next forecasting cycle.

To copy a demand plan:
1. Select the Demand Planning Integration Administrator responsibility.
2. Navigate to Demand Plan Definitions > Demand Plans.
3. Select the demand plan to be copied, then click OK.
   The Demand Plans window appears.
4. Click the Copy To button.
   The Copy To window appears.

*Figure 18–28  Copy To window*

5. Enter the name of the new demand plan. All data fields are copied automatically.
6. Click OK.
Modifying a Demand Plan for the Next Forecast Cycle

These are the demand plan modifications that would make a demand plan suitable for a subsequent cycle in a demand planning process involving rolling forecasts.

- In the Input Parameters tab, roll the end (and possibly start) dates of booking and shipping histories forward by one forecasting period.
- In the Scenarios tab, roll the history start, history end, horizon start and horizon end dates for all scenarios forward by one forecasting period.

Details of how to make the above changes are covered in the section Defining a Demand Plan starting on on page 18-30.

Thus far we have described the basic ODP features and functions. The next few sections describe some advanced functionalities of ODP.
Events

This section provides a detailed discussion on how to define and manage events. Any occurrence that is expected to impact the sales or demand is termed as events here. Some different types of events are: promotions, new product introductions, cannibalization, phasing out products, store openings/closings, new features/changes in existing product, introduction of products to the new markets.

Any business needs to plan ahead for all these events and analyze their potential effect on future demand. The outcome of such an analysis may be in the form of a lift or modification factor. The positive modification factor would indicate increased sales while a negative modification factor would indicate cannibalization or reduced sales. For example, 10% reduction in the retail price of product A may result in a 15% lift in its sales but a 3% reduction in sales for product B.

Oracle Demand Planning has a user interface to define such events and their impacts on future sales that can vary by product, time, and market. The events so planned and defined are considered for calculating a demand forecast as shown in the figure below:

_Figure 18–29  Impact of an Event_
Feature Description

Types of Events Supported:

- **Promotions and other events**: Events for those existing products for which some history data is available to generate a baseline forecast and for which the impact of an event can be defined in terms of modification factors for base demand and price. Some such events are: price reductions to clear inventory, advertising campaigns, new product by the competition, and Christmas week sales promotion.

- **New product introductions and cannibalization**: Events for those existing or new products for which history data is not available but which are expected to sell, similar to some existing products with known sales history or forecast. The baseline forecast is generated on the basis of available data and can be modified by applying suitable modification factors. Some such events are: new product introductions or product introduction in new markets.

- **Product phase outs**: Events for products nearing the end of life when the sales of those products is expected to become flat or reduce at some rate to zero and the impact of event can be defined in terms of modification factors. Some such events are: removing a product from a certain market, product declared unsafe, or product replaced by the next generation.

Event-Modeling Capability

It is possible to specify all the items that the event affects and the time period for which the event is effective. The expected increase or decrease in demand and price for each event can also be specified. Any such impact of an event could be multiplicative, additive, or subtractive and the user is able to enter both the absolute values or the change in value. For example, if the event is a promotion or introduction of a product, the impact could be in the form of a increase by percentage modification factor. However, such an event may lead to cannibalization (reduced sales), or phase out of other products, for which the impact could be a decrease by percentage modification factor.

Different modifications factors can be specified for different time periods. For example, it is possible to specify percentage increase in demand by 10% and 20% for two different time periods within the effective period of a promotion.

Event impacts can also vary by region, market, sales channel etc. To model this requirement, different modification factors can be defined for any dimension (geography, sales channel etc.) supported by ODP. Within the dimension, different modifications can also be specified for various levels (region, country,
ship-to-location, etc. for the geography dimension) For example, it is common to see a marketing campaign that does well in one market and not well in another. Such situations can be handled by specifying a increase in sales by 10% for western region and a decrease in sales by 400 for the eastern region and the direct sales channel.

**Simulation Capability**
After the events have been completely defined, they can be associated with a scenario. Multiple events can be associated with a scenario and multiple scenarios are allowed to be associated with an event. This feature provides unlimited what-if events analysis capability. It may be recalled here that multiple scenarios can be defined within a demand plan in the demand planning server. For example, the optimistic forecast scenario may include promotions with higher estimate of increase in sales or lower estimate of reduction in price.

**Conflict Resolution**
If there is a conflict when a product is covered by two events, there exists a precedence logic to resolve it. Alternative events can be accurately modeled by assigning priority at the time of associating an event with the scenario. This obviates the need for multiple definitions of the same event just to change the priority. The priority determines the order in which the events are applied.

**Separate Statistical and Event Forecast**
The events associated with a scenario are applied on top of the statistical forecast to generate two more separate and similar event forecasts (editable baseline forecast and non-editable event forecast). For each event forecast, both quantity and revenue forecasts are generated in the Demand Planning Engine. The entire event-related information defined in the Demand Planning Server is suitably used to calculate the forecast for the items covered by that event.

**Business Application**
In order to increase the sales, clear excess inventory, expand existing markets or build new ones, improve margins, match the competition, or improve investor or company morale, events are planned by most companies. Because the company may be offering many similar products, increases in the sales of one product may cannibalize (reduce) the sales of other similar product. Introducing a new product may also reduce the sale of another similar spatial variety and may lead to end-of-life phasing out of an existing product. Such events and their impacts, different for
different dimensions, can be defined in the Demand Planning server at Events and Product Introductions under Demand Planning Integration Administration responsibility in the navigator window. The following window shows you where you can access Events and the type of events.

Scenario:
A company has two models, 00FLMA and 00FLMB, in the light motor car segment. It decides to introduce a new model 00FLMF on 1 June 2001. Hereinafter, these models are respectively called A, B, and F for simplicity. F is expected to sell 20% more during 2001 than what model A would have sold. The demand for A is expected to decrease by 50% due to introduction of F. The company also decides to reduce the price of model B by 5% starting 1 April 2001 only in the United States, which is expected to increase the sale of B in the United States by 10% for first two months but only 5% afterwards due to introduction of F. The company expects to phase out model A during the year 2002 as follows:

- United States only: 01/01/2002 to 03/31/2002 by 25%
- All geography: 04/01/2002 to 06/30/2002 by 25% and afterwards to death at the end of the year 2002.
To define a promotion:
1. From the Navigator, select Events and Product Introductions > Promotions and Other Events.
   The Promotions and Other events window appears.

   Figure 18–30  Promotions and Other Events window

2. Click on the Details button.
   The Details window appears.
3. Fill out the window using the information in the following table:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Date</td>
<td>First Row: 01-APR-2001</td>
</tr>
<tr>
<td></td>
<td>Second Row: 01-JUN-2001</td>
</tr>
<tr>
<td>To Date</td>
<td>First Row: 31-MAY-2001</td>
</tr>
<tr>
<td></td>
<td>Second Row: 31-DEC-2001</td>
</tr>
<tr>
<td>Qty. Modification Type</td>
<td>Both Rows: Increase by Percentage</td>
</tr>
<tr>
<td>Qty. Modification Value</td>
<td>First Row: 10</td>
</tr>
<tr>
<td></td>
<td>Second Row: 5</td>
</tr>
</tbody>
</table>

4. Price modification (5% for this scenario) can be specified by scrolling to the right and by:
   - Selecting Decrease by Percentage as the Price Modification Type for both the rows
   - Entering 5 as the Price Modification Value for both the rows

5. Click the Geography tab.
6. Select the following values:
   Geography column, first row: Country
   Geography Value column, first row: United State
   Geography column, second row: Country
   Geography Value column, second row: United States

At this point, you have modeled the following part of the scenario:
The existing forecast for B (from 1 April, 2001 to 31 December, 2001) in the United States is increased by 10% during 1 April, 2001 to 31 May, 2001 and by 5% during 1 June, 2001 to 31 December, 2001. The revenue forecast for B in the United States during the period from 1 April, 2001 to 31 December, 2001 decreases by 5%.

7. From the Navigator, select Events and Product Introduction > New Product Introductions and Cannibalization.
   The New Product Introduction window appears.
8. Fill out the window using the information in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>00FLM_newf</td>
</tr>
<tr>
<td>Type</td>
<td>Supercession</td>
</tr>
<tr>
<td>Description</td>
<td>Apr - Dec’01 campaign</td>
</tr>
<tr>
<td>Product Level</td>
<td>Item</td>
</tr>
<tr>
<td>Product</td>
<td>00FLMF</td>
</tr>
<tr>
<td>Start Date</td>
<td>01-JUN-2001</td>
</tr>
<tr>
<td>End Date</td>
<td>31-DEC-2001</td>
</tr>
</tbody>
</table>

9. Click the Details tab.
   
   The Details window appears.
10. Fill out the window using the information in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Date</td>
<td>01-JUN-2001</td>
</tr>
<tr>
<td>To Date</td>
<td>31-DEC-2001</td>
</tr>
<tr>
<td>Qty Modification Type</td>
<td>Increase by Percentage</td>
</tr>
<tr>
<td>Qty Modification Value</td>
<td>20</td>
</tr>
</tbody>
</table>

11. Close the Details window.

The New Product Information window reappears.

12. Click the Base Product button.

The Base Products window appears.
13. Fill out the window using the information in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product</td>
<td>00FLMA</td>
</tr>
<tr>
<td>Weight</td>
<td>100</td>
</tr>
<tr>
<td>Lag (Days)</td>
<td>n/a</td>
</tr>
<tr>
<td>History Start Date</td>
<td>default value</td>
</tr>
</tbody>
</table>

Though not required for this scenario, details for base products can also be entered. Also, any number of base products with varying weights (total should be 100) can be used to model the forecast of new product. Weight% for a base product determines the fraction of its forecast that is used as the forecast of the new product.


The New Product Information window reappears.

15. Click on Cannibalized Products button.

The Cannibalized Products window appears.
16. Fill out the window using the information in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product</td>
<td>00FLMA</td>
</tr>
<tr>
<td>From Date</td>
<td>01-JUN-2001</td>
</tr>
<tr>
<td>To Date</td>
<td>31-DEC-2001</td>
</tr>
<tr>
<td>Qty Modification Type</td>
<td>Decrease by Percentage</td>
</tr>
<tr>
<td>Qty Modification Value</td>
<td>50</td>
</tr>
</tbody>
</table>

At this point, you have modeled the following part of the scenario:

The existing forecast for A (from 1 June, 2001 to 31 December, 2001) is increased by 20% and is considered as the forecast for model F during the same period. On the other hand, the same existing forecast for model A is decreased by 50% and is considered as the new forecast for A.

17. From the Navigator, click on Events and Product Introductions > Product Phase Out.

The Product Phase Out window appears.
18. Fill out the window using the information in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>00FLM_outA</td>
</tr>
<tr>
<td>Description</td>
<td>00FLM_A phase out in 2002</td>
</tr>
<tr>
<td>Product Level</td>
<td>Item</td>
</tr>
<tr>
<td>Product</td>
<td>00FLMA</td>
</tr>
<tr>
<td>Start Date</td>
<td>01-JAN-2002</td>
</tr>
<tr>
<td>End Date</td>
<td>31-DEC-2002</td>
</tr>
</tbody>
</table>

If you want to start with the reduced forecast on 31 December, 2001 due to cannibalization as mentioned in step 16, the Start Date should be entered here as 31 December, 2001.

19. Click the Details button.

The Details window appears.
20. Fill out the window using the information in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Date</td>
<td>First Row: 01-JAN-2002</td>
</tr>
<tr>
<td></td>
<td>Second Row: 31-MAR-2002</td>
</tr>
<tr>
<td></td>
<td>Third Row: 30-JUN-2002</td>
</tr>
<tr>
<td>To Date</td>
<td>First Row: 31-MAR-2002</td>
</tr>
<tr>
<td></td>
<td>Second Row: 30-JUN-2002</td>
</tr>
<tr>
<td></td>
<td>Third Row: 31-DEC-2002</td>
</tr>
<tr>
<td>Qty Modification Type</td>
<td>All three rows: Decrease by Percentage</td>
</tr>
<tr>
<td>Qty Modification Value</td>
<td>First Row: 25</td>
</tr>
<tr>
<td></td>
<td>Second Row: 25</td>
</tr>
<tr>
<td></td>
<td>Third Row: 100</td>
</tr>
</tbody>
</table>

21. Click the Geography tab.
22. Fill out the window using the information in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Geography</td>
<td>First Row: Country</td>
</tr>
<tr>
<td></td>
<td>Second Row: All Geography</td>
</tr>
<tr>
<td></td>
<td>Third Row: All Geography</td>
</tr>
<tr>
<td>Geography Value</td>
<td>First Row: United States</td>
</tr>
<tr>
<td></td>
<td>Second Row: All Geography</td>
</tr>
<tr>
<td></td>
<td>Third Row: All Geography</td>
</tr>
</tbody>
</table>

At this point, you have modeled the following part of the scenario:

For United States: The forecast for A linearly decreases by 25% on 31 Mar, 2002 from its value on 1 January, 2002 and then by another 25% on 30 June, 2002 from its decreased value on 31 Mar, 2002. It reduces to zero on 31 December, 2002 from the reduced value on 30 June, 2002.

23. Follow all the instructions in the Defining a Demand Plan section starting on page 18-30. Stop after performing the first step in the Scenarios section (on page 18-37). At the end of that step, click the Events button.

24. The Scenario Events window appears.

*Figure 18-40 Scenario Events*

25. Associate the three defined events; promotion (steps 1 through step 6), new product introduction (steps 7 through 16), and product phase out (steps 17 through 22) to a scenario and specify priority for each association as shown in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scenario</td>
<td>Default value</td>
</tr>
<tr>
<td>Event Name</td>
<td>Select the event name</td>
</tr>
<tr>
<td>Priority</td>
<td>Enter the priority number</td>
</tr>
</tbody>
</table>

Priority indicates the order in which the events are applied. Within the same priority, the events are applied in the order of their creation in the system and thus the event priority should always be specified. When the corresponding
demand plan is used to generate the forecasts in the Demand Planning Engine, these events would be included in the event forecast.

Promotions

**Mandatory and Optional Promotions**

There are two types of promotions that can be defined at step 1 in the Events section: mandatory and optional.

---

**Note:** Throughout these sections, all references to steps refer to the steps in the Events section.

---

Mandatory promotion means that it is applied regardless of whether another promotion has been applied, while the optional promotion is applied only when a mandatory promotion for the same item has not been applied. In addition to this, a priority can also be specified to resolve any conflicts between the two promotions of the same type. However, this priority is overridden by the priority specified at the time of associating a promotion to a scenario (see step 25). Two or more promotions can also be specified in one window, in which case the priority or the promotion type is the same for both promotions. In this situation, the promotions are applied in the order they are defined.

For example, if two mandatory promotions are defined during the same time period, first one at all product level with 10% modification factor and second for item A with 20% modification factor, these promotions would be applied successively. The result would be a lift of 10% for all products except for item A, which would have a 20% lift on top of the 10% lift.

**Types of Modification**

Multiple time periods with varying modifications can be defined for any promotion as shown in steps 2 and 4. For each time period and quantity modification, one price modification type and value can be selected.

The quantity modification types are:

- increase by percentage, decrease by percentage, increase by quantity, decrease by quantity, and absolute

The Price modification types are:
Events

- increase by percentage, decrease by percentage, increase by quantity, decrease by quantity, and absolute

Promotion Details
While all other events can be defined for a product, the promotions can also be specified at other levels in the product dimension; product category and product family. For each promotion at least one detailed entry needs to be made under Details as shown in steps 2 and 4. This includes the time period (From Date and To Date), type of modifications (for quantity as well as price), and corresponding modification values. Various dimension levels and values can also be entered for each detail as indicated in step 3. The values for the From Date and To Date in steps 2 and 4 are defaulted from the Start Date and End Date on the main form in step 1. These values can be modified by the user.

New Product Introductions and Cannibalization

Life cycle and supersession based new product introductions
The information about the existing products is used for generating forecasts for new products as there are no historical data to use as a starting point. Any new product introduction (called NPI hereinafter) can be modeled in two distinct ways (refer to steps 7 and 8). These are:

- Life Cycle - Based on history of an existing product. The historical sales data of any existing product for any specified period is considered as the history data for the new product with some time difference that can also be specified by the user.
- Supersession - Based on future demand forecast of an existing product. It is assumed here that the new product will replace the existing product at a certain point in time in future. Thus the forecast of the existing product after that time is treated as the forecast for the new product with some modifications that can be specified by the user.

Types of Modification
Multiple time periods with varying modifications can be defined for any NPI (refer to steps 9 and 10. There are no price modifications allowed for NPI events. The quantity modification types are: increase by percentage, and decrease by percentage
Details of New Product Introductions
Additional information for an NPI is entered under Details as shown in steps 9 and 10. For each NPI event at least one detailed entry needs to be made. This includes the time period (From Date and To Date), type of modifications (for quantity only), and corresponding modification values. The values for the From Date and To Date in steps 9 and 10 are defaulted from the Start Date and End Date on the main form in steps 7 and 8. These values can be modified by the user. Various dimension levels and values can also be entered for each detail. If no qualifications are specified, the event applies to all levels.

Details of Base Products
For products that do not have historical sales data available, it is possible to specify the history or forecast of any number of existing products to base the forecast on (refer to steps 12 and 13). Details for such base products can also be specified. For example, it is possible to use historical data of a base product for any region to model a new product that is being introduced only in a certain region. If more than one base products are used, the relative weight (e.g., 30% of the forecast for base product A and 70% for B) for each base product can be specified. The base product value, weight, and lag is entered using the Base Product button. The lag (in days) will need to be entered only in case of life cycle (history-based) NPI (not applicable for the supersession-based NPI). The number of days entered in the Lag field is deducted from the introduction date of the new product being introduced. The new date arrived at from this calculation is defaulted in the History Start Date field.

Additional dimension information for any base product can be entered under the Base Product Details. For each base product, a different level can be selected for any of the six dimensions and two user-defined dimensions. If no details are specified for the base products, all their available history/forecast (for all dimensions) is used as basis for the NPI.

Details of Cannibalized Products
Introduction of a new product may reduce sales (cannibalization) of some existing products (refer to steps 15 and 16). Any number of products for which the sales will be reduced due to the respective NPI can be selected under Cannibalized Products. Time period and quantity modification can be defined for each cannibalized product. The only quantity modification type is decrease by percentage.
Product Phase Outs

Linear and Nonlinear Phase Outs
Sales promotion or a new product introduction may not only reduce the sale of another similar spatial product but may also lead to end-of-life phasing out of an existing product. Phasing out products is a conscious decision on the part of an organization. Product phase out can be linear or nonlinear. Nonlinear phase out essentially means phase out with multiple gradients and is achieved by defining multiple time periods with varying modification factors. This was shown in steps 19 and 20. If multiple time periods with varying modification factors are not defined, the forecast is linearly reduced to zero at the end of the specified phase out period.

Types of Modification
Multiple time periods with varying modifications can be defined for any phase out (refer to steps 19 and 20). There are no price modifications allowed for NPI events. The quantity modification types are: decrease by percentage, and decrease by quantity.

Product Phase-Out Details
Defining product phase outs is similar to defining promotions and new product introductions and can be accomplished from Product Phase Out in the main navigator window. Additional information for the phase out is entered under Details as shown in steps 19 and 20 and steps 21 and 22. This includes the time period (From Date and To Date), type of modifications (for quantity only), and corresponding modification values. The values for the From Date and To Date in steps 19 and 20 are defaulted from the Start Date and End Date on the main form in steps 17 and 18. These values can be modified by the user. If no details are entered, the forecast for the product from the start date will be linearly reduced to zero at the end date. Various dimension levels and values can also be entered for each time period and modification detail. If no qualifications are specified, the event applies to all levels. If there is no entry to completely phase out the product, a warning is given to the user suggesting the necessity to enter detail whereby Modification Type is set to decrease by percentage and Modification Value is set to 100. For example, in the scenario described in the earlier section, if the following details are entered at steps 19 through 22:

- United State: 1 January 2002 to 31 Mar 2002 decrease by 25%
- All geography: 31 Mar, 2002 to 30 June 2002 decrease by 25%
Then, everything remains the same except that after 30 June 2002 the forecast flattens out; that is, its value remains unchanged until 31 December 2002.

**Setups and Related Details**

No separate set up is required for events. However, some validations are performed by the system as under:

- Date validation: The From Date and To Date values on the details form should be between the Start Date and End Date on the main form.

- Increase by Percentage: If this has been selected as the modification type, the value should be zero or greater.

- Decrease by Percentage: If this has been selected as the modification type, the value should be between zero and 100.
Forecasting for Dependent Demands

Dependent Demand Forecasting is the capability to forecast demand for partially or fully dependent items, i.e., products whose demand depends wholly or in part on the demand for another independent product. The forecasts for that independent product needs to be broken down into components based on percentage rates obtained from the bills of material. The total demand for any item is the sum of the dependent and independent components of demand. For example, the demand for computer monitors is a composite of its direct demand and the demand deriving from the sale of PC Systems.

This section provides a detailed discussion on the dependent demand explosion functionality, whereby the forecast for one item is used to derive the forecast for another related item.

Feature Description

Forecasting Dependent and Independent Demand
The dependent demand forecast for a dependent item is calculated by exploding the forecast from its respective parents using the corresponding bills of material. The independent demand forecast is generated on the basis of the independent history for the item. Multilevel explosions are possible as explained in the next section.

Forecast Explosion
The dependent demand explosion feature is calculation intensive. Moreover, this functionality may not be used by all the companies. Therefore, an Enable Forecast Explosion check box is provided on the Demand Plans form. This check box remains turned off by default and should be checked to enable the forecast explosion functionality for a demand plan. It is thus possible to not use this functionality for one demand plan while enabling it for another demand plan.

To enable forecast explosion for a demand plan:

1. Select the Demand Planning Integration Administrator’s responsibility.
2. From the Navigator, select Demand Planning Definition > Demand Plans.
   The Demand Plans window appears.

Implementing and Using Oracle Demand Planning
3. Check or uncheck the Enable Forecast Explosion box.

**Business Application**

Dependent demand is characterized by the notion that the demand for some products depends on the demand of some other products. Some of the typical questions that are addressed by dependent demand forecasting are:

- Auto Manufacturer: How many alloy wheels or V6 engines would be sold?
- PC Manufacturer: How many total hard disks would need to be manufactured, of them how many would sell as part of a new PC and how many would sell individually?

The business need supported is to generate forecasts for options and mandatory items within models in short product life-cycle situations. In these situations, historical data are limited and therefore it is preferable to generate the item-level forecasts by applying planning factors to forecasts for models. The typical business flow would be:

- From sales history for models, a model forecast is derived
Item-level forecasts (for options and mandatory items) are derived by applying planning factors to the model forecast. Item-level forecasts are analyzed and updated as required in multiple dimensions. Forecast is published for supply planning (Advanced Supply Chain Planning module) where it is consumed by sales orders and a supply chain plan allocating supply to combined sales order and consumed forecast demand is generated.

A possible business scenario might be one in which components of a typical PC system are sold as a part of the computer configuration as well as independent components. The total demand is calculated by the system as follows:

- By forecasting computer demand based on its sales history
- By exploding this forecast to the components using the planning factors specified in the model bill for the computer (this is the dependent demand)
- By forecasting independent demand for components based on their independent history
- By suitably adding the independent and dependent portions to find out total demand

The following table shows the independent and dependent demands for the model, standard items, option class, and options of a computer system being manufactured.

<table>
<thead>
<tr>
<th>Configuration</th>
<th>Type</th>
<th>BOM Planning Factor</th>
<th>Generated Forecast (based on independent history)</th>
<th>Derived Forecast (dependent portion of demand)</th>
<th>Total Forecast</th>
</tr>
</thead>
<tbody>
<tr>
<td>Computer Model, A500</td>
<td>ATO Model (Parent Item)</td>
<td>n/a</td>
<td>1000</td>
<td>n/a</td>
<td>1000</td>
</tr>
<tr>
<td>Monitor, 66MHz</td>
<td>Standard item (Child of Computer)</td>
<td>80</td>
<td>300</td>
<td>800</td>
<td>1100</td>
</tr>
<tr>
<td>CPU</td>
<td>Standard item (Child of Computer)</td>
<td>100</td>
<td>50</td>
<td>1000</td>
<td>1050</td>
</tr>
<tr>
<td>CD Drive</td>
<td>Option Class (Child of Computer)</td>
<td>50</td>
<td>200</td>
<td>500</td>
<td>700</td>
</tr>
</tbody>
</table>
The demand planner, responsible for planning monitors, can see both the independent and dependent portions as well as the total demand for the monitors. To use this functionality, the following additional steps are required before starting the normal forecasting process:

- perform setups and BOM collections (if not already completed) as explained in Setups and Related Details starting on page 18-92.
- enable the forecast explosion on the demand plan form

The remaining process is the same; the demand plan is defined in the Demand Planning Server and, based on the demand plan, all the forecasts show up in the Demand Planning Engine. For each demand plan, one baseline forecast for independent demand is generated by the system. In addition, the system generates three statistical forecasts (dependent, independent, and total). The statistical forecasts are not editable, and are used for reference purposes, while the baseline forecast can be updated.

The changes in the baseline forecast are reflected in the total statistical forecast. When the demand planner submits the edited baseline forecast, the dependent and total statistical forecasts are also submitted along with it. The dependent forecasts are updated in the shared database on the basis of the independent forecasts submitted by the individual planners. Finally, all the forecasts are sent back to the Demand Planning Server.

### Setups and Related Details

#### Forecast Control

Forecast control of an item determines how the demand for the item is forecast. The forecast control for an item in Demand Planning is the same as that at the source ERP applications. Only those items that have forecast control setup as consume or

---

<table>
<thead>
<tr>
<th>Configuration</th>
<th>Type</th>
<th>BOM Planning Factor</th>
<th>Generated Forecast (based on independent history)</th>
<th>Derived Forecast (dependent portion of demand)</th>
<th>Total Forecast</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read/Write CD Drive</td>
<td>Option (Child of CD Drive)</td>
<td>80</td>
<td>100</td>
<td>400</td>
<td>500</td>
</tr>
<tr>
<td>Read Only CD Drive</td>
<td>Option (Child of CD Drive)</td>
<td>20</td>
<td>80</td>
<td>100</td>
<td>180</td>
</tr>
</tbody>
</table>
consume and derive are collected by Demand Planning. The dependent demand portion is calculated for items with forecast control set as consume and derive. The forecast control for an item can be set up in the source Oracle Inventory application from the Item/Master Item menu under the MPS/MRP Planning tab. Forecast control can be one of the following three types:

- **Consume** - Consume is a forecast control, which when associated with an item, identifies that the item has only independent demand. For example, the Dell computer model - Dimension L500

- **Consume and Derive** - Consume and derive is a forecast control, which when associated with an item, identifies that the item has both independent demand and dependent demand.

- **None** - Items for which forecast control is set to None are not read into Demand Planning.

Only the forecast control item attributes from the master organization are used for forecasting. This means that if the forecast control attribute for an item is different in the master organization and in any other inventory organization, the one for the master organization is used even for the inventory organization. This is further explained in the Bill of Material section starting on page 18-94.

**Note:** Items with an MRP Planning Method of Not Planned are not brought into Demand Planning for forecasting.

---

**Bill of Material Item Type**

The type of an item is important in the context of bills of materials and is the same as BOM_ITEM_TYPE in the source ERP instance. Item Type can be set up in the source Oracle Inventory application from the Item/Master Item menu under the Bills of Materials tab. The five possible values are:

- **Model:** This item's bill of material lists option classes and options available when you place an order for the model item. Forecast for models with forecast control of consume is generated based on the shipment/booking history of models.

- **Option class:** This item's bill of material contains a list of related options. Option classes group like options together. Model forecasts are exploded down to the option class level for those items that have a forecast control attribute of consume and derive.
Planning: This item’s bill of material contains a list of items and planning percentages. A planning item can represent a product family or demand channel. The total component planning percentages on a planning bill can exceed 100%. This is neither brought in nor used in ODP.

Standard: This is any item that can have a bill or be a component on a bill, except planning, model, or option class items. Standard items include purchased items, subassemblies, or finished products. In ODP, bills for standard items are not exploded further.

Product family: A product family is a grouping of products whose similarity in resource usage, design, and manufacturing process facilitates planning at an aggregate level. To explode the forecast from the Product Family to product family member items, predefined allocation rules in ODP are used in place of using the planning percentages.

Bill of Material
The forecasts for components (or any dependent item) are generated using bills of material (BOM) from the source ERP application. The planning percentages can be setup in the Oracle BOM application from the Bills of Materials/Bills menu under the Component Details tab. The figure below is a sample BOM for a car.

```
<table>
<thead>
<tr>
<th>Car [F/C = C]</th>
</tr>
</thead>
<tbody>
<tr>
<td>--- Steering Column (1 per Car) Planning Factor = 100% [F/C = C &amp; D]</td>
</tr>
<tr>
<td>--- Door (2 per Car) Planning Factor = 100% [F/C = C &amp; D]</td>
</tr>
<tr>
<td>--- Sunroof (1 per Car) Planning Factor = 50% [F/C = C &amp; D]</td>
</tr>
<tr>
<td>--- Alloy wheel (1 per Car) Planning Factor = 50% [F/C = C &amp; D]</td>
</tr>
</tbody>
</table>
```

F/C = forecast control
C = consume
C & D = consume and derive

Organizations
Different bills of material may exist for different organizations. If the master and inventory organizations have different bills, dependent demand explosions are...
performed on the basis of attributes (forecast control and planning method) defined in the master organization and the bills (and planning percentages) defined in the respective inventory organizations. In the figure shown below, the explosions are still performed for the assembly in the inventory organization even though the assembly’s forecast control is set to none.

Conversely, if the assembly has forecast control as None in the master organization and consume & derive in the inventory organization, dependent demand explosions are not performed for the inventory organization. This is true for differences in forecast control attribute at all levels in the bills of materials. This is because in ODP the bills are collected for all the organizations, while the items pertain only to the master organization. Thus, the assumption here is that the critical items that need to be forecast will in general be common across multiple ship-from organizations. In other situations, the source setups should be accordingly affected.

If there are multiple master organizations, any one of them can be selected from the profile option, MSD_MASTER_ORG, in the source ERP applications. This is a site-level profile option accessible under the System Administrator responsibility. The forecast control attributes pertaining to the selected master organization are used in ODP. If more than one master organizations exists and none is chosen from the above mentioned profile option, the first queried master organization is used by the system. There is no default value and a warning is displayed to the user indicating the fact that a master organization has been picked at random. If there is only one master organization, it is picked by the system without any warning.

**Data Collection**

In addition to the existing collections (collect and pull fact data, level values, time data, and pricing data), BOM Collections, under Collections on the navigator window for demand planning administrator responsibility, needs to be run to collect the bills of materials.
From the BOM Collections menu, a Planning Data Collection window opens up which shows that the Demand Planning BOM Data Collection program is a two-step concurrent report set. Firstly, the Demand Planning BOM Data Collect program collects the BOM data from the source instance into the MSC_ST_BOM and MSC_ST_BOM_COMPONENTS tables in the staging area of the ASCP component. From there, the Demand Planning BOM Data Pull program takes the data and populates the MSC_BOMS and MSC_BOM_COMPONENTS tables in the fact area of the ASCP component.

Both the programs run automatically, i.e., the user needs to submit the report set request only once. The following parameters can be defined before submitting the request.

- **Instance**: Source applications instance from where the bills of material would be collected.
- **Number of workers**: Number of concurrent workers to be launched in this collection process. The default value is 2.
- **Time out (Minutes)**: If not completed within this time, the collection program times out. The default value is 30 minutes.
- **Language**: Language used. For example, American English.

For the legacy systems, BOM data should be populated into the staging tables, MSC_ST_BOM and MSC_ST_BOM_COMPONENTS. The concurrent ASCP program, Planning ODS Load, can then be run to populate the corresponding fact tables.

**Example**

The following figure showing a sample model bill is used to elucidate the forecast explosion calculations.
PF: Planning Factor value (For immediate parent)

FC: Forecast Control (C: Consume, C&D: Consume & Derive, N: None)

**Assumptions for the Sample Model Bill:**

For all the components, quantity per item is one.

Except for Model 1, Model 2, and Std Item 1, other components do not have any independent demand or history and their demand depends only on its corresponding parent items.

Assume that for the sample model bill, Model 1 has only independent demand and Model 2 as well as Std Item 1 have both independent and dependent demand. The remaining components have only dependent demand. The system will forecast for Model 1, Model 2, and Std Item 1 based on their independent histories, and explode the forecast for all items with consume and derive forecast control from their respective parents.
The forecasts for Model 1, Model 2, and Std Item 1 are calculated from history. The forecasts for all items with consume and derive are then exploded from their parent assemblies.

The following table shows the results of the forecast calculations for the sample model bill.

<table>
<thead>
<tr>
<th>Level</th>
<th>Item</th>
<th>BOM Type</th>
<th>Forecast Control</th>
<th>Planning %</th>
<th>Independent Forecast</th>
<th>Dependent Forecast exploded from Model 1’s forecast</th>
<th>Dependent Forecast exploded from Model 2’s forecast</th>
<th>Total Demand</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Model 1</td>
<td>Model</td>
<td>C</td>
<td>n/a</td>
<td>1000</td>
<td>n/a</td>
<td>n/a</td>
<td>1000</td>
</tr>
<tr>
<td>2</td>
<td>std Item1</td>
<td>Std Item</td>
<td>C&amp;D</td>
<td>100%</td>
<td>1200</td>
<td>1000</td>
<td>n/a</td>
<td>2200</td>
</tr>
<tr>
<td>2</td>
<td>Model 2</td>
<td>Model</td>
<td>C&amp;D</td>
<td>50%</td>
<td>800</td>
<td>500</td>
<td>n/a</td>
<td>1300</td>
</tr>
<tr>
<td>3</td>
<td>Std Item2</td>
<td>Std Item</td>
<td>N</td>
<td>100%</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
</tr>
<tr>
<td>3</td>
<td>Option Class 2</td>
<td>Option Class</td>
<td>C&amp;D</td>
<td>100%</td>
<td>n/a</td>
<td>500</td>
<td>800</td>
<td>1300</td>
</tr>
<tr>
<td>4</td>
<td>Std Item3</td>
<td>Std Item</td>
<td>N</td>
<td>100%</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
</tr>
<tr>
<td>4</td>
<td>Option4</td>
<td>Option</td>
<td>C&amp;D</td>
<td>50%</td>
<td>n/a</td>
<td>250</td>
<td>400</td>
<td>650</td>
</tr>
<tr>
<td>4</td>
<td>Option5</td>
<td>Option</td>
<td>C&amp;D</td>
<td>50%</td>
<td>n/a</td>
<td>250</td>
<td>400</td>
<td>650</td>
</tr>
<tr>
<td>2</td>
<td>Option1</td>
<td>Option</td>
<td>C&amp;D</td>
<td>20%</td>
<td>n/a</td>
<td>200</td>
<td>n/a</td>
<td>200</td>
</tr>
<tr>
<td>2</td>
<td>Option2</td>
<td>Option</td>
<td>C&amp;D</td>
<td>80%</td>
<td>n/a</td>
<td>800</td>
<td>n/a</td>
<td>800</td>
</tr>
<tr>
<td>2</td>
<td>Option Class 1</td>
<td>Option Class</td>
<td>C&amp;D</td>
<td>100%</td>
<td>n/a</td>
<td>1000</td>
<td>n/a</td>
<td>1000</td>
</tr>
<tr>
<td>3</td>
<td>Std Item2</td>
<td>Std Item</td>
<td>N</td>
<td>100%</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
</tr>
<tr>
<td>3</td>
<td>Option3</td>
<td>Option</td>
<td>C&amp;D</td>
<td>20%</td>
<td>n/a</td>
<td>200</td>
<td>n/a</td>
<td>200</td>
</tr>
<tr>
<td>3</td>
<td>Option4</td>
<td>Option</td>
<td>C&amp;D</td>
<td>80%</td>
<td>n/a</td>
<td>800</td>
<td>n/a</td>
<td>800</td>
</tr>
</tbody>
</table>

Here the sample calculation for each component’s forecast value:

Model 1 = forecast based on independent history (Because, Model 1 forecast control set to Consume)

\[= 1000\]
Model 2 = forecast based on independent history + Planning factor value * parent forecast value
   = 800 + 50% * Model 1
   = 800 + 50% 1000 = 1300

Option Class 1 = Planning factor value * parent forecast value
   = 100% * Model 1
   = 100% *1000 = 1000

Option Class 2 = Planning factor value * parent forecast value derived from Model 1
                + Planning factor value * parent forecast value derived from Model 2
   = 100% * Model 2 + 100% * parent forecast value derived from Model 2
   = 100% 500 + 100% 800 = 1300

Option 1 = Planning factor value * parent forecast value
   = 20% * Model 1
   = 20% * 1000 = 200

Option 2 = Planning factor value * parent forecast value
   = 80% * Model 1
   = 80% * 1000 = 800

Option 3 = Planning factor value * parent forecast value
   = 20% * Option Class 1
   = 20% * 1000 = 200

Option 4 = Planning factor value * parent forecast value + Planning factor value * parent forecast value derived from Option Class 2
   = 80% * Option Class 1 + 50% * Option Class 2 + 50% * parent forecast value derived from Option Class 2
   = 80% * 1000 + 50% * 500 + 50% * 800
   = 800 + 250 + 400 = 1450

Option 5 = Planning factor value * parent forecast value + Planning factor value * parent forecast value derived from Option Class 2
   = 50% * Option Class 2 + 50% * parent forecast value derived from Option Class 2
Forecasting for Dependent Demands

\[ = 50\% \times 500 + 50\% \times 800 = 650 \]

Std Item 1 = forecast based on independent history + Planning factor value * parent forecast value

\[ = 1200 + 100\% \times \text{Model 1} \]

\[ = 1200 + 100\% \times 1000 = 2200 \]

Std Item 2 = N/A (Because its forecast control is set to None)

Std Item 3 = N/A (Because its forecast control is set to None)

Based on the above calculation, the final forecast for each component is shown in the following table:

<table>
<thead>
<tr>
<th>Item</th>
<th>Final Forecast</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model 1</td>
<td>1000</td>
<td>Forecast based on Independent History</td>
</tr>
<tr>
<td>Std Item1</td>
<td>1200 + 1000 = 2200</td>
<td>Forecast based on Independent History and Exploded Demand from Model 1’s Forecast</td>
</tr>
<tr>
<td>Model 2</td>
<td>800 + 500 = 1300</td>
<td>Forecast based on Independent History and Exploded Demand from Model 1’s Forecast</td>
</tr>
<tr>
<td>Std Item2</td>
<td>n/a</td>
<td>Forecast Control is set to None</td>
</tr>
<tr>
<td>Option Class2</td>
<td>500 + 800 = 1300</td>
<td>Forecast based on Exploded Demand from Model 1’s and Model 2’s Forecast</td>
</tr>
<tr>
<td>Std Item3</td>
<td>n/a</td>
<td>Forecast Control is set to None</td>
</tr>
<tr>
<td>Option4</td>
<td>800 + 250 + 400 = 1450</td>
<td>Forecast based on Exploded Demand from Model 1’s and Model 2’s Forecast. This component is used for two different model in same bill</td>
</tr>
<tr>
<td>Option5</td>
<td>250 + 400 = 650</td>
<td>Exploded Demand from Model 1’s and Model 2’s Forecast.</td>
</tr>
<tr>
<td>Option1</td>
<td>200</td>
<td>Exploded Demand from Model 1’s Forecast.</td>
</tr>
<tr>
<td>Option2</td>
<td>800</td>
<td>Exploded Demand from Model 1’s Forecast.</td>
</tr>
<tr>
<td>Option Class1</td>
<td>1000</td>
<td>Exploded Demand from Model 1’s Forecast.</td>
</tr>
<tr>
<td>Option3</td>
<td>200</td>
<td>Exploded Demand from Model 1’s Forecast.</td>
</tr>
</tbody>
</table>
Notes

Product Dependency
This feature has dependencies with Oracle BOM and Oracle Inventory.

Dependent revenue
For this feature, the revenue for the dependent demand is not calculated, because this may result in double counting the revenue; the revenue from the dependent part of the components is included in the revenue for the assembly. Only independent demand revenue (amount) is stored in the Amount column in MSD_DP_SCENARIO_ENTRIES.

API changes
The two APIs (additional views) that are exposed to Demand Planning Engine are:

- MSD_ITEM_MASTER_V based on MSD_ITEM_LIST_PRICE table, where new fields for Forecast Control and Item Type have been added.
- MSD_BOM_COMPONENTS_V based on MSC_BOM_COMPONENTS, MSC_ITEM_ID_LID, and MSD_ITEM_LIST_PRICE tables, where some fields (Lead Time, Spare Part, Forecast Type, Cyclic) are not used by Demand Planning.

Customizing Demand Planning Hierarchies

Oracle Demand Planning supports eight dimensions: product, time, geography, ship from location, sales channel, sales representative, user-defined dimension 1, and user-defined dimension 2. Hierarchies and levels for the first six dimensions are preseeded, while they need to be defined for the two user-defined dimensions. Existing dimensions, hierarchies, and levels have been described in other sections. This whole ODP structure consisting of dimensions, hierarchies, and levels is very flexible and can be easily altered. The steps to exploit this flexibility are presented in this section. The first two features in the next section pertain to the onetime setup related changes in the basic ODP structure. The third feature, however, relates to the ongoing and routine changes.

Feature Description

Hierarchies Manipulation
The existing and preseeded levels can be manipulated to define a new hierarchy. For example, the geography hierarchy, one of the three preseeded hierarchies of the geography dimension consists of the following levels:

- Ship to Location
- Region
- Country
- Area
- All Geography

A new hierarchy can be defined where Ship to Location rolls up to Country and Country rolls up to All Geography. The names of the levels and hierarchies can be changed using a simple user interface.

For example, the levels Ship to Location and Region may need to be renamed as Customer Store and Distribution Center respectively, while the hierarchy geography may need to be called Customer Geography.

This can be done from the Demand Planning Levels or Demand Planning Hierarchies forms, which can be accessed respectively from the Levels or Hierarchies menu under Setup for the Demand Planning Integration Administrator responsibility. To change the names of any level or hierarchy, open the corresponding window, select the level or hierarchy, and enter the new name.

User-Defined Levels, Hierarchies, and Dimensions
When the six dimensions with preseeded levels and hierarchies are not adequate, two user-defined dimensions can be used. When the preseeded levels and hierarchies are not adequate, new levels and hierarchies can be defined.
Custom Association of Level Values

Level values (such as Western distribution center, South-West distribution center) for a level (such as region) can be viewed and changed through this feature after collecting them from the sources applications. The routine business changes in the level value associations can be accomplished. For example, a customer store location can be associated with a different regional distribution center.

Business Application

Every business is structured differently and it may be required to match the respective business processes while implementing ODP. During the normal course of business also, it is often necessary to restructure the hierarchies. Such restructuring may include changing the names of levels or hierarchies, or defining new hierarchies.

To define a new hierarchy using the existing levels:

For this example, My Geo Hierarchy is the name of the new hierarchy to be represented as: Ship to Location – Country – All Geography.

1. Select the Demand Planning Integration Administrator responsibility.
2. From the Navigator, select Setup > Hierarchies.
   The Demand Planning Hierarchies window appears.
3. Add a new record in order to enter a new hierarchy. Use the information in the following table to add the new record:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>My Geo Hierarchy</td>
</tr>
<tr>
<td>Description</td>
<td>Test New Hierarchy</td>
</tr>
<tr>
<td>Dimension</td>
<td>Geography</td>
</tr>
</tbody>
</table>

4. From the Navigator, select Setup > Hierarchy Levels button.

The Demand Planning Hierarchy Levels window appears.
5. Enter a new record.
7. Select Country for the Level column.
8. Select All Geography for the Parent Level column.
9. Enter MSD_SR_COUNT_ALL_V for the Relationship View column. Any view name on the same pattern can be specified.
10. Enter the same values in all the remaining columns as already specified for existing hierarchies.
11. Repeat step 5 through step 10 to enter the second relationship. Enter the second relationship from Country to All Geography as shown above (the row below the highlighted entry). Use the information in the following table to see what values should be entered.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hierarchy</td>
<td>My Geo Hierarchy</td>
</tr>
</tbody>
</table>
The Relationship View entered in the previous steps are the source views that steer the aggregation of levels collected from the source applications. For any new set of relationship between levels, these relationship views, which are source views, must be defined.

The SQL commands that create one of the new views, MSD_SR_SHIPTO_COUNT_V is presented below to impart some understanding of the view’s definition. The purpose for this view is to map the values and primary keys of levels and parent levels to the source data. For example, the following table shows what will be achieved by creating this view.

<table>
<thead>
<tr>
<th>Level</th>
<th>Level value</th>
<th>Primary key for Level value</th>
<th>Parent Level</th>
<th>Primary key for Parent Level value</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Detroit</td>
<td>101</td>
<td>United States</td>
<td>1001</td>
</tr>
<tr>
<td>2</td>
<td>East bay</td>
<td>102</td>
<td>United States</td>
<td>1001</td>
</tr>
<tr>
<td>3</td>
<td>San Jose</td>
<td>103</td>
<td>United States</td>
<td>1001</td>
</tr>
</tbody>
</table>

The following section contains the SQL commands that created this view.

**MSD_SR_SHIPTO_COUNT_V**

```sql
CREATE OR REPLACE VIEW MSD_SR_SHIPTO_COUNTRY_V

(level_value_pk, level_value, parent_value_pk, parent_value, attribute1, attribute2, attribute3, attribute4, attribute5)

AS SELECT

/* Uses the following for the values and primary keys of Levels and Parent Levels */

/* Maps to line 2 above. null corresponds to attributes. prs and pra are aliases */
```
To define new levels and hierarchies; using the two user-defined dimensions

The user-defined dimension 1 is represented as shown below:

User-defined hierarchy 1: user-defined level 1 rolls up to user-defined level 2
User-defined hierarchy 2: user-defined level 1 rolls up to user-defined level 2; user-defined level 2 rolls up to user-defined level 3

The process of using user-defined dimension 1 is presented next.

1. Select the Demand Planning Integration Administrator responsibility.
2. From the Navigator, select Setup > Levels.

The Demand Planning Levels window appears.
3. Enter the three new records for the new Levels (UD Level 1, UD Level 2, UD Level 3) as shown in the following table and save the records.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Record 1: UD Level 1, Record 2: UD Level 2, Record 3: UD Level 3</td>
</tr>
<tr>
<td>Description</td>
<td>Record 1: User Defined Level 1, Record 2: User Defined Level 2,</td>
</tr>
<tr>
<td></td>
<td>Record 3: User Defined Level 3</td>
</tr>
<tr>
<td>Dimension</td>
<td>User Defined dimension 1</td>
</tr>
<tr>
<td>Level Type</td>
<td>Record 1: Bottom, Record 2: Intermediate, Record 3: Top</td>
</tr>
</tbody>
</table>

4. In the Dimension column, associate these levels to the User Defined Dimension 1 by selecting the Dimension name from the list of values.

5. In the Level Type column, select the appropriate level type from the list of values (Bottom, Intermediate, Top).

   There can only be one bottom and one top level, while any number of intermediate levels are possible within one Dimension. UD Level 2 is the only intermediate level in this example.
6. Close the Demand Planning Levels window.

7. From the Navigator, select Setup > Hierarchies.

   The Demand Planning Hierarchies window appears.

**Figure 18–45  Demand Planning Hierarchies window**

8. Enter the two new records for the new hierarchies, UD Hierarchy 1 and UD Hierarchy 1 as described in the following table and save the records.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Record 1: UD hierarchy 1, Record 2: UD hierarchy 2</td>
</tr>
<tr>
<td>Description</td>
<td>Record 1: Hierarchy 1 for User Define Dimension 1, Record 2: Hierarchy 2 for User Defined Dimension 1</td>
</tr>
<tr>
<td>Dimension</td>
<td>User Defined Dimension 1</td>
</tr>
</tbody>
</table>

9. Click the Hierarchy Level button.

   The Demand Planning Hierarchy Levels window appears.
10. Associate the hierarchy levels with the user-defined hierarchies as shown in the table below. The information is given in the table is what you will select for three rows.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hierarchy</td>
<td>Select UD hierarchy 1, UD Hierarchy 2, UD Hierarchy 3</td>
</tr>
<tr>
<td>Level</td>
<td>UD Level 1, UD Level 2, UD Level 3</td>
</tr>
<tr>
<td>Parent Level</td>
<td>UD Level 3, US Level 2, UD Level 3</td>
</tr>
<tr>
<td>Relationship View</td>
<td>MSD_SR_UL1_UL3_V, MSD_SR_UL1_UL2_V, MSD_SR_UL2_UL3_V</td>
</tr>
<tr>
<td>Level ID Column</td>
<td>LEVEL_VALUE_PK (for all three rows)</td>
</tr>
</tbody>
</table>

11. Define the Relationship Views as described in To define a new hierarchy using existing levels on on page 18-103.
Manipulating the Level Values and Associations

It is often desirable to change level value associations so that the forecasts for the lower levels roll up appropriately to the corresponding higher levels. For example, consider the reassignment of a particular customer site (AU Dodge - CDET) from the Michigan sales region to the Ohio sales region. Forecasts for AU Dodge-CDET need to roll up under the Ohio sales region instead of the Michigan sales region.

**To change level value associations**

1. Select the Demand Planning Integration Administrator responsibility.
2. From the Navigator, select Dimension Values > Level Values.
   
   The Find Level Values window appears.

   **Figure 18–47  Find Level Values window**

3. Enter the Dimension, Hierarchy, and Level of the child level value in the Find Level Values window.
4. Click the Find button.
   
   The Level Values screen is populated with all the values of the selected hierarchy level.
5. Select the appropriate value (AU Dodge-CDET) on the Level Values window and click on the Associations button.

   The Level Associations window appears.
6. Change the Parent Level Value, which is set to MI, to OH (for Ohio) by selecting OH from the list of values.

7. Click Ok.
Profile Options

For a complete list of all the main ASCP profile options, please refer to Implementing Profile Options Summary in the Oracle Master Scheduling/MRP and Oracle Supply Chain Planning User’s Guide.

The other topics in this section list profile options you set when configuring Oracle ASCP and Oracle Global Order Promising.

Oracle ASCP Scheduling Profile Options

**MSO: Default Forecast Priority.** This profile option contains the default priority value for forecasts and is used by the scheduling engine to determine when to schedule the forecast.

This profile option can be defined at the site level. You can update this value. The default value is 100000.

**MSO: Default Sales Order Priority.** This profile option contains the default priority value for sales orders and is used by the scheduling engine to determine when to schedule the sales order.

This profile option can be defined at the site level. You can update this value. The default value is 10000.

**MSO: Floating Point Precision.** This is used by the scheduling engine to convert floating point numbers to integers since ILOG scheduler works only with integers.

This profile option can be defined at the site level. You can update this value.
**Profile Options**

**MSO: Heuristic type.** This is used by the scheduling engine to determine which heuristic to use. A value of 0 corresponds to the default heuristic which proceeds priority by priority, and tries to schedule demands just in time and minimize lateness. A value of 1 corresponds to the look-ahead heuristic. This heuristic tries to reserve some time for lower priorities, so the schedule begins with the tasks of higher priorities.

This profile option can be defined at the site level. You can update this value. The default value is 0.

**MSO: Maximum Number of Prepones.** This is an important scalability factor for the scheduling engine. The scheduling engine will try to schedule the operations in different orders to find a solution. As the number of order can be very large, this parameter limits the number of times the scheduling engine tries to schedule an operation. If you have many components for some items, or many small supplies answering a demand, the number of orders (between this components and this supplies) become larger, and you should reduce this parameter.

This profile option can be defined at the site level. You can update this value. The default value is 10 operations.

**MSO: Maximum Demands per Group.** This is used by the scheduling engine to determine the maximum number of demands that can be grouped together for scheduling. Within a group, the default heuristic can try different orders among the demands. The value is specified as an integer greater than 0 and smaller than the size of a slice.

This profile option can be defined at the site level. You can update this value. The default value is 5 demands.

**MSO: Maximum Demands per Slice.** This determines the number of demands in a slice. A slice is a part of the plan that is scheduled at a time. This option enables the scheduling engine to better resolve the interactions of demands on each other within a slice. In particular, the supplies shared between demands are scheduled better when the demands are in the same slice. However, making slices too large causes the scheduling engine to be slower and consume more memory.

This profile option can be defined at the site level. You can update this value. The default value is 100 demands.

**MSO: Maximum Lead Time Factor.** This is used by the scheduling engine. This is the fraction of the overall horizon length, within which the backward pass restricts looking for resources to fit the schedule. If this cannot be scheduled within this
fraction of the overall horizon length, it is forward scheduled. The value is specified as a number between 0 to 1.

This profile option can be defined at the site level. You can update this value. The default value is 1.

**MSO: Maximum Number of Pull for Operation.** When an operation cannot be scheduled on a certain day, the scheduling engine attempts to schedule it on an earlier date (for backward scheduling). This profile option controls how many days are tried this way. This should be larger than 0. A large number of days result in degraded performance.

This profile option can be defined at the site level. You can update this value. The default value used is 8 operations.

**MSO: Maximum Resource Over-capacity.** This is used by the scheduling engine to assign resource slacks whenever it does not find the resource available and it is forced to use slacks. The value is specified as a number greater than 0.

This profile option can be defined at the site level. You can update this value.

**MSO: Network routing cycle time coefficient.** This is used by the scheduling engine to calculate the window of time allocated to schedule a network flow. This is used in conjunction with NFL Fixed Time Window. The window of time is (coefficient * <cycle time> + fixed_window).

This profile option can be defined at the site level. You can update this value. The default value is 2.

**MSO: Network routing fixed time window.** This is used by the scheduling engine to calculate the window of time allocated to schedule a network flow. This is used in conjunction with NFL Cycle Time Coefficient. The window of time is (coefficient * <cycle time> + fixed_window)

This profile option can be defined at the site level. You can update this value. The default value is 0.

**MSO: NFL BACKWARD COMPRESSION PCT.** This profile defines the percentage of the actual resources capacity that the network flow takes into account. A value under 100 percent tends to offload more activities to alternate resources. The value should typically be between 10 and 100 percent.

This profile option can be defined at the site level. You can update this value. The default value is 100 percent.
Profile Options

**MSO: NFL FORWARD COMPRESSION PCT.** This is used in the same way as the previous profile, but for the forward scheduling phases. This profile is useful in forward phase to force the system to use alternates and limit the lateness of the activities.

This profile option can be defined at the site level. You can update this value. The default value is 100 percent.

**MSO: Schedule Across Breaks.** This determines if the scheduling engine will start an activity before a break and end it after the break. If set to No, you should make sure that every activity has enough resource in 1 shift; otherwise, the activities are pushed to the end of the horizon.

This profile option can be defined at the site level. You can update this value. The default value is Yes (can schedule across break).

**MSO: schedule window width.** This defines the window of time (expressed in days) during which the scheduling engine looks for the primary resource. If the primary resource is not present in this window, the scheduling engine tries to move to an alternate resource.

This profile option can be defined at the site level. You can update this value. The default value is 8 days.

**MSO: Firm Supply Allocation Window (days).** This profile option determines a window of time during which firm supplies such as on-hand, receipts, and firmed orders are allocated based on demand priority. Without this window, you might run into a situation in which higher priority demands that are due much later would consume firm supplies that are available in the near future. The value is specified as an integer greater than 0.

This profile option can be defined at the site level. You can update this value.

**Oracle ASCP Optimization Profile Options**

The following profile options can be used to specify default values necessary for optimization

**MSO: Alternate Process Penalty.** This specifies the weight to use for alternate process objective in optimization. This value is specified as a number greater than 0, and is an internal value.
**MSO: Alternate Resource Penalty.** This profile option contains the weight to use for alternate resource objective in optimization. This value is specified as a number greater than 0, and is an internal value.

**MSO: Alternate Source Penalty.** This profile option contains the weight to use for alternate source objective in optimization. This value is specified as a number greater than 0 and is an internal value.

**MSO: Inventory Carrying Costs Percentage.** Use this profile option to specify the inventory carrying costs percentage for all items in the plan. The value is specified as a number between 0 and 1.

This profile option can be defined at the site level. You can update this value.

**MSO: LP Optimization Algorithm.** This profile option is used by optimization to determine what optimization algorithm will be used. The valid values are:

- 0 = primal simplex
- 1 = dual simplex
- 2 = hybrid barrier primal
- 3 = hybrid barrier dual

This profile option can be defined at the site level. You can update this value. This profile option value is defaulted internally.

**MSO: Maximum Allowable Days Late.** Use this profile option to limit the number of days by which a demand or unconfirmed scheduled receipt can be moved out when optimization is turned on. This value is only used by optimization to improve performance and reduce the size of the plan for the optimization component of the Memory Based Planner. Scheduling moves demands and unconfirmed scheduled receipts out as long as necessary. The value is specified as an integer greater than 0.

This profile option can be defined at the site level. You can update this value. The default value is 5.

**MSO: Penalty Cost Factor for Exceeding Material Capacity.** Use this profile option to define a global penalty cost factor for exceeding material capacity. This value is common to all items in the plan. The value is specified as a number greater than 0.

This profile option can be defined at the site level. You can update this value.
**Profile Options**

**MSO: Penalty Cost Factor for Exceeding Resource Capacity.** Use this profile option to define a global penalty cost factor for exceeding resource capacity. This value is common to all manufacturing and transportation resources in the plan. The value is specified as a number greater than 0.

This profile option can be defined at the site level. You can update this value.

**MSO: Penalty Cost Factor for Late Demands.** Use this profile option to define a penalty cost factor common to all demands. The demands include sales orders, forecasts, and safety stock. The value is specified as a number greater than 0.

This profile option can be defined at the site level. You can update this value.

**MSO: Queue Time Factor.** This contains a factor by which to increase the item lead time in optimization, so that the lead time values are close to those used in the scheduling engine. Optimization lead time is padded to include queue time, etc. This value is specified as a number greater than or equal to 0.

**MSO: Substitute Item Penalty.** Use this profile option to define an internal penalty weight to use for substitute item objective in supply chain optimization. This value is specified as a number greater than 0. This is an internal value.

**Other Oracle ASCP Profile Options:**

**MSC: Default Workbench Height.** This profile option is used to specify the default workbench height. This profile option can be defined at the site level.

**MSC: Default Workbench Width.** This profile option is used to specify the default workbench width. This profile option can be defined at the site level.

**MSC: Hour UOM.** This profile option is used to specify the unit of measure (UOM). The default value is HR. This profile option can be defined at the site level.

**MSC: Map Server Host.** This profile option is used to map server host. This profile option can be defined at the site level.

**MSC: Map Server Port.** This profile option is used to map server port. This profile option can be defined at the site level.

**MSC: Plan co-products.** This profile option is used to indicate if co-products will be planned. This profile option can be defined at the site level.
**MSC: Planning Currency.** This profile option is used to specify the planning currency. The default value is US dollar. This profile option can be defined at the site level.

**MSC: Sales Orders Offset Days.** The value of this profile option is specified as a number greater than 0. Collections will pick up the completed sales orders within the offset duration.

For example, if Sales Orders Offset Days is set to 90, then all the sales orders which have completed in the past 90 days will also be collected.

This profile option can be defined at the site level. You can update this value.

**MSC: Share Plan Partitions.** The profile option is added as a workaround for test/demo scenarios where you expect a lot of plans to be created by different testers and demonstrators. This profile option is not meant for production use by the customer. If you do decide to enable it, then the number of plan partitions parameter to the concurrent program mentioned above becomes irrelevant, since only one partition is created for a plan (you can enter 1 just to be safe).

---

**Note:** If the MSC: Share Plan Partitions profile is turned on, you need to run Create APS Partitions program afterwards so that it can create the partition that every plan will share.

---

**MSC: Sourcing Rule Category Set.** This profile option is used to specify the sourcing rule category set. This profile option can be defined at the site level.

### ILOG CPLEX Solver Profile Options

All the following profile options are included to better control the ILOG CPLEX solver. It is not expected that these will be changed often, and if they need to be changed, it will usually be with some input from development and ILOG support. They are included here only so that you may be aware that they exist in case a situation arises where they will need to be altered.

**MSO: Check Redundant Constraints.** This profile option specifies to check for redundant constraints and eliminate them. The allowable values for this profile option are 0,1. This value is defaulted by CPLEX.

**MSO: CPLEX Crash Parameter.** This profile option is used to determine how objective coefficients are used to select basis. The allowable values are -1, 0, and 1. This value is defaulted by CPLEX.
Profile Options

**MSO: CPLEX Refactor Rate.** This profile option specifies the value of the parameter to control the refactor rate. The value of this profile option is specified as an integer greater than or equal to 0. This value is defaulted by CPLEX.

**MSO: CPLEX Scaling Factor.** This profile option contains the scaling factor in CPLEX. The allowable values for this profile option are -1, 0 and 1. This value is defaulted by CPLEX.

**MSO: Dual Simplex Parameter.** This profile option is a gradient parameter for dual simplex. The allowable values for this profile option are 0, 1, 2, 3, and 4. This value is defaulted by CPLEX.

**MSO: Global Time Limit.** This profile option is a parameter used to set the global time limit before stopping optimization. This value is specified as number greater than 0. This value is defaulted by CPLEX.

**MSO: List Size for Pricing Candidates.** This profile option is a parameter to set the list size for pricing candidates. This value is specified as an integer greater than 0. This value is defaulted by CPLEX.

**MSO: LP Markowitz Coefficient.** This profile option is used to set the Markowitz Coefficient. The allowable value is any number between 0.0001 and 0.99999. This value is defaulted by CPLEX.

**MSO: Maximum Simplex Iterations.** This profile option is a parameter to set the maximum number of simplex iterations. The value is specified as an integer greater than 0. This value is defaulted by CPLEX.

**MSO: Preprocessing Aggregator Fill.** This profile option is the preprocessor aggregator fill. The value is specified as an integer greater than 0. This value is defaulted by CPLEX.

**MSO: Preprocessing Aggregator Limit.** This profile option is a parameter to control preprocessing aggregator limit. The value is specified as an integer greater than 0. This value is defaulted by CPLEX.

**MSO: Preprocessing Flag for LP Matrix.** This contains the presolve indicator. The allowable values are 0 and 1. This value is defaulted by CPLEX.
MSO: Primal Simplex Parameter. This profile option is a gradient parameter for primal simplex algorithm. The allowable values are -1, 0, 1, 2, 3, and 4. This value is defaulted by CPLEX.

MSO: Simplex Feasibility Tolerance. This profile option is a parameter to set the simplex feasibility tolerance. The value is specified as a number between e-9 and e-4. This value is defaulted by CPLEX.

MSO: Simplex Optimality Tolerance. This profile option is a parameter to set the optimality tolerance for the simplex algorithm. The value is specified as a number between e-9 and e-4. This value is defaulted by CPLEX.

MSO: Simplex Perturbation Constant. This profile option is a parameter to set the simplex perturbation constant. The value is specified as any number greater than e-8. This value is defaulted by CPLEX.

MSO: Simplex Perturbation Limit. This profile option is a parameter for the simplex perturbation limit. The value is specified as an integer greater than 0. This value is defaulted by CPLEX.

MSO: Simplex Perturbation Indicator. This profile option is a simplex perturbation parameter. The allowable values are 0 and 1. This value is defaulted by CPLEX.

MSO: Simplex Presolve Limit. This profile option is a parameter to set the limit on the number of presolves. The allowable values are -1, 0, and any integer greater than 0. This value is defaulted by CPLEX.

MSO: Simplex Singularity Repair Limit. This profile option is a parameter to set the simplex singularity repair limit. The value is specified as an integer greater than 0. This value is defaulted by CPLEX.

MSO: Solve Dual Problem. This profile option controls whether CPLEX solves the dual problem or the primal problem. The allowable values are 0 and 1. This value is defaulted by CPLEX.

Oracle ASCP Flexfield Attribute Profile Option

These profile options store the name of the flexfield column that contains the value in the corresponding table. For example, if the Aggregate Resource Name is stored in column ATTRIBUTE1, the profile option MSC: Aggregate Resource Name Flexfield Attribute will contain the value 1.
This setup is only performed during application install, so it should not be modified unless it’s necessary.

MSC: Aggregate Resource Name Flexfield Attribute
MSC: Cost of Using a BOM/ Routing Flexfield Attribute
MSC: Priority for Substitute Items Flexfield Attribute
MSC: Priority of Alternate Resources for an Operation Flexfield Attribute
MSC: Resource Group for a Line Flexfield Attribute
MSC: Resource Type for an Operation Flexfield Attribute
MSC: Simultaneous Resource Sequence Flexfield Attribute
MSO: Penalty Cost Factor for Exceeding Item Material Capacity Flexfield Attribute
MSO: Penalty Cost Factor for Exceeding Material Capacity Flexfield Attribute
MSO: Penalty Cost Factor for Exceeding Org Material Capacity Flexfield Attribute
MSO: Penalty Cost Factor for Exceeding Org Resource Capacity Flexfield Attribute
MSO: Penalty Cost Factor for Exceeding Org Transportation Capacity Flexfield Attribute
MSO: Penalty Cost Factor for Exceeding Resource Capacity Flexfield Attribute
MSO: Penalty Cost Factor for Exceeding Transportation Capacity Flexfield Attribute
MSO: Penalty Cost Factor for Late Forecasts Flexfield Attribute
MSO: Penalty Cost Factor for Late Item Demands Flexfield Attribute
MSO: Penalty Cost Factor for Late Org Demands Flexfield Attribute
MSO: Penalty Cost Factor for Late Sales Orders Flexfield Attribute
MSO: Resource Group for the Line Flexfield Attribute

**Oracle Global Order Promising Profile Options**

**INV: Capable to Promise.** This site level profile option determines how a promise date is derived. It can have the values shown in the following table:

<table>
<thead>
<tr>
<th>Value</th>
<th>Text</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Enable Product Family ATP and CTP</td>
</tr>
</tbody>
</table>
Profile Options

(*) new setting for this release

You can update this profile at the site level.

<table>
<thead>
<tr>
<th>Value</th>
<th>Text</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Enable Product Family ATP</td>
</tr>
<tr>
<td>3</td>
<td>Enable ATP</td>
</tr>
<tr>
<td>4</td>
<td>Enable PL/SQL based ATP with Planning Output (*)</td>
</tr>
<tr>
<td>5</td>
<td>Enable PL/SQL based ATP without Planning Output (*)</td>
</tr>
</tbody>
</table>

INV: External ATP. Set this profile option in the Source instance if the Source is 10.7 or 11.0 instance. If Global ATP is selected, the system uses the new Global Order Promising program. If None is selected, the system uses the old ATP program.

You can update this profile at the site level. If no value is selected, the system assumes None for 10.7/11.0 instance and Global ATP for 11i instance.

MRP: Calculate Supply Demand. Use this profile option to control whether you want to calculate Supply Demand for Order Promising check. The default value is Yes. You can update this profile at the user level.

MRP: ATP Assignment Set. Use this profile option to indicate the name of the assignment set to use for Supply Chain Order Promising. You can update this profile at the site level in the Source instance.

MRP: ATP Database Link. Use this profile to determine if distributed Order Promising is used or not. You can update this profile at the site level.

MRP: Include Substitute Components. Use this profile option to indicate whether to include substitute components in Order Promising calculation. If no value is entered, the systems assumes No. You can update this profile at the site level.

MSC: ATP Debug Mode. Use this profile option to indicate whether to enable debug messages within Oracle Global Order Promising. If no value is entered, the system assumes No. You can update this profile at the user level.

MSC: Enable Allocated ATP. Use this profile options to indicate if Allocated Order Promising is used or not. If no value is entered, the system assumes No. You can update this profile at the site level.
**Profile Options**

**MSC: Enable Allocated ATP Workflow.** Use this profile options to indicate if Allocated ATP Workflow is used or not. If no value is entered, the system assumes No. You can update this profile at the user level.

**MSC: ATP Assignment Set.** Use this profile option to indicate the name of the assignment set to use for Global Order Promising. You can update this profile at the site level in the Planning instance.

**MSC: Class Hierarchy.** Use this profile to indicate which allocation hierarchy to use. There are two values for this profile:
- Demand Class: this hierarchy is a user-defined, single-level hierarchy
- Customer Class: this hierarchy has three levels: customer class, customer, and site.

If no value is entered, the system assumes Demand Class. You can update this profile at the site level.

**MRP: Set Category for Backlog Form** Use this profile option to indicate which items belonging to this category set will be displayed in the Backlog Scheduling Workbench tree navigator. If no value is entered, no items are displayed in the Backlog Scheduling Workbench tree navigator. You can update this profile at the site level.

**Oracle Risk Optimization Profile Options**

In addition to using ASCP Optimization profile options, Risk Optimization uses the following profile options:

**MSR: Safety Stock Holding Strategy** This profile option specifies where safety stock should be held when the carrying cost is the same for an item in the destination organization and a source organization. A value of 0 causes the safety stock to be held at the destination organization. A value of 1 causes the safety stock to be held at the source organization. The default value is 0.

**MSR: Postponement Factor** This profile option specifies the maximum depth in the BOM and sourcing tree to which uncertainty (and hence safety stock) needs to be postponed. Any value greater than or equal to 0 is valid. The default value is 10.
Oracle ASCP Flexfields

The following flexfields are used to enter penalty cost data at the appropriate levels for independent demands, items, and resources.

**Penalty Cost Factor for Late Demands (at the demand level)** Defined via a flexfield in the Forecast Items form (for forecasts) or in the Scheduling region of the Sales Orders form (for sales orders). This will be stored in the table OE_ORDER_LINES_ALL and MRP_FORECAST_DATES.

**Penalty Cost Factor for Late Demands (at the item level)** Defined via a flexfield in the Items form. This will be stored in the table MTL_SYSTEM_ITEMS.

**Penalty Cost Factor for Late Demands (at the org level)** Defined via a flexfield in the Organizations Parameters form. This will be stored in the table MTL_PARAMETERS.

**Penalty Cost Factor for Exceeding Material Capacity (at the item/vendor level)** Defined via a flexfield in the Supplier-Item Attributes form (in the header region). It will be stored in PO_ASL_ATTRIBUTES.

**Penalty Cost Factor for Exceeding Material Capacity (at the item level)** Defined via a flexfield in the Items form. It will be stored in MTL_SYSTEM_ITEMS.

**Penalty Cost Factor for Exceeding Material Capacity (at the org level)** Defined via a flexfield in the Organizations Parameters form. This will be stored in the table MTL_PARAMETERS.
Penalty Cost Factor for Exceeding Resource Capacity (at the resource level) Defined via a flexfield in the Department Resources form. This will be stored in the table BOM_DEPARTMENT_RESOURCES.

Penalty Cost Factor for Exceeding Resource Capacity (at the org level) Defined via a flexfield in the Organizations Parameters form. This will be stored in the table MTL_PARAMETERS.

Penalty Cost Factor for Exceeding Transportation Cap. (ship method level) Defined via a flexfield in the Inter-location Transit Times form. It will be stored in MTLINTERORG_SHIP_METHODS.

Penalty Cost Factor for Exceeding Transportation Capacity (at the org level) Defined via a flexfield in the Organizations Parameters form. This will be stored in the table MTL_PARAMETERS.

Other APS flexfields are:

Aggregate Resource for a Resource This is defined via a flexfield in the Department Resources form. It is based on the existing flexfield ‘Aggregate Resource Id’. It is stored in the table BOM_DEPARTMENT_RESOURCES.

Priority for Substitute Items This is defined in the Substitute Components form. This is stored in the table BOM_SUBSTITUTE_COMPONENTS.

Priority for MDS Entries This is defined via a flexfield in the Master Demand Schedule Entries form. It is stored in the table MRP_SCHEDULE_DATES.

Service Level (at the item level) This is defined via a flexfield in the Items form. It is stored in the table MTL_SYSTEM_ITEMS.

Service Level (at the org level) This is defined via a flexfield in the Organization Parameters form. It is stored in the table MTL_PARAMETERS.

Service Level (at the customer level) This is defined via a flexfield in the Customer Entries form. It is stored in the table RA_CUSTOMERS.

The following three are for 10.7 and 11.0 and 11.i.1 sources only. For 11.i.2 and beyond, they are in the forms for routings in the source.

Simultaneous Resource Sequence This is defined via a flexfield in the Operation Resources form. This is stored in the table BOM_OPERATION_REROURCES.
Alternate Resources for an Operation  This is defined via a flexfield in the Operation Resources form. It is stored in the table BOM_OPERATION_RERESOURCES.

Priority of Alternate Resources for an Operation  This is defined via a flexfield in the Operation Resources form. This is stored in the table BOM_OPERATION_RERESOURCES.

Applying Flexfields to Different Versions of Oracle RDBMS

All flexfields are applied as a set to the following releases of the Oracle RDBMS:

- 10.7
- 11
- 11i

In each case, Oracle ASCP and Oracle Global Order Promising checks to whether you have existing flexfield. If you do, it does not overwrite your existing settings.

Transportation Capacity

Oracle ASCP and Oracle Global Order Promising R11i provides fields in the Inter-Location Transit Time window for setting load weight and load volume. These fields are not available in Releases 10.7 and 11.0. You should use flexfields to set these values when running either Release 10.7 or 11.0.

Creating Demand Priority Flexfield Numbers Manually

To Create Demand Priority Flexfield Number Manually

For 11 and later

1. From sysadmin responsibility, navigate to Application > Flexfields > Descriptive > Segments.
2. Double-click Segments.
   The Descriptive Flexfield Segments window appears.
3. For the Application field, click Find and select Oracle master Scheduling/MRP MRP_SCHEDULE_DATES.
4. Click the Segments button.
The Segments summary window appears.

5. Click the New button.

Fill in the fields as shown in the following table:

<table>
<thead>
<tr>
<th>Field</th>
<th>Enter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Demand Priority</td>
</tr>
<tr>
<td>Window Prompt</td>
<td>Demand Priority</td>
</tr>
<tr>
<td>Column</td>
<td>Pick a right attribute column &lt;attribute col&gt; (attribute 10 for example)</td>
</tr>
<tr>
<td>Number</td>
<td>1</td>
</tr>
</tbody>
</table>

6. Click the Value Set button.

The Value Set window appears.

7. For Value Set Name, click on the Find button.

The Find Value Sets window appears.

8. From list of values, select 7/Number.

9. Press the OK button.

To create Profile

1. Changes responsibility to Application Developer. Select Profile.

The Profile window appears.

2. Fill in the fields as shown in the following table:

<table>
<thead>
<tr>
<th>Fields</th>
<th>Enter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>MRP_DMD_PRIORITY_FLEX_NUM</td>
</tr>
<tr>
<td>Application</td>
<td>Select Oracle Master Scheduling/MRP from List of Values</td>
</tr>
<tr>
<td>User Profile Name</td>
<td>Same as Name</td>
</tr>
<tr>
<td>Description</td>
<td>MRP:demands flexfield attribute for demand priority</td>
</tr>
</tbody>
</table>

3. Save and close this window.

4. Switch responsibilities back to System Administrator.
5. Select Profile > System.
   The Find System Profile Values screen appears.

6. In the Profile filed, find the Profile MRP_DMD_PRIORITY_FLEX_NUM from the List of Values.

7. Click the Site radio button.

8. Click the Find button.
   The System Profile Values screen appears.

9. In the site column, enter the number 10 (or whatever number you chose for column).
Overview of the Order Backlog Workbench

The Order Backlog Workbench is a powerful graphic tool that enables you to easily manage existing order lines you wish to reschedule. This workbench is especially useful when a significant issue such as item availability occurs within your supply chain, manufacturing line, or distribution chain, and you need to react rapidly to reschedule groups of order lines affected by the item availability.

- Once you have selected orders for scheduling, using system processing constraints and user defined controls, order lines are processed in a simulated scheduling mode and then presented for your review.

**Note:** You must first select and schedule order lines before you can navigate to the Order Backlog Workbench. For a complete list of the steps required for scheduling order lines with the Order Backlog Workbench, refer to the Order Backlog Scheduling Process.

During the review process, you can:

- Take actions based on system exceptions or errors resulting from simulated scheduling
- Update or modify the simulated scheduled dates or source organizations for order lines presented
- Choose to accept or cancel all simulated order line scheduling information
- Choose to firm selected order lines for simulated rescheduling
- Choose to pick (accept) selected order line simulation results
- View Global Order Promising Pegging Detail information
- Reschedule order lines information presented in simulated schedule mode again

Once you are satisfied with your scheduling simulation results, save your changes and your new order line scheduling information is updated for order lines selected.

**Order Backlog Scheduling Process**

1. Define Priority Rules.
   - Priority Rules to determine the processing order used when scheduling orders through the scheduler.
2. Define scheduling Sequence Rules.
   - Sequence Rules determine the actual processing order used by the scheduler during order lines scheduling.

3. Define Filter Criteria
   - Filter Criteria enables you to determine order line selection criteria for scheduling within the Order Backlog Workbench.

4. Schedule Orders using the Order Backlog Workbench
   a. Simulate Order Scheduling
      View scheduling simulation results by:
      * Exceptions
      * Order Number
      * Organization/Item
   b. Choose to:
      * Firm all or selected simulated order lines scheduling results.
      * Pick all or selected simulated order lines scheduling results.
      * Save all scheduling simulation results.
      * Cancel all scheduling simulation results.
      * Modify simulated order line schedule dates or source org’s (organizations) fields and re-simulate scheduling based upon modifications made, performing any of the functions previously listed, until satisfied.

5. Save your work. Once your simulation work is saved, simulated order line schedule dates and sources become the scheduled date and source organization for all order lines selected.
Overview of the Order Backlog Workbench

Order Backlog Workbench User Interface

The Order Backlog Workbench consists of three panes within a window:

- Navigator Tree
- Reschedule Lines Results
- Order Line Pegging Information

Navigator Tree

The Navigator tree controls the display of information for the Reschedule Lines Results and Order Line Pegging panes within the Workbench. Drill down to different levels the within Exception, Order, or Items tab to view order line and pegging information in their respective panes.

Exceptions Tab

The Exceptions tab is the default tab displayed within the Navigation Tree pane upon system display of the Order Backlog Workbench. This tab displays a tree containing order line exceptions that occurred during simulated scheduling.
Exceptions are grouped and displayed by exception type, and a corresponding number is displayed to the right of each exception tree node to denote the number of occurrences for each of the exception types that occurred during simulated scheduling.

**Exception Tree Drill Down Details**

- Exceptions
  - Exception Folder Name
  - Order Number

**Orders Tab**  The Orders tab displays a folder tree of all orders selected for simulated scheduling. Orders within this folder tree are displayed in the ascending order.

**Order Tree Folder Drill Down Details**

- Sales Orders
  - Order Number
  - Independent Lines (order lines)

**Items Tab**  The Items tab displays a folder tree of all items contained within order lines that were selected for simulated scheduling. Items are displayed in alpha numeric sort of the organization to which they were scheduled against.

**Item Tree Folder Drill Down Details**

- Organizations
  - Organization Name
    - Product Families
      - Product Family
    - Categories
      - Item Category Sets
        - Item Category Set code combinations
Reschedule Lines Results
The Reschedule Lines Results pane is used to display order line information based upon cursor placement within the Navigator pane.

If the Item field is highlighted in yellow, simulated scheduling encountered an error during processing, and the order line was not modified in any way. Specific scheduling error messages can be seen in the Error column.

The Reschedule Lines Results pane displays the following order line information:

- Pick Check box
- Firm Check box
- Item
- Order line number
- Quantity ordered
- Order line UOM
- Ship from Org (organization)
- Ship Date (Scheduled Date)
- Scheduled Arrival Date
- Available Quantity
- Group Ship Date
- Group Arrival Date
- Request Date Quantity
- Requested Ship Date
- Requested Arrival Date
- Firm Source Org (organization)
- Firm Ship Date
- Firm Arrival Date
- Latest Acceptable Date
- Ship Method
- Lead Time
- Demand Class
Overview of the Order Backlog Workbench

- Ship set
- Arrival Set
- Customer
- Location (Customer Site)
- Status (Order line status)
- Error

**Order Line Pegging**
The Order Line Pegging Information pane displays pegging information based upon the cursor location within the Navigator tree.

---

**Note:** If there is no information contained within the Pegging Information window based upon the cursor location within Order Backlog Workbench:

- Entity referenced within the Navigator tree is not related to pegging, such as Organization.
- The item/order line that is referenced is not ATP enabled.
- The item/order line does not currently reside in Global Order Promising collection tables.

---

Selecting a node element within the Order Line Pegging pane and then selecting the Details button will display the Global Order Promising Details window.

For more information on the Global Order Promising Detail window, see Oracle Advanced Planning (APS) and Scheduling and Global Order Promising User Guide.

**Selection Criteria for Scheduling with the Order Backlog Workbench**

**Prerequisite**
You must define at least one Sequencing Rule (priority rule) prior to utilizing the Order Backlog Workbench.

**Priority Rules**
Oracle APS utilizes Priority Rules to determine the processing order used when scheduling orders through the scheduler.

- You can choose to define a default scheduling order processing Priority Rule.
- You can choose to disable a Priority Rule.
- You can also choose to define single or multiple criteria within a priority rule to further define the processing order the scheduler will utilize during line scheduling.

Priority Rules are not instance specific, and are defined by selecting specific criteria that will determine the order input to the scheduler.

**Note:** At least one priority rule must be defined prior to utilizing the Order Backlog Workbench for scheduling.

**To define Priority Rules:**

1. From an APS Responsibility, navigate to the Priority Rules window. The Define Priority Rules window displays.

2. Enter the name for the Priority Rule in the Name field.
3. Enter a description for the Priority Rule in the Description field.
4. Select the Enabled check box to enable the priority rule to be utilized by the scheduler.
5. Choose to establish whether the priority rule will be used as the default priority rule used during scheduling execution.

Select the Default check box to use the priority rule as the default rule.

---

**Note:** If another priority rule has been defined as the Default Priority Rule, and you select the Default check box, you will be presented with a decision box asking if you wish to update the current default priority rule to the rule you are currently modifying. Select Yes to update your default Priority Rule.

---

6. Select the Priority Rule criteria name in the Criteria Name field. Valid values are:

- Gross Margin
- Promise Date
- Request Date
- Sales Order and MDS Entities priority
- Scheduled Date

7. Select the criteria processing order the scheduler will use when scheduling order lines. Enter a numeric value in the Criteria Priority field.

8. Save your work.

---

**Note:** Once a Priority Rule has been successfully saved, you can only update the following information:

- Enabled check box
- Default check box

You may, however, choose to add additional criteria to the Priority Rule.

---

To schedule orders using the Order Backlog Workbench:

1. Navigate to the Order Backlog Workbench.

The Schedule Orders window appears.
2. Determine your order selection (filter criteria) for scheduling:
   - Select the Filter Criteria Name and proceed to Step 3 or
   - Select the Filter Criteria Name you wish to modify and select the Create/Edit button or
   - Select the Create/Edit button if you wish to enter new filter criteria information.
   
The Criteria folder window appears.

Create your order selection criteria for scheduling. Order selection is determined by current order line status and the Filter Criteria you define.
The Schedule Orders window utilizes Oracle Applications Folder technology to save Filter Criteria for reuse. Users can choose to create filter criteria and save it to a folder, or query an existing folder and modify the Filter Criteria. However, you are not allowed to enter Filter Criteria for scheduling without first saving the criteria to a folder.

a. Either edit the Filter Criteria for the folder selected, or enter new filter criteria. Select the Field name. Valid values are:
   - Task
   - Customer
   - Item Name
   - Order Number
   - Project Number
   - Promise Date
   - Requested Arrival Date
   - Requested Ship Date
   - Scheduled Arrival Date
   - Scheduled Shipped Date
   - Ship from org

b. Select an operator for your criteria. Valid values are:
   - Equals
   - Is Not (equal)
   - Less Than
   - At most
   - At Least

Note: Order lines that have a current status of Shipped or Cancelled are not selected for simulated scheduling. Order lines whose source is External (i.e. Drop ship order lines) are also not selected for simulated scheduling.
c. Choose to further define your query criteria values by entering limiting values in the From and To fields. Enter values appropriate to the Field Name selected.

For example, if you are interested in displaying order lines that have a scheduled order date two weeks from today, enter the present date in the From field, and a date two weeks from the present date in the To field.

d. Save your work to a folder. From the File menu, select Save As to save your folder. When you save your folder, there are several options available. Once you have saved your folder, close the Criteria window.

For more information on using folders within Oracle Order Management, see Oracle Order Management User's Guide, Private Folders.

For more information on folder options, see Oracle Applications Users Guide, Folders.


4. Choose whether to overwrite or preserve all existing source organizations for current order line sources during scheduling.

   - Select No to use current order line source information. Use existing sourcing rules and priority rules to determine order line schedule date.

   - Select Yes to overwrite current order line source information. Use any source for your order, based upon sourcing and priority rules for scheduling, and use the modified sourcing information during scheduling to determine order line scheduled date.
5. Choose to manually sequence the processing order during scheduling for your order lines or allow the system to schedule your order lines based upon the sequencing rule chosen by selecting the Manual Sequence button.

**Note:** If you choose to allow the system to process order lines by the Sequencing Rule chosen, proceed to Step e.

The Manual Sequence button enables a user, based upon query criteria, to schedule, sequence, Firm, or delete order lines selected for rescheduling.

a. Once you select the Manual Sequence button, the system will query open sales orders (based upon filter criteria) that contain order lines and then present them for display in based upon the Sequencing Rule selected.

<table>
<thead>
<tr>
<th>Seq</th>
<th>Order Number</th>
<th>Line Number</th>
<th>Option Number</th>
<th>Shipment Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>51104</td>
<td>4</td>
<td>4</td>
<td>1</td>
</tr>
<tr>
<td>2</td>
<td>51103</td>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>3</td>
<td>51103</td>
<td>2</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>4</td>
<td>51103</td>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>5</td>
<td>51105</td>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>6</td>
<td>51107</td>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>7</td>
<td>51109</td>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>8</td>
<td>51113</td>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
</tbody>
</table>

b. Choose to Firm current order line information: Select the Firm check box if you do not want a particular order line processing sequence to be modified when selecting the Apply button.

For example, suppose you update sequence 1 to sequence 5, sequence 6 to sequence 8, and select the Firm check box for sequence 2. Once the Apply
button is selected, the order line associated with sequence 2 remains sequence 2.

If the Firm check box for sequence 2 had not been selected, then, based upon your user changes, the order line originally associated with sequence 2 could possibly be changed because of your re-sequencing.

c. Choose to update order processing sequence during reschedule. Select the line you wish to modify, then update the sequence number assigned to the order line.

d. Select the Apply button. This will save your new order line sequence to be used during rescheduling.

e. Select the Schedule button to initiate simulated order line scheduling.

While scheduler is running, the user is presented with a Progress window to track the reschedule process.

The Progress Window continually updates a user as to the progress of rescheduling concurrent program. The following information is displayed:

- **Total Lines #**: Total order lines selected for scheduling
- **Remaining**: Total order lines remaining to be scheduled
- **Time + Remaining**: Total time remaining to process order lines currently not scheduled.
Complete: Total order lines current completed scheduling.

Progress Indicator Bar: An indicator bar that graphically displays the current order lines scheduled as a percentage of the total order lines selected for scheduling.

Once the indicator bar reaches 100% and the Remaining field displays 0, the Ok button is enabled. Select the button to display scheduling results.

Results are presented within the Order Backlog Workbench.

Scheduling Order Lines with the Order Backlog Workbench

Once order lines have been scheduled and processed, users are presented with the Order Backlog Workbench, a graphical user interface that enables a user to review, manage, and process simulated order line scheduling results.

1. Review the following reschedule exceptions generated during rescheduling process:
   - Item Shortage
   - Insufficient Margin
   - Modified Source
   - Later Than Old Schedule Date
   - Later than Promise Date
   - Later than Request Date

2. Choose to modify the schedule date and source org’s (organizations) fields for order lines prior to selecting the Pick check box.

3. Choose to accept current order line scheduling information. Select the Pick checkbox if you wish to schedule the order line.
   You must select the Pick check box if you wish to accept the simulated scheduling information for each order line. Once you select the Pick check box, the Firm check box is also enabled.

4. Choose to Firm current order line information.
   Select the Firm check box if you:
   - Want to accept current simulation scheduling information for an order line.
   - Do not want a particular order line to be modified during any additional simulated rescheduling that may occur within the workbench for the
Overview of the Order Backlog Workbench

current workbench simulation session. See: Rescheduling Within the Order Backlog Workbench.

**Note:** If you do not select the Firm check box, when you save your changes, the simulated order line scheduling information is discarded. Your current order line scheduling information is not updated.

5. Choose to view Global Order Promising Details. If Global Order Promising information is available for an item/order line, the Details button will be enabled.

Select the Details button to be presented with the Global Order Promising details window to review supply/demand and horizontal planning details. For more information on the Global Order Promising details window, see Oracle APS and Global Order Promising User Guide.


- You may modify only the Schedule Date and Source Org (organization) fields for an order line.

- You may choose to Firm an order line or group of order lines, and then process new a new scheduling simulation using the current order line information by selecting the Reschedule button. See: Rescheduling Within the Order Backlog Workbench.

7. Accept simulated scheduling recommendations. Select the Save button.

Once you select the Save button, all simulated scheduling results for order lines that have the Pick check box enabled are committed to the database. The Order Backlog Workbench closes, and the user is presented with the Schedule Orders window.

**Note:** For order lines that have a current Exception Type of Shortage, the old schedule date is preserved.

Simulated scheduling information for order lines without the Pick check box enabled are discarded, irrespective of the Firm check box setting.

8. Reject simulated scheduling recommendations. Select the Cancel button.
Simulated scheduling information is discarded, order line information is not updated within the database, the Order Backlog Workbench closes, and the user is presented with the Schedule Orders window.
Rescheduling Within the Order Backlog Workbench

The Backlog Orders Workbench enables a user to continue to reschedule order lines based upon data contained for the last saved simulation of scheduling.

You may initially select a group of order lines with your Filter Criteria for simulation scheduling, and then, when presented with the results, choose to firm or modify a subset of your original order lines, and then run a new simulation based upon this data. You can repeatedly reschedule the information presented until satisfied.

Reschedule Order Line Simulation Data Process

1. Define scheduling Sequence Rules.
   - Determine initial order line processing sequence during simulated scheduling.

2. Define Filter Criteria
   - Determine Selection criteria for scheduling with the Order Backlog Workbench.

   a. Simulate Order Scheduling
      - Choose to:
        * Manually sequence, delete, firm, and simulate order line scheduling or
        * Simulate order line scheduling for all order line selected by your Filter Criteria.

3. Reschedule Order lines
   - Choose to:
     * Modify order line schedule dates or source org’s (organizations) fields.
     * Firm order lines.
     * Pick order lines.

4. Select the Reschedule button.
5. Proceed back to Step 3 until satisfied.
Note: If, at any time during the rescheduling of simulated order line information, you decide your last simulation results were more acceptable than the current order line information displayed, select the Cancel button.

6. Save your work. Select the Save button.
action message
Output of the MRP process that identifies a type of action to be taken to correct a current or potential material coverage problem.

aggregate resources
The summation of all requirements of multi-department resources across all departments that use it.

Allocated ATP
This term is used to describe the ability to allocate scarce supply, whether it’s finished goods, or a key components or resources, to various demand channels. Whether you are performing ATP or CTP, the allocation is being considered for order promising. See Feature Highlight: Allocation.

alternate bill of material
An alternate list of component items you can use to produce an assembly.

Alternate Resources
Different resource or a group of different resources that can be used instead of primary resource or group of resources in the job operation. Each resource, or group of resources, can form an alternate group. Alternative scheduling is when the primary group can be replaced by an alternate group in the job operation.

alternate routing
An alternate manufacturing process you can use to produce an assembly.
alternate unit of measure
All other units of measure defined for an item, excluding the primary unit of measure.

API
An “Application Programming Interface (API)” is a published interface to accomplish a business or scientific function. An API defines a contract to its users by guaranteeing a published interface but hides its implementation details.

assemble-to-order (ATO)
An environment where you open a final assembly order to assemble items that customers order. Assemble-to-order is also an item attribute that you can apply to standard, model, and option class items.

assembly
An item that has a bill of material. You can purchase or manufacture an assembly item. See assemble-to-order, bill of material.

assignment hierarchy
You can assign sourcing rules and bills of distribution to a single item in an inventory organization, all items in an inventory organization, categories of items in an inventory organization, a site, and an organization. These assignments have an order of precedence relative to one another.

assignment set
A group of sourcing rules and/or bills of distribution and a description of the items and/or organizations whose replenishment they control.

ATO
See assemble-to-order.

ATO item
See assemble-to-order item.

ATO model
See assemble-to-order model.
**ATP (Available to Promise)**

ATP (Available to Promise) typically refers to the ability to promise finished goods availability based on a statement of current and planned material supply.

**ATP**

See available to promise.

**available capacity**

The amount of capacity available for a resource or production line.

**Available To Promise (ATP)**

The quantity of current on-hand stock, outstanding receipts and planned production which has not been committed through a reservation or placing demand. In Oracle Inventory, you define the types of supply and demand that should be included in your ATP calculation.

**available-to-promise rule**

A set of Yes/No options for various entities that the user enters in Oracle Inventory. The combination of the various entities are used to define what is considered supply and demand when calculating available to promise quantity.

**Basic ATP**

This term is used to describe the task of performing an ATP check against a given organization.

**bill of distribution**

Specifies a multilevel replenishment network of warehouses, distribution centers, and manufacturing centers (plants).

**bill of material**

A list of component items associated with a parent item and information about how each item relates to the parent item. Oracle Manufacturing supports standard, model, option class, and planning bills. The item information on a bill depends on the item type and bill type. The most common type of bill is a standard bill of material. A standard bill of material lists the components associated with a product or subassembly. It specifies the required quantity for each component plus other information to control work in process, material planning, and other Oracle Manufacturing functions. Also known as product structures.
**bill of resources**
A list of each resource and/or production line required to build an assembly, model, or option.

**Bottleneck Resource**
A resource whose capacity is less than the demand placed upon it. For example, a bottleneck machine or work center exists where jobs are processed at a slower rate than they are demanded.

**Calculate ATP**
An item attribute the planning process uses to decide when to calculate and print available to promise (ATP) for the item on the Planning Detail Report. The planning process calculates ATP using the following formula:

\[ ATP = \text{Planned production} - \text{committed demand} \]

**calendar type**
The period pattern used to define a manufacturing calendar.

**capable to deliver**
CTD (Capable to Deliver) refers to considering the transportation resources and transportation lead time to meet your customers delivery needs. In this release, only transportation lead time is being considered. Transportation resources will be added in a future release.

**capable to promise**
CTP (Capable to Promise) refers to the additional ability to determine the availability of component materials and resources to meet unplanned demands.

**capacity requirements planning**
A time-phased plan comparing required capacity to available capacity, based on a material requirements plan and department/resource information. See **routing-based capacity and rate-based capacity**.

**component**
A serviceable item that is a part or feature in another serviceable item. Your customers cannot report service requests against this type of serviceable item directly. You can reference components when you enter service requests against actual end item-type serviceable items, or products. For example, if you define three inventory items, A, B, and C, where A and B are products (end item-type serviceable items) but C is a component (non-end item-type serviceable item) of A,
you can enter service requests against A and B directly, but not against C. When you enter a service request against product A, you can reference C because it is a component of A. see standard component.

**component demand**
Demand passed down from a parent assembly to a component.

**component item**
An item associated with a parent item on a bill of material.

**component yield**
The percent of the amount of a component you want to issue to build an assembly that actually becomes part of that assembly. Or, the amount of a component you require to build plus the amount of the component you lose or waste while building an assembly. For example, a yield factor of 0.90 means that only 90% of the usage quantity of the component on a bill actually becomes part of the finished assembly.

**compression days**
The number of days the planning process suggests you compress the order (in other words, reduce the time between the start date and the due date).

**Discrete Job**
Discrete jobs are used to manufacture assemblies using specific materials and resources within a start and end date. (Also known as work order or assembly order).

**end item**
Any item that can be ordered or sold. See finished good and product.

**engineering change order (ECO)**
A record of revisions to one or more items usually released by engineering.

**firm planned order**
An MRP-planned order that is firmed using the Planner Workbench. This allows the planner to firm portions of the material plan without creating discrete jobs or purchase requisitions. Unlike a firm order, a MRP firm planned order does not create a natural time fence for an item.
**forecast**
An estimate of future demand on inventory items. A forecast contains information on the original and current forecast quantities (before and after consumption), the confidence factor, and any specific customer information. You can assign any number of inventory items to the forecast and use the same item in multiple forecasts. For each inventory item you specify any number of forecast entries.

**Independent Demand**
Demand for an item unrelated to the demand for other items.

**Item Routing**
A sequence of manufacturing operations that you perform to manufacture an assembly. A routing consists of an item, a series of operations, an operation sequence, and operation effective dates. Edits to an Item Routing do not automatically update a job routing.

**Job Routing**
A snapshot of an item routing that has been assigned to a job. The routing is current on the day the job was created. Edits to a job routing do not automatically revert to the item routing.

**master demand schedule**
The anticipated ship schedule in terms of rates or discrete quantities, and dates. In ASCP, MDS is used as an input to the enterprise plan.

**Material Constrained Plan**
In this plan, all material constraints that can be specified in the form of a supply schedule from manufacturing plants or by statements of vendor capacity from vendors are considered. When material availability is not a concern, resource availability constraints are used only to generate exceptions arising due to over utilization or under-utilization of resources.

**Material and Resource Constrained Plan**
In this plan, you can generate a plan that respects material, resource, and transportation constraints. However, no plan objectives are considered.

**Multilevel Supply Chain ATP/CTP/CTD**
This term is used to describe the task of performing a multilevel BOM availability check including finished goods, components, resource, supplier capacity and
transportation lead time. See Feature Highlight: *Multilevel Supply Chain ATP/CTP/CTD*

For the rest of the document, we will use ‘Multilevel ATP’ as a short form for this feature.

**Need By Date**

The ‘need by date’ for the end item is the demand date. The need by dates for the dependent demands are calculated based on the lead-time offsets that are associated to the Items and routings used.

- If a **constrained** plan is run, the planning process will use the planned orders and actual routings for scheduling to derive the suggested due date.
- If an **unconstrained** plan is run, the suggested due date will simply be the same as the need by date.

Therefore, any differences between the lead time offsets (need by date) and actual manufacturing time (suggested due date) created by the planning process, will show up in the form of multiple exception messages.

**Operation Data Store (ODS)**

It represents all the tables that acts as destination for the collected data from each of the data sources (both Oracle Applications or legacy systems). This acts as the input for the snapshot portion of the planning process.

When we refer to ODS based ATP, we mean ATP based on collected data.

**Optimized Plan**

In this plan, you can generate an optimized and executable plan based on plan objectives as well as material, resource, and transportation constraints.

**overload**

A condition where required capacity for a resource or production is greater than available capacity.

**Pegging**

The capability to identify for a given item the sources of its gross requirements and/or allocations. Pegging can be thought of as active where-used information.

**Planned Order**

A suggested quantity, release date, and due date that satisfies net item requirements.
Planner Workbench
You can use the Planner Workbench to act on recommendations generated by the planning process for a plan. You can implement planned orders as discrete jobs or purchase requisitions, maintain planned orders, reschedule scheduled receipts, and implement repetitive schedules. You can choose all suggestions from an MRP plan, or only those that meet a certain criteria.

Planning Data Store (PDS)
It represents all the tables within Oracle ASCP which encompass those in the ODS and other output tables from planning. When we refer to PDS based ATP, we mean ATP based on planning output.

Planning Exception Set
An item attribute that the planning process uses to decide when to raise planning exceptions for the item.

planning horizon
The amount of time a master schedule extends into the future.

Planning Time Fence
A Master Scheduling/MRP item attribute used to determine a future point in time inside which there are certain restrictions on the planning recommendations the planning process can make for the item.

postprocessing lead time
The time required to receive a purchased item into inventory from the initial supplier receipt, such as the time required to deliver an order from the receiving dock to its final destination.

preprocessing lead time
The time required to place a purchase order or create a discrete job or repetitive schedule that you must add to purchasing or manufacturing lead time to determine total lead time. If you define this time for a repetitive item, the planning process ignores it.

processing lead time
The time required to procure or manufacture an item. For manufactured assemblies, processing lead time equals the manufacturing lead time.
**projected available balance**

Quantity on hand projected into the future if scheduled receipts are rescheduled or cancelled, and new planned orders are created as per recommendations made by the planning process. Calculated by the planning process as current and planned supply (nettable quantity on hand + scheduled receipts + planned orders) minus demand (gross requirements). Note that gross requirements for projected available includes derived demand from planned orders. Note also that the planning process uses suggested due dates rather than current due dates to pass down demand to lower level items. See current projected on hand.

**projected on hand**

The total quantity on hand plus the total scheduled receipts plus the total planned orders.

**Resource Constrained Plan**

In this option, all resource constraints such as available machine hours, transportation capacity, as well as alternate resources are considered. Alternate bill of materials are considered only when optimized option is selected. Material constraints are used only to generate exceptions arising due to lack of material availability.

**routing**

A sequence of manufacturing operations that you perform to manufacture an assembly. A routing consists of an item, a series of operations, an operation sequence, and operation effective dates.

**safety stock**

Quantity of stock planned to have in inventory to protect against fluctuations in demand and/or supply.

**scheduled receipt**

A discrete job, repetitive schedule, non-standard job, purchase requisition, or purchase order. It is treated as part of available supply during the netting process. Schedule receipt dates and/or quantities are not altered automatically by the MRP system.
**Seiban manufacturing**
A type of manufacturing environment where demand and supply are identified by Seiban numbers to peg supply to demand. This numbering system is widely used in Japan and Korea.

**Simultaneous Resources**
Two or more resources are scheduled to be working concurrently within a job operation. Each operation contains a scheduled sequence of activities and resources used in the operation. Simultaneity is implemented by having more than one resource used in an operation.

**sourcing rule**
Specifies how to replenish items in an organization, such as purchased items in plants. **Suggested Dock Date**
The date you expect to receive an order (to arrive on the receiving dock) as suggested by the planning process.

**Suggested Due Date**
The date when scheduled receipts are expected to be received into inventory and become available for use as suggested by the planning process.

The ‘need by date’ for the end item is the demand date. The need by dates for the dependent demands are calculated based on the lead-time offsets that are associated to the Items and routings used.

- If a constrained plan is run, the planning process will use the planned orders and actual routings for scheduling to derive the suggested due date.
- If an unconstrained plan is run, the suggested due date will simply be the same as the need by date.

Therefore, any differences between the lead time offsets (need by date) and actual manufacturing time (suggested due date) created by the planning process, will show up in the form of multiple exception messages.

**Suggested Order Date**
The date that the planning process suggests an order for goods or services is entered. The earliest order date allowed is today and no compression days are allowed.
**Suggested Start Date**
The date you or your suppliers expect to start to manufacture the order as suggested by the planning process.

**Supply Chain ATP**
This term is used to describe the task of performing an ATP check against multiple sourcing organizations for a given customer request. See Feature Highlight: *ATP for Multiple Supply Locations*.

**Supplier Flex-fences**
Specifies capacity tolerance percentages that vary over time for each source. This allows you to represent the ability of your supplier to flex capacity upwards based on the amount of advanced notice you provide.

**time bucket**
A unit of time used for defining and consuming forecasts. A bucket can be one day, one week, or one period.

**Unconstrained Plan**
In this plan, the system performs traditional MRP type planning and assumes infinite material availability and resource capacity. Statements of material availability and resource capacity are used to generate exceptions. Demand priorities are included during the planning run to determine the appropriate pegging relationships between supply and demand.

**underload**
A condition where required capacity for a resource or production is less than available capacity.

**workday calendar**
A
a day in the life of a planner, 3-5
accessing and executing planned orders, 10-43
accessing the Aggregation tab, 17-12
accessing the Gantt Chart, 10-47
accessing the Optimization tab, 17-14
accessing the Options tab, 17-11
accessing the Organizations tab, 17-15
accessing the resource tool tip, 10-54
Accumulate Available, 16-61
Accurate Global Statement of Availability, 16-2
actions
  saving, 7-7
  undoing, 7-11
  viewing, 7-7
  viewing details, 7-10
Actions tab, 1-10
Actions tab and tree, 1-9
actions/exceptions tab, 10-30
adding capacity, 10-61
additional scheduling heuristic, 11-16
advanced planning for mixed mode manufacturing, 1-4
aggregate resources, 12-7
  flexfields, 12-7 to 12-10
aggregation, 17-30, 17-31
aggregation levels, 5-32, 17-17
  product, 5-33
  resource, 5-33
  time, 5-32
Aggregation tab
  accessing from the Navigator, 5-21
Allocated ATP, 16-38
ATP Inquiry and Viewing Allocations, 16-44
ATP Plan, 16-40
ATP Rule, 16-39
Business Applications, 16-38
Data Collection, 16-44
Define Allocation Rules, 16-40
Define Customer Class Hierarchy, 16-40
Define Demand Classes, 16-40
Example, 16-48
Feature Description, 16-38
Item Attributes, 16-39
Product Dependency, 16-54
Profile - INV
  Capable to Promise, 16-43
Profile - MRP
  ATP Database Link, 16-44
Profile - MSC
  Class Hierarchy, 16-43
  Enable Allocated ATP, 16-44
  Enable Allocated Workflow, 16-44
  Refreshing Allcations, 16-47
Resource Allocation, 16-55
Setup Steps, 16-39
View Allocations Workbench, 16-46
allocated ATP
  assigning allocation rules, 16-42
  percentages, 16-40
  priorities, 16-41
Allocated ATP From Advanced Supply Chain Planning, 16-45
Allocated ATP From i-Store, 16-45
Allocated ATP From Order Management, 16-45
Allocated ATP Using Customer-Class Hierarchy, 16-51
allocated Order Promising, 1-20
assigning allocation rules, 16-42
defining the allocation rules, 16-41
allocating demand based on historical demand, 6-19
allocating demand to suppliers, 6-18
Allocation, 16-3
allocation priorities, 16-41
alternate resources, 12-7
flexfields, 12-7 to 12-10
loading, 10-61
AOL concurrent program architecture, 4-2
Applications Instance window setting up, 2-14
APS information flows, 3-2
ASCP and Oracle BIS, 1-8
assigning allocation rules, 16-42
assignment sets
assignment hierarchy, 6-4
defining, 6-3
viewing, 6-30
ATP, 16-2
API, 16-70
Collecting Data, 16-70
Component Substitution, 16-63
inquiry, 16-65
Using Multiple Plans, 16-64
ATP Based on Collected Data, 16-6
ATP Based on Planning Data, 16-6
ATP for Multiple Supply Locations, 16-2
ATP Inquiry, 16-70
ATP Methods, 16-6
ATP Scheduling, 16-70
available capacity
viewing, 10-27
Available to Promise
See ATP, 16-21

B
Backward Consumption of Shortage, 16-61
Basic ATP, 16-9
ATP Inquiry, 16-10
ATP Logic, 16-11
ATP Rule, 16-9

Business Application, 16-9
Data Collection, 16-10
From Advanced Supply Chain Planning, 16-11
From Order Management, 16-10
Profile - INV
  Capable to Promise, 16-10
Profile - MRP
  ATP Database Link, 16-10
Setup Steps, 16-9
Basic ATP From i-Store, 16-10
batch replan
running, 7-5
bills of distribution
  See BODs, 6-2
Bills of Materials, 11-3
BODs, 6-2
defining, 6-3
viewing, 6-30
BOM
reviewing, 10-46
bookmark
creating, 7-12
borrow payback, 12-13
business flows, 3-2
by-products, 11-5

C
Capable to Deliver
  See CTD, 16-21
Capable to Promise
  See CTP, 16-21
capacity
  adding, 10-61
capacity exceptions, 17-52
category/demand class, 17-37
centralized and decentralized planning, 16-4
Centralized Order Promising, 16-4
centralized planning, 4-7
changing duration of an operation, 10-58
checking status of an online planner session, 7-6
choosing a plan type, 5-11
choosing between global inventory and subset plans
defining a plan, 17-6
choosing plan types
centralized vs. decentralized planning, 1-4
collaborating with suppliers, 13-4
collection strategy, 4-3
data consolidation, 4-4
detect net change, 4-4
multiprocess collection architecture, 4-4
projects/tasks and Seiban numbers, 4-5
pull architecture, 4-4
Collection Workbench, 4-3
color codes
Gantt Chart, 10-50
commanality of the items produced
- defining a plan, 17-6
common planner tasks
- a day in the life of a planner, 3-5
commanality of the supply base
- defining a plan, 17-6
comparing different optimization runs, 8-28
comparing KPIs for multiple plans, 10-22
Computation Options, 16-61
computational burden considerations, 5-43
Configuration ATP, 16-3
configurations
- support for, 4-5
- supported, 4-7
constrained safety stocks, 17-47
constraint types, 11-2
demands, 11-3, 11-10
items, 11-2, 11-3
BOMs, 11-3
byproducts, 11-5
coproducts, 12-37
ECOs, 11-3
order modifiers, 11-7
product families, 11-5
safety stocks, 11-5
substitute components, 11-4
lot-based jobs, 12-36
manufacturing resources, 11-2, 11-8
sourcing constraints, 11-3, 11-9
suppliers, 11-3, 11-9
transportation resources, 11-2, 11-9
constraint-based planning, 1-6
- overview, 11-2
- constraint-based planning rules

additional scheduling heuristic, 11-16
constraints
- enabling and disabling, 11-11
- rules, 11-16
controlling aggregation
- plan end date, 17-29
- plan options, 17-29
- setting routing aggregation level for a time horizon, 17-32
- viewing the end date for inventory plan, 17-29
coproducts, 12-37
- planned order released quantity, 12-39
corporate structure
- defining a plan, 17-7
cost breakdown, 1-18
creating a bookmark, 7-12
creating a custom folder, 10-35
creating a plan, 3-6
creating and implementing firm planned orders, 10-43
creating and launching an inventory plan, 17-7
creating demand priority flexfield numbers manually, B-3
creating profile, B-4
CTD, 16-2
CTO enhancements, 14-2
CTP, 16-2
custom folder, 10-35
customer submissions, 13-3
- consolidating customer forecasts, 13-3

data collection, 4-3, 4-14
- architecture, 4-2, 4-5, 4-6
- collection strategy, 4-4
- multiple source instances, 4-4
- Oracle Global Order Promising, 16-8
- setting up, 4-10, 4-12
- simplified architecture, 4-9
data consolidation, 4-4
Decentralized Order Promising, 16-5
decentralized planning, 4-8
decreasing demands, 5-43
decreasing items, 5-43
Index-4

decreasing resources, 5-43
defining a demand class service level, 17-35
defining a demand class ATP from Advanced Supply Chain Planning, 16-56
defining a demand class ATP versus Allocated ATP, 16-57
defining a demand plan, 18-30
defining a demand plan hierarchy, 18-33
defining a demand plan parameters, 18-34 to ??
defining a demand plan scenario, 18-37
defining a demand plan scenario, 18-37 to ??
defining a demand plan scenario, 18-37 to ??
defining a demand planning hierarchy levels, 18-19
defining a demand planning levels, 18-18
defining a demand plans, 18-30
defining a plan
  choosing between global inventory and subset plans, 17-6
comanality of the items produced, 17-6
comanality of the supply base, 17-6
corporate structure, 17-7
factors to consider when deciding to run global supply chain or subset plan, 17-7
linkage among plants, 17-7
Oracle Risk Optimization, 17-6
physical proximity of organizations being planned, 17-6
defining a plan parameters
  defining demand plan parameters, 18-34 to ??
defining a plan scenario, 18-37
defining a plan scenario, 18-37 to ??
defining a plan scenario, 18-37 to ??
defining demand class service level, 17-35
defining demand class ATP from Advanced Supply Chain Planning, 16-56
defining demand class ATP versus Allocated ATP, 16-57
defining demand plan hierarchy, 18-33
defining demand plan parameters, 18-34 to ??
defining demand plan scenario, 18-37
defining demand plan scenario, 18-37 to ??
defining demand planning hierarchy levels, 18-19
defining demand planning levels, 18-18
defining demand plans, 18-30
defining Express setup, 18-40
  defining Express setup, 18-40
defining graphs, 10-26
defining plan parameters, 18-34
defining plans, 5-2
  choosing plan classes, 5-15
  controlling aggregation levels, 5-32, 17-17
global supply chain planning and subset planning, 5-9, 17-6
  setting plan options, 5-18, 17-11
defining priority rules
  order backlog workbench, C-8
defining the allocation rules, 16-41
Demand ATP From Advanced Supply Chain Planning, 16-56
demand class, 17-40
Demand Class ATP From Order Management, 16-58
demand flow diagram
  multilevel ATO, 14-8
demand management, 12-24
demand plan hierarchy levels
  defining, 18-19
demand plan parameters
  defining, 18-34 to ??
demand plan scenarios, 18-37
defining, 18-37 to ??
development responsibilities
  choosing the aggregate level, granularity, and past data, 18-57
  choosing the statistical forecasting method, 18-56
  generating pre-defined and ad-hoc reports, 18-58
  modifying forecast numbers using judgment, 18-57
  modifying history and re-forecasting, 18-57
  performing what-if simulations and sales planning, 18-58
  reacting to alerts, 18-58
demand planning dimensions
  defining, 18-13
demand planning hierarchy levels
  defining, 18-19
demand planning levels
  defining, 18-18
demand plans
  defining, 18-30
demand schedules
  specifying sources of demand, 17-27
demand sources, 3-5
deficeps
demand-to-make/demand-to-buy business flow, 3-3
Detailed Availability Information with Graphical Pegging Tree, 16-2
discrete and process manufacturing, 1-4
discrete jobs and purchase requisitions recommendations, 9-58
displaying the Find window, 10-51
displaying the pegging tree, 10-39
displaying the Property window, 10-53
displaying your plan horizontally, 10-24, 10-25

E
early replenishment for forecast, 9-33
early replenishment for sales order, 9-32
ECOs, 11-3
effectivity in the BOM, 12-16
enabling and disabling constraints, 11-11
entering order promising criteria, 16-65
exceeding resource capacity, 8-27, 8-28
exception details
days late column, 10-33
viewing, 10-35
exception messages, 9-12
early replenishment for forecast, 9-33
early replenishment for sales order, 9-32
figuring out root cause of late replenishment, 9-30
figuring out the root cause of late replenishment, 9-32
item exceptions, 9-12, 9-55
items allocated across projects/tasks, 9-54
items below safety stock, 9-44
items that are over-committed, 9-55
items with a shortage, 9-43
items with a shortage in a project/task, 9-53
items with excess inventory, 9-44
items with excess inventory in a project/task, 9-54
items with expired lot, 9-57
items with negative starting on hand, 9-56
items with no activity, 9-58
items with repetitive variance, 9-57
late replenishment for forecast, 9-31
late replenishment for sales order, 9-29
late sales orders and forecasts, 9-22
late supply pegged to forecast, 9-27
late supply pegged to sales order, 9-26
making decisions based on, 9-20
material and resource capacity, 9-34
material constraint, 9-34
Oracle Workflow, 12-18
order at risk due to materials shortage, 9-22
order at risk due to resource shortage, 9-24
order sourced from alternate facility, 9-51
order sourced from alternate supplier, 9-52
orders to be cancelled, 9-46
orders to be rescheduled in, 9-47
orders to be rescheduled out, 9-46
orders with compression days, 9-48
past due forecast, 9-29
past due orders, 9-45
past due sales orders, 9-27
planned order uses alternate BOM, 9-49
planned order uses alternate resources, 9-51
planned order uses alternate routing, 9-49
planned order uses substitute components, 9-50
projects/tasks, 9-53
recommendations, 9-58
reschedules, 9-45
resource constraint, 9-36
resource overloaded, 9-38
resource underloaded, 9-40
shortages and excess, 9-43
substitutes and alternates used, 9-49
supplier capacity overloaded, 9-39
transportation and distribution exception messages, 9-41
transportation resource constraint, 9-41
transportation resource overloaded, 9-42
transportation resource underloaded, 9-42
exceptions
reviewing, 3-7
sorting, 10-31
exceptions details
viewing, 10-32
exceptions for multiple plan scenarios
graphically comparing, 10-36
exclusive stochastic optimization solution, 1-16
Express setup
defining, 18-40

F
factors to consider when deciding to run global supply chain or subset plan, 17-7
figuring out root cause of late replenishment, 9-30, 9-32
Find window
displaying, 10-4, 10-51
Gantt Chart, 10-50
firm planned orders
creating and implementing, 10-43
firming an operation, 10-59
firming order, 3-13
fixed days supply, 11-8
fixed lot multiple, 11-7
fixed order quantity, 11-7
flexfield numbers
creating manually, B-3
flexfields, B-1
applying to different versions of Oracle RDBMS, B-3
transportation capacity, B-3
flexibly tailor the scope of availability checks, 1-19
flow line scheduling, 12-18
flow manufacturing
See Oracle Flow Manufacturing, 12-22
forecast consumption as an input to a plan, 5-26
forecast explosion
multilevel ATO, 14-4
Forward Consumption of Shortage, 16-61

G
Gantt Chart
accessing, 10-47
color codes, 10-50
Find window, 10-50
interactive scheduling, 10-47
rescheduling operations, 10-57
right-click menu options, 10-51
saving changes, 10-63
generating planned orders, 12-16
global (plan level), 17-41
global supply chain and subset plans
choosing between, 5-9
global supply chain plan, 5-9, 17-6
creating and launching, 5-4
running, 5-3
setting parameters, 17-9
graphically comparing exceptions for multiple plan scenarios, 10-36
graphs
changing number of periods, 10-27
choosing types of, 10-27
defining, 10-26
defining dynamically, 10-26
group netting, 12-13

H
hard and soft constraints
setting, 11-12
hard pegging, 12-12, 12-13
supply chain planning with, 12-13
historical demand
allocating demand according to, 6-19
Horizontal Plan, 1-10
horizontal plan, 10-23

I
ILOG CPLEX Solver Profile Options, A-7
implementing planning recommendations, 10-43
increasing inventory turns, 9-10
increasing margin percentage, 9-10
increasing ontime delivery, 9-11
increasing planned utilization, 9-10
Infinite Supply Time Fence, 16-60
inquiry-to-order business flow, 3-4
integrated performance management, 1-8
integration with OSFM, 1-14
interactive scheduling
Gantt Chart, 10-47
INV-Capable to Promise
profile options, A-10
inventory carrying costs percentage, 8-27
inventory methods, 11-6
inventory turns, 5-38, 10-20
inventory value, 9-7
INV-External ATP
  profile options, A-11
item exceptions exception messages, 9-55
Item Forecast Workflow
  See also Oracle Workflow, 13-6
item planning information, 10-22
item workflow, 3-9
item/demand class
  setting service levels, 17-35
items
  decreasing, 5-43
items allocated across projects/tasks, 9-54
items below safety stock, 9-44
items that are over-committed, 9-55
items with a shortage, 9-43
items with a shortage in a project/task, 9-53
items with excess inventory, 9-44
items with excess inventory in a project/task, 9-54
items with expired lot, 9-57
items with negative starting on hand, 9-56
items with no activity, 9-58
items with repetitive variance, 9-57

K
  kanban planning and execution, 12-24
  key performance indicators, 1-18
  See also KPIs, 1-8
KPI setup, 9-8
KPIs, 1-8, 9-2
  comparing multiple plans, 10-22
  cost breakdown, 1-18
    calculation, 9-6
  inventory turns, 10-20
    calculation, 9-4
    increasing, 9-10
  margin
    calculation, 9-6
  margin percentage, 10-21
    calculation, 9-5
    increasing, 9-10
  ontime delivery, 10-21
    calculation, 9-6
    increasing, 9-11
  planned utilization, 10-21
    calculation, 9-5
    increasing, 9-10
  profit margin, 1-18
    calculation, 9-7
    setting targets, 9-9
  tab, 10-17
  viewing, 10-18
  viewing an enlarged version, 10-18

L
  late replenishment for forecast, 9-31
  late replenishment for sales order, 9-29
  late sales orders and forecasts, 9-22
  late supply pegged to forecast, 9-27
  late supply pegged to sales order, 9-26
  launching a plan, 3-6
  line design and balancing, 12-24
  linkage among plants
    defining a plan, 17-7
  loading alternate resources, 10-61
  lot-based jobs, 12-36
  LRS
    See Log roll-forward server (LRS), B-1

M
  making decisions based on exception
    messages, 9-20
  manufacturing resources
    network routings, 12-42
    operation yield, 12-40
    resources, 11-8
    routings, 11-8
    workday calendar, 11-8
  margin percentage, 5-38, 10-21
  material aggregation, 5-36, 17-30
  material and resource capacity exception
    messages, 9-34
  Material and Resource Capacity Workflow
See also Oracle Workflow, 13-6
material constraint, 9-34
material workflow, 3-9
material/resource availability, 17-50
maximize inventory turns, 8-3
specifying plan objectives, 17-33
maximize ontime delivery, 8-3
specifying plan objectives, 17-34
maximize plan profit, 8-3
specifying plan objectives, 17-33
maximum allowable days late, 8-28
minimum and maximum order quantity, 11-7
mixed mode manufacturing, 1-4
common features, 12-2
discrete and process manufacturing, 1-4
efficiency, 12-6
Engineer to Order/Aerospace Defense, 1-5
Oracle Project Manufacturing and Oracle
ASCP, 1-5
Oracle Flow Manufacturing and Oracle
overview, 12-2
phantom routings, 12-2 to 12-5
routing effectiveness, 12-6
utilization, 12-6
model and manage variability, 1-17
model unit number, 12-16
generating planned orders, 12-16
model/unit effectiveness, 12-16
effectiveness in the BOM, 12-16
flow line scheduling, 12-18
model unit number, 12-16
pegging, 12-18
Planner Workbench, 12-16
unit numbers in sales orders, 12-16
WIP mass/load PO requisitions interface, 12-18
modes, 7-3
modify objectives, 3-10
modify supplier parameters, 3-12
modifying release properties, 10-44
modifying resources, 3-11
modifying supply and demand, 3-11
MRP
Include Substitute Components, 16-64
MRP planned percent, 11-6
MRP Planning Type item attribute, 5-11
MRP-ATP Assignment Set
profile options, A-11
MRP-ATP Database Link
profile options, A-11
MRP-Calculate Supply Demand
profile options, A-11
MRP-Include Substitute Components, A-11
MSC-ATP Assignment Set
profile options, A-12
MSC-Default Workbench Height
profile options, A-6
MSC-Default Workbench Width
profile options, A-6
MSC-Enable Allocated ATP
profile options, A-11
MSC-Enable Allocated ATP Workflow
profile options, A-12
MSC-Hour UOM
profile options, A-6
MSC-Map Server Host
profile options, A-6
MSC-Map Server Port
profile options, A-6
MSC-Plan co-products
profile options, A-6
MSC-Planning Currency
profile options, A-7
MSC-Sales Orders Offset Days
profile options, A-7
MSC-Share Plan Partitions
profile options, A-7
MSC-Sourcing Rule Category Set
profile options, A-7
MSO- Alternate Resource Penalty
profile options, A-5
MSO-Alternate Process Penalty
profile options, A-4
MSO-Alternate Source Penalty
profile options, A-5
MSO-Check Redundant Constraints
profile options, A-7
MSO-CPLEX Crash Parameter
profile options, A-7
MSO-CPLEX Refactor Rate
profile options, A-8
MSO-CPLEX Scaling Factor
profile options, A-8
MSO-Default Forecast Priority
profile options, A-1
MSO-Default Sales Order Priority
profile options, A-1
MSO-Dual Simplex Parameter
profile options, A-8
MSO-Firm Supply Allocation Window (days)
profile options, A-4
MSO-Float Point Precision
profile options, A-1
MSO-Global Time Limit
profile options, A-8
MSO-Heuristic type
profile options, A-2
MSO-Inventory Carrying Costs Percentage
profile options, A-5
MSO-List Size for Pricing Candidates
profile options, A-5
MSO-LP Markowitz Coefficient
profile options, A-8
MSO-LP Optimization Algorithm
profile options, A-8
MSO-Maximum Allowable Days Late
profile options, A-5
MSO-Maximum Demands per Group
profile options, A-2
MSO-Maximum Demands per Slice
profile options, A-2
MSO-Maximum Number of Prepones
profile options, A-2
MSO-Maximum Number of Pull for Operation
profile options, A-3
MSO-Maximum Resource Overcapacity
profile options, A-3
MSO-Maximum Simplex Iterations
profile options, A-8
MSO-Network routing cycle time coefficient
profile options, A-3
MSO-Network routing fixed time window
profile options, A-3
MSO-NFL BACKWARD COMPRESSION
PCT, A-3
MSO-NFL FORWARD COMPRESSION PCT
profile options, A-4
MSO-Penalty Cost Factor for Exceeding Material Capacity
profile options, A-5
MSO-Penalty Cost Factor for Exceeding Resource Capacity
profile options, A-6
MSO-Penalty Cost Factor for Late Demands
profile options, A-6
MSO-Preprocessing Aggregator Fill
profile options, A-8
MSO-Preprocessing Aggregator Limit
profile options, A-8
MSO-Preprocessing Flag for LP Matrix
profile options, A-8
MSO-Primal Simplex Parameter
profile options, A-9
MSO-Queue Time Factor
profile options, A-6
MSO-Schedule Across Breaks
profile options, A-4
MSO-Schedule window width
profile options, A-4
MSO-Simplex Feasibility Tolerance
profile options, A-9
MSO-Simplex Optimality Tolerance
profile options, A-9
MSO-Simplex Perturbation Constant
profile options, A-9
MSO-Simplex Perturbation Indicator
profile options, A-9
MSO-Simplex Perturbation Limit
profile options, A-9
MSO-Simplex Presolve Limit
profile options, A-9
MSO-Simplex Singularity Repair Limit
profile options, A-9
MSO-Solve Dual Problem
profile options, A-9
MSO-Substitute Item Penalty
profile options, A-6
multilevel ATO
demand flow diagram, 14-8
forecast explosion, 14-4
Order Promising, 14-7
planning process, 14-4
setup required to use, 14-10
Multilevel ATO Model, 16-37
multilevel ATO with example, 14-2
Multilevel ATP From Advanced Supply Chain Planning, 16-27
Multilevel ATP From i-Store, 16-26
Multilevel ATP From Order Management, 16-26
Multilevel ATP Logic in a Single Organization, 16-27
Multilevel ATP Logic Involving Supply Chain, 16-28
Multilevel Supply Chain ATP, 16-2, 16-21
ATP Inquiry, 16-26
ATP Logic, 16-27
ATP Plan, 16-23
ATP Rule, 16-23
Business Application, 16-22
Data Collection and Running a Plan, 16-26
Example, 16-28
Feature Description, 16-21
Instance Setup, 16-25
Interlocation Transit Times, 16-24
Item Attributes, 16-22
Manufacturing Capacity, 16-24
Product Dependency, 16-37
Profile - MRP
   ATP Assignment Set, 16-25
   ATP Database Link, 16-25
Profile - MSC
   ATP Assignment Set, 16-25
   Setup Steps, 16-22
Supplier Capacity, 16-24
Supply Chain, 16-23
multilevel supply chain ATP/CTP/CTD, 1-20
multiprocess collection architecture, 4-4

network routings, 1-14, 12-42
optimize, 12-43
planned percent, 12-43
primary path, 12-43
new time bucket for lower pane specifying, 10-56
new time bucket for right pane specifying, 10-55

objective functions, 5-38
   combining objectives, 5-40
   implicit objectives, 5-40
   inventory turns, 5-38
   margin percentage, 5-38
   ontime delivery, 5-39
ODS
   Demand, 16-62
   Supply, 16-61
ODS Load, 4-3
online planner, 7-4
   batch mode planner, 7-3
online planner session
   checking status, 7-6
   stopping, 7-7
online replan
   running, 7-5
ontime delivery, 5-39, 10-21
operation
   changing duration, 10-58
   firming, 10-59
   reschedule graphically, 10-58
   rescheduling, 10-57, 10-60
   resolving overload, 10-60
   viewing information, 10-52
operation yield, 12-40
Operational Data Store (ODS), 4-2
Operational Data Store (ODS) Load, 4-2
optimization, 1-7, 7-3
   comparing different optimization runs, 8-28
   maximize inventory turns, 8-3
   maximize ontime delivery, 8-3
   maximize plan profit, 8-3
   objectives, 3-10

nervousness, 5-45
net availability, 12-6
net change, 3-12, 4-4
net change planning, 3-12
net change replan, 7-3
   running, 7-5
See also KPIs, 8-2
overview, 8-2
plan types, 3-10
profile options, A-4
See also KPIs, 3-10
See also plan classes, 5-17
weighting objectives, 1-7
optimization across multiple objectives, 1-17
optimization objectives
maximize inventory turns, 1-7
maximize ontime delivery, 1-7
maximize plan profit, 1-7
Optimization tab
accessing from the Navigator, 5-22
optimize
network routings, 12-43
optimized plan
running, 3-10
Options tab
accessing from the Navigator, 5-18
Oracle Advance Supply Chain Planning
introduction, 1-3
Oracle Applications Data Store (ADS), 4-2
Oracle Applications version, 4-5
Oracle ASCP Flexfield Attribute Profile
Option, A-9
Oracle ASCP Flexfields, B-1
Oracle ASCP for Engineer to Order/Aerospace and
Defense, 1-5
Oracle ASCP Optimization Profile Options, A-4
Oracle ASCP Scheduling Profile Options, A-1
Oracle Demand Planning
demand planner responsibilities, 18-56 to ??
Oracle Flow Manufacturing, 1-5, 12-22, 12-23,
12-24, 12-25
demand management, 12-24
Oracle Global Order Promising
allocated order promising, 1-20
flexibly tailor the scope of availability
checks, 1-19
introduction, 1-19
multilevel supply chain ATP/CTP/CTD, 1-20
overview, 16-2
profile options, A-10
sources of supply and demand, 16-6
Order Promising from ODS-ATP Rules, 16-6
Order Promising from PDS, 16-6
Oracle Process Manufacturing, 12-26
creating a resource warehouse, 12-29
differences between production in OPM and
Oracle Applications, 12-27
effectivity, formulas, and routings, 12-31
merged organization structure, 12-26, 12-27
merging effectivities, formulas, and
routings, 12-29
MPS schedule, 12-33
OPM data for Oracle ASCP, 12-26 to 12-35
OPM organizations, 12-30
plant/warehouse relationships, 12-33
recommended organization structure, 12-28
resources, 12-32
setting up and using OPM data, 12-30
unit of measure, 12-30
Oracle Project Manufacturing, 1-5, 12-11
borrow payback, 12-13
group netting, 12-13
hard pegging, 12-12, 12-13
model/unit effectivity, 12-16
soft pegging, 12-12
Oracle Risk Optimization
defining a plan, 17-6
input, 17-4
introduction, 1-16
key performance indicators, 1-18
model and manage variability, 1-17
optimization across multiple objectives, 1-17
output, 17-5
overview, 17-2
Oracle Workflow, 13-5
defining and modifying business rules, 13-5
defining electronic notifications, 13-5
exception messages, 12-18
item workflow, 3-9
material workflow, 3-9
overview, 13-5
predefined workflows, 13-6
project workflow, 3-9
rescheduling workflow, 3-9
review workflow notifications, 3-8
sales order workflow, 3-9
order
  firming, 3-13
  releasing, 3-13
order at risk due to materials shortage, 9-22
order at risk due to resource shortage, 9-24
order backlog scheduling process, C-2
order backlog workbench, C-1
  defining priority rules, C-8
  rescheduling, C-18
  scheduling order lines, C-15
  scheduling orders, C-9
  selection criteria for scheduling, C-7
  user interface, C-4
order line pegging, C-7
order modifiers, 11-7
  fixed days supply, 11-8
  fixed lot multiple, 11-7
  fixed order quantity, 11-7
  minimum and maximum order quantity, 11-7
  rounding order quantities, 11-8
  supplier specific, 6-10
Order Promising
  Architecture, 16-4
  criteria, 16-65
  data collection, 16-8
  Integration with Other Oracle Applications, 16-4
  multilevel ATO, 14-7
Order Promising Flexible Configuration, 16-3
Order Promising from PDS, 16-6
Order Promising related attributes
  multilevel ATO
    Order Promising related attributes, 14-10
order sourced from alternate facility, 9-51
order sourced from alternate supplier, 9-52
orders to be cancelled, 9-46
orders to be rescheduled in, 9-47
orders to be rescheduled out, 9-46
orders with compression days, 9-48
Organization window
  setting up, 2-15
Organizations tab
  accessing from the Navigator, 5-25
OSFM
  integration with, 1-14
network routings, 1-14
  support for coproducts, 1-14
  support for lot-based jobs, 1-14
  yield at operation level, 1-14
Other ATP Functions, 16-60
Other Oracle ASCP Profile Options, A-6
overview of optimization, 8-2

P
  past due forecast, 9-29
  past due orders, 9-45
  past due sales orders, 9-27
  Past due demand days, 16-60
  Past due supply days, 16-60
  PDS
    Supply & Demand, 16-62
    pegging, 12-12, 12-13, 12-15, 12-18
    viewing supply and demand information, 10-39
    pegging supply and demand, 3-9
    pegging tree
      displaying, 10-39
penalty costs, 8-27, 8-28
  exceeding material capacity, 8-26, 8-27
  exceeding resource capacity, 8-27
  exceeding transportation capacity, 8-27
  late demand, 8-26, 8-27
penalty costs vs. penalty factors, 8-4
penalty factors
  exceeding material capacity, 8-13
  exceeding resource capacity, 8-21
  late demand, 8-5
  setting, 8-4
  setting using plan options, 8-26
  setting using the Optimization tab, 5-24, 8-27
performance indicators
  viewing output, 17-44
performance management
  overview, 9-2
  supply chain partners, 13-4
phantom routings, 12-2 to 12-5
physical proximity of organizations being planned
  defining a plan, 17-6
plan
  viewing undo summary, 7-9
plan classes
  material and resource constrained, 5-15, 5-16
  material constrained, 5-15, 5-16
  optimized, 5-15, 5-17
  resource constrained, 5-15, 5-16
  unconstrained, 5-15, 5-16
plan end date
  controlling aggregation, 17-29
plan options
  Aggregation tab, 5-21, 17-12
  controlling aggregation, 17-29
  Optimization tab, 5-22, 17-14
  Options tab, 5-18, 17-11
  Organizations tab, 5-25, 17-15
  selecting planned items, 17-24
  set supplier lead time variability, 17-22
  setting penalty factors, 8-26
  setting supplier lead time variability, 17-23
  specify supply types, 17-27
  specifying items to be included in the inventory plan, 17-24
  specifying sources of supply and demand, 17-27
  specifying supply types, 17-27
  using an existing plan as a demand schedule for new plan, 17-17
  using an existing plan as a supply schedule for a new plan, 17-17
plan type
  choosing a, 5-11
  MRP Planning Type item attribute, 5-11
plan types, 3-10
  setting constraints, 11-14
  unconstrained, 3-10
planned order released quantity for coproducts, 12-39
planned order uses alternate BOM, 9-49
planned order uses alternate resources, 9-51
planned order uses alternate routing, 9-49
planned order uses substitute components, 9-50
planned orders
  accessing and executing, 10-43
planned percent
  network routings, 12-43
planned utilization, 10-21
Planner Workbench, 1-8, 1-9, 10-10, 12-16
  drill down, 10-3
  find window, 10-3
  general navigation, 10-2
  pull-down menus, 10-5
  right-click menu options, 10-6
  tailoring, 10-9
  using left pane and navigation tree, 10-13
  using right pane and navigation tree, 10-17
Planning Data Store (PDS), 4-2
planning process
  multilevel ATO, 14-4
planning recommendations
  planning, 10-43
Planning Server
  performing tasks on the, 6-30
plans
  creating, 3-6
  launching, 3-6
preface
  PT PrefaceTitle, xxxv
primary path
network routings, 12-43
primary path
product families, 11-5, 12-25
profile options, A-1, A-3, A-11
  INV-Capable to Promise, A-10
  INV-External ATP, A-11
  MRP-ATP Assignment Set, A-11
  MRP-ATP Database Link, A-11
  MRP-Calculate Supply Demand, A-11
  MRP-Include Substitute Components, A-11
  MSC-ATP Assignment Set, A-12
  MSC-Default Workbench Height, A-6
  MSC-Default Workbench Width, A-6
  MSC-Enable Allocated ATP, A-11
  MSC-Enable Allocated ATP Workflow, A-12
  MSC-Hour UOM, A-6
  MSC-Map Server Host, A-6
  MSC-Map Server Port, A-6
  MSC-Plan co-products, A-6
  MSC-Planning Currency, A-7
  MSC-Sales Orders Offset Days, A-7
  MSC-Share Plan Partitions, A-7
  MSC-Sourcing Rule Category Set, A-7
  MSO- NFL FORWARD COMPRESSION
PCT, A-4
MSO-Alternate Process Penalty, A-4
MSO-Alternate Source Penalty, A-5
MSO-Check Redundant Constraints, A-7
MSO-CPLEX Crash Parameter, A-7
MSO-CPLEX Refactor Rate, A-8
MSO-CPLEX Scaling Factor, A-8
MSO-Default Forecast Priority, A-1
MSO-Default Sales Order Priority, A-1
MSO-Dual Simplex Parameter, A-8
MSO-Firm Supply Allocation Window (days), A-4
MSO-Floating Point Precision, A-1
MSO-Global Time Limit, A-8
MSO-Heuristic type, A-2
MSO-Inventory Carrying Costs Percentage, A-5
MSO-List Size for Pricing Candidates, A-8
MSO-LP Markowitz Coefficient, A-8
MSO-LP Optimization Algorithm, A-5
MSO-Maximum Allowable Days Late, A-5
MSO-Maximum Demands per Group, A-2
MSO-Maximum Demands per Slice, A-2
MSO-Maximum Lead Time Factor, A-2
MSO-Maximum Number of Prepones, A-2
MSO-Maximum Number of Pull for Operation, A-3
MSO-Maximum Resource Overcapacity, A-3
MSO-Maximum Simplex Iterations, A-8
MSO-Network routing cycle time coefficient, A-3
MSO-Network routing fixed time window, A-3
MSO-NFL BACKWARD COMPRESSION PCT, A-3
MSO-Penalty Cost Factor for Exceeding Material Capacity, A-5
MSO-Penalty Cost Factor for Exceeding Resource Capacity, A-6
MSO-Penalty Cost Factor for Late Demands, A-6
MSO-Preprocessing Aggregator Fill, A-8
MSO-Preprocessing Aggregator Limit, A-8
MSO-Preprocessing Flag for LP Matrix, A-8
MSO-Primal Simplex Parameter, A-9
MSO-Queue Time Factor, A-6
MSO-Schedule Across Breaks, A-4
MSO-Schedule window width, A-4
MSO-Simplex Feasibility Tolerance, A-9
MSO-Simplex Optimality Tolerance, A-9
MSO-Simplex Perturbation Constant, A-9
MSO-Simplex Perturbation Indicator, A-9
MSO-Simplex Perturbation Limit, A-9
MSO-Solve Dual Problem, A-9
MSO-Substitute Item Penalty, A-6
MSO-substitution parameter, A-6
MSO-Substitution optimization, A-4
Oracle Global Order Promising, A-10
Project MRP
  implementation steps, 12-18, 12-19
Oracle ASCP setup, 12-20
Oracle Inventory setup, 12-19
Oracle Project Manufacturing setup, 12-19
planning logic, 12-21
Project Workflow
  See also Oracle Workflow, 13-6
project workflow, 3-9
projects/tasks and Seiban numbers, 4-5
projects/tasks exception messages, 9-53
Property window
  displaying, 10-53
PT PrefaceTitle, xxxv
pull architecture, 4-4
pull program, 4-3

R
rank and allocation
  setting, 6-18
RDBMS version, 4-5
recommendations
  discrete jobs and purchase requisitions, 9-58
  exception messages, 9-58
related exceptions
  drill down, 10-35
related exceptions for the late replenishment
  viewing, 10-36
releasing all recommendations, 10-45
releasing order, 3-13
releasing recommendations, 10-43
reschedule line results, C-6
reschedules exception messages, 9-45
rescheduling an operation, 10-57, 10-60
rescheduling an operation graphically, 10-58
rescheduling order line simulation data process, C-18
rescheduling within order backlog workbench, C-18
Rescheduling Workflow
See also Oracle Workflow, 13-6
rescheduling workflow, 3-9
resize windows, 10-10
resolving overload of an operation, 10-60
resource aggregation, 5-35, 17-31
resource availability viewing, 10-29
resource constraint, 9-36
resource overloaded, 9-38
resource tool tip accessing, 10-54
resource underloaded, 9-40
resources aggregate, 12-7
decreasing, 5-43
modifying, 3-11
selecting to plot, 10-55
simultaneous, 12-7
viewing, 10-28
reverse actions or changes, 7-9
review constrained forecast, 3-12
review workflow notifications, 3-8
reviewing a BOM, 10-46
reviewing a BOM or supply chain bill, 10-45
reviewing exception messages, 17-52
reviewing exceptions, 3-7
reviewing KPIs, 3-7
rounding order quantities, 11-8
routing effectiveness, 12-6
routings, 11-8
run net change, 3-12
running a batch replan, 7-5
running a global supply chain plan, 5-3, 17-7
running an online replan, 7-5
running an optimized plan, 3-10
running an unconstrained plan, 3-10
safety stocks, 11-5, 17-47
safety stocks and target safety stocks, 17-47
Sales Order Workflow
See also Oracle Workflow, 13-6
sales order workflow, 3-9
saving actions, 7-7
saving changes Gantt Chart, 10-63
scheduling order lines with order backlog workbench, C-15
scheduling orders using order backlog workbench, C-9
See also online replan
online replan, 3-12
Seiban numbers, 4-5
selecting planned items plan options, 17-24
selecting resources to plot, 10-55
selection criteria for scheduling with order backlog workbench, C-7
service level, 1-18
set supplier lead time variability plan options, 17-22
set up flowchart, 2-6
setting constraints plan types, 11-14
setting plan options, 17-25
setting demand variability, 17-17
setting hard and soft constraints, 11-12
setting item demand class service level, 17-35
setting Oracle Risk Optimization constraints, 17-26
setting penalty costs, 17-42
setting penalty factor for exceeding material capacity hierarchy, 8-13
setting penalty factor for exceeding resource capacity hierarchy, 8-21
setting penalty factor for late demand hierarchy, 8-5
setting performance indicators, 17-43
setting plan options
setting constraints, 17-25
setting resource aggregation levels, 5-35, 17-31
setting routing aggregation level for a time horizon
controlling aggregation, 17-32
setting service levels, 17-34
item/demand class, 17-35
setting supplier lead time variability
plan options, 17-23
setting targets for KPIs, 9-9
setting the category demand class service level, 17-37
setting the customer service level, 17-39
setting the demand class service level, 17-40
setting the item service level, 17-37
setting the material aggregation level, 5-36, 17-30
setting the organization service level, 17-40
setting up, 4-14
Applications Instance window, 2-14
Organization window, 2-15
setting up a demand plan
defining demand planning dimensions, 18-13
defining demand planning hierarchy levels, 18-19
defining demand planning levels, 18-18
setting up Project MRP, 12-18, 12-19
setup required to use multilevel ATO, 14-10
sharing forecasts/demand plans, 13-2
forecast consumption status, 13-2
providing viewing and updating access, 13-2
viewing customer specific forecasts, 13-2
shortages and excess exception messages, 9-43
simulation modes, 7-3
simulation scenarios
demands, 7-2
item supply and demand, 7-2
optimization objectives, 7-3
resource availability, 7-2
supplier capacity, 7-2
supplies, 7-2
simulations, 1-8, 7-3
comparing scenarios quantitatively, 7-12
net change replan, 7-3
overview, 7-2
simultaneous high level planning, 1-6
simultaneous resources, 12-7
flexfields, 12-7 to 12-10
Single Level Supply Chain ATP, 16-12
Assignment Set, 16-14
ATP Inquiry, 16-16
ATP Logic, 16-17
ATP Rule, 16-13
Business Application, 16-12
Data Collection, 16-16
Example, 16-17
Inter-Location Transit Times, 16-14
Item Attributes, 16-12
Profile - INV
Capable to Promise, 16-15
Profile - MRP
ATP Assignment Set, 16-15
ATP Database Link, 16-15
Setup Steps, 16-12
Sourcing Rule, 16-13
Single Level Supply Chain ATP From i-Store, 16-16
Single Level Supply Chain ATP From Order Management, 16-16
Single Level Supply Chain ATP With or Without APS, 16-15
soft pegging, 12-12
sorting exceptions, 10-31
sources of demand, 3-5
specifying, 3-5
sourcing assignment hierarchy
viewing, 6-30
sourcing constraints
tolerance fences, 11-10
sourcing percentages
splitting demand according to, 6-18
sourcing rules
defining, 6-3
supply chain, 6-2
viewing, 6-29
specify supply types
plan options, 17-27
specifying items to be included in the inventory plan
plan options, 17-24
specifying new time bucket for lower pane, 10-56
specifying new time bucket for right pane, 10-55
specifying plan objectives, 17-33
maximize inventory turns, 17-33
maximize ontime delivery, 17-34
maximize plan profit, 17-33
specifying sources of demand, 3-5
demand schedules, 17-27
supply schedules, 17-27
specifying sources of supply and demand
plan options, 17-27
specifying supply types
plan options, 17-27
splitting demand according to sourcing
percentages, 6-18
stochastic optimization solution, 1-16
stopping an online planner session, 7-7
subset plan, 5-9, 17-6
setting parameters, 17-9
subset planning
pitfalls, 5-7
scenarios, 5-6
substitute components, 11-4
substitutes and alternates used exception
messages, 9-49
supplier capacity, 7-2
delivery and reception frequency calendars, 6-9
setting, 6-4
setting a delivery and reception frequency
calendar, 6-10
setting by time periods, 6-6
setting by time periods for version 10.7 or
11.0, 6-8
setting by time periods for version 11i, 6-6
setting supplier flexfences for version 10.7 or
11.0, 6-8
setting supplier specific lead time, 6-9
supplier specific planning constraints, 6-9
supplier capacity overloaded, 9-39
Supply and Demand, 16-61
supply and demand
modifying, 3-11
pegging, 3-9
See also pegging, 3-9
view pegged, 3-9
supply chain, 6-2
assignment sets, 6-3
performance management, 13-4
setting up, 6-2
sourcing rules, 6-2
viewing, 6-29, 10-40
Supply Chain ATP From Advanced Supply Chain
Planning, 16-17
supply chain bill
illustration, 14-4
supply chain collaboration, 1-10
demand planning, 1-10
order promising, 1-10
performance management, 1-10
supply chain planning, 1-10
supply chain modeling
See also supply chain, 6-2
supply chain or where used information
viewing, 10-40
supply chain planning, 5-2
supply chain synchronization, 12-23
supply schedules
specifying sources of demand, 17-27
support for coproducts, 1-14
support for flow schedules, 12-23
support for lot-based jobs, 1-14
supported configurations, 4-7

T

tabs
Actions, 1-9, 1-10
layout, 10-13
Aggregation, 5-21, 5-36, 17-12, 17-31
horizontal plan, 10-23
Items
layout, 10-15
Key Indicators, 10-17
Optimization, 5-22, 8-3, 17-14, 17-33
Options, 5-18, 11-13, 17-11
Organizations, 5-25, 17-15
Projects
layout, 10-16
Resources
layout, 10-16
Suppliers
layout, 10-17
vertical plan, 10-23
tailoring the user interface, 10-9, 10-10
Planer Workbench
  customize columns, 10-11
display preferences, 10-11
target safety stocks, 17-47
time buckets, 1-10
  specifying, 10-55
Time Fence Options, 16-60
time-phased supply and demand
  viewing output, 17-45
tolerance fences
  sourcing constraints, 11-10
transportation capacity
  flexfields, B-3
transportation resource constraint, 9-41
transportation resource overloaded, 9-42
transportation resource underloaded, 9-42

U
unconstrained plan
  running, 3-10
  See also plan types, 3-10
unconstrained safety stocks, 17-47
undoing your actions, 7-11
unit numbers in sales orders, 12-16
using an existing plan as a demand schedule for
  new plan, 5-26
  plan options, 17-17
using an existing plan as a supply schedule for a
  new plan, 5-31
  plan options, 17-17
Using Global ATP Server from Non-Oracle
  Applications, 16-70
using multilevel ATO features, 14-10

V
vertical plan, 10-23
view the supply chain, 10-40
viewing actions, 7-7
viewing allocations, 16-46
viewing assignment sets, 6-30
viewing available capacity, 10-27
viewing bills of distribution (BODs), 6-30
viewing details on an action, 7-10
viewing exception details, 10-32, 10-35
viewing exceptions
  exceptions
    viewing, 10-30
viewing graphical pegging, 10-39
viewing output, 17-44
  performance indicators, 17-44
  time-phased supply and demand, 17-45
viewing related exceptions for the late
  replenishment, 10-36
viewing resource availability, 10-29
viewing resources, 10-28
viewing sourcing assignment hierarchy, 6-30
viewing sourcing rules, 6-29
viewing supply chain or where used
  information, 10-40
viewing the end date for inventory plan
  controlling aggregation, 17-29
viewing the plan, 12-22
viewing time-phased material and resource
  availability, 17-50
viewing time-phased resource requirements, 17-48
viewing time-phased safety stocks, 17-48
viewing time-phased supply and demand, 17-45
viewing undo summary for a plan, 7-9

W
windows
  Adjusting Resource Availability from the Planner
    Workbench, 9-25
  Aggregation tab, 5-21
  Allocation Rule, 17-35
  Application Utilities
    MSD_DIMENSIONS Lookups, 18-14
  Assign Allocation, 17-36
  Assign Allocation Rule, 17-38, 17-41
  Assign Allocation Rule, Allocation Rule
    field, 17-36, 17-38
  Assign Allocation Rules, 16-43
  ATP Criteria, 16-65
  ATP Detail, 16-68, 16-69
  Comparing Exceptions, 10-37
  Customer Information, 17-39
  Data Pull Parameters, 4-10
Demand Plan Hierarchies, 18-33
Demand Plan Parameters, 18-35
Demand Plan Scenarios, 18-37
Demand Planning Hierarchies, 18-17
Demand Planning Hierarchy Levels, 18-20
Demand Planning Levels, 18-18
Demand Plans, 18-31
Distribution Plan Names, 5-5
Exception Details, 10-32
Exception Details for Past Due Sales
Orders, 9-28
Express Setup, 18-26, 18-40
Find, 10-4
Find window, 10-51
Firm Option, 10-60
Gantt Chart, 10-48
Horizontal Plan, 10-25, 17-48
Item’s Supply Chain bill, 10-41
Items, 17-37
Items Attributes, 6-7
Key Performance Indicators (KPIs), 10-18
Key Performance Indicators (KPIs) trend chart, 10-20
KPI bar chart (enlarged version), 10-19
KPIs Summary Chart in the Planner Workbench, 17-45
Manufacturing Plan Names, 5-5
Material Plan Names, 5-5
Material Plan tab, 10-12
Multiple Plans Comparison, 7-13
ODS Load Parameters, 4-12
Online Planner Status, 7-6
Options tab, 5-19
Options tab with Planned Items displayed, 17-25
Oracle ASCP Key Performance Indicators, 9-3
Oracle Risk Optimization Key Performance Indicators, 9-4
Order Promising Workbench, 16-67
Organization Parameters, 17-40
Organizations tab, 5-25
Organizations tab (setting demand variability), 17-18
Pegging, 12-21
Pegging tree, 10-39
Planner Workbench, 10-2
Planner Workbench Actions tab, 9-18
Planner Workbench Sourcing Rule, 9-36
Preferences, 12-15
Properties, 10-8
Property window, 10-53
Releasing Recommendations, 10-44
Reschedule, 10-58
Resource Availability, 10-30, 10-62
Resource Availability Summary, 10-61, 17-51
Resource Tool Tip, 10-54
Resources, 10-28, 17-49
Resources Requirements, 10-29
Scenario Output Levels, 18-39
Schedule, 4-14
Select Resources, 10-55
Setting KPI Target Levels in Oracle BIS, 9-8
SRO Names, 17-8
Subinventory Netting, 5-27
Supplier Capacity, 6-8
Supplier Capacity Adjustment, 9-23
Supplier Flexfences, 6-9
Supplier Variability, 17-23
Supply/Demand, 17-46
Time Buckets, 10-56
Undo Detail, 7-11
Undo Summary, 7-10
Vertical Plan, 10-24
Where Used Information for an End Item, 10-42
WIP mass/load PO requisitions interface, 12-18
workflow
See Oracle Workflow, 12-18
workflows
See also Oracle Workflow, 3-9
Y

yield at operation level, 1-14